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20Willkommen!

Willkommen!

Hinweis: Das Handbuch enthält bislang nur grundlegende Informationen zur Bedienung des Programms
über die neue Menüband-Benutzeroberfläche ("Ribbons"). Ausführlichere Informationen dazu wer-
den in einer späteren Auflage nachgereicht.

Tipp: Eine Tabelle, die zeigt, welcher Menübefehl welchem Ribbonbefehl entspricht, finden Sie hier:
Menübefehle und entsprechende Ribbonbefehle.

Willkommen bei PlanMaker! Mit PlanMaker haben Sie ein überaus leistungsfähiges und dabei komfortabel
zu bedienendes Tabellenkalkulationsprogramm erworben. 

Wir haben uns bei der Erstellung dieses Programms bemüht, die Funktionen von PlanMaker so zu integrie-
ren und aufeinander abzustimmen, dass Ihnen bei möglichst geringem Arbeitsaufwand der größtmögliche
Nutzen geboten wird. 

Dabei lässt Ihnen PlanMaker genügend Freiraum für Ihre individuellen Ansprüche. Über zahlreiche Ein-
stellmöglichkeiten können Sie sich PlanMaker so einrichten, wie es Ihnen am besten gefällt.

Einige Features von PlanMaker

¡ Erhältlich für Windows, Mac, Linux und Android. 

¡ Durchdachte und ergonomische Benutzeroberfläche – wahlweise mit modernen "Ribbons" oder klassi-
schen Menüs und Symbolleisten

¡ PlanMaker kennt über 330 Rechenfunktionen – von der einfachen Summenberechnung bis hin zu zahl-
reichen finanzmathematischen und statistischen Funktionen. 

¡ Das Erstellen von ansehnlichen Tabellen wird durch die vielfältigen Gestaltungsfunktionen erleichtert.
Nüchterne Zahlenkolonnen können mit dem AutoFormat-Befehl auf Knopfdruck in übersichtliche und
ansprechende Tabellen verwandelt werden. Mit Zellen- und Zeichenvorlagen bringen Sie häufig benö-
tigte Formatierungen auf Knopfdruck an etc.

¡ Das integrierte Diagramm-Modul erlaubt es Ihnen, Zahlen anschaulich in Diagrammen zu präsentieren.

¡ ... und vieles mehr

PlanMaker wird ständig weiterentwickelt. Falls Sie beim Arbeiten einmal ein Feature vermissen sollten
oder andere Anregungen haben, schreiben Sie uns – wir wollen, dass PlanMaker den Wünschen der Anwen-
der entspricht!

Android-Version

PlanMaker ist auch für Android-Geräte erhältlich und enthält praktisch alle Funktionen der Windows-Versi-
on.
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Technischer Support
Wenn Sie Fragen haben, hilft Ihnen unser technischer Support gerne weiter. Sie können diesen wie folgt er-
reichen:

Website

Auf unserer Website finden Sie die neuesten Updates für Ihre Programme, Tipps und Tricks, kostenlose
Downloads und vieles mehr. 

Besuchen Sie uns auf: www.softmaker.de

Supportforen

In unseren Supportforen können Sie technische Fragen stellen und mit anderen Anwendern kommunizieren.

Sie finden diese unter: forum.softmaker.de

Anfragen an unseren Support

Bei Problemen mit unserer Software helfen wir Ihnen gerne weiter. 

Sie können Ihre Fragen hier eingeben: www.softmaker.de/supportassistent

Über dieses Handbuch
PlanMaker besitzt sehr viele Funktionen – aber keine Sorge: Sie müssen nicht alle davon beherrschen! Nut-
zen Sie am Anfang nur die Möglichkeiten, die Sie benötigen. Wenn Sie später einmal fortgeschrittenere
Funktionen in Anspruch nehmen möchten, können Sie die entsprechenden Stellen im Handbuch immer noch
nachlesen.

Dieses Handbuch ist wie folgt aufgebaut:

¡ Das Kapitel Installation und Programmstart beschäftigt sich mit der Installation von PlanMaker. Sie
erfahren weiterhin, wie das Programm gestartet wird. 

¡ Im Kapitel Der Arbeitsbildschirm werden die einzelnen Bestandteile des Programmfensters von
PlanMaker beschrieben.

¡ Das Kapitel Grundlagen stellt Ihnen die grundlegenden Funktionen von PlanMaker vor und erläutert ei-
nige Grundbegriffe der Tabellenkalkulation.

¡ Das Kapitel Die PlanMaker-Tour befasst sich praxisbezogen mit dem Thema Tabellenkalkulation und
führt Sie anhand einiger Beispiele in die Bedienung von PlanMaker ein. 

¡ Mit dem Kapitel Bearbeiten einer Tabelle beginnt der Referenzteil des Handbuchs. Dieser ist nach
Sachgebieten aufgeteilt und beschreibt ausführlich alle Funktionen von PlanMaker.

http://www.softmaker.de/
http://forum.softmaker.de
http://www.softmaker.de/supportassistent
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Systemvoraussetzungen
Zum Einsatz dieser Software benötigen Sie folgende Hard- und Software: 

Windows-Version

¡ Windows 10, Windows 8/8.1 oder Windows 7 (32 oder 64 Bit) 

Mac-Version

¡ macOS oder OS X ab Version 10.10 ("Mavericks") 

Linux-Version

¡ Beliebiges x86-Linux (32 oder 64 Bit) 

Android-Version

¡ Android 5.0 oder höher 
¡ ARM-kompatible CPU
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Installation und Programmstart
In diesem Kapitel erfahren Sie, wie Sie PlanMaker installieren und wie Sie das Programm starten.

Das Kapitel ist nach Betriebssystemen aufgeteilt:

¡ Installation unter Windows 

¡ Installation unter macOS

¡ Installation unter Linux

¡ Installation auf Android-Geräten

Lesen Sie bitte bei dem Abschnitt für Ihr Betriebssystem weiter.

Installation unter Windows

Download

Wenn Sie die Software als Download aus dem Internet bezogen haben, finden Sie Instruktionen zur Installa-
tion in der E-Mail, die Sie beim Kauf automatisch erhalten haben.

CD-ROM

Wenn Sie die Software auf CD-ROM bezogen haben, starten Sie nun bitte das Installationsprogramm im
Hauptverzeichnis der CD. Folgen Sie dann den Anweisungen des Installationsprogramms.

Starten der Programme

Zum Starten der installierten Programme verwenden Sie das Start-Menü in der linken unteren Bildschirme-
cke. Sie finden Ihre SoftMaker Office-Programme dort in einem Unterordner namens SoftMaker Office.

Adresseingabe beim ersten Start: Wenn Sie PlanMaker zum ersten Mal starten, werden Sie gebeten, Ihren Namen, Ihre Adresse etc. anzugeben.
Diese Angaben dienen nicht der Registrierung. Vielmehr erlauben sie Ihnen, über die Funktion BENUTZERFELD Ihren Namen, Ihre Adresse etc in
Dokumente oder Dokumentvorlagen einzufügen Sie können diese Angaben später jederzeit wieder ändern (siehe Abschnitt Einstellungen, Karteikar-
te Allgemein).

Installation unter macOS
Informationen zur Installation der Software finden Sie in der E-Mail, die Sie beim Kauf automatisch erhal-
ten haben.
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Fehlermeldung beim Starten des Installationsprogramms?

Abhängig von den Einstellungen Ihres Systems erhalten Sie beim Starten des Installationsprogramms mögli-
cherweise folgende Fehlermeldung:

Dies passiert, wenn in den Sicherheitseinstellungen Ihres Systems festgelegt ist, dass nur Programme ausge-
führt werden dürfen, die aus dem App Store heruntergeladen wurden.

Wie Sie das Installationsprogramm dennoch ausführen können, verrät ein Klick auf das Fragezeichen in der
linken unteren Ecke der Meldung. Es erscheint ein Hilfefenster, das folgende Vorgehensweise empfiehlt:

1. Schließen Sie die Fehlermeldung.

2. Halten Sie die ctrl-Taste gedrückt und klicken Sie auf das Installationsprogramm.

3. Es erscheint ein Kontextmenü. Wählen Sie darin den Befehl Öffnen.

4. Es erscheint eine Meldung, in der nachgefragt wird, ob Sie das Programm wirklich öffnen möchten. Be-
stätigen Sie das, indem Sie auf die Schaltfläche Öffnen klicken.

Das Installationsprogramm wird nun gestartet.

Starten der Programme

Nach erfolgter Installation erscheinen Symbole für die installierten Programme sowohl im Launchpad als
auch im Dock am unteren Bildschirmrand. Um eines der Programme zu starten, klicken Sie einfach sein
Symbol an. 

Installation unter Linux
Informationen zur Installation der Software finden Sie in der E-Mail, die Sie beim Kauf automatisch erhal-
ten haben.

Starten der Programme

Bei den meisten Linux-Distributionen legt das Installationsprogramm automatisch Verknüpfungen für alle
SoftMaker Office-Applikationen im Menü an. Mit diesen können Sie die Programme bequem per Mausklick
starten.
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Als Alternative werden außerdem Skripte zum Starten der Programme angelegt: 

¡ textmaker18 startet TextMaker 

¡ planmaker18 startet PlanMaker

¡ presentations18 startet Presentations

Sie können diese Skripte beispielsweise in einer Shell aufrufen.

Adresseingabe beim ersten Start: Wenn Sie PlanMaker zum ersten Mal starten, werden Sie gebeten, Ihren Namen, Ihre Adresse etc. anzugeben.
Diese Angaben dienen nicht der Registrierung. Vielmehr erlauben sie Ihnen, über die Funktion BENUTZERFELD Ihren Namen, Ihre Adresse etc in
Dokumente oder Dokumentvorlagen einzufügen Sie können diese Angaben später jederzeit wieder ändern (siehe Abschnitt Einstellungen, Karteikar-
te Allgemein).

Installation auf Android-Geräten

Bei Kauf im Google Play Store

Wenn Sie eine Applikation über den Google Play Store auf Ihrem Gerät erwerben, brauchen Sie zum In-
stallieren nichts weiter zu tun: Die App wird direkt nach dem Kauf automatisch heruntergeladen und instal-
liert.
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Der Arbeitsbildschirm
Auf den nächsten Seiten stellen wir Ihnen die einzelnen Komponenten der Benutzeroberfläche von PlanMa-
ker vor. 

Das Programmfenster von PlanMaker (Windows-Version)

Anmerkung: Die Abbildungen in diesem Handbuch wurden größtenteils mit der Windows-Version von
PlanMaker angefertigt. Unter anderen Betriebssystemen sehen manche Bedienelemente zwar etwas an-
ders aus, ihre Funktionsweise ist jedoch die gleiche.

Titelleiste
In der obersten Zeile des Programms finden Sie die Titelleiste.

Diese zeigt den Programmnamen und den Namen des Dokuments an, das Sie gerade bearbeiten. 

Falls das Dokument Änderungen enthält, die noch nicht gespeichert wurden, wird ein Sternchen hinter sei-
nem Namen angezeigt.
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Menüleiste
Unter der Titelleiste befindet sich die Menüleiste.

Diese enthält sämtliche Befehle von PlanMaker in Form von übersichtlichen Menüs. Klicken Sie auf einen
Menüeintrag, um ein Menü zu öffnen und darin einen Befehl aufzurufen.

Kontextmenü

Es gibt außerdem noch ein weiteres Menü: das sogenannte Kontextmenü. 

Dieses enthält je nach Situation unterschiedliche Befehle. Wenn Sie beispielsweise etwas Text markieren
und dann das Kontextmenü öffnen, bietet dieses Befehle zum Ausschneiden, Kopieren und Formatieren die-
ses Textes an.

Um das Kontextmenü zu öffnen, markieren Sie üblicherweise erst etwas im Dokument und klicken das Mar-
kierte dann mit der rechten Maustaste an.

Android: Bei der Android-Version können Sie das Kontextmenü auch mit dem Finger öffnen: Tippen Sie da-
zu auf den Bildschirm und halten Sie den Finger für etwa eine Sekunde gedrückt.

Funktionsleiste
Unter der Menüleiste wird die Funktionsleiste angezeigt. Diese enthält Symbole für die gebräuchlichsten
Befehle von PlanMaker.

Symbolleisten wie die Funktionsleiste ermöglichen blitzschnellen Zugriff auf die Funktionen eines Pro-
gramms. Jedes Symbol steht für einen bestimmten Befehl. Klicken Sie darauf, wird der entsprechende Be-
fehl aufgerufen. 

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), erscheint ein Infotext, der
die Funktion des Symbols angibt.
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Es gibt in PlanMaker noch zahlreiche weitere solche Symbolleisten, die Sie nach Belieben ein- und aus-
schalten können. Rufen Sie dazu entweder den Menübefehl Ansicht > Symbolleisten auf oder klicken Sie
mit der rechten Maustaste auf eine der angezeigten Symbolleisten. Es erscheint ein Menü, in dem Sie wäh-
len können, welche Leisten angezeigt werden sollen.

Symbolleisten selbst gestalten: Sie können die vorgegebenen Symbolleisten nach Belieben verändern und
auch eigene Symbolleisten erstellen. Informationen dazu finden Sie im Abschnitt Symbolleisten anpassen.

Formatleiste
Die Formatleiste finden Sie unterhalb der Funktionsleiste. Sie können damit die gebräuchlichsten Textfor-
matierungen (Schriftart, Fettdruck, Kursivschrift usw.) für Tabelleninhalte sowohl ablesen als auch ändern.

Um beispielsweise eine andere Schriftart auszuwählen, klicken Sie auf das kleine Pfeilchen rechts neben der
Schriftart, um die Liste zu öffnen, und wählen dann eine Schriftart aus.

Andere Symbole der Formatleiste sind wiederum Schalter, die Sie durch Anklicken ein- und ausschalten
können – zum Beispiel das F für Fettdruck.

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), erscheint ein Infotext, der
die Funktion des Symbols angibt.

Bearbeitungsleiste
Unterhalb von Funktions- und Formatleiste finden Sie die Bearbeitungsleiste.

Auf dieser Leiste gibt es folgende Bedienelemente:

Zelladresse

Ganz links wird die Adresse der momentan aktiven Tabellenzelle angezeigt.

Symbole und Eingabefeld zum Bearbeiten von Zellinhalten

Rechts daneben finden Sie vier Symbole und ein Eingabefeld.

Mit Hilfe des Eingabefelds können Sie den Inhalt der aktuellen Zelle bearbeiten. Alternativ können Sie den
Zellinhalt allerdings auch direkt in der entsprechenden Zelle bearbeiten: die Zelle einfach ansteuern und tip-
pen. Letzteres geht in der Regel schneller. 

Ausführliche Informationen zum Ausfüllen und Bearbeiten von Tabellenzellen finden Sie im Abschnitt Da-
ten in Zellen eingeben.
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Die Schaltflächen daneben haben folgende Funktionen:

Symbol Funktion

Menübefehl Einfügen > Funktion aufrufen

Eingabe im Eingabefeld übernehmen (entspricht dem Drücken der Eingabetaste ¿)

Eingabe im Eingabefeld verwerfen (entspricht dem Drücken der Taste Esc)

Weitere Informationen zum Eingeben von Rechenformeln finden Sie im Kapitel Formeln und Funktionen.

Ribbon (Menüband)
Wenn Sie in den Einstellungen ausgewählt haben, dass Sie statt klassischer Menüs und Symbolleisten lieber
ein Ribbon (also ein Menüband) verwenden möchten, sieht der oberste Bereich des Programmfensters bei
Ihnen etwa folgendermaßen aus:

Das "Ribbon" (Ausschnitt) und die Schnellzugriffsleiste (ganz unten)

Ribbons sind eine moderne Art von Benutzeroberfläche, die Menüs und Symbolleisten ersetzen soll, indem
sie diese kombiniert. Dies soll den Umgang mit der Software vereinfachen.

Wie Sie sehen, verfügt das Ribbon über mehrere Karteikarten, deren Karteikartenreiter ganz oben angezeigt
werden (Datei, Start, Einfügen etc.). Jede dieser Ribbon-Karten enthält Symbole zu einem bestimmten Auf-
gabenbereich. Um zu einer bestimmten Ribbon-Karte zu wechseln, klicken Sie auf ihren Reiter.

Tipp: Sie können auch über die Tastatur zwischen den Ribbon-Karten wechseln: Mit Strg+F12 bewegen
Sie sich zur nächsten Karte und mit Strg+Umschalt+F12 zur vorherigen Karte.

Unter dem Ribbon wird die Schnellzugriffsleiste angezeigt. Diese bietet eine Auswahl an besonders häufig
benötigten Befehlen.

Hinweis: Das Handbuch enthält bislang nur grundlegende Informationen zur Bedienung des Programms
über das Ribbon. Ausführlichere Informationen dazu werden in einer späteren Auflage nachgereicht.

Tipp 1: Eine Tabelle, die zeigt, welcher Menübefehl welchem Ribbonbefehl entspricht, finden Sie hier:
Menübefehle und entsprechende Ribbonbefehle.
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Tipp 2: Sie können auch vom Ribbon aus auf das klassische Menü zugreifen: Klicken Sie einfach auf das

Symbol  in der Schnellzugriffsleiste, um dieses zu öffnen.

Tipp 3: Die Benutzeroberfläche lässt sich jederzeit zwischen Ribbon und klassischen Menüs mit Symbol-
leisten umschalten. Rufen Sie dazu im Menü den Befehl Weiteres > Einstellungen auf (beziehungsweise
im Ribbon den Befehl Datei > Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Ausse-
hen und klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein weiterer Dialog, in
dem Sie die gewünschte Art von Benutzeroberfläche wählen können.

Registerkarten für Dokumente
Unter der Bearbeitungsleiste sehen Sie eine Leiste mit Registerkarten. Darin wird für jedes momentan ge-
öffnete Dokument jeweils eine Registerkarte angezeigt.

Die Registerkarten für Dokumente

Mit den Registerkarten lassen sich folgende Aktionen durchführen:

¡ Um ein Dokument zum aktiven Dokument zu machen, klicken Sie mit der linken Maustaste auf seine Re-
gisterkarte. So können Sie blitzschnell zwischen den geöffneten Dokumenten hin- und herwechseln. 

¡ Um ein Dokument zu schließen, klicken Sie mit der mittleren Maustaste auf seine Registerkarte.

Alternativ können Sie auch mit der linken Maustaste auf das x-Symbol klicken, das ganz rechts in der
Registerkarte angezeigt wird.

Dokumente können bei Bedarf übrigens auch in einem neuen Programmfenster geöffnet werden. Details
zum Arbeiten mit mehreren Dokumenten finden Sie im Kapitel Mehrere Dokumente gleichzeitig bearbeiten.

Dokument
Den größten Teil des Programmfensters nimmt das Dokument selbst ein. Dies ist Ihr Arbeitsbereich. Hier
tragen Sie Ihre Daten ein, nehmen Berechnungen vor etc.

Informationen dazu finden Sie im Rest dieses Handbuchs, insbesondere im Kapitel Bearbeiten einer Tabel-
le.

Arbeitsblattregister
Unterhalb des Dokuments wird das Arbeitsblattregister angezeigt.

Ein PlanMaker-Dokument kann aus mehreren Tabellenblättern bestehen, die – wie ein Stapel Papier – auf-
einander gestapelt sind. Diese werden Arbeitsblätter genannt. Mit dem Arbeitsblattregister können Sie zwi-
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schen den einzelnen Arbeitsblättern eines Dokuments wechseln, neue Blätter anlegen und Blätter löschen
(siehe Abschnitt Arbeiten mit mehreren Arbeitsblättern).

In obiger Abbildung sehen Sie, wie das Arbeitsblattregister bei einer Arbeitsmappe mit drei Arbeitsblättern
aussieht. Das momentan aktive Blatt "Tabelle1" ist hervorgehoben.

Statuszeile
Am unteren Ende des Programmfensters befindet sich die Statuszeile.

Hinweis: Wenn Sie die Statuszeile nicht sehen sollten, müssen Sie die Einstellungen dafür ändern, wie
im Abschnitt Einstellungen, Karteikarte Aussehen beschrieben.

Wenn Sie mit der Maus auf eines der Symbole einer Symbolleiste oder eines Ribbons zeigen, wird in der
Statuszeile eine kurze Erläuterung zur Funktion dieses Symbols ausgegeben.

Darüber hinaus werden in der Statuszeile folgende Informationen angezeigt:

Beispiel Erläuterung

Ganz links werden unterschiedliche Informationen angezeigt. Zeigen Sie beispielsweise auf ein
Symbol der Funktionsleiste, wird hier die Funktion dieses Symbols eingeblendet.

Tabelle1 Rechts daneben wird der Name des aktuellen Arbeitsblatts angezeigt.

Summe=6 Daneben wird die sogenannte Online-Berechnung angezeigt. Ist nur eine Zelle markiert, wird ihr
Inhalt angezeigt. Sind mehrere Zellen markiert, wird die Summe der Zellinhalte angezeigt. (Siehe
auch Option Online-Berechnung in Statuszeile in den Einstellungen.)

Dieses Symbol leuchtet auf, wenn die Tabelle einen zirkulären Bezug enthält. Dies weist norma-
lerweise auf eine fehlerhaft formulierte Formel hin – zum Beispiel eine Rechenformel in Zelle A1,
die sich auf die Zelle A1 bezieht.

Wenn Sie dieses Symbol anklicken, springt der Zellrahmen auf die Zelle mit dem zirkulären Be-
zug. Klicken Sie erneut, springt er auf die nächste derartige Zelle (falls mehrere vorhanden sind).

EINF Zeigt an, ob der Einfügemodus (EINF) oder der Überschreibmodus (ÜB) aktiv ist. Dadurch be-
stimmen Sie, was beim Editieren einer Zelle mit dem alten Zellinhalt passieren soll:

EINF: Der Einfügemodus ist aktiv – neu eingegebener Text wird also vor dem bestehenden Text
eingefügt.

ÜB: Der Überschreibmodus ist aktiv – neu eingegebener Text überschreibt also den bestehenden
Text.

Die Standardeinstellung ist EINF. Mit der Taste Einfg können Sie zwischen diesen beiden Modi
umschalten.

AUTO Zeigt den aktuellen Eingabemodus von PlanMaker an:
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AUTO: Der normaler Eingabemodus ist aktiv – Zahlen werden automatisch als Zahlen erkannt,
und Formeln werden automatisch als Formeln erkannt. Dies ist die Standardeinstellung.

TEXT: Der Text-Eingabemodus ist aktiv – sämtliche Eingaben werden in Text umgewandelt
(auch Zahlen und Formeln).

Um zwischen diesen beiden Modi zu wechseln, klicken Sie auf den Text "AUTO" in der Status-

zeile oder betätigen die Tastenkombination Strg+Umschalt+F4.

Wichtig: Wenn Sie in den TEXT-Eingabemodus umschalten, wird allen Zahlen und Formeln, die
Sie eingeben, automatisch ein einfaches Anführungszeichen (') vorangestellt. Dadurch werden die-
se in Text umgewandelt und können nicht mehr für Berechnungen verwendet werden. (Um aus so
umgewandelten Zahlen/Formeln wieder normale Zahlen/Formeln zu machen, wechseln Sie wieder
zurück in den AUTO-Modus und entfernen diese Anführungszeichen.)

Darüber hinaus enthält die Statuszeile einen Zoomregler, mit dem Sie die Vergrößerungsstufe für das Doku-
ment ändern können:

Ziehen Sie dazu entweder an dem Schieber in der Mitte, oder klicken Sie auf das Minus- oder Plussymbol.
(Siehe auch Abschnitt Vergrößerungsstufe.)
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Grundlagen
Dieses Kapitel stellt Ihnen die wichtigsten grundlegenden Funktionen von PlanMaker vor und erläutert eini-
ge Grundbegriffe der Tabellenkalkulation. 

Folgende Themen werden in diesem Kapitel behandelt:

¡ Der Aufbau einer Tabelle 

Zunächst erfahren Sie, wie Tabellen überhaupt aufgebaut sind.

¡ Bewegen in einer Tabelle 

Anschließend geht es darum, wie Sie in einer Tabelle navigieren können.

¡ Daten eingeben und Daten löschen 

In den nächsten beiden Abschnitten lernen Sie Methoden zum Eingeben und Löschen von Daten kennen.

¡ Änderungen rückgängig machen 

Hier erfahren Sie, wie Sie Änderungen am Dokument wieder rückgängig machen können.

¡ Neues Dokument beginnen 

Dieser Abschnitt zeigt Ihnen, wie Sie ein neues Dokument anlegen.

¡ Dokument öffnen, Dokument drucken und Dokument speichern 

In diesen drei Abschnitten geht es um das Öffnen, das Drucken und das Speichern von Dokumenten.

Lesen Sie dazu die nächsten Seiten.

Der Aufbau einer Tabelle
Um PlanMaker beim Durcharbeiten dieses Kapitels gleich ausprobieren zu können, sollten Sie ihn jetzt star-
ten. 
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Wie Sie an der Abbildung schon erkennen können, sind Tabellen in Zeilen und Spalten aufgeteilt. Jede Ta-
belle kann bis zu eine Million Zeilen und 16384 Spalten haben. Diese sind wie folgt beschriftet:

¡ Die Zeilen sind durchnummeriert. 

¡ Die Spalten hingegen sind mit Buchstaben gekennzeichnet: A bis Z, dann AA bis AZ, dann BA bis BZ
etc.

Durch diese Aufteilung in Zeilen und Spalten entsteht ein Netz aus "Kästchen". Diese Kästchen werden die
Zellen der Tabelle genannt. 

Jede Zelle hat eindeutige "Koordinaten": "B5" bezeichnet beispielsweise die Zelle in der fünften Zeile der
Spalte B (also der zweiten Spalte). "A3" wäre die Zelle in der dritten Zeile der Spalte A etc. Diese Koordi-
naten einer Zelle nennt man die Adresse dieser Zelle. 

Die Zelladresse ist sehr wichtig, denn Berechnungen beziehen sich oft auf andere Zellen: Wenn Sie bei-
spielsweise in Zelle A2 ausrechnen möchten, wie groß der doppelte Wert der Zelle A1 ist, so tippen Sie ein-
fach in Zelle A2 ein: =A1*2. 

In A2 wird nun stets der doppelte Wert von A1 ausgegeben. Wenn Sie den Wert in A1 ändern, wird diese
Berechnung automatisch aktualisiert.

Bewegen in einer Tabelle
Wenn Sie in PlanMaker etwas eingeben, landet diese Eingabe stets in der aktuellen Zelle. Welche Zelle dies
ist, zeigt ein kleiner dunkler Rahmen, der die Zelle umgibt – der Zellrahmen: 
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Um den Zellrahmen zu einer anderen Zelle zu verschieben, gehen Sie wie folgt vor:

Maus: Klicken Sie die gewünschte Zelle an.

Tastatur: Über die Tastatur können Sie den Zellrahmen mit den Richtungstasten verschieben. 

Über Tastatur ist auch möglich: Mit der Tabulatortaste Tab gelangen Sie zur nächsten rechten Zelle und mit
Umschalt+Tab zur nächsten linken Zelle. Mit der Eingabetaste ¿ bewegen Sie sich nach unten und mit
Umschalt+Eingabetaste nach oben.

Eine Tabelle aller hierfür verfügbaren Tasten finden Sie im Abschnitt Tastenbelegung.

Daten eingeben
Um in eine Zelle etwas einzugeben, steuern Sie die gewünschte Zelle mit den Richtungstasten oder per
Mausklick an und beginnen mit dem Tippen.

Um Ihre Eingabe abzuschließen, drücken Sie die Eingabetaste ¿. 

Wenn Sie einen Eingabefehler gemacht haben, ist das kein Problem: Drücken Sie nach der Eingabe statt der
Eingabetaste ¿ die Taste Esc, worauf PlanMaker vergisst, was Sie getippt haben, und den alten Zellinhalt
wiederherstellt. 

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bearbeitungsleiste abschließen:

¡ Klicken Sie auf , um die Eingabe zu übernehmen. 

¡ Oder klicken Sie auf , um die Eingabe zu verwerfen.

Um den Inhalt einer bereits ausgefüllten Zelle nachträglich zu bearbeiten, steuern Sie die Zelle an und betä-
tigen die Taste F2. Alternativ können Sie auch einfach einen Doppelklick auf die Zelle ausführen. 

Ausführliche Informationen zu diesem Thema finden Sie im Abschnitt Daten in Zellen eingeben.

Daten löschen
Es gibt mehrere Möglichkeiten, Daten aus einem Dokument zu löschen:

¡ Löschen des Inhalts einer Zelle 

Um den kompletten Inhalt einer Zelle zu löschen, steuern Sie diese Zelle an und drücken dann die Taste
Entf oder rufen den Menübefehl Bearbeiten > Löschen auf.

¡ Löschen von Teilen des Inhalts einer Zelle 

Um nur einen Teil des Inhalts einer Zelle zu löschen, steuern Sie diese an und drücken die Taste F2. Nun
können Sie den Zellinhalt editieren, also beispielsweise auch Teile davon löschen.



36Grundlagen

¡ Löschen des Inhalts mehrerer Zellen 

Um mehrere Zellen auf einmal zu löschen, markieren Sie diese bevor Sie die Taste Entf drücken oder
den Befehl Löschen aufrufen. Wie man Zellen markieren kann, beschreibt der Abschnitt Markieren von
Zellen und Zellinhalten.

Ausführlichere Informationen zu diesem Thema finden Sie im Abschnitt Löschen von Zellen und Zellinhal-
ten.

Änderungen rückgängig machen
Mit dem Menübefehl Bearbeiten > Rückgängig können Sie die zuletzt an einem Dokument durchgeführten
Änderungen widerrufen. Formatieren Sie also beispielsweise Zellen in einer anderen Schrift, brauchen Sie
nur Bearbeiten > Rückgängig aufzurufen, und schon wird dies wieder aufgehoben. 

Der Befehl Rückgängig lässt sich bei Bedarf mehrmals hintereinander anwenden. Rufen Sie ihn zum Bei-
spiel fünfmal auf, werden die letzten fünf Änderungen widerrufen.

Wiederherstellen von widerrufenen Aktionen

Es gibt auch ein Gegenstück zum Befehl Rückgängig: den Menübefehl Bearbeiten > Wiederherstellen. Er
stellt die zuletzt von Ihnen widerrufene Aktion wieder her. So können Sie also das Widerrufen von Ände-
rungen widerrufen.

Ausführliche Informationen zu diesem Thema finden Sie im Abschnitt Änderungen rückgängig machen. 

Neues Dokument beginnen
Wenn Sie ein neues Dokument beginnen möchten, rufen Sie den Menübefehl Datei > Neu auf.

Es erscheint ein Dialogfenster, in dem Sie eine Dokumentvorlage für die Tabelle wählen können. Wenn Sie
einfach eine normale Tabelle ohne weitere Vorgaben erstellen möchten, wählen Sie die Standardvorlage
Normal.pmvx.

Sobald Sie mit OK bestätigen, wird das neue Dokument angelegt.

Verwenden von Dokumentvorlagen

Vorlage: Neben der Standardvorlage Normal.pmvx sehen Sie auch einige Ordner, die sich per Doppelklick
öffnen lassen. Diese enthalten vorgefertigte Dokumentvorlagen.

Sprache: Wählen Sie hier die Sprache aus, für die Dokumentvorlagen angezeigt werden sollen.

Neuer Standard: Ändern Sie die Standardvorlage, indem Sie eine Vorlage anklicken und auf die Schaltflä-
che Neuer Standard drücken.

Informationen zur Verwendung von Dokumentvorlagen können Sie später im Abschnitt Dokumentvorlagen
nachlesen.
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Option "Neues Programmfenster"

Die Option Neues Programmfenster hat folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint das
neue Dokument in einem eigenen Programmfenster. Ist sie ausgeschaltet, wird das Dokument im bestehen-
den Programmfenster mit einer neuen Registerkarte angelegt. (Hinweis: Diese Option steht in der Android-
Version nicht zur Verfügung.)

Dokument öffnen
Um ein Dokument zu öffnen, rufen Sie den Befehl Öffnen im Menü Datei auf. 

Es erscheint ein Dialogfenster, das beispielsweise wie folgt aussehen kann:

Je nach Betriebssystem ist dieses Dialogfenster etwas anders gestaltet, seine Funktion ist aber immer die
gleiche: Über diesen Dialog teilen Sie PlanMaker mit, welches Dokument geöffnet werden soll.

Dazu könnten Sie einfach den Namen der zu öffnenden Datei von Hand eintippen. Über die Auswahlliste
mit den Dateien geht dies allerdings komfortabler, denn hier werden alle Dateien im aktuellen Ordner auf-
gelistet und können bequem ausgewählt werden.
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Option "Neues Programmfenster"

Die Option Neues Programmfenster hat folgende Bedeutung: Wenn sie eingeschaltet ist, erscheint das
neue Dokument in einem eigenen Programmfenster. Ist sie ausgeschaltet, wird das Dokument im bestehen-
den Programmfenster mit einer neuen Registerkarte geöffnet. (Hinweis: Diese Option steht in der Android-
Version nicht zur Verfügung.)

Vorschau auf ein Dokument

Wenn die Option Vorschau eingeschaltet ist, erscheint rechts neben dem Dialog eine kleine Vorschau auf
den Inhalt des momentan selektierten Dokuments.

Andere Dateiformate öffnen

PlanMaker kann nicht nur seine eigenen Dokumente, sondern auch Dateien anderer Programme öffnen. Sie
müssen dazu lediglich das gewünschte Format in der Liste der Dateitypen auswählen. 

Weitere Informationen dazu finden Sie im Kapitel Fremdformate.

Schnellwahlpfade verwenden

Über die Schaltfläche Schnellwahlpfad können Sie Schnellwahlpfade anlegen und abrufen, um beim Öff-
nen oder Speichern von Dateien blitzschnell in einen bestimmten Ordner wechseln zu können. 

Weitere Informationen dazu finden Sie im Abschnitt Schnellwahlpfade.

Dateimanager

Über die Schaltfläche Dateimanager können Sie den integrierten Dateimanager aufrufen. Dieser zeigt eine
Liste Ihrer Dokumente an und lässt Sie diese nicht nur öffnen, drucken, ansehen oder löschen, sondern auch
durchsuchen. 

Weitere Informationen dazu finden Sie im Abschnitt Dateimanager.

Liste der zuletzt geöffneten Dateien

Tipp: Am unteren Ende des Menüs Datei finden Sie eine Liste der zuletzt geöffneten Dateien. Um eine die-
ser Dateien erneut zu öffnen, klicken Sie sie einfach an.

Dokument drucken
Wenn Sie das aktuelle Dokument ausdrucken möchten, rufen Sie den Menübefehl Datei > Drucken auf.

Es erscheint ein Dialogfenster, in dem Sie unter anderem einstellen können, welche Bestandteile des Doku-
ments gedruckt werden sollen.

Ausführliche Informationen zum Ausgeben Ihrer Dokumente finden Sie im Kapitel Ausgeben von Doku-
menten.
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Dokument speichern
Wenn Sie ein Dokument fertiggestellt haben, sollten Sie dieses speichern, um es dauerhaft zu erhalten. Ru-
fen Sie dazu den Menübefehl Datei > Speichern auf. 

Sollte das Dokument noch keinen Namen besitzen, fordert Sie PlanMaker vor dem Speichern automatisch
auf, einen Dateinamen zu vergeben.

Speichern unter einem anderen Namen/an einem anderen Ort

PlanMaker verfügt außerdem über den Menübefehl namens Datei > Speichern unter. Dieser sichert Ihr
Dokument ebenfalls, jedoch können Sie ihm zuvor einen anderen Dateinamen geben oder einen anderen
Ordner zum Speichern wählen.

Speichern in einem anderen Dateiformat

Sie können ein Dokument mit dem Menübefehl Datei > Speichern unter auch im Dateiformat eines ande-
ren Programms speichern. Wählen Sie dazu das gewünschte Format in der Liste Dateityp (siehe Kapitel
Fremdformate).

Speichern aller geöffneten Dokumente

Haben Sie mehrere Dokumente gleichzeitig geöffnet, können Sie den Menübefehl Datei > Alles speichern
verwenden, um diese alle auf einmal speichern zu lassen. PlanMaker prüft dabei nach, ob die Dokumente
seit dem letzten Speichern geändert wurden, und speichert nur diejenigen Dokumente, bei denen dies der
Fall ist.

Arbeit beenden
Wenn Sie PlanMaker beenden möchten, rufen Sie den Menübefehl Datei > Beenden auf. 

Wurde eines der geöffneten Dokumente seit seiner letzten Speicherung verändert, fragt PlanMaker automa-
tisch nach, ob Sie es zuvor noch speichern möchten.



40Die PlanMaker-Tour

Die PlanMaker-Tour
Willkommen bei der PlanMaker-Tour! 

Auf den nächsten Seiten werden Sie PlanMaker noch etwas näher kennenlernen als im Kapitel Grundlagen.
Anwender, die keine oder nur wenig Erfahrung im Umgang mit Tabellenkalkulationen haben, sollten die
nächsten Seiten unbedingt lesen. 

Auch fortgeschrittene Anwender sollten dieses Kapitel zumindest überfliegen – Sie werden darin einige
nützliche Tipps finden, die Ihnen die Bedienung von PlanMaker erleichtern.

Anmerkung: Die Abbildungen in diesem Handbuch wurden größtenteils mit der Windows-Version von
PlanMaker angefertigt. Unter anderen Betriebssystemen sehen manche Bedienelemente zwar etwas an-
ders aus, ihre Funktionsweise ist jedoch die gleiche.

Zu Beginn fünf Minuten Theorie
Das Thema "Rechnen und Computer" erschließt sich am besten von einem kleinen Rückblick her. Denn ge-
rade über das Gebiet "Rechnen" erfolgte ursprünglich der Siegeszug der Computertechnik in die Haushalte
und Büros. Den ersten zaghaften Vorstoß unternahmen die Taschenrechner. Sie sind sicherlich eine große
Hilfe, aber gerade an ihren Nachteilen lässt sich gut zeigen, wo die Stärken einer Tabellenkalkulation lie-
gen:

Wenn Sie beispielsweise einen Computerkauf planen, müssen Sie diverse Angebote vergleichen, die jeweils
aus verschiedenen Einzelposten bestehen: Sie brauchen beispielsweise einen PC, einen Monitor und einen
Drucker. Beim einen Anbieter ist der PC sehr günstig, beim anderen gibt es den Monitor billiger etc. Wel-
ches Angebot ist nun das günstigste?

Um dies herauszufinden, müssen Sie fleißig addieren. Dazu zücken Sie den Taschenrechner, addieren Zahl
für Zahl, notieren das Ergebnis – und ärgern sich. Denn bei jedem neuen Angebot beginnt das gleiche Spiel
von vorn. Selbst dann, wenn die meisten Zahlen gleich bleiben sollten.

Mit einer Tabellenkalkulation lassen sich derartige Kalkulationen komfortabler durchführen.

Die erste Technik, der Sie beim Arbeiten mit PlanMaker begegnen werden, ist der Einsatz von "Variablen".
Variablen helfen dabei, Formeln – in unserem Beispiel einfache Additionen – zunächst einmal ohne Zahlen
zu notieren. Dies könnte so aussehen:

PC + Monitor + Drucker = Gesamtpreis 

Ein wenig abstrakter ausgedrückt – so, wie wir es alle einmal im Mathematikunterricht gelernt haben –
heißt unsere Formel also:

a + b + c = d

Praktischen Nutzen hat solch eine Formel beim Rechnen ohne Tabellenkalkulation nur, wenn Sie beispiels-
weise einen programmierbaren Taschenrechner besitzen – in den können Sie dann die Formel eintippen,
und er fragt Angebot für Angebot die Einzelpreise ab, um daraus automatisch die Summe zu berechnen. All-
zu viel gewonnen ist damit allerdings noch nicht...
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Erste Schritte mit PlanMaker
Nach diesen Vorüberlegungen ist es nun an der Zeit, sich einmal anzusehen, wie solche Aufgaben mit
PlanMaker gelöst werden können.

Starten Sie dazu PlanMaker jetzt.

Unter Windows sieht PlanMaker wie folgt aus:

Den größten Teil des Programmfensters nimmt das Arbeitsblatt ein. Oben ist es durch eine Leiste mit Buch-
staben begrenzt, links durch eine Leiste mit Zahlen.

Sehen wir uns ein solches Arbeitsblatt einmal etwas genauer an:

Der Aufbau einer Tabelle

Wie Sie aus dem Kapitel Grundlagen bereits wissen, ist ein Arbeitsblatt (wir nennen es meist einfach "Ta-
belle") in Zeilen und Spalten aufgeteilt. Die grauen Linien, die in der Tabelle zu sehen sind, deuten dies
auch an. 

Die Zelle in der linken oberen Ecke ist mit einem dunklen Rahmen umgeben. Dieser wird Zellrahmen ge-
nannt. Er zeigt an, welche Zelle gerade aktiv ist. 

Wenn Sie etwas eintippen, landet das immer in der Zelle, auf der sich der Zellrahmen befindet.
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Drücken Sie nun einige Male die Pfeiltasten â und à, um den Zellrahmen zu bewegen. 

Achten Sie dabei auf das Anzeigefeld links oberhalb der Tabelle: Dort zeigt PlanMaker die Adresse der Zel-
le an, auf der sich der Zellrahmen gerade befindet. Die Adresse besteht immer aus ein bis zwei Buchstaben
und einer Zahl: 

"A1" bedeutet "Spalte 1, Zeile 1".

"A5" bedeutet "Spalte 1, Zeile 5".

"D5" bedeutet "Spalte 4, Zeile 5" etc.

Die Tatsache, dass jede Zelle eine eindeutige Adresse hat, ist der Schlüssel zu allen Funktionen der Tabel-
lenkalkulation: Sie können dadurch in jede beliebige Zelle Berechnungen eingeben, die sich auf andere Zel-
len beziehen – also beispielsweise die Summe von Zellen bilden. Dabei brauchen Sie nicht einmal mit Va-
riablen wie a, b, c zu hantieren, sondern verwenden einfach die Koordinaten der Zellen.

Dies verhält sich so, als würden Sie jemandem ein Arbeitsblatt übergeben und ihn beispielsweise auffor-
dern: "Addiere bitte die Zahlen in der zweiten, dritten und vierten Zeile der zweiten Spalte".

Eingeben von Werten und Formeln
Genug der Theorie. Lassen Sie uns nun die erste Berechnung durchführen.

Zuerst tippen wir den Preis für den PC, darunter den Preis für den Monitor und darunter den Preis für den
Drucker ein.

Steuern Sie also die Zelle B2 an und tippen Sie den Wert 799 ein. Der Wert erscheint sowohl in der gewähl-
ten Zelle als auch in der Bearbeitungsleiste oberhalb der Tabelle. 

Hinweis: Übernehmen Sie bitte beim Eingeben von Zahlen nicht die früher verbreitete Angewohnheit,
statt der Zahl "0" den Buchstaben "O" oder "o" zu tippen. PlanMaker unterscheidet nämlich penibel zwi-
schen Zahlen und Buchstaben. Der Buchstabe "O" ist für das Programm keine Zahl. PlanMaker akzep-
tiert Ihre Eingabe zwar, interpretiert sie aber als Text und kann dementsprechend keine Berechnungen da-
mit anstellen.

Drücken Sie nun die Eingabetaste ¿, um Ihre Eingabe abzuschließen. Der Zellrahmen wandert automatisch
um eine Zeile nach unten in die Zelle B3. Tragen Sie hier den Wert 425 und in der Zelle darunter den Wert
199 ein.

Tipp: Wenn Sie einmal in eine Zelle etwas Falsches eingegeben und bereits die Eingabetaste ¿ gedrückt
haben, ist dies nicht weiter schlimm. Steuern Sie die Zelle mit den Pfeiltasten an und tippen Sie den rich-
tigen Inhalt ein. Drücken Sie dann wieder die Eingabetaste, und der Zellinhalt wird überschrieben. Sie
können den Inhalt bereits ausgefüllter Zellen auch editieren: drücken Sie dazu in der Zelle die Taste F2.

Eingeben von Rechenformeln

Nun geht es an die erste Rechenformel:

Um die Gesamtkosten für unsere Computerausstattung auszurechnen, müssen wir die gerade eingetippten
Einzelpreise addieren. Und das geht denkbar einfach:
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Steuern Sie die Zelle B5 an und tippen Sie erst ein Gleichheitszeichen = ein. Das Gleichheitszeichen ist
nämlich für PlanMaker das Signal, dass Sie nun eine Formel in diese Zelle eingeben möchten.

Als nächstes tippen Sie die Rechenformel ein. Dazu arbeiten Sie, wie schon angedeutet, mit den Adressen
der Zellen als "Variablen". Die Eingabe lautet somit:

=B2+B3+B4

Die Buchstaben dürfen wahlweise als Groß- oder als Kleinbuchstaben getippt werden. 

Wenn Sie die Eingabetaste ¿ drücken, erscheint sofort das Ergebnis der Berechnung in der Zelle:

Probieren Sie nun einmal aus, was geschieht, wenn Sie die Zahlen in den Zellen auswechseln. Steuern Sie
beispielsweise die "425" einmal an und tippen Sie "259" oder einen beliebigen anderen Wert ein. Drücken
Sie dann wieder die Eingabetaste ¿ und beobachten Sie, was passiert: Sobald Sie den Zellinhalt ersetzen,
wird sofort das Ergebnis der Addition aktualisiert. 

Sie sehen: Egal, was in den Zellen B2, B3 und B4 steht, PlanMaker addiert es brav zusammen. Ändert sich
bei einem Computer-Angebot also beispielsweise nur der Preis für den Drucker, brauchen Sie diesen nur zu
ändern und schon steht in Zelle B5 der neue Gesamtpreis.

Die Funktion "SUMME"

Die vorgestellte Methode zum Berechnen der Summe war nun sicherlich zweckmäßig, aber noch nicht allzu
komfortabel. Stellen Sie sich einmal vor, es wären nicht drei, sondern 50 Zahlen zu addieren – das gäbe eine
lange Formel zu tippen! Zum Glück gibt es hier Alternativen: die Rechenfunktionen von PlanMaker.

Um eine davon kennenzulernen, steuern Sie noch einmal die Zelle B5 mit der Rechenformel an. 

Löschen Sie erst den Inhalt, indem Sie die Taste Entf drücken – oder überschreiben Sie den Zellinhalt ein-
fach. Tippen Sie folgende Formel ein:

=SUMME(B2:B4)

Nach dem Betätigen der Eingabetaste ¿ steht das Ergebnis der Berechnung in der Zelle: die Summe der
Zellen B2 bis B4.

PlanMaker kennt eine ganze Reihe von Rechenfunktionen – und eine davon ist SUMME. Diese ermittelt,
wie der Name schon sagt, die Summe von Werten. Der eingeklammerte Ausdruck hinter dem Funktionsna-
men sagt PlanMaker, wo er mit dem Summieren beginnen und aufhören soll: 

Der Start soll in diesem Fall bei der Zelle B2 liegen und das Ende der zu addierenden Zahlenkolonne bei
B4. Dazwischen liegt in diesem Fall nur die Zahl in B3, aber die Summenfunktion würde auch mit Angaben
wie B2:B123 funktionieren.

Die Schreibweise Startzelle:Endzelle funktioniert übrigens auch zeilen- und spaltenübergreifend. Wenn Sie
beispielsweise als Startzelle B2 und als Endzelle C4 eingeben, so bilden diese beiden Koordinaten in der
Tabelle die Eckpunkte eines Rechtecks. Die Formel =SUMME(B2:C4) berechnet also die Summe aller in
diesem Rechteck enthaltenen Zahlen.
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Formelvielfalt

Um einen Eindruck von der Vielzahl der Rechenfunktionen zu bekommen, die in PlanMaker zur Verfügung
stehen, können Sie nun einmal den Menübefehl Einfügen > Funktion aufrufen.

Es erscheint nun ein Dialogfenster mit einer Liste aller Rechenfunktionen, die PlanMaker beherrscht.

Tipp: Bei der Windows-Version von PlanMaker können Sie eine Hilfeseite zu jeder Rechenfunktion ab-
rufen, indem Sie die gewünschte Funktion in obigem Dialog anklicken und dann die Taste F1 drücken.

Probieren wir noch ein Beispiel aus: Wir berechnen den Mittelwert unserer drei Zahlen in der Tabelle:

Verlassen Sie dazu das Dialogfenster und löschen Sie noch einmal den Inhalt von B5. 

Rufen Sie dann den Menübefehl Einfügen > Funktion auf. Wählen Sie in der linken Liste die Kategorie
"Alle Funktionen". Durchblättern Sie dann die rechte Liste mit Hilfe des Rollbalkens, bis die Funktion
"Mittelwert" zu sehen ist. Klicken Sie dann doppelt auf "Mittelwert". 

Im Eingabefeld des Dialogs hat PlanMaker nun automatisch die Zeile

Mittelwert()

eingesetzt. Um die Formel zu vervollständigen, tippen Sie wieder B2:B4 ein. 

Alternativ können Sie auch hier einfach den gewünschten Bereich direkt in der Tabelle mit der Maus mar-
kieren, also die Maus bei gedrückter linken Maustaste über die Zellen B2 bis B4 ziehen. Sie wissen ja
schon, wie das geht. Falls das Dialogfenster im Weg sein sollte, ziehen Sie es einfach beiseite, indem Sie
auf seine Titelleiste klicken und es dann bei gedrückter Maustaste verschieben.

Die fertige Formel sieht schließlich wie folgt aus:

=Mittelwert(B2:B4)

Klicken Sie auf Einfügen, wird diese Formel in Zelle B5 übertragen und sofort ausgerechnet.
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Zwei der über 330 Rechenfunktionen von PlanMaker haben Sie nun kennengelernt. Eine Liste aller Funk-
tionen mit ausführlicher Beschreibung finden Sie übrigens im Abschnitt Funktionen von A-Z.

Die dritte Dimension
Tabellen müssen nicht unbedingt aus nur einem einzigen Arbeitsblatt bestehen. Es ist auch möglich, mehre-
re Arbeitsblätter hintereinander zu legen – praktisch wie bei einem Stapel Papier. Wir nennen ein PlanMa-
ker-Dokument deshalb auch eine Arbeitsmappe. Jede Arbeitsmappe kann bis zu 256 Arbeitsblätter enthal-
ten.

Der Clou dabei: Berechnungen in einem Arbeitsblatt können sich auch auf Zellen anderer Arbeitsblätter be-
ziehen, was Ihnen ermöglicht, sozusagen "dreidimensionale" Berechnungen durchzuführen.

Ein Beispiel: Sie erfassen auf drei Arbeitsblättern die Bilanzen mehrerer Filialen Ihrer Firma. Nun könnten
Sie ein viertes Arbeitsblatt anlegen und darauf beispielsweise die Summe der Ergebnisse auf den drei ande-
ren Blättern berechnen.

Wenn Sie ein neues Arbeitsblatt anlegen möchten, rufen Sie den Menübefehl Arbeitsblatt > Blatt > Einfü-
gen auf. Um zwischen den vorhandenen Blättern zu wechseln, können Sie das Arbeitsblattregister am unte-
ren Fensterrand verwenden. 

Klicken Sie das gewünschte Arbeitsblatt dort einfach mit der Maus an. 

Weitere Informationen zu diesem Thema finden Sie im Abschnitt Arbeiten mit mehreren Arbeitsblättern.

Tabellen gestalten
Kehren wir noch einmal zu unserer ersten Beispieltabelle zurück. Gut rechnen ließ es sich mit ihr, aber von
der Gestaltung her sieht sie bislang nicht gerade ansprechend aus. Dabei verfügt PlanMaker doch über äu-
ßerst leistungsfähige Möglichkeiten zur optischen Aufbereitung von Tabellen. 

Probieren wir einige davon einmal aus:

Überschrift hinzufügen

Was unserer Tabelle auf jeden Fall fehlt, ist eine Überschrift. Tragen wir also einfach in eine Zelle oberhalb
der Zahlen einen entsprechenden Text ein und formatieren diesen in einer größeren Schrift.

Setzen Sie den Zellrahmen dazu auf die Zelle B1. Tippen Sie dann zum Beispiel folgenden Text:

Meine erste Tabelle¿

Zeichenformatierung ändern

Jetzt sollten wir vielleicht noch eine andere Schrift für die Überschrift wählen und sie vor allem deutlich
größer machen.
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Bewegen Sie den Zellrahmen dazu wieder in die Zelle B1 mit der Überschrift zurück. Klappen Sie dann die
Schriftenliste in der Formatleiste auf, indem Sie das kleine Pfeilchen rechts neben dem Schriftnamen ankli-
cken. 

Es erscheint eine Liste aller auf Ihrem Rechner installierten Schriften. Wählen Sie beispielsweise die
Schriftart "Tahoma". Öffnen Sie dann die Liste mit den Schriftgrößen rechts daneben und wählen Sie die
Größe 24 Punkt. 

Rechts daneben könnten Sie auf Wunsch noch die Schriftfarbe einstellen, und noch ein Stück weiter rechts
finden Sie drei mit F, K und U beschriftete Schaltflächen zum Ein-/Ausschalten von Fettdruck, Kursiv-
schrift und Unterstreichen.

Zahlenformatierung ändern

In einer Tabellenkalkulation finden Sie natürlich auch umfangreiche Möglichkeiten zum Formatieren von
Zahlen. Sie können nicht nur Zeichenformat von Zellinhalten ändern (Schriftart, Schriftgröße etc.), sondern
auch deren Zahlenformat.

Probieren Sie es aus: In den Zellen B2 bis B5 stehen Geldbeträge – also sollen diese auch wie Geldbeträge
angezeigt werden. Dies erreichen Sie folgendermaßen:

Markieren Sie zunächst die Zellen B2 bis B5. Klicken Sie dazu einfach die Zelle B2 an und ziehen Sie den
Mauszeiger dann – mit weiterhin gedrückter Maustaste – zur Zelle B5. 

Android: Falls Sie die Android-Version verwenden, beachten Sie bitte, dass das Markieren von Zellen
dort etwas anders funktioniert. Siehe Abschnitt Markieren von Zellen und Zellinhalten.

Wenn die gewünschten Zellen markiert sind, rufen Sie den Menübefehl Format > Zelle auf. Es erscheint
ein Dialog mit zahlreichen Einstellungsmöglichkeiten. Uns interessiert aber nur die erste Karteikarte: die
Karteikarte Zahlenformat. Wählen Sie darin in der Liste den Eintrag "Währung" und bestätigen Sie mit
OK. 

Das Ergebnis: PlanMaker versieht die Zahlen in den markierten Zellen nun mit einem Währungssymbol und
zeigt sie mit zwei Nachkommastellen an, wie das bei Geldbeträgen üblich ist.

Es gibt viele weitere Einstellungen zum Zahlenformat, mit denen Sie das Erscheinungsbild von Zahlen än-
dern können. So lässt sich beispielsweise die Anzahl der angezeigten Nachkommastellen einstellen, Zahlen
können als Prozentwerte dargestellt werden etc. Wichtig: Die Zahl in der entsprechenden Zelle bleibt dabei
stets unverändert – es ändert sich lediglich ihre Darstellung.
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Einen kleinen Teil der Funktionen zum Gestalten von Tabellen haben Sie jetzt kennengelernt. Wie Sie sich
denken können, gibt es noch viele weitere Möglichkeiten, Tabellen optisch aufzuwerten und übersichtlicher
zu machen. Alle Informationen dazu finden Sie im Kapitel Gestalten einer Tabelle. 

Diagramme
Werfen wir zum Schluss unserer kleinen PlanMaker-Tour noch einen Blick auf Diagramme.

Zahlenkolonnen machen es einem oft schwer, ihre wirkliche Bedeutung zu erkennen. PlanMaker hat des-
halb zur optischen Aufbereitung der Daten aus Ihren Tabellen ein eigenes Diagramm-Modul aufzuweisen.

Um ein Diagramm einzufügen, markieren Sie die darzustellenden Werte und rufen den Menübefehl Objekt
> Neuer Diagrammrahmen auf. Es erscheint ein Dialog, in dem Sie nur noch den gewünschten Dia-
grammtyp auswählen müssen – und schon erscheint das fertige Diagramm im Dokument.

Weitere Informationen zu diesem Thema finden Sie im Kapitel Diagramme.

Ausblick
Hier endet unsere kleine Einführung in PlanMaker. Die grundlegendsten Funktionen haben Sie jetzt kennen-
gelernt, alles Weitere erfahren Sie im Referenzteil des Handbuchs, der mit dem nächsten Kapitel beginnt. 

Der Referenzteil ist nach Sachgebieten aufgeteilt und beschreibt ausführlich alle Funktionen von PlanMa-
ker. Sie müssen diesen natürlich nicht Kapitel für Kapitel durchlesen, um gleich alle Funktionen von
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PlanMaker auf einmal zu erlernen. Befassen Sie sich immer nur den Kapiteln, die Sie gerade benötigen, und
erkunden Sie so Schritt für Schritt die Funktionen von PlanMaker.

In diesem Sinne: Viel Spaß mit PlanMaker!
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Bearbeiten einer Tabelle
Mit diesem Kapitel beginnt der Referenzteil des Handbuchs, der ausführliche Informationen zu den einzel-
nen Funktionen von PlanMaker enthält und nach Sachgebieten geordnet ist.

In diesem ersten Kapitel erfahren Sie, wie Sie eine Tabelle ausfüllen und bearbeiten. Folgende Themen wer-
den in diesem Kapitel behandelt:

¡ Daten in Zellen eingeben 

Im ersten Abschnitt wird erläutert, was es beim Ausfüllen von Tabellenzellen mit Text, Zahlen, Berech-
nungen etc. zu beachten gibt.

¡ Änderungen rückgängig machen 

Über den Menübefehl Bearbeiten > Rückgängig kann man Operationen wieder ungeschehen machen.
Der Befehl Bearbeiten > Wiederherstellen ist das Gegenstück dazu – er macht sozusagen den Befehl
Rückgängig wieder rückgängig.

¡ Befehle wiederholen 

Der Menübefehl Bearbeiten > Wiederholen wiederholt die Ausführung des zuletzt aufgerufenen Be-
fehls mit genau den gleichen Einstellungen.

¡ Markieren von Zellen und Zellinhalten 

Hier erfahren Sie, wie man Zellen markiert – zum Beispiel durch Überstreichen der Zellen mit gedrück-
ter Maustaste oder per Tastatur.

¡ Löschen von Zellen und Zellinhalten 

Sie können wahlweise mit dem Menübefehl Bearbeiten > Löschen nur die Zellinhalte löschen oder mit
Arbeitsblatt > Zellen löschen die kompletten Zellen aus der Tabelle entfernen (der Rest der Tabelle
rückt dann entsprechend nach).

¡ Einfügen von neuen Zellen 

Der Menübefehl Arbeitsblatt > Zellen einfügen fügt neue Zellen in die Tabelle ein, wobei der Rest der
Tabelle automatisch verschoben wird.

¡ Verschieben und Kopieren 

Markierte Tabellenbereiche können mit den Befehlen des Menüs Bearbeiten oder einfach per Maus ko-
piert oder verschoben werden. Rechenformeln werden dabei automatisch angepasst.

¡ Selektives Einfügen 

Der Menübefehl Bearbeiten > Inhalte einfügen ist eine leistungsfähigere Variante des Befehls Einfü-
gen. Sie können damit beim Einfügen der Zwischenablage bestimmen, dass beispielsweise nur die nack-
ten Zellinhalte oder nur deren Formatierung eingefügt werden soll.

¡ Automatisches Füllen von Zellen 

Mit dem Menübefehl Bearbeiten > Ausfüllen können Sie Zellen bequem mit gleichbleibenden Werten
oder Wertereihen füllen.
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¡ Arbeiten mit mehreren Arbeitsblättern 

Sie können in PlanMaker mehrere Arbeitsblätter – wie bei einem Stapel Papier – hintereinander anlegen
und damit "dreidimensional" rechnen.

¡ Bereiche benennen 

Wenn Sie Zellbereichen mit dem Menübefehl Arbeitsblatt > Namen einen Namen geben, können Sie
diese Namen in Berechnungen verwenden – zum Beispiel =SUMME(Umsätze).

¡ Sortieren 

Mit dem Menübefehl Arbeitsblatt > Sortieren können Sie Tabellenzellen nach einem oder mehreren
Kriterien sortieren lassen.

¡ Transponieren 

Der Menübefehl Arbeitsblatt > Transponieren vertauscht die zeilen-/spaltenweise Anordnung eines
Zellbereichs.

¡ Text in Spalten aufteilen 

Mit dem Menübefehl Arbeitsblatt > Text in Spalten aufteilen können Sie Text, der sich in einer Tabel-
lenzelle befindet, auf mehrere Tabellenspalten aufteilen.

¡ Filtern 

Mit dem Menübefehl Arbeitsblatt > Filter lässt sich ein Zellbereich nach einem oder mehreren Kriteri-
en filtern. Es werden dann alle Zeilen in diesem Bereich, die den Filterbedingungen nicht entsprechen,
verborgen.

¡ Analysieren von Tabellen 

Dieser Abschnitt stellt einige Werkzeuge vor, die für die Analyse von Tabellen und die Fehlersuche sehr
nützlich sein können. Dazu gehören die Formelanzeige, die Syntaxhervorhebung, das Beobachtungsfens-
ter für Zellinhalte sowie verschiedene Funktionen zum Analysieren der Rechenformeln in einer Tabelle.

¡ Aktualisieren von Tabellen 

Die Berechnungen in einer Tabelle werden automatisch auf dem neuesten Stand gehalten. Jedes Mal,
wenn Sie einen Zellinhalt abändern, rechnet PlanMaker die gesamte Tabelle neu durch. Bei Bedarf kön-
nen Sie dieses Verhalten abschalten und den Menübefehl Weiteres > Neu berechnen verwenden, um
die Tabelle manuell zu aktualisieren.

¡ Kommentare einfügen 

Mit dem Menübefehl Einfügen > Kommentar können Sie Zellen mit einem Kommentar versehen. Die-
ser wird angezeigt, wenn Sie mit der Maus auf die Zelle zeigen.

¡ Zielwertsuche 

Mit dem Menübefehl Weiteres > Zielwertsuche können Sie durch ein Näherungsverfahren ermitteln,
welchen Wert ein bestimmter Bestandteil einer Berechnung annehmen muss, damit das gewünschte Er-
gebnis herauskommt.

¡ Szenarien 

Der Menübefehl Weiteres > Szenarien erlaubt das Anlegen und Anzeigen verschiedener Szenarien. Mit
deren Hilfe können Sie beobachten, welche Auswirkungen das Ändern der Werte in bestimmten Zellen
auf die Berechnungen in einem Arbeitsblatt hat. Dies ermöglicht das Durchführen von "Was-wäre-
wenn"-Analysen aller Art.
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¡ Konsolidieren von Daten 

Mit dem Menübefehl Arbeitsblatt > Daten konsolidieren lassen sich Daten aus einem oder mehreren
Zellbereichen auswerten, um beispielsweise die Summe der einzelnen Daten über all diese Bereiche hin-
weg zu ermitteln.

¡ Tabellen in Arbeitsblättern 

Sie können einen Zellbereich markieren und daraus dann mit dem Menübefehl Arbeitsblatt > Neue Ta-
belle eine "Tabelle in einem Arbeitsblatt" erstellen. 

Dies hat u.a. folgende Auswirkungen: 

Der Bereich wird mit einer sogenannten Tabellenvorlage formatiert. Sie können diese jederzeit wech-
seln, und damit das Aussehen des kompletten Zellbereichs auf einmal zu verändern. Außerdem wird die
"Tabelle" automatisch mit einem Autofilter versehen. Darüber stehen weitere nützliche Features wie eine
Ergebniszeile mit zusammenfassenden Berechnungen zur Verfügung.

¡ Pivot-Tabellen 

Große Datenmengen mit komplexen Daten lassen sich mit Pivot-Tabellen sehr anschaulich nach be-
stimmten Kriterien zusammenfassen. Markieren Sie einen vorliegenden Datenbereich und erstellen Sie
über den Menübefehl Arbeitsblatt > Neue Pivot-Tabelle mit wenig Aufwand aussagekräftige Präsenta-
tionen Ihrer Daten. Mit Übungsbeispielen zur Veranschaulichung im Abschnitt.

¡ Fixieren von Zeilen und Spalten 

Mit dem Menübefehl Ansicht > Fixieren können Sie die ersten Zeilen oder Spalten einer Tabelle auf
dem Bildschirm fixieren. Das bewirkt, dass sich diese beim Blättern in der Tabelle nicht mehr bewegen.
Ideal für Spalten- oder Zeilenbeschriftungen.

¡ Sonderzeichen einfügen 

Der Menübefehl Einfügen > Sonderzeichen öffnet ein Dialogfenster mit allen verfügbaren Zeichen ei-
ner Schrift. Mit dessen Hilfe können Sie Zeichen einfügen, die per Tastatur nicht erreichbar sind.

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Daten in Zellen eingeben
Um in eine Zelle etwas einzugeben, steuern Sie die gewünschte Zelle mit den Richtungstasten oder per
Mausklick an und beginnen einfach mit dem Tippen.

Um Ihre Eingabe abzuschließen, drücken Sie die Eingabetaste ¿. 

Wenn Sie einen Eingabefehler gemacht haben, ist dies kein Problem: Drücken Sie statt der Eingabetaste ¿
die Taste Esc, vergisst PlanMaker, was Sie getippt haben, und stellt den alten Zellinhalt wieder her.

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bearbeitungsleiste abschließen:

¡ Klicken Sie auf , um die Eingabe zu übernehmen. 

¡ Oder klicken Sie auf , um die Eingabe zu verwerfen.

Um den Inhalt einer bereits ausgefüllten Zelle nachträglich zu bearbeiten, steuern Sie die Zelle an und betä-
tigen die Taste F2. Alternativ können Sie auch einen Doppelklick auf die Zelle ausführen.
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Anmerkungen zum Eingeben von Zahlen:

¡ Zahlen können auch in wissenschaftlicher Schreibweise (Exponentialschreibweise) eingegeben werden.
4E03 entspricht beispielsweise 4 * 10^3, also 4000. Anderes Beispiel: 4E-03 entspricht 4* 10^-3, also
0,004. 

¡ Zahlen können auch als Brüche eingegeben werden. 2 1/2 entspricht beispielsweise 2,5.

¡ Zahlen können auch als Prozentwerte eingegeben werden. 70% entspricht beispielsweise 0,7.

Mit dem Menübefehl Format > Zelle können Sie das Format von Zahlen in Tabellenzellen jederzeit än-
dern. Sie können PlanMaker also beispielsweise veranlassen, Zahlen als Prozentwerte oder als Währung mit
einem Währungssymbol anzuzeigen. Siehe dazu Abschnitt Zahlenformat.

Anmerkungen zum Eingeben von Daten und Uhrzeiten:

¡ Daten können in beliebiger Schreibweise eingetragen werden – also zum Beispiel 25.09.18 oder
25.9.2018 etc. 

¡ Sie können Daten zwischen dem 1.1.1900 und dem 31.12.2500 eingeben.

¡ Wenn Sie ein Datum lediglich mit zweistelliger Jahreszahl eingeben, wird dieses wie folgt interpretiert:

Jahreszahl zwischen 0 und 29: 2000 bis 2029.

Jahreszahl zwischen 30 und 99: 1930 bis 1999.

Der 1.1.29 ist für PlanMaker also der 1.1.2029, der 1.1.30 hingegen der 1.1.1930.

¡ Uhrzeiten lassen sich in einem (nahezu) beliebigen Format eingeben. Die Uhrzeit 9:30 kann also bei-
spielsweise eingetragen werden als: 

9:30

09:30

09:30:00

09:30:00 AM 

etc. 

¡ Sie können in eine Zelle auch eine Kombination aus Datum und Uhrzeit eingeben, indem Sie das Datum,
ein Leerzeichen und dann die Uhrzeit eintragen. Bei der Eingabe 25.9.18 6:00 weiß PlanMaker beispiels-
weise, dass damit der 25. September 2018 um 6:00 Uhr gemeint ist. 

Anmerkung: Daten und Uhrzeiten werden in Tabellenkalkulationen stets als Zahl gespeichert, damit Be-
rechnungen mit ihnen durchgeführt werden können. Die Zahl 0 steht für den 1.1.1900, die Zahl 1 für den
2.1.1900 etc. Die Uhrzeit wird in den Nachkommastellen der Zahl gespeichert.

Darum brauchen Sie sich aber nicht zu kümmern. Geben Sie Daten und Uhrzeiten einfach in beliebiger
Schreibweise ein. PlanMaker wandelt Ihre Eingabe unbemerkt in eine Zahl um, formatiert diese aber auto-
matisch als Datum beziehungsweise Uhrzeit. Wie Sie das Format von Daten und Uhrzeiten ändern, können
Sie bei Bedarf im Abschnitt Zahlenformat nachlesen.

Anmerkungen zum Eingeben von Wahrheitswerten:

¡ Um in eine Zelle einen Wahrheitswert einzugeben, tragen Sie dort entweder WAHR oder FALSCH ein. 
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Anmerkungen zum Eingeben von Berechnungen:

¡ Rechenformeln müssen stets mit dem Gleichheitszeichen = beginnen – zum Beispiel =2+5. 

¡ Über den Menübefehl Einfügen > Funktion lassen sich komfortabel Rechenfunktionen einfügen. Sie
können diese aber auch einfach eintippen – zum Beispiel =SUMME(2; 5).

¡ Ausführliche Informationen zum Durchführen von Berechnungen finden Sie im Kapitel Formeln und
Funktionen.

¡ Eine Beschreibung aller Rechenfunktionen finden Sie im Abschnitt Funktionen von A-Z.

Anmerkungen zum Eingeben von Text:

¡ Text kann einfach eingetippt werden.  

¡ In bestimmten Situationen möchte man PlanMaker "zwingen", eine Zahl als Text anzusehen. Dies kön-
nen Sie erreichen, indem Sie der Zahl ein einfaches Anführungszeichen voranstellen. Tippen Sie in eine
Zelle also beispielsweise '42 ein (inklusive des Anführungszeichens), betrachtet PlanMaker diese Einga-
be als Text – nicht als Zahl.

¡ Tipp: Wenn Sie in einer Spalte einige Texteinträge direkt untereinander eingegeben haben, können Sie
jederzeit eine Auswahlliste mit diesen Einträgen aufrufen. Betätigen Sie dazu in der Zelle unter dem
letzten (oder über dem ersten) Eintrag die Tastenkombination Alt+Umschalt+â. 

Es erscheint daraufhin eine Liste aller Zellinhalte direkt oberhalb oder unterhalb dieser Zelle. Wenn Sie
einen der Einträge auswählen und mit der Eingabetaste ¿ bestätigen, wird dieser in die Zelle übernom-
men. Dies spart Ihnen viel Tipparbeit bei häufig wiederkehrenden Texteinträgen.

Hinweis: Dies funktioniert nur mit Texteinträgen – nicht mit Zahlen, Datumsangaben oder Formeln.

¡ Ein weiterer Tipp: Darüber hinaus macht PlanMaker beim Eintippen von Text in eine Zelle automatisch
Vorschläge aus den Texteinträgen in den Zellen oberhalb und unterhalb dieser Zelle.  

Ein Beispiel: Sie haben in drei Tabellenzellen untereinander "New York", "Rio" und "Tokyo" eingetra-
gen. Wenn Sie nun in der Zelle unterhalb dieser Einträge ein "N" eintippen, schlägt das Programm auto-
matisch "New York" vor. Tippen Sie hingegen ein "T" ein, wird "Tokyo" vorgeschlagen etc.

Um den Vorschlag zu übernehmen, drücken Sie die Eingabetaste ¿. Um ihn abzulehnen, tippen Sie ein-
fach weiter oder drücken Sie die Taste Entf.

Hinweis: Falls Sie nicht möchten, dass PlanMaker beim Tippen solche Vorschläge macht, können Sie
diese Funktion jederzeit deaktivieren. Rufen Sie dazu den Menübefehl Weiteres > Einstellungen und
schalten Sie auf der Karteikarte Bearbeiten die Option Zellen automatisch vervollständigen aus.
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Änderungen rückgängig machen
Mit dem Menübefehl Bearbeiten > Rückgängig können Sie die zuletzt an einem Dokument durchgeführten
Änderungen widerrufen. Formatieren Sie beispielsweise Zellen in einer anderen Schrift, brauchen Sie nur
Bearbeiten > Rückgängig aufzurufen, und schon wird diese Änderung wieder aufgehoben. 

Dies funktioniert nicht nur bei Formatierungen, sondern bei praktisch allen Änderungen – so können Sie
beispielsweise auch das Eintippen oder Löschen von Text rückgängig machen. 

Der Befehl Rückgängig lässt sich bei Bedarf mehrmals hintereinander anwenden. Rufen Sie ihn zum Bei-
spiel fünfmal auf, werden die letzten fünf Änderungen widerrufen.

Wiederherstellen von widerrufenen Aktionen

Es gibt auch ein Gegenstück zum Befehl Rückgängig: den Menübefehl Bearbeiten > Wiederherstellen. Er
stellt die zuletzt von Ihnen widerrufene Aktion wieder her. So können Sie also das Widerrufen von Ände-
rungen widerrufen.

Auch dieser Befehl lässt sich mehrmals hintereinander aufrufen. Rufen Sie also beispielsweise fünfmal den
Befehl Rückgängig auf, werden die letzten fünf Änderungen widerrufen. Rufen Sie anschließend fünfmal
den Befehl Wiederherstellen auf, erhalten Sie wieder den Ausgangszustand.

Befehle wiederholen
Der Menübefehl Bearbeiten > Wiederholen wiederholt die Ausführung des zuletzt aufgerufenen Befehls
mit genau den gleichen Einstellungen.

Dies ist insbesondere beim Anbringen von Formatierungen praktisch. Wenn Sie beispielsweise eine Zelle
über den Menübefehl Format > Zeichen mit einer anderen Schrift versehen haben, können Sie anschlie-
ßend weitere Zellen ansteuern und dort einfach den Menübefehl Bearbeiten > Wiederholen aufrufen. Die-
se Zellen werden dann in der gleichen Schrift formatiert – als ob Sie den letzten Befehl noch einmal aufge-
rufen und erneut die gleichen Einstellungen vorgenommen hätten.

Auch viele andere Befehle lassen sich auf diese Weise beliebig oft wiederholen.

Markieren von Zellen und Zellinhalten
Bei manchen PlanMaker-Befehlen können Sie vor deren Ausführung erst Zellen markieren. Der Befehl wird
dann auf alle Zellen innerhalb der Markierung angewandt. 

Wenn Sie beispielsweise einige Zellen markieren und dann den Menübefehl Bearbeiten > Löschen aufru-
fen, werden alle markierten Zellen auf einmal gelöscht.
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Bei gedrückter Strg-Taste können auch unzusammenhängende Bereiche markiert werden.

Je nachdem, unter welchem Betriebssystem Sie das Programm einsetzen, unterscheidet sich die Vorgehens-
weise zum Markieren etwas. Deshalb enthält dieser Abschnitt folgende zwei Teile:

¡ Markieren in der Windows-, Mac- oder Linux-Version 

¡ Markieren in der Android-Version

Markieren in der Windows-, Mac- oder Linux-Version

In der Windows-, Mac- oder der Linux-Version von PlanMaker können Sie Zellen und Zellinhalte folgen-
dermaßen markieren:

Markieren mit der Maus

Um etwas mit der Maus zu markieren, gehen Sie wie folgt vor:

¡ Markieren beliebiger Zellbereiche 

Zellbereiche beliebigen Umfangs können durch Überstreichen der gewünschten Zellen bei gedrückter
linker Maustaste markiert werden.

¡ Markieren kompletter Zeilen und Spalten 

Eine komplette Spalte wird markiert, wenn Sie den dazugehörigen Spaltenkopf anklicken. Die Spalten-
köpfe sind die Schaltflächen oberhalb der Tabelle (beschriftet mit A, B, C usw.). 

Weiterhin gibt es für jede Zeile einen Zeilenkopf (links der Tabelle, beschriftet mit 1, 2, 3 etc.). Klicken
Sie diesen an, wird die komplette Zeile markiert. 

Ziehen Sie den Mauszeiger bei gedrückter Maustaste über mehrere Spalten- oder Zeilenköpfe, können
Sie mehrere Spalten beziehungsweise Zeilen auf einmal markieren.

¡ Markieren der gesamten Tabelle 

Eine besondere Funktion hat die Schaltfläche links oben im Tabellenfenster (oberhalb von 1 und links
von A): Ein Klick darauf markiert die gesamte Tabelle.
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Alternativ können Sie dies auch mit dem Menübefehl Bearbeiten > Alles markieren erreichen.

¡ Markieren einer einzelnen Zelle 

Um eine einzelne Zeile zu markieren, klicken Sie diese an und führen dann den Mauszeiger bei weiterhin
gedrückter Maustaste auf eine Nachbarzelle und wieder zurück. 

¡ Markieren unzusammenhängender Bereiche 

Sie können auch unzusammenhängende Bereiche markieren. Halten Sie dazu die Taste Strg gedrückt
und markieren Sie dann die gewünschten Bereiche.

¡ Markieren nur eines Teils des Zellinhalts 

Um nur einen Teil des Inhalts einer Zelle zu markieren, gehen Sie wie folgt vor:

Klicken Sie zunächst doppelt auf die Zelle, um ihren Inhalt bearbeiten zu können. Dann streichen Sie bei
gedrückter linker Maustaste mit der Maus über den Teil des Zellinhalts, den Sie markieren möchten.

¡ Markieren von Objekten 

Um ein Objekt (zum Beispiel eine Grafik oder Zeichnung) zu markieren, klicken Sie dieses mit der Maus
an. Es erscheint dann ein Rahmen um das Objekt, um anzuzeigen, dass es nun markiert ist.

Markieren mit der Tastatur

Alternativ können Sie zum Markieren auch die Tastatur verwenden. Gehen Sie dabei wie folgt vor:

¡ Markieren beliebiger Zellbereiche 

Um einen Bereich von Zellen zu markieren, halten Sie die Umschalttasteñ gedrückt und betätigen dann
beliebige Richtungstasten.

Wenn Sie beispielsweise die Zelle B5 ansteuern und dann bei gedrückter Umschalttasteñ fünfmal die
Pfeiltaste â drücken, werden die Zellen B5 bis B10 markiert. Eine Liste aller Tastenkombinationen zum
Bewegen und Markieren in einer Tabelle finden Sie im Abschnitt Tastenbelegung.

¡ Markieren einer einzelnen Zelle 

Eine einzelne Zelle markieren Sie, indem Sie die Zelle ansteuern, dann bei gedrückter Umschalttasteñ
eine benachbarte Zelle markieren und schließlich wieder in die Ausgangszelle zurückkehren. 

Drücken Sie also beispielsweise von der zu markierenden Zelle aus bei gedrückter Umschalttasteñ erst
die Taste à und dann die Taste ß.

¡ Markieren unzusammenhängender Bereiche 

Unzusammenhängende Bereiche können nur mit der Maus markiert werden (siehe oben).

¡ Markieren nur eines Teils des Zellinhalts 

Um nur einen Teil des Inhalts einer Zelle zu markieren, gehen Sie wie folgt vor:

Steuern Sie die Zelle an und betätigen Sie die Taste F2, um ihren Inhalt bearbeiten zu können. Dann ver-
wenden Sie wie gewohnt die Richtungstasten mit gleichzeitig gedrückter Umschalttasteñ, um Text zu
markieren.

¡ Markieren von Objekten 

Objekte können nur mit der Maus markiert werden (siehe oben).
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Markieren in der Android-Version

Auf Android-Geräten funktioniert das Markieren teilweise etwas anders. Sie können dabei wahlweise den
Finger oder eine Maus verwenden. Gehen Sie wie folgt vor:

¡ Markieren von Zellen 

Tabellenzellen können unter Android wie folgt selektiert werden: 

Tippen Sie ein Mal auf die gewünschte Startzelle. (Die Schreibmarke darf jetzt nicht darin blinken.)

Nach einer kurzen Pause tippen Sie erneut auf diese Zelle, halten den Finger weiterhin gedrückt, und zie-
hen den Finger dann zur gewünschten Endzelle.

¡ Markieren nur eines Teils des Zellinhalts 

Um nur einen Teil des Inhalts einer Zelle zu markieren, gehen Sie wie folgt vor:

Tippen Sie zunächst doppelt auf die Zelle, um ihren Inhalt bearbeiten zu können. Dann tippen Sie dop-
pelt auf dasjenige Wort in der Zelle, mit dem die Markierung beginnen soll. Das Wort sollte nun mar-
kiert sein. Sie erkennen das daran, dass große "Greifer" davor und dahinter erscheinen:

Diese Greifer stehen für den Anfang und das Ende der Markierung. Um die Markierung auf weiteren
Text auszuweiten, ziehen Sie die beiden Greifer einfach an die gewünschten Positionen.

¡ Markieren von Objekten 

Um ein Objekt (zum Beispiel eine Grafik oder Zeichnung) zu markieren, tippen Sie einfach darauf. Es
erscheint dann ein Rahmen um das Objekt, um anzuzeigen, dass es nun markiert ist.

Löschen von Zellen und Zellinhalten
Wenn Sie etwas aus einer Tabelle herauslöschen möchten, sollten Sie beachten, dass es hierfür zwei unter-
schiedliche Methoden gibt:

¡ Löschen von Zellinhalten 

Wenn Sie den Menübefehl Bearbeiten > Löschen verwenden, werden nur die Inhalte der markierten
Zellen gelöscht. 

¡ Löschen kompletter Zellen 

Wenn Sie hingegen den Menübefehl Arbeitsblatt > Zellen löschen verwenden, werden die markierten
Zellen komplett aus der Tabelle gelöscht. Die anderen Zellen der Tabelle rücken entsprechend nach.

Darüber hinaus gibt es Befehle speziell zum Löschen von leeren Zeilen und doppelt vorkommenden Zeilen:
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¡ Löschen leerer Zeilen 

Um alle leeren Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu löschen, markieren Sie diese
Zeilen und rufen dann den Menübefehl Arbeitsblatt > Entfernen > Leere Zeilen auf.

¡ Löschen doppelt vorkommender Zeilen 

Um alle doppelt vorkommenden Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu löschen, mar-
kieren Sie diese Zeilen und rufen dann den Menübefehl Arbeitsblatt > Entfernen > Doppelte Zeilen
auf.

Ausführlichere Informationen folgen auf den nächsten Seiten.

Löschen von Zellinhalten

Um die Inhalte von Zellen zu löschen, gehen Sie wie folgt vor:

1. Markieren Sie die gewünschten Zellen.

(Auf welche Arten man Zellen markieren kann, beschreibt der Abschnitt Markieren von Zellen und Zell-
inhalten.)

2. Rufen Sie den Menübefehl Bearbeiten > Löschen auf – oder drücken Sie einfach das Tastenkürzel für
diesen Befehl: die Taste Entf..

Es werden dabei nur die Inhalte der Zellen entfernt, nicht die Zellen selbst (siehe nächster Abschnitt).

Eingrenzen, was gelöscht werden soll

Wenn Sie statt des Menübefehls Bearbeiten > Löschen den Befehl Bearbeiten > Selektiv löschen benut-
zen, können Sie eingrenzen, was genau gelöscht werden soll.

Es erscheint dazu ein Untermenü mit folgenden Optionen:

¡ Alles 

Löscht alles – sowohl Zellinhalte als auch Formatierung, Kommentare, bedingte Formatierungen und
Gültigkeitsprüfung der markierten Zellen.

¡ Formate 

Löscht nur die Formatierung (Zahlenformat, Zeichenformat, Hintergrund, Umrandung usw.) der markier-
ten Zellen.

¡ Inhalte 

Löscht nur die Inhalte der markierten Zellen. Alles andere (Formatierung etc., Kommentare etc.) bleibt
erhalten.

¡ Kommentare 

Löscht weder Inhalt noch Formatierung der markierten Zellen, sondern entfernt nur die Kommentare, die
an diesen Zellen angebracht wurden (siehe Abschnitt Kommentare einfügen).

¡ Bedingte Formatierung 

Entfernt alle bedingten Formatierungen von den markierten Zellen (siehe auch Abschnitt Bedingte For-
matierung).
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¡ Gültigkeitsprüfung 

Entfernt alle Gültigkeitsprüfungen von den markierten Zellen (siehe auch Abschnitt Gültigkeitsprüfung).

Löschen kompletter Zellen

Der Menübefehl Arbeitsblatt > Zellen löschen löscht nicht nur den Inhalt von Zellen, sondern entfernt die
Zellen komplett aus der Tabelle. 

Dazu erscheint ein Dialogfenster, in dem Sie bestimmen können, wie die anderen Tabellenzellen nach dem
Löschvorgang nachrücken sollen.

Folgende Optionen stehen zur Wahl:

¡ Zellen nach oben verschieben 

Wählen Sie diese Option, wird der markierte Bereich gelöscht und die Zellen, die sich darunter befinden,
rücken nach oben nach.

¡ Zellen nach links verschieben 

Wählen Sie diese Option, wird der markierte Bereich gelöscht und die Zellen, die sich rechts davon be-
finden, rücken nach links nach.

¡ Ganze Zeilen löschen 

Hier werden nicht nur die markierten Zellen, sondern die kompletten Zeilen innerhalb des markierten
Bereichs gelöscht. Die Zeilen darunter rücken entsprechend nach oben nach.

¡ Ganze Spalten löschen 

Hier werden nicht nur die markierten Zellen, sondern die kompletten Spalten innerhalb des markierten
Bereichs gelöscht. Die Spalten rechts davon rücken entsprechend nach links nach.

Löschen leerer Zeilen

Um alle leeren Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu löschen, markieren Sie diese Zei-
len und rufen den Menübefehl Arbeitsblatt > Entfernen > Leere Zeilen auf. 

PlanMaker durchsucht diesen Bereich dann nach leeren Zeilen (also Zeilen, in denen keine einzige Zelle
ausgefüllt ist). Alle entsprechenden Zeilen werden gelöscht.
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Anmerkung

Normalerweise markiert man vor der Anwendung dieses Befehls einen Bereich aus kompletten Zeilen. Sie
können allerdings auch einen Zellbereich markieren, der nicht aus kompletten Zeilen besteht. PlanMaker
fragt dann nach, ob die gefundenen Zeilen komplett gelöscht werden sollen oder nicht:

¡ Antworten Sie mit Ja, wird bei allen Fundstellen die komplette Zeile gelöscht. 

¡ Antworten Sie mit Nein, werden nur die Zellen innerhalb der Markierung gelöscht. Die Zellen links und
rechts der Markierung bleiben erhalten.

Löschen doppelt vorkommender Zeilen

Um alle doppelt vorkommenden Zeilen innerhalb eines bestimmten Bereichs von Zeilen zu löschen, markie-
ren Sie diese Zeilen und rufen den Menübefehl Arbeitsblatt > Entfernen > Doppelte Zeilen auf. 

PlanMaker durchsucht den Bereich dann nach völlig identischen Zeilen (also Zeilen, bei denen die Inhalte
aller Zellen identisch zu den entsprechenden Inhalten in einer anderen Zeile sind). Diese Duplikate werden
dann gelöscht.

Anmerkung

Normalerweise markiert man vor der Anwendung dieses Befehls einen Bereich aus kompletten Zeilen. Sie
können allerdings auch einen Zellbereich markieren, der nicht aus kompletten Zeilen besteht. PlanMaker
fragt dann nach, ob die gefundenen Zeilen komplett gelöscht werden sollen oder nicht:

¡ Antworten Sie mit Ja, wird bei allen Fundstellen die komplette Zeile gelöscht. 

¡ Antworten Sie mit Nein, werden nur die Zellen innerhalb der Markierung gelöscht. Die Zellen links und
rechts der Markierung bleiben erhalten.

Einfügen von neuen Zellen
Der Menübefehl Arbeitsblatt > Zellen einfügen fügt neue Zellen, Zeilen oder Spalten in die Tabelle ein. 

Es erscheint dazu ein Dialogfenster, in dem Sie wählen können, auf welche Weise die Zellen eingefügt wer-
den sollen:
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¡ Zellen nach unten verschieben 

Es werden genau so viele Zellen eingefügt, wie beim Aufruf des Befehls markiert sind. Wurde nichts
markiert, wird nur eine Zelle eingefügt. 

Die darunter liegenden Zellen werden nach unten verschoben.

¡ Zellen nach rechts verschieben 

Es werden genau so viele Zellen eingefügt, wie beim Aufruf des Befehls markiert sind. Wurde nichts
markiert, wird nur eine Zelle eingefügt. 

Die Zellen rechts daneben werden nach rechts verschoben.

¡ Ganze Zeilen einfügen 

Es werden so viele komplette Zeilen eingefügt, wie von der Markierung umfasst werden. Wurde nichts
markiert, wird nur eine Zeile eingefügt. 

Die darunter liegenden Zeilen werden nach unten verschoben.

¡ Ganze Spalten einfügen 

Es werden so viele komplette Spalten eingefügt, wie von der Markierung umfasst werden. Wurde nichts
markiert, wird nur eine Spalte eingefügt. 

Die Spalten rechts davon werden nach rechts verschoben.

Kopierte Zellen einfügen
Es kommt immer wieder mal vor, dass man kopierte Zellen an eine Stelle setzen will, an der bereits Werte
stehen. Wenn diese Werte nicht überschrieben, sondern beim Einfügen aus der Zwischenablage verschoben
werden sollen, gibt es die folgende Option.

Der Menübefehl Arbeitsblatt > Kopierte Zellen einfügen... fügt Zellen, Zeilen oder Spalten aus der Zwi-
schenablage in die Tabelle ein. 

Es erscheint dazu ein Dialogfenster, in dem Sie wählen können, auf welche Weise die Zellen eingefügt wer-
den sollen:

¡ Zellen nach unten verschieben 

Es werden die kopierten Zellen aus der Zwischenablage an der markierten Stelle eingefügt.

Die darunter liegenden Zellen werden nach unten verschoben.
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¡ Zellen nach rechts verschieben 

Es werden die kopierten Zellen aus der Zwischenablage an der markierten Stelle eingefügt.

Die Zellen rechts daneben werden nach rechts verschoben.

¡ Ganze Zeilen einfügen 

Es werden die kopierten Zeilen aus der Zwischenablage an der markierten Stelle eingefügt.

Die darunter liegenden Zeilen werden nach unten verschoben.

¡ Ganze Spalten einfügen 

Es werden die kopierten Spalten aus der Zwischenablage an der markierten Stelle eingefügt.

Die Spalten rechts davon werden nach rechts verschoben.

Verschieben und Kopieren
Alle von PlanMaker unterstützten Betriebssysteme verfügen über eine äußerst nützliche Einrichtung: die
Zwischenablage.

Die Zwischenablage hat folgende Aufgabe: Sie können in der Tabelle etwas markieren und dieses dann in
die Zwischenablage hinein löschen oder kopieren. Anschließend können Sie es an einer anderen Stelle der
Tabelle wieder einfügen. Auf diese Weise lassen sich Zellen (und auch Objekte) löschen, duplizieren oder
verschieben. 

Alle hierzu nötigen Befehle finden Sie im Menü Bearbeiten:

Befehl Erläuterung

Ausschneiden Der Menübefehl Bearbeiten > Ausschneiden löscht den Inhalt der Markierung – jedoch nicht
für immer. Er wandert vielmehr in die Zwischenablage und kann von dort aus jederzeit wieder
eingefügt werden. 

Kopieren Der Menübefehl Bearbeiten > Kopieren kopiert den Inhalt der Markierung in die Zwischen-
ablage.

Einfügen* Um den Inhalt der Zwischenablage einzufügen, verwenden Sie den Menübefehl Bearbeiten >
Einfügen. Setzen Sie die Markierung an die gewünschte Stelle und rufen Sie diesen Befehl
dann auf. Sie können den Inhalt der Zwischenablage auch mehrmals einfügen.

* Wie Sie aus der Zwischenablage einfügen, ohne dabei die vorhandenen Werte an der markierten Stelle zu überschreiben, finden Sie im Abschnitt
Kopierte Zellen einfügen.

Dies funktioniert auf die gleiche Weise auch mit Objekten wie Grafiken, Diagrammen und Zeichnungen.

Einfügen der Zwischenablage in einen markierten Bereich

Wenn Sie Zellen in die Zwischenablage kopieren, anschließend einen Zellbereich in der Tabelle markieren
und erst dann den Menübefehl Bearbeiten > Einfügen aufrufen, werden die Zellen beim Einfügen in diese
Markierung eingepasst.

Dies äußert sich folgendermaßen:
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¡ Ist der markierte Zellbereich kleiner als der einzufügende Zellbereich, werden beim Einfügen alle Zellen
abgeschnitten, die nicht hineinpassen. 

¡ Ist der markierte Zellbereich größer, werden die Zellen so oft wiederholt, bis der markierte Bereich voll-
ständig ausgefüllt ist.

¡ Dabei gibt es eine Ausnahme:

Umfasst der markierte Bereich nur eine einzige Zeile, werden trotzdem alle Spalten der kopierten Zellen
eingefügt.

Entsprechendes gilt, wenn der markierte Zellbereich nur eine Spalte umfasst.

Verschieben und Kopieren mit der Maus ("Drag and Drop")

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar.

Sie können Zellen auch verschieben oder kopieren, indem Sie diese mit der Maus einfach nehmen, an eine
andere Stelle ziehen und dort ablegen. Mit dieser "Drag and Drop" ("Ziehen und Ablegen") genannten
Technik können Sie Zellinhalte besonders schnell verschieben oder kopieren.

Gehen Sie dazu folgendermaßen vor:

1. Markieren Sie die gewünschten Zellen. 

2. Zeigen Sie mit der Maus auf diese Zellen. 

3. Drücken Sie die linke Maustaste und halten Sie diese gedrückt.

4. Ziehen Sie die Maus bei weiterhin gedrückter Maustaste an die Zielstelle.

5. Wenn Sie die Maustaste nun loslassen, werden die Zellen an die Zielstelle verschoben.

Wenn Sie beim Loslassen der Maustaste die Taste Strg gedrückt halten, werden sie hingegen dorthin ko-
piert.

Wenn Sie beim Loslassen der Maustaste die Taste Alt gedrückt halten, erscheint ein Dialog, in dem Sie
wählen können, ob verschoben oder kopiert werden soll. Außerdem können Sie beim Kopieren festlegen,
ob nur die Inhalte der Zellen oder auch deren Formatierungen kopiert werden sollen.

Tipp: Das Verschieben oder Kopieren einer einzigen Zelle funktioniert auch mit folgender Methode: Kli-
cken Sie die Zelle einmal an, um sie zur aktuellen Zelle zu machen. Dann klicken Sie die Zelle erneut an
und halten die linke Maustaste gedrückt. Nach etwa einer Sekunde ändert sich der Mauszeiger. Nun können
Sie die Zelle mit der Maus an eine andere Position ziehen (wie oben beschrieben).

Formeln mit relativen Koordinaten kopieren und verschieben

Wenn Sie Zellen, die Formeln enthalten, kopieren oder verschieben, werden automatisch die Zelladressen in
diesen Formeln dem neuen Ort angepasst.

Ein Beispiel:

Nehmen Sie an, in A7 befände sich eine Formel, die die Werte aus den vier darüber liegenden Zellen zu-
sammenrechnet:

=SUMME(A3:A6)

Diese Formel kopieren Sie nun an Position B7. PlanMaker setzt die Formel dabei automatisch so um, dass
sie wieder mit den vier Zellen oberhalb der Ergebniszelle arbeitet. Sie bekommen also in Zelle B7 folgende
Formel präsentiert:
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=SUMME(B3:B6)

Wünschen Sie dies nicht, verwenden Sie in den Formeln nicht die übliche relative Zelladressierung, son-
dern eine absolute Zelladressierung (siehe Abschnitt Relative und absolute Zellbezüge).

Selektives Einfügen
Vom Menübefehl Bearbeiten > Einfügen gibt es noch eine leistungsfähigere Variante: nämlich den Befehl
Bearbeiten > Inhalte einfügen. Bei diesem können Sie genau festlegen, in welcher Form der Inhalt der
Zwischenablage eingefügt werden soll.

Hintergrund:

Wenn Sie mit dem Befehl Ausschneiden oder Kopieren Informationen in der Zwischenablage ablegen,
werden diese dort in mehreren Formaten gleichzeitig gespeichert. Hatten Sie beispielsweise Text markiert,
erscheint dieser in der Zwischenablage sowohl in formatierter Form als auch unformatiert.

Normalerweise brauchen Sie sich darum nicht zu kümmern, denn PlanMaker wählt automatisch das geeig-
netste Format, wenn Sie die Zwischenablage mit dem Befehl Einfügen ins Dokument einfügen. Sie können
das Format jedoch alternativ selbst auswählen. Verwenden Sie hierzu den Menübefehl Bearbeiten > Inhal-
te einfügen. 

Beim Aufruf dieses Befehls erscheint ein Dialogfenster mit einer Liste aller Formate, in denen die momen-
tan in der Zwischenablage befindliche Information gespeichert ist. Wählen Sie das gewünschte Format in
der Liste Einfügen als aus und bestätigen mit OK, wird der Inhalt der Zwischenablage im gewählten For-
mat eingefügt.

Darüber hinaus bietet dieser Dialog verschiedene zusätzliche Optionen an, die allerdings nur verfügbar sind,
wenn Tabellenzellen in die Zwischenablage kopiert wurden:
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Folgende zusätzliche Optionen gibt es:

Inhalt einfügen

Hier können Sie festlegen, auf welche Weise die Inhalte der kopierten Zellen eingefügt werden sollen:

¡ Inhalte einfügen 

Ist diese Option aktiviert, wird auch der Inhalt der kopierten Zellen eingefügt. Ist sie deaktiviert, nur de-
ren Formatierung.

¡ Formeln in Werte umwandeln 

Ist diese Option aktiviert, werden sämtliche in den kopierten Zellen enthaltenen Rechenformeln beim
Einfügen ausgerechnet und als feste Werte eingetragen. Kopieren Sie also eine Zelle mit der Berechnung
"=A1*2" in die Zwischenablage, würde beim Einfügen nicht die Rechenformel eingefügt, sondern das
Ergebnis dieser Berechnung als Zahlenwert.
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¡ Kommentare ignorieren 

Ist diese Option aktiviert, werden Kommentare, mit denen die kopierten Zellen versehen wurden, beim
Einfügen weggelassen.

Formatierung einfügen

Bestimmt, ob beim Einfügen auch die Formatierung der kopierten Zellen übernommen werden soll.

Hierfür gibt es folgende Optionen:

¡ Alle 

Alle Formatierungsoptionen der kopierten Zellen übernehmen. (Schaltet sämtliche nachfolgend aufge-
führten Optionen ein.)

¡ Zahlenformat 

Das Zahlenformat der kopierten Zellen übernehmen.

¡ Zellenformat 

Das Zellenformat der kopierten Zellen übernehmen.

¡ Gültigkeitsprüfung 

Die Einstellungen zur Gültigkeitsprüfung der kopierten Zellen übernehmen.

¡ Bedingte Formatierung 

Bedingte Formatierungen der kopierten Zellen übernehmen.

¡ Umrandung, Schattierung 

Umrandung/Schattierung der kopierten Zellen übernehmen.

Zellengrößen einfügen

Bestimmt, ob beim Einfügen auch die Zellengrößen der kopierten Zellen auf die Zielzellen übertragen wer-
den sollen.

¡ Spaltenbreite 

Breite der kopierten Zellen übernehmen.

¡ Zeilenhöhe 

Höhe der kopierten Zellen übernehmen.

Optionen

Dieser Bereich enthält folgende zusätzlichen Optionen:

¡ Transponieren 

Ist diese Option aktiviert, wird beim Einfügen die zeilen-/spaltenweise Anordnung der kopierten Zellen
vertauscht. Zeilen werden also zu Spalten, und Spalten werden zu Zeilen.
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¡ Leere Zellen überspringen 

Ist diese Option aktiviert, werden beim Einfügen der kopierten Zellen alle leeren Zellen übersprungen.
Fügen Sie also eine leere Zelle auf einer bestehenden Zelle ein, behält die bestehende Zelle ihren Inhalt
und ihre Formatierung bei.

¡ Rechenoperation 

Diese Option betrifft das Einfügen von kopierten Zellen auf bereits vorhandene Zellen. Sie bestimmt, ob
dabei die vorhandenen Werte mit den kopierten Werten kombiniert werden sollen. Hierfür stehen die
vier Grundrechenarten zur Verfügung.

Verfügbare Optionen:

Keine: Die kopierten Werte und die vorhandenen Werte nicht kombinieren. Die vorhandenen Werte
werden also einfach überschrieben. Dies ist die Standardeinstellung.

Zum Ziel addieren: Die kopierten Werte zu den vorhandenen Werten addieren.

Vom Ziel subtrahieren: Die kopierten Werte von den vorhandenen Werten abziehen.

Mit dem Ziel multiplizieren: Die vorhandenen Werte mit den kopierten Werten multiplizieren.

Das Ziel dividieren: Die vorhandenen Werte durch die kopierten Werte teilen.

Ein Beispiel: Sie kopieren eine Zelle, die den Wert 2 enthält, in die Zwischenablage. Dann steuern Sie
eine Zelle an, die den Wert 8 enthält, und rufen den Menübefehl Einfügen > Inhalte einfügen auf. Ist
hierbei die Option Zum Ziel addieren eingeschaltet, wird diese Zelle danach den Wert 10 enthalten
(8+2=10).

Schaltfläche "Bezug einfügen"

Diese Schaltfläche ignoriert sämtliche Einstellungen, die Sie in dem Dialog vornehmen, denn sie hat folgen-
de Spezialfunktion:

Wenn Sie Tabellenzellen in die Zwischenablage kopiert haben, den Menübefehl Bearbeiten > Inhalte ein-
fügen aufrufen und dann auf die Schaltfläche Bezug einfügen klicken, werden nicht die Inhalte dieser Zel-
len eingefügt, sondern Zellbezüge auf die Adressen dieser Zellen.

Kopieren Sie also die Zelle B15 in die Zwischenablage, fügt diese Schaltfläche den Zellbezug =B15 ein.

Tipp: Dies funktioniert sogar, wenn Zellen von einem anderen Dokument aus in die Zwischenablage ko-
piert wurden. In diesem Fall fügt PlanMaker automatisch einen externen Zellbezug ein (siehe Abschnitt
Externe Zellbezüge).

Automatisches Füllen von Zellen
Mit der Funktion Ausfüllen ist es möglich, den Inhalt einer Zelle blitzschnell in andere Zellen zu kopieren –
oder von diesem Zellinhalt ausgehend eine ansteigende oder abfallende Wertereihe über mehrere Zellen
hinweg aufzubauen. 

Es gibt zwei Methoden, diese Funktion einzusetzen:



68Bearbeiten einer Tabelle

Füllen mit der Maus

Am einfachsten funktioniert das automatische Füllen von Zellen mit der Maus. Gehen Sie wie folgt vor:

1. Tragen Sie den Ausgangswert in eine Zelle ein.

2. Klicken Sie auf diese Zelle (um sie zur aktuellen Zelle zu machen).

3. Zeigen Sie mit der Maus auf das kleine Rechteck in der rechten unteren Ecke des Zellrahmens, der die
aktuelle Zelle umgibt (in der Abbildung rot umrandet):

4. Ziehen Sie dieses Rechteck bei gedrückter Maustaste in die gewünschte Richtung. Lassen Sie die
Maustaste los, wenn die Zielposition erreicht ist.

Alle Zellen in dem aufgezogenen Bereich werden nun automatisch gefüllt.

Womit die Zellen gefüllt werden, hängt davon ab, was sich in der Ausgangszelle befindet:

¡ Ist dort Text eingetragen, füllt PlanMaker alle Zellen mit diesem Text.  

¡ Ist eine Zahl (z.B. 42) eingetragen, füllt PlanMaker die Zellen automatisch mit einer Zahlenreihe mit In-
krement 1 (hier also 43, 44, 45 etc.).

Tipp: Wenn Sie nicht möchten, dass PlanMaker eine Zahlenreihe bildet, sondern einfach nur alle Zellen
mit 42 gefüllt haben möchten, dann drücken Sie während des Ziehens mit der Maus die Taste Strg.

Wenn Sie während des Ziehens die Taste Alt gedrückt halten, erscheint der weiter unten beschriebene Dia-
log, in dem Sie genauer festlegen können, auf welche Weise die Zellen gefüllt werden sollen.

Füllen per Tastatur

Um Zellen per Tastatur automatisch füllen zu lassen, gehen Sie wie folgt vor:

1. Tragen Sie den Ausgangswert in eine Zelle ein.

2. Markieren Sie die Zelle mit dem Ausgangswert und alle zu füllenden Zellen.

3. Rufen Sie den Menübefehl Bearbeiten > Ausfüllen nach auf.

4. Es erscheint ein Untermenü. Wählen Sie darin, in welche Richtung gefüllt werden soll (ausgehend von
der Zelle mit dem Ausgangswert): Links, Rechts, Oben oder Unten.

5. Es erscheint ein Dialog, in dem Sie genau festlegen können, auf welche Weise die Zellen gefüllt werden
sollen (siehe unten).

6. Sobald Sie mit OK bestätigen, werden die markierten Zellen Ihren Einstellungen entsprechend gefüllt.

Es erscheint dabei das folgende Dialogfenster:
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In diesem Dialog können folgende Einstellungen vorgenommen werden:

¡ Reihen in 

Wählen Sie hier, ob in Richtung der Zeilen (nach rechts) oder in Richtung der Spalten (nach unten) aus-
gefüllt werden soll.

¡ Quelle 

Aktivieren Sie die Option Inhalte, wenn die zu füllenden Zellen mit Werten gefüllt werden sollen.

Aktivieren Sie die Option Formate, wenn die zu füllenden Zellen auch die Formatierung der Ausgangs-
zelle erben sollen.

Standardmäßig sind beide Optionen aktiviert.

¡ Aktion 

Diese Option entspricht dem Drücken der Taste Strg beim Füllen von Zellen per Maus: Sie können da-
durch bestimmen, ob der Wert in der Ausgangszelle fortgeschrieben oder kopiert werden soll:

Steht in der Ausgangszelle beispielsweise die Zahl 42, werden bei Kopieren alle auszufüllenden Zellen
ebenfalls mit 42 gefüllt.

Wählen Sie hingegen Fortschreiben, werden die Zellen mit einer Zahlenreihe (in diesem Fall also 43,
44, 45 etc.) gefüllt.

Wie diese Zahlenreihe aufgebaut sein soll, legen Sie mit den anderen Optionen in diesem Dialog fest:

¡ Reihentyp 

Hier bestimmen Sie, welche Art von Zahlenreihe erzeugt werden soll:

Automatisch: 

Entspricht einer arithmetischen Reihe: Jeder weitere Wert wird um das Inkrement erhöht. Das Inkrement
ermittelt PlanMaker dabei allerdings automatisch. 

Wenn Sie beispielsweise zwei Zellen mit den Werten 10 und 20 fortführen, werden die auszufüllenden
Zellen mit 30, 40, 50 etc. gefüllt (siehe auch Tipps und Tricks im nächsten Abschnitt).

Arithmetisch: 

Hier wird jeder weitere Wert um das Inkrement erhöht. 
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Steht in der Ausgangszelle also 1, werden die Zellen bei einem Inkrement von 2 mit folgender Zahlenrei-
he gefüllt: 3, 5, 7, 9, 11 etc.

Geometrisch: 

Hier wird jeder weitere Wert mit dem Inkrement multipliziert.

Steht in der Ausgangszelle also 1, werden die Zellen bei einem Inkrement von 2 mit folgender Zahlenrei-
he gefüllt: 2, 4, 8, 16, 32 etc.

Datum: 

Hier wird jeder weitere Wert um das Inkrement in der gewählten Zeiteinheit (siehe unten) erhöht. Die-
ser Reihentyp ist nur dann sinnvoll anwendbar, wenn sich in der Ausgangszelle ein Datum befindet.

Steht in der Ausgangszelle also 1.1.2018, werden die Zellen bei Inkrement 1 und Zeiteinheit "Monate"
wie folgt gefüllt: 1.2.2018, 1.3.2018, 1.4.2018 etc.

¡ Zeiteinheit 

Diese Option ist nur dann verfügbar, wenn der Reihentyp auf "Datum" gesetzt wurde.

Sie können hier die Zeiteinheit für das Inkrement bestimmen:

Tage: tageweise weiterzählen

Werktage: tageweise weiterzählen, dabei jedoch Samstag und Sonntag überspringen. Steht in der Aus-
gangszelle also ein Datum, das auf einen Freitag fällt, so wäre der nächste Wert nicht der darauf folgen-
de Samstag, sondern der Montag.

Monate: monateweise weiterzählen

Jahre: jahreweise weiterzählen

¡ Inkrement 

Hier bestimmen Sie, um welchen Betrag jeder weitere Wert ansteigen soll. Einige Beispiele finden Sie
weiter oben.

Es ist auch ein negativer Wert zulässig.

Diese Option ist nicht verfügbar, wenn der Reihentyp auf "Automatisch" gesetzt wurde, da PlanMaker
das Inkrement hier automatisch ermittelt.

¡ Jede Zelle einzeln inkrementieren 

Wenn diese Option eingeschaltet wird, wendet PlanMaker das gewählte Inkrement auf jede der momen-
tan markierten Zellen einzeln an. 

Ein Beispiel: Sie markieren Zellen mit den Inhalten 1, 2, 3 und füllen dann die Zellen direkt darunter.

Wenn die Option ausgeschaltet ist, wird diese Sequenz einfach fortgeführt, und die Zellen werden wie
folgt gefüllt: 

4, 5, 6, 7, 8, 9, 10, 11, 12 etc.

Wenn Sie die Option hingegen einschalten, sehen die gefüllten Zellen wie folgt aus: 

2, 3, 4, dann 3, 4, 5, dann 4, 5, 6 etc.

¡ Schaltfläche Listen bearbeiten 

Sie können auch eigene Listen für die Funktion Ausfüllen herstellen. 
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Erzeugen Sie beispielsweise eine Liste mit dem Inhalt "Rot", "Grün" und "Blau" und füllen dann, ausge-
hend von einer Zelle mit dem Inhalt "Rot", weitere Zellen, so werden diese mit Grün, Blau, Rot, Grün,
Blau etc. ausgefüllt.

Diese Schaltfläche ruft den Menübefehl Weiteres > Listen editieren auf, mit dem Sie solche Listen an-
legen können. Siehe Abschnitt Listen für das automatische Füllen editieren.

Tipps und Tricks zum automatischen Füllen

Die vielen Optionen, die es bei der Funktion Ausfüllen gibt, lassen ihre Anwendung schwieriger erschei-
nen, als sie tatsächlich ist. Deshalb finden Sie nachfolgend einige Tipps und Tricks, wie Sie dieses äußerst
nützliche Feature am effektivsten einsetzen.

Tipp: Am schnellsten gelingt das automatische Füllen, wenn Sie einfach mit der Maus an dem kleinen
Rechteck in der rechten unteren Ecke des Zellrahmens ziehen. Denn hier setzt PlanMaker den Reihentyp
auf "Automatisch". Das heißt: Er erkennt selbstständig, mit welchen Werten die Zellen auszufüllen sind
(siehe Beispiele).

¡ Füllen mit Text 

Beim Füllen mit Text brauchen Sie sich um keinerlei Optionen zu kümmern, denn Text kann ohnehin
nur kopiert werden.

Möchten Sie also mehrere Zellen mit dem gleichen Text füllen, tragen Sie ihn einfach in eine Zelle ein,
klicken diese Zelle an und ziehen das kleine Rechteck in der rechten unteren Ecke des Zellrahmens über
die Zellen, die damit gefüllt werden sollen.

¡ Füllen mit Zahlen 

Wenn Sie zum Füllen mit Zahlen die Maus verwenden, erhalten Sie eine Zahlenreihe, deren Inkrement
PlanMaker automatisch bestimmt.

Ziehen Sie also von einer Zelle mit der Zahl 42 aus an dem kleinen Rechteck, werden die Zellen mit den
Werten 43, 44, 45 etc. gefüllt.

Tragen Sie hingegen in eine Zelle 10 und darunter 20 ein, markieren diese beiden Zellen und ziehen
dann das Rechteck nach unten, erkennt PlanMaker automatisch, wie diese Reihe fortzuführen ist, trägt
also 30, 40, 50 etc. ein.

¡ Füllen mit Formeln 

Wenn Sie Zellen mit Formeln füllen, versucht PlanMaker automatisch, die Zelladresse in einer Reihe
fortzuführen.

Tragen Sie in die Ausgangszelle beispielsweise =A1*2 ein, werden die Zellen mit =A2*2, =A3*2 etc.
gefüllt.

¡ Füllen mit Datumsangaben 

Das Füllen mit Datumsangaben funktioniert genauso wie das Füllen mit Zahlen:

Tragen Sie das Ausgangsdatum in die Ausgangszelle ein, ziehen Sie an dem Rechteck und PlanMaker
addiert bei jeder Zelle einen Tag hinzu.

Bei Bedarf können Sie über den Dialog des Menübefehls Bearbeiten > Ausfüllen festlegen, ob um Ta-
ge, Monate oder Jahre weitergezählt werden soll.
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¡ Füllen mit Strukturen 

Wie Sie bereits erfahren haben, können Sie auch mehrere Zellen markieren und diese fortführen. Was
aber, wenn die markierten Zellen kein automatisch erkennbares Inkrement oder völlige unterschiedliche
Werte haben?

Hier versucht PlanMaker, dennoch eine Regelmäßigkeit zu erkennen. Tragen Sie beispielsweise unter-
einander die Werte 1, 2, Text ein, so führt PlanMaker diese Reihe mit 3, 4, Text, 5, 6, Text, 7, 8, Text
etc. fort.

Handelt es sich bei den Werten ausschließlich um Zeichenketten, so werden diese einfach wiederholt.
Sind die Ausgangszellen also mit den Zeichenketten Rot, Grün, Blau gefüllt, werden die Zellen mit Rot,
Grün, Blau, Rot, Grün, Blau etc. gefüllt.

¡ Füllen mit selbst erstellen Listen 

Mit dem Menübefehl Weiteres > Listen editieren können Sie eigene Listen für die Funktion Ausfüllen
herstellen.

Erzeugen Sie beispielsweise eine Liste mit dem Inhalt "Rot", "Grün" und "Blau" und füllen dann, ausge-
hend von einer Zelle mit dem Inhalt "Rot", weitere Zellen, so werden diese mit Grün, Blau, Rot, Grün,
Blau etc. ausgefüllt.

Informationen zum Erstellen solcher Listen finden Sie im Abschnitt Listen für das automatische Füllen
editieren.

Arbeiten mit mehreren Arbeitsblättern
Tabellen müssen nicht unbedingt aus nur einem einzigen Arbeitsblatt bestehen. Es ist auch möglich, mehre-
re Arbeitsblätter hintereinander zu legen – praktisch wie bei einem Stapel Papier. Wir nennen ein PlanMa-
ker-Dokument deshalb auch eine Arbeitsmappe. Jede Arbeitsmappe kann bis zu 256 Arbeitsblätter enthal-
ten.

Der Clou dabei: Berechnungen in einem Arbeitsblatt können sich auch auf Zellen anderer Arbeitsblätter be-
ziehen, was Ihnen ermöglicht, sozusagen "dreidimensionale" Berechnungen durchzuführen (siehe Abschnitt
Rechnen in drei Dimensionen).

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit mehreren Arbeitsblättern in einem
Dokument. Folgende Themen werden darin behandelt:

¡ Neue Arbeitsblätter anlegen 

Mit dem Menübefehl Arbeitsblatt > Blatt > Einfügen können Sie jederzeit ein neues Arbeitsblatt anle-
gen.

¡ Verwenden des Arbeitsblattregisters 

Mit dem Arbeitsblattregister am unteren Rand des Dokumentfensters können Sie per Mausklick zwi-
schen den Arbeitsblätter eines Dokuments wechseln. Weiterhin lassen sich Arbeitsblätter damit anlegen,
verschieben und verwalten.

¡ Arbeitsblätter verwalten 

Das Kontextmenü des Arbeitsblattregisters und der Menübefehl Arbeitsblatt > Blatt stellt Ihnen Befeh-
le zur Verfügung, mit denen Sie Arbeitsblätter verwalten können (umbenennen, kopieren, verschieben
etc.).
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¡ Rechnen in drei Dimensionen 

Im letzten Abschnitt erfahren Sie, wie Sie Berechnungen über mehrere Arbeitsblätter hinweg durchfüh-
ren.

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten.

Neue Arbeitsblätter anlegen

Um ein neues Arbeitsblatt anzulegen, rufen Sie den Menübefehl Arbeitsblatt > Blatt auf. Es öffnet sich ein
Untermenü, aus dem Sie den Befehl Einfügen wählen. Nun erscheint ein Dialogfenster, das Sie auffordert,
dem neuen Blatt einen Namen zu geben. Tragen Sie einen beliebigen Namen ein und bestätigen Sie mit OK.
 

PlanMaker legt das Arbeitsblatt an und macht es zum aktiven Arbeitsblatt. 

Verwenden des Arbeitsblattregisters

Im Arbeitsblattregister am unteren Rand des Dokumentfensters werden Registerkarten für alle im aktuellen
Dokument vorhandenen Arbeitsblätter angezeigt.

Das momentan aktive Blatt ist hervorgehoben dargestellt.

Mit dem Arbeitsblattregister lassen sich folgende Aktionen durchführen:

¡ Wechseln zwischen Arbeitsblättern 

Um auf ein anderes Arbeitsblatt zu wechseln, klicken Sie einfach dessen Registerkarte im Arbeitsblattre-
gister an.

Hinweis: Falls aus Platzgründen nicht alle Blätter angezeigt werden, können Sie das Register mit Hilfe
der Pfeilchen links davon durchblättern.

Tipp: Sie können auch über die Tastatur zwischen den Arbeitsblättern wechseln: Mit Strg+Tab bewe-
gen Sie sich zum nächsten Arbeitsblatt und mit Strg+Umschalt+Tab zum vorherigen Arbeitsblatt.

¡ Reihenfolge von Arbeitsblättern ändern 

Sie können Arbeitsblätter im Arbeitsblattregister jederzeit verschieben und so die Reihenfolge der Blät-
ter ändern. 

Klicken Sie dazu die Registerkarte des Blatts an, das verschoben werden soll, halten Sie die linke
Maustaste gedrückt und ziehen Sie seine Registerkarte an die gewünschte Position im Register.

¡ Bearbeiten mehrerer Arbeitsblätter gleichzeitig 

Sie können im Arbeitsblattregister auch mehrere Arbeitsblätter auf einmal selektieren und diese dann ge-
meinsam bearbeiten. Halten Sie dazu die Taste Strg gedrückt und klicken Sie die Registerkarten aller
Arbeitsblätter an, die Sie selektieren möchten.
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Wenn mehrere Arbeitsblätter markiert sind, wirken sich Änderungen an einem dieser Arbeitsblätter auf
alle markierten Arbeitsblätter gleichzeitig aus. 

Beispiele:

Wenn Sie die Formatierung von Zellen ändern, wird diese Änderung auch von den gleichen Zellen auf
den anderen markierten Blättern übernommen.

Wenn Sie den Inhalt einer Zelle bearbeiten oder löschen, wird auch diese Änderung auf allen markierten
Blättern übernommen.

Änderungen mit den Menübefehlen Arbeitsblatt > Zeile und Arbeitsblatt > Spalte wirken sich eben-
falls auf alle markierten Blätter aus.

¡ Verwalten von Arbeitsblättern 

Wenn Sie mit der rechten Maustaste auf eine der Registerkarten im Arbeitsblattregister klicken, er-
scheint ein Kontextmenü, das alle Befehle zum Anlegen und Verwalten von Arbeitsblättern enthält. Le-
sen Sie dazu den nächsten Abschnitt.

¡ Anlegen eines neuen Arbeitsblatts 

Die Registerkarte mit dem Sternchen (*) ganz rechts dient als "Abkürzung" für das Anlegen neuer Ar-
beitsblätter: Wenn Sie darauf klicken, legt PlanMaker sofort ein neues Arbeitsblatt an.

Arbeitsblätter verwalten

Wenn Sie den Menübefehl Arbeitsblatt > Blatt aufrufen, öffnet sich ein Untermenü mit Befehlen zum Ver-
walten von Arbeitsblättern.

Tipp: Dieses Menü erscheint auch, wenn Sie mit der rechten Maustaste auf die gewünschte Registerkarte
im Arbeitsblattregister klicken.

Folgende Befehle sind in dem Menü verfügbar:

¡ Der Befehl Einfügen legt ein neues Arbeitsblatt an. 

¡ Der Befehl Kopieren fertigt eine Kopie des aktuellen Arbeitsblatts an. Dazu erscheint ein Untermenü, in
dem Sie wählen können, an welcher Position die Kopie platziert werden soll (innerhalb der anderen Ar-
beitsblätter).

Sie können die Kopie auch in einem anderen (momentan geöffneten) Dokument oder in einem neuen Do-
kument ablegen. Wählen Sie dazu die Option In ein anderes Dokument.

¡ Der Befehl Verschieben verschiebt das Arbeitsblatt an eine andere Position. Genau wie beim Befehl
Kopieren erscheint auch hier ein Untermenü zur Auswahl des Zielorts. 

¡ Der Befehl Löschen entfernt das Arbeitsblatt (samt Inhalt).

¡ Der Befehl Umbenennen lässt Sie den Namen des Arbeitsblatts ändern.

¡ Der Befehl Einblenden macht ausgeblendete Arbeitsblätter wieder sichtbar (siehe Befehl Ausblenden). 

Dazu öffnet sich ein Untermenü, das alle ausgeblendeten Arbeitsblätter anzeigt. Klicken Sie darin auf
das Blatt, das wieder eingeblendet werden soll. Der Eintrag Alle einblenden macht alle ausgeblendeten
Blätter wieder sichtbar.
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¡ Der Befehl Ausblenden blendet das Arbeitsblatt aus.  

Ausgeblendete Arbeitsblätter sind unsichtbar. Sie können nicht angezeigt oder bearbeitet werden und er-
scheinen auch nicht im Arbeitsblattregister. PlanMaker zieht sie aber auch weiterhin bei Berechnungen
heran.

¡ Die Befehle Alle Blätter selektieren und Blätter deselektieren (nur im Kontextmenü verfügbar) selek-
tieren beziehungsweise deselektieren alle Arbeitsblätter im Arbeitsblattregister. 

¡ Der Befehl Seite einrichten im Kontextmenü entspricht dem Menübefehl Datei > Seite einrichten im
Hauptmenü. Sie können damit Einstellungen wie Papierformat, Seitenränder etc. für das Arbeitsblatt
vornehmen. Siehe Abschnitt Seitenformat.

¡ Der Befehl Seiteneinrichtung kopieren im Kontextmenü erlaubt es Ihnen, die Seiteneinrichtung eines
Arbeitsblatts (also alle mit dem Menübefehl Datei > Seite einrichten gemachten Einstellungen) auf ein
anderes Arbeitsblatt zu übertragen. Es erscheint ein Untermenü mit folgenden Befehlen:

Auf alle Blätter: Überträgt die Seiteneinrichtung vom aktuellen Arbeitsblatt auf alle anderen.

Von...: Überträgt die Seiteneinrichtung vom einem beliebigen anderen Arbeitsblatt auf das aktuelle
Blatt.

¡ Der Befehl Eigenschaften im Kontextmenü entspricht dem Menübefehl Arbeitsblatt > Eigenschaften
im Hauptmenü. Sie können damit allgemeine Einstellungen zu einem Arbeitsblatt vornehmen. Siehe Ab-
schnitt Arbeitsblatteigenschaften ändern. 

Tipp: Wie zuvor im Abschnitt Verwenden des Arbeitsblattregisters beschrieben, können Sie vor dem Aufruf
eines dieser Befehle mehrere Arbeitsblätter im Arbeitsblattregister selektieren. Der Befehl wird dann auf al-
le selektierten Blätter gleichzeitig angewandt.

Hinweis: Wenn Sie in einem Dokument den Arbeitsmappenschutz aktivieren, bewirkt das, dass sich darin
ab sofort keinerlei Änderungen am Arbeitsblattregister mehr durchführen lassen. Auch der Menübefehl
Arbeitsblatt > Blatt ist nicht mehr verfügbar. Weitere Informationen dazu finden Sie im Abschnitt Ar-
beitsmappenschutz.

Rechnen in drei Dimensionen

Der besondere Clou an Dokumenten mit mehreren Arbeitsblättern ist, dass Sie auch Berechnungen über
mehrere Arbeitsblätter hinweg durchführen können. 

Dazu muss in der Formel lediglich vor der Zelladresse der Name des Blatts angegeben werden (durch ein
Ausrufezeichen getrennt). "Tabelle1!A1" steht beispielsweise für die Zelle A1 auf dem Arbeitsblatt "Tabel-
le1".

Ein Beispiel

Nehmen wir an, Sie möchten eine Gewinn- und Verlustrechnung erstellen. Dazu haben Sie drei Arbeitsblät-
ter mit den Namen "Einnahmen", "Ausgaben" und "Ergebnis" angelegt.

Nun soll beispielsweise vom Wert in der Zelle A8 des Blatts "Einnahmen" der Wert in Zelle D2 des Blatts
"Ausgaben" abgezogen werden und in Zelle C9 des Blatts "Ergebnis" erscheinen. 
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Wechseln Sie dazu zum Blatt "Ergebnis". Steuern Sie darin die Zelle C9 an und tragen Sie folgende Formel
ein:

=Einnahmen!A8-Ausgaben!D2

Nach Betätigen der Eingabetaste ¿ erhalten Sie in der Zelle C9 auf dem Blatt "Ergebnis" das Resultat die-
ser Berechnung.

Bereiche benennen
Mit dem Menübefehl Arbeitsblatt > Namen können Sie beliebigen Zellbereichen Namen geben. 

Hat Ihre Tabelle beispielsweise vier Spalten mit den Umsätzen für Frühling, Sommer, Herbst und Winter,
benennen Sie diese einfach entsprechend. Nun ist beispielsweise folgende Berechnung möglich:

=SUMME(Frühling) 

Wenn Sie den Menübefehl Arbeitsblatt > Namen aufrufen, öffnet sich ein Untermenü. Dieses enthält alle
Befehle, die Sie für benannte Bereiche benötigen.

Hinweis: Dieser Befehl ist nicht verfügbar, wenn mindestens ein Arbeitsblatt der Tabelle mit einem
Blattschutz versehen ist (siehe auch Abschnitt Blattschutz).

Ausführlichere Information zum Arbeiten mit Bereichen finden Sie auf den nächsten Seiten. Folgende The-
men werden darin behandelt:

¡ Namen festlegen und bearbeiten 

¡ Namen aus der Markierung automatisch festlegen

¡ Liste aller Namen ausgeben

¡ Namen in der Praxis einsetzen

¡ Namen nachträglich auf Berechnungen anwenden

Namen festlegen und bearbeiten

Namen festlegen

Um einem Zellbereich einen Namen zu geben, gehen Sie wie folgt vor:

1. Markieren Sie den Zellbereich, der benannt werden soll.

2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Bearbeiten auf.

3. Geben Sie in das Eingabefeld Name den gewünschten Namen ein.

4. Klicken Sie auf die Schaltfläche Hinzufügen.

Der markierte Zellbereich wurde nun mit dem angegebenen Namen versehen.
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Diesen Namen können Sie ab jetzt – stellvertretend für die Zellen im angegebenen Bereich – in Formeln
verwenden. Geben Sie zum Beispiel dem Bereich A2 bis A10 den Namen "Januar", ist die Rechenformel
=SUMME(Januar) gleichbedeutend mit =SUMME(A2:A10).

Hinweis: Namen für benannte Bereiche dürfen nur aus Buchstaben, Zahlen, Unterstrichen und Punkten
bestehen. Das erste Zeichen muss ein Buchstabe oder ein Unterstrich sein.

Weiterhin dürfen Namen nicht wie Zellbezüge aufgebaut sein. Der Name "A2" ist beispielsweise nicht
zulässig, da PlanMaker ihn nicht von der Adresse der Zelle A2 unterscheiden kann.

Tipp: Eine schnellere Methode

Folgendermaßen können Sie Namen noch schneller festlegen:

Links oberhalb der Tabelle befindet sich eine editierbare aufklappbare Liste, die normalerweise anzeigt, in
welcher Zelle sich der Zellrahmen gerade befindet. 

Sie können dort aber auch blitzschnell Bereiche benennen:

1. Markieren Sie den Zellbereich, der benannt werden soll.

2. Klicken Sie mit der Maus in diese editierbare Liste.

3. Tragen Sie den Namen ein, den der markierte Bereich erhalten soll.

4. Drücken Sie die Eingabetaste ¿.

Der markierte Bereich wurde nun mit dem eingegebenen Namen versehen.

Namen umbenennen oder löschen

Um einen benannten Bereich umzubenennen oder ihn zu löschen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Bearbeiten auf.

2. Selektieren Sie den gewünschten Namen in der Liste der Namen.

3. Um ihn umzubenennen, klicken Sie auf die Schaltfläche Umbenennen. Um ihn zu löschen, klicken Sie
auf Löschen.

Der Name wurde nun geändert beziehungsweise entfernt.

Hinweis: Wenn Sie einen Namen löschen, wird anschließend bei Formeln, die diesen Namen verwenden,
anstelle des Ergebnisses der Fehlerwert #NAME? zurückgegeben. War also beispielsweise ein Zellbe-
reich mit dem Namen "Januar" versehen, wird als Ergebnis der Formel =SUMME(Januar) jetzt #NAME?
angezeigt.
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Namen aus der Markierung automatisch festlegen

Wenn Sie Zellen markieren, die sowohl Werte als auch Zeilen- oder Spaltenüberschriften enthalten, können
Sie PlanMaker daraus entsprechend benannte Bereiche generieren lassen. Die Namen holt sich PlanMaker
dabei automatisch aus den Überschriften.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie den gewünschten Zellbereich. Dieser muss sowohl die Werte als auch die Überschriften,
die für die Namensgebung verwendet werden sollen, enthalten.

2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Übernehmen auf.

3. Es erscheint ein Dialog, in dem Sie angeben, in welcher Zeile und/oder Spalte sich die Überschriften be-
finden, die für die Namensgebung herangezogen werden sollen (siehe Beispiel).

4. Bestätigen Sie mit OK.

Die Namen wurden nun den Überschriften entsprechend festgelegt.

Ein Beispiel

Sie haben die folgende Tabelle erstellt:

Markieren Sie nun alle Werte und alle Bezeichnungen und rufen Sie den Menübefehl Arbeitsblatt > Na-
men > Übernehmen auf. Legen Sie dann fest, aus welcher Zeile und/oder Spalte Namen erzeugt werden
sollen:

¡ Wenn Sie nur die Option Oberste Zeile einschalten, gibt PlanMaker den Zellen unter Januar, Februar
und März automatisch den Namen "Januar", "Februar" beziehungsweise "März". 

¡ Wenn Sie nur die Option Linke Spalte einschalten, benennt PlanMaker die Zellen neben Kiel, Hamburg
und München mit "Kiel", "Hamburg" beziehungsweise "München".

¡ Sie können auch beide Optionen einschalten, worauf PlanMaker alle sechs oben aufgeführten Namen an-
legt.

Liste aller Namen ausgeben

Sie können PlanMaker anweisen, eine Liste aller benannten Bereiche in die Tabelle einzufügen. Dies ist
praktisch, wenn man einen Überblick haben möchte, welche benannten Bereiche sich in der Tabelle befin-
den und welche Zellen diese umfassen.

Gehen Sie dazu wie folgt vor:

1. Steuern Sie die Zelle an, an der die Liste eingefügt werden soll.
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2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Liste einfügen auf.

Es wird nun eine Liste aller benannten Bereiche in die Tabelle eingefügt.

Namen in der Praxis einsetzen

Wenn Sie mit dem Menübefehl Arbeitsblatt > Namen Zellbereiche benannt haben, können Sie verschiede-
ne Operationen wesentlich effizienter durchführen.

Folgendermaßen setzen Sie benannte Bereiche in der Praxis ein:

Schnelles Markieren eines benannten Bereichs

Links oberhalb des Tabellenfensters befindet sich eine aufklappbare Liste, die normalerweise anzeigt, in
welcher Zelle sich der Zellrahmen gerade befindet. 

Wenn Sie diese mit einem Mausklick auf das kleine Pfeilchen rechts daneben öffnen, werden alle vorhande-
nen Bereichsnamen angezeigt. Klicken Sie einen Namen an, wird der entsprechende Bereich sofort mar-
kiert.

Verwenden von Namen in Rechenformeln

Sie können den Namen eines Bereichs – stellvertretend für die Zellen, die sich darin befinden – in Rechen-
formeln verwenden. Dies spart Ihnen nicht nur Tipparbeit, sondern macht Formeln auch übersichtlicher.

Ein Beispiel:

In den Zellen A2 bis A10 haben Sie die Umsätze für den Monat Januar eingetragen. Diesem Bereich geben
Sie nun den Namen "Januar".

Wenn Sie nun die Summe aller Umsätze vom Januar ermitteln möchten, tippen Sie einfach:

=SUMME(Januar)

Darunter kann man sich schon wesentlich besser vorstellen, was diese Formel berechnet, als bei der Formel
=SUMME(A2:A10).

Natürlich können Sie nun auch die Umsätze für Februar, März etc. entsprechend benennen.

Tipp: Im Dialogfenster des Menübefehls Einfügen > Funktion gibt es in der Liste Kategorie auch einen
Eintrag namens "Benannte Bereiche". Wenn Sie diesen wählen, werden in der Liste Funktion alle be-
nannten Bereiche aufgelistet, so dass Sie diese bequem in Formeln einfügen können.
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Namen nachträglich auf Berechnungen anwenden

Der Befehl Anwenden im Untermenü des Menübefehls Arbeitsblatt > Namen ist ein nützlicher Helfer für
den Einsatz benannter Bereiche: Er durchsucht alle Formeln im markierten Bereich. Findet er innerhalb ei-
ner Formel einen Zellbezug, für den bereits ein Name definiert wurde, ersetzt er diesen durch den Namen.

Folgendermaßen setzen Sie diesen Befehl ein:

1. Markieren Sie den Tabellenbereich, dessen Formeln angepasst werden sollen. Wenn Sie nichts markie-
ren, wirkt sich diese Funktion auf die gesamte Tabelle aus.

2. Rufen Sie den Menübefehl Arbeitsblatt > Namen > Anwenden auf.

3. Selektieren Sie in der Liste Namen alle Namen, die angewandt werden sollen oder klicken Sie auf Alle
markieren, um alle Namen auszuwählen.

4. Bestätigen Sie mit OK.

PlanMaker durchsucht nun alle Zellbezüge, die in dem markierten Bereich vorkommen. Befinden sich darin
Zellbezüge, die benannt wurden, ersetzt er sie durch den entsprechenden Namen.

Ein Beispiel:

Sie haben den Bereich A2 bis A10 "Januar" genannt. In Ihrer Tabelle befindet sich eine Zelle mit der Be-
rechnung =SUMME(A2:A10). Setzen Sie nun den Menübefehl Arbeitsblatt > Namen > Anwenden ein,
wird die Formel in dieser Zelle in =SUMME(Januar) umgewandelt.

Die Option "Auch relative Bezüge umwandeln"

Im obigen Dialog gibt es eine Option namens Auch relative Bezüge umwandeln. Normalerweise sollten
Sie diese eingeschaltet lassen.

Diese Option hat folgende Bedeutung:

Wir haben Ihnen bisher der Einfachheit halber unterschlagen, dass sich Namen immer auf Zellbereiche mit
absoluter Adressierung (also beispielsweise $A$1:$A$10) beziehen. In Berechnungen verwendet man je-
doch meist die relative Adressierung (zum Beispiel A1:A10). 

Ist diese Option eingeschaltet, werden auch relativ adressierte Zellbezüge umgewandelt.

Wird die Option ausgeschaltet, werden nur absolut adressierte Zellbezüge umgewandelt.

Ein Beispiel:

Der Bereich von A1 bis A10 (genauer gesagt also $A$1:$A$10) wurde "Januar" genannt. Wenden Sie die
Funktion Anwenden nun auf die Berechnung =SUMME($A$1:$A$10) an, wird diese in jedem Fall in
=SUMME(Januar) umgewandelt. Wenden Sie sie jedoch auf die Berechnung =SUMME(A1:A10) an, wird
diese nur dann umgewandelt, wenn die Option Auch relative Bezüge umwandeln eingeschaltet ist.

Weitere Informationen zum Thema finden Sie im Abschnitt Relative und absolute Zellbezüge.
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Sortieren
Mit dem Menübefehl Arbeitsblatt > Sortieren können Sie einen Zellbereich sortieren lassen.

Gehen Sie wie folgt vor:

1. Markieren Sie den Zellbereich, der sortiert werden soll.

2. Rufen Sie den Menübefehl Arbeitsblatt > Sortieren auf.

3. Wählen Sie bei 1: die Spalte aus, nach der sortiert werden soll. 

4. Rechts daneben können Sie auch die Reihenfolge der Sortierung ändern: Aufsteigend (A bis Z) oder
Absteigend (Z bis A).

5. Bei Bedarf können Sie bei 2: und 3: noch weitere Spalten wählen, nach denen sortiert werden soll. 

Wählen Sie beispielsweise bei 1: eine Spalte mit Nachnamen und bei 2: eine Spalte mit Vornamen, wird
der Zellbereich nach Nachnamen und (innerhalb gleicher Nachnamen) außerdem nach Vornamen sor-
tiert.

6. Nehmen Sie bei Bedarf weitere Einstellungen vor, siehe unten.

Sobald Sie mit OK bestätigen, wird der Zellbereich entsprechend sortiert.

Optionen des Dialogs

Das Dialogfenster für diesen Befehl hat folgende Optionen:

¡ Spalte und Reihenfolge 

Wählen Sie zuerst hier die gewünschte(n) Spalte(n) aus, nach denen sortiert werden soll. 
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Sie können jeweils auch die Reihenfolge bestimmen: Aufsteigend (A bis Z) oder Absteigend (Z bis A).

Standardmäßig lassen sich bis zu drei Spalten festlegen. Sie können sogar noch weitere Spalten hinzufü-
gen, wenn Sie mehr als drei Sortierkriterien benötigen. Maximal sind 64 Spalten möglich. Gehen Sie da-
zu wie folgt vor:

Spalte hinzufügen: Klicken Sie auf die Schaltfläche mit dem Plus-Zeichen, um eine weitere Spalte
einzufügen.

Spalte anhängen: Klicken Sie auf die Schaltfläche Anhängen (unter der Liste), um eine weitere
Spalte unter allen anderen anzuhängen.

Spalte entfernen: Klicken Sie auf die Schaltfläche mit dem Minus-Zeichen, um die entsprechende
Spalte zu entfernen. (Dies funktioniert nur, wenn mehr als 3 Spalten vorhanden sind.)

¡ Zeilenweise sortieren oder Spaltenweise sortieren 

Diese Option bestimmt, ob zeilen- oder spaltenweise sortiert werden soll.

¡ Erste Zeile enthält Überschriften 

Wenn die erste Zeile (beziehungsweise Spalte) des markierten Zellbereichs Überschriften enthält, sollten
Sie diese Option einschalten. PlanMaker sortiert diese dann nicht mit.

Beispiel: Sie haben eine Adressenliste markiert, die Sie zeilenweise sortieren möchten. In der ersten Zei-
le der Markierung stehen Überschriften wie "Name", "Straße", "Ort" etc., darunter die Daten. Hier soll-
ten Sie diese Option einschalten, damit diese Zeile nicht mitsortiert wird, sondern weiterhin die erste
Zeile bleibt.

¡ Groß-/Kleinschreibung beachten 

Wenn Sie diese Option einschalten, wird beim Sortieren zwischen groß- und kleingeschriebenen Buch-
staben unterschieden. Dadurch landen beispielsweise alle Wörter, die mit einem Kleinbuchstaben begin-
nen, vor den Wörtern, die mit einem Großbuchstaben beginnen:

Aus: Apfel, birne, Clementine. Ein: birne, Apfel, Clementine.

¡ Umrandung/Schattierung mitsortieren 

Ist diese Option aktiviert, nimmt jede Zelle ihre Umrandung und Schattierung mit, wenn sie durch das
Sortieren verschoben wird. 

Ist sie ausgeschaltet, bleibt die ursprüngliche Formatierung der Zellen im markierten Zellbereich erhal-
ten, was Umrandungen und Schattierungen betrifft. 

Transponieren
Der Menübefehl Arbeitsblatt > Transponieren vertauscht die zeilen- und spaltenweise Anordnung der
markierten Zellen. Zeilen werden also zu Spalten, und Spalten werden zu Zeilen.

Markieren Sie den gewünschten Zellbereich, bevor Sie diesen Befehl anwenden.

Wichtig: Beachten Sie, dass beim Transponieren keinerlei Rechenformeln oder Bereichsnamen auf die
dadurch verschobenen Zelladressen angepasst werden – weder innerhalb noch außerhalb des transponier-
ten Bereichs!
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Text in Spalten aufteilen
Mit dem Menübefehl Arbeitsblatt > Text in Spalten aufteilen können Sie Text, der sich in einer Tabellen-
zelle befindet, auf mehrere Tabellenspalten aufteilen. Steht in dieser Zelle beispielsweise ein Satz, verteilt
dieser Befehl die einzelnen Wörter auf jeweils eine Spalte.

Wenden Sie diesen Befehl wie folgt an:

1. Navigieren Sie zu der Zelle, die den Text enthält, den Sie auf Spalten verteilen möchten. 

(Sie können auch mehrere Zellen markieren, wenn Sie die Inhalte mehrerer Zellen auf einmal auf Spal-
ten verteilen möchten.)

2. Rufen Sie den Menübefehl Arbeitsblatt > Text in Spalten aufteilen auf.

3. Es erscheint ein Dialogfenster mit einigen Optionen (siehe unten). 

In der Regel nimmt PlanMaker alle Einstellungen darin automatisch vor, und Sie brauchen nichts zu än-
dern.

4. Bestätigen Sie mit OK.

Der Text in der Zelle wird nun auf mehrere Spalten verteilt.

Optionen des Dialogs

Tipp: Die optimalen Einstellungen für dieses Dialogfenster werden nach Analyse des Zellinhalts automa-
tisch ermittelt und müssen in der Regel nicht verändert werden.

Das Dialogfenster für diesen Befehl hat folgende Optionen:

¡ Zielbereich 

Hier können Sie auf Wunsch einen anderen Zielbereich eintragen. Der verteilte Text landet dann nicht an
seiner ursprünglichen Position, sondern an der angegebenen Zielposition. 

Es genügt, die Adresse der Zelle in der linken oberen Ecke der Zielposition anzugeben.

¡ Trennzeichen 

Hier können Sie bei Bedarf festlegen, welches Zeichen PlanMaker als Trennzeichen ansehen soll. Ist in
die Zelle beispielsweise der Satz "Dies ist ein Test." eingetragen, wählt PlanMaker automatisch ein Leer-
zeichen als Trennzeichen, verteilt also jedes Wort auf eine Spalte. 

¡ Texterkennungszeichen 

Falls der Text in der Zelle mit Texterkennungszeichen versehen ist, können Sie hier einstellen, welches
Zeichen hierfür verwendet wurde (zum Beispiel Anführungszeichen). 

(Hintergrund: Die Text-Exportfunktion mancher Programme umgibt jedes Datenfeld mit einem solchen
Texterkennungszeichen, damit genau zu erkennen ist, wo jedes Feld beginnt und endet.)
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Filtern
Sie können einen Tabellenbereich markieren und dann die Daten darin anhand einer Filterbedingung "fil-
tern". Alle Zeilen, die dieser Bedingung nicht entsprechen, werden daraufhin ausgeblendet. 

Es gibt vier Befehle zum Filtern von Daten, die alle im Untermenü des Menübefehls Arbeitsblatt > Filter
zu finden sind:

¡ Der Befehl AutoFilter bietet Ihnen Möglichkeiten zum Filtern von Tabellenzeilen: Wenn Sie einen Zell-
bereich markieren und dann diesen Befehl aufrufen, wird von nun an über jeder Spalte dieses Zellbe-
reichs ein Pfeil angezeigt. Klicken Sie einen dieser Pfeile an, öffnet sich ein Menü mit allen Zellinhalten
dieser Spalte – und verschiedenen Bedingungen, nach denen Sie filtern können. 

¡ Der Befehl Spezialfilter öffnet ein Dialogfenster, in dem Sie eine oder mehrere Filterbedingungen for-
mulieren können. Nach Ihrem OK wird der Filter aktiv: Alle Zeilen im selektierten Bereich, die der Fil-
terbedingung nicht entsprechen, werden ausgeblendet. 

¡ Der Befehl Alles anzeigen zeigt alle ausgeblendeten Zellen wieder an, hebt die Wirkung sowohl des
Spezialfilters als auch des AutoFilters also auf.

¡ Mit dem Befehl Filter erneut anwenden können Sie auch nachträglich hinzugefügte Werte in dem Zell-
bereich eines aktiven AutoFilters aktualisieren (für Spezialfilter nicht möglich).

Ausführliche Informationen zu diesen Befehlen finden Sie auf den nächsten Seiten.

AutoFilter

Über den Menübefehl AutoFilter können Sie die Zeilen einer Tabelle filtern:

Wenn Sie einen Zellbereich markieren und dann den Befehl Arbeitsblatt > Filter > AutoFilter aufrufen,
wird von nun an über jeder Spalte dieses Zellbereichs ein Pfeil angezeigt. Klicken Sie einen dieser Pfeile
an, öffnet sich ein Menü mit allen Zellinhalten dieser Spalte – und verschiedenen Bedingungen, nach denen
Sie filtern können.

Anmerkung1: Das Einsetzen des Autofilters ist nur einmalig pro Arbeitsblatt möglich, es können keine
zwei unabhängigen Filter auf einem Arbeitsblatt gesetzt werden. Anderenfalls heben Sie den vorher an-
gewendeten Filter durch erneute Auswahl des Menübefehls AutoFilter wieder auf. Auf verschiedenen
Arbeitsblättern ist es allerdings durchaus möglich, jeweils einen eigenen AutoFilter anzuwenden.

Anmerkung2: Neu hinzugefügte oder aktualisierte Werte werden von den zuvor eingestellten Filterbe-
dingungen nicht automatisch einsortiert. Um auch geänderte Daten in bestehende AutoFilter zu integrie-
ren, benutzen Sie daher den Menübefehl Filter erneut anwenden.

Im Einzelnen gehen Sie zum Anwenden des AutoFilters wie folgt vor:

1. Markieren Sie den gewünschten Tabellenbereich. Wichtig: Die erste Zeile des Bereichs muss Über-
schriften für die darunter liegenden Daten enthalten.

2. Rufen Sie den Menübefehl Arbeitsblatt > Filter auf, worauf sich ein Untermenü öffnet. Wählen Sie
darin den Befehl AutoFilter.
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Die AutoFilter-Funktion ist nun aktiviert. Sie erkennen das daran, dass in der ersten Zeile des markierten
Bereichs ein nach unten weisender Pfeil für jede Spalte angezeigt wird. 

Klicken Sie einen solchen Pfeil an, öffnet sich ein Menü, das unter anderem eine Liste aller Zellinhalte ent-
hält, die in der entsprechenden Spalte vorkommen. Standardmäßig sind in dieser Liste alle Werte ausge-
wählt, es findet also keine Filterung statt.

Um eine Filterung durchzuführen, verwenden Sie dieses Menü wie folgt:

¡ Aufsteigend sortieren: Sortiert die Filterergebnisse des angewendeten AutoFilter-Bereichs in aufstei-
gender Reihenfolge. 

¡ Absteigend sortieren: Sortiert die Filterergebnisse des angewendeten AutoFilter-Bereichs in absteigen-
der Reihenfolge.

¡ Weitere Filter: Textfilter, Zahlenfilter und Datumsfilter öffnen ein Untermenü mit zusätzlichen Fil-
tern (siehe unten).

¡ (Alle): Dieser Menüeintrag ist ein praktischer Platzhalter: Mit seiner Hilfe können Sie mit einem einzi-
gen Klick alle Zellinhalte, die in der Spalte vorkommen, hinzufügen/entfernen. 

Das Häkchen vor dem Eintrag zeigt an, dass derzeit alle Zellinhalte in den Filter aufgenommen sind.

Klicken Sie nun den Eintrag (Alle) an, werden alle Zellinhalte auf einmal aus dem Filter entfernt (und
das Häkchen verschwindet). Klicken Sie ihn erneut an, werden wieder alle Zellinhalte in den Filter auf-
genommen (das Häkchen erscheint wieder).

Wenn nicht alle Zellinhalte in den Filter aufgenommen sind, aber mindestens ein Zellinhalt, wird anstatt
des Häkchens eine graue Fläche angezeigt.

¡ (Leer): Wenn sie in Ihrer Spalte leere Zellinhalte haben, können Sie mit dieser Auswahl alle leeren Zei-
len einblenden/ausblenden.

¡ Liste der Zellinhalte: Der wichtigste Teil: Hier werden alle Zellinhalte aufgelistet, die in der Spalte
vorkommen. Durch Anklicken eines Werts können Sie diesen in den Filter aufnehmen (es erscheint da-
nach ein Häkchen davor) beziehungsweise durch erneutes Anklicken wieder entfernen (das Häkchen ver-
schwindet).

Hinweis: Für die letzten 3 beschriebenen Optionen (Alle), (Leer) und Liste der Zellinhalte achten Sie
bitte stets darauf: Um Ihre Auswahl zu übernehmen, müssen Sie zur Bestätigung auf OK drücken.

Beispiel

Um beispielsweise einen Zellbereich so zu filtern, dass nur noch diejenigen Zeilen angezeigt werden, bei
denen in einer Spalte mit der Überschrift "Name" das Wort "Schmidt" steht, gehen Sie wie folgt vor:

Markieren Sie den Zellbereich (inklusive der Spaltenüberschriften) und rufen Sie den Menübefehl Arbeits-
blatt > Filter > AutoFilter auf, um den AutoFilter zu aktivieren.

Es erscheint nun ein Pfeilchen neben jeder Spaltenüberschrift. Klicken Sie auf das Pfeilchen für die Spalte
mit der Überschrift "Name", um das AutoFilter-Menü für diese Spalte zu öffnen.

Klicken Sie im AutoFilter-Menü zunächst auf den Menüeintrag (Alle), um alle Zellinhalte aus dem Filter zu
entfernen. Dann wählen Sie den Menüeintrag "Schmidt" und betätigen mit OK. Sie haben damit einen Filter
mit der Bedingung "Name entspricht Schmidt" definiert. Alle Zeilen, die dieser Filterbedingung nicht ent-
sprechen, werden nun ausgeblendet.
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Möchten Sie darüber hinaus noch alle Müllers aufgelistet bekommen, wählen Sie einfach zusätzlich den
Menüeintrag "Müller". Sollen die Müllers aus den Ergebnissen wieder verschwinden, klicken Sie den Ein-
trag "Müller" erneut an, um ihn wieder abzuwählen. Drücken Sie dabei jeweils auf OK zur Bestätigung.

Sie sehen: Die Einträge im Menü des AutoFilters können individuell zu dem Filter hinzugefügt und entfernt
werden, dabei sind beliebige Kombinationen möglich.

Weitere Filter: Textfilter, Zahlenfilter, Datumsfilter

Je nach Format-Kategorie der gefilterten Spalten setzt PlanMaker automatisch im AutoFilter-Menü weitere
Filteroptionen für Textfilter, Zahlenfilter oder Datumsfilter. Bei reinen Textwerten wird der Textfilter ange-
boten und bei reinen Datumswerten der Datumsfilter. Sind die Formate gemischt, wird der Zahlenfilter an-
gewendet.

Nutzen Sie den jeweiligen angebotenen Filter, um spezialisierte Filterbedingungen zu erhalten, zum Bei-
spiel:

Textfilter

¡ Entspricht...  Nur die Zeilen mit genauen Übereinstimmungen anzeigen. 

¡ Entspricht nicht...  Zeilen mit genauen Übereinstimmungen ausblenden. 

¡ Größer als...   Sie bekommen die Zeilen mit den Textwerten angezeigt, die alphabetisch hinter dem ein-
gegebenen Filterwert liegen.

¡ Größer oder gleich...  siehe oben, aber inklusive des eingegebenen Werts.

¡ Kleiner als...  Sie bekommen die Zeilen mit den Textwerten angezeigt, die alphabetisch vor dem einge-
gebenen Filterwert liegen.

¡ Kleiner oder gleich...  siehe oben, aber inklusive des eingegebenen Werts.

¡ Beginnt mit...  Nur die Zeilen mit bestimmten Wortanfängen anzeigen.

¡ Beginnt nicht mit...  Zeilen mit bestimmten Wortanfängen ausblenden.

¡ Endet mit...  Nur die Zeilen mit bestimmten Wortendungen anzeigen.

¡ Endet nicht mit...  Zeilen mit bestimmten Wortendungen ausblenden.

¡ Enthält...  Nur die Zeilen anzeigen, die eine bestimmte Textfolge als Teil des Textes haben.

¡ Enthält nicht...  Zeilen ausblenden, die eine bestimmte Textfolge als Teil des Textes haben.

Zahlenfilter

¡ Größer als...   Funktioniert wie der Operator > . Sie bekommen die Zeilen mit den Werten angezeigt, die
größer als der eingegebene Filterwert sind.

¡ Größer oder gleich...  
zeigt, die größer oder gleich dem eingegebenen Filterwert sind.

¡ Kleiner als...  Funktioniert wie der Operator < . Sie bekommen die Zeilen mit den Werten angezeigt, die
kleiner als der eingegebene Filterwert sind.

¡ Kleiner oder gleich...  
zeigt, die kleiner oder gleich dem eingegebenen Filterwert sind.

¡ Zwischen...  Definieren Sie hier, in welchem Zahlenbereich sich die Werte der Zeilen befinden, die an-
gezeigt werden sollen.
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¡ Nicht zwischen...  Definieren Sie hier, in welchem Zahlenbereich sich die Werte der Zeilen befinden,
die ausgeblendet werden sollen.

¡ Top 10... Nur noch diejenigen Zeilen anzeigen, bei denen sich in dieser Spalte beispielsweise einer der
10 höchsten (oder 10 niedrigsten) Werte befindet. Sie können diese Auswahl anpassen, nachdem sich
das Dialogfenster zu Top 10... geöffnet hat: Im linken Feld wählen Sie zwischen Obersten oder Unters-
ten Werten. Im mittleren Feld haben Sie die Möglichkeit, die Anzahl der Top-Werte einzustellen. Im
rechten Feld können Sie zwischen absoluten Werten (Elemente) und relativen Werten (Prozent) wählen.

Ein Beispiel: Sie wollen von 60 Werten die 50% der niedrigsten Werte erhalten, dann stellen Sie
folgendes ein:

Linkes Feld: Unterste   Mittleres Feld: 50   Rechtes Feld: Prozent

¡ Nur leere:  Nur die Zeilen anzeigen, bei denen der Wert in dieser Spalte leer ist.

¡ Nicht leere: Nur die Zeilen anzeigen, bei denen der Wert in dieser Spalte nicht leer ist.

¡ Über dem Durchschnitt: Nur noch Zeilen anzeigen, bei denen der Wert über dem Durchschnittswert
der Werte in dieser Spalte liegt.

¡ Unter dem Durchschnitt: Nur noch Zeilen anzeigen, bei denen der Wert unter dem Durchschnittswert
der Werte in dieser Spalte liegt.

Datumsfilter

¡ Entspricht...  Nur die Zeilen mit genauen Datums-Übereinstimmungen anzeigen. 

¡ Entspricht nicht...  Zeilen mit genauen Datums-Übereinstimmungen ausblenden. 

¡ Vor...  Nur die Zeilen anzeigen, in denen die Datumswerte vor dem eingegebenen Datumswert liegen.

¡ Vor oder ist gleich...  siehe oben, aber inklusive des eingegebenen Werts.

¡ Nach...  Nur die Zeilen anzeigen, in denen die Datumswerte nach dem eingegebenen Datumswert liegen.

¡ Nach oder ist gleich...  siehe oben, aber inklusive des eingegebenen Werts.

¡ Zwischen...  Nur die Zeilen anzeigen, in denen die Datumswerte innerhalb eines definierten Datumsbe-
reichs liegen.

¡ Nicht zwischen...  Die Zeilen ausblenden, in denen die Datumswerte innerhalb eines definierten Da-
tumsbereichs liegen.

¡ Tag, Woche, Monat, Quartal, Jahr: Hier stehen Ihnen weitere Auswahlmöglichkeiten zur Verfügung,
um schnell die gewünschten Datumsbereiche einzugrenzen.

Anmerkung: Wenn Sie den AutoFilter auf Datumswerte angewendet haben, erkennen Sie in der aufklappbaren Liste des AutoFilters, dass die
Einzeltage bereits auf Jahres- und Monatsebene einsortiert wurden. Klicken Sie auf das Plus-Zeichen vor der Jahres-/Monatsebene, um sie auf-
zuklappen und sich die dazugehörigen Einzelwerte anzuschauen. Haben Sie nun den Datums-"Baum" aufgeklappt und beispielsweise nur ein-
zelne Tageswerte aus einer bestimmten Datumsebene selektiert, so erscheint vor der dazugehörigen Datumsebene (Monat/Jahr) anstatt eines
Häkchens eine graue Fläche. Erst wenn alle vorhandenen Werte einer Datumsebene ausgewählt sind, erscheint auch ein Häkchen für diese Ebe-
ne. Wenn kein Wert einer Datumsebene ausgewählt ist, sehen Sie davor eine weiße Fläche. Damit können Sie auf einen Blick erkennen, ob alle,
keine oder einzelne Werte einer Datumsebene ausgewählt wurden.

Außerdem gibt es bei jeder der angebotenen Filtermöglichkeiten Textfilter, Zahlenfilter oder Datumsfilter
die folgenden Optionen:

¡ Benutzerdefiniert: Öffnet einen Dialog, in dem Sie individuelle Filterbedingungen anwenden können. 

¡ Filter entfernen: Diese Option wird erst aktiviert, wenn Kriterien über die Auswahl Textfilter, Zahlen-
filter oder Datumsfilter eingestellt wurden. Drücken Sie Filter entfernen, um genau diese angewendeten
Filter wieder aufzuheben.
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Alle ausgeblendeten Zeilen wieder einblenden

Wenn Sie möchten, dass alle per AutoFilter ausgeblendeten Zeilen wieder sichtbar werden, dann rufen Sie
den Menübefehl Arbeitsblatt > Filter > Alles anzeigen auf.

Filter erneut anwenden

Wenn sich Werte in dem durch Autofilter gesetzten Zellbereich geändert haben, können Sie mit dem Menü-
befehl Arbeitsblatt > Filter > Filter erneut anwenden die von Ihnen bereits definierte Auswahl aktuali-
sieren.

Sie haben beispielsweise bestimmt, dass alle Zeilen mit dem Namen "Schmidt" nicht angezeigt werden sol-
len und es wurden im Nachhinein weitere Einträge mit diesem Namen hinzugefügt. Mit dem Menübefehl
Filter erneut anwenden können Sie solche nachträglich entstandenen Einträge erneut herausfiltern und
müssen die Bedingungen des Filters nicht extra wieder neu definieren.

Besonders hilfreich ist diese Funktion natürlich speziell bei dynamischen Formel- und Datumswerten.

Autofilter ausschalten

Um die AutoFilter-Funktion gänzlich zu deaktivieren, rufen Sie den Menübefehl Arbeitsblatt > Filter >
AutoFilter noch einmal auf. Die Pfeile über dem Zellbereich verschwinden, und es werden wieder alle Zel-
len angezeigt.

Spezialfilter

Neben dem im vorherigen Abschnitt vorgestellten AutoFilter gibt es zusätzliche Möglichkeiten, die Daten
in einem Zellbereich anhand einer oder mehrerer kombinierbarer Bedingungen wesentlich komplexer zu fil-
tern: mit dem Menübefehl Arbeitsblatt > Filter > Spezialfilter.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie den gewünschten Tabellenbereich.

2. Rufen Sie den Menübefehl Arbeitsblatt > Filter auf, worauf sich ein Untermenü öffnet. Wählen Sie
darin den Befehl Spezialfilter.

3. Es erscheint ein Dialogfenster. Legen Sie darin eine oder mehrere Filterbedingungen fest (siehe unten).

4. Bestätigen Sie mit OK.

Nun werden alle Zeilen, die der Bedingung nicht entsprechen, ausgeblendet. 

Filterbedingungen formulieren

Um im Dialogfenster des Befehls Spezialfilter eine oder mehrere Filterbedingungen festzulegen, gehen Sie
wie folgt vor:

Wählen Sie in der Rubrik Bedingung 1 zunächst links die Spalte aus, der eine Bedingung zugeordnet wer-
den soll. Rechts daneben wählen Sie den Operator. Ganz rechts geben Sie schließlich den Vergleichswert
ein.
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Einige Beispiele:

¡ Die Bedingung "Spalte A entspricht Kiel" zeigt nur noch Einträge an, bei denen in der Spalte A das Wort
Kiel steht. 

¡ Bei der Bedingung "Spalte E größer oder gleich 100000" werden alle Einträge herausgefiltert, bei denen
die Spalte E einen Wert kleiner als 100000 enthält.

Reicht eine Bedingung nicht aus, so haben Sie die Möglichkeit, bis zu drei Bedingungen miteinander zu ver-
knüpfen, indem Sie zusätzlich die Rubriken Bedingung 2 und Bedingung 3 ausfüllen. 

Platzhalter verwenden: Die Zeichen * und ? können in Bedingungen als Platzhalter für beliebige andere Zei-
chen verwendet werden: * steht für eine beliebige Anzahl an beliebigen Zeichen, ? steht für ein einzelnes
beliebiges Zeichen. Die Bedingung "NAME entspricht M*er" trifft also beispielsweise auf die Namen
Müller, Meierhuber etc. zu, die Bedingung NAME = Me?er auf die Namen Meier, Meyer etc.

Optionen des Dialogs

Das Dialogfenster für Spezialfilter verfügt über folgende Optionen:

¡ Bereich enthält Überschriften 

Wenn die erste Zeile und/oder Spalte der markierten Zellen Überschriften enthält, sollten Sie diese Opti-
on einschalten. PlanMaker ignoriert diese Zeile/Spalte dann beim Filtern.

¡ Groß-/Kleinschreibung beachten 

Wenn diese Option eingeschaltet ist, wird die Groß-/Kleinschreibung in Bedingungen beachtet. Bei der
Bedingung "SPALTE A entspricht Meyer" passieren den Filter also nur Zeilen, bei denen in der Spalte A
"Meyer" steht. Zeilen mit "MEYER" oder "meyer" werden hingegen herausgefiltert.

¡ Modus 

Bestimmt, ob Zeilen oder Spalten gefiltert werden sollen.

Wählen Sie die Option Zeilenweise filtern, werden alle Zeilen herausgefiltert, die den Bedingungen
nicht entsprechen.

Wählen Sie hingegen die Option Spaltenweise filtern, werden alle Spalten herausgefiltert.

¡ Ergebnisse 

Bestimmt, ob der Filter auf die Originaldaten oder auf eine Kopie davon angewandt werden soll:

An Ort und Stelle filtern – Wählen Sie diese Option, werden die Originaldaten gefiltert. Zeilen/Spal-
ten, die der Filterbedingung nicht entsprechen, werden also genau an der Stelle ausgeblendet, wo Sie den
Filter gesetzt haben.

An folgende Stelle kopieren – Wählen Sie hingegen diese Option, wird eine Kopie der Originaldaten an
einer von Ihnen bestimmten Zelladresse erstellt. Diese Kopie enthält nur die gefilterten Daten und die
Originaldaten bleiben unverändert an ihrer Stelle bestehen. 

Geben Sie dazu in das Eingabefeld unter dieser Option ein, an welcher Stelle die Kopie eingefügt wer-
den soll. Sie können entweder eine einzelne Zelladresse angeben (hier wird dann die linke obere Ecke
der Kopie platziert) oder den Zellbereich genau festlegen, in den die Kopie gesetzt werden soll. Auch
das Kopieren in andere Arbeitsblätter ist möglich. Vorsicht: Passt die Kopie nicht in diesen Bereich hin-
ein, wird entsprechend abgeschnitten (Ausnahme: Sie geben eine einzelne Zelladresse als Einfügestelle
an).
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Alle ausgeblendeten Zeilen wieder einblenden

Wenn Sie möchten, dass alle per Filter ausgeblendeten Zeilen wieder sichtbar werden, dann rufen Sie den
Menübefehl Arbeitsblatt > Filter > Alles anzeigen auf.

Analysieren von Tabellen
In PlanMaker stehen Ihnen verschiedene Werkzeuge zum Analysieren der Zellinhalte und Rechenformeln in
einer Tabelle zur Verfügung. Diese können insbesondere bei der Fehlersuche sehr hilfreich sein.

Im Einzelnen gibt es hierfür folgende Werkzeuge:

¡ Formelanzeige 

Wenn Sie den Menübefehl Ansicht > Formelanzeige aufrufen, werden bei Berechnungen die Rechen-
formeln statt der Ergebnisse angezeigt.

¡ Syntaxhervorhebung 

Wenn Sie den Menübefehl Ansicht > Syntaxhervorhebung aufrufen, werden alle Zellinhalte Ihrem In-
halt entsprechend farblich gekennzeichnet. Zellen, die einen Fehler enthalten, erscheinen in roter Schrift,
Zellen mit einer Berechnung in grüner Schrift etc.

¡ Beobachtungsfenster für Zellinhalte 

Mit dem Menübefehl Ansicht > Beobachtungsfenster können Sie jederzeit ein Beobachtungsfenster für
Zellen einblenden. Mit dessen Hilfe lässt sich der Inhalt der gewählten Zellen permanent überwachen.

¡ Formelüberwachung 

Der Menübefehl Weiteres > Formelüberwachung bietet Funktionen zur grafischen Darstellung der Be-
ziehungen zwischen Zellen an. Enthält die aktuelle Zelle beispielsweise eine Rechenformel, die sich auf
andere Zellen bezieht, können Sie PlanMaker Pfeile zu diesen Zellen einblenden lassen.

Weiterhin lassen sich mit diesem Befehl Fehler in der Tabelle aufspüren oder ungültige Daten mit roten
Kringeln kennzeichnen.

Ausführliche Informationen zu diesen Funktionen finden Sie auf den nächsten Seiten.

Formelanzeige

Wenn Sie die Formelanzeige einschalten, werden bei Berechnungen die Rechenformeln statt der Ergebnisse
angezeigt. Dies kann bei der Analyse der Formeln in einer Tabelle und bei der Fehlersuche nützlich sein. 

Formelanzeige ein- und ausschalten

Um die Formelanzeige einzuschalten, rufen Sie den Menübefehl Ansicht > Formelanzeige auf. 

Wenn Sie den Befehl noch einmal aufrufen, wird sie wieder deaktiviert.
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Syntaxhervorhebung

Wenn Sie die Syntaxhervorhebung aktivieren, werden alle Zellinhalte Ihrem Inhalt entsprechend farblich
gekennzeichnet. Zellen, die einen Fehler enthalten, erscheinen in roter Schrift, Zellen mit einer Berechnung
in grüner Schrift etc.

So können Sie auf einen Blick sehen, wo sich Formeln befinden und wo fest eingegebene Werte, wo Fehler
auftreten usw.

Syntaxhervorhebung ein- und ausschalten

Um die Syntaxhervorhebung einzuschalten, rufen Sie den Menübefehl Ansicht > Syntaxhervorhebung
auf. 

Wenn Sie den Befehl noch einmal aufrufen, wird sie wieder deaktiviert.

Bedeutung der Vordergrundfarbe

Bei aktivierter Syntaxhervorhebung werden die Zellen mit folgenden Farben eingefärbt:

Zellinhalt Farbe

Fehlerwert Rot

Formel Grün

Fest eingegebene positive Zahl Dunkelblau

Fest eingegebene negative Zahl Hellblau

Fest eingegebener Wahrheitswert Braun

Fest eingegebene Zeichenkette Schwarz

Bedeutung der Hintergrundfarbe

Zellen, die einen Fehler enthalten, werden also in roter Farbe dargestellt. Bei schwerwiegenden Fehlern
wird die Zelle außerdem mit einem farbigen Hintergrund versehen. Dessen Farbe zeigt an, um welche Art
von Fehler es sich handelt:

Hintergrundfarbe Art des Fehlers

Weiß Die Formel liefert einen Fehlerwert. Die Berechnung in dieser Zelle liefert einen Fehler-
wert, weil sie beispielsweise eine Division durch Null enthält.

Abhilfe: Setzen Sie den Zellrahmen auf diese Zelle, worauf eine Fehlermeldung in der Sta-
tuszeile erscheint. Korrigieren Sie die Formel entsprechend.

Zyanblau Schwerwiegender Fehler in der Formel. Die Formel in dieser Zelle ist falsch formuliert,
weil beispielsweise eine schließende Klammer fehlt oder eine Funktion nicht mit den kor-
rekten Argumenten aufgerufen wurde.
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Abhilfe: Setzen Sie den Zellrahmen auf diese Zelle, worauf eine Fehlermeldung in der Sta-
tuszeile erscheint. Korrigieren Sie die Formel entsprechend. Wenn Sie dies nicht tun, wird
die Formel beim Speichern entfernt und durch den Fehlerwert #NULL! ersetzt!

Hellgrau Nicht exportierbare Funktion. Die Formel in dieser Zelle verwendet eine Rechenfunkti-
on, die das Dateiformat, in dem Sie das Dokument gespeichert haben, nicht unterstützt.

Abhilfe: Ersetzen Sie die Funktion durch eine andere Funktion, die zum gewünschten Da-
teiformat kompatibel ist. Informationen dazu finden Sie bei der Beschreibung der betref-
fenden Funktion.

Magentarot Möglicherweise falsch importierte Funktion. Die Formel in der Zelle enthält eine Re-
chenfunktion, die PlanMaker zwar bekannt ist, von ihm aber anders verwendet wird als von
der Vorgängerversion PlanMaker 97. Tritt beim Import von PlanMaker 97-Dokumenten
mit Zeit-Funktionen auf.

Abhilfe: Lesen Sie die Informationen bei der Beschreibung der betreffenden Funktion.

Gelb Unbekannte Funktion. Die Formel in dieser Zelle enthält eine Rechenfunktion, die
PlanMaker nicht bekannt ist. Tritt beim Import von Fremdformaten (z.B. Microsoft Excel)
auf.

Abhilfe: Ersetzen Sie die Funktion durch eine entsprechende PlanMaker-Funktion. Infor-
mationen über alle verfügbaren Rechenfunktionen finden Sie im Abschnitt Funktionen von
A-Z.

Beobachtungsfenster für Zellinhalte

Sie können jederzeit ein Beobachtungsfenster für Zellen einblenden. Mit dessen Hilfe lässt sich der Inhalt
der gewählten Zellen permanent überwachen. 

Beobachtungsfenster ein- und ausschalten

Um das Beobachtungsfenster einzublenden, rufen Sie den Menübefehl Ansicht > Beobachtungsfenster
auf. 

Wenn Sie den Befehl noch einmal aufrufen, wird das Fenster wieder ausgeblendet.
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Zellen zum Beobachtungsfenster hinzufügen

Um den Inhalt einer Zelle zu überwachen, fügen Sie diese dem Beobachtungsfenster hinzu. Gehen Sie dazu
wie folgt vor:

1. Klicken Sie im Beobachtungsfenster auf die Schaltfläche Zelle hinzufügen.

2. Geben Sie die Adresse der Zelle ein und bestätigen Sie mit OK.

Tipp: Sie können auch einen ganzen Zellbereich angeben. Tragen Sie als Adresse beispielsweise A1:A3
ein, werden die Zellen A1, A2 und A3 hinzugefügt.

Der Inhalt der angegebenen Zellen wird nun im Beobachtungsfenster angezeigt. Bei jeder Neuberechnung
der Tabelle wird auch das Beobachtungsfenster aktualisiert.

Zellen aus dem Beobachtungsfenster entfernen

Wenn Sie eine Zelle nicht mehr überwachen möchten, können Sie diese jederzeit aus dem Beobachtungs-
fenster entfernen. Selektieren Sie die Zelle dazu im Beobachtungsfenster und klicken Sie auf die Schaltflä-
che Zelle entfernen.

Sie können auch alle beobachteten Zellen auf einmal entfernen, indem Sie auf die Schaltfläche Alle entfer-
nen klicken.

Formelüberwachung

Der Menübefehl Weiteres > Formelüberwachung bietet Funktionen zur grafischen Darstellung der Bezie-
hungen zwischen Zellen an. Enthält die aktuelle Zelle beispielsweise eine Rechenformel, die sich auf andere
Zellen bezieht, können Sie PlanMaker Pfeile zu diesen Zellen einblenden lassen.

Weiterhin lassen sich mit diesem Befehl Fehler in der Tabelle aufspüren oder ungültige Daten mit roten
Kringeln kennzeichnen.

Wenn Sie den Menübefehl Weiteres > Formelüberwachung aufrufen, öffnet sich ein Untermenü, das ent-
sprechende Kommandos bereithält. Nach Themen geordnet stehen darin folgende Funktionen zur Verfü-
gung:

¡ Anzeigen der Beziehungen zwischen Zellen 

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, mit denen sich
die Beziehungen zwischen Zellen grafisch darstellen lassen. So können Sie beispielsweise Pfeile zu allen
Zellen einblenden, auf die sich die Rechenformel in der aktuellen Zelle bezieht. Enthält die Zelle also die
Berechnung =A1*A2, erscheinen Pfeile zu den Zellen A1 und A2.

¡ Selektieren der mit einer Zelle verbundenen Zellen 

Darüber hinaus gibt es Kommandos zum Selektieren aller Zellen, auf die sich die Rechenformel in der
aktuellen Zelle bezieht. Oder umgekehrt aller Zellen, die sich auf die aktuelle Zelle beziehen.

¡ Fehler in Berechnungen aufspüren 

Außerdem können Sie auf die vorherige oder nächste Zelle springen, die einen Fehlerwert enthält, und
Pfeile zur Quelle des Fehlers einblenden lassen.
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¡ Ungültige Daten in Zellen aufspüren 

Schließlich lassen sich alle Zellen aufspüren, deren Inhalt der Gültigkeitsprüfung für die entsprechende
Zelle nicht entspricht.

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten.

Tipp: Verwenden der Formelüberwachungsleiste

Am schnellsten lassen sich die Funktionen dieses Befehls über die Formelüberwachungsleiste aufrufen.

Sie können diese Leiste jederzeit ein- oder ausblenden, indem Sie den Menübefehl Weiteres > Formel-
überwachung > Formelüberwachungsleiste anzeigen aufrufen.

Die Leiste verfügt über folgende Schaltflächen (von links nach rechts):

¡ Spur zu den Vorgängern 
¡ Spuren zu den Vorgängern entfernen
¡ Spur zu den Nachfolgern
¡ Spuren zu den Nachfolgern entfernen
¡ Alle Spuren entfernen
¡ Spur zum Fehler

¡ Ungültige Daten markieren 
¡ Markierung für ungültige Daten entfernen

¡ Gehe zum vorhergehenden Fehler 
¡ Gehe zum nächsten Fehler
¡ Gehe zur vorhergehenden ungültigen Zelle
¡ Gehe zur nächsten ungültigen Zelle

Informationen zur Funktion der einzelnen Symbole folgen auf den nächsten Seiten.

Anzeigen der Beziehungen zwischen Zellen

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, mit denen sich die
Beziehungen zwischen Zellen grafisch darstellen lassen. 

Steuern Sie dazu die Zelle an, die Sie analysieren möchten, und rufen Sie dann eines der folgenden Kom-
mandos im Untermenü dieses Befehls auf:

¡ Spur zu den Vorgängern 

Dieser Befehl blendet Pfeile zu allen Zellen ein, auf die sich die Rechenformel in der aktuellen Zelle be-
zieht.
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Beispiel: Enthält die aktuelle Zelle die Berechnung =A1*A2, zeigt dieser Befehl Pfeile zu den Zellen A1
und A2 an.

¡ Spuren zu den Vorgängern entfernen 

Blendet alle Pfeile, die mit dem obigen Befehl eingeblendet wurden, für die aktuelle Zelle wieder aus.

¡ Spur zu den Nachfolgern 

Blendet Pfeile zu allen Zellen ein, die sich auf die aktuelle Zelle beziehen.

Beispiel: Enthält eine beliebige Zelle die Berechnung =B5*2, zeigt dieser Befehl einen Pfeil zu dieser
Zelle an, wenn Sie ihn in der Zelle B5 aufrufen.

¡ Spuren zu den Nachfolgern entfernen 

Blendet alle Pfeile, die mit dem obigen Befehl eingeblendet wurden, für die aktuelle Zelle wieder aus.

¡ Alle Spuren entfernen 

Blendet alle Pfeile, die mit den Befehlen Spur zu den Vorgängern oder Spur zu den Nachfolgern ein-
geblendet wurden, für die gesamte Arbeitsmappe wieder aus.

Anmerkungen und Tipps

¡ Sie können die Befehle Spur zu den Vorgängern und Spur zu den Nachfolgern in einer Zelle auch
mehrmals hintereinander aufrufen. Bei jedem Aufruf wird eine weitere Ebene von Beziehungen ange-
zeigt. 

¡ Die Pfeile, die sich mit obigen Befehlen einblenden lassen, sind anklickbar. Wenn Sie auf einen solchen
Pfeil klicken, springt PlanMaker zu der Zelle, die sich am anderen Ende des Pfeils befindet.

¡ Falls sich die aktuelle Zelle auf eine Zelle bezieht, die sich auf einem anderen Arbeitsblatt befindet, wird
nur ein kleiner Pfeil in der linken oberen Ecke der Zelle angezeigt. Auch diesen Pfeil können Sie ankli-
cken, um blitzschnell zu der entsprechenden Zelle zu gelangen.

¡ Wenn Sie den Inhalt einer Zelle bearbeiten, die Zelle löschen oder sie verschieben, werden alle Pfeile zu
dieser Zelle automatisch entfernt.

¡ Alle eingeblendeten Pfeile erscheinen auch im Ausdruck.

¡ Im Dokument werden die Pfeile allerdings nicht gespeichert. Wenn Sie das Dokument also speichern
und erneut öffnen, sind alle Pfeile wieder entfernt. 

Selektieren der mit einer Zelle verbundenen Zellen

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, mit denen Sie dieje-
nigen Zellen selektieren können, die eine Beziehung zur aktuellen Zelle haben.

Steuern Sie dazu die gewünschte Zelle an und rufen Sie dann eines der folgenden Kommandos im Unterme-
nü für diesen Befehl auf:

¡ Vorgänger selektieren 

Dieser Befehl selektiert alle Zellen, auf die sich die Rechenformel in der aktuellen Zelle bezieht.

Beispiel: Enthält die aktuelle Zelle die Berechnung =A1*A2, selektiert dieser Befehl die Zellen A1 und
A2.
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¡ Nachfolger selektieren 

Selektiert alle Zellen, die sich auf die aktuelle Zelle beziehen.

Beispiel: Enthält eine beliebige Zelle die Berechnung =B5*2, selektiert dieser Befehl diese Zelle, wenn
Sie ihn in der Zelle B5 aufrufen.

Fehler in Berechnungen aufspüren

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, mit denen sich Zel-
len finden und analysieren lassen, die einen Fehlerwert liefern. 

Anmerkung: Eine Zelle liefert dann einen Fehlerwert, wenn in der Berechnung, die sie enthält, ein Fehler
auftritt. Enthält eine Zelle beispielsweise eine Division durch Null, wird darin der Fehlerwert #DIV/0 ange-
zeigt. (Weitere Informationen zu Fehlerwerten finden Sie im Abschnitt Fehlerwerte.)

Verwenden Sie zur Fehlersuche die folgenden Kommandos im Untermenü des Menübefehls Weiteres >
Formelüberwachung:

¡ Spur zum Fehler 

Falls die aktuelle Zelle einen Fehlerwert enthält, blendet dieser Befehl Pfeile zu den Zellen ein, die die-
sen Fehlerwert versuchen (sofern anwendbar).

Beispiel: Wenn eine Zelle den Fehlerwert #DIV/0 liefert und sie diesen Befehl dort aufrufen, erscheinen
Pfeile auf die Zellen, die diese Division durch Null verursachen.

¡ Gehe zum vorhergehenden Fehler 

Springt zur vorherigen Zelle mit einem Fehlerwert.

¡ Gehe zum nächsten Fehler 

Springt zur nächsten Zelle mit einem Fehlerwert.

Ungültige Daten in Zellen aufspüren

Der Menübefehl Weiteres > Formelüberwachung bietet unter anderem Kommandos, mit denen sich Zel-
len aufspüren lassen, die einen ungültigen Wert enthalten.

Anmerkung: Eine Zelle enthält dann einen ungültigen Wert, wenn mit dem Menübefehl Format > Gültig-
keitsprüfung festgelegt wurde, dass die Zelle nur bestimmte Werte enthalten darf, und der aktuelle Zellin-
halt dieser Prüfung nicht entspricht. (Weitere Informationen dazu finden Sie im Abschnitt Gültigkeitsprü-
fung.)

Verwenden Sie zur Fehlersuche die folgenden Kommandos im Untermenü des Menübefehls Weiteres >
Formelüberwachung:

¡ Ungültige Daten markieren 

Dieser Befehl umgibt alle Zellen auf dem aktuellen Arbeitsblatt, die einen ungültigen Wert enthalten,
mit einem roten Kringel.
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¡ Markierung für ungültige Daten entfernen 

Entfernt alle Kringel (auf dem aktuellen Arbeitsblatt) wieder.

¡ Gehe zur vorhergehenden ungültigen Zelle 

Springt zur vorherigen Zelle mit einem ungültigen Wert.

¡ Gehe zur nächsten ungültigen Zelle 

Springt zur nächsten Zelle mit einem ungültigen Wert.

Anmerkungen

¡ Die Markierungen für ungültige Daten erscheinen auch im Ausdruck.  

¡ Im Dokument werden die Markierungen allerdings nicht gespeichert. Wenn Sie das Dokument also spei-
chern und erneut öffnen, sind alle Markierungen wieder entfernt. 

Aktualisieren von Tabellen
Sämtliche Berechnungen in einer Tabelle werden automatisch stets auf dem neuesten Stand gehalten. Dazu
rechnet PlanMaker jedes Mal, wenn Sie einen Zellinhalt abändern, die gesamte Tabelle neu durch. 

Normalerweise müssen Sie sich um dieses Thema also überhaupt nicht kümmern.

Deaktivieren der automatischen Neuberechnung

Bei Bedarf können Sie das automatische Neuberechnen aller Berechnungen auch abschalten. Dies ist bei-
spielsweise bei sehr rechenintensiven Tabellen nützlich, bei denen das Neuberechnen einige Zeit dauert.

Ändern Sie dazu die Einstellung Neuberechnung in den Dokumenteigenschaften entsprechend. Siehe Ab-
schnitt Dokumenteigenschaften, Karteikarte Berechnen.

Das Aktualisieren der Tabelle muss dann manuell erfolgen. Hierfür gibt es folgende Tasten beziehungswei-
se Menübefehle:

¡ Wenn Sie die Taste F9 betätigen oder den Menübefehl Weiteres > Neu berechnen aufrufen, aktualisiert
PlanMaker die Berechnungen auf allen Arbeitsblättern. 

¡ Wenn Sie hingegen Umschalt+F9 drücken, aktualisiert PlanMaker nur die Berechnungen auf dem aktu-
ellen Arbeitsblatt. 

Hinweis: Letzteres kann zu veralteten Ergebnissen führen, falls das aktuelle Arbeitsblatt Berechnun-
gen mit Zellen auf anderen Arbeitsblättern durchführt.

Aktualisieren externer Zellbezüge

Beachten Sie, dass externe Zellbezüge nicht bei jedem Neuberechnen der Arbeitsmappe aktualisiert wer-
den. 

(Externe Zellbezüge sind Zellbezüge, die sich auf Zellen in einer anderen Arbeitsmappe beziehen – also bei-
spielsweise ='C:\Mein Verzeichnis\[Meine Arbeitsmappe.pmdx]Tabelle1'!A1.)
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Solche Zellbezüge werden nur beim Öffnen des Dokuments, das die externen Bezüge enthält, automatisch
aktualisiert. Außerdem können Sie externe Bezüge jederzeit manuell aktualisieren.

Ausführliche Informationen zum Arbeiten mit externen Zellbezügen finden Sie im Abschnitt Externe Zell-
bezüge.

Kommentare einfügen
Mit dem Menübefehl Einfügen > Kommentar können Sie die aktuelle Tabellenzelle mit einem Kommen-
tar versehen – zum Beispiel: "Hier müssen noch die Daten vom Vorjahr eingetragen werden!".

Folgendermaßen arbeiten Sie mit Kommentaren:

Anbringen von Kommentaren

Um einen Kommentar anzubringen, steuern Sie die gewünschte Zelle an und rufen den Menübefehl Einfü-
gen > Kommentar auf. Es erscheint ein gelbes Rechteck, in das Sie den Kommentar eintippen. Um Ihre
Eingabe abzuschließen, klicken Sie an eine beliebige Stelle außerhalb des gelben Rechtecks oder drücken
die Taste Esc.

Kommentare werden im Dokument gespeichert, stehen also wieder zur Verfügung, wenn Sie das Dokument
das nächste Mal öffnen.

Ansehen von Kommentaren

Bei Zellen, die mit einem Kommentar versehen sind, wird in der rechten oberen Ecke ein gelbes Dreieck an-
gezeigt. Zeigen Sie mit der Maus auf eine solche Zelle, wird nach kurzer Zeit automatisch der Kommentar
eingeblendet. Er verschwindet wieder, wenn Sie die Maus aus der Zelle herausbewegen.

Ändern von Kommentaren

Um einen Kommentar abzuändern, rufen Sie den Menübefehl Einfügen > Kommentar in der betreffenden
Zelle noch einmal auf und nehmen die gewünschten Änderungen vor.

Tipp: Alternativ können Sie auch einen Doppelklick auf das gelbe Dreieck in der Zelle durchführen oder
die Tastenkombination Umschalt+F2 betätigen, um den Kommentar zu einer Zelle zu bearbeiten.

Wenn Sie mit den Änderungen fertig sind, klicken Sie an eine beliebige Stelle außerhalb des Kommentars
oder drücken die Taste Esc.

Löschen von Kommentaren

Um Kommentare von Zellen zu entfernen, markieren Sie die betreffenden Zellen und rufen den Menübefehl
Bearbeiten > Selektiv löschen auf. Es öffnet sich ein Untermenü, aus dem Sie die Option Kommentare
wählen. Die Kommentare werden daraufhin gelöscht.
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Zielwertsuche
Mit dem Menübefehl Weiteres > Zielwertsuche können Sie herausfinden, welchen Wert ein bestimmter
Bestandteil einer Berechnung annehmen muss, damit ein vorgegebenes Ergebnis herauskommt. 

Hinweis: Bei der Zielwertsuche handelt es sich nicht um "schwarze Magie" oder künstliche Intelligenz,
sondern um ein simples mathematisches Näherungsverfahren (Iterationsverfahren) – und wie bei allen
Näherungsverfahren muss das Ergebnis nicht unbedingt exakt sein.

Steuern Sie, bevor Sie diesen Befehl aufrufen, mit dem Zellrahmen die Zelle an, in der die Rechenformel
enthalten ist.

Nach dem Aufruf meldet sich der Befehl mit einem Dialogfenster. Dieses wird wie folgt bedient:

¡ In Formelzelle geben Sie – sofern PlanMaker nicht schon den richtigen Eintrag ermitteln konnte – die
Adresse der Zelle mit der Rechenformel ein.  

¡ In Zielwert tippen Sie das gewünschte Ergebnis ein.

¡ In Variable Zelle tippen Sie die Adresse derjenigen Zelle ein, in der PlanMaker so lange verschiedene
Werte ausprobieren soll, bis in der Formelzelle das gewünschte Ergebnis steht.

¡ Bei Genauigkeit können Sie die Genauigkeit der Annäherung festlegen. PlanMaker wird solange versu-
chen, Werte anzunähern, bis der Unterschied zum Zielwert kleiner als der Parameter Genauigkeit ist. 

Wenn PlanMaker auch nach mehreren Sekunden keinen ausreichend genauen Wert finden kann, so lässt
sich dieser nicht durch Näherung ermitteln. PlanMaker bricht die Suche dann ab.

Ein Beispiel

In der weiter unten abgebildeten Tabelle wurde in Zelle A5 die Summenfunktion verwendet, um die Zahlen
1, 2 und 3 in den Zellen A2, A3 und A4 zu addieren. Als Ergebnis in A5 kommt 6 heraus. Wir möchten nun
wissen, auf welchen Wert beispielsweise die Zelle A3 geändert werden muss, damit das Ergebnis der Addi-
tion 7 ist. 

Wir steuern dazu die Zelle mit der Berechnung an, deren Ergebnis wir verändern möchten – hier also die
Zelle A5 mit der Summenformel – und rufen die Zielwertsuche auf.
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In der Abbildung sehen Sie, wie das Dialogfenster für die Berechnung ausgefüllt werden muss. Nach Ihrem
OK startet PlanMaker die Annäherung und meldet das Ergebnis 3 in einem Dialogfenster.

Der Inhalt der Zelle A3 muss also von 2 auf 3 geändert werden, damit die Berechnung das Ergebnis 7 hat.
Wenn Sie in dem Dialogfenster auf Übernehmen klicken, wird der gefundene Wert in Zelle A3 übernom-
men.

Szenarien
Der Menübefehl Weiteres > Szenarien erlaubt das Anlegen und Anzeigen von "Szenarien".

Mit Hilfe von Szenarien können Sie beobachten, welche Auswirkungen das Ändern der Werte in bestimm-
ten Zellen auf die Berechnungen in einem Arbeitsblatt hat. Dies ermöglicht das Durchführen von "Was-wä-
re-wenn"-Analysen aller Art.

Beispiel: Wie ändern sich die Gesamtkosten eines Kredits, wenn die Laufzeit 24, 36 oder 96 Monate be-
trägt?

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Szenarien. Folgende Themen wer-
den darin behandelt:

¡ Erstellen von Szenarien 

¡ Anzeigen von Szenarien

¡ Verwalten von Szenarien

¡ Zusammenführen von Szenarien

¡ Anlegen eines Szenarioberichts

Lesen Sie dazu die nächsten Seiten.
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Erstellen von Szenarien

Um Szenarien zu erstellen, füllen Sie zunächst ein Arbeitsblatt mit den gewünschten Werten und Berech-
nungen aus.

Dann gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Szenarien auf.

2. Klicken Sie auf Hinzufügen.

3. Geben Sie bei Szenarioname einen beschreibenden Namen für das Szenario ein.

4. Geben Sie bei Veränderbare Zellen die Adresse der Zelle ein, deren Inhalt verändert werden soll. 

Sie können auch mehrere Zellen angeben. Trennen Sie die Zelladressen dazu mit einem Strichpunkt –
zum Beispiel: A2;A4;A10. Auch Zellbereiche wie B5:B10 sind erlaubt.

5. Klicken Sie auf die Schaltfläche Weiter, um fortzufahren.

6. Es erscheint ein weiterer Dialog. Tragen Sie darin den Wert ein, der in diesem Szenario in die "veränder-
bare Zelle" eingesetzt werden soll.

Falls Sie in dem Szenario mehrere veränderbare Zellen definiert haben, enthält dieser Dialog eine Liste
all dieser Zellen. Klicken Sie darin auf jeden einzelnen Listeneintrag und tragen Sie daneben jeweils den
gewünschten Zellwert ein.

7. Klicken Sie auf Fertigstellen, um das Anlegen dieses Szenarios abzuschließen.

8. Wiederholen Sie die Schritte 2. bis 7. für alle weiteren Szenarien, die Sie anlegen möchten.

9. Wenn Sie fertig sind, verlassen Sie den Dialog mit Schließen.

Die gewünschten Szenarien wurden nun angelegt. Um zu erfahren, wie Sie diese anzeigen, lesen Sie bitte
den nächsten Abschnitt.

Optionen des Dialogs

Im Dialogfenster für das Hinzufügen von Szenarien gibt es folgende zusätzlichen Optionen:

¡ Kommentar 

Hier können Sie einen beschreibenden Kommentar für das Szenario eingeben.

¡ Änderungen verhindern 

Ist diese Option eingeschaltet, lässt sich das Szenario nicht mehr bearbeiten oder löschen, wenn Sie den
Blattschutz aktivieren.

¡ Ausblenden 

Ist diese Option eingeschaltet, wird das Szenario nicht mehr in der Liste der Szenarien angezeigt, wenn
Sie den Blattschutz aktivieren.

Allgemeine Informationen zum Verwenden eines Blattschutzes finden Sie im Abschnitt Blattschutz.
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Anzeigen von Szenarien

Wenn Sie, wie im vorherigen Abschnitt beschrieben, Szenarien angelegt haben, können Sie diese jederzeit
anzeigen.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Befehl Weiteres > Szenarien auf.

2. Wählen Sie das anzuzeigende Szenario in der Liste Szenarien.

3. Klicken Sie auf Anzeigen.

Tipp: Schneller geht dies, wenn Sie in der Liste einfach einen Doppelklick auf das anzuzeigende Sze-
nario durchführen.

Das gewählte Szenario wird nun angezeigt. 

Durch das Wechseln zwischen verschiedenen Szenarien können Sie nun also vergleichen, wie sich das Än-
dern der im Szenario festgelegten Zellen jeweils auf die Berechnungen auswirkt, die sich auf diese Zellen
beziehen.

Hinweis: Beim Anzeigen eines Szenarios werden die Werte in den angegebenen "veränderbaren Zellen"
physikalisch durch die Werte ersetzt, die im Szenario festgelegt wurden. Die alten Zellinhalte gehen für die-
se Zellen also verloren.

Verwalten von Szenarien

Sie können den Menübefehl Weiteres > Szenarien auch verwenden, um die im aktuellen Arbeitsblatt ange-
legten Szenarien zu verwalten. 

Verwenden Sie dazu die folgenden Schaltflächen im Dialogfenster für diesen Befehl:

¡ Hinzufügen 

Legt ein neues Szenario an.

Siehe dazu Abschnitt Erstellen von Szenarien.

¡ Löschen 

Löscht das momentan in der Liste gewählte Szenario.

¡ Bearbeiten 

Öffnet einen Dialog, in dem Sie die Einstellungen für das gewählte Szenario bearbeiten können. Wenn
Sie darin auf die Schaltfläche Weiter klicken, erscheint ein weiterer Dialog, in dem Sie die Werte für die
veränderbaren Zellen ändern können.

¡ Zusammenführen 

Führt Szenarien, die sich in anderen Arbeitsblättern (oder Arbeitsmappen) befinden, auf dem aktuellen
Arbeitsblatt zusammen. 
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Siehe dazu Abschnitt Zusammenführen von Szenarien.

¡ Zusammenfassung 

Erstellt einen Bericht, in dem die Werte in den veränderbaren Zellen und die Werte in beliebigen "Er-
gebniszellen" für alle Szenarien direkt miteinander verglichen werden können.

Siehe dazu Abschnitt Anlegen eines Szenarioberichts.

Zusammenführen von Szenarien

Sie können den Menübefehl Weiteres > Szenarien auch verwenden, um Szenarien, die sich in anderen Ar-
beitsblättern (oder gar anderen Arbeitsmappen) befinden, auf dem aktuellen Arbeitsblatt zusammenzufüh-
ren.

Hinweis: Damit dies funktioniert, sollten alle Arbeitsblätter, deren Szenarien Sie zusammenführen möch-
ten, den gleichen Aufbau haben und in ihren Szenarien die gleichen veränderbaren Zellen verwenden.

Um Szenarien zusammenzuführen, gehen Sie wie folgt vor:

1. Öffnen Sie die Arbeitsmappen, in denen sich die Szenarien befinden, die Sie zusammenführen möchten.

2. Wechseln Sie zu der Arbeitsmappe und dem Arbeitsblatt, auf dem die Szenarien zusammengeführt wer-
den sollen.

3. Rufen Sie den Menübefehl Weiteres > Szenarien auf.

4. Klicken Sie auf Zusammenführen.

5. Wählen Sie die Arbeitsmappe und das Arbeitsblatt, auf dem sich die gewünschten Szenarien befinden.

6. Bestätigen Sie mit OK.

7. Wiederholen Sie die Schritte 4. bis 6. für alle weiteren Szenarien, die Sie zusammenführen möchten.

Alle gewählten Szenarien stehen nun auf dem aktuellen Arbeitsblatt zur Verfügung. 

Anlegen eines Szenarioberichts

Sie können den Menübefehl Weiteres > Szenarien auch verwenden, um einen Szenariobericht für alle im
aktuellen Arbeitsblatt vorhandenen Szenarien anzulegen. 

Ein Szenariobericht listet alle Szenarien übersichtlich nebeneinander auf. Für jedes Szenario werden sowohl
die veränderbaren Zellen als auch beliebige "Ergebniszellen" (mit den Berechnungen, die Sie betrachten
möchten) angezeigt.

Solche Berichte sind nützlich, um die veränderbaren Werte und die resultierenden Ergebnisse von Szenarien
auf einen Blick miteinander vergleichen zu können.

Um einen Szenariobericht zu erzeugen, gehen Sie wie folgt vor:

1. Legen Sie, wie im Abschnitt Erstellen von Szenarien beschrieben, die gewünschten Szenarien an.
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2. Rufen Sie den Menübefehl Weiteres > Szenarien auf.

3. Klicken Sie auf Zusammenfassung.

4. Geben Sie die Adresse der gewünschten Ergebniszelle ein. Das ist eine beliebige Zelle mit der Berech-
nung, die Sie in Ihren Szenarien betrachten möchten.

Sie können auch mehrere Zellen angeben. Trennen Sie die Zelladressen dazu mit einem Strichpunkt –
zum Beispiel: A2;A4;A10. Auch Zellbereiche wie B5:B10 sind erlaubt.

5. Bestätigen Sie mit OK.

PlanMaker legt nun ein neues Arbeitsblatt an und erzeugt dann darin den Szenariobericht.

Hinweis: Szenarioberichte werden nicht automatisch aktualisiert, wenn Sie Zellinhalte oder die Einstel-
lungen von Szenarien verändern. Um einen Szenariobericht zu aktualisieren, löschen Sie das Arbeitsblatt,
das den Bericht enthält, und erzeugen den Bericht dann noch einmal.

Konsolidieren von Daten
Mit dem Menübefehl Arbeitsblatt > Daten konsolidieren können Sie Daten aus einem oder mehreren Zell-
bereichen auswerten, um beispielsweise die Summe der einzelnen Daten über all diese Bereiche hinweg zu
ermitteln.

Dafür legen Sie zunächst die "Quellbereiche" für die Konsolidierung fest. Dies können beliebige Zellberei-
che mit den auszuwertenden Daten sein. Sie können sich allesamt im aktuellen Arbeitsblatt befinden, oder
auf mehrere Arbeitsblätter oder gar mehrere Dateien verteilt sein. Für die Auswertung steht eine Vielzahl
von Statistikfunktionen zur Verfügung: Summe, Minimum, Durchschnitt etc.

Das Ergebnis der Auswertung wird – als feste Zahlenwerte – in den angegebenen "Zielbereich" eingefügt.
Beachten Sie: Diese Werte werden nicht aktualisiert, wenn sich an den Zahlen in den Quellbereichen etwas
ändert. Dieser Befehl ist also in erster Linie dann nützlich, wenn man den aktuellen Stand von Daten aus-
werten und Änderungen nicht mehr berücksichtigen möchte (z.B. bei Monatsberichten etc.).
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In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Konsolidierungen. Folgende The-
men werden darin behandelt:

¡ Konsolidieren von Daten anhand ihrer Position 

Im einfachsten Fall werden Daten anhand ihrer Position konsolidiert. Dies funktioniert wie folgt: 

Sie haben z.B. drei Quellbereiche, die alle identisch aufgebaut und gleich groß sind. In jedem der Berei-
che befinden sich die einzelnen Daten also jeweils an der gleichen (relativen) Position.

Beim Konsolidieren wird nun die erste Zelle (links oben) im ersten Bereich zur ersten Zelle im zweiten
und dritten Bereich addiert. Das Ergebnis erscheint als erste Zelle im Zielbereich. Dann wird das gleiche
mit allen anderen Zellen in den Quellbereichen durchgeführt.

¡ Konsolidieren von Daten anhand ihrer Beschriftungen 

Darüber hinaus kann diese Funktion auch nach Beschriftungen konsolidieren. Dies funktioniert wie
folgt: 

Es können ein oder mehrere Quellbereiche vorliegen, die eines gemein haben: Jeder einzelne Wert ist
mit einer Beschriftung versehen – beispielsweise in der Zelle links von ihm. 

Wenn Sie nun beim Konsolidieren die Option Beschriftungen in linker Spalte einschalten, addiert
PlanMaker alle Werte, bei denen sich links die gleiche Beschriftung befindet. 

Dabei darf die gleiche Beschriftung beliebig oft vorkommen. Die Größe der Quellbereiche und die Rei-
henfolge der Daten spielen keine Rolle. PlanMaker erkennt schließlich anhand der Beschriftungen, wel-
che Werte addiert werden sollen.

¡ Bearbeiten und Aktualisieren von Konsolidierungen 

Wenn Sie mit dem Menübefehl Arbeitsblatt > Daten konsolidieren eine Konsolidierung durchführen,
merkt sich PlanMaker alle Einstellungen, die Sie im Konsolidieren-Dialog vorgenommen haben (und
zwar pro Arbeitsblatt).

Dies ermöglicht es Ihnen, diesen Befehl jederzeit erneut aufzurufen, gegebenenfalls Einstellungen für
die Konsolidierung zu ändern und diese dann erneut durchzuführen. 
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Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Konsolidieren von Daten anhand ihrer Position

Wie in der Einleitung des Abschnitts Konsolidieren von Daten erläutert, können Sie mit dem Befehl Daten
konsolidieren Daten aus einem oder mehreren Zellbereichen konsolidieren – diese Daten also auswerten
und beispielsweise die Summe der einzelnen Daten ermitteln.

Im einfachsten Fall werden Daten anhand ihrer Position konsolidiert. Dies funktioniert wie folgt: 

Sie haben z.B. drei "Quellbereiche", die alle identisch aufgebaut und gleich groß sind. In jedem der Berei-
che befinden sich die einzelnen Daten also jeweils an der gleichen (relativen) Position.

Beim Konsolidieren wird nun die erste Zelle (links oben) im ersten Bereich zur ersten Zelle im zweiten und
dritten Bereich addiert. Das Ergebnis erscheint als erste Zelle im "Zielbereich". Dann wird das gleiche mit
allen anderen Zellen in den Quellbereichen durchgeführt.

Beispiel

Die Tageserlöse zweier Obstläden sollen, aufgeteilt nach Obstsorten, mittels Summenfunktion konsolidiert
werden. 

Dazu wurden die Erlöse der beiden Läden in eine Tabelle eingetragen. In der Abbildung sieht man diese
Daten in den Zellbereichen C3:C5 und C8:C10.

Dann wurde der Befehl Daten konsolidieren aufgerufen und diese beiden Bereiche als Quellbereiche hin-
zugefügt. Der Zielbereich wurde auf C13:C15 gesetzt (in der Abbildung selektiert) und die Konsolidierung
gestartet. 

Ergebnis: Im Zielbereich erscheinen die Summen der Tageserlöse (ebenfalls wieder pro Obstsorte, genau
wie in den Quellbereichen).
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Durchführen der Konsolidierung

Um Daten anhand ihrer Position zu konsolidieren, gehen Sie im Einzelnen wie folgt vor:

1. Tragen Sie die zu konsolidierenden Daten in einzelne Zellbereiche ein, die allesamt gleich aufgebaut
sind. Die Daten müssen also in jedem dieser Bereiche gleich angeordnet sein.

Die einzelnen Zellbereiche können sich alle auf dem gleichen Arbeitsblatt, in mehreren Arbeitsblättern
oder sogar in mehreren unterschiedlichen Dokumenten befinden.

2. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf.

3. Klicken Sie in das Eingabefeld Quellbereiche. Tragen Sie dort die Adresse des ersten Zellbereichs mit
den zu konsolidierenden Daten ein. (Siehe auch Anmerkungen weiter unten.)

Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken und den Zellbereich darin
einfach mit der Maus selektieren.

4. Klicken Sie auf die Schaltfläche Hinzufügen.

5. Um weitere Zellbereiche zu den Quellbereichen hinzuzufügen, wiederholen Sie die Schritte 3. und 4. 

6. Tragen Sie bei Zielbereich die Adresse des Zellbereichs ein, in dem das Ergebnis der Konsolidierung er-
scheinen soll.

Tipp: Es genügt, die Adresse der Zelle anzugeben, in der sich die linke obere Ecke des Zielbereichs be-
finden soll. PlanMaker ermittelt die korrekte Größe dann automatisch.

Tipp: Sie können die gewünschte Zelle auch einfach in der Tabelle anklicken, um ihre Adresse in den
Dialog zu übertragen.

7. Wählen Sie bei Funktion, welche Rechenfunktion für die Konsolidierung verwenden werden soll.

8. Die Optionen Beschriftung in... müssen bei dieser Art der Konsolidierung unbedingt ausgeschaltet blei-
ben. (Mehr zu diesen Optionen im Abschnitt Konsolidieren von Daten anhand ihrer Beschriftungen.)

9. Klicken Sie auf Anwenden, um den Vorgang zu starten.

Die Daten aus den Quellbereichen werden nun mit der gewählten Rechenfunktion konsolidiert, und das Er-
gebnis wird im Zielbereich eingefügt.

Hinweis: Das Ergebnis der Konsolidierung wird in Form von festen Zahlenwerten eingefügt. Diese wer-
den nicht aktualisiert, wenn sich an den Werten in den Quellbereichen etwas ändert. 

Dieser Befehl ist also in erster Linie dann nützlich, wenn man den aktuellen Stand der Daten auswerten
und Änderungen nicht mehr berücksichtigen möchte (z.B. bei Monatsberichten). Siehe auch Abschnitt
Bearbeiten und Aktualisieren von Konsolidierungen.

Anmerkungen zum Festlegen der Quellbereiche

Wenn Sie im oben beschrieben Dialogfenster in das Eingabefeld Quellbereiche klicken, haben Sie folgende
Möglichkeiten, einen Quellbereich hinzuzufügen:

¡ Quellbereich im aktuellen Arbeitsblatt 

Wenn Sie einen Zellbereich zu den Quellbereichen hinzufügen möchten, der sich im aktuellen Arbeits-
blatt befindet, geben Sie einfach dessen Adresse oder Namen ein. 

Beispiel: D2:G5
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Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken und den Zellbereich darin
mit der Maus selektieren. 

¡ Quellbereich in einem anderen Arbeitsblatt 

Wenn Sie einen Zellbereich hinzufügen möchten, der sich in einem anderen Arbeitsblatt befindet, stellen
Sie der Adresse wie üblich den Namen des Arbeitsblatts und ein Ausrufezeichen voran.

Beispiel: Tabelle3!D2:G5

Tipp: Auch hier können Sie den Zellbereich einfach mit der Maus selektieren. Klicken Sie zuvor im Ar-
beitsblattregister auf das gewünschte Arbeitsblatt.

¡ Quellbereich in einem anderen Dokument 

Wenn Sie einen Zellbereich hinzufügen möchten, der sich in einem anderen Dokument befindet, tragen
Sie dessen Adresse so ein, wie es im Abschnitt Externe Zellbezüge beschrieben wurde.

Beispiel: 'C:\Mein Verzeichnis\[Meine Arbeitsmappe.pmdx]Tabelle3'!D2:G5

Tipp: Den ersten Teil der Adresse, der den Pfad und Dateinamen enthält, brauchen Sie nicht von Hand
einzugeben. Klicken Sie einfach auf die Schaltfläche Datei, worauf ein Dateidialog erscheint, in dem Sie
die gewünschte Datei auswählen können.

Vergessen Sie nicht, nach dem Eingeben der Adresse für einen Quellbereich jeweils auf Hinzufügen zu kli-
cken.

Konsolidieren von Daten anhand ihrer Beschriftungen

Wie in der Einleitung des Abschnitts Konsolidieren von Daten erläutert, können Sie mit dem Befehl Daten
konsolidieren Daten aus einem oder mehreren Zellbereichen konsolidieren – diese Daten also auswerten
und beispielsweise die Summe der einzelnen Daten ermitteln.

Neben dem Konsolidieren von Daten anhand ihrer Position (siehe vorheriger Abschnitt) lassen sich Daten
auch anhand ihrer Beschriftungen konsolidieren. Dies funktioniert wie folgt:

Die auszuwertenden Daten können in beliebig vielen "Quellbereichen" abgelegt sein – die allesamt eines
gemein haben sollten: Jeder darin enthaltene Wert ist mit einer Beschriftung versehen (beispielsweise in der
Zelle links von ihm).

Wenn Sie nun beim Konsolidieren die Option Beschriftungen in linker Spalte einschalten, addiert
PlanMaker alle Werte, bei denen sich links die gleiche Beschriftung befindet. 

Dabei darf die gleiche Beschriftung beliebig oft vorkommen. Die Größe der einzelnen Quellbereiche und
die Reihenfolge der Daten darin spielen keinerlei Rolle. PlanMaker erkennt schließlich anhand der Beschrif-
tungen, welche Daten konsolidiert werden sollen.

Beispiel

Ein Obststand bietet verschiedene Sorten Obst an. Jeder einzelne Verkauf im Laufe eines Tages wird in ei-
ner Tabelle erfasst. Nun soll ausgerechnet werden, wie viel insgesamt von jeder Obstsorte verkauft wurde.
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Die einzelnen Obstsorten kommen hierbei natürlich in völlig zufälliger Reihenfolge vor, aber das stört den
Konsolidieren-Befehl überhaupt nicht:

Rufen Sie einfach den Befehl Daten konsolidieren auf. Fügen Sie den Zellbereich mit den einzelnen Ver-
käufen als Quellbereich hinzu (hier also B3:C11). Beachten Sie: Dieser muss die Zahlen und deren Be-
schriftungen enthalten! Dann wählen Sie einen beliebigen Zielbereich für das Ergebnis (in der Abbildung
B14:C16) und bestätigen.

Ergebnis: Im Zielbereich erscheinen die Summen der Verkäufe der einzelnen Obstsorten.

Durchführen der Konsolidierung

Um Daten anhand ihrer Beschriftungen zu konsolidieren, gehen Sie wie im Einzelnen folgt vor:

1. Tragen Sie die zu konsolidierenden Daten in einen oder mehrere Zellbereiche ein. Deren Aufbau und
Größe spielt keine Rolle – allerdings sollten die zu konsolidierenden Werte allesamt eine Beschriftung
haben: entweder in der Spalte links der Werte und/oder in der Zeile oberhalb der Werte.

Die einzelnen Zellbereiche können sich alle auf dem gleichen Arbeitsblatt, in mehreren Arbeitsblättern
oder sogar in mehreren unterschiedlichen Dokumenten befinden.

2. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf.

3. Klicken Sie in das Eingabefeld Quellbereiche. Tragen Sie dort die Adresse des Zellbereichs mit den zu
konsolidierenden Daten ein. (Siehe auch Anmerkungen am Ende des vorherigen Abschnitts.)

Tipp: Alternativ können Sie auch von dem Dialog aus in die Tabelle klicken und den Zellbereich darin
einfach mit der Maus selektieren.

Wichtig: Jeder Quellbereich muss sowohl die auszuwertenden Daten selbst als auch deren Beschrif-
tungen enthalten. Die Beschriftungen müssen sich in der äußersten linken Spalte oder in der obersten
Zeile des Bereichs befinden.
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4. Klicken Sie auf die Schaltfläche Hinzufügen.

5. Falls Sie weitere Zellbereiche zu den Quellbereichen hinzuzufügen möchten, wiederholen Sie die Schrit-
te 3. und 4. 

6. Tragen Sie bei Zielbereich die Adresse des Zellbereichs ein, in dem das Ergebnis der Konsolidierung er-
scheinen soll.

Tipp: Es genügt, die Adresse der Zelle anzugeben, in der sich die linke obere Ecke des Zielbereichs be-
finden soll. PlanMaker ermittelt die korrekte Größe dann automatisch.

Tipp: Sie können die gewünschte Zelle auch einfach in der Tabelle anklicken, um ihre Adresse in den
Dialog zu übertragen.

7. Wählen Sie bei Funktion, welche Rechenfunktion für die Konsolidierung verwenden werden soll.

8. Geben Sie bei den Optionen an, wo sich die Beschriftungen der Daten in den Quellbereichen befinden:

Beschriftungen in linker Spalte: Die Beschriftungen befinden sich jeweils in der äußersten linken
Spalte der Quellbereiche. (Die zugehörigen Daten müssen dann direkt rechts daneben eingetragen sein.)

Beschriftungen in oberster Zeile: Die Beschriftungen befinden sich jeweils in der obersten Zeile der
Quellbereiche. (Die zugehörigen Daten müssen dann direkt darunter eingetragen sein.)

Sie können auch beide Optionen aktivieren, falls Sie Quellbereiche auswerten möchten, bei denen sich
Beschriftungen in der äußersten linken Spalte und in der in der obersten Zeile befinden.

Wenn Sie die Option Beschriftungen sortieren einschalten, werden die Ergebnisse der Konsolidierung
im Zielbereich nach Beschriftungen sortiert eingetragen.

9. Klicken Sie auf Anwenden, um den Vorgang zu starten.

Die Daten aus den Quellbereichen werden nun mit der gewählten Rechenfunktion konsolidiert, und das Er-
gebnis wird im Zielbereich eingefügt.

Hinweis: Das Ergebnis der Konsolidierung wird in Form von festen Zahlenwerten eingefügt. Diese wer-
den nicht aktualisiert, wenn sich an den Werten in den Quellbereichen etwas ändert.

Dieser Befehl ist also in erster Linie dann nützlich, wenn man den aktuellen Stand der Daten auswerten
und Änderungen nicht mehr berücksichtigen möchte (z.B. bei Monatsberichten etc.). Siehe auch Ab-
schnitt Bearbeiten und Aktualisieren von Konsolidierungen.

Bearbeiten und Aktualisieren von Konsolidierungen

Wenn Sie mit dem Befehl Daten konsolidieren eine Konsolidierung durchführen, merkt sich PlanMaker al-
le Einstellungen, die Sie im Konsolidieren-Dialog vorgenommen haben (und zwar pro Arbeitsblatt). 

Dies ermöglicht es Ihnen, diesen Befehl jederzeit erneut aufzurufen, gegebenenfalls Einstellungen für die
Konsolidierung zu ändern und diese dann erneut durchzuführen. 

Tipp: Die Einstellungen werden sogar im Dokument gespeichert, sodass sich PlanMaker auch beim
nächsten Öffnen des Dokuments wieder darin erinnert. (Kleine Einschränkung: Der Zielbereich wird in
xls-Dateien nicht gespeichert, da dieses Dateiformat das nicht unterstützt. Bei xlsx-Dateien, pmd-Dateien
und pmdx-Dateien funktioniert es aber.)
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Einstellungen bearbeiten und Konsolidierung erneut durchführen

Um die Einstellungen für eine Konsolidierung zu bearbeiten und ihr aktualisiertes Ergebnis erneut einzufü-
gen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf.

2. Nehmen Sie die gewünschten Änderungen an den Einstellungen für die Konsolidierung vor. Sie können
auch neue Quellbereiche hinzufügen oder vorhandene entfernen.

3. Klicken Sie auf die Schaltfläche Anwenden, um die Änderungen zu übernehmen und die Konsolidie-
rung erneut durchzuführen.

Die Konsolidierung auf dem aktuellen Arbeitsblatt wird nun erneut durchgeführt und ihr aktualisiertes Er-
gebnis wird in den Zielbereich eingefügt. Die alten Daten werden dabei überschrieben.

Konsolidierung aktualisieren

Wenn Sie eine Konsolidierung einfach nur aktualisieren möchten (ohne Einstellungen zu ändern), gehen Sie
wie folgt vor:

1. Rufen Sie den Menübefehl Arbeitsblatt > Daten konsolidieren auf.

2. Klicken Sie auf die Schaltfläche Anwenden.

Die Konsolidierung auf dem aktuellen Arbeitsblatt wird nun, mit genau den gleichen Einstellungen wie
beim letzten Mal, erneut durchgeführt.

Tabellen in Arbeitsblättern
Mit dem Menübefehl Arbeitsblatt > Neue Tabelle können Sie "Tabellen" in einem Arbeitsblatt anlegen. 

Anmerkung: Dass dieses Feature "Tabellen" genannt wird, ist zunächst natürlich verwirrend, da "Tabel-
len" ja eigentlich der Oberbegriff für das ist, was Sie in einer Tabellenkalkulation bearbeiten. Nachdem
jedoch Microsoft dieses Feature in Excel als "Tabellen" bezeichnet, haben wir uns entschlossen, in
PlanMaker aus Kompatibilitätsgründen den gleichen Begriff zu verwenden.

Was aber macht dieses Feature nun genau?

Wenn Sie einen Zellbereich markieren und dann den Menübefehl Arbeitsblatt > Neue Tabelle aufrufen,
wird für diesen Zellbereich eine "Tabelle" angelegt. 

Dies hat folgende Auswirkungen auf den Zellbereich:

¡ Automatische Formatierung mit einer "Tabellenvorlage" 

Der markierte Zellbereich wird automatisch mit einer Tabellenvorlage formatiert. Die Standardvorlage
bringt abwechselnd eine blaue und weiße Schattierung an den Zellen an. Sie können aber blitzschnell auf
eine andere Vorlage wechseln und somit die Formatierung der gesamten "Tabelle" auf Knopfdruck än-
dern.
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¡ Automatisches Anbringen eines Autofilters 

Außerdem wird der Zellbereich, aus dem die "Tabelle" erzeugt wurde, automatisch mit einem Autofilter
versehen. Sie erkennen das an den kleinen Pfeilchen neben den Spaltenüberschriften der Tabelle. Kli-
cken Sie eines der Pfeilchen an, erscheint ein Menü, mit dem Sie einen Filter auf die Zellinhalte der zu-
gehörigen Spalte setzen können. 

¡ Ergebniszeile 

Für Tabellen lässt sich zudem eine Ergebniszeile aktivieren, die unterhalb der Tabelle angezeigt wird. In
dieser lassen sich zusammenfassende Berechnungen durchführen (zum Beispiel die Summe von Spal-
ten).

¡ Besondere Zellbezüge 

Das Anlegen von "Tabellen" in einem Arbeitsblatt erlaubt auch das Verwenden besonderer Zellbezüge.
So lassen sich die Zellinhalte in einer Spalte einer Tabelle beispielsweise über ihre Spaltenüberschrift
ansprechen – zum Beispiel: 

=SUMME(Tabelle3[Frühling])

Auf den nächsten Seiten erfahren Sie alles Wissenswerte zu dem "Tabellen"-Feature. Folgende Themen
werden darin behandelt:

¡ Tabellen in Arbeitsblättern anlegen 

¡ Tabellen in Arbeitsblättern entfernen

¡ Tabellen in Arbeitsblättern bearbeiten

¡ Tabellen in Arbeitsblättern formatieren

¡ Verwenden der Ergebniszeile von Tabellen in Arbeitsblättern

¡ Tabellen in Arbeitsblättern und Zellbezüge

Lesen Sie dazu die nächsten Seiten.

Tabellen in Arbeitsblättern anlegen

Wie in der Einleitung des Abschnitts Tabellen in Arbeitsblättern beschrieben, bietet Ihnen der Menübefehl
Arbeitsblatt > Neue Tabelle die Möglichkeit, in Ihren Arbeitsblättern "Tabellen in Arbeitsblättern" zu ver-
wenden. Hier erfahren Sie, wie Sie solche Tabellen erzeugen: 

Zum Anlegen von "Tabellen in Arbeitsblättern" gehen Sie wie folgt vor:

1. Optional: Tragen Sie in einen zusammenhängenden Zellbereich die Daten ein, aus denen Sie eine Tabel-
le anlegen möchten.

Tipp: Es ist hilfreich, wenn Sie diesen Zellbereich in seiner ersten Zeile mit Spaltenüberschriften für
die jeweilige Spalte darunter versehen. (Ist das nicht der Fall, erzeugt PlanMaker automatische Über-
schriften wie Spalte1, Spalte2, etc.) 

2. Markieren Sie den Zellbereich (inklusive Spaltenüberschriften).

3. Rufen Sie den Menübefehl Arbeitsblatt > Neue Tabelle auf.

4. Es erscheint ein Dialog mit folgenden Optionen:
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Quellbereich: Der Zellbereich, aus dem die Tabelle erzeugt werden soll. Vorgegeben ist der Bereich,
den Sie vor dem Aufruf des Befehls markiert hatten. In der Regel müssen Sie diesen also nur bestätigen. 

Quellbereich enthält Überschriften: Hier können Sie angeben, ob die erste Zeile des Quellbereichs aus
Spaltenüberschriften für die Zellinhalte darunter besteht, wie oben empfohlen. Wenn Sie die Option aus-
schalten, generiert PlanMaker automatische Spaltenüberschriften wie Spalte1, Spalte2, etc. und rückt
diese Überschriften mit einer zusätzlichen Zeile über dem Quellbereich ein.

Sobald Sie den Dialog bestätigen, wird eine "Tabelle" für den Quellbereich angelegt. Genauer gesagt, pas-
siert dabei folgendes:

¡ An den Zellen und Zellinhalten selbst ändert sich nichts 

Die Zellen im Quellbereich bleiben auch nach dem Anlegen einer Tabelle ganz normale Tabellenzellen.
Sie können deren Inhalte also nach Belieben bearbeiten, formatieren etc.

¡ Automatische Formatierung mit einer "Tabellenvorlage" 

Es fällt allerdings sofort auf, dass die Zellen im Quellbereich automatisch umformatiert wurden: Stan-
dardmäßig wird die erste Zeile (also die Spaltenüberschriften) mit einem mittelblauen Hintergrund verse-
hen, die Zeilen darunter werden abwechselnd hellblau und weiß schattiert. 

Diese automatische Formatierung erfolgt über eine sogenannte Tabellenvorlage. Wenn Sie eine Tabelle
anlegen, wird diese automatisch mit dem Standard-Tabellenstil umformatiert. Alternativ stehen zahlrei-
che weitere Tabellenvorlagen mit unterschiedlichen Farben und Stilen zur Verfügung. Mit dem Menü-
befehl Arbeitsblatt > Tabelle > Tabelleneigenschaften können Sie jederzeit auf eine andere Vorlage
wechseln.

¡ Automatisches Anbringen eines Autofilters 

Außerdem sehen Sie neben jeder der Spaltenüberschriften in der ersten Zeile einen kleinen Pfeil. Dabei
handelt es sich um einen Autofilter, der automatisch auf den Quellbereich Ihrer Tabelle angewandt wur-
de. 

Standardmäßig ist dieser Filter ausgeschaltet; es werden also alle Daten angezeigt. Wenn Sie eines der
Pfeilchen anklicken, öffnet sich das Menü des Autofilters für die zugehörige Spalte. Darin können Sie
nun verschiedene Arten von Filtern anwenden – oder gar eine Sortierung der Daten in der Tabelle durch-
führen.

Ausführliche Informationen zur Verwendung von Autofiltern finden Sie im Abschnitt AutoFilter.

Tabellen in Arbeitsblättern entfernen

Wie in der Einleitung des Abschnitts Tabellen in Arbeitsblättern beschrieben, bietet Ihnen der Menübefehl
Arbeitsblatt > Neue Tabelle die Möglichkeit, "Tabellen in Arbeitsblättern" anzulegen. Hier erfahren Sie,
wie Sie solche Tabellen wieder entfernen können: 

Es gibt dafür folgende Möglichkeiten:

A) Tabelle zurück in einen normalen Zellbereich verwandeln

Um eine Tabelle wieder in einen "gewöhnlichen" Zellbereich zurückzuwandeln, bewegen Sie den Zellrah-
men auf eine beliebige Zelle innerhalb der Tabelle und rufen dann den Menübefehl Arbeitsblatt > Tabelle
> In Bereich konvertieren auf. Im folgenden Dialogfenster setzen Sie einen Haken vor Formatierung der
Zellen entfernen.
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Die "Magie" des Tabellen-Features wird daraufhin von allen Zellen dieser Tabelle entfernt – inklusive der
automatischen Formatierung und des Autofilters.

B) Tabelle samt Inhalt löschen

Um eine Tabelle samt aller Inhalte komplett zu löschen, bewegen Sie den Zellrahmen auf eine beliebige
Zelle innerhalb der Tabelle und rufen dann den Menübefehl Arbeitsblatt > Tabelle > Tabelle löschen auf. 

Die Tabelle wird daraufhin komplett gelöscht – inklusive aller Zellinhalte.

Tabellen in Arbeitsblättern bearbeiten

Wie in der Einleitung des Abschnitts Tabellen in Arbeitsblättern beschrieben, bietet Ihnen der Menübefehl
Arbeitsblatt > Neue Tabelle die Möglichkeit, "Tabellen in Arbeitsblättern" anzulegen. Hier erfahren Sie,
wie Sie solche Tabellen bearbeiten können:

Es gibt dafür folgende Möglichkeiten:

Weitere Zeilen oder Spalten anfügen

"Tabellen in Arbeitsblättern" lassen sich sehr leicht um eine zusätzliche Zeile oder Spalte erweitern – und
zwar auf folgende Arten:

¡ Wenn Sie in eine Zelle, die sich direkt rechts neben der Tabelle befindet, einen Wert eingeben, erweitert
sich diese Tabelle automatisch um die Spalte mit diesem Wert.  

¡ Wenn Sie in eine Zelle, die sich direkt unterhalb der Tabelle befindet, einen Wert eingeben, erweitert
sich die Tabelle automatisch um die Zeile mit diesem Wert.

(Hinweis: Dies funktioniert nur, wenn die "Ergebniszeile" für diese Tabelle ausgeschaltet ist.)

Tipp: Die obigen zwei Methoden zum Erweitern einer Tabelle lassen sich deaktivieren, falls dieses
Verhalten nicht erwünscht ist. Schalten Sie dazu im Dialogfenster des Menübefehls Weiteres > Ein-
stellungen auf der Karteikarte Bearbeiten die Option Tabellen automatisch erweitern aus.

¡ Wenn Sie in der letzten Zelle einer Tabelle (der Zelle ganz rechts unten) die Tabulatortaste Tab betäti-
gen, wird die Tabelle automatisch um eine Zeile erweitert. Das funktioniert hier auch dann, wenn eine
"Ergebniszeile" eingeschaltet ist, diese wird dann automatisch um eine Zeile verschoben.

Größe der Tabelle ändern

Sie können außerdem die Größe einer Tabelle jederzeit selbst ändern – und zwar auf folgende Arten:

¡ In der rechten unteren Ecke einer Tabelle wird ein kleiner Pfeil angezeigt. Wenn Sie mit der Maus an
diesem Pfeil ziehen, wird die Tabelle entsprechend vergrößert oder verkleinert. 

¡ Wenn Sie den Menübefehl Arbeitsblatt > Tabelle > Tabellenbereich aufrufen, erscheint ein Dialog, in
dem Sie den Zellbereich, den die Tabelle umfasst, editieren können.

¡ Genauso gut können Sie auch das Kontextmenü durch Rechtsklick in die Tabelle aufrufen und über den
Menübefehl Tabellenbereich ändern den Zellbereich editieren.
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Zeilen oder Spalten einfügen

Um innerhalb einer Tabelle (und zwar nur dieser Tabelle) eine neue Zeile einzufügen, gehen Sie wie folgt
vor:

1. Setzen Sie den Zellrahmen in die gewünschte Zeile in der Tabelle.

2. Rufen Sie den Menübefehl Arbeitsblatt > Tabelle > Einfügen > Zeilen oberhalb einfügen bezie-
hungsweise Zeilen unterhalb einfügen auf. 

Die neue Zeile wird nun oberhalb beziehungsweise unterhalb der aktuellen Zeile in die Tabelle eingefügt.

Hinweis: Diese beiden Befehle fügen die neue Zeile nur in die Tabelle selbst ein – nicht in die Zellen,
die diese Tabelle umgeben. 

Das Einfügen von neuen Spalten funktioniert entsprechend (mit den Befehlen Arbeitsblatt > Tabelle >
Einfügen > Spalten links einfügen beziehungsweise Spalten rechts einfügen).

Zeilen oder Spalten löschen

Zum Löschen einer Zeile aus einer Tabelle (und zwar nur dieser Tabelle) gehen Sie wie folgt vor:

1. Setzen Sie den Zellrahmen in die Zeile in der Tabelle, die gelöscht werden soll.

2. Rufen Sie den Menübefehl Arbeitsblatt > Tabelle > Löschen > Zeilen löschen auf. 

Die Zeile wird nun (samt Inhalt) aus der Tabelle entfernt.

Hinweis: Dieser Befehl entfernt die Zeile nur aus der Tabelle selbst – nicht aus den Zellen, die diese Ta-
belle umgeben. 

Das Löschen von Spalten funktioniert entsprechend (mit dem Befehl Arbeitsblatt > Tabelle > Löschen >
Spalten löschen).

Zellen in einer Tabelle selektieren

Zellen in einer Tabelle können natürlich wie üblich mit Maus oder Tastatur selektiert werden. 

Als zusätzlicher Helfer für das Selektieren innerhalb von Tabellen steht außerdem der Menübefehl Arbeits-
blatt > Tabelle > Selektieren zur Verfügung. Dieser öffnet ein Untermenü mit folgenden Kommandos:

¡ Zeilen selektieren: Selektiert die aktuelle Zeile in der Tabelle. 

¡ Spalten selektieren: Selektiert die aktuelle Spalte in der Tabelle.

¡ Spaltendaten selektieren: Selektiert nur die Zellen in der aktuellen Spalte, die Daten enthalten. Spalten-
überschriften oder Zellen in der Ergebnisleiste werden also nicht selektiert.

¡ Tabelle selektieren: Selektiert die gesamte Tabelle.
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Tabellen in Arbeitsblättern formatieren

Wie in der Einleitung des Abschnitts Tabellen in Arbeitsblättern beschrieben, bietet Ihnen der Menübefehl
Arbeitsblatt > Neue Tabelle die Möglichkeit, "Tabellen in Arbeitsblättern" anzulegen. Hier erfahren Sie,
wie Sie solche Tabellen formatieren und weitere Eigenschaften der Tabelle ändern können:

Zunächst einmal lassen sich die Zellen in Tabellen, genau wie "gewöhnliche" Zellen, mit dem kompletten
Arsenal an Befehlen und Funktionen formatieren, die PlanMaker Ihnen auch sonst zur Verfügung stellt. 

Darüber hinaus gibt es speziell für Tabellen den Menübefehl Arbeitsblatt > Tabelle > Tabelleneigen-
schaften. Dieser bietet Formatierungsoptionen, die ausschließlich auf Tabellen anwendbar sind. 

Sie können diesen Befehl wie folgt anwenden:

1. Bewegen Sie den Zellrahmen auf eine beliebige Zelle innerhalb der Tabelle, die sie formatieren möch-
ten.

2. Rufen Sie im Menü den Befehl Arbeitsblatt > Tabelle > Tabelleneigenschaften auf.

3. Es erscheint ein Dialog mit den nachfolgend beschriebenen Optionen. Nehmen Sie darin die gewünsch-
ten Einstellungen vor und bestätigen Sie dann mit OK.

Folgende Einstellungen können in diesem Dialog vorgenommen werden: 

Eine andere Tabellenvorlage anwenden

Auf der ersten Karteikarte des Dialogs finden Sie die Liste Vorlage. Darin können Sie eine andere Tabel-
lenvorlage auf die Tabelle anwenden. 

Das Anbringen einer anderen Tabellenvorlage ändert das komplette Erscheinungsbild einer Tabelle. In ers-
ter Linie betrifft das die Farbgebung der Tabelle (über Schattierungen). Die kleinen Vorschaubilder in der
Liste zeigen an, welche Farben in der jeweiligen Vorlage enthalten sind. 

Kopfzeile und Ergebniszeile ein- und ausblenden

Unter der Liste Vorlage finden Sie weitere Einstellungen für das Erscheinungsbild der Tabelle. Die ersten
beiden Optionen haben folgende Funktion:

¡ Kopfzeile 

Schaltet die Kopfzeile oberhalb der Tabelle ein/aus. Diese zeigt Spaltenüberschriften für jede der Spalten
darunter an. 

Sie sehen in der Kopfzeile außerdem einen kleinen Pfeil neben jeder Spaltenüberschrift. Hierbei handelt
es sich um den Autofilter, der automatisch auf jede Tabelle angewandt wird. Um Daten zu filtern, kli-
cken Sie eines dieser Pfeilchen an. Es öffnet sich ein Menü, in dem Sie verschiedene Arten von Filtern
auf die Werte in der zugehörigen Spalte setzen können. Informationen zur Verwendung von Autofiltern
finden Sie im Abschnitt AutoFilter.

¡ Ergebniszeile 

Schaltet die Ergebniszeile unterhalb der Tabelle ein/aus. Diese zeigt zusammenfassende Berechnungen
für die Spalten der Tabelle an. 

Standardmäßig wird lediglich die Summe der Werte in der letzten Spalte angezeigt. Über die kleinen
Pfeilchen rechts neben jeder einzelnen Zelle der Ergebniszeile können Sie aber Anpassungen vornehmen
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– und darin beispielsweise die Summe, den Mittelwert oder andere Berechnungen für beliebige Spalten
der Tabelle anzeigen lassen. Mehr dazu im Abschnitt Verwenden der Ergebniszeile von Tabellen in Ar-
beitsblättern.

Weitere Formatierungsoptionen für Tabellenvorlagen

Die weiteren Optionen auf der Karteikarte Vorlage dienen folgendem Zweck:

¡ Gebänderte Zeilen und Gebänderte Spalten 

Schaltet die abwechselnde farbige Schattierung für die Zeilen beziehungsweise Spalten der Tabelle ein
oder aus. Deren Farbe ist in der Tabellenvorlage festgelegt, die Sie ebenfalls in diesem Dialog einstellen
können (siehe oben).

¡ Erste Spalte und Letzte Spalte 

Wenn Sie diese Option einschalten, werden die erste und/oder die letzte Spalte der Tabelle besonders
hervorgehoben. 

Bei den meisten Tabellenvorlagen geschieht dies durch Einschalten von Fettdruck, bei manchen Vor-
lagen werden diese Spalten zusätzlich mit einem andersfarbigen Hintergrund hervorgehen – dies hängt
von der jeweiligen Tabellenvorlage ab.

Erweiterte Eigenschaften auf der Karteikarte "Eigenschaften"

Auf der Karteikarte Eigenschaften des gleichen Dialogfensters finden Sie folgende erweiterte Einstellun-
gen für die Tabelle:

¡ Name 

Hier können Sie den Namen der Tabelle ändern. 

Der Name einer Tabelle kann unter anderem in Zellverweisen verwendet werden (siehe Abschnitt Tabel-
len in Arbeitsblättern und Zellbezüge).

Beachten Sie, dass es für Tabellennamen folgende Regeln gibt:

1. Tabellennamen müssen eindeutig sein.

2. Tabellennamen müssen mit einem Buchstaben oder Unterstrich beginnen.

3. Tabellennamen dürfen keine Leerzeichen und andere ungültige Zeichen enthalten. (Für maximale
Kompatibilität mit anderen Programmen verwenden Sie vorzugsweise nur Buchstaben, Ziffern und Un-
terstriche.)

4. Tabellennamen dürfen nicht wie Zellverweise aufgebaut sein (z.B. A1).

¡ Überschrift und Beschreibung 

Hier können Sie eine Überschrift für die Tabelle und eine kurze Beschreibung für deren Inhalt eintra-
gen. 

Dies ist hilfreich für Menschen, die aufgrund eingeschränkter Sehfähigkeit spezielle Werkzeuge wie
einen Screenreader verwenden, um sich die einzelnen Bestandteile des Arbeitsblatts vorlesen zu lassen. 
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Verwenden der Ergebniszeile von Tabellen in Arbeitsblättern

Wie in der Einleitung des Abschnitts Tabellen in Arbeitsblättern beschrieben, bietet Ihnen der Menübefehl
Arbeitsblatt > Neue Tabelle die Möglichkeit, "Tabellen in Arbeitsblättern" anzulegen. Hier erfahren Sie,
was es mit der sogenannten "Ergebniszeile" solcher Tabellen auf sich hat und wie Sie diese anpassen kön-
nen:

Ein weiterer Vorteil von "Tabellen in Arbeitsblättern" ist nämlich die Möglichkeit, auf Wunsch eine Ergeb-
niszeile mit zusammenfassenden Berechnungen anzeigen zu lassen. Sie können die Ergebniszeile jederzeit
ein- oder ausschalten. Wenn sie eingeschaltet ist, erscheint sie in Form einer zusätzlichen Zeile unterhalb
der Tabelle. 

Standardmäßig zeigt die Ergebniszeile lediglich links den Text "Ergebnis" und rechts die Summe der Werte
der Spalte ganz rechts in der Tabelle an. Sie können darin aber auch andere Berechnungen vornehmen, in-
dem Sie die Ergebniszeile bearbeiten (siehe unten).

Ergebniszeile ein-/ausschalten

Um die Ergebniszeile für eine Tabelle einzuschalten, gehen Sie wie folgt vor:

1. Bewegen Sie den Zellrahmen auf eine beliebige Zelle innerhalb der Tabelle.

2. Rufen Sie im Menü den Befehl Arbeitsblatt > Tabelle > Tabelleneigenschaften auf.

3. Schalten Sie die Option Ergebniszeile auf der Karteikarte Vorlage ein. Bestätigen Sie dann mit OK.

Die Ergebniszeile wird nun unter der Tabelle angezeigt.

Wenn Sie die Ergebniszeile wieder deaktivieren möchten, schalten Sie diese Option wieder aus.

Ergebniszeile bearbeiten

Standardmäßig zeigt die Ergebniszeile nur den Text "Ergebnis" sowie die Summe der Werte der Spalte ganz
rechts in der Tabelle an.

Sie können dies jedoch nach Belieben anpassen. Die Zellen in der Ergebniszeile lassen sich bearbeiten wie
jede andere Zelle in einem Arbeitsblatt auch, Sie können hier also jederzeit eigene Formeln oder Text ein-
tragen. 

Für das Einfügen geeigneter Berechnungen gibt es ein kleines Helferlein: Wenn Sie den Zellrahmen auf ei-
ne der Zellen in der Ergebniszeile setzen, erscheint neben dieser Zelle ein kleiner Pfeil. Klicken Sie diesen
an, öffnet sich ein Menü mit verschiedenen Statistikfunktionen zur Wahl. Wenn Sie hier beispielsweise die
Funktion "Summe" auswählen, fügt PlanMaker in die Zelle eine Formel ein, die die Summe der entspre-
chenden Spalte berechnet.

Tabellen in Arbeitsblättern und Zellbezüge

Wie in der Einleitung des Abschnitts Tabellen in Arbeitsblättern beschrieben, bietet Ihnen der Menübefehl
Arbeitsblatt > Neue Tabelle die Möglichkeit, "Tabellen in Arbeitsblättern" anzulegen. Hier erfahren Sie,
welche Besonderheiten es beim Verwenden von Zellbezügen auf die Zellen in einer solchen Tabelle es gibt:
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Abgesehen von den üblichen Zellbezügen lassen sich Tabellen und deren Inhalte nämlich auch mit Namen
und speziellen Bezeichnern ansprechen:

Namen verwenden

Namen in Zellbezügen auf Tabelleninhalte können wie folgt verwendet werden:

¡ Tabellen über ihren Namen ansprechen 

Wenn Sie in einem Zellbezug den Namen einer Tabelle verwenden, steht dieser stellvertretend für die
entsprechende Tabelle (mit all ihren Zellen, außer den Spaltenüberschriften und der Ergebniszeile).

=SUMME(Tabelle3) liefert beispielsweise die Gesamtsumme aller Zellen in der Tabelle namens "Ta-
belle3".

Tipp: Den Namen einer Tabelle können Sie über den Menübefehl Arbeitsblatt > Tabelle > Tabellenei-
genschaften ändern (Karteikarte Eigenschaften).

¡ Tabellenspalten über ihre Spaltenüberschrift ansprechen 

Um eine einzelne Spalte einer Tabelle in einem Zellbezug anzusprechen, tippen Sie den Namen der Ta-
belle ein, gefolgt von der Spaltenüberschrift der gewünschten Spalte in eckigen Klammern.

=SUMME(Tabelle3[Frühling]) liefert beispielsweise die Summe aller Zellen in der Spalte mit der
Spaltenüberschrift "Frühling" in der Tabelle namens "Tabelle3".

¡ Mehrere zusammenhängende Tabellenspalten ansprechen 

Sie können auch mehrere zusammenhängende Spalten ansprechen. Verwenden Sie dazu die Schreibwei-
se [[Startspalte]:[Zielspalte]].

=SUMME(Tabelle3[[Frühling]:[Herbst]]) liefert beispielsweise die Summe aller Zellen in den Spalten
"Frühling" bis "Herbst" in dieser Tabelle.

¡ Mehrere nicht zusammenhängende Tabellenspalten ansprechen 

Um nicht zusammenhängende Spalten anzusprechen, trennen Sie diese mit einem Strichpunkt.

=SUMME(Tabelle3[Sommer];Tabelle3[Winter]) liefert beispielsweise die Summe aller Zellen in den
Spalten "Sommer" und "Winter". 

Beachten Sie, dass hierbei der Name der Tabelle vor jeder Spalte angegeben werden muss.

Spezielle Bezeichner verwenden

Abgesehen von Namen können in Zellbezügen auf Tabelleninhalte auch spezielle Bezeichner verwendet
werden, die für eine bestimmte Komponente dieser Tabelle stehen. 

Der Bezeichner muss dazu, hinter dem Tabellennamen, in eckigen Klammern eingegeben werden. Tabel-
le3[#Ergebnisse] ist beispielsweise ein Zellbezug auf alle Zellen in der Ergebniszeile der Tabelle namens
"Tabelle3".

Es gibt folgende Bezeichner:

¡ #Alle: Steht für die gesamte Tabelle inklusive Spaltenüberschriften und Ergebniszeile, zum Beispiel: Ta-
belle3[#Alle].  

¡ #Daten: Steht für alle Zellen in der Tabelle, die die eigentlichen Werte enthalten. Dies sind alle Zellen
außer den Spaltenüberschriften und der Ergebniszeile. 
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¡ #Kopfzeilen: Steht für die Zellen in der Kopfzeile der Tabelle (also der Zeile mit den Spaltenüberschrif-
ten). 

¡ #Ergebnisse: Steht für die Zellen in der Ergebniszeile der Tabelle. (Hinweis: Wenn die Ergebniszeile
ausgeschaltet ist, liefert der Zellbezug den Fehlerwert #BEZUG! zurück.)

¡ @[Spaltenname]: Steht für diejenige Zelle, die sich in der gleichen Zeile der angegebenen Spalte befin-
det. Dies ist vor allem bei Berechnungen innerhalb einer Tabelle nützlich. 

Wenn Sie beispielsweise in einer Zelle einer Tabelle einen Zellbezug wie [@Frühling] verwenden, steht
dieser für die Zelle, die sich in der gleichen Zeile der Spalte mit der Spaltenüberschrift "Frühling" befin-
det. 

Beispiel: 

=SUMME([@[Frühling]:[Winter]]) liefert die Summe der Werte aus den Spalten "Frühling" bis "Win-
ter" – und zwar für diejenige Zeile, in die Sie diese Berechnung eintragen.

Die Groß-/Kleinschreibung spielt bei der Eingabe von Bezeichnern keine Rolle.
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Pivot-Tabellen
Neben den normalen Tabellen (siehe Kapitel Tabellen in Arbeitsblättern) gibt es noch die sogenannten Pi-
vot-Tabellen. Eine Pivot-Tabelle können Sie mit dem Menübefehl Arbeitsblatt > Neue Pivot-Tabelle ba-
sierend auf Ihren vorliegenden Quelldaten erstellen.

Was genau ist eine Pivot-Tabelle?

Eine Pivot-Tabelle ist ein optimales Werkzeug, um große Datenmengen in einer aussagekräftigen Form zur
Verfügung zu stellen. Die erzeugten Pivot-Daten kann man nach verschiedenen Blickwinkeln strukturieren,
zusammenfassen, filtern und analysieren. Die Quelldaten bleiben davon unberührt. 

Auswertungen über Pivot-Tabellen eignen sich vor allem für Datensätze mit vielen verschiedenen Elemen-
ten und Kriterien, die überwiegend gleichartig sind und voneinander abhängen, zum Beispiel bei der Be-
richterstattung von Umsätzen.

Was ist der Vorteil von Pivot-Tabellen gegenüber "normalen" Tabellen? 
Neben der Übersichtlichkeit eignen sich Pivot-Tabellen wesentlich besser zur Datenanalyse. Möchten Sie
an umfangreiche Daten komplexe Fragen stellen, z.B. "Wie viele Umsätze hat ein Mitarbeiter für welche Ar-
tikel zu welcher Zeit gemacht?", so wird es schon ziemlich umständlich, wenn Sie diese Informationen di-
rekt aus einer normalen Tabelle entnehmen würden. Sie müssten die Datensätze zuerst sortieren, dann fil-
tern, Befehle einsetzen und schließlich aufbereiten. Mit Pivot-Tabellen sparen Sie sich viele Arbeitsschritte
und gelangen zu einer deutlich besseren Darstellung der gewünschten Informationen.

Bearbeitet werden können Datenbestände sowohl direkt aus Ihrem PlanMaker-Arbeitsblatt, als auch über
den Import aus externen PlanMaker-Dateien und Microsoft Excel-Dateien.

Pivot-Tabellen anhand eines Beispiels

Die Funktionsweise von Pivot-Tabellen wird an dieser Stelle mit einem vereinfachten Beispiel veranschau-
licht, das im gesamten Kapitel immer wieder zur Beschreibung herangezogen wird.

Sie sehen hier Beispiel-Datensätze in PlanMaker, aus denen eine Pivot-Tabelle erstellt werden soll. Die
Mitarbeiter einer Firma hatten über das Jahr verteilt verschiedene Ausgaben für ihre Pausenraum-Versor-
gung. Sowohl einige Mitarbeiter, als auch einige Artikel kommen in den betreffenden Spalten mehrfach vor.

Quelldaten für die Pivot-Tabelle
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Hinweis: Zahlenformatierungen der Quelldaten werden für Pivot-Tabellen nicht übernommen. Zur For-
matierung von Werten in der erstellten Pivot-Tabelle lesen Sie bitte den Abschnitt Werteeinstellungen
(Bereich Werte).

Als Auswertung könnte folgende Pivot-Tabelle entstehen: Hier sind die Mitarbeiter übersichtlich aufgelistet
mit den Summen aus ihren gekauften Artikeln und dem Gesamtergebnis aller Ausgaben.

Variante 1 einer Pivot-Tabelle (Sicht auf die Mitarbeiter)

Aber auch folgende Pivot-Auswertung ist möglich: Hier sind die gekauften Artikel in einer Übersicht sum-
miert angeordnet.

Variante 2 einer Pivot-Tabelle (Sicht auf die Artikel)

Vor allem die Möglichkeit der gruppierten Betrachtung zeigt die großen Vorzüge von Pivot-Tabellen: Hier
sind Mitarbeiter und Artikel gemeinsam und geschachtelt in einer Übersicht ausgewiesen.

Variante 3 einer Pivot-Tabelle (Sicht auf Mitarbeiter mit gruppierten Artikeln)

Es lässt sich anhand dieser Beispiele erkennen, dass je nach Fragestellung an die vorhandenen Daten unter-
schiedliche Aussagemöglichkeiten mit Pivot-Tabellen gestaltet werden können.

In den folgenden Abschnitten wird Ihnen näher erläutert, wie Sie zu verschiedenen Perspektiven der Pivot-
Daten kommen und welche Einstellungen Sie vornehmen können, um eine passende Darstellung Ihrer Er-
gebnisse zu erzielen:

¡ Neue Pivot-Tabelle erstellen 

¡ Start mit der Pivot-Tabellen-Feldliste 



123Bearbeiten einer Tabelle

¡ Pivot-Tabellen gestalten mit der Feldliste 

¡ Pivot-Tabellen sortieren und filtern 

¡ Pivot-Tabellen aktualisieren und Datenbereich ändern

¡ Pivot-Tabellen löschen, kopieren, verschieben

Neue Pivot-Tabelle erstellen

Um eine Pivot-Tabelle zu erstellen, müssen Sie über Datensätze verfügen, auf die eine Pivot-Tabelle ange-
wendet werden kann.

Über den Menübefehl Arbeitsblatt > Neue Pivot-Tabelle können Sie aus bestehenden Quelldaten eine Pi-
vot-Tabelle erzeugen.

Beachten Sie dabei allerdings ein paar wichtige Regeln für die vorliegenden Quelldaten. Einige der Anfor-
derungen sind nicht zwingend erforderlich, aber dennoch hilfreich für eine zweckmäßige Handhabung:

Anforderungen an die Quelldaten

¡ Die Spalten der Quelldaten müssen Überschriften haben. 

¡ Überschriften dürfen nur in einer einzigen Zeile stehen, nicht untereinander. 

¡ Überschriften müssen eindeutig sein, doppelte Namen für die Überschriften dürfen nicht vorkommen. 

¡ Leere Zeilen/Spalten und verbundene Zellen dürfen in den Quelldaten nicht vorhanden sein. 

¡ Die Daten unter den jeweiligen Spaltenüberschriften müssen vom gleichen Datentyp sein (Zahl, Text,
Datum - nicht vermischt). 

¡ Die Daten sollten möglichst in ihrer Rohform vorliegen, also keine Formeln, Verdichtungen, Teilergeb-
nisse oder andere Aufbereitungen zuvor darauf angewendet worden sein. 

Sie können als Quelldaten entweder bereits bestehende Datensätze in der aktuellen Arbeitsmappe verwen-
den oder Datensätze aus einer anderen Datei importieren (importierbare Formate: PlanMaker und Excel).

Lesen Sie dazu bitte die beiden nächsten Abschnitte:

¡ Pivot-Tabelle mit vorliegenden Daten erstellen 

¡ Pivot-Tabelle mit importierten Daten erstellen 

Tipp: Pivot-Tabellen lassen sich auch aus Tabellen in Arbeitsblättern erzeugen. Markieren Sie dazu eine
Zelle in der Tabelle und rufen Sie den Menübefehl Arbeitsblatt > Tabelle > Pivot-Tabelle erstellen auf
oder alternativ durch Rechtsklick in die Tabelle im Kontextmenü den Menübefehl Als Pivot-Tabelle zu-
sammenfassen. Daraufhin verfahren Sie mit den weiteren Schritten zum Erstellen einer Pivot-Tabelle
wie im nächsten Abschnitt beschrieben.
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Pivot-Tabelle mit vorliegenden Daten erstellen

Wenn sich die Quelldaten bereits in der geöffneten Arbeitsmappe befinden, gehen Sie folgendermaßen vor:

1. Markieren Sie den gesamten Datenbereich. Sie können auch nur eine Zelle aus den Quelldaten markie-
ren, PlanMaker erweitert automatisch die Auswahl auf den gesamten zusammenhängenden Bereich.

2. Rufen Sie den Menübefehl Arbeitsblatt > Neue Pivot-Tabelle auf.

Es öffnet sich das folgende Dialogfenster:

3. Quellbereich: Der Zellbereich mit den vorliegenden Daten, aus dem die Pivot-Tabelle erzeugt werden
soll. Hier ist der Quellbereich bereits durch Ihre vorher getätigte Markierung vorgegeben und kann so
übernommen werden. Wollen Sie den Quellbereich noch abändern, können Sie im Eingabefeld den rich-
tigen Zellbereich eintippen oder Sie markieren einfach direkt im Arbeitsblatt mit der Maus den korrekten
Zellbereich. 

Tipp: Haben Sie den Datenbereich zuvor mit einem Namen versehen (siehe Bereiche benennen), kön-
nen Sie im Eingabefeld auch einfach nur diesen Namen eingeben. Ein Vorteil dieses Vorgehens ist,
dass Sie nur den benannten Bereich anpassen müssen, wenn sich die Quelldaten ändern.

Mit der Schaltfläche Datei... können Sie alternativ auch externe Daten importieren. Lesen Sie mehr dazu
im Abschnitt Pivot-Tabelle mit importierten Daten erstellen.
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4. Zielbereich: Hier können Sie entscheiden, wo die Pivot-Tabelle erstellt werden soll. Wählen Sie nun
zwischen den folgenden Möglichkeiten aus: 

Neues Arbeitsblatt: Die Pivot-Tabelle wird in einem neuen Arbeitsblatt erstellt, das automatisch von
PlanMaker generiert wird. Sie können im unteren Eingabefeld das vorgeschlagene Ziel anpassen.

Vorhandenes Arbeitsblatt: Die Pivot-Tabelle wird in einem bereits vorhandenen Arbeitsblatt erstellt.
Das kann das Arbeitsblatt sein, in dem sich auch die Quelldaten befinden oder auch ein anderes bereits
existierendes Arbeitsblatt. Achten Sie bitte darauf, dass Sie zuerst die Auswahl Vorhandenes Arbeits-
blatt aktivieren und klicken Sie dann mit der Maus im gewünschten Arbeitsblatt auf eine Zelle in einem
freien Bereich. Oder tippen Sie in das untere Eingabefeld den Zielbereich ein.

Tipp: Für Pivot-Tabellen mit großen Datenmengen empfiehlt es sich, ein neues Arbeitsblatt zu neh-
men und nicht das Arbeitsblatt mit den Quelldaten, da es schnell zu Platzmangel führen kann. Sind nur
wenige Daten vorhanden - wie in unserem Beispiel - ist es durchaus zweckmäßig und anschaulich, die
Pivot-Tabelle in demselben Arbeitsblatt neben oder unter den Quelldaten darzustellen.

5. Bestätigen Sie mit der Schaltfläche Einfügen, um die Pivot-Tabelle anzulegen.

Wenn Sie die Pivot-Tabelle in demselben Arbeitsblatt erstellt haben, in dem sich auch die Quelldaten befin-
den, sollte das Ergebnis etwa so aussehen:

Auf der linken Seite sehen Sie nach wie vor die Quelldaten, rechts daneben den (noch leeren) Pivot-Tabel-
len-Bericht und ganz rechts in der Seitenleiste die sogenannte Pivot-Tabellen-Feldliste oder einfach nur
Feldliste. Sie ist die zentrale Steuerung der Pivot-Tabelle. Mit der Auswahl der Elemente aus der Feldliste
füllen Sie die leere Pivot-Tabelle nach Ihren Vorstellungen mit Inhalten.

Lesen Sie mehr zu Struktur und Bedienung der Feldliste im Abschnitt Start mit der Pivot-Tabellen-Feldliste.

Pivot-Tabelle mit importierten Daten erstellen

Sie können auch Datensätze aus anderen PlanMaker-Dateien oder Microsoft Excel-Dateien zum Erstellen
einer Pivot-Tabelle importieren. Gehen Sie dazu folgendermaßen vor:
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1. Rufen Sie den Menübefehl Arbeitsblatt > Neue Pivot-Tabelle auf.

Es öffnet sich das folgende Dialogfenster:

2. Quellbereich

Im Dateibrowser suchen Sie die Datei mit Ihren Quelldaten und bestätigen Sie mit Öffnen. 

Im Eingabefeld unter Quellbereich erscheint der Dateipfad mit dem Dateinamen und ein vorgeschlage-
nes Tabellenblatt mit einem Zellbereich. Hier müssen Sie präzise den gewünschten Zellbereich anpas-
sen, PlanMaker erweitert beim Import aus externen Dateien nicht automatisch den Zellbereich auf zu-
sammenhängende Datensätze.

Beispiel: Ihre Quelldaten sind in der Datei Pivot.pmdx im Arbeitsblatt Tabelle1 und der Zellbereich Ih-
rer Quelldatensätze ist von A1 bis D11.

Die Schreibweise im Eingabefeld lautet dann: 'Dateipfad\[Pivot.pmdx]Tabelle1'!$A$1:$D$11

Tipp: Wenn Sie den Bereich der Quelldaten in Ihrer externen Datei zuvor mit einem Namen versehen
haben (siehe Abschnitt Bereiche benennen), können Sie sich die genaue Eingabe des Zellbereichs er-
sparen. Ein weiterer Vorteil dieses Vorgehens ist, dass Sie bei Änderungen an den Datensätzen nur
noch den benannten Bereich anpassen müssen. Rufen Sie den Namen des benannten Bereichs im Ein-
gabefeld nach folgender Schreibweise auf: 'Dateipfad\[Dateiname]'!Name

3. Zielbereich: Hier können Sie entscheiden, wo die Pivot-Tabelle erstellt werden soll: 

Neues Arbeitsblatt: Die Pivot-Tabelle wird in einem neuen Arbeitsblatt erstellt, das automatisch von
PlanMaker generiert wird. Sie können im unteren Eingabefeld das vorgeschlagene Ziel anpassen.

Vorhandenes Arbeitsblatt: Die Pivot-Tabelle wird in einem bereits vorhandenen Arbeitsblatt erstellt.
Das kann das Arbeitsblatt sein, in dem sich auch die Quelldaten befinden oder auch ein anderes schon
angelegtes Arbeitsblatt. Achten Sie bitte darauf, dass Sie zuerst die Auswahl Vorhandenes Arbeitsblatt
aktivieren und klicken Sie dann mit der Maus im gewünschten Arbeitsblatt auf eine Zelle in einem frei-
en Bereich. Oder tippen Sie den Zielbereich in das untere Eingabefeld.

4. Bestätigen Sie mit der Schaltfläche Einfügen, um die Pivot-Tabelle anzulegen.

Sie sollten jetzt im Arbeitsblatt einen (noch leeren) Pivot-Tabellen-Bericht sehen und rechts in der Seiten-
leiste die sogenannte Pivot-Tabellen-Feldliste oder einfach nur Feldliste. Sie ist der Dialog und die zentra-
le Steuerung der Pivot-Tabelle. Mit der Auswahl der Elemente aus der Feldliste gestalten Sie die leere Pi-
vot-Tabelle nach Ihren Vorstellungen.

In den folgenden Abschnitten erfahren Sie mehr zu Struktur und Bedienung der Pivot-Tabellen-Feldliste.
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Start mit der Pivot-Tabellen-Feldliste

Sobald Sie eine Pivot-Tabelle erstellt haben, erscheint rechts in der Seitenleiste die Feldliste mit dem obe-
ren Feldabschnitt und dem unteren Bereicheabschnitt. Sie ist das zentrale Element einer Pivot-Tabelle,
denn hier steuern Sie, welche Daten im Zielbereich der Pivot-Tabelle, dem Pivot-Tabellen-Bericht, ange-
zeigt werden und welche Anordnung die Daten haben.

Hinweis: Die Feldliste wird immer dann angezeigt, wenn Sie den Mauszeiger in den Pivot-Tabellen-Be-
richt setzen.

Gliederung der Feldliste

Links der noch leere Pivot-Tabellen-Bericht; rechts die Feldliste mit dem "Feldabschnitt" oben und dem "Bereicheabschnitt" unten

Feldabschnitt: Im oberen Teil der Feldliste sind die Überschriften aus den Spalten der Quelldaten in ihrer
ursprünglichen Sortierung eingruppiert. Die Reihenfolge der Spalten von links nach rechts in den Quellda-
ten entspricht der Anordnung von oben nach unten im Feldabschnitt. Diese Elemente heißen aber hier nicht
"Spalten", sondern "Felder".

Bereicheabschnitt: In den unteren Teil der Feldliste können Sie die Felder aus dem oberen Feldabschnitt
hineinziehen und damit je nach Anordnung dieser Felder die Struktur der Pivot-Tabelle gestalten. Sobald
Sie mindestens ein Feld in einem der 4 Bereiche des Bereicheabschnitts abgelegt haben, erscheinen im Pi-
vot-Tabellen-Bericht Ergebnisse.

Der Bereicheabschnitt ist in folgende 4 Einzelbereiche unterteilt:
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¡ Zeilenbeschriftungen 

Ziehen Sie ein Feld in diesen Bereich, so werden die aus diesem Feld stammenden Daten zeilenweise im
Pivot-Tabellen-Bericht gruppiert. Gruppieren bedeutet in diesem Zusammenhang, dass gleichlautende
Elemente aus einer Spalte der Quelltabelle nur noch einmal auftauchen und zusammengezählt werden.
Sie können auch mehrere Felder in diesen Bereich ziehen, die hinzugenommenen Felder bilden dann
ebenfalls zeilenweise weitere Untergruppierungen. Das Feld, das in den Zeilenbeschriftungen oben steht,
ist das übergeordnete Hauptsortierkriterium. Weiter unten stehende Felder werden als nachgeordnete
Gliederungsebenen behandelt und dieser Struktur entsprechend im Pivot-Tabellen-Bericht angezeigt.

¡ Spaltenbeschriftungen 

Gleiches Vorgehen wie bei Zeilenbeschriftungen, aber die Gruppierung erfolgt spaltenweise.

¡ Werte 

Im Prinzip der wichtigste Bereich: Die Datensätze des hierher gezogenen Feldes werden im Pivot-Tabel-
len-Bericht zusammengerechnet, z.B. Beträge aufsummiert. Üblicherweise kommen deshalb Felder mit
Zahlenwerten an diese Stelle.

¡ Berichtsfilter 

Erlaubt das Ein- und Ausblenden ausgewählter Datensätze im Pivot-Tabellen-Bericht, bezogen auf das
Feld, das in den Berichtsfilter eingefügt wird (siehe auch Abschnitt Pivot-Tabellen sortieren und filtern).

Tipps zur Anzeige der Feldliste: Passen Sie die Breite der Feldliste nach Ihren Wünschen an, indem Sie
mit dem Mauszeiger am inneren Rand der Seitenleiste ziehen. Um die Feldliste ein- oder auszublenden,
klicken Sie auf die schmale vertikale Schaltfläche mit dem kleinen Pfeil am Rand der Seitenleiste. Wäh-
len Sie mit dem Menübefehl Ansicht > Pivot-Tabellen-Seitenleiste > Links anzeigen/Rechts anzeigen
die Seite zur Anzeige der Feldliste aus.

In den nächsten Abschnitten finden Sie praktische Informationen zur Bedienung der Feldliste.

Übungen zum Aufbau der Feldliste

Sie haben eine Pivot-Tabelle über den Menübefehl Arbeitsblatt > Neue Pivot-Tabelle bereits grundsätz-
lich angelegt, auf der rechten Seite befindet sich die Feldliste mit dem oberen Feldabschnitt und dem unte-
ren Bereicheabschnitt, der Zielbereich der Pivot-Tabelle (der Pivot-Tabellen-Bericht) ist aber noch leer.

In diesem Abschnitt wird Ihnen erläutert, wie Sie in der Feldliste Elemente Schritt für Schritt aus dem
Feldabschnitt in den Bereicheabschnitt ziehen, um im Pivot-Tabellen-Bericht aussagekräftige Ergebnisse
mit unterschiedlicher Ausprägung anzuzeigen.

Sind Sie bereits prinzipiell mit dem Aufbau einer Pivot-Tabelle vertraut, überspringen Sie diesen Abschnitt.

Tipp 1: Sie können die Felder zum einen mit der Maus in den gewünschten Bereich ziehen. Es ist genau-
so gut möglich, im oberen Feldabschnitt einen Haken vor das betreffende Feld zu setzen. PlanMaker ord-
net dann automatisch das Feld einem Bereich im unteren Bereicheabschnitt zu. Felder mit Zahlen landen
im Bereich Werte, alle anderen Formate, wie z.B. Text und Datum, im Bereich Zeilenbeschriftungen.

Tipp 2: Felder können nicht nur zwischen dem oberen Feldabschnitt und dem unteren Bereicheabschnitt
hin- und hergezogen werden, sondern auch zwischen den einzelnen Bereichen des Bereicheabschnitts
und innerhalb der Bereiche selbst, sodass Sie ganz leicht die Position der Felder austauschen können.
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Übung 1: Ein Feld dem Bereich "Werte" hinzufügen

Setzen Sie im oberen Feldabschnitt einen Haken vor das Feld Betrag oder ziehen Sie das Feld mit der linken
Maustaste direkt nach unten in den Bereicheabschnitt zum Bereich Werte.

Links die unveränderten Quelldaten, mittig das Ergebnis der Pivot-Tabelle, rechts die Feldliste mit der Auswahl der Felder für Übung 1

¡ In der Feldliste erscheint im Bereich Werte das Feldelement "Summe von Betrag". 

¡ Im Pivot-Tabellen-Bericht wird jetzt anstelle des leeren Berichts das Wertefeld mit dem Kopftitel "Sum-
me von Betrag" angezeigt.

¡ Alle Werte aus dem Feld Betrag werden im Pivot-Tabellen-Bericht zu einem Gesamtergebnis summiert.

Übung 2: Ein Feld dem Bereich "Zeilenbeschriftungen" hinzufügen

Setzen Sie jetzt zusätzlich im oberen Feldabschnitt einen Haken vor das Feld Mitarbeiter oder ziehen Sie
das Feld mit der linken Maustaste direkt nach unten in den Bereich Zeilenbeschriftungen.

Links das Ergebnis der Pivot-Tabelle, rechts die Feldliste mit der Auswahl der Felder für Übung 2

¡ In der Feldliste erscheint im Bereich Zeilenbeschriftungen das Feldelement "Mitarbeiter". 

¡ Im Pivot-Tabellen-Bericht gibt es jetzt ein Zeilenfeld mit dem Kopftitel "Zeilenbeschriftungen". Darun-
ter sind die Mitarbeiter zeilenweise angeordnet und jeder Name taucht nur noch einmal auf.

¡ Das Wertefeld mit dem Kopftitel "Summe von Betrag" im Pivot-Tabellen-Bericht zeigt die Ausgaben
summiert und aufgeschlüsselt auf die Mitarbeiter an.
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Übung 3: Ein Feld dem Bereich "Spaltenbeschriftungen" hinzufügen

Sie können sich das Ergebnis anstatt zeilenweise alternativ auch spaltenweise anzeigen lassen. Ziehen Sie
dazu das gleiche Feld Mitarbeiter in den Bereich Spaltenbeschriftungen.

Links das Ergebnis der Pivot-Tabelle, rechts die Feldliste mit der Auswahl der Felder für Übung 3

¡ In der Feldliste erscheint im Bereich Spaltenbeschriftungen das Feldelement "Mitarbeiter". 

¡ Im Pivot-Tabellen-Bericht wird ein Spaltenfeld mit dem Kopftitel "Spaltenbeschriftungen" angezeigt
und die Mitarbeiter sind spaltenweise angeordnet. Jeder Name taucht auch hier nur noch einmal auf.

¡ Die Ausgaben werden im Pivot-Tabellen-Bericht im Wertefeld "Summe von Betrag" summiert und auf
die Mitarbeiter aufgeschlüsselt.

Übung 4: Ein zweites Feld dem Bereich "Zeilenbeschriftungen" hinzufügen

Ziehen Sie das Feld Mitarbeiter wieder in den Bereich Zeilenbeschriftungen und setzen Sie jetzt auch
noch einen Haken vor das Feld Artikel.

Links das Ergebnis der Pivot-Tabelle, rechts die Feldliste mit der Auswahl der Felder für Übung 4

¡ Im Pivot-Tabellen-Bericht werden unter "Zeilenbeschriftungen" die Mitarbeiter mit ihren summierten
Artikelarten jeweils gruppiert. Da das Feld Mitarbeiter im Bereich Zeilenbeschriftungen oben steht, ist
es das vorrangige Kriterium und wird im Pivot-Tabellen-Bericht demzufolge als übergeordnet angezeigt.
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¡ Die Beträge für gekaufte Artikel werden im Pivot-Tabellen-Bericht im Wertefeld "Summe von Betrag"
auf die Mitarbeiter aufgeschlüsselt und Zwischensummen als Teilergebnis je Mitarbeiter ausgewiesen.

Hinweis: Es kann sein, dass bei Ihnen die Artikel im Pivot-Tabellen-Bericht als eingerückte Spalte
rechts neben den Mitarbeitern gruppiert werden. Die hier gezeigte Gliederung der Ergebnisse basiert
auf den Grundeinstellungen von PlanMaker. Im Abschnitt Pivot Tabellen gestalten: Feldeinstellungen
finden Sie nützliche Hinweise zur Anpassung der Darstellung.

Übung 5: "Spaltenbeschriftungen" und "Zeilenbeschriftungen" gemeinsam nutzen

Ziehen Sie das Feld Artikel in den Bereich Spaltenüberschriften, das Feld Mitarbeiter bleibt im Bereich
Zeilenbeschriftungen.

Links das Ergebnis der Pivot-Tabelle, rechts die Feldliste mit der Auswahl der Felder für Übung 5

¡ Sie sehen dieselben Ergebnisse wie in Übung 4, allerdings als Kreuztabelle dargestellt. Die sich kreuzen-
den Felder ohne vorhandene Werte (z.B. Anna hat keinen Süßstoff gekauft) werden als leere Zellen an-
gezeigt.

Übung 6: "Spaltenbeschriftungen" und "Zeilenbeschriftungen" gemeinsam mit mehreren Feldern

Ziehen Sie schließlich auch noch das Feld Datum in den Bereich Zeilenbeschriftungen, unterhalb des
Felds Mitarbeiter.

Links das Ergebnis der Pivot-Tabelle, rechts die Feldliste mit der Auswahl der Felder für Übung 6

¡ Das Datum der von den Mitarbeitern gekauften Artikel wird im Pivot-Tabellen-Bericht zusätzlich ausge-
wiesen, hier im Beispiel direkt unter den Mitarbeitern eingruppiert. Auch eine Gruppierung als einge-
rückte Spalte rechts daneben könnte erscheinen, abhängig von den Einstellungen in PlanMaker. 
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Anmerkung 1: Sie können zur Auswertung mehrere Felder in die Zeilen- und/oder Spaltenbeschrif-
tungen ziehen, stoßen dabei aber auch schnell an die Grenzen der Übersichtlichkeit.

Anmerkung 2: Bei mehreren Feldern in einem Bereich ist die Reihenfolge der Felder ausschlagge-
bend für die angezeigte Struktur der Gliederungsebenen im Pivot-Tabellen-Bericht. Sie können diese
Reihenfolge jederzeit durch Ziehen des Feldes mit der Maus nach oben oder unten innerhalb des Be-
reichs abändern.

Übung 7: Ein Feld dem Bereich "Berichtsfilter" hinzufügen

Ziehen Sie das Feld Datum aus dem Bereich Zeilenbeschriftungen in den Bereich Berichtsfilter und das
Feld Artikel wieder in den Bereich Zeilenbeschriftungen.

Links das Ergebnis der Pivot-Tabelle, rechts die Feldliste mit der Auswahl der Felder für Übung 7

¡ Es wurde für das Feld Datum ein Berichtsfilter hinzugefügt, der als neue Zeile oberhalb des Pivot-Be-
richts integriert wird.

¡ Sie können oberhalb des Pivot-Berichts rechts von (Alle Elemente) ein Auswahl-Menü öffnen und nach
den angezeigten Datumswerten der Liste filtern. Zunächst sind alle Datumswerte ausgewählt, erkennbar
am Haken davor. Sie können die nicht zur Anzeige erwünschten Datumselemente aus dem Pivot-Bericht
herausfiltern, indem Sie die Haken davor entfernen.

Bedienung der Feldliste: Feldabschnitt

Der Feldabschnitt im oberen Teil der Feldliste zeigt die Überschriften der Spalten Ihrer Quelldaten an. Für
den Feldabschnitt können Sie folgende Anpassungen vornehmen:

¡ Feldnamen im Feldabschnitt alphabetisch anzeigen 

Die Feldnamen sind zunächst automatisch gemäß der Reihenfolge der Spalten aus Ihren Quelldaten sor-
tiert. Sie können die Felder aber auch alphabetisch sortiert anzeigen lassen, um spezifische Feldnamen
schneller zu finden. Gehen Sie dazu auf die Schaltfläche Pivot-Tabelleneinstellungen unterhalb des Be-
reicheabschnitts. Wählen Sie in der Karteikarte Filter in der Rubrik Feldliste die Option Alphabetisch
sortieren und bestätigen Sie mit OK.



133Bearbeiten einer Tabelle

Hinweis: Die hier vorgenommene alphabetische Reihenfolge wirkt sich nicht auf die Anzeige im Pi-
vot-Tabellen-Bericht aus. Für die alphabetische Sortierung der Elemente direkt im Pivot-Tabellen-Be-
richt lesen Sie bitte den Abschnitt Pivot-Tabellen sortieren und filtern.

¡ Feldnamen im Feldabschnitt umbenennen 

Öffnen Sie rechts neben dem Feldnamen das Auswahl-Menü und rufen Sie dort die Feldeinstellungen
auf. In dem geöffneten Dialog können Sie einen Benutzerdefinierten Namen vergeben.

Umbenennungen können Sie auch vornehmen, wenn sich das Feld im Bereicheabschnitt im Bereich
Werte, Zeilen- oder Spaltenbeschriftungen befindet. Lesen Sie dazu bitte den nächsten Abschnitt Bedie-
nung der Feldliste: Bereicheabschnitt

¡ Felder aus dem Feldabschnitt in den Bereicheabschnitt bewegen 

Um ein Feld aus dem Feldabschnitt oben in die Bereiche des Bereicheabschnitts unten zu bewegen, gibt
es die folgenden Möglichkeiten:

1. Aktivieren Sie das Kontrollkästchen links neben dem Feldnamen im Feldabschnitt. PlanMaker ord-
net das Feld gemäß seinem Format automatisch einem Bereich des Bereicheabschnitts zu: Zahlenfor-
mate landen im Bereich Werte, Text- und Datumsformate im Bereich Zeilenbeschriftungen. 

2. Oder ziehen Sie mit der linken Maustaste das Feld in den gewünschten unteren Bereich.

3. Oder Sie klicken rechts neben dem Feldnamen auf das Auswahl-Menü. Sie können hier auswählen,
in welchen Bereich Sie das Feld direkt bewegen möchten.

Bedienung der Feldliste: Bereicheabschnitt

Nach dem Erstellen einer Pivot-Tabelle sehen Sie zunächst in Ihrem Arbeitsblatt einen leeren Pivot-Tabel-
len-Bericht und rechts in der Seitenleiste die Feldliste. Sie können durch hinzufügen der Felder aus dem
oberen Feldabschnitt in die 4 Teilbereiche des unteren Bereicheabschnitts beobachten, wie sich die Zuwei-
sungen in der Feldliste auf den zuvor leeren Pivot-Bericht auswirken.

Tipp: Ziehen Sie möglichst immer erst das Feld mit den Beträgen in den Bereich Werte des Bereicheab-
schnitts. So können Sie am besten die weiteren Schritte zur Strukturierung der Pivot-Tabelle verfolgen.

Felder hinzufügen, verschieben, entfernen

Hinzufügen von Feldern in den Bereicheabschnitt

Um ein Feld aus dem Feldabschnitt oben in die Bereiche des Bereicheabschnitts unten zu bewegen, gibt es
die folgenden Möglichkeiten:

1. Aktivieren Sie das Kontrollkästchen links neben dem Feldnamen im Feldabschnitt. PlanMaker ordnet das
Feld gemäß seinem Format automatisch einem Bereich des Bereicheabschnitts zu: Zahlenformate landen
im Bereich Werte, Text- und Datumsformate im Bereich Zeilenbeschriftungen. 

2. Oder ziehen Sie mit der linken Maustaste das Feld in den gewünschten Bereich.

3. Oder Sie klicken rechts neben dem Feldnamen auf das Auswahl-Menü. Sie können hier auswählen, in
welchen Bereich Sie das Feld direkt bewegen möchten.
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Verschieben von Feldern innerhalb des Bereicheabschnitts

Möchten Sie Felder von einem Bereich zu einem andern Bereich innerhalb des Bereicheabschnitts verschie-
ben, können Sie folgendermaßen vorgehen:

1. Ziehen Sie das Feld mit der linken Maustaste von einem Bereich in den anderen. 

2. Oder klicken Sie rechts neben dem Feldnamen auf das Auswahl-Menü (entweder im Feldabschnitt oben
oder im Bereicheabschnitt unten). Sie können hier auswählen, in welchen Bereich Sie das Feld direkt
verschieben möchten.

3. Oder ziehen Sie mit der linken Maustaste das Feld erneut aus dem oberen Feldabschnitt in den ge-
wünschten neuen Bereich des Bereicheabschnitts. Es wird dadurch automatisch aus dem vorherigen Be-
reich entfernt (außer beim Bereich Werte, da hier Kopien eines Feldes möglich sind).

Entfernen von Feldern aus dem Bereicheabschnitt

Sie können jederzeit Felder aus dem unteren Bereicheabschnitt entfernen, gehen Sie dazu wie folgt vor:

1. Ziehen Sie das Feld mit der linken Maustaste zurück nach oben in den Feldabschnitt. 

2. Oder deaktivieren Sie das Kontrollkästchen links neben dem Feldnamen im Feldabschnitt.

3. Oder klicken Sie rechts neben dem Feldnamen auf das Auswahl-Menü (entweder im Feldabschnitt oben
oder im Bereicheabschnitt unten) und wählen Sie Feld entfernen.

Hinweis: Durch das Entfernen von Feldern aus dem Bereicheabschnitt oder durch Verschieben zwi-
schen den Bereichen werden alle an dem Feld vorgenommenen Änderungen wieder verworfen (Aus-
nahme: Umbenennungen im Bereich Zeilen-/Spaltenbeschriftungen).

Tipps und Regeln für die Verwendung des Bereicheabschnitts

Felder mehrfach im Bereicheabschnitt verwenden

¡ Für die Bereiche Zeilenbeschriftungen, Spaltenbeschriftungen und Berichtsfilter gilt: Ein Feld kann nur
einmal in einen dieser Bereiche gezogen werden. Wollen Sie es zusätzlich in einen weiteren Bereich ein-
fügen, wird es aus dem Bereich, wo es vorher war, entfernt. 

¡ Für den Bereich Werte gilt das nicht: hier kann man ein Feld erneut ablegen, auch wenn es bereits in ei-
nem anderen Bereich vorhanden ist. Sogar dasselbe Feld kann mehrfach als Kopie eingefügt werden.
Wozu könnte das gut sein? Sie können ein Feldelement sowohl als Summe, als auch ein zweites Mal in
einem anderen Format (z.B. Mittelwert) ausweisen. Es erscheint daraufhin automatisch ein zusätzliches
Element  Werte in den Spaltenbeschriftungen, das Sie auch zum Bereich Zeilenbeschriftungen verschie-
ben können (das Format wird beibehalten), aber nicht in den Bereich Berichtsfilter.

Bitte beachten Sie: Wenn Sie das Feld Werte zurück in den Feldabschnitt ziehen, werden alle Felder
des Bereichs Werte automatisch entfernt und alle an diesen Feldern vorgenommenen Änderungen wie-
der verworfen.

Reihenfolge der Felder in einem Bereich des Bereicheabschnitts ändern

¡ Die Reihenfolge der Felder in einem Bereich lässt sich verändern, indem Sie mit der Maus das Feld an
die richtige Postion innerhalb des Bereichs ziehen.

¡ Oder klicken Sie rechts neben dem Feldnamen auf das Auswahl-Menü. Sie können hier auswählen, wo-
hin Sie das Feld bewegen möchten (nach oben, nach unten, zum Anfang oder zum Ende).
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Feldname im Bereicheabschnitt umbenennen

Ein Feldname kann im Bereicheabschnitt umbenannt werden, sodass er in der Pivot-Tabelle mit anderem
Namen erscheint.

¡ Benutzerdefinierter Name im Bereich Zeilen- oder Spaltenbeschriftungen: 

Befindet sich das Feld im Bereich Zeilen-oder Spaltenbeschriftungen, klicken Sie rechts neben dem
Feldnamen auf das Auswahl-Menü und wählen Sie den Eintrag Feldeinstellungen. Geben Sie in der
Karteikarte Feld einen benutzerdefinierten Namen ein.

¡ Benutzerdefinierter Name im Bereich Werte:

Befindet sich das Feld im Bereich Werte, wählen Sie aus dem Auswahl-Menü rechts neben dem Feld
den Eintrag Werteeinstellungen und geben Sie in der Karteikarte Werte zusammenfassen einen benut-
zerdefinierten Namen ein. 

Hinweis: Für das Umbenennen im Bereich Werte gilt, dass beim Entfernen des Feldes aus seinem Be-
reich die neue Benennung verworfen wird. Sie können das Feld aber auch im oberen Feldabschnitt
umbenennen (siehe Abschnitt Bedienung der Feldliste: Feldabschnitt), die dort vorgenommene Ände-
rung des Namens bleibt bestehen. Im Bereich Werte wird allerdings dann immer noch der Zusatz
"Summe/Anzahl von..." hinzugefügt.

¡ Für den Bereich Berichtsfilter ist das Umbenennen von Feldern nicht möglich. Sie können das Feld aber
ebenfalls oben im Feldabschnitt umbenennen. 

Weitere Bedienungs-Optionen in der Feldliste

In der Feldliste finden sie noch weitere Bedienelemente, die hier noch nicht beschrieben sind, aber in den
folgenden aufgeführten Abschnitten näher erläutert werden:

¡ Schaltfläche Pivot-Tabelleneinstellungen: 
Abschnitt Pivot-Tabelleneinstellungen 

¡ Schaltfläche Daten aktualisieren: 
Abschnitt Pivot-Tabellen aktualisieren und Datenbereich ändern 

¡ Layouteinstellungen zurückstellen zusammen mit der Schaltfläche Aktualisieren: 
Abschnitt Layoutaktualisierung zurückstellen 

¡ Feldeinstellungen (über das Auswahl-Menü von Feldern im Bereich Zeilen-/Spaltenbeschriftungen):
Abschnitt Feldeinstellungen (Bereiche Zeilen-/Spaltenbeschriftungen) 

¡ Filterbeschriftungen (über das Auswahl-Menü von Feldern im Bereich Zeilen-/Spaltenbeschriftungen):
Abschnitt Pivot-Tabellen sortieren und filtern 

¡ Filterwerte (über das Auswahl-Menü von Feldern im Bereich Berichtsfilter):
Abschnitt Pivot-Tabellen sortieren und filtern 

¡ Werteeinstellungen (über das Auswahl-Menü von Feldern im Bereich Werte):
Abschnitt Werteeinstellungen (Bereich Werte)
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Pivot-Tabellen gestalten mit der Feldliste

Sie haben in der Feldliste diverse Optionen für unterschiedlichste Gestaltungsmöglichkeiten Ihrer Pivot-Ta-
belle, die Ihnen in diesem Abschnitt erläutert werden:

¡ Feldeinstellungen 

Die Feldeinstellungen befinden sich im Bereicheabschnitt der Feldliste in den Bereichen Zeilen- oder
Spaltenbeschriftungen. Öffnen Sie dazu das Auswahl-Menü rechts des jeweiligen Feldes. In den Feldein-
stellungen können Sie festlegen, ob und wie Teilergebnisse angezeigt werden, in welchem Format das
Berichtslayout erscheint (Gliederungsformat oder Tabellenformat) und hier lässt sich auch der Feldname
abändern.

¡ Werteeinstellungen:

Felder, die sich im Bereich Werte befinden, haben andere Einstellungskomponenten als die Feldeinstel-
lungen in den Zeilen- oder Spaltenbeschriftungen. Sie lassen sich ebenfalls über das Auswahl-Menü des
jeweiligen Feldes aufrufen und heißen hier Werteeinstellungen. In den Werteeinstellungen finden Sie
eine Auswahl von Auswertungsfunktionen und Berechnungen sowie das gewünschte Zahlenformat für
die angezeigten Ergebnisse. Der Feldname lässt sich auch hier umbenennen.

¡ Pivot-Tabelleneinstellungen 

In den Pivot-Tabelleneinstellungen können Sie erweiterte Anpassungen des Layouts vornehmen, Filter-
methoden bestimmen, Vorlagen auswählen, den Umgang mit Daten einstellen und eine Bezeichnung für
die Pivot-Tabelle vergeben. Sie finden die Pivot-Tabelleneinstellungen als Schaltfläche unterhalb des
Bereicheabschnitts.

¡ Layoutaktualisierung zurückstellen 

Sie finden die Option Layoutaktualisierung zurückstellen zusammen mit der Schaltfläche Aktualisie-
ren ganz unten in der Feldliste. Hiermit lässt sich die fortlaufende Neuberechnung "einfrieren" und Sie
können die Felder derweil ohne zeitraubende Berechnung neu zwischen den Bereichen anordnen.

Bitte beachten Sie: Änderungen an Feldeinstellungen und Werteeinstellungen werden verworfen,
wenn ein Feld aus seinem Bereich entfernt wird (zurück in den Feldabschnitt oder in einen anderen Be-
reich des Bereicheabschnitts). Änderungen an den Pivot-Tabelleneinstellungen werden beibehalten.
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Feldeinstellungen (Bereiche Zeilen-/Spaltenbeschriftungen)

Wenn Sie im unteren Bereicheabschnitt der Feldliste bei einem Feld aus den Bereichen Zeilenbeschriftun-
gen oder Spaltenbeschriftungen das Auswahl-Menü öffnen, finden Sie dort die Option Feldeinstellungen.
Oder rufen Sie das Kontextmenü mit der rechten Maustaste direkt im Pivot-Tabellen-Bericht auf (wählen
Sie dazu eine Zelle des gewünschten Feldes unterhalb der Kopftitel Zeilen-/Spaltenbeschriftungen).

In diesem Abschnitt erfahren Sie, welche Anpassungen Sie über die Feldeinstellungen vornehmen können.

Veranschaulicht wird dies anhand der bekannten Beispieldaten, die Sie in der untenstehenden Abbildung se-
hen: Das Feld Betrag wird in den Bereicheabschnitt zum Bereich Werte gezogen, sowie die Felder Mitar-
beiter und Artikel zum Bereich Zeilenbeschriftungen.

Der Pivot-Tabellen-Bericht bei Standardwerten für die Feldeinstellungen; blau markiert: Aufrufen der Feldeinstellungen

Anmerkung: Die in diesem Abschnitt ausgeführten Beschreibungen beziehen sich der Einfachheit halber
auf die Anordnung der Felder im Bereich Zeilenbeschriftungen. Wenn Sie die Felder stattdessen in den
Bereich Spaltenbeschriftungen ziehen, erzielen Sie prinzipiell die gleichen Ergebnisse. Diese werden
aber transponiert dargestellt (also von links nach rechts, statt von oben nach unten).

Feldeinstellungen, Karteikarte "Teilergebnisse"

Haben Sie mehrere Felder in einem Bereich Zeilen-oder Spaltenbeschriftungen angeordnet, bekommen Sie
für das übergeordnete Feldelement (hier: Mitarbeiter) Zwischensummen im Pivot-Tabellen-Bericht ange-
zeigt, wie in der Abbildung oben ersichtlich (für Anna, Maria, Toni). Diese Teilergebnisse werden automa-
tisch als Summen berechnet, sofern im Bereich Werte ein Zahlenfeld erkannt wurde. In der Karteikarte
Teilergebnisse können Sie die Anzeige der Teilergebnisse auch auf andere Auswertungsfunktionen umstel-
len (z.B. Anzahl, Mittelwert, etc. anstatt Summe) oder die Anzeige von Teilergebnissen komplett ausblen-
den.

Wichtig: Die Feldeinstellungen wirken sich immer nur auf das ausgewählte Feld des Bereichs Zeilen-
oder Spaltenbeschriftungen für die Pivot-Tabelle aus.

Klicken Sie im Bereich Zeilenbeschriftungen (im Bereicheabschnitt der Feldliste) auf das Auswahl-Menü
rechts neben dem Feld (hier: Mitarbeiter) und rufen Sie die Feldeinstellungen auf. Im geöffneten Dialog
wählen Sie die Karteikarte Teilergebnisse.

Hier haben Sie folgende Auswahlmöglichkeiten:
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¡ Automatisch (Standard): Es werden Summen für die Teilergebnisse angezeigt (hier: Mitarbeiter, wie in
der Abbildung oben). Enthält das Wertfeld (hier: Betrag) keine Zahlen, sondern Werte mit anderer For-
matierung, wird automatisch die Funktion Anzahl für die Teilergebnisse verwendet.  

¡ Keine: Die Teilergebnisse (hier: Mitarbeiter) werden nicht angezeigt. 

Der Pivot-Tabellen-Bericht ohne Teilergebnisse

¡ Benutzerdefiniert 

Sie können aus verschiedenen Auswertungsfunktionen für die Anzeige von Teilergebnissen auswählen,
sobald Sie den Eintrag Benutzerdefiniert angeklickt haben:

Summe: Die Teilergebnisse werden als Summe der Einzelwerte angezeigt.

Anzahl: Zeigt die Anzahl der vorkommenden Einzelwerte an. Entspricht der Funktion ANZAHL2.

Mittelwert: Zeigt den gemittelten Wert der vorkommenden Einzelwerte an.

Maximum: Zeigt den höchsten vorkommenden Einzelwert an.

Minimum: Zeigt den niedrigsten vorkommenden Einzelwert an.

Produkt: Zeigt den multiplizierten Wert aus den vorkommenden Einzelwerten an.

Anzahl Zahlen: Zeigt die Anzahl der Werte an, die Zahlen sind. Entspricht der Funktion ANZAHL.

Standardabweichung (Stichprobe): Liefert den Schätzwert für die Standardabweichung der Grundge-
samtheit anhand einer Stichprobe. Entspricht der Funktion STABW.S

Standardabweichung (Grundgesamtheit): Liefert die Standardabweichung der Grundgesamtheit. Ent-
spricht der Funktion STABW.N.

Varianz (Stichprobe): Liefert den Schätzwert für die Varianz der Grundgesamtheit anhand einer Stich-
probe. Entspricht der Funktion VAR.S.

Varianz (Grundgesamtheit): Liefert die Varianz der Grundgesamtheit. Entspricht der Funktion VAR.P.

Tipp 1: Es lassen sich auch mehrere benutzerdefinierte Funktionen kombinieren. Diese werden dann
jeweils als eigene Zeile für das Teilergebnis ausgewiesen.

Tipp 2: Wenn Sie nicht nur die Teilergebnisse, sondern auch die restlichen Werte auf eine bestimmte
Anzeige umstellen wollen, dann können Sie im Bereich Werte mit der Option Werteeinstellungen, sie-
he Abschnitt Werteeinstellungen (Bereich Werte) die entsprechenden Anpassungen vornehmen. Wol-
len Sie hingegen die Gesamtergebnisse für Spalten/Zeilen ein- oder ausblenden, dann finden Sie die
Optionen hierfür unter Pivot-Tabelleneinstellungen.
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Feldeinstellungen, Karteikarte "Berichtslayout"

In der Beispiel-Abbildung am Anfang des Abschnitts sehen Sie den Pivot-Tabellen-Bericht in der Gliede-
rungsansicht dargestellt. Mit dem Berichtslayout können Sie diese Ansicht anpassen.

Hinweis: Die Anpassung des Berichtslayouts ist nur für Felder im Bereich Zeilenbeschriftungen mög-
lich. Für Felder im Bereich Spaltenbeschriftungen sind die Gliederungsformate nicht einstellbar.

Klicken Sie im Bereich Zeilenbeschriftungen (im Bereicheabschnitt der Feldliste) auf das Auswahl-Menü
rechts neben dem Feld Mitarbeiter und rufen aus der Liste die Feldeinstellungen auf. Im geöffneten Dialog
wählen Sie die Karteikarte Berichtslayout.

Der Dialog Feldeinstellungen mit den Standardwerten in der Karteikarte Berichtslayout

Rubrik Berichtslayout

Hier können Sie zwischen der Ansicht im Gliederungsformat oder im Tabellenformat wählen:

¡ Beim Gliederungsformat werden - mit zusätzlich aktiviertem Kurzformat - mehrere Felder zusammen
in einer Spalte angezeigt und die Elemente der nachgeordneten Ebene in die Spalte eingerückt. Sie kön-
nen hier auch auswählen, ob die Teilergebnisse oberhalb oder unterhalb der Gruppierung erscheinen.

Die folgenden Abbildungen illustrieren die unterschiedlichen Darstellungs-Varianten, abhängig von den
aktivierten Optionen:
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Gliederungsformat: Kurzformat aktiviert; Teilergebnisse oben anzeigen aktiviert

Gliederungsformat: Kurzformat deaktiviert; Teilergebnisse oben anzeigen aktiviert

Gliederungsformat: Kurzformat deaktiviert; Teilergebnisse oben anzeigen deaktiviert
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¡ Beim Tabellenformat wird grundsätzlich für jedes Feld eine eigene Spalte angezeigt, mit der dazugehö-
rigen Feldüberschrift:

Weitere Optionen in der Karteikarte "Berichtslayout"

Es gibt noch drei weitere Optionen im unteren Abschnitt der Karteikarte Berichtslayout, mit denen Sie dem
Pivot-Tabellen-Bericht je nach Bedarf ein strukturierteres Aussehen geben können.

Bitte beachten Sie: Die Optionen Beschriftungen wiederholen und Nach Teilergebnissen Leerzeilen ein-
fügen wirken sich nur bei übergeordneten Feldelementen (hier: Mitarbeiter) aus. Die Option Elemente
ohne Daten anzeigen hingegen nur bei nachgeordneten Feldelementen (hier: Artikel).

¡ Beschriftungen wiederholen 

Die Beschriftungen der Elemente werden in jeder Zeile erneut angezeigt. Diese Option funktioniert nur
für das Tabellenformat bzw. im Gliederungsformat nur dann, wenn Sie das Kurzformat deaktivieren.

Aktivierte Option "Beschriftungen wiederholen" beim Berichtslayout Tabellenformat

¡ Nach Teilergebnissen Leerzeilen einfügen 

Für die Übersichtlichkeit des Pivot-Tabellen-Berichts kann es von Vorteil sein, wenn nach jeder Gruppe
der Teilergebnisse eine Leerzeile erscheint. Aktivieren Sie hierzu diese Option (für Felder im Bereich
Spaltenbeschriftungen nicht auswählbar).
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¡ Elemente ohne Daten anzeigen 

Aktivieren Sie diese Option, um auch diejenigen Elemente anzuzeigen, die keine zugeordneten Daten
enthalten haben.

Beispiel: Toni hat keinen Artikel Kaffee gekauft. Nach aktivierter Option wird dieser Artikel dennoch
ausgewiesen, mit einer leeren Zelle in "Summe von Betrag".

Feldeinstellungen, Karteikarte "Feld"

Sie können hier für das Feld einen Benutzerdefinierten Namen vergeben, sodass es in der Pivot-Tabelle
mit einem benutzerdefinierten Namen erscheint. Aktivieren Sie das Kontrollkästchen und tippen Sie den
neuen Namen in das Eingabefeld (siehe auch Bedienung der Feldliste: Bereicheabschnitt).

Werteeinstellungen (Bereich Werte)

Wenn Sie im Bereich Werte im unteren Bereicheabschnitt der Feldliste rechts neben einem Feld das Aus-
wahl-Menü öffnen, finden Sie dort die Option Werteeinstellungen. Oder rufen Sie das Kontextmenü mit
der rechten Maustaste direkt im Pivot-Tabellen-Bericht auf (wählen Sie dazu eine Zelle unterhalb des Kopf-
titels Summe von...).

Die Werteeinstellungen bestehen aus den Karteikarten Werte zusammenfassen und Werte anzeigen als,
die Ihnen verschiedene Auswertungsfunktionen und Berechnungsmöglichkeiten zur Auswahl stellen.

Werteeinstellungen, Karteikarte "Werte zusammenfassen"

Die Ergebnisse im Pivot-Tabellen-Bericht werden automatisch als Summe ausgegeben, sofern im Bereich
Werte ein Zahlenfeld erkannt wurde. Hat das Feld andere Werte als Zahlen, werden die Ergebnisse als An-
zahl berechnet.

Sie können die Anzeigefunktion der Ergebnisse anpassen. Die vorgenommene Auswahl gilt für die Teiler-
gebnisse des übergeordneten Feldes und auch für die untergruppierten Felder.

Rufen Sie dazu im Bereich Werte (im Bereicheabschnitt) aus dem Auswahl-Menü des gewünschten Feldes
die Werteeinstellungen auf. Im geöffneten Dialog wählen Sie die Karteikarte Werte zusammenfassen.

Im oberen Abschnitt der Karteikarte finden Sie "Werte zusammenfassen durch" mit folgenden Auswahl-
möglichkeiten für die Anzeige der Werte: 

¡ Summe: Die Ergebnisse der Einzelwerte werden als Summe angezeigt. 

¡ Anzahl: Zeigt die Anzahl der vorkommenden Einzelwerte an. Entspricht der Funktion ANZAHL2.

¡ Mittelwert: Zeigt den gemittelten Wert der vorkommenden Einzelwerte an.

¡ Maximum: Zeigt den höchsten vorkommenden Einzelwert an.

¡ Minimum: Zeigt den niedrigsten vorkommenden Einzelwert an.

¡ Produkt: Zeigt den multiplizierten Wert aus den vorkommenden Einzelwerten an.

¡ Anzahl Zahlen: Zeigt die Anzahl der Werte an, die Zahlen sind. Entspricht der Funktion ANZAHL.

¡ Standardabweichung (Stichprobe): Liefert den Schätzwert für die Standardabweichung der Grundge-
samtheit anhand einer Stichprobe. Entspricht der Funktion STABW.S.
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¡ Standardabweichung (Grundgesamtheit): Liefert die Standardabweichung der Grundgesamtheit. Ent-
spricht der Funktion STABW.N.

¡ Varianz (Stichprobe): Liefert den Schätzwert für die Varianz der Grundgesamtheit anhand einer Stich-
probe. Entspricht der Funktion VAR.S.

¡ Varianz (Grundgesamtheit): Liefert die Varianz der Grundgesamtheit. Entspricht der Funktion VAR.P.

Tipp: Wenn Sie nur die Teilergebnisse auf eine bestimmte Anzeige umstellen wollen, dann können Sie
im Bereich Zeilen-/Spaltenbeschriftungen mit der Option Feldeinstellungen die entsprechenden Anpas-
sungen vornehmen, siehe vorheriger Abschnitt Feldeinstellungen (Bereiche Zeilen-/Spaltenbeschriftun-
gen). Wollen Sie hingegen die Gesamtergebnisse für Spalten/Zeilen ein- oder ausblenden, dann finden
Sie die Optionen hierfür unter Pivot-Tabelleneinstellungen.

Außerdem finden Sie in der Karteikarte die Option Benutzerdefinierter Name. Hier können Sie das Feld
umbenennen, sodass es in der Pivot-Tabelle mit anderem Namen erscheint. Lesen Sie hierzu bitte auch den
Abschnitt Bedienung der Feldliste: Bereicheabschnitt.

Werteeinstellungen, Karteikarte "Werte anzeigen als"

In der Karteikarte Werte anzeigen als finden Sie verschiedene Optionen, wie Sie die Ergebnisse der Pivot-
Tabelle anzeigen möchten, zum Beispiel als prozentuale Werte.

Tipp: Sie können dasselbe Feld auch mehrfach in den Bereich Werte ziehen. Wenn Sie die Kopie des
Feldes dann mittels Werte anzeigen als mit unterschiedlichen Ausgabe-Einstellungen versehen (z. B. für
das eine Feld die Standardwerte und das andere Feld prozentuale Werte), können Sie im Pivot-Tabellen-
Bericht die verschiedenen Ausgabewerte übersichtlich miteinander vergleichen.

Im oberen Abschnitt der Karteikarte finden Sie die Rubrik Werte anzeigen als mit Auswahlmöglichkeiten
für die Berechnung der Werte. Je nach Berechnungsart erscheinen zusätzlich auswählbare Einträge in den
darunterliegenden Listen Basisfeld und Basiselement. 

¡ Standard (keine Berechnung): Zeigt den Wert wie gewohnt an. 

¡ % des Gesamtergebnisses: Jede einzelne Position wird als Anteil des Gesamtergebnisses in Prozent
dargestellt.

¡ % des Spaltenergebnisses: Pro Spalte wird das Gesamtergebnis als 100%-Referenz angesetzt und jede
einzelne Position der Spalte wird in Prozent vom Gesamtergebnis der Spalte dargestellt.

¡ % des Zeilenergebnisses: Pro Zeile wird das Gesamtergebnis als 100%-Referenz angesetzt und jede
einzelne Position der Zeile wird in Prozent vom Gesamtergebnis der Spalte dargestellt.

¡ % von: Ein Spalten- oder Zeilenfeld wird als 100%-Referenz angesetzt, alle anderen Werte werden an-
teilig in Prozent von diesem Referenzwert dargestellt. Hierzu müssen die gewünschten Einträge aus den
Listen Basisfeld und Basiselement ausgewählt werden.

¡ % des Vorgängerzeilenergebnisses: Zeigt die prozentualen Anteile bezogen auf das Element der über-
geordneten Ebene (= Vorgänger) in der Zeilengliederung an.

¡ % des Vorgängerspaltenergebnisses: Zeigt die prozentualen Anteile bezogen auf das Element der
übergeordneten Ebene (= Vorgänger) in der Spaltengliederung an.

¡ % des Vorgängerergebnisses: Zeigt die prozentualen Anteile bezogen auf eine beliebige (auswählbare)
übergeordnete Ebene in der Gliederung an. Hierzu muss der gewünschte Eintrag aus der Liste Basisfeld
ausgewählt werden.
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¡ Differenz von: Zeigt die absolute Abweichung der Werte vom ausgewählten Referenzwert an. Hierzu
müssen die gewünschten Einträge aus den Listen Basisfeld und Basiselement ausgewählt werden.

¡ % Differenz von:  Zeigt die prozentuale Abweichung der Werte vom ausgewählten Referenzwert an.
Hierzu müssen die gewünschten Einträge aus den Listen Basisfeld und Basiselement ausgewählt werden.

¡ Fortlaufendes Ergebnis in: Zeigt die kumulierten absoluten Werte der aufeinander folgenden Elemente
an. Hierzu muss der gewünschte Eintrag aus der Liste Basisfeld ausgewählt werden.

¡ % des fortlaufenden Ergebnisses in: Zeigt die kumulierten prozentualen Werte der aufeinander folgen-
den Elemente an. Hierzu muss der gewünschte Eintrag aus der Liste Basisfeld ausgewählt werden.

¡ Aufsteigende Sortierung des Rangs: Zeigt den Rang der ausgewählten Werte eines bestimmten Feldes
an. Das kleinste Element im Feld wird mit Rang 1 ausgewiesen. Hierzu muss der gewünschte Eintrag aus
der Liste Basisfeld ausgewählt werden.

¡ Absteigende Sortierung des Rangs: Wie oben, aber das größte Element im Feld wird mit Rang 1 aus-
gewiesen.

¡ Index: Zeigt die Gewichtung der Werte in Bezug auf Zeilengesamtergebnis und Spaltengesamtergebnis.
Je höher der Indexwert, desto stärker die Gewichtung des Wertes auf das Zeilen-/Spaltengesamtergebnis.
Für den Indexwert gilt die Formel:

Wert in Zelle x Gesamtergebnis der Pivot-Tabelle
 Zeilengesamtergebnis x Spaltengesamtergebnis

Über die Schaltfläche Zahlenformat in der Karteikarte können Sie auch noch die Darstellung des ge-
wünschten Zahlenformats dauerhaft anpassen. Für Details zu den verschiedenen Zahlenformaten siehe Ab-
schnitt Liste der Zahlenformate.

Hinweis: Nur die hier gemachten Änderungen des Zahlenformats werden dauerhaft übernommen. Än-
dern Sie das Zahlenformat lediglich über die Zellenformatierung, werden die Änderungen beim Aktuali-
sieren der Daten verworfen. Ebenfalls nicht in die Pivot-Tabelle übernommen wird die Zahlenformatie-
rung des Quellbereichs.

Pivot-Tabelleneinstellungen

In der Feldliste unterhalb des Bereicheabschnitts mit den 4 Bereichen finden Sie die Schaltfläche Pivot-Ta-
belleneinstellungen. Sie können den Befehl auch über das Kontextmenü aufrufen, indem Sie mit der rech-
ten Maustaste direkt in den Pivot-Tabellen-Bericht klicken.

Sie können hier weitere Anpassungen zur Gestaltung Ihrer Pivot-Tabelle vornehmen, die Sie nicht in den
Feldeinstellungen oder Werteeinstellungen finden, da sie übergreifender Natur sind. Geänderte Optionen in
den Pivot-Tabelleneinstellungen bleiben im Gegensatz zu den Feld- und Werteeinstellungen daher auch
weiterhin bestehen, wenn Sie die Felder aus dem Bereicheabschnitt wieder entfernen.

Karteikarte Layout

¡ Ergebnisse für Zeilen/Spalten anzeigen: Blendet die Anzeige von Gesamtergebnissen für Zeilen/Spal-
ten ein oder aus. 

¡ Zeilenbeschriftung: Wenn Sie mehrere Felder im Bereich Zeilenbeschriftungen angeordnet haben und
bei den Feldeinstellungen das Gliederungsformat mit Kurzformat eingestellt ist, wird das Feld der nach-
geordneten Ebene eingerückt darunter dargestellt.
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...Zeichen: Hier können Sie nun festlegen, wie groß der Einzug vom linken Spaltenrand ist, indem Sie
eine entsprechende Zahl in das Eingabefeld eintippen (voreingestellt ist 1 Zeichen).

¡ Optimale Spaltenbreite: Bei aktivierter Option passt sich die Spaltenbreite der Pivot-Tabelle automa-
tisch an den Text der Spalten an, so dass der Text nicht von der nächsten Spalte abgeschnitten wird. Das
hat seine Vorzüge, aber der Nachteile daran ist: Manuell vorgenommene Anpassungen der Spaltenbreite
werden bei Änderungen an den Feldern unter Umständen wieder verworfen. Deaktivieren Sie diese Opti-
on, um die Spaltenbreite so beizubehalten, wie Sie es manuell eingestellt haben.

¡ Zellenformatierung erhalten: Ist die Option deaktiviert, werden die von Ihnen vorgenommenen Forma-
tierungen in der Pivot-Tabelle (z.B. eine andere Schriftart anwenden) wieder verworfen, sobald Sie die
Pivot-Tabelle aktualisieren bzw. die Arbeitsmappe erneut öffnen. Ist die Option aktiviert, werden Ände-
rungen an der Formatierung beibehalten.

¡ Klassisches Pivot-Tabellenformat: Sollten Sie im Pivot-Tabellen-Bericht die Kopftitel "Zeilenbe-
schriftungen" und "Spaltenbeschriftungen" für etwas verwirrend halten und möchten sich stattdessen lie-
ber die Klarnamen der Felder anzeigen lassen, dann aktivieren Sie diese Option für eine klassische Dar-
stellung (bekannt aus älteren Versionen von Microsoft Excel bis 2003).

¡ Wertezeile anzeigen: Aktivieren Sie das Kontrollkästchen, um oberhalb des Pivot-Tabellen-Berichts ei-
ne zusätzliche Zeile mit der Überschrift "Werte" einzufügen. Hinweis: Die Anzeige der Wertezeile wird
nur ausgeführt, wenn sich mindestens zwei Felder im Bereich Werte befinden und ist für das klassische
Pivot-Tabellenformat nicht aktivierbar.

Karteikarte Filter

¡ Rubrik Berichtsfilter: Sie können die folgenden Optionen Felder anzeigen und Felder pro Zeile mitein-
ander kombinieren, um die Platzierung der Berichtsfilter im Pivot-Tabellen-Bericht anders anzuordnen.

Felder anzeigen - Befinden sich mindestens zwei Felder im Bereich Berichtsfilter, legen Sie über diese
Option fest, wie die Felder des Berichtfilters im Pivot-Tabellen-Bericht angeordnet werden. Zur Wahl
stehen Erst nach unten, dann nach rechts oder Erst nach rechts, dann nach unten. 

Felder pro Zeile - Hier können Sie auch noch für die Berichtsfilter des Pivot-Tabellen-Berichts festle-
gen, wie viele Felder pro Spalte angezeigt werden, bevor eine neue Spalte beginnt.

¡ Rubrik Feldliste:

Alphabetisch sortieren/In der Reihenfolge der Datenquellen sortieren - Die Feldnamen sind in der
Feldliste gemäß der Reihenfolge der Spalten aus Ihren Quelldaten sortiert. Sie können die Felder aber
auch alphabetisch sortiert anzeigen lassen, um spezifische Feldnamen im Feldabschnitt schneller zu fin-
den.

Hinweis: Die hier vorgenommene Reihenfolge wirkt sich nicht auf die Anzeige im Pivot-Tabellen-Be-
richt aus. Für die alphabetische Sortierung der Elemente direkt im Pivot-Tabellen-Bericht lesen Sie
bitte den Abschnitt Pivot-Tabellen sortieren und filtern.

¡ Rubrik Anzeige:

Feldbeschriftungen und Filterdropdowns anzeigen - Die Feldnamen und die Filtersymbole für Zeilen-
und Spaltenbeschriftungen werden im Pivot-Tabellen-Bericht angezeigt/ ausgeblendet.

Karteikarte Vorlage

Sie können das optische Erscheinungsbild des Pivot-Tabellen-Berichts vielfältig anpassen, wie Sie es auch
von den normalen Tabellenvorlagen her kennen. Suchen Sie sich unter der Rubrikbezeichnung Vorlage aus
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der linken oberen Liste eine Vorlagenquelle aus (Excel 2007, Excel 2003, Excel 97) und entscheiden Sie
sich in der darunter befindlichen Liste für eine der Pivot-Vorlagen unterschiedlicher Formatierung. Für die
Vorlagenquelle Excel 2007 steht Ihnen zusätzlich in der oberen rechten Liste die Auswahl hell/dunkel/mittel
zur Verfügung. 

Die Optionen Gebänderte Zeilen, Gebänderte Spalten, Zeilenköpfe und Spaltenköpfe werden automatisch
angepasst an die Vorlagenquelle angezeigt. Für die Vorlagenquelle Excel 2007 können Sie diese Optionen
manuell nach Ihren Wünschen modifizieren.

Die Aktivierung der Option Gebänderte Zeilen/Gebänderte Spalten bewirkt eine abwechselnde farbige
Schattierung der Zeilen/Spalten, aktivieren der Option Zeilenköpfe/Spaltenköpfe hebt die erste Zeile/Spal-
te der Pivot-Tabelle gesondert hervor.

Die Änderung des Designs wird Ihnen direkt im Pivot-Tabellen-Bericht als Vorschau angezeigt und erst
durch Bestätigung mit OK endgültig übernommen.

Karteikarte Daten

¡ Rubrik Besondere Werte:

Für Fehlerwerte anzeigen - Zellen mit fehlerhaften Berechnungen liefern auch im Pivot Tabellen-Be-
richt die bekannten Fehlerwerte (z.B. #NV, siehe Abschnitt Fehlerwerte). Aktivieren Sie diese Option
und tippen Sie im rechten Eingabefeld einen individuellen Text ein, um selbst definierte Ausgabewerte
stellvertretend für die Fehlerwerte anzeigen zu lassen.

Für leere Zellen anzeigen - Können einem Element keine Daten zugeordnet werden (dies tritt üblicher-
weise bei Kombinationen aus Zeilen- und Spaltenbeschriftungen für Kreuztabellen auf), wird im Pivot-
Tabellen-Bericht eine leere Zelle angezeigt. Deaktivieren Sie das Kontrollkästchen, so erscheint anstelle
von leeren Zellen dort jeweils eine 0. Bei aktiviertem Kontrollkästchen können Sie im Eingabefeld dane-
ben auch einen individuellen Text eintippen, um einen selbst definierten Ausgabewert statt einer leeren
Zelle oder der 0 anzeigen zu lassen.

¡ Rubrik Pivot-Tabellendaten:

Quelldaten in der Datei speichern - Bei aktivierter Option werden die Quelldaten in einem internen
Cache gespeichert und stehen aus dem Cache heraus auch unabhängig von Ihren Quelldaten für die Pi-
vot-Tabelle zur Verfügung. Es wird gewissermaßen eine Kopie der Quelltabelle angelegt. Das ist vor al-
lem bei externen Quelldaten sinnvoll: Sind sie nicht mehr vorhanden, so kann Ihre Pivot-Tabelle auch
weiterhin noch mit den Daten aus dem Pivot-Cache bearbeitet werden.

Deaktivieren Sie die Option, so werden Ihre Daten nicht im Pivot-Cache gespeichert. Beim erneuten Öff-
nen der Datei müssen Sie die Schaltfläche Daten aktualisieren betätigen (siehe Abschnitt Pivot-Tabellen
aktualisieren und Datenbereich ändern), um den Pivot-Cache für die Pivot-Tabelle mit den Quelldaten zu
initialisieren. Für externe Quelldaten gilt: Sind sie nicht mehr vorhanden, so kann Ihre Pivot-Tabelle
auch nicht mehr aktualisiert werden.

Beim Öffnen der Datei aktualisieren - Die Pivot-Tabellendaten werden beim Öffnen der Datei automa-
tisch auf aktuelle Quelldaten angepasst, wenn Sie diese Option aktivieren. Deaktivieren Sie die Option,
können Sie mit Ihren alten Pivot-Daten weiterarbeiten, bis Sie die Schaltfläche Daten aktualisieren aus-
gelöst haben (siehe Abschnitt Pivot-Tabellen aktualisieren und Datenbereich ändern).

Bitte beachten Sie: Durch das Aktualisieren der Daten mit der Option Beim Öffnen der Datei aktuali-
sieren oder auch durch die Schaltfläche Daten aktualisieren wird der Pivot-Cache durch aktualisierte
Quelldaten ersetzt und damit auch die bisherigen Daten in Ihrer Pivot-Tabelle überschrieben.
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Karteikarte Text

Sie können in der Karteikarte Text Ihrer Pivot-Tabelle einen benutzerdefinierten Namen, eine Überschrift
und eine Beschreibung geben. Der Name wird automatisch von PlanMaker fortlaufend generiert (Pivot-Ta-
belle 1, Pivot-Tabelle 2, etc.) und ist im leeren Pivot-Tabellen-Bericht als Titel sichtbar. Auch in Benannter
Bereich wird ein Eintrag erzeugt, lässt sich aber dort nicht umbenennen. Der vergebene Name kann auch
nicht zur Identifizierung der Pivot-Tabelle aus der Funktion PIVOTDATENZUORDNEN verwendet wer-
den, Sie müssen dazu explizit einen neuen Eintrag für die Pivot-Tabelle in Benannter Bereich anlegen.

Ansonsten tauchen die Einträge aus der Karteikarte Text nirgendwo in der Pivot-Tabelle auf. Überschrift
und Beschreibung können als interne Information sinnvoll sein. Um die tatsächlich in der Pivot-Tabelle er-
scheinenden Felder umzubenennen, lesen Sie bitte den Abschnitt Bedienung der Feldliste: Feldabschnitt.

Layoutaktualisierung zurückstellen

Ganz unten in der Feldliste finden Sie die Option Layoutaktualisierung zurückstellen. Sie steht in Kombi-
nation mit der rechts daneben befindlichen Schaltfläche Aktualisieren, hat aber keinen Zusammenhang mit
der Option Daten aktualisieren (lesen Sie dazu bitte den Abschnitt Pivot-Tabellen aktualisieren und Daten-
bereich ändern).

Wenn Sie Felder in der Feldliste neu positionieren, zum Beispiel Felder im Bereicheabschnitt hinzufü-
gen/entfernen/verschieben, wird der Pivot-Tabellenbericht jedes Mal erneut berechnet. Das kann bei um-
fangreichen Berichten schon mal ziemlich lange dauern. Wenn Sie daher die fortlaufende Neuberechnung
vorübergehend abstellen wollen, gehen Sie bitte wie folgt vor:

1. Setzen Sie einen Haken in das Kontrollkästchen vor Layoutaktualisierung zurückstellen. Sie können
daraufhin die Felder Ihrer Pivot-Tabelle umsortieren, sehen allerdings zunächst nicht die damit einherge-
henden Veränderungen im Pivot-Tabellen-Bericht. Außerdem sind alle weiteren Bearbeitungsoptionen
für diesen Zustand deaktiviert.

2. Klicken Sie auf die Schaltfläche Aktualisieren, sobald Sie mit der Neu-Positionierung der Felder fertig
sind, um sich das Ergebnis der veränderten Zusammenstellung anzeigen zu lassen.

3. Entfernen Sie das Häkchen vor Layoutaktualisierung zurückstellen wieder.

Hinweis: Wenn Sie die aktivierte Option Layoutaktualisierung zurückstellen wieder ausschalten, ohne
dass Sie auf Aktualisieren gedrückt haben, werden alle Anordnungen der Felder, die Sie ab der Aktivie-
rung der Option gemacht haben, wieder verworfen.
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Pivot-Tabellen sortieren und filtern

Allzu viele Daten erschweren den Blick auf die relevanten Inhalte. Daher gibt es für Pivot-Tabellen ver-
schiedene Optionen, die Tabellenfelder zu sortieren und zu filtern:

¡ Feldelemente im Pivot-Tabellen-Bericht alphabetisch sortieren 

¡ Filtern im Bereicheabschnitt mit der Option Filterbeschriftungen (Filterwerte) 

¡ Filtern durch Hinzufügen von Berichtsfiltern

¡ Zusätzliche spezielle Filter über das Auswahl-Menü direkt im Pivot-Tabellen-Bericht setzen

Bitte beachten Sie: Für alle vorgestellten Optionen von Sortieren und Filtern gilt, dass die Änderungen
verworfen werden, sobald Sie das Feld aus dem Bereicheabschnitt entfernt oder in einen anderen Bereich
verschoben haben.

Feldelemente im Pivot-Tabellen-Bericht alphabetisch sortieren

Sie können die Feldelemente eines Pivot-Tabellen-Berichts alphabetisch sortieren, indem Sie im Bericht
selber beim Kopftitel Zeilen-/Spaltenbeschriftungen das Auswahl-Menü öffnen und aus der Liste wählen:

¡ Von A-Z sortieren (alphabetische Reihenfolge) 

¡ Von Z-A sortieren (umgekehrte alphabetische Reihenfolge)

Sind mehrere Felder im Bereich Zeilen-/Spaltenbeschriftungen vorhanden (wie in der obigen Abbildung),
können Sie die Sortierung für jedes Feld getrennt vornehmen. Gehen Sie hierzu im Auswahl-Menü des Pi-
vot-Berichts über das gewünschte Feld nach rechts zur nächsten Menüebene, um zu den Sortierungsoptio-
nen dieses Feldes zu gelangen.

Hinweis: Zur alphabetischen Anzeige der Felder nur in der Feldliste lesen Sie bitte den Abschnitt Bedie-
nung der Feldliste: Feldabschnitt.
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Filtern im Bereicheabschnitt mit der Option Filterbeschriftungen (Filterwerte)

Gehen Sie im Bereicheabschnitt der Feldliste in den Bereichen Zeilen-/Spaltenbeschriftungen zum ge-
wünschten Feld, dessen Elemente Sie filtern wollen. Öffnen Sie das Auswahl-Menü rechts neben dem Feld
und wählen Sie die Option Filterbeschriftungen (für Felder im Bereich Berichtsfilter gehen Sie entspre-
chend vor, hier heißt die Option jedoch Filterwerte). Sie können die Option auch durch Rechtsklick auf das
gewünschte Feld direkt im Pivot-Tabellen-Bericht über das Kontextmenü aufrufen.

Aus dem geöffneten Dialogfenster Filter können Sie wählen:

¡ Suchen Sie sich einzelne Listenelemente aus, die Sie einblenden oder ausblenden wollen, indem Sie
einen Haken davor setzen oder den Haken entfernen. 

¡ Mit der Schaltfläche Alle anzeigen werden alle Elemente ausgewählt. 

¡ Mit der Schaltfläche Alle verbergen werden alle Elemente abgewählt.

Bestätigen Sie zum Abschluss mit OK.

Im Pivot-Tabellen-Bericht verändert sich der schwarze Auswahl-Pfeil neben dem Kopftitel zu einem roten
Pfeil und zeigt Ihnen an, dass ein Filter aktiv ist. Die herausgefilterten Werte werden im Pivot-Tabellen-Be-
richt nicht mehr ausgewiesen.

Filtern durch Hinzufügen von Berichtsfiltern

Der Berichtsfilter befindet sich im unteren Bereicheabschnitt der Feldliste und bietet Ihnen eine besonders
einfache und übersichtliche Möglichkeit der Filterung von Daten.

Ziehen Sie die Felder, nach denen Sie filtern möchten, in den Bereich Berichtsfilter. Oberhalb des Pivot-Ta-
bellen-Berichts wird daraufhin eine Zelle mit dem Feldnamen und rechts daneben eine weitere Zelle (Alle
Elemente) mit einem Auswahl-Pfeil integriert. Über das Auswahl-Menü lassen sich die Elemente des Feldes
filtern. Sie können auch hier einzelne Listenelemente auswählen oder mit Alle Anzeigen/Alle verbergen
die komplette Liste der Elemente aus-/abwählen.

Der rote Auswahl-Pfeil rechts der Zelle zeigt Ihnen an, dass ein Filter aktiv ist. Die herausgefilterten Werte
werden im Pivot-Tabellen-Bericht nicht mehr ausgewiesen.

Sie können mehrere Felder aus der Feldliste in den Bereich Berichtsfilter ziehen und aus den verschiedenen
Feldern beliebige Kombinationen einzelner Elemente für den Pivot-Tabellen-Bericht herausfiltern.

Tipp: Die Platzierung der Berichtsfelder im Pivot-Tabellen-Bericht anders anzuordnen ist möglich über
die Pivot-Tabelleneinstellungen, Karteikarte Filter.

Zusätzliche spezielle Filter über das Auswahl-Menü direkt im Pivot-Tabellen-Bericht setzen 

Öffnen Sie im Pivot-Tabellen-Bericht beim Kopftitel Zeilen-/Spaltenbeschriftungen das Auswahl-Menü.
Sofern nur ein Feld im Bereich Zeilen-/Spaltenbeschriftungen vorhanden ist, erhalten Sie direkt die Filter-
auswahl zum gewählten Feld.

Befinden sich mehrere Felder im Bereich Zeilen-/Spaltenbeschriftungen, lassen sich für jedes Feld eigene
Filter anwenden. Gehen Sie hierfür zuerst im Auswahl-Menü über das gewünschte Feld nach rechts zur
nächsten Menüebene, um zur Filterauswahl zu gelangen.

¡ Sie können aus der Auswahlliste die einzelnen Listenelemente auswählen oder mit den Optionen Alle
Anzeigen/Alle verbergen die gesamte Liste der Elemente aus-/abwählen. 
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Hinweis: Hat die Liste zu viele Einträge, wird sie abgekürzt angezeigt und am Ende der Liste er-
scheint der Eintrag Weiteres. Klicken Sie auf den Eintrag, gelangen Sie zum Dialogfenster Filter.
Hier wird Ihnen die komplette Liste der Elemente zur Auswahl angezeigt.

Darüber hinaus stehen Ihnen in der Auswahlliste zusätzliche spezielle Filterbedingungen zur Verfügung.
Detailbeschreibungen zu den einzelnen Filterbedingungen finden Sie im Abschnitt Autofilter.

¡ Beschriftungsfilter bzw. Datumsfilter: Je nachdem, ob Sie ein Feld mit Zahlen/Text bzw. Datumswer-
ten ausgewählt haben, wird Ihnen einer der beiden Filter automatisch angeboten. Je nach Filter können
Sie Zahlen/Text oder Datumswerte nach bestimmten Bedingungen filtern. 

¡ Ergebnisfilter: Der Ergebnisfilter verfügt über spezielle Filterbedingungen, mit denen Sie die Beträge
der Wertefelder eingrenzen können.

Bitte beachten Sie bei der Anwendung von Filtern auf mehrere Felder die Reihenfolge, in der Sie die
Filter setzen. Der nächste angewendete Filter bezieht sich nur auf die verbleibenden Ergebnisse des
vorher gesetzten Filters.

¡ Mehrere Filter: Die Filter in Pivot-Tabellen-Berichten können additiv angewendet werden, das heißt,
Sie können einen weiteren Filter auf den aktuell wirksamen Filter desselben Feldes aufsetzen. Dazu müs-
sen Sie allerdings die Option Mehrere Filter aktivieren, um Filter auf einzelne Listenelemente, Beschrif-
tungs-/Datumsfilter und Ergebnisfilter für dasselbe Feld miteinander zu kombinieren. Ist diese Option
Mehrere Filter nicht aktiviert, ersetzt ein neu angewendeter Filter den alten. 

¡ Filter löschen: Wenn Sie die eingesetzten Filter aus Beschriftungsfilter/Datumsfilter oder Ergebnisfilter
wieder entfernen möchten, wählen Sie aus der Auswahlliste des betreffenden Filters den Eintrag Filter
löschen.

Tipp: Wollen Sie alle Filter auf einmal entfernen, deaktivieren Sie den Eintrag Mehrere Filter. Es er-
scheint ein Dialogfenster Alle Filter zurücksetzen? Bestätigen Sie dann mit OK, um alle Filter aufzu-
heben.

Im Pivot-Tabellen-Bericht zeigt Ihnen der rote Auswahl-Pfeil neben dem Kopftitel an, dass ein Filter gesetzt
ist. Die herausgefilterten Werte werden im Pivot-Tabellen-Bericht nicht mehr ausgewiesen.

Pivot-Tabellen aktualisieren und Datenbereich ändern

Grundsätzlich gilt für Pivot-Tabellen folgendes: Fügen Sie der Quelltabelle nachträglich neue Daten hinzu,
hat das zunächst keinen Einfluss auf die Pivot-Tabelle. Durch die Standardwerte von PlanMaker für Pivot-
Tabelleneinstellungen (siehe Abschnitt Pivot-Tabelleneinstellungen, Karteikarte Daten) sind die Daten der
ursprünglichen Quelltabelle nach dem initialen Erstellen der Pivot-Tabelle in einem internen Pivot-Cache
gespeichert. Auf die Daten aus dem Cache greift die Pivot-Tabelle zu.

Erst durch das Daten aktualisieren wird der Pivot-Cache überschrieben und die Pivot-Tabelle auf den
neuesten Stand gebracht:

In den Pivot-Tabelleneinstellungen, Karteikarte Daten finden Sie auch die Option Beim Öffnen der Da-
tei automatisch aktualisieren. Durch Aktivieren der Option wird der Pivot-Cache regelmäßig gleich beim
Öffnen der Datei mit den aktuellen Daten des Quellbereichs überschrieben. Wenn Sie nach dem Öffnen zu-
nächst noch mit Ihren alten Pivot-Daten weiterarbeiten möchten, lassen Sie die Option deaktiviert.



151Bearbeiten einer Tabelle

Sie können jederzeit manuell durch Betätigen der Schaltfläche Daten aktualisieren Ihre Pivot-Tabelle auf
den neuesten Stand bringen.

Bitte beachten Sie: Durch das Aktualisieren der Daten mit der Schaltfläche Daten aktualisieren oder mit
der Option Beim Öffnen der Datei aktualisieren wird der Pivot-Cache durch aktualisierte Quelldaten er-
setzt und damit auch die bisherigen Daten in Ihrer Pivot-Tabelle überschrieben.

Schaltfläche "Daten aktualisieren"

Sie finden die Schaltfläche Daten aktualisieren unterhalb des Bereicheabschnitts in der Feldliste.

Je nachdem, an welcher Stelle im Quelldatenbereich Sie neue Daten hinzufügt haben, wirkt sich das unter-
schiedlich auf die Pivot-Tabelle aus:

¡ Wenn Sie Daten innerhalb des Quelldatenbereichs überschreiben, werden die geänderten Daten in der
aktualisierten Pivot-Tabelle berücksichtigt. 

¡ Wenn Sie eine neue Zeile/Spalte innerhalb des Quelldatenbereichs einfügen, wird der Datenbereich au-
tomatisch erweitert und in der aktualisierten Pivot-Tabelle berücksichtigt. 

¡ Wenn Sie jedoch eine neue Zeile oder Spalte am Ende des Quelldatenbereichs hinzufügen, werden die
geänderten Daten im aktualisierten Pivot-Tabellen-Bericht zunächst nicht berücksichtigt. Dazu müssen
Sie den Quelldatenbereich erneut anpassen (siehe unten "Quelldatenbereich ändern").

Alle Pivot-Tabellen aktualisieren

Wenn Sie alle vorhandenen Pivot-Tabellen aktualisieren wollen - auch mit unterschiedlichen Quellberei-
chen - dann verwenden Sie den Menübefehl Weiteres > Alle Pivot-Tabellen aktualisieren.

Quelldatenbereich ändern

Haben sich Ihre Quelldaten insoweit verändert, dass sie nicht mehr dem ursprünglichen Quellbereich der Pi-
vot-Tabelle entsprechen (neue Datensätze wurden angefügt / Datei mit importierten Daten wurde verscho-
ben), muss der referenzierte Datenbereich für die Quelldaten geändert werden.

Gehen Sie dazu folgendermaßen vor:

1. Setzen Sie den Mauszeiger in den Pivot-Tabellen-Bericht.

2. Rufen Sie den Menübefehl Arbeitsblatt > Pivot-Tabellenbereiche ändern auf oder öffnen Sie direkt
mit Rechtsklick in den Pivot-Tabellen-Bericht das Kontextmenü, um dort den gleichlautenden Menü-
befehl auszuwählen.

3. Es erscheint ein Dialogfenster, das dem Erstellen einer neuen Pivot-Tabelle entspricht, mit einem Unter-
schied: Die Schaltfläche Einfügen heißt hier Ändern. Außerdem wird direkt im Arbeitsblatt mit den
Quelldaten der ursprünglich referenzierte Quellbereich mit einem blauen Rand markiert.

4. Geben Sie im Dialog den neuen Datenbereich in das Eingabefeld (Quellbereich) ein, voreingestellt ist
der bisherige Quellbereich. Alternativ ist es möglich, den gewünschten Quellbereich mit der Maus auf-
zuziehen, wenn Sie das Arbeitsblatt mit den Quelldaten vor sich haben. Greifen Sie hierzu mit der linken
Maustaste die blaue Markierung am rechten unteren Rand.

Hinweis: Für externe Daten ist die Anpassung nur im Eingabefeld (Quellbereich) möglich.

5. Bestätigen Sie mit der Schaltfläche Ändern. Zuvor können Sie im unteren Eingabefeld noch eingeben,
ob Sie möglicherweise auch den Zielbereich an eine andere Stelle verschieben wollen, voreingestellt ist
der bisherige Zielbereich.
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Pivot-Tabellen löschen, kopieren, verschieben

Sie können Ihre erstellten Pivot-Tabellen auch löschen, kopieren und verschieben. Wie das genau geht, er-
fahren Sie in den folgenden Absätzen.

Tipp: Zum Löschen, Kopieren, Verschieben ist es immer notwendig, den gesamten Bereich des Pivot-
Tabellen-Berichts exakt zu markieren. Am einfachsten geht das, wenn Sie die Maus in eine Zelle des Be-
richts setzen und zum Markieren die Tastenkombination Strg+A oder den Menübefehl Bearbeiten > Al-
les markieren nutzen.

Pivot-Tabellen löschen

Das Löschen von Pivot-Tabellen funktioniert ähnlich, wie Sie es aus den Standardwerkzeugen von Daten
löschen kennen. Achten Sie allerdings darauf, dass der Pivot-Tabellen-Bericht als Ganzes markiert sein
muss, einzelne Zellen können nicht separat gelöscht werden.

Markieren Sie zum Löschen den gesamten Pivot-Tabellen-Bericht und gehen Sie nach einer der folgenden
Methoden vor:

¡ Drücken Sie auf der Tastatur die Taste Entf 

¡ Verwenden Sie den Menübefehl Arbeitsblatt > Zellen löschen... oder öffnen Sie durch Rechtsklick mit
der Maus auf den Pivot-Tabellen-Bericht das Kontextmenü und wählen Sie dort Zellen löschen... 

¡ Verwenden Sie den Menübefehl Bearbeiten > Löschen

¡ Verwenden Sie den Menübefehl Bearbeiten > Selektiv löschen oder öffnen Sie durch Rechtsklick mit
der Maus auf den Pivot-Tabellen-Bericht das Kontextmenü und wählen Sie dort Selektiv löschen. In der
nächsten Menüebene können Sie mit Alles oder Inhalte die Pivot-Tabelle komplett löschen. Wählen Sie
den Eintrag Formate, wenn Sie nur die angewendeten Formatierungen aus der Pivot-Tabelle entfernen
wollen.

Pivot-Tabellen kopieren

Sie können jederzeit Pivot-Tabellen kopieren und in demselben Arbeitsblatt an einer anderen Stelle oder in
einem neuen Arbeitsblatt duplizieren. Die kopierte Pivot-Tabelle nimmt dieselben Werte an, wie die kopier-
te Vorlage. Auch nach Betätigen der Schaltfläche Daten aktualisieren übernimmt die kopierte Pivot-Tabelle
abgeänderte Daten aus der Quelltabelle.

Sie haben in der kopierten Pivot-Tabelle aber dennoch die Möglichkeit, sie unabhängig von der kopierten
Vorlage zu gestalten, in Bezug auf Anordnung der Felder, Formatierung, etc. So erhalten Sie für gleiche
Quelldaten unterschiedliche Darstellungen der Berichte.

Zum Kopieren markieren Sie den gesamten Pivot-Tabellen-Bericht und gehen nach einer der folgenden
Methoden vor:

¡ Verwenden Sie den Menübefehl Bearbeiten > Kopieren und daraufhin Bearbeiten > Einfügen

¡ Oder öffnen Sie durch Rechtsklick mit der Maus auf den Pivot-Tabellen-Bericht das Kontextmenü und
wählen Sie dort Kopieren und daraufhin Einfügen

¡ Oder Sie ziehen mit der Maus den Pivot-Tabellen-Bericht zur gewünschten Stelle und drücken beim Ab-
legen die Taste Strg vor dem Loslassen der Maus
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¡ Oder Sie verwenden einfach die Tastenkombination Strg+C und Strg+V

Sie können nun durch Bewegen des Mauszeigers in eine Zelle des jeweiligen Pivot-Tabellen-Bericht ent-
scheiden, an welchem Bericht sie arbeiten möchten. Die Feldliste erscheint jeweils zugehörig zum ausge-
wählten Bericht.

Pivot-Tabellen verschieben

Zum Verschieben markieren Sie den gesamten Pivot-Tabellen-Bericht und ziehen Sie den markierten Be-
reich mit der linken Maustaste an eine freie Stelle des Arbeitsblatts. Achten Sie dabei darauf, dass Sie nicht
den Quelldatenbereich überlappen.

Möchten Sie den Pivot-Tabellen-Bericht in ein anderes Arbeitsblatt verschieben wollen, gehen Sie wie folgt
vor:

¡ Rufen Sie den Menübefehl Pivot-Tabellenbereich ändern auf, entweder über das Kontextmenü mit der
rechten Maustaste oder über den Menübefehl Arbeitsblatt > Pivot-Tabellenbereich ändern und geben
Sie im Dialog den gewünschten Zielbereich ein. (siehe Abschnitt Pivot-Tabellen aktualisieren und än-
dern) 

¡ Oder kopieren Sie den Pivot-Tabellenbericht wie weiter oben beschrieben, wechseln Sie zum gewünsch-
ten Arbeitsblatt an eine freie Stelle und fügen dort die Kopie aus der Zwischenablage ein. Entfernen Sie
dann den verbliebenen Pivot-Tabellen-Bericht von der alten Stelle.

Einschränkende Hinweise zum Kopieren und Verschieben von Quellbereich/Zielbereich

Das Kopieren und Verschieben von Datenbereichen - sowohl Quellbereich als auch Zielbereich (also der Pi-
vot-Tabellen-Bericht) - ist für Pivot-Tabellen nicht uneingeschränkt möglich, so wie Sie es aus normalen
Tabellen gewohnt sind. Folgende Grundsätze sollten Sie beachten:

¡ Kopieren & Einfügen des Quellbereichs/Zielbereichs: Es ist zwar zunächst möglich, den Quellbereich
Ihrer Daten zu kopieren und an einer anderen Stelle einzufügen, allerdings wird die Pivot-Tabelle nach
wie vor auf die Position des ursprünglichen Quellbereichs referenziert und nicht auf die neue Position.
Somit wird der historische Zellbereich auch beim Aktualisieren der Daten weiterhin angesteuert und
falls er entfernt wurde, erscheint eine Fehlermeldung. Auch für den Fall, dass Sie den Quellbereich ge-
meinsam mit dem Zielbereich Kopieren & Einfügen, gilt diese Einschränkung. Das Kopieren & Einfü-
gen nur des Zielbereichs an eine andere Stelle ist problemlos möglich.

¡ Ziehen & Ablegen des Quellbereichs/Zielbereichs: Ziehen Sie mit der Maus den markierten Quellbe-
reich an eine andere Stelle, tritt die oben beschriebene Einschränkung nicht auf. Die Pivot-Daten werden
auf den neuen Zellbereich referenziert und beim Aktualisieren der Daten angesteuert. Das Ziehen & Ab-
legen nur des Zielbereichs oder zusammen mit dem Quellbereich ist ebenfalls problemlos möglich.

¡ Ausschneiden & Einfügen des Quellbereichs/Zielbereichs: Das Ausschneiden ist weder für den Quell-
bereich noch für den Zielbereich möglich. Beim Verwenden des Befehls erscheint eine Fehlermeldung.

In der folgenden Tabelle sehen Sie die Optionen noch einmal übersichtlich zusammengefasst:

Aktion Quellbereich Zielbereich

Kopieren & Einfügen û ü

Ziehen & Ablegen mit Maus ü ü

Ausschneiden & Einfügen û û
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Fixieren von Zeilen und Spalten
Mit dem Menübefehl Ansicht > Fixieren können Sie die ersten Zeilen und/oder Spalten einer Tabelle auf
dem Bildschirm fixieren. Das bewirkt, dass sich diese beim Blättern in der Tabelle nicht mehr mitbewegen,
sondern permanent angezeigt werden.

Wenn Sie beispielsweise die Zeilen oder Spalten einer Tabelle mit Überschriften versehen haben, können
Sie diese Beschriftungen fixieren, so dass sie immer zu sehen sind.

Fixieren einschalten

Um Zeilen oder Spalten zu fixieren, gehen Sie wie folgt vor:

1. Zunächst müssen Sie festlegen, welche Zeilen und/oder Spalten fixiert werden sollen:

Zeilen fixieren: Wenn Sie die ersten Zeilen der Tabelle fixieren möchten, dann markieren Sie die Zeile di-
rekt unterhalb der Zeilen, die fixiert werden sollen.

Spalten fixieren: Wenn Sie die ersten Spalten fixieren möchten, markieren Sie die Spalte rechts dieser
Spalten.

Zeilen und Spalten fixieren: Wenn Sie sowohl Zeilen als auch Spalten fixieren möchten, setzen Sie den
Zellrahmen in die Zelle rechts unter dem zu fixierenden Bereich.

2. Anschließend rufen Sie den Menübefehl Ansicht > Fixieren auf.

Die Zeilen und/oder Spalten wurden nun fixiert. Beim Blättern durch die Tabelle sind diese von nun an stets
zu sehen.

Tipp: Sie können auch das Symbol  in der rechten unteren Ecke des Programmfensters verwenden, um
Titel zu fixieren. Ziehen Sie dieses Symbol dazu einfach mit der Maus an die gewünschte Stelle.

Fixieren aufheben

Wenn Sie Zeilen oder Spalten fixiert haben und das Menü Ansicht aufrufen, sehen Sie ein Häkchen vor
dem Befehl Fixieren. Dieses zeigt an, dass das Fixieren eingeschaltet ist. Um es wieder auszuschalten, ru-
fen Sie den Menübefehl Ansicht > Fixieren noch einmal auf. Das Häkchen verschwindet; die Zeilen/Spal-
ten sind nun nicht mehr fixiert.

Tipp: Ein Mausklick auf das Symbol  in der rechten unteren Ecke des Programmfensters hebt die Fi-
xierung ebenfalls wieder auf.

Ein Beispiel

Ihnen liegt folgende Tabelle mit Aktienkursen vor:
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Wie Sie sehen, sind darin sowohl die Spalten als auch die Zeilen beschriftet. Um diese Beschriftungen zu fi-
xieren, gehen Sie wie folgt vor:

¡ Die Spaltenbeschriftungen (Höchstkurs, Tiefstkurs etc.) befinden sich in der ersten Zeile der Tabelle.  

Um diese zu fixieren, müssen Sie also die zweite Zeile markieren, indem Sie auf ihren Zeilenkopf (die
mit "2" beschriftete Schaltfläche links der Zeile) klicken. Dann rufen Sie den Menübefehl Ansicht > Fi-
xieren auf.

¡ Die Zeilenbeschriftungen (23.10., 24.10. etc.) befinden sich in der ersten Spalte der Tabelle.  

Um diese zu fixieren, markieren Sie die zweite Spalte (Spalte B), indem Sie auf ihren Spaltenkopf (die
mit "B" beschriftete Schaltfläche über der Spalte) klicken. Dann rufen Sie den Menübefehl Ansicht >
Fixieren auf.

¡ Um beide Beschriftungen zu fixieren, setzen Sie den Zellrahmen in die Zelle B2 und rufen den Menü-
befehl Ansicht > Fixieren auf. 

Wenn Sie die Fixierung wieder aufheben möchten, rufen Sie den Befehl Fixieren erneut auf.

Sonderzeichen einfügen
Einige Zeichen lassen sich über die Tastatur nicht direkt eingeben – zum Beispiel das Copyrightzeichen, das
Promillezeichen oder Akzentzeichen aus anderen Sprachen. Bei PlanMaker können Sie diese sogenannten
Sonderzeichen bequem über die integrierte Zeichentabelle einfügen.

Gehen Sie dazu folgendermaßen vor:

1. Rufen Sie den Menübefehl Einfügen > Sonderzeichen auf.

2. Es erscheint ein Dialogfenster, das alle in der derzeit gewählten Schrift verfügbaren Zeichen anbietet.
Über die aufklappbare Liste Schriftart können Sie bei Bedarf eine andere Schriftart wählen.

3. Über die aufklappbare Liste Subset können Sie zu einem bestimmten Bereich des Zeichensatzes sprin-
gen. Wählen Sie beispielsweise Kyrillisch, um zu den kyrillischen Zeichen zu gelangen (sofern in der
gewählten Schriftart welche vorhanden sind).

Hinweis: Viele Schriften enthalten nur einen kleinen Teil des verfügbaren Zeichensatzes. Ein besonders
großes Reservoir an Zeichen ist in den bei Ihrem Betriebssystem mitgelieferten Standardschriften vor-
handen. Bei Windows sind dies zum Beispiel die Schriften Arial, Tahoma und Times New Roman.
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4. Selektieren Sie das einzufügende Zeichen mit den Pfeiltasten und drücken Sie die Eingabetaste ¿ oder
führen Sie einen Doppelklick auf das Zeichen aus, um es in den Text einzufügen.

5. Sie können nun auf die gleiche Weise noch weitere Zeichen einfügen oder den Dialog mit der Schaltflä-
che Schließen beenden.

Tipp für Windows-Anwender: Die meisten Windows-Versionen enthalten zwei Symbolschriften namens
Symbol und Wingdings. Darin finden Sie zahlreiche nützliche Symbole (Telefonsymbole, Bullets etc.).

Tastenkürzel verwenden

Wenn Sie ein bestimmtes Sonderzeichen besonders häufig benötigen, können Sie ihm jederzeit ein Tasten-
kürzel geben. Dies hat den Vorteil, dass Sie das Zeichen dann blitzschnell mit einem einzigen Tastendruck
einfügen können.

Um einem Sonderzeichen ein Tastenkürzel zuzuordnen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Einfügen > Sonderzeichen auf.

2. Wählen Sie das Sonderzeichen, dem Sie ein Tastenkürzel geben möchten.

3. Klicken Sie neben der Option Tastenkürzel auf die Schaltfläche Ändern.

4. Es erscheint ein weiterer Dialog. Drücken Sie darin im Eingabefeld Bitte Tastenkürzel drücken das ge-
wünschte Tastenkürzel.

Wir empfehlen Ihnen, stets Tastenkombinationen mit den Tasten Strg und Umschalt zu verwenden, da
diese normalerweise nicht belegt sind.

Tipp: Falls Sie sich vertippt haben, können Sie das eingegebene Tastenkürzel mit der RücktasteÕ wie-
der löschen.

5. Nicht vergessen: Klicken Sie auf Hinzufügen, um dem Zeichen dieses Tastenkürzel zuzuweisen. 

6. Bestätigen Sie mit OK und verlassen Sie den Hauptdialog mit Schließen.

Von nun an können Sie dieses Sonderzeichen mit der entsprechenden Tastenkombination einfügen. 

Hinweis: Das Tastenkürzel merkt sich nur das ausgewählte Zeichen, nicht jedoch die gewählte Schriftart.

Weitere Informationen zum Ändern der Tastaturbelegung finden Sie im Abschnitt Tastenkürzel anpassen.
Tipp: Die Tastenkürzel für Sonderzeichen können Sie bearbeiten, indem Sie in dem Dialog für das Bearbei-
ten der Tastaturbelegung in der linken Liste den Eintrag Zeichen auswählen.

Sonderzeichen über ihren Zeichencode einfügen

Es gibt noch eine andere Methode zum Einfügen von Sonderzeichen: Tippen Sie dazu dessen hexadezima-
len Zeichencode (Unicode) ein, und betätigen Sie dann die Tastenkombination Strg+Alt+Umschalt+X. 

Wenn Sie beispielsweise 20AC eingeben und dann diese Tastenkombination drücken, erhalten Sie ein Euro-
zeichen, da dieses in der Unicode-Zeichentabelle den Zeichencode 20AC hat.

Sonderzeichen über Alt + Nummernblock einfügen

Und hier noch eine weitere Methode zum Einfügen eines Sonderzeichens, über dessen ASCII Code: Halten
Sie dazu die Taste Alt gedrückt, und geben Sie dabei die entsprechende Ziffernfolge ein (nur über den
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Nummernblock möglich!). Bitte achten Sie auch darauf, dass der Nummernblock über die Num-Taste akti-
viert ist

Wenn Sie beispielsweise Alt+0128 eingeben, erhalten Sie ein Eurozeichen, sobald Sie die Alt-Taste losge-
lassen haben.

Mac/Linux: Auf manchen Systemen (inklusive macOS und einigen Linux-Distributionen) funktionieren
diese Tastenkombinationen nicht.
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Gestalten einer Tabelle
Durch den Einsatz von Diagrammen, Farben, Umrandungen und anderen Gestaltungsmöglichkeiten können
Sie das Erscheinungsbild Ihrer Tabellen aufwerten und die Lesbarkeit erhöhen.

In diesem Kapitel erfahren Sie alles über das Gestalten ansprechender Tabellen. Folgende Themen werden
darin behandelt:

¡ Zellengröße 

Die Zellengröße kann unter anderem über die Untermenüs der Menübefehle Arbeitsblatt > Zeile und
Arbeitsblatt > Spalte. Sie können die Zellengröße aber auch durch Ziehen an den Zeilen- und Spalten-
köpfen ändern.

¡ Zahlenformat 

PlanMaker kann Zahlen in den unterschiedlichsten Zahlenformaten anzeigen: angefangen bei einfachen
Zahlen mit und ohne Nachkommastellen über Währungs-, Prozent- und Datumsformate bis hin zu frei
definierbaren Formaten. Der Menübefehl Format > Zelle lässt Sie das Format genau festlegen.

¡ Umrandung 

Mit dem Menübefehl Format > Umrandung können Zellen mit einer Umrandung oder einzelnen Linien
versehen werden.

¡ Schattierung 

Der Hintergrund von Zellen kann mit einer Schattierung versehen werden. Der Menübefehl Format >
Schattierung stellt hierzu verschiedene Farben, Raster und Muster zur Verfügung.

¡ Ausrichtung 

Mit dem Menübefehl Format > Zelle können Sie Zellinhalte unter anderem ausrichten (linksbündig,
rechtsbündig etc.) und drehen.

¡ Schutz 

Weiterhin können Sie mit dem Menübefehl Format > Zelle Zellen schützen, so dass diese beispielswei-
se nicht überschrieben oder verändert werden können. Diesem Thema widmet sich auch der Abschnitt
Blattschutz.

¡ Zeichenformat 

Der Menübefehl Format > Zeichen lässt Sie das Zeichenformat von Zellen oder einzelnen Zeichen fest-
legen. Dazu gehören Einstellungen wie die Schriftart, Textauszeichnungen (fett, kursiv etc.) und die
Schriftfarbe.

¡ Absatzformat (nur in Textrahmen) 

Wenn Sie Textrahmen in die Tabelle eingefügt haben, können Sie jederzeit die Absatzformatierung (Zei-
lenabstand, Einzüge etc.) des enthaltenen Textes ändern. Dazu dient der Menübefehl Format > Absatz
(nur in Textrahmen verfügbar).

¡ Zeichenvorlagen 

Besonders häufig benötigte Zeichenformate lassen sich in einer Zeichenvorlage speichern, die Sie dann
beliebig oft anwenden können.
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¡ Zellenvorlagen 

Darüber hinaus können Sie Zellenvorlagen erstellen. In diesen lässt sich sowohl das Zeichenformat
(Schriftart etc.) als auch das Zellenformat (Zahlenformat, Umrandung, Schattierung, Ausrichtung und
Zellschutz) speichern.

¡ Dokumentvorlagen 

Wenn Sie einen Satz an Zeichen- und Zellenvorlagen erstellt haben und der Meinung sind, dass Sie diese
auch in Zukunft gut gebrauchen können, können Sie diese in einer Dokumentvorlage speichern.

¡ AutoFormat 

Der Befehl AutoFormat ist ein besonders praktischer Helfer: Er formatiert einen kompletten Tabellen-
bereich in einem von zahlreichen vorgegebenen Formaten – auf Knopfdruck.

¡ Bedingte Formatierung 

Sie können Zellen auch mit einer bedingten Formatierung versehen. Diese wird nur angewandt, wenn ei-
ne bestimmte Bedingung erfüllt ist. So können Sie beispielsweise festlegen, dass eine Zelle immer dann
rot eingefärbt werden soll, wenn sie einen Wert größer als 1000 enthält.

¡ Gültigkeitsprüfung 

Wenn Sie Zellen mit einer Gültigkeitsprüfung versehen, werden darin nur noch bestimmte Arten von
Werten (zum Beispiel nur Zahlen) innerhalb der angegebenen Grenzwerte (zum Beispiel nur Werte zwi-
schen 10 und 20) als gültig erachtet.

¡ Format übertragen 

Mit dem Befehl Format übertragen können Sie die Formatierung einer Zelle mit einem "Pinsel" blitz-
schnell auf andere Zellen übertragen.

¡ Seitenformat 

Das Seitenformat bestimmt das Erscheinungsbild des Dokuments beim Ausdruck. Dazu gehören Einstel-
lungen wie das Papierformat, Seitenränder, Kopf- und Fußzeilen und vieles mehr. Diese können Sie mit
dem Menübefehl Datei > Seite einrichten festlegen.

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Zellengröße
Auf den nächsten Seiten lernen Sie die unterschiedlichen Methoden zum Festlegen der Größe von Zellen
kennen.

Wichtig: Wenn in einer Zelle statt des Inhalts lauter Doppelkreuze angezeigt werden (z.B. ########),
liegt das daran, dass die Spalte zu schmal ist, um den Zellinhalt darzustellen. Verbreitern Sie die Spalte
dann entsprechend.
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Zellengröße per Maus ändern

Oberhalb der Tabelle finden Sie mit A, B, C etc. beschriftete Schaltflächen, links der Tabelle sehen Sie
Schaltflächen mit der Beschriftung 1, 2, 3 etc. 

Über diese sogenannten Spaltenköpfe und Zeilenköpfe können Sie die Spaltenbreiten und Zeilenhöhen Ihrer
Tabelle ganz einfach mit der Maus ändern:

¡ Zum Ändern der Spaltenbreite einer Spalte führen Sie den Mauszeiger auf den rechten Rand des zugehö-
rigen Spaltenkopfes. Der Mauszeiger verwandelt sich in einen Doppelpfeil. Wenn Sie nun die linke
Maustaste drücken und gedrückt halten, können Sie die Spaltenbreite durch Ziehen mit der Maus ändern.
 

¡ Zum Ändern der Zeilenhöhe benutzen Sie in gleicher Weise den unteren Rand eines Zeilenkopfes.

Zellengröße per Menü ändern

Über die Menübefehl Arbeitsblatt > Spalte und Arbeitsblatt > Zeile können Sie die Spaltenbreiten und
Zeilenhöhen Ihrer Tabelle per Menü ändern. 

Beim Aufruf eines dieser beiden Menübefehle klappt ein Untermenü auf, das unter anderem folgende Ein-
träge enthält:

Breite (beziehungsweise Höhe)

Mit diesem Befehl können Sie die Breite der Spalte beziehungsweise die Höhe der Zeile exakt festlegen.
Geben Sie dazu den gewünschten Wert in das Eingabefeld ein.

Optimale Breite (beziehungsweise Optimale Höhe)

Der Menübefehl Arbeitsblatt > Spalte > Optimale Breite passt die Breite einer Tabellenspalte automa-
tisch an ihren Inhalt an.

Sie können diesen Befehl auf folgende Arten einsetzen:

¡ Wenn Sie eine komplette Spalte markieren und diesen Befehl aufrufen, wird die Spaltenbreite an diejeni-
ge Zelle angepasst, deren Inhalt den meisten Platz benötigt. 

Tipp: Dies geht auch schneller: Führen Sie einfach einen Doppelklick auf den Spaltenkopf durch, um
eine Spalte auf die optimale Breite zu setzen. 

¡ Wenn Sie eine einige Zellen innerhalb einer Spalte markieren und diesen Befehl dann aufrufen, werden
zum Ermitteln der optimalen Spaltenbreite nur diese Zellen berücksichtigt. 

¡ Wenn Sie hingegen gar nichts markieren und diesen Befehl aufrufen, wird die Spaltenbreite an den In-
halt der aktuellen Zelle angepasst.

Entsprechendes gilt den Menübefehl Arbeitsblatt > Zeile > Optimale Höhe, mit dem Sie die Höhe einer
Zeile automatisch anpassen können.
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Einblenden und Ausblenden von Zeilen/Spalten

Sie können einzelne Zeilen und Spalten ausblenden, also unsichtbar machen. Dies ist nützlich, wenn deren
Inhalt im Augenblick nicht benötigt wird oder verborgen bleiben soll.

Tipp: Wenn Sie den Blattschutz für das aktuelle Arbeitsblatt aktivieren, lassen sich ausgeblendete Zellen
auf diesem Blatt nicht mehr einblenden. Siehe auch Abschnitt Blattschutz.

Folgendermaßen blenden Sie Zeilen oder Spalten aus:

Ausblenden von Zeilen über ihren Zeilenkopf

Am schnellsten können Sie Zeilen über ihren Zeilenkopf ausblenden. Der Zeilenkopf ist die mit der Zeilen-
nummer beschriftete Schaltfläche links von der Zeile.

Um beispielsweise die Zeile 14 auszublenden, ziehen Sie die untere Begrenzungslinie des Zeilenkopfes für
diese Zeile so lange nach oben, bis die Zeile komplett verschwindet.

Die Zeile ist nun verborgen. Anstelle ihres Zeilenkopfes erscheint ein kleines Dreieck:

Klicken Sie dieses Dreieck an, wird die Zeile wieder eingeblendet.

Ausblenden von Zeilen über den Menübefehl "Arbeitsblatt > Zeile"

Alternativ können Sie Zeilen auch wie folgt ein- und ausblenden:

Markieren Sie die auszublendenden Zeilen und rufen Sie den Menübefehl Arbeitsblatt > Zeile > Ausblen-
den auf.

Die Zeilen werden daraufhin ausgeblendet.

Um sie wieder einzublenden, markieren Sie einen Bereich an Zeilen, der die ausgeblendeten Zeilen enthält
und rufen den Menübefehl Arbeitsblatt > Zeile > Einblenden auf.

Ausblenden von Spalten

Das Aus- und Einblenden von Spalten funktioniert genauso. Hier verwenden Sie entsprechend die Spalten-
köpfe der Spalten beziehungsweise die Menübefehle Arbeitsblatt > Spalte > Ausblenden und Arbeits-
blatt > Spalte > Einblenden.
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Zahlenformat
Auf der Karteikarte Zahlenformat im Dialogfenster des Menübefehls Format > Zelle können Sie das Zah-
lenformat von Zellen ändern.

Das Zahlenformat bestimmt, wie Zahlen in diesen Zellen dargestellt werden. Sie können beispielsweise ein
Zahlenformat auswählen, bei dem die Zahlen mit einem Währungssymbol versehen und auf zwei Nachkom-
mastellen gerundet dargestellt werden (z.B. € 42,50).

Beachten Sie: Die Zahlen werden hierbei nur gerundet angezeigt, aber nicht tatsächlich gerundet. Sie be-
halten also auch weiterhin alle Nachkommastellen. Wenn Sie eine Zahl tatsächlich runden möchten, soll-
ten Sie Rechenfunktionen wie RUNDEN verwenden

Um das Zahlenformat von Zellen zu ändern, gehen Sie wie folgt vor:

1. Markieren Sie die Zellen, deren Zahlenformat geändert werden soll.

2. Rufen Sie den Menübefehl Format > Zelle auf.

3. Wechseln Sie auf die Karteikarte Zahlenformat.

4. Legen Sie das gewünschte Format fest (siehe unten).

5. Bestätigen Sie mit OK.

In dem Dialogfenster können folgende Einstellungen vorgenommen werden:
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¡ Kategorie 

In dieser Liste wählen Sie die gewünschte Art von Zahlenformat. Ausführliche Informationen zu den
einzelnen Formaten finden Sie im Abschnitt Liste der Zahlenformate).

¡ Format 

Bei manchen Zahlenformaten stehen außerdem mehrere Unterformate zur Wahl. Wählen Sie hier das ge-
wünschte Unterformat.

¡ Dezimalstellen 

Bei manchen Formaten können Sie wählen, mit wie vielen Nachkommastellen die Zahlen angezeigt wer-
den sollen.

Hinweis: Die Zahlen werden hierbei nur gerundet angezeigt, aber nicht tatsächlich gerundet. Sie behal-
ten also auch weiterhin alle Nachkommastellen. 

¡ Tausendertrennzeichen 

Bei manchen Formaten können Sie wählen, ob Zahlen mit Tausenderpunkten (z.B. 5.000.000) oder ohne
Tausenderpunkte (z.B. 5000000) angezeigt werden sollen.

¡ Negative Werte in Rot 

Bei manchen Formaten können Sie wählen, ob negative Zahlen in roter Farbe angezeigt werden sollen.

¡ Minuszeichen unterdrücken 

Bei manchen Formaten können Sie wählen, ob bei negativen Zahlen das Minuszeichen vor der Zahl un-
terdrückt werden soll.

¡ Null nicht anzeigen 

Bei manchen Formaten können Sie wählen, ob der Inhalt von Zellen, die den Wert "0" enthalten, nicht
angezeigt werden soll.

Bestätigen Sie mit OK, werden die Zahlen in den markierten Zellen entsprechend formatiert dargestellt.

Liste der Zahlenformate

Wie im vorherigen Abschnitt beschrieben, können Sie mit dem Menübefehl Format > Zelle das Zahlenfor-
mat einer Zelle einstellen und so bestimmen, wie Zahlen in dieser Zelle dargestellt werden sollen.

Hierfür gibt es folgende Zahlenformate:

Standard

Stellt die Zahl so dar, wie sie eingegeben wurde. 

Genauer gesagt: Die Zahl wird rechtsbündig angezeigt; ansonsten werden aber keine Änderungen an ihrer
Formatierung vorgenommen. Sie wird mit so vielen Nachkommastellen angezeigt, wie sie tatsächlich besitzt
(maximal jedoch mit fünf Nachkommastellen).

Beispiel: 42
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Zahl

Entspricht dem Zahlenformat Standard, lässt Sie aber verschiedene Formatierungsoptionen einstellen (sie-
he vorheriger Abschnitt). Unter anderem können Sie festlegen, mit wie vielen Nachkommastellen die Zahl
angezeigt werden soll.

Beispiel: 42,00

Beachten Sie: Die Zahl wird hierbei nur gerundet angezeigt, aber nicht tatsächlich gerundet. Sie behält
also auch weiterhin alle Nachkommastellen. Wenn Sie die Zahl tatsächlich runden möchten, sollten Sie
eine Rechenfunktion wie RUNDEN verwenden

Währung

Zeigt die Zahl mit einem Währungssymbol und zwei Nachkommastellen an. 

Die gewünschte Währung können Sie in der Liste Währung auswählen.

Beispiel: € 42,00

Buchhaltung

Entspricht dem Zahlenformat Währung (siehe oben), stellt die Zahl jedoch so dar, wie es in der Buchhal-
tung üblich ist. 

Der Unterschied zum Währungsformat besteht darin, dass bei negativen Beträgen das Minuszeichen am lin-
ken Zellrand steht, abgetrennt von der Zahl. Außerdem werden Währungssymbole bündig untereinander
ausgerichtet.

Beispiel: -€      42,00

Datum/Zeit

Stellt die Zahl als Datum und/oder Uhrzeit dar.

In der Liste Format werden dazu, abhängig von den Ländereinstellungen Ihres Systems, zahlreiche unter-
schiedliche Schreibweisen angeboten. 

Prozent

Stellt die Zahl als Prozentwert dar. 

Dazu wird nicht nur ein Prozentzeichen (%) hinter der Zahl angezeigt, sondern die Zahl auch mit 100 multi-
pliziert dargestellt. Schließlich entspricht beispielsweise 0,5 – in Prozent ausgedrückt – 50%.

Beispiel: 4200%

Wissenschaft

Stellt die Zahl in wissenschaftlicher Schreibweise (Exponentialschreibweise) dar.

Beispiele: 5E+03 (entspricht 5 * 10 hoch 3, also 5000)

4,2E-01 (entspricht 4,2 * 10 hoch -1, also 0,42)
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Bruch

Stellt die Zahl als Bruch dar.

Das Format des Bruchs ist in der Liste Format wählbar.

Beachten Sie: Die Zahl wird dazu bei Bedarf gerundet angezeigt. Wenn Sie also beispielsweise das For-
mat Als Halbe wählen und dann die Zahl 2,3 eingeben, wird diese als 2 1/2 angezeigt.

Beispiele: 2 1/2

5 9/10

Wahrheitswert

Stellt den Wert in der Zelle als Wahrheitswert dar.

Genauer gesagt: Ist der Wert Null, wird FALSCH angezeigt. Für alle anderen Werte wird WAHR angezeigt.

Beispiele: WAHR

FALSCH

Text

Ein Sonderfall: Dieses Format zwingt PlanMaker dazu, die Zahl in der Zelle wie Text zu behandeln – nicht
wie eine Zahl. 

Die Zahl wird linksbündig ausgerichtet und exakt so dargestellt, wie sie eingegeben wurde. Im Gegensatz zu
allen anderen Zahlenformaten werden Zahlen hier nach der Eingabe nicht automatisch umformatiert. Es
werden also keine führenden Nullen entfernt, Datumsangaben werden nicht automatisch formatiert etc.

Ein Anwendungsgebiet für dieses Format sind Zahlen mit führenden Nullen (z.B. Telefonvorwahlen). Tip-
pen Sie in einer Zelle die Telefonvorwahl "089" ein, entfernt PlanMaker normalerweise automatisch die
führende Null. Formatieren Sie die Zelle zuvor mit dem Zahlenformat Text, geschieht dies nicht.

Vorsicht: Dieses Zahlenformat wurde aus Kompatibilitätsgründen genau so wie in Microsoft Excel im-
plementiert und liefert deshalb auch in PlanMaker unerwartete Ergebnisse bei numerischen Berechnun-
gen: 
Wenn Sie beispielsweise die Zellen A1 und A2 mit diesem Format versehen, liefert die Berechnung
A1+A2 die korrekte Summe dieser Zellen. Das Ergebnis der Berechnung SUMME (A1:A2) ist hingegen
Null. Für die meisten Rechenfunktionen hat Text nämlich generell den Wert Null!

Benutzerdefiniert

Stellt die Zahl in einem frei definierbaren Zahlenformat dar.

Lesen Sie dazu den nächsten Abschnitt.
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Benutzerdefinierte Zahlenformate verwenden

Bei Bedarf können Sie mit dem Menübefehl Format > Zelle auch eigene Zahlenformate definieren und an-
wenden.

Ein neues Zahlenformat definieren und anwenden

Folgendermaßen legen Sie ein neues benutzerdefiniertes Zahlenformat an:

1. Selektieren Sie die Tabellenzellen, auf die Sie das neue Zahlenformat anwenden möchten.

2. Rufen Sie den Menübefehl Format > Zelle auf und wechseln Sie auf die Karteikarte Zahlenformat.

3. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert.

4. Klicken Sie in das Eingabefeld bei Format.

5. Geben Sie eine Zeichenkette mit Formatcodes ein, um das Format zu bestimmen. 

Eine Tabelle aller verfügbaren Codes finden Sie im Abschnitt Aufbau eines benutzerdefinierten Zahlen-
formats.

6. Bestätigen Sie mit OK.

Das Zahlenformat wurde nun angelegt (und auch gleich auf die markierten Zellen angewandt). 

Tipp: Falls Sie ein Zahlenformat erstellen möchten, das so ähnlich wie eines der eingebauten Zahlenformate
aussehen soll, haben wir einen guten Tipp für Sie: Klicken Sie nach dem Öffnen des Dialogs erst auf das ge-
wünschte eingebaute Zahlenformat in der Liste Kategorie. Dessen Formatcodes werden dann nämlich als
Vorgabe in das Eingabefeld für die Formatcodes (Schritt 5.) übertragen. Jetzt müssen Sie nur noch die ge-
wünschten Änderungen vornehmen – fertig.

Benutzerdefinierte Zahlenformate anwenden

Natürlich können Sie ein einmal definiertes Zahlenformat auch jederzeit auf andere Zelle anwenden. Das
geht folgendermaßen:

1. Selektieren Sie die gewünschten Tabellenzellen.

2. Rufen Sie den Menübefehl Format > Zelle auf und wechseln Sie auf die Karteikarte Zahlenformat.

3. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert.

4. In der Liste Format sind alle benutzerdefinierten Zahlenformate für das aktuelle Dokument aufgelistet.
Wählen Sie das gewünschte Format darin aus.

5. Bestätigen Sie mit OK.

Das Zahlenformat wird nun auf die markierten Zellen angewandt.

Benutzerdefinierte Zahlenformate löschen

Wenn Sie ein benutzerdefiniertes Zahlenformat nicht mehr benötigen, können Sie es jederzeit löschen. Ge-
hen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl Format > Zelle auf und wechseln Sie auf die Karteikarte Zahlenformat.
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2. Wählen Sie in der Liste Kategorie den Eintrag Benutzerdefiniert.

3. Wählen Sie das zu löschende Format in der Liste Format.

4. Klicken Sie auf die Schaltfläche Löschen.

5. Verlassen Sie den Dialog (am besten mit der Schaltfläche Abbrechen, da beim Klicken auf OK ja sonst
das momentan selektierte Zahlenformat auf die aktuelle Zelle angewandt werden würde).

Anmerkung: Die Schaltfläche Löschen ist nur bei benutzerdefinierten Zahlenformaten verfügbar; die einge-
bauten Formate lassen sich nicht löschen.

Aufbau eines benutzerdefinierten Zahlenformats

Beim Anlegen eines neuen Zahlenformats geben Sie (wie im vorherigen Abschnitt beschrieben) eine Zei-
chenkette mit Formatcodes ein. Diese Codes bestimmen, wie die Zahl dargestellt wird. 

Ein Beispiel:

#,00

Diese Formatcodes bewirken, dass Zahlen wie folgt ausgegeben werden: sämtliche Vorkommastellen, dann
der Dezimaltrenner, dann genau zwei Nachkommastellen. 

Im Einzelnen sind folgende Formatcodes verfügbar:

Formatcodes für Zahlen und Text

Für Zahlen und Text gibt es die folgenden Formatcodes:

Code Bedeutung

# Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl keine Ziffer befindet, nichts
ausgeben.

Beispiel: #,## ergibt bei 1,2 beispielsweise 1,2.

0 Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl keine Ziffer befindet, statt-
dessen eine Null ausgeben.

Beispiel: #,00 ergibt bei 1,2 beispielsweise 1,20.

? Eine Ziffer der Zahl ausgeben. Falls sich an dieser Position der Zahl keine Ziffer befindet, statt-
dessen ein Leerzeichen ausgeben.

Beispiel: #,?? ergibt bei 1,2 beispielsweise 1,2  (mit einem Leerzeichen hinter der 2).

Wichtig: Sobald sich vor dem Dezimalkomma mindestens einer der obigen drei Formatcodes be-
findet, werden alle Vorkommastellen angezeigt. Der Formatcode 0,00 liefert bei der Zahl 123,456
also nicht 3,46 sondern 123,46.

, (Komma) An dieser Stelle den Dezimaltrenner ausgeben.

Hinweis: Falls Ihr System als Dezimaltrenner nicht ein Komma, sondern ein anderes Zeichen nutzt
(zum Beispiel einen Punkt), verwenden Sie bitte dieses Zeichen anstelle des Kommas.
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. (Punkt) Die Zahl mit Tausendertrennzeichen ausgeben. Fügen Sie dazu einfach (an einer beliebigen Stel-
le) einen Punkt in das Zahlenformat ein. .0,00 ergibt bei 5000000 beispielsweise 5.000.000,00.

Hinweis: Falls Ihr System als Tausendertrenner nicht einen Punkt, sondern ein anderes Zeichen
nutzt, verwenden Sie bitte dieses Zeichen anstelle des Punkts.

% An dieser Stelle ein Prozentzeichen ausgeben, und die Zahl außerdem mit 100 multiplizieren. 

Beispiel: 0% ergibt bei 0,5 beispielsweise 50%.

E+ oder e+ Wissenschaftliche Schreibweise (Exponentialschreibweise) verwenden. 

Beispiel: 0E+00 ergibt bei 50000 beispielsweise 5E+04.

Tipp: Technische Schreibweise (bei der nur durch 3 teilbare Exponenten erlaubt sind) ist ebenfalls
möglich: #00E+00 ergibt beispielsweise bei 50000 nicht 5E+04 sondern 50E+03.

E- oder e- Entspricht E+, allerdings wird das Vorzeichen beim Exponenten nur dann ausgegeben, wenn der
Exponent negativ ist. (Bei E+ hingegeben wird es immer ausgegeben.) 

Beispiel: 0E-00 ergibt bei 50000 beispielsweise 5E04.

Standard Platzhalter für den kompletten Zellinhalt (im Zahlenformat "Standard")

@ Platzhalter für den kompletten Zellinhalt als Text

\ Das nachfolgende Zeichen nicht als Formatcode interpretieren, sondern es einfach ausgeben.

Wenn Sie beispielsweise das Zeichen "#" ausgeben möchten, müssen Sie hierfür \# schreiben (da
"#" ja ein gültiger Formatcode ist).

"Text" Den Text zwischen den Anführungszeichen nicht als Formatcode interpretieren, sondern ihn ein-
fach ausgegeben.

Beispiel: "MeinText"

* (Sternchen) Das nachfolgende Zeichen wiederholen. *x füllt beispielsweise die komplette Zelle mit dem Zei-
chen "x".

Beispiel: Das Zahlenformat "Summe:"* 0,00 gibt links in der Zelle den Text "Summe:" und rechts
die Zahl (mit zwei Nachkommastellen) aus. Der Raum dazwischen wird mit Leerzeichen aufge-
füllt.

_ (Unterstrich) Einen Leerraum in der Breite des nachfolgenden Zeichens ausgeben. 

Beispiel: Der Code _- liefert beispielsweise einen Leerraum, der exakt breit ist wie ein Minuszei-
chen. 

[Rot] Zeigt den Zellinhalt in roter Farbe an. Insgesamt gibt es folgende Farbcodes:

[Schwarz] [Weiß] [Rot] [Grün] [Blau] [Zyan] [Magenta] [Gelb] 

Formatcodes für Daten und Uhrzeiten

Für Datumsangaben und Uhrzeiten sind ausschließlich die folgenden Formatcodes zulässig:
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Hinweis: Achten Sie genau auf die Groß-/Kleinschreibung der Formatcodes!

Code Bedeutung

T Tag (1-31)

TT Tag, zweistellig (01-31)

TTT Wochentag, abgekürzt ("Mo" bis "So")

TTTT Wochentag ("Montag" bis "Sonntag")

M Monat (1-12)

MM Monat, zweistellig (01-12)

MMM Monatsname, abgekürzt ("Jan" bis "Dez")

MMMM Monatsname ("Januar" bis "Dezember")

MMMMM Monatsname, nur erster Buchstabe ("J" für Januar bis "D" für Dezember)

JJ Jahr, zweistellig (z.B. 18)

JJJJ Jahr, vierstellig (z.B. 2018)

Q Quartal (1-4)

QQ Das Wort "Quartal" in der Sprache, die in den regionalen Einstellungen des Systems gewählt wur-
de

h Stunde (0-23)

hh Stunde, zweistellig (00-23)

m Minute (0-59)

mm Minute, zweistellig (00-59)

s Sekunde (0-59)

ss Sekunde, zweistellig (00-59)

0 Zehntelsekunden (z.B. hh:mm:ss,0)

00 Hundertstelsekunden (z.B. hh:mm:ss,00)

000 Tausendstelsekunden (z.B. hh:mm:ss,000)

AM/PM Stunden im 12 Stunden-Format ausgegeben und AM beziehungsweise PM anhängen. Muss sich
am Ende der Zeichenkette mit den Formatcodes befinden! 

Beispiel: h:mm:ss AM/PM

am/pm Wie AM/PM, jedoch mit am oder pm (in Kleinbuchstaben)

a/p Wie AM/PM, jedoch mit a oder p
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[h] Zahl der Stunden im Endlosformat*

[m] Zahl der Minuten im Endlosformat*

[mm] dito, aber als zweistellige Zahl*

[s] Zahl der Sekunden im Endlosformat*

[ss] dito, aber als zweistellige Zahl*

[$-n] Optional: Ländercode für die Sprache, in der Tages- und Monatsnamen ausgegeben werden.
Wenn Sie keinen Ländercode angeben, verwendet PlanMaker automatisch die Systemsprache. [$-
407] steht beispielsweise für Deutsch, [$-409] für Englisch (US).

* Das Endloszeitformat zeichnet sich dadurch aus, dass es Uhrzeiten nicht nach 24 Stunden auf 0:00 zurücksetzt. Dadurch eignet es sich besonders
für das Rechnen mit Uhrzeiten. Addieren Sie beispielsweise die Uhrzeiten 20:00 und 5:00, ist das Ergebnis normalerweise 1:00. Formatieren Sie
dieses jedoch im Format [h]:mm, so lautet das Ergebnis 25:00.

Weiterhin sind beim Endloszeitformat auch negative Werte möglich: 7:00 - 10:00 ergibt also nicht 21:00, sondern -3:00.

Das gleiche gilt für Minuten und Sekunden: Auch diese werden nicht nach 60 Minuten bzw. 60 Sekunden zurückgesetzt. So können Sie das End-
loszeitformat sogar für das Umrechnen von Zeitangaben in Minuten oder Sekunden verwenden. Formatieren Sie 02:00:00 beispielsweise als
[mm]:ss, wird 120:00 ausgegeben; 2 Stunden sind also 120 Minuten. Beim Format [ss] würde 7200 angezeigt; 2 Stunden sind also 7200 Sekun-
den.

Definieren separater Abschnitte für positive Zahlen, negative Zahlen, Nullwerte und Text

Bei Bedarf können Sie die Zeichenkette mit den Formatcodes in bis zu vier Abschnitte unterteilen, die
durch Strichpunkte zu trennen sind. Dies ermöglicht das Definieren eines eigenen Zahlenformats jeweils für
positive Zahlen, negative Zahlen, den Wert Null und Text – in folgender Form:

Positiv; Negativ; Null; Text

Die Anzahl der Abschnitte, die Sie dabei definieren, wirkt sich wie folgt aus:

Zahl der Abschnitte Auswirkung

Nur 1 Abschnitt: Die Formatcodes gelten für alle Werte.

2 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte.

Die Codes im 2. Abschnitt gelten für negative Werte.

3 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte.

Die Codes im 2. Abschnitt gelten für negative Werte.

Die Codes im 3. Abschnitt gelten für die Zahl Null.

4 Abschnitte: Die Codes im 1. Abschnitt gelten für positive Werte.

Die Codes im 2. Abschnitt gelten für negative Werte.

Die Codes im 3. Abschnitt gelten für die Zahl Null.

Die Codes im 4. Abschnitt gelten für Text.

Ein Beispiel (mit zwei Abschnitten):

0,00; -0,00[Rot]

Dieses Zahlenformat liefert folgende Formatierung:
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Abschnitt 1: 0,00 bedeutet: Positive Zahlen mit zwei Nachkommastellen darstellen.

Abschnitt 2: -0,00[Rot] bedeutet: Negative Zahlen ebenfalls mit zwei Nachkommastellen darstellen. Minus-
zeichen davor anzeigen (siehe Hinweis!). Zahl außerdem rot einfärben.

Hinweis: Wenn Sie ein Zahlenformat mit zwei (oder mehr) Abschnitten definieren, müssen Sie im zwei-
ten Abschnitt explizit ein Minuszeichen hinzufügen, wenn Sie möchten, dass bei negativen Zahlen eines
angezeigt wird. 

Im Gegensatz zu Zahlenformaten mit nur einem Abschnitt wird das Minuszeichen hier bei negativen Zahlen
nämlich nicht automatisch angezeigt. 

Definieren separater Abschnitte mithilfe von Bedingungen

Alternativ können Sie die Zeichenkette mit den Formatcodes auch in mehrere Abschnitte aufteilen, indem
Sie eine Bedingung für jeden Abschnitt angeben. 

Auch hier sind die einzelnen Abschnitte durch Strichpunkte zu trennen. Um die Bedingungen zu definieren,
fügen Sie einfach jedem Abschnitt die gewünschte Vergleichsoperation in eckigen Klammern hinzu – zum
Beispiel Bedingungen wie [>0] oder [>=100] oder [=42].

Es dürfen maximal zwei Sektionen mit Bedingungen angelegt werden. Dahinter sollte außerdem eine Sekti-
on ohne Bedingung hinzugefügt werden. Diese definiert dann das Format für Zahlen, die keiner der Bedin-
gungen entsprechen.

Ein Beispiel:

[<=0][Blau]0,00; [>30][Rot]0,00; 0,00

Diese Formatcodes zeigen die Zahlen in Blau an, wenn der Wert kleiner oder gleich Null ist – und in Rot,
wenn der Wert größer als 30 ist. Trifft keine der beiden Bedingungen zu, wird der Wert ohne Einfärbung
(also in schwarz) angezeigt.

Tipp: Erheblich komfortabler lassen sich solche Aufgaben über "bedingte Formatierungen" lösen. Siehe
Abschnitt Bedingte Formatierung.

Umrandung
Auf der Karteikarte Umrandung im Dialogfenster des Menübefehls Format > Zelle können Sie Zellen mit
einer kompletten Umrandung oder einzelnen Linien versehen. Auch Gitternetzlinien (die Linien zwischen
den Zellen) lassen sich hier anbringen.

Alternativ lässt sich dieses Kommando auch über den Menübefehl Format > Umrandung aufrufen.
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Ein ähnlicher Dialog erscheint auch bei Objekten, die sich mit Umrandungslinien versehen lassen (zum Bei-
spiel Textrahmen). Die Bedienung ist jeweils identisch.

Kurz zusammengefasst wird dieser Dialog wie folgt bedient:

1. Erst legen Sie fest, was für eine Art von Umrandungslinie angebracht werden soll (Linienstil, Liniendi-
cke, Farbe).

2. Dann legen Sie fest, wo diese Art von Umrandungslinie angebracht werden soll. Dazu klicken Sie ein-
fach in der rechten Hälfte des Dialogs auf die gewünschten Linien (oder deren Schaltflächen).

Sehen wir uns die einzelnen Schritte einmal etwas genauer an. 

Um Tabellenzellen mit Umrandungslinien zu versehen, gehen Sie wie folgt vor:

1. Selektieren Sie die gewünschten Zellen.

2. Rufen Sie den Menübefehl Format > Umrandung auf.

3. Legen Sie als erstes fest, welche Art von Umrandungslinie angebracht werden soll. Hierfür gibt es fol-
gende Einstellmöglichkeiten:

Linienstil (einfache Linien, doppelte Linien oder gestrichelte Linien)

Liniendicke (die Stärke der Linie)

Farbe (die Farbe der Linie)

4. Legen Sie dann fest, wo Sie diese Art von Umrandungslinie anwenden möchten (oben, unten, links,
rechts, etc.). 

Hierfür finden Sie in der rechten Hälfte des Dialogs einen Kasten mit einer Vorschau auf das Ergebnis,
umgeben von einigen Schaltflächen. Verwenden Sie diese wie folgt:
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A) Klicken Sie in der Vorschau in der rechten Hälfte des Dialogs einfach direkt auf alle Linien, an denen
eine Umrandungslinie angebracht werden soll. 

B) Alternativ können Sie hierfür auch die Schaltflächen verwenden, die links und unterhalb der Vor-
schau angezeigt werden. Jede Schaltfläche steht für eine bestimmte Linie (siehe Symbol auf der Schalt-
fläche).

C) Die Schaltflächen oberhalb der Vorschau sind nützliche Abkürzungen: 

Die Schaltfläche Kontur wendet die eingestellte Umrandungslinie auf alle äußeren Linien an. 

Die Schaltfläche Gitter macht das gleiche für alle inneren Linien (also die "Gitternetzlinien"). 

Die Schaltfläche Keine entfernt alle Linien auf einmal.

5. Wenn Sie möchten, können Sie noch weitere Linien anbringen, indem Sie einfach Schritt 4. wiederho-
len. 

Dabei können Sie die Einstellungen für die Linie (Stil, Dicke, Farbe) jederzeit ändern (Schritt 3.), bevor
Sie diese anbringen (Schritt 4.).

6. Wenn alles passt, bestätigen Sie mit OK.

Die Tabellenzellen werden nun mit den entsprechenden Linien versehen.

Vorhandene Umrandungslinien bearbeiten oder entfernen

Sie können Linienstil, -dicke und -farbe von vorhandenen Umrandungslinien jederzeit ändern beziehungs-
weise Linien wieder entfernen. Rufen Sie den Dialog dazu erneut auf und gehen Sie wie folgt vor: 

¡ Ändern: Um das Aussehen einer Linie zu ändern, nehmen Sie zuerst die gewünschten Einstellungen vor
(Linienstil, Liniendicke, Farbe). Dann klicken Sie in der Vorschau auf die Linie (oder ihre Schaltfläche),
auf die Sie diese Einstellungen anwenden möchten. 

¡ Entfernen: Um eine Umrandungslinie zu entfernen, klicken Sie in der Vorschau zwei Mal auf diese Linie
(oder auf ihre Schaltfläche). Einmaliges Anklicken bringt die Umrandungslinie an, nochmaliges Ankli-
cken entfernt sie wieder. 

Tipp: Die Schaltfläche Keine oberhalb der Vorschau entfernt alle Linien.

Tipp: Verwenden der Formatleiste

Sie können alternativ auch das Symbol  ganz rechts in der Formatleiste verwenden, um Umrandungsli-
nien anzubringen.

Gehen Sie dazu wie folgt vor:

1. Selektieren Sie die gewünschten Zellen.

2. Klicken Sie nicht auf das Symbol selbst, sondern auf den Pfeil rechts davon. Es öffnet sich ein Menü, in
dem Sie gewünschte Art der Umrandung bestimmen können. Wählen Sie darin einen Eintrag per
Mausklick.

Die entsprechende Umrandung wird nun angebracht. 

Tipp: Wenn Sie anschließend noch weitere Zellen mit genau der gleichen Art von Umrandung versehen
möchten, genügt es, diese zu markieren und das Symbol selbst (nicht den Pfeil) anzuklicken. PlanMaker
wendet dann die zuletzt gewählte Art von Umrandung erneut an.
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Schattierung
Auf der Karteikarte Schattierung im Dialogfenster des Menübefehls Format > Zelle können Sie Zellen mit
einer farbigen Schattierung oder einem Muster hinterlegen.

Alternativ lässt sich dieses Kommando auch über den Menübefehl Format > Schattierung aufrufen.

Gehen Sie wie folgt vor:

1. Selektieren Sie die gewünschten Zellen.

2. Rufen Sie den Menübefehl Format > Schattierung auf.

3. Bringen Sie die gewünschte Schattierung an (siehe unten).

4. Bestätigen Sie mit OK.

Dabei haben Sie die Wahl zwischen folgenden Arten von Schattierungen:

¡ Ein Raster anbringen 

Ein Raster ist eine Farbschattierung, die aus der gewählten Vordergrundfarbe und Hintergrundfarbe ge-
mischt wird. 

Um ein Raster anzubringen, wählen Sie bei Typ die Option Raster und nehmen dann die gewünschten
Einstellungen vor: 

Stellen Sie zuerst die gewünschte Vordergrundfarbe und Hintergrundfarbe ein. (Für die Hintergrund-
farbe ist Weiß voreingestellt.)
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In der Rubrik Raster werden nun verschiedene Mischungen dieser beiden Farben vorgeschlagen. Wäh-
len Sie einen dieser Vorschläge aus. Alternativ können Sie auch in das Eingabefeld unter Raster die ge-
wünschte Mischung in Prozent eintippen. Zulässig sind Werte zwischen 0 (100% Hintergrundfarbe) und
100 (100% Vordergrundfarbe).

¡ Ein Muster anbringen 

Um ein Muster anzubringen, klicken Sie auf eines der Muster in der Rubrik Muster.

Weiterhin können Sie die Vordergrundfarbe und Hintergrundfarbe für das Muster auswählen. 

¡ Raster oder Muster entfernen 

Möchten Sie ein gewähltes Raster oder Muster wieder entfernen, wählen Sie bei Typ die Option Keines.

Schließlich bestätigen Sie mit OK.

Tipp: Verwenden der Formatleiste

Sie können alternativ auch das Symbol  ganz rechts in der Formatleiste verwenden, um eine Schattie-
rung anzubringen.

Gehen Sie dazu wie folgt vor:

1. Selektieren Sie die gewünschten Zellen.

2. Klicken Sie nicht auf das Symbol selbst, sondern auf den Pfeil rechts davon. Es öffnet sich ein Menü, in
dem Sie gewünschte Farbe bestimmen können. Wählen Sie diese per Mausklick.

Die Schattierung wird nun angebracht. 

Tipp: Wenn Sie anschließend noch weitere Zellen mit der gleichen Schattierung versehen möchten, ge-
nügt es, diese zu markieren und das Symbol selbst (nicht den Pfeil) anzuklicken. PlanMaker wendet dann
die zuletzt gewählte Schattierung erneut an.

Ausrichtung
Auf der Karteikarte Ausrichtung im Dialogfenster des Menübefehl Format > Zelle können Sie die Aus-
richtung des Zellinhalts innerhalb der Zelle bestimmen.

Bevor Sie diesen Befehl aufrufen, müssen Sie die gewünschten Zellen markieren. Soll nur eine einzige Zelle
bearbeitet werden, reicht es, wenn Sie diese ansteuern.
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Das Dialogfenster dieses Befehls enthält folgende Optionen:

Horizontale Ausrichtung

Bestimmt die horizontale Ausrichtung des Zellinhalts innerhalb der Zellgrenzen:

Standard: Text linksbündig, Zahlen rechtsbündig, Wahrheitswerte und Fehlerwerte zentriert

Links: Zellinhalt am linken Rand der Zelle ausrichten

Zentriert: Zellinhalt mittig ausrichten

Rechts: Zellinhalt am rechten Rand der Zelle ausrichten

Blocksatz: Zellinhalt gleichmäßig zwischen linkem und rechten Rand verteilen (wirkt sich nur auf Zellen
mit mehrzeiligem Inhalt und aktivierter Option Zeilenumbruch aus)

Zentriert über Spalten: Zentriert den Inhalt einer Zelle über mehrere Spalten. Markieren Sie dazu die Zelle
sowie beliebige viele benachbarte Zellen rechts davon (diese müssen leer sein!). Wählen Sie dann die Aus-
richtung Zentriert über Spalten.

Vertikale Ausrichtung

Bestimmt die vertikale Ausrichtung des Zellinhalts innerhalb der Zellgrenzen:

Unten: Zellinhalt am unteren Rand der Zelle ausrichten

Zentriert: Zellinhalt vertikal zentrieren

Oben: Zellinhalt am oberen Rand der Zelle ausrichten
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Vertikaler Blocksatz: Zellinhalt gleichmäßig zwischen oberem und unterem Rand verteilen (wirkt sich nur
auf Zellen mit mehrzeiligem Inhalt und aktivierter Option Zeilenumbruch aus)

Drehen um ...

Hier können Sie die komplette Zelle (samt Inhalt) um den gewählten Winkel drehen.

Schreibrichtung

Für Text in arabischer Schrift können Sie hier die Schreibrichtung der Zelle auf rechts-nach-links ändern. 

Tipp: Bei der Standardeinstellung Kontextabhängig stellt PlanMaker die korrekte Schreibrichtung automa-
tisch ein.

Siehe auch Kapitel Arbeiten mit arabischem Text.

Innenränder

Hier können Sie die Innenränder der Zelle einstellen.

Zeilenumbruch

Ist diese Option aktiviert, wird der Zellinhalt automatisch in die nächste Zeile umbrochen, falls die Zellen-
breite nicht ausreicht, um ihn in einer einzigen Zeile anzuzeigen. 

Tipp: Mit der Tastenkombination Strg+¿ können Sie dabei manuell Zeilenumbrüche innerhalb einer Zelle
vornehmen.

Standardmäßig ist die Option ausgeschaltet.

Vertikaler Text

Ist diese Option aktiviert, wird der Zellinhalt nicht von links nach rechts, sondern von oben nach unten ge-
zeichnet.

Zellen verbinden

Ermöglicht das Verbinden einer Zelle mit ihren benachbarten Zellen. Markieren Sie dazu die Zelle sowie
beliebige viele direkt benachbarte Zellen und aktivieren Sie dann diese Option.

Verbundene Zellen werden von PlanMaker so behandelt, als ob sie eine einzige Zelle wären. 

Hinweis: Wenn Sie Zellen verbinden, verlieren alle Zellen außer der linken oberen Zelle ihren Inhalt.

Um die Verbindung wieder zu lösen, klicken Sie auf die verbundenen Zellen und schalten diese Option wie-
der aus.



178Gestalten einer Tabelle

Schutz
Auf der Karteikarte Schutz im Dialogfenster des Menübefehl Format > Zelle können Sie Zellen mit einem
Zellschutz versehen.

Sämtliche Informationen hierzu finden Sie im Abschnitt Blattschutz.

Zeichenformat
Über den Menübefehl Format > Zeichen können Sie das Zeichenformat (Schriftart, Schriftgröße, Schrift-
farbe, Textauszeichnungen etc.) ändern.

Worauf sich dieser Befehl auswirkt, hängt davon ab, was Sie markiert haben, bevor Sie ihn aufrufen:

¡ Wenn Sie nichts markieren, wirkt sich der Befehl auf die Zelle aus, auf der sich der Zellrahmen momen-
tan befindet. 

¡ Wenn Sie mehrere Zellen markieren, sind alle markierten Zellen von der Änderung betroffen.

¡ Sie können auch die Taste F2 in einer Zelle drücken und dann Zeichen innerhalb des Zellinhalts markie-
ren, worauf nur die Zeichenformatierung dieser Zeichen geändert wird.

Das Dialogfenster des Befehls Zeichen verfügt über drei Karteikarten, zwischen denen Sie wechseln kön-
nen, indem Sie mit der Maus oben auf einen der Karteikartenreiter klicken.
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Die einzelnen Karteikarten enthalten folgende Formatierungen:

¡ Karteikarte Schrift 

Schriftart und Schriftgröße, Textauszeichnungen (fett, kursiv, unterstrichen etc.), Schriftfarbe und Hin-
tergrundfarbe wählen

¡ Karteikarte Abstand 

Hoch- und Tiefstellen, Laufweite und Zeichenbreite verändern und Kerning (Unterschneidung von Zei-
chen) ein-/ausschalten

¡ Karteikarte Hyperlink 

Hyperlinks (Verknüpfungen) anbringen und bearbeiten. Lesen Sie dazu den Abschnitt Hyperlinks ver-
wenden.

Ausführliche Informationen zu den einzelnen Formatierungen finden Sie auf den nächsten Seiten.

Schriftart und Schriftgröße

Um die Schriftart und/oder -größe zu ändern, gehen Sie wie folgt vor:

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text.

2. Rufen Sie den Menübefehl Format > Zeichen auf.

3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte Schrift, falls nötig.



180Gestalten einer Tabelle

Nun können Sie die gewünschte Schriftart und -größe einstellen:

¡ Um die Schriftart zu ändern, wählen Sie die gewünschte Schrift in der aufklappbaren Liste Schriftart.  

¡ In der aufklappbaren Liste Größe werden die gebräuchlichsten Schriftgrößen angeboten. Sie können
aber jederzeit andere Werte von Hand eintippen. Die Schriftgröße lässt sich auf Zehntel genau eingeben
– Schriftgrößen wie 11,9 sind also auch zulässig.

Verwenden der Formatleiste

Sie können die Schriftart und -größe auch über die Formatleiste ändern.

In der Formatzeile werden Schriftart und -größe angezeigt. Um diese zu ändern, markieren Sie erst den ge-
wünschten Text und öffnen dann die Liste mit den Schriftarten beziehungsweise -größen, indem Sie auf das
kleine Pfeilchen rechts daneben klicken. Jetzt können Sie eine Schriftart oder -größe per Mausklick auswäh-
len.

Textauszeichnungen

Als Textauszeichnungen werden Zeichenformatierungen wie Fettdruck, Kursivschrift etc. bezeichnet. 

Es gibt bei PlanMaker folgende Textauszeichnungen:

¡ Kursiv: Eine schräg liegende Variante der Schrift. 

¡ Fett: Eine kräftigere ("fettere") Variante der Schrift.

¡ Unterstreichen: Der Text wird unterstrichen (einfach, doppelt, wortweise einfach, wortweise doppelt).

¡ KAPITÄLCHEN: Anstelle von Kleinbuchstaben werden verkleinerte Großbuchstaben ausgegeben.

¡ GROSSBUCHSTABEN: Alle Zeichen werden in Großbuchstaben ausgegeben.

¡ Durchstreichen: Der Text wird durchgestrichen.

¡ Hochstellen (z.B. r2) und Tiefstellen (z.B. H20): Diese Textauszeichnungen sind auf der nächsten Kar-

teikarte zu finden (siehe Abschnitt Hochstellen und Tiefstellen).

Anbringen von Textauszeichnungen

Um Text mit Textauszeichnungen zu versehen, gehen Sie wie folgt vor:

1. Markieren Sie den gewünschten Text.

2. Rufen Sie den Menübefehl Format > Zeichen auf.

3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte Schrift, falls nötig.

Um Fettdruck und/oder Kursivschrift einzuschalten, öffnen Sie die Liste Stil (rechts neben der Schriftgröße)
und wählen darin den gewünschten Eintrag: Normal, Kursiv, Fett oder Fett-kursiv.

Weitere Textauszeichnungen finden Sie in der Sektion Auszeichnungen. Diese lassen sich dort per einfa-
chem Mausklick ein- oder ausschalten.
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Textauszeichnungen können (nahezu) beliebig miteinander kombiniert werden.

Verwenden der Formatleiste

Die gebräuchlichsten Textauszeichnungen lassen sich auch über die Formatleiste anbringen.

Klicken Sie dazu das Symbol für die Textauszeichnung an, um diese ein- oder wieder auszuschalten: Das F
steht für Fettdruck, das K für Kursivschrift und das U für einfaches Unterstreichen.

Tastenkürzel

Tipp: Für einige Textauszeichnungen sind außerdem Tastenkürzel verfügbar:

Befehl Windows/Linux Mac

Fettdruck Strg+Umschalt+F Cmd+B

Kursivschrift Strg+Umschalt+K Cmd+I

Unterstreichen Strg+Umschalt+U Cmd+U

Schriftfarbe

Sie können sowohl Text als auch seinen Hintergrund einfärben. 

Gehen Sie dazu wie folgt vor:

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text.

2. Rufen Sie den Menübefehl Format > Zeichen auf.

3. Es erscheint ein Dialog. Wechseln Sie darin auf die Karteikarte Schrift, falls nötig.

In der Liste Schriftfarbe können Sie nun die gewünschte Farbe für den Text auswählen.

Über die Liste Hintergrundfarbe können Sie zusätzlich die Hintergrundfarbe ändern. Wählen Sie hier an-
stelle der Standardeinstellung Transparent eine andere Farbe, wird der Text mit dieser Farbe hinterlegt.

Tipp: Wenn Sie die Hintergrundfarbe auf diese Weise ändern, wirkt sich das nur die einzelnen Zeichen
innerhalb der Zelle aus. Möchten Sie hingegen die komplette Zelle einfärben, sollten Sie stattdessen den
Menübefehl Format > Schattierung verwenden.

Anmerkungen

¡ Farblisten bieten immer nur einige Standardfarben an, Sie können aber jederzeit auch andere Farben
wählen. Klicken Sie dazu auf den Eintrag Andere... am Ende der Liste (siehe auch Abschnitt Dokumen-
teigenschaften, Karteikarte Farben). 

¡ Die Schriftfarbe lässt sich auch über das Symbol  in der Formatleiste ändern:
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Dazu markieren Sie den gewünschten Text (oder die gewünschten Zellen), klicken auf das Pfeilchen
rechts neben diesem Symbol (also nicht auf das Symbol selbst). Dann wählen Sie die gewünschte Farbe
aus der Liste, die sich daraufhin öffnet. 

Tipp: Um weiteren Text in der gleichen Farbe zu formatieren, markieren Sie diesen wie üblich und kli-
cken dann einfach auf das Symbol selbst. 

Hochstellen und Tiefstellen

Sie können Zeichen auch hochstellen (z.B. r2) oder tiefstellen (z.B. H20).

Gehen Sie dazu wie folgt vor:

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text.

Wenn Sie nur einzelne Zeichen innerhalb einer Zelle ändern wollen, so drücken Sie erst die Taste F2,
um einzelne Zeichen markieren zu können.

2. Rufen Sie den Menübefehl Format > Zeichen auf.

3. Wechseln Sie auf die Karteikarte Abstand.

Nun können Sie die Optionen Hochstellen beziehungsweise Tiefstellen einschalten.

Auf Wunsch lässt sich zusätzlich bei Position angeben, um wie viel Prozent der Text hoch- beziehungswei-
se tiefgestellt werden soll. Weiterhin können Sie durch eine Prozentangabe im Feld Größe bestimmen, wie
stark die Schriftgröße vermindert werden soll. Geben Sie beispielsweise 100 Prozent ein, wenn die Schrift
nicht verkleinert werden soll.

Laufweite und Zeichenbreite

Sie können in PlanMaker sogar die Laufweite und die Zeichenbreite von Zeichen ändern.

Die Laufweite bezeichnet den Abstand zwischen den einzelnen Zeichen. Bei Werten unter 100% rutschen
die Zeichen enger zusammen, bei Werten größer als 100% weiter auseinander.

Wenn Sie die Zeichenbreite ändern, wird nicht der Abstand zwischen den Zeichen, sondern die Breite der
Zeichen selbst verändert – die Zeichen werden also verzerrt. 

Um diese Einstellungen zu ändern, rufen Sie den Menübefehl Format > Zeichen auf, wechseln auf die Kar-
teikarte Abstand und tragen die gewünschten Werte bei Laufweite beziehungsweise Zeichenbreite ein.

Hinweis: Manche Drucker unterstützen das Ändern der Zeichenbreite bei druckerinternen Schriften
nicht. Die Schrift erscheint dann zwar auf dem Bildschirm breiter oder schmaler, nicht jedoch im Aus-
druck.
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Kerning (Unterschneidung)

Bei bestimmten Paaren von Buchstaben sieht das Schriftbild gleichmäßiger aus, wenn diese Buchstaben et-
was näher zusammen oder weiter auseinander geschoben werden. Diesen Ausgleich bezeichnet man als Un-
terschneiden von Zeichen (englisch: Kerning).

Die folgende Abbildung illustriert, was gemeint ist:

Oben: ohne Kerning. Unten: mit Kerning

Beim oberen Text (ohne Kerning) sieht man, dass die Buchstaben "V" und "A" normalerweise zu weit aus-
einander stehen. Beim unteren Text (mit Kerning) wurde dies korrigiert.

Dieser Ausgleich findet vollautomatisch statt. Sie müssen das Kerning lediglich aktivieren. Dazu markieren
Sie die gewünschten Zellen (oder den gewünschten Text), rufen den Menübefehl Format > Zeichen auf,
wechseln auf die Karteikarte Abstand und schalten die Option Kerning verwenden ein. 

PlanMaker korrigiert dann selbstständig den Zeichenabstand von allen Buchstabenpaaren, bei denen dies zu
einer Verbesserung des Schriftbilds führt.

Hinweis: Nicht alle Schriften enthalten in ihren Schriftdaten die hierfür erforderlichen Kerninginforma-
tionen. In diesen ist genau festgelegt, bei welchen Buchstabenkombinationen wie viel Ausgleich erforder-
lich ist. So gut wie alle von SoftMaker veröffentlichten Schriftensammlungen sind natürlich mit umfang-
reichen Kerninginformationen ausgestattet.

Zeichenformatierung zurücksetzen

Einmal angebrachte Zeichenformatierungen lassen sich jederzeit wieder entfernen. Gehen Sie dazu wie
folgt vor:

1. Markieren Sie die gewünschten Zellen oder den gewünschten Text.

2. Rufen Sie den Menübefehl Format > Standard auf.

PlanMaker entfernt nun alle Zeichenformatierungen, die Sie über den Menübefehl Format > Zeichen oder
die Formatleiste angebracht haben.
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Absatzformat (nur in Textrahmen)
Wenn Sie Textrahmen in Ihre Tabelle eingefügt haben, können Sie die Absatzformatierung (Zeilenabstand,
Einzüge etc.) des enthaltenen Textes jederzeit ändern. Verwenden Sie dazu den Menübefehl Format > Ab-
satz. 

Hinweis: Der Menübefehl Format > Absatz ist nur in Textrahmen verfügbar. Allgemeine Informationen
zum Arbeiten mit Textrahmen finden Sie im Abschnitt Textrahmen.

Zu den Absatzformatierungen zählen folgende Optionen:

¡ Einzüge 

¡ Zeilenabstand

¡ Absatzausrichtung

¡ Abstände oberhalb/unterhalb eines Absatzes

¡ Trennhäufigkeit der Silbentrennung (siehe Abschnitt Silbentrennung)

Details dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Einzüge (nur in Textrahmen)

Hinweis: Einzüge sind nur auf Text anwendbar, der in einen Textrahmen eingefügt wurde. Um Text in
Tabellenzellen einzurücken, können Sie die Option Innenränder auf der Karteikarte Ausrichtung im
Dialogfenster des Menübefehls Format > Zelle verwenden.

Mit Hilfe von Einzügen können Sie den linken und rechten Rand von Absätzen in Textrahmen ändern, um
Text ein- oder auszurücken. Der Einzug für die erste Zeile eines Absatzes lässt sich dabei getrennt einstel-
len.

Um Einzüge zu verwenden, markieren Sie die gewünschten Absätze in dem Textrahmen und rufen dann den
Menübefehl Format > Absatz auf.

In der Rubrik Einzüge können Sie die Einzüge Von links, Von rechts und den Einzug für die Erste Zeile
einstellen. Geben Sie hier die gewünschten Werte ein. Sie dürfen auch negative Werte für Einzüge eintra-
gen.

Zeilenabstand (nur in Textrahmen)

Hinweis: Der Zeilenabstand ist nur bei Text änderbar, der in einen Textrahmen eingefügt wurde.
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Der Zeilenabstand bestimmt den Abstand zwischen den einzelnen Zeilen eines Absatzes in einem Textrah-
men.

Um den Zeilenabstand zu verändern, gehen Sie wie folgt vor:

1. Setzen Sie die Schreibmarke in den gewünschten Absatz des Textrahmens (oder markieren Sie mehrere
Absätze darin).

2. Rufen Sie den Menübefehl Format > Absatz auf. 

Die Optionen zum Ändern des Zeilenabstands finden sie in der Rubrik Zeilenabstand:

3. Wählen Sie dort zunächst über die aufklappbare Liste aus, welche Methode zum Festlegen des Zeilenab-
stands verwendet werden soll (siehe unten).

4. Tragen Sie dann rechts daneben das gewünschte Maß ein.

Wenn Sie mit OK bestätigen, wird der Zeilenabstand entsprechend geändert.

Methoden zum Festlegen des Zeilenabstands

In der aufklappbaren Liste Zeilenabstand können Sie dabei wählen, welche Methode zum Festlegen des
Zeilenabstands verwendet werden soll.

Die Liste hat folgende Einträge:

¡ Einfach 

Einfacher automatischer Zeilenabstand. 

Hier wird der optimale Zeilenabstand automatisch ermittelt:

Wenn Sie beispielsweise die Schriftgröße in dem Absatz erhöhen, wird auch der Zeilenabstand entspre-
chend vergrößert. 

Reduzieren Sie die Schriftgröße, wird der Zeilenabstand hingegen automatisch verkleinert.

¡ Mehrfach 

Mehrfacher automatischer Zeilenabstand. 

Entspricht der Option Einfach, liefert also ebenfalls einen automatischen Zeilenabstand. Allerdings kön-
nen Sie diesen bei Bedarf einfach vergrößern oder verkleinern, indem Sie in dem Eingabefeld rechts von
dieser Option die gewünschte Anzahl an Zeilen angeben.

Beispiele:

Tragen Sie bei Zeilen "1,5" ein, um anderthalbfachen automatischen Zeilenabstand zu erhalten.

Tragen Sie "2" ein, um zweifachen automatischen Zeilenabstand zu erhalten.

Tragen Sie "1" ein, um einfachen automatischen Zeilenabstand zu erhalten (entspricht dem Wählen der
Option Einfach).

¡ Genau 

Fester Zeilenabstand.

Hier können Sie den Zeilenabstand auf einen festen Wert in Punkt setzen. Der Zeilenabstand wird dann
nicht mehr automatisch an die Schriftgröße angepasst. 

¡ Mindestens 

Mindest-Zeilenabstand.
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Diese Einstellung entspricht der Option Einfach, verhindert jedoch, dass der angegebene Mindestwert
unterschritten wird. 

Tragen Sie als Mindestwert also 12 Punkt ein, verwendet das Programm normalerweise einen einfachen
automatischen Zeilenabstand. Unterschritte dieser jedoch 12 Punkt (weil Sie eine sehr kleine Schrift ver-
wenden), wird stattdessen ein fester Zeilenabstand von 12 Punkt verwendet.

Standardmäßig ist der Zeilenabstand auf Einfach gesetzt.

Absatzausrichtung (nur in Textrahmen)

Hinweis: Die Absatzausrichtung ist nur bei Text einstellbar, der in einen Textrahmen eingefügt wurde.
Um die Ausrichtung von Text in Tabellenzellen festzulegen, rufen Sie den Menübefehl Format > Zelle
auf und wechseln auf die Karteikarte Ausrichtung.

Mit dem Menübefehl Format > Absatz kann auch die Ausrichtung von Textabsätzen geändert werden, die
in einen Textrahmen eingefügt wurden.

Folgende Arten der Absatzausrichtung stehen zur Wahl:

¡ Linksbündig 
¡ Zentriert
¡ Rechtsbündig
¡ Blocksatz (Wörter gleichmäßig zwischen linkem und rechtem Rand verteilen)

Abstände oberhalb/unterhalb eines Absatzes (nur in Textrahmen)

Hinweis: Der Abstand oberhalb/unterhalb eines Absatzes ist nur bei Text einstellbar, der in einen Text-
rahmen eingefügt wurde. Um die Abstände zwischen Tabellenzellen festzulegen, können Sie jederzeit die
Zeilenhöhe der Zellen ändern.

Neben dem Zeilenabstand können Sie bei Text in einem Textrahmen auch festlegen, wie viel Platz oberhalb
der ersten Zeile und unterhalb der letzten Zeile eines Absatzes freigehalten werden soll. 

Dies können Sie in der Rubrik Abstände im Dialogfenster des Menübefehls Format > Absatz einstellen.
Es gibt hier folgende Optionen:

Option Bedeutung

Oberhalb Geben Sie hier ein, wie viel Abstand zum Ende des vorherigen Absatzes eingehalten werden soll.

Unterhalb Hier ist einzutragen, wie viel Abstand PlanMaker zum Beginn des nächsten Absatzes einhalten
soll.

Anmerkung: Diese Werte haben keinen Einfluss auf den Abstand zwischen den Zeilen innerhalb eines Ab-
satzes (siehe Abschnitt "Zeilenabstand").
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Zeichenvorlagen
Mit dem Menübefehl Format > Zeichenvorlage können Sie "Zeichenvorlagen" zum Einsatz bringen. 

In einer Zeichenvorlage lässt sich ein häufig benötigtes Zeichenformat (Schriftart, Schriftgröße, Textaus-
zeichnungen etc.) speichern und dann immer wieder auf beliebige Zeichen (oder ganze Zellen) anwenden.

Möchten Sie beispielsweise regelmäßig kleingedruckte Bereiche in einer anderen Schriftart und einer klei-
neren Größe drucken, erstellen Sie sich einfach eine entsprechende Zeichenvorlage – nennen wir sie "Klein-
gedrucktes" – und wenden diese an den gewünschten Textstellen an.

Anmerkung: Der Unterschied zwischen Zeichenvorlagen und Zellenvorlagen (siehe Abschnitt Zellenvor-
lagen) liegt darin, dass in Zeichenvorlagen nur das Zeichenformat gespeichert wird, in Zellenvorlagen hin-
gegen sowohl das Zeichenformat als auch das Zellenformat (Zahlenformat, Ausrichtung, Umrandung etc.).
Weiterhin sind Zeichenvorlagen auch auf einzelne Zeichen anwendbar, Zellenvorlagen hingegen nur auf
komplette Zellen.

Ausführlichere Informationen zu diesem Feature folgen auf den nächsten Seiten.

Zeichenvorlagen erstellen

Um eine Zeichenvorlage zu erstellen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf.

2. Klicken Sie auf die Schaltfläche Neu.

3. Geben Sie der Zeichenvorlage einen beliebigen Namen und bestätigen Sie mit OK.

4. Es erscheint ein Dialogfenster, das dem des Menübefehls Format > Zeichen weitgehend entspricht.
Stellen Sie hier die gewünschte Zeichenformatierung ein (siehe Abschnitt Zeichenformat).

5. Wurden alle gewünschten Einstellungen vorgenommen, klicken Sie auf OK, um die Vorlage zu definie-
ren.

6. Verlassen Sie das Dialogfenster "Zeichenvorlage" mit Schließen.

Die Vorlage ist nun definiert und einsatzbereit. Wie Sie die neue Vorlage in der Praxis einsetzen, erfahren
Sie im nächsten Abschnitt.

Tastenkürzel verwenden

Benötigen Sie eine Formatvorlage besonders häufig, können Sie ihr jederzeit ein Tastenkürzel geben. Das
hat den Vorteil, dass Sie die Vorlage blitzschnell mit einem einzigen Tastendruck aktivieren können.

Um einer Vorlage ein Tastenkürzel zuzuordnen, wechseln Sie im Dialog des Menübefehls Format > Zei-
chenvorlage auf die Karteikarte Vorlage, setzen die Schreibmarke in das Eingabefeld Tastenkürzel und
betätigen die gewünschte Tastenkombination. 
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Hinweis: Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird unter dem Eingabefeld
Tastenkürzel angezeigt, womit diese momentan belegt ist. Sie sollten dann die RücktasteÕ betätigen,
um das Tastenkürzel wieder zu löschen und eine andere Tastenkombination verwenden. Andernfalls
überschreiben Sie die Tastenkombination einer anderen Vorlage oder gar die eines PlanMaker-Befehls.

Wir empfehlen Ihnen, für Formatvorlagen stets Tastenkombinationen mit den Tasten Strg und Umschalt zu
verwenden, da diese normalerweise nicht belegt sind.

Zeichenvorlagen anwenden

Um eine Zeichenvorlage anzuwenden, gehen Sie wie folgt vor:

1. Markieren Sie die gewünschten Zellen. Sie können auch einzelne Zeichen innerhalb einer Zelle markie-
ren, nachdem Sie die Taste F2 betätigt haben.

2. Rufen Sie den Menübefehl Format > Zeichenvorlage auf.

3. Wählen Sie die gewünschte Vorlage.

4. Klicken Sie auf Anwenden.

Sofort ändert sich die Formatierung der markierten Zeichen so, wie Sie es in der Zeichenvorlage festgelegt
hatten. 

Tipp: Sie können Zeichenvorlagen auch aus der Liste der Schriftarten in der Formatleiste auswählen.
Noch schneller: Haben Sie der Formatvorlage ein Tastenkürzel zugewiesen, können Sie die Vorlage
noch schneller anwenden: Markieren Sie die gewünschten Zellinhalte und betätigen Sie die gewählte
Tastenkombination.

Zeichenvorlagen ändern

Selbstverständlich können Sie Zeichenvorlagen jederzeit wieder abändern.

Wichtig: Wenn Sie die Formatierung einer Zeichenvorlage abändern, ändert sich automatisch die Forma-
tierung aller Zeichen, die mit dieser Vorlage formatiert wurden.

Um eine Zeichenvorlage zu bearbeiten, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf.

2. Wählen Sie die zu ändernde Vorlage aus der Liste.

3. Klicken Sie auf Bearbeiten.

4. Nehmen Sie die gewünschten Änderungen an der Vorlage vor.

5. Klicken Sie auf OK.

6. Verlassen Sie das Dialogfenster mit Schließen.
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Zeichenvorlagen löschen oder umbenennen

Die Schaltfläche Löschen im Dialogfenster des Befehls Zeichenvorlage löscht die gewählte Vorlage im ak-
tuellen Dokument. 

Um einer Vorlage einen neuen Namen zu geben, klicken Sie auf Umbenennen und tippen den neuen Na-
men ein. Auch dies wirkt sich nur auf das aktuelle Dokument aus.

Um Formatvorlagen einer Dokumentvorlage zu löschen oder umzubenennen, öffnen Sie die Dokumentvor-
lage, nehmen die Änderungen darin vor und speichern die Dokumentvorlage.

Zeichenvorlage Normal

Die Zeichenvorlage namens "Normal" existiert standardmäßig in jedem Dokument und hat eine besondere
Bedeutung. Sie ist die Standardvorlage für alle Zellinhalte. Solange Sie in einem neuen Dokument einfach
etwas eintippen, wird diesem automatisch die Zeichenvorlage "Normal" zugewiesen.

Ändern Sie beispielsweise die Schriftart der Vorlage "Normal", ändert sich dementsprechend die Schrift in
sämtlichen Zellen (außer bei Zellen, die Sie mit dem Menübefehl Format > Zeichen in einer anderen
Schrift formatiert haben). Weiterhin haben Sie auf diese Weise die Standardschrift für zukünftige Eingaben
geändert.

Verknüpfte Zeichenvorlagen erstellen

Wenn Sie, wie zu Beginn dieses Kapitels beschrieben, neue Vorlagen erstellen, basieren diese stets auf der
Zeichenvorlage "Normal". Wählen Sie also beispielsweise für die Vorlage "Normal" eine neue Schriftart,
ändert sich die Schrift auch in allen anderen Vorlagen – sofern dort keine andere Schrift gewählt wurde.

Also: Normalerweise sind alle Zeichenvorlagen mit der Vorlage "Normal" verknüpft. Sie können aber
beim Erstellen einer neuen Vorlage unter Basierend auf eine beliebige andere Zeichenvorlage als Basis
angeben.

Um eine Vorlage zu erstellen und diese auf einer bestimmten anderen Vorlage basieren zu lassen, gehen Sie
folgendermaßen vor:

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf.

2. Klicken Sie auf die Schaltfläche Neu.

3. Geben Sie der Zeichenvorlage einen Namen.

4. Wählen Sie auf der Karteikarte Vorlage unter Basierend auf die Vorlage, mit der die neue Vorlage ver-
knüpft sein soll.

5. Nun können Sie die gewünschte Formatierung anbringen etc.
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Relative Schriftgröße

Wenn Sie eine Vorlage auf einer anderen basieren lassen, können Sie auf Wunsch die relative Schriftgröße
angeben. Sie können zum Beispiel festlegen, dass die Schriftgröße der Vorlage X stets 80% der Schriftgrö-
ße von Vorlage Y betragen soll.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl Format > Zeichenvorlage auf.

2. Selektieren Sie eine Vorlage und klicken Sie auf Bearbeiten.

3. Wechseln Sie auf die Karteikarte Vorlage.

4. Schalten Sie die Option Größe ein.

5. Tragen Sie den gewünschten Faktor in Prozent ein – zum Beispiel 80.

6. Bestätigen Sie mit OK.

Die Schriftgröße einer so bearbeiteten Vorlage wird nun stets 80% der Vorlage betragen, auf der sie basiert.

Zellenvorlagen
Mit dem Menübefehl Format > Zellenvorlage können Sie "Zellenvorlagen" zum Einsatz bringen. 

In einer Zellenvorlage lässt sich ein bestimmtes Zellenformat (Zahlenformat, Ausrichtung, Umrandung etc.)
und bei Bedarf auch das Zeichenformat (Schriftart etc.) abspeichern. Einmal gespeichert, können Sie diese
Zellenvorlage immer wieder auf beliebige Zellen anwenden.

Möchten Sie beispielsweise regelmäßig Zellen mit dem Zahlenformat "Prozent", rotem Hintergrund und fet-
ter Schrift formatieren, erstellen Sie sich einfach eine entsprechende Zellenvorlage und wenden diese auf
die gewünschten Zellen an.

Anmerkung: Der Unterschied zwischen Zeichenvorlagen (siehe Abschnitt Zeichenvorlagen) und Zellenvor-
lagen liegt darin, dass in Zeichenvorlagen nur das Zeichenformat (Schriftart etc.) gespeichert wird, in Zel-
lenvorlagen hingegen sowohl das Zeichenformat als auch das Zellenformat. Weiterhin sind Zeichenvorlagen
auch auf einzelne Zeichen anwendbar, Zellenvorlagen hingegen nur auf komplette Zellen.

Ausführliche Informationen zu diesem Feature folgen auf den nächsten Seiten.

Zellenvorlagen anwenden

Um eine Zellenvorlage anzuwenden, gehen Sie wie folgt vor:

1. Navigieren Sie zu der Zelle, die Sie formatieren möchten. Alternativ können Sie natürlich auch mehrere
Zellen selektieren, um deren Formatierung gemeinsam zu ändern.

2. Rufen Sie den Menübefehl Format > Zellenvorlage auf. 

Es erscheint ein Dialog mit einer Liste aller Zellenvorlagen.
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Tipp: Über die Option Anzeigen können Sie dabei bestimmen, ob in dieser Liste alle verfügbaren Vor-
lagen angezeigt werden sollen – oder nur die im aktuellen Dokument bereits benutzten Vorlagen.

3. Wählen Sie die anzuwendende Zellenvorlage in der Liste Vorlagen.

4. Klicken Sie auf Anwenden.

Sofort ändert sich die Formatierung der markierten Zellen so, wie es in der Zellenvorlage festgelegt wurde. 

Tipp: Zellenvorlagen können auch über die aufklappbare Liste ganz links in der Formatleiste ausgewählt
werden.

Im Einzelnen kann eine Zellenvorlage folgende Formatierungsoptionen beinhalten:

¡ Zahlenformat  

¡ Schrift (Schriftart und -größe, Textauszeichnungen etc.)

¡ Ausrichtung der Zellen

¡ Schattierung

¡ Umrandung

¡ Zellschutz

Über die Sektion Format enthält in obigem Dialogfenster können Sie bei Bedarf genau festlegen, welche
dieser Formatierungsoptionen angewendet werden sollen, wenn Sie die ausgewählte Vorlage anwenden
(siehe auch nächster Abschnitt).

Zellenvorlagen erstellen

Um eine neue Zellenvorlage zu erstellen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Format > Zellenvorlage auf.

2. Optional: Wählen Sie in der Liste Vorlagen diejenige Zellenvorlage aus, auf der ihre neue Vorlage ba-
sieren soll (oder wählen Sie einfach die Standardvorlage "Normal").

3. Klicken Sie auf die Schaltfläche Neu.

4. Geben Sie der Zellenvorlage einen beliebigen Namen und bestätigen Sie mit OK.

5. Die neue Vorlage wurde nun angelegt, und Sie können sie wie folgt bearbeiten:

Klicken Sie auf Zeichenformat, wenn Sie das Zeichenformat der Vorlage ändern möchten. Dazu er-
scheint ein Dialogfenster, das dem des Menübefehls Format > Zeichen weitgehend entspricht (siehe
Abschnitt Zeichenformat).

Klicken Sie auf Zellenformat, wenn Sie das Zellenformat der Vorlage ändern möchten. Dazu erscheint
ein Dialogfenster, das dem des Menübefehls Format > Zelle weitgehend entspricht (siehe Abschnitte
Zahlenformat und folgende).

6. Ist alles wunschgemäß, verlassen Sie das Dialogfenster mit Schließen (bzw. drücken Sie vorher auf An-
wenden, wenn Sie das Ergebnis der Zellenvorlage direkt für die markierten Zellen sehen wollen).

Die Vorlage ist nun definiert und einsatzbereit.
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Sie können für jedes Dokument eigene Zellenvorlagen erstellen; diese werden im Dokument gespeichert.

Die Auswahl "Basierend auf"

Mit der Auswahl Basierend auf können Sie für das Anlegen neuer Zellenvorlagen auf zuvor selbst erstellte
Zellenvorlagen zurückgreifen, deren Formatierung kopieren und neu anpassen. Sie bauen also auf die For-
mat-Eigenschaften eines von Ihnen bereits angelegten Vorlagen-Vorgängers auf.

Außerdem werden nachträgliche Änderungen der Formatierung des Vorlagen-Vorgängers auch für alle wei-
teren Vorlagen, die Sie basierend auf diesen Vorgänger eingestellt haben, auf seine Nachfolger sozusagen
"vererbt".

Bitte beachten Sie: Wenn Sie eine neue Zellenvorlage mit Basierend auf anlegen wollen und Sie haben
noch keine eigene Zellenvorlage erstellt, dann ist diese Option zunächst ausgegraut (also nicht auswähl-
bar), weil bisher nur die Standardvorlagen vorhanden sind, zum Beispiel die Vorlage "Normal". In die-
sem Fall werden für eine neue Vorlage die Formatierungen der Vorlage "Normal" standardmäßig über-
nommen.
Erst wenn sie eine eigene neue Vorlage selbst definiert haben und diese daraufhin aus der Liste Vorlagen
auswählen, wird die Option Basierend auf für Sie nutzbar.

Zur Erläuterung der "Vererbung" der Formatierung ein Beispiel:

Erstellen Sie eine erste Zellenvorlage wie oben im Kapitel beschrieben über die Schaltfläche Neu. Nennen
wir diese neue Vorlage "Zellenvorlage1". Diese Vorlage hat zunächst die Formatierungen der Standardvor-
lage "Normal" und lässt sich nach eigenen Wünschen über Zellenformat und Zeichenformat anpassen. Ver-
geben Sie zum Beispiel für das Zellenformat unter Schattierung ein Muster.

Erstellen Sie jetzt eine zweite Zellenvorlage basierend auf Zellenvorlage1 und drücken Sie wieder die
Schaltfläche Neu. Nennen wir nun diese nächste Vorlage "Zellenvorlage2".

Das Ergebnis sieht folgendermaßen aus:

1. Die Zellenvorlage2 hat die Formatierung von Zellenvorlage1 übernommen.

2. Sie können die Formatierung von Zellenvorlage2 weiter individuell anpassen.

Aber wichtig ist: Auch nachträgliche Änderungen an der Formatierung der Zellenvorlage1 führen dazu,
dass sie in der Zellenvorlage2 übernommen werden. Es sei denn, es betrifft Formatierungsoptionen, die in
Zellenvorlage2 bereits individuell angepasst wurden: diese bleiben dort erhalten.

Die Sektion "Format enthält"

In der Sektion Format enthält können Sie bei Bedarf genau festlegen, welche der Formatierungsoptionen
einbezogen werden sollen, wenn Sie die Zellenvorlage anwenden.

So sollen beispielsweise Zellenvorlagen wie "Währung" die Zellen lediglich mit dem Zahlenformat "Wäh-
rung" versehen – und sonst nichts verändern. Deshalb sind bei dieser Vorlage alle Optionen bis auf "Zahlen-
format" deaktiviert.

Diese Einstellungen in dieser Sektion lassen sich für jede Vorlage einzeln vornehmen.

Bitte beachten Sie: Wie bei "Basierend auf" können Sie diese Optionen erst dann nutzen, wenn sie eine
eigene neue Zellenvorlage erstellt haben. Ansonsten sind die Felder ausgegraut und nicht auswählbar.
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Tastenkürzel verwenden

Wenn Sie eine Zellenvorlage besonders häufig benötigen, können Sie ihr jederzeit ein Tastenkürzel geben.
Das hat den Vorteil, dass Sie die Vorlage blitzschnell mit einem einzigen Tastendruck aktivieren können.

Um einer Vorlage ein Tastenkürzel zuzuordnen, rufen Sie den Menübefehl Format > Zellenvorlage auf
und selektieren die gewünschte Vorlage in der Liste. Dann klicken Sie in das Eingabefeld Tastenkürzel
und betätigen die gewünschte Tastenkombination. 

Hinweis: Wenn Sie eine Tastenkombination betätigen, die bereits belegt ist, wird unter dem Eingabefeld
Tastenkürzel angezeigt, womit diese momentan belegt ist. Sie sollten dann die RücktasteÕ betätigen,
um das Tastenkürzel wieder zu löschen und eine andere Tastenkombination verwenden. Andernfalls
überschreiben Sie die Tastenkombination einer anderen Vorlage oder gar die eines PlanMaker-Befehls.

Wir empfehlen Ihnen, für Formatvorlagen stets Tastenkombinationen mit den Tasten Strg und Umschalt zu
verwenden, da diese normalerweise nicht belegt sind.

Zellenvorlagen ändern

Selbstverständlich können Sie Zellenvorlagen jederzeit wieder abändern.

Wichtig: Wenn Sie die Formatierung einer Zellenvorlage abändern, ändert sich die Formatierung aller
Zellen, auf die diese Vorlage angewandt wurde, entsprechend.

Um eine Zellenvorlage zu bearbeiten, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Format > Zellenvorlage auf.

2. Wählen Sie die zu ändernde Vorlage aus der Liste.

3. Klicken Sie auf Zeichenformat, wenn Sie ihr Zeichenformat ändern möchten, beziehungsweise auf Zel-
lenformat, wenn Sie ihr Zellenformat ändern möchten.

4. Wenn Sie fertig sind, verlassen Sie das Dialogfenster mit Schließen.

Zellenvorlagen löschen oder umbenennen

Die Schaltfläche Löschen im Dialog des Menübefehls Format > Zellenvorlage löscht die gewählte Vor-
lage im aktuellen Dokument. 

Um einer Vorlage einen neuen Namen zu geben, klicken Sie auf Umbenennen und tippen den neuen Na-
men ein. Auch dies wirkt sich nur auf das aktuelle Dokument aus.

Hinweis: Einige der Zellenvorlagen sind vorgegeben und können nicht gelöscht oder umbenannt werden.
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Zellenvorlage Normal

Die Zellenvorlage namens "Normal" existiert standardmäßig in jedem Dokument und hat eine besondere
Bedeutung. Sie ist die Standardvorlage für alle Zellen. Solange Sie einer Zelle also keine andere Vorlage
zuweisen, ist Sie immer in der Zellenvorlage "Normal" formatiert.

Ändern Sie nun beispielsweise das Zahlenformat der Vorlage "Normal", ändert sich sofort das Zahlenformat
aller Zellen – außer bei Zellen, denen Sie ein anderes Zahlenformat "von Hand" zugewiesen haben (zum
Beispiel mithilfe des Menübefehls Format > Zelle).

Dokumentvorlagen
Wie Sie in den letzten beiden Abschnitten erfahren haben, werden Zeichen- und Zellenvorlagen in dem Do-
kument gespeichert, in dem sie erstellt wurden. Wenn Sie solche Formatvorlagen auch in anderen Doku-
menten verwenden möchten, sollten Sie diese in einer Dokumentvorlage speichern. 

Jedes Mal, wenn Sie den Menübefehl Datei > Neu aufrufen, lässt Sie PlanMaker nämlich auswählen, auf
welcher Dokumentvorlage das neue Dokument basieren soll. Wählen Sie hier eine von Ihnen erstellte Doku-
mentvorlage, stehen in dem neuen Dokument genau die Zeichen- und Zellenvorlagen zur Verfügung, die in
der Dokumentvorlage vorhanden sind.

Dokumentvorlagen können übrigens nicht nur Ihre bevorzugten Formatvorlagen enthalten, sondern auch mit
Text, Werten etc. vorgefüllt sein. Erstellen Sie also Ihre "Schablonen" für Rechnungen, Jahresberichte, Kos-
tengegenüberstellungen etc. – schon wird das Erstellen neuer Tabellen zum Kinderspiel: einfach den Menü-
befehl Datei > Neu aufrufen, die Vorlage auswählen und die Tabelle fertig ausfüllen.

Ausführlichere Informationen folgen auf den nächsten Seiten.

Dokumentvorlagen erstellen

Um eine neue Dokumentvorlage zu erstellen, gehen Sie folgendermaßen vor:

1. Beginnen Sie ein neues Dokument oder öffnen Sie das Dokument beziehungsweise die Dokumentvor-
lage, auf deren Basis die neue Dokumentvorlage erstellt werden soll. 

2. Erstellen Sie die gewünschten Zeichen- und Zellenvorlagen und/oder tragen Sie Text, Werte etc. ein, um
die Vorlage zu erstellen.

3. Rufen Sie den Menübefehl Datei > Speichern unter auf.

4. Wählen Sie in der Liste Dateityp den Eintrag PlanMaker-Vorlage.

5. PlanMaker wechselt nun automatisch in den Ordner, in dem sich die Dokumentvorlagen befinden.

6. Tippen Sie bei Dateiname einen Namen für die Vorlage ein.

7. Bestätigen Sie mit OK.
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Die Vorlage wird nun gespeichert.

Dokumentvorlagen anwenden

Um eine Dokumentvorlage zu verwenden, beginnen Sie einfach mit dem Menübefehl Datei > Neu ein neu-
es Dokument. PlanMaker fragt Sie dabei automatisch, auf welcher Dokumentvorlage dieses basieren soll:

1. Rufen Sie den Menübefehl Datei > Neu auf.

2. Wählen Sie die gewünschte Dokumentvorlage aus der Liste Vorlage. 

3. Klicken Sie auf OK.

Es wird nun ein neues Dokument angelegt, in dem Ihnen alle in der Dokumentvorlage gespeicherten Zei-
chen- und Zellenvorlagen zur Verfügung stehen. Enthält die Dokumentvorlage auch ausgefüllte Zellen, wer-
den diese entsprechend angezeigt und können ganz normal bearbeitet werden.

Dokumentvorlagen ändern

Das Ändern einer Dokumentvorlage unterscheidet sich nicht weiter vom Bearbeiten eines normalen Doku-
ments. Sie öffnen die Vorlage, nehmen Ihre Änderungen vor und speichern die Dokumentvorlage.

Wichtig: Das Ändern einer Dokumentvorlage wirkt sich auf alle Dokumente aus, die anschließend mit
dieser Vorlage erstellt werden.

Um eine Dokumentvorlage zu ändern, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Datei > Öffnen auf.

2. Wählen Sie in der Liste der Dateitypen den Eintrag PlanMaker-Vorlage.

3. Suchen Sie sich die zu ändernde Vorlage aus und bestätigen Sie mit OK.

4. Machen Sie die gewünschten Änderungen an den Zellen und/oder Vorlagen dieser Dokumentvorlage.

5. Rufen Sie den Menübefehl Datei > Speichern auf, um geänderte Vorlage zu speichern.

Sie können die Vorlage natürlich auch mit dem Menübefehl Datei > Speichern unter unter einem anderen
Namen sichern, wenn das Original nicht überschrieben werden soll.

Dokumentvorlage Normal.pmvx

Die Dokumentvorlage normal.pmvx ist die Standardvorlage für neue Dokumente. Wenn Sie den Menü-
befehl Datei > Neu aufrufen, wird stets diese Vorlage vorgegeben. Sie ist gänzlich leer und enthält lediglich
die Standardzeichenvorlage "Normal" sowie die Standardzellenvorlage "Normal".

Dementsprechend eignet sich die Dokumentvorlage normal.pmvx als Basis, wenn Sie eine völlig neue
Vorlage erstellen möchten, in der zu Beginn nichts eingetragen sein soll.
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Wichtig: Die Standardvorlage normal.pmvx sollten Sie normalerweise nicht ändern. Wenn Sie dies
trotzdem tun möchten, sollten Sie sich bewusst sein, dass sich diese Änderungen auf alle Dokumente aus-
wirken, die anschließend auf Basis dieser Vorlage angelegt werden.

Möchten Sie also beispielsweise das Seitenformat für alle Dokumente ändern, die zukünftig auf Basis der
Vorlage normal.pmvx erstellt werden, dann öffnen Sie diese Vorlage, ändern das Seitenformat und spei-
chern die Vorlage.

Übrigens können Sie für neue Dateien auch eine andere Standardvorlage wählen. Rufen Sie dazu den Menü-
befehl Datei > Neu auf, wählen Sie die gewünschte Vorlage und klicken Sie auf Neuer Standard. Ab jetzt
bietet Ihnen PlanMaker beim Anlegen neuer Dokumente stets diese Vorlage als Standardvorlage an.

AutoFormat
Mit dem Menübefehl Format > AutoFormat können Sie das Layout ganzer Tabellenbereiche auf einmal
ändern.

Der Dialog zu diesem Befehl zeigt Ihnen eine Liste mit vorgefertigten "AutoFormat-Vorlagen", deren Aus-
sehen Sie im Feld Beispiel vorab begutachten können. Zur Anwendung einer AutoFormat-Vorlage genügt
es, einen Tabellenbereich zu markieren, obigen Befehl aufzurufen, die gewünschte Vorlage auszuwählen
und auf OK zu klicken.

Über die Optionen im Bereich Anwenden können Sie dabei bestimmen, welche Formatierungen der Vor-
lage angebracht werden sollen. Schalten Sie beispielsweise alle Optionen bis auf Umrandungen aus, wer-
den nur die Umrandungen der AutoFormat-Vorlage angewandt; alle anderen Formatierungen der Tabelle
bleiben erhalten.
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Bedingte Formatierung
Mit dem Menübefehl Format > Bedingte Formatierung können Sie Zellen mit einer bedingten Formatie-
rung versehen. Diese wird nur angewandt, wenn eine bestimmte Bedingung erfüllt ist. So können Sie bei-
spielsweise festlegen, dass eine Zelle immer dann rot eingefärbt werden soll, wenn sie einen Wert größer als
1000 enthält. 

Auf den nächsten Seiten erfahren Sie alles Wissenswerte dazu. Folgende Themen werden darin behandelt:

¡ Neue Formatierungsregeln anlegen 

Um Tabellenzellen mit einer bedingten Formatierung zu versehen, markieren Sie diese Zellen und legen
dann eine sogenannte Formatierungsregel für sie an – zum Beispiel: "Wenn der Zellinhalt größer als
1000 ist, dann stelle die Zelle in roter Farbe dar."

Sie können beliebig viele Formatierungsregeln an einer Zelle anbringen – also beispielsweise eine zweite
Regel anlegen, die die Zelle mit Fettdruck versieht, wenn der Zellwert kleiner als Null ist etc. etc.

¡ Arten von bedingten Formatierungen 

In diesem Abschnitt werden die unterschiedlichen Arten von bedingten Formatierungen vorgestellt.

¡ Formatierungsregeln verwalten 

Mit dem Befehl Regeln verwalten können Sie alle im Dokument angebrachten bedingten Formatierun-
gen zentral verwalten, sie also unter anderem bearbeiten und löschen. 

¡ Bedingte Formatierung entfernen 

Im letzten Abschnitt erfahren Sie, wie Sie bedingte Formatierungen von Zellen wieder entfernen können.

Neue Formatierungsregeln anlegen

Um Tabellenzellen mit einer bedingten Formatierung zu versehen, markieren Sie diese Zellen und legen
dann eine sogenannte Formatierungsregel für sie an.

Eine Formatierungsregel hat immer zwei Bestandteile:

¡ eine Bedingung 

¡ ... und die Formatierung, die angewandt werden soll, wenn diese Bedingung erfüllt ist. 

Einfaches Beispiel: "Wenn der Zellinhalt größer als 1000 ist, dann stelle die Zelle in roter Farbe dar."

Um eine solche Regel zu definieren (und gleichzeitig anzuwenden), gehen Sie wie folgt vor:

1. Steuern Sie die gewünschte Zelle an. Sie können natürlich auch mehrere Zellen markieren, um diese ge-
meinsam mit einer bedingten Formatierung zu versehen.

2. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Neue Regel auf.

3. Wählen Sie zuerst bei Typ, welche Art von Bedingung verwendet werden soll. 

In unserem Beispiel wäre das die Option Nur Zellen formatieren, die enthalten. 
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(Erläuterungen zu allen verfügbaren Optionen finden Sie im Abschnitt Arten von bedingten Formatie-
rungen.)

4. Nun können Sie die gewünschte Bedingung festlegen.

In unserem Beispiel wäre das die Bedingung "Zellwert größer als 1000". Wählen Sie also die Optionen
Zellwert und Größer als. Dann tragen Sie rechts den Wert 1000 ein.

5. Im letzten Schritt klicken Sie auf die Schaltfläche Format und wählen die Formatierung, die angebracht
werden soll, wenn diese Bedingung zutrifft. 

Für unser Beispiel wechseln Sie also auf die Karteikarte Schrift, stellen die Schriftfarbe auf Rot, und
bestätigen Sie mit OK.

6. Alle nötigen Einstellungen sind nun gemacht. Klicken Sie auf OK, um die neue Regel anzulegen.

7. Schließen Sie den Dialog mit der Schaltfläche Schließen.

Die Formatierungsregel wurde nun festgelegt – und auch gleich auf die selektierten Zellen angewandt. Dies
hat folgenden Effekt:

¡ Ist der Wert in der Zelle kleiner oder gleich 1000, wird die Zelle in ihrer ursprünglichen Formatierung
angezeigt. 

¡ Ist der Wert hingegen größer als 1000, wird die bedingte Formatierung angewandt, der Zellinhalt also rot
dargestellt.

Tipp: Sie können übrigens beliebig viele Formatierungsregeln an einer Zelle anbringen – also beispiels-
weise eine zweite Regel anlegen, die die Zelle mit Fettdruck versieht, wenn der Zellwert kleiner als Null
ist etc. etc.

Arten von bedingten Formatierungen

Im vorherigen Abschnitt wurde beschrieben, wie Sie Zellen mit einer bedingten Formatierung versehen. In
dem Dialog, der dabei erscheint, können Sie zwischen folgenden Arten von Formatierungsregeln wählen:

Alle Zellen basierend auf ihren Werten formatieren

Bei dieser Art von bedingter Formatierung gibt es eigentlich gar keine Bedingung. Es werden vielmehr alle
zuvor markierten Zellen umformatiert – und zwar entsprechend der Werte, die sie enthalten.

Wählen Sie hier beispielsweise eine 2-Farben-Skala von Rot nach Grün, wird der niedrigste Wert rot und
der höchste grün hinterlegt. Die Werte dazwischen werden mit einem ihrer Größe entsprechenden Zwi-
schenton versehen. Das Ergebnis ist ein Farbverlauf wie etwa folgender:
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Es gibt für diese Art von Formatierungsregel mehrere verschiedene Untertypen. Sie können diese über die
Option Formatstil auswählen. Diese enthält folgende Einträge:

¡ 2-Farbenskala 

Wie in obigem Beispiel beschrieben.

¡ 3-Farbenskala 

Entspricht der 2-Farbenskala, lässt Sie aber zusätzlich die Farbe für den Mittelwert festlegen.

¡ Datenbalken 

Hier werden im Hintergrund der Zellen Balken eingeblendet, die der relativen Größe des Wertes entspre-
chen – ähnlich einem Balkendiagramm:

¡ Symbolsätze 

Hier wird in der Zelle ein Symbol eingeblendet, das die Größe des Wertes wiedergibt – zum Beispiel ein
rotes Signallicht beim unteren Drittel der Werte, ein gelbes beim mittleren Drittel beziehungsweise ein
grünes beim oberen Drittel:

Nur Zellen formatieren, die ... enthalten

Hier werden nur diejenigen Zellen umformatiert, die die angegebene Bedingung erfüllen.
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Legen Sie dazu zuerst die gewünschte Bedingung fest. Verwenden Sie dazu die entsprechenden Kontrollen
und Eingabefelder in dem Dialog.

Klicken Sie dann auf die Schaltfläche Format und stellen Sie die Formatierung ein, mit der die Zellen ver-
sehen werden sollen, bei denen die Bedingung erfüllt ist.

Ein Beispiel hierfür haben wir Ihnen im vorherigen Abschnitt vorgestellt – und Ihnen gezeigt, wie Sie die
bedingte Formatierung "Wenn der Zellinhalt größer als 1000 ist, dann stelle ihn in roter Farbe dar" anlegen.

Nur obere oder untere Werte formatieren

Hier werden nur diejenigen Zellen umformatiert, die die höchsten beziehungsweise niedrigsten Werte inner-
halb der markierten Zellen enthalten.

Legen Sie dazu zuerst fest, welche Werte umformatiert werden sollen – zum Beispiel die obersten 3 Werte
oder die obersten 10% der Werte.

Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatierung, mit der die entspre-
chenden Zellen versehen werden sollen.

Werte über oder unter dem Durchschnitt formatieren

Hier werden nur diejenigen Zellen umformatiert, deren Werte über beziehungsweise unter dem Mittelwert
für die markierten Zellen liegen.

Legen Sie dazu zuerst fest, welche Werte umformatiert werden sollen – zum Beispiel alle Werte über dem
Durchschnitt.

Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatierung, mit der die entspre-
chenden Zellen versehen werden sollen.

Eindeutige oder doppelte Werte formatieren

Hier werden alle eindeutigen Werte (beziehungsweise alle doppelten Werte) innerhalb der markierten Zel-
len umformatiert.

Wählen Sie dazu zuerst aus, welche Werte umformatiert werden sollen: 

¡  alle eindeutigen Werte (Werte, die nur genau ein Mal vorkommen). 

¡ oder alle doppelten Werte (Werte, die mindestens zwei Mal vorkommen)

Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatierung, mit der die entspre-
chenden Zellen versehen werden sollen.

Formel verwenden, um die zu formatierenden Zellen zu bestimmen

Hier werden nur diejenigen Zellen umformatiert, bei denen die angegebene Rechenformel den Wert WAHR
zurückliefert.

Tragen Sie dazu die gewünschte Rechenformel in den Dialog ein. Es sind nur Rechenformeln zulässig, die
einen Wahrheitswert liefern (also WAHR oder FALSCH). Siehe auch Hinweise weiter unten.

Klicken Sie dann auf die Schaltfläche Format und bestimmen Sie die Formatierung, mit der die entspre-
chenden Zellen versehen werden sollen.

Einige Hinweise:
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¡ Formulieren geeigneter Rechenformeln 

Für die Bedingung lassen sich beliebige Rechenformeln verwenden. Sie müssen lediglich beachten, dass
die Rechenformel immer einen Wahrheitswert (also WAHR oder FALSCH) als Ergebnis haben muss.

Beispiele:

Bei der Formel "SUMME($A$1:$C$3) > 42" wird die bedingte Formatierung immer dann angebracht,
wenn die Summe des Zellbereichs A1:C3 größer als 42 ist.

Bei der Formel "ISTGERADE(ZEILE())" wird die bedingte Formatierung angebracht, wenn sich die
Zelle in einer Zeile mit einer geraden Zeilennummer befindet.

¡ Absolute und relative Adressen 

Beachten Sie, dass in der Formel nicht nur absolute Zellbezüge (wie im obigen Beispiel), sondern auch
relative Zellbezüge verwendet werden können. Diese werden hierbei wie folgt behandelt:

Ein absoluter Zellbezug – zum Beispiel $A$1 – bezieht sich immer auf die Zelle A1.

Ein relativer Zellbezug – zum Beispiel A1 – bezieht sich hingegen auf die Zelle in der linken oberen
Ecke der Markierung. Das bedeutet: 

Wenden Sie eine bedingte Formatierung auf eine einzelne Zelle an, bezieht sich A1 auf eben diese
Zelle. 

Hatten Sie zuvor einen Bereich von Zellen markiert, bezieht sich A1 auf die Zelle in der linken obe-
ren Ecke der Markierung, A2 auf die Zelle darunter etc.

Formatierungsregeln verwalten

Mit dem Menübefehl Format > Bedingte Formatierung > Regeln verwalten können Sie die bedingten
Formatierungen in einem Dokument verwalten, sie also unter anderem bearbeiten und löschen. 

Verwenden Sie diesen Befehl wie folgt:

1. Steuern Sie die Zelle an, deren Formatierungsregeln Sie bearbeiten möchten. Sie können natürlich auch
mehrere Zellen markieren. 

2. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Regeln verwalten auf.

3. Es erscheint ein Dialog. 

Anmerkung: Dieser Dialog zeigt standardmäßig nur die Regeln für die aktuelle Zelle (oder Markierung)
an. Falls Sie hingegen alle Regeln im gesamten Arbeitsblatt sehen möchten, schalten Sie die Option
Quelle auf Aktuelles Arbeitsblatt um (siehe unten).

4. Führen Sie die gewünschten Änderungen an den Formatierungsregeln durch (siehe unten). 

5. Beenden Sie den Dialog mit der Schaltfläche Schließen.

Bedienung des Dialogfensters

Das Dialogfenster für diesen Befehl hat folgende Bedienelemente:

¡ Quelle 

Hier können Sie bestimmen, welche Formatierungsregeln in dem Dialog angezeigt werden sollen: 
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Nur markierte Zellen: Nur Regeln anzeigen, die die momentan markierten Zellen betreffen (bezie-
hungsweise die aktuelle Zelle, falls derzeit keine Zellen markiert sind)

Aktuelles Arbeitsblatt: Alle Regeln im aktuellen Arbeitsblatt anzeigen

Arbeitsblatt <Name>: Alle Regeln auf einem anderen Arbeitsblatt (sofern vorhanden) anzeigen

¡ Liste Regeln 

In der Liste Regeln werden alle Regeln für die aktuelle Markierung oder das gesamte Arbeitsblatt ange-
zeigt (je nachdem, was Sie bei Quelle ausgewählt haben).

Dabei sind diejenigen Regeln, die die momentan markierten Zellen betreffen, mit Fettdruck hervorgeho-
ben.

Anhalten: Um die Kontrollkästchen in der Spalte Anhalten müssen Sie sich normalerweise nicht küm-
mern. Diese sind nur aus Gründen der Kompatibilität mit älteren Dokumenten vorhanden. (Hintergrund:
Bei älteren Versionen von PlanMaker und Excel wurde die bedingte Formatierung für eine Zelle "ange-
halten", wenn diese Zelle mit mehreren Regeln versehen war und eine dieser Regeln zutraf. Alle weite-
ren Regeln für die Zelle wurden dann ignoriert. Bei aktuellen Versionen von PlanMaker und Excel ist
dies jedoch nicht mehr der Fall: Hier werden stets alle Regeln für eine Zelle beachtet.)

¡ Pfeiltasten neben der Liste Regeln 

Mit den Pfeiltasten neben der Liste Regeln können Sie die Rangfolge der Formatierungsregeln ändern. 

Um die Rangfolge einer Regel zu ändern, selektieren Sie diese in der Liste und schicken sie dann durch
Anklicken der Pfeiltasten nach oben (= höherer Rang) oder unten (= niedriger Rang).

Dies kann notwendig sein, wenn ein Zellbereich mit konkurrierenden Formatierungsregeln versehen
wurde. Einfaches Beispiel: Eine Regel möchte die Zelle grün einfärben, eine andere Regel will sie hinge-
gen rot einfärben.

Je weiter oben sich eine Regel in der Liste befindet, umso höher ist ihre Rangfolge.

Hinweis: Beachten Sie dabei, dass die Liste nicht die Reihenfolge wiedergibt, in der die Regeln abge-
arbeitet werden – im Gegenteil: Die Liste wird von unten nach oben abgearbeitet, damit die Regeln
mit der höchsten Rangfolge zuletzt angewandt werden.

¡ Anwenden auf 

Hier können Sie den Zellbereich ändern, auf den eine Regel angewandt werden soll. 

Wählen Sie die Regel dazu in der Liste Regeln und tragen Sie dann den gewünschten Zellbereich in die-
ses Eingabefeld ein.

¡ Schaltfläche Neu 

Legt, genau wie der Menübefehl Format > Bedingte Formatierung > Neue Regel, eine neue Formatie-
rungsregel für die momentan im Arbeitsblatt markierten Zellen an. 

Es erscheint dazu wieder der Dialog zum Erstellen von Regeln, der im Abschnitt Neue Formatierungsre-
geln anlegen beschrieben wurde.

¡ Schaltfläche Bearbeiten 

Lässt Sie die Regel bearbeiten, die momentan in der Liste Regeln ausgewählt ist.

Die Regel wird dann in allen Zellen geändert, auf die sie angewandt wurde – unabhängig davon, welche
Zellen derzeit im Arbeitsblatt markiert sind.
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Es erscheint dazu wieder der Dialog zum Erstellen von Regeln, der im Abschnitt Neue Formatierungsre-
geln anlegen beschrieben wurde.

¡ Schaltfläche Löschen 

Löscht die Regel, die momentan in der Liste Regeln ausgewählt ist. 

Die Regel wird dann von allen Zellen entfernt, auf die sie angewandt wurde – unabhängig davon, welche
Zellen derzeit im Arbeitsblatt markiert sind.

Weitere Informationen zum Thema Bedingte Formatierung entfernen finden Sie im nächsten Abschnitt.

¡ Schaltfläche Gehe zu 

Schließt den Dialog und springt zu dem Zellbereich für die Regel, die momentan in der Liste Regeln
ausgewählt ist.

Bedingte Formatierung entfernen

Zum Entfernen bedingter Formatierung gibt es zwei Möglichkeiten:

A) Löschen von Formatierungsregeln

Wenn Sie eine Formatierungsregel löschen, wird diese von allen Zellen entfernt, auf die sie angewandt wur-
de – ganz unabhängig davon, welche Zellen derzeit im Arbeitsblatt markiert sind.

Gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Regeln verwalten auf.

2. Es erscheint ein Dialog. 

Anmerkung: Dieser Dialog zeigt standardmäßig nur die Regeln für die aktuelle Zelle (oder Markierung)
an. Falls Sie hingegen alle Regeln im gesamten Arbeitsblatt sehen möchten, schalten Sie die Option
Quelle auf Aktuelles Arbeitsblatt um.

3. Wählen Sie die zu löschende Regel in der Liste Regeln.

4. Klicken Sie auf die Schaltfläche Löschen.

Die ausgewählte Regel wird nun gelöscht – und somit von allen Zellen entfernt, die sie betraf.

B) Entfernen aller bedingten Formatierungen von einem Zellbereich

Es gibt noch eine andere Methode zum Entfernen von bedingter Formatierung: Bei dieser wird sämtliche
bedingte Formatierung von den markierten Zellen entfernt.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie die Zellen, von denen Sie sämtliche bedingte Formatierung entfernen möchten.

2. Rufen Sie den Menübefehl Format > Bedingte Formatierung > Regeln in den markierten Zellen lö-
schen auf.

(Alternativ können Sie auch den Menübefehl Bearbeiten > Selektiv löschen > Bedingte Formatierung
aufrufen, der genau das gleiche tut.)
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Die markierten Zellen werden nun von sämtlichen bedingten Formatierungsregeln, mit denen sie derzeit
versehen sind, "befreit". 

Alle Formatierungsregeln, die dadurch überflüssig werden, werden automatisch gelöscht.

Gültigkeitsprüfung
Wenn Sie Zellen mit einer Gültigkeitsprüfung versehen, können Sie damit folgendes erreichen:

¡ Festlegen, dass in diesen Zellen nur noch bestimmte Arten von Werten (zum Beispiel nur Zahlen) inner-
halb bestimmter Grenzwerte (zum Beispiel nur Werte zwischen 10 und 20) als gültig erachtet werden. 

¡ Einen Infotext zum Ausfüllen der Zellen anzeigen lassen, sobald der Anwender diese Zelle ansteuert
(zum Beispiel: "Hier bitte nur Zahlen zwischen 10 und 20 eingeben!").

¡ Eine Fehler-, Warn- oder Infomeldung ausgeben lassen, wenn der Anwender dennoch Werte eingibt, die
der Gültigkeitsprüfung nicht entsprechen.

Dies ist nützlich, wenn Sie Tabellen erstellen, die von anderen Anwendern ausgefüllt werden sollen, und
Sie verhindern möchten, dass in diesen Zellen falsche Werte eingetippt werden können.

Wenn Sie beispielsweise möchten, dass in bestimmten Zellen nur noch Zahlen zwischen 10 und 20 als gül-
tig erachtet werden, gehen Sie dazu wie folgt vor:

1. Selektieren Sie die gewünschten Zellen.

2. Rufen Sie den Menübefehl Format > Gültigkeitsprüfung auf.

3. Auf der Karteikarte Einstellungen können Sie bestimmen, welche Arten von Werten für die Zellen als
gültig erachtet werden sollen – und Grenzwerte für die zulässigen Werte festlegen. 

In unserem Beispiel wäre also einzustellen: 

Zulässig sind: "Dezimalzahlen"

Mit Werten: "zwischen"

Minimum: 10

Maximum: 20

4. Auf der Karteikarte Eingabemeldung können Sie (auf Wunsch) einen Infotext eintragen, der angezeigt
wird, sobald der Anwender eine dieser Zellen ansteuert. 

Tragen Sie beispielsweise "Hier bitte nur Zahlen zwischen 10 und 20 eingeben!" ein. Sie können die
Eingabemeldung natürlich auch leer lassen.

5. Auf der Karteikarte Fehlermeldung können Sie festlegen, was für eine Meldung erscheinen soll, wenn
der Anwender in die Zellen ungültige Werte eintippt.

Über die Symbole im Bereich Typ bestimmen Sie zunächst die Art der Fehlermeldung (siehe Erläuterun-
gen weiter unten). 

Wichtig: Der Typ der Meldung bestimmt auch, ob es dem Anwender erlaubt sein soll, trotzdem ungül-
tige Eingaben zu machen. Nur beim Typ Fehlermeldung (erstes Symbol) weist PlanMaker ungültige
Eingaben strikt zurück!
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Weiterhin können Sie den Text der Meldung angeben. Wenn Sie nichts eingeben, wird eine Standard-
meldung ausgegeben.

Wählen Sie hier beispielsweise den Typ Fehlermeldung (erstes Symbol) und tragen Sie auf Wunsch ei-
ne geeignete Meldung ein (zum Beispiel mit dem Titel "Eingabefehler" und dem Text "Hier dürfen nur
Zahlen zwischen 10 und 20 eingegeben werden!").

6. Bestätigen Sie mit OK.

In den gewählten Zellen werden jetzt nur noch Zahlen zwischen 10 und 20 als gültig erachtet. Gibt der An-
wender etwas anderes ein, erscheint eine Fehlermeldung.

Hinweis: Beachten Sie dabei, dass die Gültigkeitsprüfung nur dann aktiv wird, wenn der Anwender Wer-
te eintippt. Fügt der Anwender hingegen ungültige Werte durch Kopieren und Einfügen ein (zum Beispiel
mit dem Menübefehl Bearbeiten > Einfügen), schlägt die Gültigkeitsprüfung nicht Alarm!

Wenn Sie die Gültigkeitsprüfung wieder abschalten möchten, markieren Sie die betroffenen Zellen und
wenden den Menübefehl Bearbeiten > Selektiv löschen > Gültigkeitsprüfung an. Alternativ können Sie
auch erneut den Menübefehl Format > Gültigkeitsprüfung aufrufen und bei Zulässig sind: wieder "Alle
Werte" auswählen.

Das Dialogfenster des obigen Befehls verfügt über folgende Optionen:

Karteikarte Einstellungen

¡ Zulässig sind: 

Mit dieser Option bestimmen Sie, welche Arten von Werten zulässig sind:

Option Erläuterung

Alle Werte Alle Arten von Werten zulassen (die Gültigkeitsprüfung also deaktivieren)

Ganze Zahlen Nur ganze Zahlen zulassen

Dezimalzahlen Nur Zahlen zulassen

Feste Listeneinträge Nur Einträge aus einer Liste von zulässigen Einträgen zulassen.

Tragen Sie dazu in das Feld Quelle eine durch Strichpunkte getrennte Liste
der erlaubten Werte ein – zum Beispiel Hund;Katze;Maus oder 1;2;3;4;5;6.

Alternativ können Sie auch ein Gleichheitszeichen und dahinter einen Zellbe-
reich eintragen, der alle gültigen Einträge enthält. Enthalten die Zellen C1 bis
C3 also z.B. "Hund", "Katze" und "Maus" und Sie geben bei Quelle =C1:C3
ein, sind nur noch diese drei Begriffe zulässig.

Über die Schaltfläche Einstellungen können Sie zusätzliche Optionen einstel-
len.

Datumswerte Nur Datumsangaben zulassen

Zeitwerte Nur Uhrzeiten zulassen

Textlänge Nur Einträge (auch Zahlen) mit der angegebenen Textlänge zulassen

Benutzerdefiniert Nur Einträge zulassen, die der angegebenen Bedingung entsprechen. Tragen
Sie diese anschließend im Feld Berechnung ein. Weitere Informationen dazu
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finden Sie am Ende dieses Abschnitts.

¡ Mit Werten 

Hier können Sie die zulässigen Werte weiter eingrenzen. Wählen Sie beispielsweise die Option Zwi-
schen, können Sie darunter das Minimum und Maximum angeben, zwischen dem die Werte liegen müs-
sen.

¡ Minimum, Maximum etc. 

Darunter legen Sie die Grenzwerte für die Eingaben fest. Tragen Sie beispielsweise als Minimum 10
und als Maximum 20 ein, werden nur noch Werte zwischen 10 und 20 akzeptiert.

Sie können hier übrigens auch Rechenformeln verwenden. Tragen Sie bei Minimum zum Beispiel C1
ein, muss der Zellinhalt größer als der Inhalt der Zelle C1 sein. Tragen Sie SUMME(D2:D8) ein, muss
der Zellinhalt größer als die Summe der Zellen D2 bis D8 sein etc.

¡ Auswahlliste verwenden 

Nur verfügbar, wenn bei Zulässig sind der Eintrag Feste Listenwerte gewählt wurde. Ist diese Option
aktiviert, erscheint ein Pfeilchen am rechten Rand der Tabellenzelle, wenn der Anwender sie ansteuert.
Wird dieses Pfeilchen angeklickt, erscheint eine Liste aller zulässigen Werte zur Auswahl.

¡ Leere Zellen ignorieren 

Ist diese Option aktiviert, wird bei leeren Zellen keine Gültigkeitsprüfung vorgenommen. Löscht der An-
wender also beispielsweise den Zellinhalt, wird in der Zelle keine Gültigkeitsprüfung mehr vorgenom-
men (bis wieder ein Wert eintragen wird).

Karteikarte Eingabemeldung

Auf dieser Karteikarte können Sie einen Infotext zum Ausfüllen der Zellen anzeigen lassen (zum Beispiel
"Hier bitte nur Zahlen zwischen 10 und 20 eingeben!"). Dieser wird angezeigt, wenn der Anwender diese
Zelle ansteuert.

Es gibt hierfür folgende Optionen:

¡ Eingabemeldung anzeigen, wenn die Zelle markiert ist 

Bestimmt, ob die Eingabemeldung angezeigt werden soll oder nicht.

¡ Titel 

Hier können Sie den Titel der Meldung angeben.

¡ Meldung 

Hier können Sie den Meldungstext angeben.

Karteikarte Fehlermeldung

Auf dieser Karteikarte können Sie die Fehler-, Warn- oder Infomeldung festlegen, die erscheinen soll, wenn
der Anwender Daten eingibt, die der Gültigkeitsprüfung nicht entsprechen.

Es gibt hierfür folgende Optionen:

¡ Fehlermeldung anzeigen, wenn ungültige Daten eingegeben wurden 

Bestimmt, ob die Fehlermeldung angezeigt werden soll oder nicht.
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Anmerkung: Normalerweise sollten Sie diese Option eingeschaltet lassen, da eine Gültigkeitsprüfung
nicht sonderlich hilfreich ist, wenn der Anwender nicht darauf hingewiesen wird, dass er ungültige Da-
ten eingibt.

¡ Typ 

Hier können Sie den Typ der Meldung festlegen. Klicken Sie dazu auf das gewünschte Symbol.

Wichtig: Der Typ der Meldung bestimmt auch, ob es dem Anwender erlaubt sein soll, dennoch ungül-
tige Eingaben zu machen. Nur beim Typ Fehlermeldung (erstes Symbol) weist PlanMaker ungültige
Eingaben strikt zurück!

Folgende Arten von Meldungen stehen zur Wahl:

Fehlermeldung (erstes Symbol): PlanMaker gibt eine Fehlermeldung aus. Der Anwender ist gezwun-
gen, einen gültigen Wert anzugeben; ungültige Werte werden nicht akzeptiert.

Warnmeldung (zweites Symbol): PlanMaker gibt eine Warnmeldung aus. Der Anwender kann selbst
entscheiden, ob er den ungültigen Wert dennoch in das Arbeitsblatt übernehmen möchte.

Infomeldung (drittes Symbol): PlanMaker gibt nur eine Infomeldung aus. Der Anwender muss diese
lediglich bestätigen, und der ungültige Wert wird übernommen (sofern der Anwender nicht auf Abbre-
chen klickt).

¡ Titel 

Hier können Sie den Titel der Meldung angeben. 

Wenn Sie nichts eintragen, wird ein Standardtext ausgegeben.

¡ Meldung 

Hier können Sie den Meldungstext angeben.

Wenn Sie nichts eintragen, wird ein Standardtext ausgegeben.

Tipp: Wenn Sie im Meldungstext das festgelegte Minimum und/oder Maximum für die Zelle ausgeben
möchten, verwenden Sie darin einfach die Platzhalter %min und %max. Beispiel: "Fehler – hier sind
nur Werte zwischen %min und %max erlaubt!".

Beispiele

Abschließend einige Beispiele zur Verwendung dieser Funktion:

¡ Nur Werte innerhalb der angegebenen Grenzen zulassen 

Wählen Sie auf der Karteikarte Einstellungen zunächst den gewünschten Typ von Werten. Sollen bei-
spielsweise nur Datumsangaben zulässig sein, setzen Sie die Option Zulässig sind auf "Datumswerte".
Sollen nur Zahlen zulässig sein, verwenden Sie die Option "Dezimalzahlen" etc.

Danach können Sie mit der Option Mit Werten die zulässigen Grenzwerte festlegen. Sollen beispiels-
weise nur Werte größer als Eins zulässig sein, wählen Sie dort den Eintrag "größer als" und tragen dar-
unter bei Minimum eine 1 ein.

¡ Nur Werte mit einer bestimmten Länge zulassen 

Wenn Sie beispielsweise verhindern möchten, dass Anwender einen Wert mit mehr als 40 Zeichen ein-
geben können, wählen Sie folgende Einstellungen: 

Zulässig sind: "Textlänge"
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Mit Werten: "kleiner oder gleich"

Maximum: 40.

Hinweis: Hierbei gelten Ziffern, Punkte, Kommas, Vorzeichen etc. genauso als ein Zeichen wie Buchsta-
ben.

¡ Eigene Formeln für die Gültigkeitsprüfung verwenden 

Fortgeschrittene Anwender können bei Zulässig sind: auch die Option "Benutzerdefiniert" wählen und
dann eine beliebige Formel für die Gültigkeitsprüfung angeben. 

Verwenden Sie dazu eine Formel, die einen Wahrheitswert (also entweder WAHR oder FALSCH) zu-
rückliefert. Ist das Resultat der Formel WAHR, erachtet PlanMaker den Eintrag als gültig, ansonsten
wird er als ungültig erachtet.

Ein Beispiel: Wenn Sie die Formel SUMME($A$1:$C$3) > 42 eintragen, wird die Eingabe nur dann als
gültig erachtet, wenn die Summe des Zellbereichs A1:C3 größer als 42 ist.

Hinweis: Beachten Sie, dass in solchen Formeln nicht nur absolute Zellbezüge (wie im obigen Beispiel),
sondern auch relative Zellbezüge verwendet werden können:

Absolute Zellbezüge wie $A$1 beziehen sich immer auf die Zelle A1.

Relative Zellbezüge wie A1 beziehen sich hingegen auf die Zelle in der linken oberen Ecke der Markie-
rung. Wenden Sie eine Gültigkeitsprüfung auf nur eine Zelle an, bezieht sich A1 also auf eben diese Zel-
le. Hatten Sie zuvor einen Bereich von Zellen markiert, bezieht sich A1 auf die Zelle in der linken obe-
ren Ecke, A2 auf die Zelle darunter etc.

Format übertragen
Mit dem Menübefehl Format > Format übertragen können Sie blitzschnell die Formatierung von Zellen
auf andere Zellen übertragen.

Gehen Sie dazu wie folgt vor:

1. Klicken Sie zuerst die Zelle an, deren Format Sie auf andere Zellen übertragen möchten.

2. Rufen Sie den Menübefehl Format > Format übertragen auf.

Der Mauszeiger ändert sich nun in ein Fadenkreuz mit einem Pinsel: 

3. Ziehen Sie die Maus nun (bei gedrückter Maustaste) über die Zellbereiche, auf die das Format übertra-
gen werden soll. Sie können diese Funktion dabei auf beliebig viele Zellbereiche oder Einzelzellen an-
wenden (Einzelzellen dazu einfach anklicken).

4. Wenn Sie fertig sind, rufen Sie den Befehl Format übertragen erneut auf oder drücken einfach die Tas-
te Esc.

Übertragen wird dabei sowohl das Zeichenformat (Schriftart, Textauszeichnungen etc.) als auch das Zellen-
format (Zahlenformat, Ausrichtung etc.).

Übertragen des Formats ganzer Zellbereiche

Sie können auch das Format ganzer Zellbereiche auf andere Zellen übertragen. Verfahren Sie dazu wie oben
beschrieben, markieren jedoch bei Punkt 1. den Zellbereich, dessen Format übertragen werden soll.
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Markieren Sie beispielsweise drei Zellen, die mit rotem, grünem und blauem Hintergrund formatiert sind,
und übertragen deren Format auf einen anderen Zellbereich, wird dieser Bereich abwechselnd mit rotem,
grünem und blauem Hintergrund formatiert.

Seitenformat
In diesem Abschnitt erfahren Sie, welche Möglichkeiten es gibt, ein Arbeitsblatt für den Ausdruck zu for-
matieren.

Folgende Themen werden darin behandelt:

¡ Seitenformat einstellen 

Über den Menübefehl Datei > Seite einrichten können Sie unter anderem das Seitenformat für das aktu-
elle Arbeitsblatt festlegen. Dazu zählen Einstellungen wie Papiergröße, Papierausrichtung (Hoch- oder
Querformat) und die Seitenränder.

¡ Optionen zum Seitenformat einstellen 

Auf der Karteikarte Optionen desselben Befehls finden Sie verschiedene Optionen für die Seitennum-
merierung, Druckrichtung etc. und können festlegen, welche Bestandteile des Arbeitsblatts gedruckt
werden sollen.

¡ Kopf- und Fußzeile einrichten 

Auf der Karteikarte Kopf- und Fußzeilen können Sie das Dokument mit einer Kopfzeile und/oder Fuß-
zeile versehen, die am Anfang beziehungsweise am Ende jeder Druckseite des Arbeitsblatts ausgegeben
wird.

¡ Seitenumbruch manuell beeinflussen 

Zur Seitenformatierung zählt weiterhin die Möglichkeit, den automatischen Seitenumbruch bei Bedarf
von Hand zu beeinflussen. Hierzu dient der Menübefehl Einfügen > Seitenumbruch.

Auf den nächsten Seiten erfahren Sie alles Wissenswerte zu diesen Themen.

Seitenformat einstellen

Mit dem Menübefehl Datei > Seite einrichten können Sie unter anderem das Seitenformat eines Arbeits-
blatts festlegen. Dazu zählen Einstellungen wie Papierformat und -ausrichtung (Hochformat oder Querfor-
mat).

Hinweis: Das Seitenformat kann für jedes Arbeitsblatt eines Dokuments anders eingestellt werden. Sie
können also beispielsweise für ein Arbeitsblatt das Hochformat wählen und für ein anderes das Querfor-
mat.

Um das Seitenformat eines Arbeitsblatts zu ändern, rufen Sie den Menübefehl Datei > Seite einrichten auf,
wechseln auf die Karteikarte Seitenformat und nehmen dann die gewünschten Einstellungen vor:
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Ausrichtung

Hier können Sie die Ausrichtung der Druckseiten festlegen: Hochformat oder Querformat.

Papiergröße

Hier bestimmen Sie das Format der Druckseiten. In der aufklappbaren Liste Papiergröße werden alle vom
derzeit gewählten Drucker unterstützten Papierformate angeboten; Sie können aber unter Breite und Höhe
auch eigene Werte von Hand angeben.

Ränder

Hier können Sie die Seitenränder einstellen.

Abstand zur Blattkante

Hier können Sie bestimmen, wie viel Abstand zwischen Kopf- und Fußzeilen und der oberen beziehungs-
weise unteren Blattkante freigelassen werden soll.

Hinweis: Kopf- und Fußzeilen werden stets in den oberen beziehungsweise unteren Seitenrand gedruckt.
Wenn sie nicht auf dem Ausdruck erscheinen, prüfen Sie, ob a) der Abstand zur Kante zu groß ist oder b)
der obere/untere Rand zu klein ist.

Papierschächte

Nur unter Windows verfügbar: Falls Ihr Drucker über mehrere Papierschächte verfügt, können Sie hier
einstellen, aus welchem Schacht der Drucker das Papier einziehen soll. Ist die Standardeinstellung Aus
Druckereinstellung gewählt, nimmt PlanMaker keinen Einfluss auf den Papiereinzug. Soll beispielsweise
die erste Seite aus Schacht 1 und alle weiteren aus Schacht 2 eingezogen werden, ändern Sie diese Einstel-
lung einfach entsprechend.

Tipp: Wenn Sie mit der rechten Maustaste unten auf ein Arbeitsblattregister klicken, können Sie mit dem
Kontextmenü-Befehl Seiteneinrichtung kopieren alle eingestellten Seiteneinrichtungen eines Arbeits-
blatts auf ein anderes Arbeitsblatt übertragen. Siehe auch Abschnitt Arbeitsblätter verwalten.

Optionen zum Seitenformat einstellen

Auf der Karteikarte Optionen des Menübefehls Datei > Seite einrichten können Sie Einstellungen vorneh-
men, die den Ausdruck des aktuellen Arbeitsblatts betreffen:

Wiederholungszeilen/Wiederholungsspalten

Falls das Arbeitsblatt Zeilenbeschriftungen oder Spaltenbeschriftungen enthält, und Sie möchten, dass diese
auf allen Druckseiten wiederholt werden, dann tragen Sie diese hier ein. 

Verwenden Sie dazu die Schreibweise Startzeile:Endzeile beziehungsweise Startspalte:Endspalte.
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Enthält beispielsweise die erste Zeile einer langen Liste von Daten eine Beschriftung, die auf allen Seiten
wiederholt werden soll, so ist bei Wiederholungszeilen 1:1 einzutragen.

Möchten Sie hingegen, dass die Spalten A bis C auf jeder Seite wiederholt werden sollen, so tragen Sie bei
Wiederholungsspalten A:C ein.

Drucken

Hier können Sie bestimmen, ob die folgenden Komponenten der Tabelle im Ausdruck erscheinen sollen:

¡ Zeilen- und Spaltenköpfe (die mit 1, 2, 3... beziehungsweise A, B, C... beschrifteten Schaltflächen links
und oberhalb der Tabelle) 

¡ Gitternetz (die grauen Gitternetzlinien zwischen den Zellen)

¡ Kommentare (mit dem Menübefehl Einfügen > Kommentar an Zellen angebrachte Kommentare).

Außerdem lässt sich über die Option Farben festlegen, ob der Ausdruck in Farbe erfolgen soll:

¡ Originalfarben: Der Ausdruck erfolgt farbig. 

¡ Graustufen: Farbiger Text wird in schwarz/weiß ausgegeben; farbige Objekte (Grafiken, Diagramme
etc.) werden in Grautöne umgewandelt.

¡ Nur Umrisse: Farbiger Text wird in schwarz/weiß ausgegeben; von Objekten werden nur die Umrissli-
nien (in schwarz/weiß) ausgegeben.

Zentrierungsoptionen

Schalten Sie die Option Horizontal zentrieren ein, wird der zu druckende Tabelleninhalt horizontal auf der
Druckseite zentriert.

Analog zentriert die Option Vertikal zentrieren den Tabelleninhalt vertikal auf der Druckseite.

Seitennummer

Hier können Sie die Seitennummerierung beeinflussen:

Automatisch: Die Druckseiten werden mit 1 beginnend durchnummeriert.

Wert: Die Druckseiten werden mit dem hier eingetragenen Wert beginnend durchnummeriert.

Tipp: Um auf einem Arbeitsblatt die Seitennummer ausgeben zu lassen, fügen Sie das Feld Seitennum-
mer in eine Kopf- oder Fußzeile ein (siehe nächster Abschnitt).

Druckrichtung

Hier bestimmen Sie, in welcher Reihenfolge PlanMaker Arbeitsblätter, die breiter als eine Druckseite sind,
ausgeben soll.

¡ Von links nach rechts 

Es wird erst von links nach rechts und anschließend von oben nach unten gedruckt.

¡ Von oben nach unten 

Es wird erst von oben nach unten und anschließend von links nach rechts gedruckt.
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Druckbereich

Hier können Sie einen Druckbereich für das aktuelle Arbeitsblatt definieren. 

Wenn ein Druckbereich definiert ist, werden beim Drucken des Arbeitsblatts nur noch diejenigen Zellen
ausgegeben, die sich innerhalb dieses Zellbereichs befinden. Der Rest des Arbeitsblatts wird weggelassen.

Standardmäßig ist dieses Eingabefeld leer – es ist also kein Druckbereich definiert und das gesamte Arbeits-
blatt wird gedruckt. Wenn Sie hier allerdings einen Zellbereich (oder den Namen eines benannten Bereichs)
eintippen, wird beim Ausdrucken des Arbeitsblatts generell nur noch dieser Bereich ausgegeben.

Der Druckbereich kann für jedes Arbeitsblatt einer Tabelle gesondert angegeben werden.

Wichtig: Diese Einstellung wird permanent im Dokument gespeichert. Wenn Sie das Dokument also spä-
ter erneut öffnen und es ausdrucken, wird der Ausdruck auch weiterhin nur die Zellen innerhalb des
Druckbereichs enthalten. Wenn Sie möchten, dass wieder das gesamte Arbeitsblatt ausgegeben wird, lee-
ren Sie einfach das Eingabefeld Druckbereich in diesem Dialog, um den Druckbereich zu entfernen.

Tipp: Es gibt alternativ eine etwas komfortablere Methode zum Arbeiten mit Druckbereichen: Sie können
einen Druckbereich für ein Arbeitsblatt auch definieren, indem Sie den gewünschten Zellbereich selektieren
und dann den Menübefehl Datei > Druckbereich > Druckbereich festlegen aufrufen. Auch für das Entfer-
nen des Druckbereichs für ein Arbeitsblatt gibt es ein eigenes Kommando: den Menübefehl Datei > Druck-
bereich > Druckbereich entfernen.

Skalierungsoptionen

Hier können Sie die Vergrößerungsstufe für Ausdrucke des Dokuments ändern. 

Die Standardeinstellung ist ein fester Skalierungsfaktor von 100% (sprich: die Originalgröße).

Um den Skalierungsfaktor zu ändern, wählen Sie erst den gewünschten Skalierungsmodus und stellen Sie
dann die gewünschte Vergrößerung ein:

¡ Festen Skalierungsfaktor verwenden: Hier können Sie die Vergrößerungsstufe manuell auf einen Pro-
zentwert setzen. Es sind Werte zwischen 20 und 200 Prozent zulässig. Bei 50% wird der Ausdruck bei-
spielsweise halb so groß, bei 200% doppelt so groß. 

Bei den anderen 4 Skalierungsmodi wird die Vergrößerungsstufe anhand Ihrer Vorgaben automatisch be-
rechnet:

¡ Höhe in Seiten festlegen: Hier können Sie die gewünschte Höhe des Ausdrucks in Druckseiten vorge-
ben. Die entsprechende Vergrößerungsstufe ermittelt PlanMaker dann automatisch. 

¡ Breite in Seiten festlegen: Analog lässt sich hier die gewünschte Breite des Ausdrucks in Druckseiten
vorgeben.

¡ Höhe und Breite in Seiten festlegen: Hier können Sie die gewünschte maximale Höhe und Breite des
Ausdrucks vorgeben.

¡ Gesamtzahl der Seiten festlegen: Hier können Sie vorgeben, wie viele Seiten der Ausdruck insgesamt
umfassen soll. 

Hinweis: Die automatisch ermittelte Vergrößerungsstufe kann dabei nicht kleiner als 20% werden.
Wird dieser Wert unterschritten, verwendet PlanMaker automatisch den zulässigen Minimalwert von
20%. Entsprechendes gilt für den Maximalwert von 200%.
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Kopf- und Fußzeile einrichten

Sie können Arbeitsblätter auf Wunsch mit einer Kopfzeile und/oder einer Fußzeile versehen. Das sind Zei-
len, die am oberen beziehungsweise unteren Ende jeder Seite des Arbeitsblatts gedruckt werden.

Hinweis: Kopf- und Fußzeilen können für jedes Arbeitsblatt separat definiert werden.

Um beispielsweise die Kopfzeile des aktuellen Arbeitsblatts zu bearbeiten, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Datei > Seite einrichten auf und wechseln Sie auf die Karteikarte Kopf-
und Fußzeilen.

Alternativ können Sie auch den Menübefehl Einfügen > Kopf- und Fußzeile aufrufen, der genau das
gleich tut.

2. Um eine der vordefinierten Arten von Kopfzeilen zu verwenden, wählen Sie diese in der aufklappbaren
Liste im oberen Teil des Dialogs.

Um die Kopfzeile nach Ihren Wünschen anzupassen, klicken Sie auf die Schaltfläche Bearbeiten (siehe
Abschnitt "Bearbeiten von Kopf- und Fußzeilen" weiter unten).

Um das Format der Kopfzeile zu ändern, klicken Sie auf die Schaltfläche Format (siehe Abschnitt "For-
matieren von Kopf- und Fußzeilen" weiter unten).



214Gestalten einer Tabelle

3. Bestätigen Sie mit OK.

Die Kopfzeile wurde nun entsprechend geändert.

Das Bearbeiten der Fußzeile funktioniert genauso (mit den Dialogelementen im unteren Teil des Dialogs).

Tipp: Kopf- und Fußzeilen werden nicht im Dokument selbst angezeigt – sie erscheinen nur im Aus-
druck. Sie können aber jederzeit den Menübefehl Datei > Druckvorschau aufrufen, um das Aussehen
der Kopf- und Fußzeile zu begutachten.

Bearbeiten von Kopf- und Fußzeilen

Wenn Sie in obigem Dialogfenster auf die Schaltfläche Bearbeiten klicken, können Sie die Kopfzeile bzw.
Fußzeile des Arbeitsblatts nach Belieben bearbeiten.

Hierzu einige Anmerkungen:

¡ Kopf- und Fußzeilen können aus bis zu drei Teilen bestehen 

Die Eingabefelder in diesem Dialog sind dreigeteilt. Das liegt daran, dass Kopf- und Fußzeilen aus bis zu
drei Teilen bestehen können: einem linken (linksbündigen), einem mittleren (zentrierten) und einem
rechten (rechtsbündigen Bereich). So können Sie beispielsweise links das Datum, in der Mitte den Da-
teinamen und rechts die Seitennummer ausgeben lassen.

Natürlich können Sie auch nur einen der drei Bereiche ausfüllen, wenn Sie beispielsweise nur links den
Dateinamen ausgeben lassen möchten.

¡ Verwenden von Feldern für die Seitennummer etc. 

Über die Schaltfläche Felder können Sie Felder in die Kopf- beziehungsweise Fußzeile einfügen.

Felder sind Platzhalter, die symbolisch für bestimmte Informationen stehen. Fügen Sie beispielsweise ein
Feld für die Seitennummer ein, steht der Platzhalter {\SEITENNUMMER} in dem Eingabefeld. Beim
Ausdruck wird diese symbolische Angabe dann automatisch durch die Seitennummer ersetzt.

Es stehen folgende Felder zur Verfügung:

Feldname Funktion

Name des Dokuments Dateiname des Dokuments (z.B. "Meine Tabelle.pmdx")
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Name und Pfad des Dokuments Dateiname und Pfad des Dokuments (z.B. "C:\Tabellen\Meine Tabel-
le.pmdx")

Name des Arbeitsblatts Name des aktuellen Arbeitsblatts

Seitennummer Seitennummer

Seitenzahl Gesamtzahl der Seiten

Druckdatum Aktuelles Datum (zum Zeitpunkt des Druckens)

Druckzeit Aktuelle Uhrzeit (zum Zeitpunkt des Druckens)

Änderungsdatum Datum, an dem das Dokument zuletzt geändert und (sprich: gespeichert)
wurde

Erstelldatum Datum, an dem das Dokument erstellt wurde

Um eines dieser Felder einzufügen, klicken Sie auf die Schaltfläche Felder und dann auf das gewünsch-
te Feld.

¡ Ändern der Zeichenformatierung 

Über die Bedienelemente im oberen Teil des Dialogs können Sie das Zeichenformat (Schriftart, Schrift-
größe etc.) der Einträge ändern. 

Hinweis: Markieren Sie zuvor den zu formatierenden Text (in einem der drei Eingabefelder).

Formatieren von Kopf- und Fußzeilen

Abgesehen von der Zeichenformatierung in Kopf- und Fußzeilen (siehe oben), können Sie auch Umrandun-
gen und Schattierungen anbringen sowie Ausrichtung und Ränder abändern. Klicken Sie dazu im Hauptdia-
log des Menübefehl Einfügen > Kopf- und Fußzeile auf die Schaltfläche Format.

Es erscheint ein Dialogfenster mit folgenden Karteikarten:

¡ Karteikarte Schattierung 

Hier können Sie die Kopf-/Fußzeile mit einer farbigen Schattierung oder einem Muster versehen. Die
Bedienung der Optionen entspricht der im Abschnitt Schattierung.

¡ Karteikarte Umrandung 

Hier können Sie die Kopf-/Fußzeile mit einer Umrandung oder einzelnen Umrandungslinien versehen.
Die Bedienung der Optionen entspricht der im Abschnitt Umrandung.

¡ Karteikarte Ausrichtung 

Hier können Sie die Innenränder der Kopf-/Fußzeile ändern und die vertikale Ausrichtung festlegen.

Tipp: Der Abstand der Kopf-/Fußzeile zur oberen/unteren Blattkante lässt sich nicht hier, sondern auf der
Karteikarte Seitenformat einstellen.
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Kopf- und Fußzeilen vorübergehend deaktivieren

Wenn Sie ein Dokument einmal ohne die definierten Kopf- oder Fußzeilen ausdrucken möchten, rufen Sie
Einfügen/Kopf- und Fußzeile auf und schalten die Option Drucken aus. Die Kopf- oder Fußzeile bleibt
dann erhalten, sie wird aber nicht mehr ausgedruckt.

Möchten Sie die Kopf- und Fußzeilen später wieder ausgedruckt haben, schalten Sie die Option Drucken
einfach wieder an.

Seitenumbruch manuell beeinflussen

Zur Seitenformatierung zählt weiterhin die Möglichkeit, den automatischen Seitenumbruch bei Bedarf von
Hand zu beeinflussen.

Normalerweise erledigt PlanMaker den Seitenumbruch ohne Ihr Zutun: Er fügt automatisch einen Seitenum-
bruch ein, sobald das Ende der Druckseite erreicht ist. Auf dem Bildschirm wird dies sichtbar gemacht
durch einen dunklen horizontalen beziehungsweise vertikalen Strich zwischen den Zellen. Hieran erkennen
Sie, wo die Druckseite beim Ausdrucken unten beziehungsweise rechts abgeschnitten wird.

Bei Bedarf haben Sie die Möglichkeit, einen Seitenumbruch manuell herbeizuführen. Rufen Sie dazu den
Menübefehl Einfügen > Seitenumbruch auf. Es öffnet sich ein Untermenü mit folgenden Befehlen:

¡ Mit Vor Zeile einfügen fügen Sie vor der aktuellen Zeile einen horizontalen Seitenumbruch ein.  

¡ Über den Befehl Vor Zeile löschen können Sie einen solchen Umbruch wieder entfernen. Der Zellrah-
men muss sich dabei direkt unter dem Umbruch befinden.

¡ Vor Spalte einfügen fügt dagegen vor der aktuellen Spalte einen vertikalen Seitenumbruch ein. 

¡ Über den Befehl Vor Spalte löschen können Sie einen solchen Umbruch wieder entfernen. Der Zellrah-
men muss sich dabei direkt rechts neben dem Umbruch befinden.

¡ Alle Seitenumbrüche löschen entfernt alle manuell eingefügten Seitenumbrüche wieder.
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Suchen und Ersetzen
In diesem Kapitel lernen Sie alle Funktionen zum Suchen und Ersetzen in Tabellen kennen:

¡ Suchen und Ersetzen 

Mit den Suchfunktionen von PlanMaker können Sie eine Tabelle nach einem bestimmten Suchbegriff
durchsuchen – und die Fundstellen bei Bedarf durch etwas anderes ersetzen lassen.

¡ Springen zu bestimmten Zelladressen 

Mit dem Befehl Gehe zu ... können Sie zu bestimmten Zellen, Zellbereichen oder benannten Bereichen
springen.

¡ Springen zu bestimmten Bestandteilen einer Tabelle 

Mit den drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters können Sie zu bestimmten
Bestandteilen einer Tabelle springen (zum Beispiel zum nächsten Fehlerwert oder Kommentar).

Alles Weitere zu diesen Themen erfahren Sie auf den nächsten Seiten.

Suchen
Mit dem Menübefehl Bearbeiten > Suchen können Sie ein Dokument nach einem bestimmten Suchbegriff
durchsuchen lassen.

Gehen Sie dazu wie folgt vor:

1. Falls Sie nur einen bestimmten Zellbereich durchsuchen möchten, müssen Sie diesen erst markieren.
Wenn Sie nichts markieren, wird das komplette Arbeitsblatt durchsucht.

2. Rufen Sie den Menübefehl Bearbeiten > Suchen auf.

3. Geben Sie bei Suchen nach: den Suchbegriff ein.

4. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Abschnitt Erweiterte Such-
funktionen).

5. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen.

Wenn der Suchbegriff gefunden wird, setzt PlanMaker den Zellrahmen auf die Zelle, die den Suchbegriff
enthält.

Sie haben nun folgende Möglichkeiten:

A) Sie klicken auf Weitersuchen, um zur nächsten Fundstelle zu gelangen.

B) Sie beenden den Suchen-Dialog mit Schließen. 
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Ersetzen
Manchmal geht es nicht nur darum, einen Suchbegriff wiederzufinden, sondern man möchte ihn auch gleich
durch etwas anderes austauschen. Hierzu dient der Menübefehl Bearbeiten > Ersetzen.

Diesen setzen Sie wie folgt ein:

1. Falls Sie nur einen bestimmten Zellbereich durchsuchen möchten, müssen Sie diesen erst markieren.
Wenn Sie nichts markieren, wird das komplette Arbeitsblatt durchsucht.

2. Rufen Sie den Menübefehl Bearbeiten > Ersetzen auf.

3. Geben Sie bei Suchen nach: den Suchbegriff ein.

4. Geben Sie bei Ersetzen durch: den Begriff ein, durch den der Suchbegriff ersetzt werden soll.

5. Stellen Sie bei Bedarf die gewünschten Optionen für die Suche ein (siehe Abschnitt Erweiterte Such-
funktionen).

6. Betätigen Sie die Schaltfläche Suchen, um die Suche zu beginnen.

Wenn der Suchbegriff gefunden wird, setzt PlanMaker den Zellrahmen auf die Zelle, die den Suchbegriff
enthält.

Sie haben nun folgende Möglichkeiten:

A) Sie klicken auf Ersetzen, woraufhin der Suchbegriff durch den Ersatzbegriff ersetzt wird und PlanMaker
zur nächsten Fundstelle springt.

B) Sie klicken auf Weitersuchen, woraufhin PlanMaker zur nächsten Fundstelle springt – ohne den Begriff
zu ersetzen.

C) Sie klicken auf Alle ersetzen, woraufhin PlanMaker alle Vorkommen des Suchbegriffs ersetzt.

D) Sie beenden den Suchen-Dialog mit Schließen. 

Suchen/Ersetzen wiederholen
Um einen Such- oder Ersetzungsvorgang zu wiederholen oder ihn nach Abbruch fortzuführen, rufen Sie den
Menübefehl Bearbeiten > Suchen wiederholen beziehungsweise Bearbeiten > Ersetzen wiederholen auf
oder drücken einfach die Taste F3. 

PlanMaker setzt die Suche nun fort und zeigt die nächste Fundstelle an.

Erweiterte Suchfunktionen
Wenn Sie im Dialog des Menübefehls Bearbeiten > Suchen oder Bearbeiten > Ersetzen auf die Schaltflä-
che Erweitern klicken, wird der Suchen-Dialog vergrößert und bietet zusätzliche Optionen an.
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Mit der Schaltfläche Reduzieren lässt sich der Dialog wieder verkleinern. So können Sie selbst bestimmen,
ob Sie lieber viele Einstellmöglichkeiten haben oder bei der Suche möglichst viel von der Tabelle sehen
möchten. 

Der erweiterte Suchen/Ersetzen-Dialog bietet folgende Optionen zusätzlich:

Rubrik "Suchen in"

Hier können Sie genau festlegen, wie die Tabelle durchsucht werden soll:

¡ Suchen in 

Über die aufklappbare Liste oben können Sie wählen, welche Bestandteile der Tabelle durchsucht wer-
den sollen: die Zellen der Tabelle, deren Kommentare oder alle Rahmen (Textrahmen und Zeichnun-
gen, die Text enthalten).

¡ Formeln 

Ist diese Option aktiviert, werden alle Rechenformeln in Zellen durchsucht. 

So können Sie beispielsweise nach "Summe" suchen, um alle Zellen zu finden, in denen die Rechenfunk-
tion SUMME verwendet wird.

¡ Ergebnissen 

Ist diese Option aktiviert, werden auch alle Ergebnisse von Rechenformeln durchsucht. 

Suchen Sie also beispielsweise nach "4", werden auch Zellen gefunden, in denen die Berechnung =2+2
eingetragen ist.

(Diese Option ist nur beim Suchen verfügbar, nicht jedoch beim Ersetzen.)

¡ Werten 

Ist diese Option aktiviert, werden alle fest eingegeben Werte durchsucht (also von Hand eingetragene
Zahlen, Zeichenketten etc.).

¡ Gesamtes Dokument 

Ist diese Option aktiviert, werden alle Arbeitsblätter des Dokuments durchsucht. 

Ist sie ausgeschaltet, wird nur das aktuelle Arbeitsblatt durchsucht (beziehungsweise alle Arbeitsblätter,
die derzeit im Arbeitsblattregister markiert sind.)

¡ Spaltenweise suchen 

Ist diese Option aktiviert, wird die Tabelle Spalte für Spalte durchsucht.

Ist sie ausgeschaltet, wird die Tabelle Zeile für Zeile durchsucht.

Rubrik "Optionen"

Hier können Sie weitere Einstellungen zum Suchvorgang vornehmen:

¡ Groß-/Kleinschreibung beachten 

Normalerweise wird die Groß-/Kleinschreibung des Suchbegriffs ignoriert. Bei der Suche nach "haus"
wird also gleichermaßen "Haus", "haus", "HAUS", "HaUs" etc. gefunden. 
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Schalten Sie diese Option jedoch ein, wird nur dann etwas gefunden, wenn die Groß-/Kleinschreibung
der Fundstelle genau mit der des Suchbegriffs übereinstimmt. Bei der Suche nach "haus" wird dann also
nur noch "haus" gefunden. 

¡ Ganze Zelle muss übereinstimmen 

Normalerweise findet PlanMaker alle Zellen, die den Suchbegriff an irgendeiner Position enthalten. Su-
chen Sie also nach "Steuer", werden auch Zellen gefunden, die den Inhalt "Steuererklärung" oder "Ein-
kommensteuer" haben.

Schalten Sie diese Option hingegen ein, muss der gesamte Zellinhalt mit dem Suchbegriff übereinstim-
men. Bei der Suche nach "Steuer" werden dann also nur noch Zellen gefunden, die exakt den Inhalt
"Steuer" haben. 

Schaltfläche "Sonstiges"

Die Schaltfläche Sonstiges ermöglicht es Ihnen, die nachfolgenden Platzhalter im Suchbegriff zu verwen-
den:

¡ Einzelnes beliebiges Zeichen (^?) – Dieser Platzhalter steht für ein einzelnes beliebiges Zeichen. Bei
der Suche nach "M^?ller", wird beispielsweise "Müller", "Möller", "Miller" etc gefunden. 

¡ Mehrere beliebige Zeichen (^*) – Dieser Platzhalter steht für eine beliebige Anzahl beliebiger Zeichen.
Bei der Suche nach "M^*er" wird beispielsweise "Müller", "Maier", "Mittermayer" etc. gefunden. 

¡ Caret (^^) – Sucht nach dem Zeichen "^" (Zirkumflex oder Caret). 

¡ Manueller Zeilenwechsel (^a) – Sucht nach einem manuellen Zeilenwechsel (erzeugt durch Strg+¿).

Um einen dieser Platzhalter in den Suchbegriff einzufügen, klicken Sie die Schaltfläche Sonstiges an und
wählen dann den gewünschten Platzhalter per Mausklick.

Sie können Platzhalter in Ihrem Suchbegriff nach Belieben wiederholen und kombinieren. Weiterhin kön-
nen Sie sie natürlich mit normalem Text mischen.

Schaltfläche "Alle suchen"

Wenn Sie die Schaltfläche Alle suchen anklicken, wird eine Liste aller Vorkommen des Suchbegriffs ange-
zeigt. Klicken Sie einen der Einträge an, springt PlanMaker zur entsprechenden Fundstelle im Dokument.

Hinweis: Diese Schaltfläche steht nur zur Verfügung, wenn Sie bei Suchen in die Option Zellen gewählt
haben.

Springen zu bestimmten Zelladressen
Der Menübefehl Bearbeiten > Gehe zu dient dazu, den Zellrahmen auf eine bestimmte Zelle in der Tabelle
zu setzen.

Es erscheint dazu ein Dialogfenster, in dem Sie die gewünschte Zelladresse angeben. Es ist sowohl eine ein-
zelne Zelladresse (zum Beispiel D2) als auch ein Zellbereich zulässig (zum Beispiel D2:D4).

In der Liste unterhalb des Eingabefelds werden weiterhin alle mit dem Menübefehl Arbeitsblatt > Namen
benannten Bereiche der Tabelle aufgeführt, so dass auch diese sofort angesprungen werden können.
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Wenn Sie mit OK bestätigen, markiert PlanMaker sofort die entsprechende Zelle beziehungsweise den ent-
sprechenden Zellbereich.

Tipp: Eine schnellere Methode

Es gibt auch eine schnellere Methode: In der Bearbeitungsleiste (oberhalb des Tabellenfensters) befindet
sich links eine aufklappbare Liste, die normalerweise anzeigt, in welcher Zelle sich der Zellrahmen gerade
befindet. 

Hier können Sie – genau wie im Dialogfenster des Menübefehls Bearbeiten > Gehe zu – die Adresse einer
Zelle oder eines Zellbereichs eintippen. Drücken Sie anschließend die Eingabetaste ¿, markiert PlanMaker
die entsprechende(n) Zelle(n).

Und: Wenn Sie einen Mausklick auf das kleine Pfeilchen rechts neben der Liste durchführen, öffnet sich
diese und bietet alle Bereichsnamen zur Auswahl an. Klicken Sie einen Namen an, wird der entsprechende
Bereich sofort markiert.

Springen zu bestimmten Bestandteilen einer Tabelle
Mit den drei Schaltflächen in der rechten unteren Ecke des Dokumentfensters können Sie zu bestimmten
Bestandteilen einer Tabelle springen (zum Beispiel zum nächsten Fehlerwert oder Kommentar).

Setzen Sie diese wie folgt ein:

¡ Klicken Sie auf die Schaltfläche mit dem roten Punkt, erscheint ein kleines Menü. Darin können Sie aus-
wählen, wonach gesucht werden soll (siehe unten). 

¡ Klicken Sie auf die Schaltfläche mit dem Pfeil nach oben, springt PlanMaker zur vorherigen Fundstelle.
Haben Sie in dem Menü also beispielsweise "Fehlerwert" gewählt, wird die vorherige Zelle mit einem
Fehlerwert angezeigt.

¡ Klicken Sie auf die Schaltfläche mit dem Pfeil nach unten, springt PlanMaker zur nächsten Fundstelle,
also beispielsweise zur nächsten Zelle mit einem Fehlerwert.

Über das Menü, das sich nach einem Klick auf den roten Punkt öffnet, bestimmen Sie also, wonach gesucht
werden soll. Dieses Menü hat folgende Einträge:

Menüeintrag Erläuterung

Formel Springe zu Zellen, die eine Rechenformel enthalten

Matrixformel Springe zu Zellen, die eine Matrixformel enthalten
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Konstante Springe zu Zellen, die einen festen Wert enthalten

Fehlerwert Springe zu Zellen, die einen Fehlerwert enthalten (siehe auch Abschnitt Fehlerwer-
te)

Fehlerhafte Zelle Springe zu Zellen, die fehlerhaft importiert worden sind – also beispielsweise Zel-
len, die eine Excel-Rechenfunktion enthalten, die von PlanMaker nicht unterstützt
wird.

Kommentar Springe zu Zellen, die einen Kommentar enthalten

Bedingte Formatierung Springe zu Zellen, die mit einer bedingten Formatierung versehen wurden

Gültigkeitsprüfung Springe zu Zellen, die mit einer Gültigkeitsprüfung versehen wurden

Alle Blätter durchsuchen Wenn diese Option aktiviert ist, durchsucht PlanMaker alle Arbeitsblätter – ansons-
ten nur das aktuelle Blatt.
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Objekte
Sie können in ihre Dokumente verschiedene Arten von Objekten einfügen – zum Beispiel Diagramme, Gra-
fiken, Textrahmen, Zeichnungen etc. 

In diesem Kapitel erfahren Sie alles Wissenswerte zum Umgang mit Objekten. Es ist in folgende Abschnitte
gegliedert:

¡ Objekte – Allgemeines 

Hier lernen Sie grundlegende Funktionen wie das Einfügen, Selektieren und Bearbeiten von Objekten
kennen.

¡ Objekte – fortgeschrittene Funktionen 

Dieser Abschnitt richtet sich an fortgeschrittene Anwender. Sie erfahren darin, wie man Objekte ver-
birgt, gruppiert etc.

Im Anschluss stellen wir Ihnen die einzelnen Arten von Objekten im Detail vor:

¡ Diagramme 

¡ Textrahmen

¡ Grafiken

¡ OLE-Objekte

¡ Zeichnungen

Objekte – Allgemeines
In diesem Abschnitt finden Sie grundlegende Informationen zum Arbeiten mit Objekten:

¡ Objekte einfügen 

¡ Selektieren von Objekten

¡ Der Objektmodus

¡ Position und Größe von Objekten ändern

¡ Rotieren und Kippen von Objekten

¡ Ausrichten und Verteilen von Objekten

¡ Duplizieren von Objekten

¡ Eigenschaften von Objekten ändern

Anschließend – im Abschnitt Objekte – fortgeschrittene Funktionen – werden Funktionen für fortgeschritte-
ne Anwender vorgestellt.
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Objekte einfügen

Um beispielsweise eine Grafik einzufügen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen auf.

2. Es erscheint ein Dialog. Wählen Sie darin die gewünschte Grafikdatei aus und bestätigen Sie mit OK.

3. Der Grafikrahmen wird nun eingefügt. 

Wenn Sie möchten, können Sie den Grafikrahmen anschließend noch verschieben oder seine Größe än-
dern:

Zum Verschieben klicken Sie mit der Maus auf den Grafikrahmen und ziehen ihn dann (bei weiterhin ge-
drückter Maustaste) an die gewünschte Position. 

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die den Grafikrahmen
umgeben. 

Auf ähnliche Weise verfahren Sie auch bei allen anderen Arten von Objekten. 

Informationen zu den einzelnen Arten von Objekten finden Sie in den Abschnitten Diagramme, Textrahmen
etc.

Selektieren von Objekten

Wenn Sie ein Objekt bearbeiten möchten, müssen Sie es erst auswählen, sprich selektieren. Klicken Sie das
gewünschte Objekt dazu einfach an. Es erscheint dann ein Rahmen um das Objekt, um anzuzeigen, dass es
nun selektiert ist.

Hinweis: Dies funktioniert allerdings nicht bei Textrahmen und anderen Objekten mit transparenter Fül-
lung. Um ein solches Objekt zu selektieren, klicken Sie auf die Umrandung, die es umgibt, oder wechseln
in den Objektmodus (siehe nächster Abschnitt), in dem sich alle Arten von Objekten einfach per
Mausklick selektieren lassen.

Wenn ein Objekt selektiert wurde, können Sie nichts mehr in die Tabellenzellen eingeben, sondern nur noch
das selektierte Objekt bearbeiten. Möchten Sie wieder Tabellenzellen bearbeiten, klicken Sie einfach mit
der Maus in die gewünschte Zelle. Die Selektion des Objekts wird dadurch aufgehoben.

Der Objektmodus

Am einfachsten gestaltet sich das Arbeiten mit Objekten im Objektmodus.

Normalerweise arbeiten Sie mit PlanMaker im Editiermodus. In diesem Modus können Sie Daten oder Be-
rechnungen in Tabellenzellen eingeben, diese bearbeiten, formatieren usw.
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Schalten Sie in den Objektmodus um, können Sie die Tabellenzellen nicht mehr bearbeiten. Dafür bietet die-
ser Modus viele Funktionen, die das Arbeiten mit Objekten erleichtern. So können Sie im Objektmodus bei-
spielsweise alle Arten von Objekten einfach per Mausklick selektieren.

Wichtig: Solange Sie sich im Objektmodus befinden, stehen Ihnen ausschließlich Funktionen zum Anle-
gen und Bearbeiten von Objekten zur Verfügung. Sie können keine Zellen mehr bearbeiten, und ein
Großteil der Menübefehle ist nicht verfügbar.

Wechseln zwischen Editiermodus und Objektmodus

Es gibt zahlreiche Möglichkeiten, um zwischen Editiermodus und Objektmodus zu wechseln:

¡ Rufen Sie den Menübefehl Ansicht > Objektmodus auf, um in den Objektmodus zu gelangen. Rufen
Sie den Befehl noch einmal auf, um wieder im Editiermodus zu landen. 

¡ Klicken Sie das Symbol  in der Formatleiste an, um in den Objektmodus zu wechseln. Klicken Sie es
erneut an, gelangen Sie zurück in den Editiermodus.

¡ Sie können auch mit der rechten Maustaste auf eine beliebige Position im Dokument klicken. Es öffnet
sich dann ein Kontextmenü, aus dem Sie den Befehl Objektmodus beziehungsweise Objektmodus ver-
lassen auswählen.

¡ Am schnellsten geht folgende Methode: Zeigen Sie mit der Maus auf eine beliebige freie Position im
Dokument und führen Sie einen Doppelklick mit der rechten Maustaste durch, um zwischen Editier- und
Objektmodus zu wechseln.

Außerdem können Sie vom Objektmodus jederzeit in den Editiermodus zurückkehren, indem Sie auf ei-
ne beliebige Stelle im Text doppelklicken, an der sich kein Objekt befindet.

Die Objektleiste

Wenn Sie den Objektmodus aktivieren, wird die Formatleiste ausgeblendet. An ihrer Stelle erscheint die
Objektleiste.

Die Objektleiste

Die Symbole in dieser Leiste dienen zum Anlegen und Bearbeiten von Objekten. Von links nach rechts:

¡ Zwischen Objektmodus/Editiermodus wechseln 

¡ Textrahmen einfügen 
¡ Grafikrahmen einfügen
¡ Diagrammrahmen einfügen
¡ OLE-Objektrahmen einfügen (nur unter Windows verfügbar)
¡ OLE-Objektrahmen mit dem SoftMaker Formeleditor* einfügen
¡ OLE-Objektrahmen mit einem TextMaker-Objekt einfügen
¡ OLE-Objektrahmen mit einem Presentations-Objekt einfügen

¡ Linie oder Kurve einfügen 
¡ Rechteck einfügen
¡ Rechteck mit abgerundeten Ecken einfügen
¡ Ellipse oder Kreis einfügen
¡ AutoForm einfügen
¡ TextArt-Objekt einfügen

¡ Selektierte Objekte gruppieren 

¡ Eigenschaften des selektierten Objekts bearbeiten 
¡ Objektliste (eine Liste aller Objekte im Dokument, siehe unten)
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* Nicht in allen PlanMaker-Versionen enthalten

Tipp: Wenn Sie den Mauszeiger auf eines dieser Symbole bewegen, wird dessen Funktion in der Statuszeile
angezeigt.

Objektliste: Ganz rechts in der Leiste sehen Sie die Objektliste. In dieser sind alle im aktuellen Dokument
enthaltenen Objekte aufgelistet. Sie können darin ein Objekt anhand seines Namens auswählen: Klicken Sie
auf die Liste, um sie zu öffnen, und wählen Sie dann das gewünschte Objekt per Mausklick. Dieses wird
daraufhin selektiert. 

Selektieren im Objektmodus

Im Objektmodus können Sie alle Arten von Objekten einfach per Mausklick selektieren.

Dies ist besonders bei Objekten mit transparenter Füllung (z.B. Textrahmen) sehr praktisch, da sich derarti-
ge Objekte im Editiermodus nur durch einen gezielten Mausklick auf den Rand des Objekts selektieren las-
sen. Im Objektmodus können Sie solche Objekte hingegen einfach an einer beliebigen Stelle anklicken, um
sie zu selektieren.

Um mehrere Objekte auf einmal zu selektieren, ziehen Sie mit der Maus einen Rahmen um die gewünschten
Objekte. Alternativ können Sie auch bei gedrückter Umschalttasteñ mehrere Objekte nacheinander ankli-
cken, um diese zu selektieren.

Springen von Objekt zu Objekt 

Sie können im Objektmodus auch zwischen den Objekten "hin- und herspringen". Verwenden Sie dazu fol-
gende Tasten:

Taste Funktion

Tab Nächstes Objekt selektieren

Umschalt+Tab Vorheriges Objekt selektieren

Position und Größe von Objekten ändern

Folgendermaßen ändern Sie die Position und Größe von Objekten:

Position von Objekten ändern

Um die Position eines Objekts zu ändern, selektieren Sie es per Mausklick und betätigen dann die Rich-
tungstasten auf der Tastatur oder ziehen es bei gedrückter Maustaste mit der Maus an die gewünschte Stelle.

Hinweis: Objekte sind in der Regel mit der Zelle verankert, die sich unter ihrer linken oberen Ecke befin-
det. Ein Objekt lässt sich zwar nach Belieben verschieben, sobald Sie das Objekt aber an der Zielposition
absetzen, "wirft es seinen Anker" erneut: Das Objekt verankert sich dann mit der Zelle, die sich jetzt un-
ter seiner linken oberen Ecke befindet.

Das bedeutet: Fügen Sie oberhalb des Objekts eine neue Zeile ein, wandert auch das Objekt eine Zeile wei-
ter nach unten, damit sich seine linke obere Ecke weiterhin in der verankerten Zelle befindet. Das Gleiche
passiert, wenn Sie beispielsweise die Höhe von Zeilen oberhalb des Objekts ändern.
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Bei Bedarf können Sie dieses Verhalten ändern, indem Sie das Objekt selektieren, den Menübefehl Objekt
> Eigenschaften aufrufen, auf die Karteikarte Format wechseln und die Option Positionierung ändern.
Wählen Sie dort beispielsweise Von Zellposition und -größe unabhängig, bleibt das Objekt unbehelligt,
wenn Sie Zellen oberhalb des Objekts einfügen oder löschen. Siehe dazu auch Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Größe von Objekten ändern

Wenn Sie ein Objekt selektieren, erscheint ein blauer Selektionsrahmen um das Objekt, der auch einige run-
de "Greifer" enthält. Wenn Sie mit der Maus an einem dieser Greifer ziehen, ändert das Objekt seine Größe
entsprechend.

Alternativ können Sie die Position und Größe von Objekten auch mit dem Menübefehl Objekt > Eigen-
schaften ändern. Auf der Karteikarte Format lassen sich diese Einstellungen exakt in Zahlenwerten festle-
gen. Weitere Details zu diesem Dialog finden Sie im Abschnitt Objekt-Eigenschaften, Karteikarte Format.

Rotieren und Kippen von Objekten

Hinweis: Nur Zeichnungen und Grafiken lassen sich rotieren und kippen; bei anderen Arten von Objek-
ten ist dies nicht möglich.

Wenn Sie ein Objekt selektieren, das sich drehen lässt, erscheint ein zusätzlicher grüner Greifer auf einer
seiner Begrenzungslinien. Ziehen Sie mit der Maus an diesem Greifer, wird das Objekt rotiert.

Alternativ können Sie den gewünschten Drehwinkel auch von Hand festlegen. Selektieren Sie das Objekt
dazu, rufen Sie den Menübefehl Objekt > Eigenschaften auf, wechseln Sie auf die Karteikarte Format und
tragen Sie in der Rubrik Drehung den Winkel ein.

Darüber hinaus können Sie Zeichnungen und Grafiken auch über den Menübefehl Objekt > Drehen oder
Kippen drehen und kippen (spiegeln).
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Ausrichten und Verteilen von Objekten

Um zwei oder mehr Objekte auszurichten oder gleichmäßig zu verteilen, selektieren Sie diese und rufen
dann den Menübefehl Objekt > Ausrichten oder verteilen auf. 

Es erscheint ein Untermenü, aus dem Sie die gewünschte Ausrichtung beziehungsweise Verteilung auswäh-
len können:

¡ Linksbündig ausrichten 
¡ Horizontal zentrieren
¡ Rechtsbündig ausrichten
¡ Oben ausrichten
¡ Vertikal zentrieren
¡ Unten ausrichten

¡ Horizontal verteilen 
¡ Vertikal verteilen

Die letzten beiden Befehle funktionieren nur, wenn mindestens drei Objekte selektiert sind. Sie sorgen da-
für, dass die Objekte gleichmäßig verteilt werden (so dass anschließend alle den gleichen Abstand vonein-
ander haben).

Duplizieren von Objekten

Um eine Kopie eines Objekts zu erhalten, kopieren Sie dieses üblicherweise in die Zwischenablage und fü-
gen es von dort aus wieder ein. 

Alternativ können Sie auch den Menübefehl Bearbeiten > Duplizieren verwenden. Dieser erstellt sofort ei-
ne Kopie des selektierten Objekts.

Tipp: Noch schneller geht das Duplizieren mit der Maus: Wenn Sie die Taste Strg gedrückt halten und
mit der Maus an einem Objekt ziehen, erhalten Sie ein Duplikat von diesem Objekt.

Eigenschaften von Objekten ändern

Zu den Eigenschaften eines Objekts zählt man beispielsweise dessen Größe, Füllung, Umrandung etc. Diese
lassen sich zentral mit dem Menübefehl Objekt > Eigenschaften bearbeiten.

Um die Eigenschaften eines Objekts zu bearbeiten, selektieren Sie dieses zunächst per Mausklick. Dann ru-
fen Sie den Menübefehl Objekt > Eigenschaften auf, worauf ein entsprechender Dialog erscheint.

Tipp: Bei den meisten Arten von Objekten können Sie diesen Dialog auch blitzschnell mit einem Dop-
pelklick auf das Objekt öffnen.

Der Dialog verfügt über mehrere Karteikarten, zwischen denen Sie wechseln können, indem Sie oben auf
einen der Karteikartenreiter klicken.
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Auf den nächsten Seiten werden alle Karteikarten mit allen darin enthaltenen Optionen ausführlich be-
schrieben.

Objekt-Eigenschaften, Karteikarte Format

Auf der Karteikarte Format können Sie Einstellungen zum Format des Objekts vornehmen, also beispiels-
weise seine Größe ändern.

Verfügbare Optionen:

¡ Rubriken Größe und Skalierung 

Hier lässt sich die Größe des Objekts ändern. Tragen Sie dazu die gewünschte Breite und Höhe ein. Al-
ternativ können Sie bei Horz. Faktor und Vert. Faktor angeben, auf wie viel Prozent seiner Original-
größe das Objekt vergrößert/verkleinert werden soll.

Haben Sie dabei die Option Seitenverhältnis beibehalten eingeschaltet, wirken sich Änderungen an der
Höhe automatisch auf die Breite aus (und umgekehrt).

Bei OLE-Objekten gibt es zusätzlich eine Option namens Skalierung beibehalten. Ist diese eingeschal-
tet ist, wirken sich Änderungen an der Größe eines OLE-Objekts innerhalb seiner Quellanwendung auto-
matisch auch auf das Objekt in PlanMaker aus. Ist sie ausgeschaltet, bleibt das Objekt in PlanMaker im-
mer gleich groß. (Hinweis: Nicht alle OLE-Quellanwendungen unterstützen dieses Feature.)

¡ Rubrik Positionierung 

Diese Option bestimmt, wie sehr das Objekt (was seine Position und Größe betrifft) von den Tabellen-
zellen abhängen soll, die sich unter ihm befinden.

Von Zellposition und -größe abhängig: Das Objekt verhält sich, als ob es in der Zelle unter seiner lin-
ken oberen Ecke verankert wäre. Fügen Sie also oberhalb dieser Zelle neue Zeilen ein, wird das Objekt
entsprechend nach unten geschoben.

Darüber hinaus ändert das Objekt seine Größe mit den darunter befindlichen Zellen. Erhöhen Sie also
die Breite dieser Zellen, wächst das Objekt entsprechend mit.

Nur von Zellposition abhängig: Auch hier verhält sich das Objekt, als ob es in der Zelle unter seiner
linken oberen Ecke verankert wäre. Seine Größe ändert sich jedoch nicht, wenn Sie die Größe der Zellen
unter dem Objekt ändern.

Von Zellposition und -größe unabhängig: Das Objekt behält seine ursprüngliche Position und Größe
stets bei – unabhängig von den Zellen unter dem Objekt.

¡ Rubrik Drehung 

Nur bei Zeichnungen und Grafiken verfügbar. 

Hier können Sie das Objekt drehen. Tragen Sie dazu den Winkel ein, um den das Objekt im Uhrzeiger-
sinn gedreht werden soll.

¡ Rubrik Kippen 

Nur bei Zeichnungen und Grafiken verfügbar. 

Hier können Sie das Objekt vertikal oder horizontal kippen.
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Objekt-Eigenschaften, Karteikarte Füllung

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar. Und: Bei Grafiken wirken sich
Änderungen an der Füllung nur auf die transparenten Teile der Grafik aus.

Auf der Karteikarte Füllung können Sie festlegen, womit das Objekt ausgefüllt werden soll. 

Wählen Sie zunächst in der Liste Fülltyp die gewünschte Art der Füllung. Anschließend können Sie zu je-
dem Fülltyp noch diverse Einstellungen vornehmen.

Nachfolgend eine Liste aller Fülltypen inklusive ihrer Einstellungen:

¡ Keine Füllung 

Wenn Sie den ersten Fülltyp in der Liste wählen, wird das Objekt nicht gefüllt, ist also transparent.

¡ Farbe 

Bei diesem Fülltyp wird das Objekt mit einer Farbe gefüllt. Wählen Sie die gewünschte Farbe dazu in
der Liste Farben. 

Tipp: Farblisten bieten immer nur einige Standardfarben an, Sie können aber jederzeit auch andere Far-
ben wählen. Klicken Sie dazu auf Weitere Farben und gehen Sie dann wie im Abschnitt Dokumentei-
genschaften, Karteikarte Farben beschrieben vor.

Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Füllung ändern. Zulässig sind
Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig). Setzen Sie diesen Wert also bei-
spielsweise auf 75, ist die Füllung zu 75% durchsichtig.

¡ Raster 

Hier wird das Objekt mit einem Raster gefüllt. Wählen Sie dazu in der Liste Raster die Art des Rasters
und stellen Sie dann die gewünschte Farbe für Vordergrund und Hintergrund ein.

Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Füllung ändern. Zulässig sind
Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

¡ Grafik 

Hier wird das Objekt mit einer Grafik gefüllt. Über die Schaltfläche Öffnen können Sie bestimmen, wel-
che Grafikdatei dies sein soll. Die zuletzt verwendeten Grafiken werden außerdem in der Liste Grafiken
angezeigt und lassen sich dort per Mausklick auswählen.

Weitere Optionen:

Mit dem Objekt drehen: Wenn Sie diese Option einschalten, dreht sich die Grafik mit, wenn Sie das zu
füllende Objekt rotieren.

Spiegelung: Mit dieser Option können Sie die Grafik horizontal oder vertikal spiegeln.

Transparenz: Mit dieser Option können Sie auf Wunsch die Transparenz der Füllung ändern. Zulässig
sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

Als Textur kacheln: Wenn diese Option aktiviert ist, wird die Grafik in dem Objekt wie ein Kachelmus-
ter wiederholt.

Über die Einstellungen in der Rubrik Kacheloptionen können Sie dann die Größe und Position der Ka-
cheln ändern: Mit X-Skalierung und Y-Skalierung ändern Sie die Größe (in Prozent). Mit X-Versatz
und Y-Versatz ändern Sie die Position. Die Option Ausrichtung bestimmt, an welcher Kante oder Ecke
des zu füllenden Objekts die Kacheln ausgerichtet werden sollen.
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Ist die Option Als Textur kacheln deaktiviert, lassen sich hier lediglich die Abstände zu den Kanten
des zu füllenden Objekts einstellen.

Speichern: Mit dieser Schaltfläche können Sie die momentan ausgewählte Grafikdatei exportieren, also
eine Kopie der Grafik unter einem beliebigen Namen auf Festplatte speichern.

Linearer Farbverlauf, Rechteckiger Farbverlauf etc.

Die untersten fünf Fülltypen sind verschiedene Arten von Farbverläufen. Wählen Sie zunächst den ge-
wünschten Typ von Farbverlauf in der Liste Fülltyp und dann einen der angebotenen Untertypen in der
Liste Varianten.

In der Rubrik Optionen lässt sich das Aussehen des Farbverlaufs noch genauer festlegen:

Mit X-Versatz und Y-Versatz können Sie das Zentrum des Farbverlaufs verschieben. Weiterhin lässt
sich der Drehwinkel einstellen.

Tipp: Sie können auch das Steuerkreuz im Feld Beispiel mit der Maus verschieben oder rotieren, um
diese Einstellungen zu ändern.

Aktivieren Sie die Option Doppelter Farbverlauf, verläuft die Farbe beispielsweise nicht nur von der
Ausgangsfarbe zur Endfarbe, sondern auch wieder zurück zur Ausgangsfarbe.

In der Rubrik Farben können Sie die Farben für den Verlauf ändern:

Um eine Farbe zu ändern, klicken Sie zunächst auf eines der kleinen Dreiecke unter dem Balken für den
Farbverlauf. Das linke Dreieck steht für die Ausgangsfarbe, das rechte Dreieck für die Endfarbe:

Wählen Sie dann die gewünschte Farbe aus der Liste Farbe darunter. 

Mit der Option Transparenz lässt sich auf Wunsch die Transparenz für die gewählte Farbe ändern. Zu-
lässig sind Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

Sie können dem Farbverlauf sogar noch weitere Farben hinzufügen, indem Sie einen Doppelklick auf die
gewünschte Position in dem Balken durchführen und dann eine Farbe auswählen. Auf die gleiche Weise,
nämlich mit einem Doppelklick auf das Dreieck, lassen sich zusätzliche Farben auch wieder aus dem
Verlauf löschen.

Objekt-Eigenschaften, Karteikarte Linien

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar. 

Auf der Karteikarte Linien können Sie festlegen, welche Art von Linien für das Objekt verwendet werden
soll. Bei Zeichnungen betrifft dies die Linien, mit denen das Objekt gezeichnet wird; bei allen anderen Ob-
jekten die Linien, mit denen das Objekt umrandet wird.

Verfügbare Optionen:

Varianten

Hier können Sie den gewünschten Linienstil auswählen. 

Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optionen des Dialogs können Sie
das Aussehen der Linien bei Bedarf noch genauer festlegen.



232Objekte

Farbe

Lässt Sie die Farbe der Linien festlegen.

Strich

Hier können Sie festlegen, ob durchgezogene Linien oder gestrichelte Linien gezeichnet werden sollen.

Liniendicke

Hier können Sie die Liniendicke exakt in Zehntelpunkt angeben.

Transparenz

Mit der Option Transparenz können Sie auf Wunsch die Transparenz der Linien ändern. Zulässig sind
Werte zwischen 0% (nicht transparent) und 100% (völlig durchsichtig).

Startpunkt und Endpunkt

Nur bei Linien, Kurven und Verbindungslinien verfügbar.

Hier können Sie festlegen, ob am Startpunkt beziehungsweise Endpunkt der Linie ein Symbol gezeichnet
werden soll. Wählen Sie beispielsweise für den Endpunkt einer Linie das Pfeilsymbol, sieht die Linie
aus wie ein Pfeil. Bei Bedarf können Sie weiterhin die Breite und die Höhe des Symbols ändern.

Objekt-Eigenschaften, Karteikarte Schatten

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar. 

Mit Hilfe der Karteikarte Schatten können Sie das Objekt mit einem Schatten versehen.

Verfügbare Optionen:

Varianten

Hier können Sie den gewünschten Typ von Schatten auswählen. 

Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optionen des Dialogs können Sie
das Aussehen des Schattens bei Bedarf noch genauer festlegen.

Skalierung

Hier können Sie die Größe des Schattens (im Verhältnis zur Größe des Objekts) ändern.

Versatz

Hier können Sie die Position des Schattens ändern.

Perspektive

Hier können Sie den Neigungswinkel des Schattens ändern.

Bei bestimmten Varianten des Typs "Perspektivische Schatten" lässt sich außerdem der Horizont än-
dern, was den Schatten perspektivisch verzerrt. Ist Horizont ein positiver Wert, liegt der Schatten vor
dem Objekt; bei negativen Werten liegt er hinter dem Objekt. 

Farbe

Hier können Sie die Farbe des Schattens ändern.
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Unschärfe

Wenn Sie hier einen Wert größer als Null eintragen, wird der Schatten mit einem Unschärfeeffekt verse-
hen. Je größer der Wert ist, desto weicher werden die Kanten des Schattens gezeichnet.

Transparenz

Hier können Sie die Transparenz des Schattens ändern. Zulässig sind Werte zwischen 0% (nicht transpa-
rent) und 100% (völlig durchsichtig). Bei einem Wert von 75 ist der Schatten also beispielsweise zu 75%
durchsichtig.

Objekt-Eigenschaften, Karteikarte 3D

Hinweis: Diese Karteikarte ist nur bei Textrahmen und Zeichnungen verfügbar.

Mit Hilfe der Karteikarte 3D können Sie das Objekt mit einem 3D-Effekt versehen.

Verfügbare Optionen:

Varianten

Hier können Sie den gewünschten Typ von 3D-Effekt auswählen. 

Die Einträge in dieser Liste sind lediglich Vorgaben; über die weiteren Optionen des Dialogs können Sie
das Aussehen des Effekts bei Bedarf noch genauer festlegen.

Rubrik Optionen

Hier können Sie die Winkel, um die das Objekt um die Achsen rotiert werden soll, und die Tiefe des
3D-Effekts einstellen.

Rubrik 3D-Oberfläche

Seitenflächen: Die Farbe für die Seitenflächen des Objekts wird normalerweise automatisch eingestellt.
Falls Sie eine andere Farbe verwenden möchten, aktivieren Sie die Option Seitenflächen und wählen
darunter die gewünschte Farbe.

Vorderfläche anpassen: Wenn diese Option aktiviert ist, wird auch die Vorderfläche des Objekts den
Beleuchtungseinstellungen des 3D-Effekts entsprechend abgedunkelt. Die Beleuchtung können Sie mit
der Schaltfläche Weiteres beeinflussen.

Drahtmodell: Wenn Sie diese Option aktivieren, wird das Objekt wie ein Drahtgittermodell dargestellt.

Schaltfläche Weiteres

Klicken Sie auf diese Schaltfläche, können Sie auf die Beleuchtung für den 3D-Effekt Einfluss nehmen.
Es erscheint dazu ein eigener Dialog. Klicken Sie im Feld Beleuchtung auf die Position, an der sich die
Lichtquelle befinden soll. Darüber hinaus können Sie die Intensität einstellen und bestimmen, welche
Art von Oberfläche der 3D-Effekt simulieren soll.

Objekt-Eigenschaften, Karteikarte Effekte

Hinweis: Diese Karteikarte ist nicht bei allen Arten von Objekten verfügbar. 

Mit Hilfe der Karteikarte Effekte können Sie das Objekt mit diversen Effekten versehen.
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Verfügbare Effekte und Optionen:

Spiegelung

Wenn Sie die Option Spiegelungseffekt verwenden aktivieren, wird das Objekt so dargestellt, als ob es
auf einer spiegelnden Oberfläche stehen würde.

Optionen:

Sichtbarer Teil des Objekts: Bestimmt, wie viel von dem Objekt in der Spiegelung zu sehen sein soll
(in Prozent).

Transparenz beginnt bei: Die Spiegelung wird nach unten hin weich ausgeblendet. Dieser Wert be-
stimmt, wie transparent die Spiegelung ganz oben sein soll (in Prozent).

Y-Versatz: Verschiebt die Spiegelung nach oben oder unten.

Weiche Kanten

Wenn Sie die Option Weiche Kanten-Effekt verwenden aktivieren, werden die Umrandungslinien des
Objekts mit einem Weichzeichner-Effekt versehen.

Optionen:

Breite: Bestimmt, wie stark der Effekt ausfallen soll.

Leuchteffekt

Wenn Sie die Option Leuchteffekt verwenden aktivieren, werden die Umrandungslinien des Objekts
mit einem Leuchteffekt umgeben.

Optionen:

Breite: Bestimmt, wie stark der Leuchteffekt ausfallen soll.

Farbe: Ändert die Farbe für den Leuchteffekt.

Objekt-Eigenschaften, Karteikarte Eigenschaften

Auf der Karteikarte Eigenschaften lassen sich allgemeine Einstellungen für ein Objekt ändern.

Verfügbare Optionen:

¡ Name 

Jedes Objekt in einem Dokument bekommt von PlanMaker automatisch einen eindeutigen Namen zuge-
wiesen. Auf Wunsch können Sie hier einen anderen Namen eintragen. 

Tipp: Der Name des momentan selektierten Objekts wird in der Objektleiste angezeigt. Klicken Sie in
der Objektleiste auf den Namen, wird eine Liste aller vorhandenen Objekte geöffnet. Klicken Sie einen
der anderen Namen an, wird das entsprechende Objekt selektiert. Auf diese Weise können Sie Objekte
also anhand ihres Namens selektieren.

¡ Sichtbar 

Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt auf dem Bildschirm angezeigt
wird (siehe auch Abschnitt Verbergen von Objekten).

Schalten Sie diese Option aus, wird das Objekt unsichtbar.
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¡ Drucken 

Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass das Objekt im Ausdruck erscheint, wenn Sie
das Arbeitsblatt ausdrucken (siehe auch Abschnitt Verbergen von Objekten).

¡ Sperren 

Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass sich Größe, Position und auch alle andere Ei-
genschaften des Objekts nicht mehr ändern lassen, wenn Sie den Blattschutz einschalten (siehe auch Ab-
schnitt Blattschutz). 

¡ Text sperren 

Nur bei Textrahmen und Zeichnungen, die Text enthalten, verfügbar.

Diese Option ist standardmäßig aktiviert. Sie bewirkt, dass sich der in diesem Objekt enthaltene Text
nicht mehr bearbeiten lässt, wenn Sie den Blattschutz einschalten (siehe auch Abschnitt Blattschutz). 

¡ Hyperlink 

Hier können Sie einen Hyperlink (eine Verknüpfung) anbringen – zum Beispiel auf eine Internetseite.
Klicken Sie dazu auf die Schaltfläche Wählen, wählen Sie die Art von Link und geben Sie das ge-
wünschte Ziel an. Dieses wird dann aufgerufen, wenn das Objekt angeklickt wird. 

Bei Grafiken werden in der rechten Hälfte des Dialogs außerdem Information zu der verwendeten Grafik
angezeigt (Auflösung, Farbtiefe etc.).

Weitere Karteikarten

Bei manchen Arten von Objekten erscheinen zusätzliche Karteikarten mit weiteren Optionen. Informationen
zu diesen Karteikarten finden Sie im Abschnitt über das betreffende Objekt.

Standardeinstellungen für Objekte ändern

Sie können die Standardeinstellungen für Objekte (Zeichnungen, Grafiken etc.) jederzeit ändern. 

Wenn Ihnen beispielsweise die voreingestellte Liniendicke für Zeichnungen nicht gefällt, legen Sie einfach
eine andere Liniendicke als Standard fest. Auch andere Standard-Eigenschaften lassen sich ändern – zum
Beispiel die Füllung (von Zeichnungen) und die Einstellungen für Schatten- und 3D-Effekte.

Hinweis: Änderungen an den Standardeinstellungen für Objekte betreffen nur Objekte, die Sie danach
einfügen. Bereits vorhandene Objekte bleiben hingegen unberührt.

Um die Standardeinstellungen für Objekte zu verändern, verwenden Sie die Schaltfläche Standard im Dia-
logfenster des Menübefehl Objekt > Eigenschaften. 

Die Standard-Liniendicke für Zeichnungen lässt sich beispielsweise folgendermaßen ändern:

1. Fügen Sie eine neue Zeichnung ein (oder klicken Sie auf eine vorhandene Zeichnung).

2. Rufen Sie den Menübefehl Objekt > Eigenschaften auf.

3. Nehmen Sie die gewünschten Einstellungen vor. Um also beispielsweise die Voreinstellung für die Lini-
endicke zu ändern, stellen Sie einfach auf der Karteikarte Linien die gewünschte Liniendicke ein.
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4. Jetzt kommt der entscheidende Schritt: Klicken Sie nicht auf OK, sondern auf die Schaltfläche Stan-
dard.

5. Es erscheint ein Dialog, in dem Sie bei Bedarf noch eingrenzen können, welche Standardeinstellungen
geändert werden sollen. In der Regel ist dies aber nicht nötig.

6. Wenn Sie mit OK bestätigen, werden die aktuell im Dialog gemachten Einstellungen als Standardein-
stellungen für neue Zeichnungen festgelegt.

7. Bestätigen Sie noch einmal mit OK, um den Dialog ganz zu verlassen.

Alle Zeichnungen, die Sie von nun an einfügen, verwenden standardmäßig die so festgelegte Liniendicke.

Hinweis: Die Standardeinstellungen für Objekte lassen sich für jedes Dokument getrennt festlegen.

Objekte – fortgeschrittene Funktionen
Die nächsten Seiten enthalten Informationen zu den etwas ausgefalleneren Funktionen zum Bearbeiten von
Objekten. Folgende Themen werden darin behandelt:

¡ Verbergen von Objekten 

¡ Reihenfolge von Objekten ändern

¡ Gruppieren von Objekten

Verbergen von Objekten

Sie können ein Objekt bei Bedarf verbergen. Es wird dann auf dem Bildschirm und/oder im Ausdruck nicht
mehr dargestellt.

Selektieren Sie das gewünschte Objekt dazu, rufen Sie den Menübefehl Objekt > Eigenschaften auf, wech-
seln Sie auf die Karteikarte Eigenschaften und gehen Sie dann wie folgt vor:

¡ Schalten Sie Option Sichtbar aus, wird das Objekt auf dem Bildschirm nicht mehr angezeigt. 

¡ Schalten Sie Option Drucken aus, erscheint das Objekt nicht mehr im Ausdruck.

Tipp: Wenn Sie ein Objekt einmal versehentlich unsichtbar gemacht haben, können Sie jederzeit den Menü-
befehl Datei > Eigenschaften aufrufen und die Option Verborgene Objekte anzeigen auf der Karteikarte
Optionen einschalten. Nun werden alle unsichtbaren Objekte wieder angezeigt. Sie können das Objekt also
wieder selektieren und die Option Sichtbar wieder einschalten.

Reihenfolge von Objekten ändern

Wenn sich mehrere Objekte überlappen, können Sie bestimmen, in welcher Reihenfolge diese hintereinan-
der angeordnet sein sollen – also welches Objekt im Vordergrund ist, welches im Hintergrund etc. 
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Gehen Sie dazu folgendermaßen vor:

1. Selektieren Sie das gewünschte Objekt.

2. Rufen Sie den Menübefehl Objekt > Reihenfolge auf. Es öffnet sich ein Untermenü mit folgenden Be-
fehlen:

In den Vordergrund: Bringt das Objekt vor alle anderen Objekte.

In den Hintergrund: Bringt das Objekt hinter alle anderen Objekte.

Eine Ebene nach vorne: Bringt das Objekt eine Ebene weiter nach vorne.

Eine Ebene nach hinten: Bringt das Objekt eine Ebene weiter nach hinten.

Gruppieren von Objekten

Wenn Sie mehrere Objekte gruppieren, fassen Sie diese zu einer Einheit zusammen, die wie ein einzelnes
Objekt selektiert und manipuliert werden kann. 

Das bedeutet in der Praxis: 

Selektieren Sie ein Objekt, das zu einer Gruppe gehört, wird stets die gesamte Gruppe selektiert. Verschie-
ben Sie dieses Objekt, werden alle Objekte der Gruppe mitbewegt. Das Gruppieren verhindert außerdem,
dass zusammengehörende Objekte versehentlich mit der Maus gegeneinander verschoben werden können.

Um Objekte zu gruppieren, gehen Sie folgendermaßen vor:

1. Selektieren Sie die zu gruppierenden Objekte.

Klicken Sie die Objekte dazu bei gedrückter Umschalttasteñ nacheinander an – oder wechseln Sie in
den Objektmodus und ziehen Sie dann bei gedrückter Maustaste ein Rechteck um alle zu selektierenden
Objekte auf.

2. Klicken Sie auf das Symbol  in der Objektleiste oder rufen Sie den Menübefehl Objekt > Gruppie-
ren auf, um die Objekte zu gruppieren.

Gruppierung wieder aufheben

Um die Gruppierung von Objekten wieder aufzuheben, gehen Sie folgendermaßen vor:

1. Selektieren Sie die Gruppe, indem Sie eines der darin enthaltenen Objekte anklicken.

2. Rufen Sie den Menübefehl Objekt > Gruppierung aufheben auf.

Die allgemeinen Informationen zu Objekten sind hiermit abgeschlossen. In den nächsten Abschnitten wer-
den die einzelnen Arten von Objekten ausführlich vorgestellt:

¡ Diagramme (siehe dazu Kapitel Diagramme) 

¡ Textrahmen

¡ Grafiken

¡ OLE-Objekte
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¡ Zeichnungen

Diagramme
Mit Hilfe von Diagrammen können Sie die Zahlenwerte in einer Tabelle grafisch darstellen und somit die
"nackten Zahlen" anschaulich und übersichtlich präsentieren.

Dem Arbeiten mit Diagrammen widmet sich ein eigenes Kapitel: das Kapitel Diagramme. Alle Informatio-
nen zu Diagrammen finden Sie dort.

Textrahmen
Mit Hilfe von Textrahmen können Sie einen Textkasten in die Tabelle setzen. In Textrahmen lässt sich nach
Belieben Text eingeben, bearbeiten und formatieren. 

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Textrahmen. Folgende Themen wer-
den darin behandelt:

¡ Textrahmen einfügen 

¡ Eigenschaften von Textrahmen ändern

Lesen Sie dazu die nächsten Seiten.

Textrahmen einfügen

Um einen Textrahmen einzufügen, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Objekt > Neuer Textrahmen auf.

Alternativ können Sie das Symbol  in der Objektleiste anklicken, sofern Sie den Objektmodus akti-
viert haben.

2. Der Textrahmen wird nun eingefügt. 

Wenn Sie möchten, können Sie den Textrahmen anschließend noch verschieben oder seine Größe än-
dern:

Wichtig: Zum Verschieben klicken Sie mit der Maus auf die Umrandung des Textrahmens. Dann ziehen
Sie ihn (bei weiterhin gedrückter Maustaste) an die gewünschte Position. 

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die den Textrahmen um-
geben. 

Der Textrahmen ist nun erstellt, und Sie können sofort mit der Eingabe von Text beginnen. 
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Wenn Sie mit der Texteingabe fertig sind, klicken Sie eine beliebige Tabellenzelle an, um den Rahmen zu
verlassen. Nun können Sie wieder Tabellenzellen bearbeiten. Umgekehrt gelangen Sie in den Textrahmen
zurück, indem Sie in den Rahmen hineinklicken.

Wichtig: Wenn PlanMaker am unteren Rand eines Textrahmens einen roten Balken anzeigt, zeigt dies
an, dass der enthaltene Text nicht vollständig in den Rahmen passt. Vergrößern Sie in diesem Falle also
den Rahmen oder verringern Sie die Textmenge.

Eigenschaften von Textrahmen ändern

Um die Eigenschaften eines Textrahmens zu bearbeiten, selektieren Sie diesen zunächst. Klicken Sie dazu
die Umrandung an, die den Textrahmen umgibt, oder klicken Sie ihn im Objektmodus einfach an. Dann ru-
fen Sie den Menübefehl Objekt > Eigenschaften auf, worauf ein entsprechender Dialog erscheint.

Tipp: Wenn Sie den Objektmodus aktiviert haben, können Sie diesen Dialog auch mit einem Doppelklick
auf den Textrahmen öffnen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

Karteikarten Format, Füllung, Linien etc.

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgen-
der Einstellungen:

¡ Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-
Eigenschaften, Karteikarte Format. 

¡ Füllung: Hier können Sie die Füllung ändern. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte Füllung.

¡ Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte
Linien.

¡ Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte
Schatten.

¡ 3D: Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte 3D.

¡ Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt Objekt-Eigenschaften, Kartei-
karte Effekte.

¡ Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Weiterhin erscheinen bei Textrahmen zwei zusätzliche Karteikarten mit weiteren Optionen:

Karteikarte Innentext

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern. 

Verfügbare Optionen:
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¡ Rubrik Innenränder 

Hier können Sie die Ränder zwischen dem Textrahmen und dem darin enthaltenen Text ändern. Schalten
Sie die Option Automatisch ein, ermittelt das Programm automatisch geeignete Ränder.

¡ Rubrik Überlappende Objekte 

Diese Einstellung bestimmt, was passieren soll, wenn sich der Textrahmen mit einem anderen Rahmen
überlappt. 

Bei der Standardeinstellung Objekt ignorieren greift PlanMaker nicht ein. In dem sich überlappenden
Bereich wird also der Inhalt beider Rahmen übereinander gedruckt. 

Wählen Sie hingegen die Option Text umbrechen, wird der Text in diesem Rahmen automatisch neu
umbrochen, so dass er die Überlappung umfließt.

¡ Rubrik Drehen um ... 

Hier können Sie den Text um den angegebenen Winkel drehen.

¡ Rubrik Vertikale Ausrichtung 

Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Unterkante des Rahmens aus-
gerichtet werden soll:

Option Erläuterung

Oben Der Text wird an der Oberkante des Rahmens ausgerichtet. (Dies ist die Stan-
dardeinstellung.)

Zentriert Der Text wird zwischen Ober- und Unterkante zentriert.

Unten Der Text wird an der Unterkante des Rahmens ausgerichtet.

Vertikaler Blocksatz Der Abstand zwischen den Textzeilen wird gleichmäßig so erweitert, dass der
Text an der Oberkante des Rahmens beginnt und an der Unterkante endet.

Karteikarte AutoFormen

Ein Textrahmen ist im Prinzip nichts anderes als eine AutoForm, der Text hinzugefügt wurde. Standardmä-
ßig wird hierzu ein einfaches Rechteck als AutoForm verwendet. Sie können dem Textrahmen jedoch jeder-
zeit eine andere AutoForm zuweisen, also beispielsweise aus dem Rechteck eine Sprechblase oder eine be-
liebige andere Form machen.

Wählen Sie dazu einfach auf der Karteikarte AutoForm die gewünschte Form aus.

Ausführliche Informationen zu AutoFormen finden Sie im Abschnitt Zeichnungen.

Grafiken
In diesem Abschnitt erfahren Sie alles Wissenswerte zum Einfügen und Bearbeiten von Grafiken. Folgende
Themen werden darin behandelt:

¡ Grafiken einfügen 

¡ Grafiken einscannen
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¡ Grafiken aus der Galerie/Kamera einfügen (Android)

¡ Eigenschaften von Grafiken ändern

¡ Verwenden der Grafikleiste

Lesen Sie dazu die nächsten Seiten.

Grafiken einfügen

Um eine Grafik einzufügen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen auf.

Alternativ können Sie das Symbol  in der Objektleiste anklicken, sofern Sie den Objektmodus akti-
viert haben. 

2. Es erscheint ein Dialog. Wählen Sie darin die gewünschte Grafikdatei aus und bestätigen Sie mit OK.

3. Der Grafikrahmen wird nun eingefügt. 

Wenn Sie möchten, können Sie den Grafikrahmen anschließend noch verschieben oder seine Größe än-
dern:

Zum Verschieben klicken Sie mit der Maus auf den Grafikrahmen und ziehen ihn dann (bei weiterhin ge-
drückter Maustaste) an die gewünschte Position. 

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die den Grafikrahmen
umgeben. 

Optionen des Dialogs

Die Optionen in obigem Dialogfenster haben folgende Bedeutung:

¡ Im Dokument ablegen 

Ist diese Option eingeschaltet, speichert PlanMaker eine Kopie der Grafik im Dokument ab und verwen-
det dieses anstelle des Originals.

Ist sie ausgeschaltet, wird im Dokument nur ein Verweis auf die originale Grafikdatei gespeichert.

¡ In den Ordner des Dokuments kopieren 

Ist diese Option eingeschaltet, erzeugt PlanMaker eine Kopie der Grafikdatei in dem Ordner, in dem sich
das Dokument befindet, und verwendet diese anstelle des Originals.

Diese Option ist nur verfügbar, wenn das Dokument schon einmal gespeichert wurde.

Grafiken einscannen

Hinweis: Das Einscannen von Grafiken ist nur mit der Windows-Version von PlanMaker möglich.
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Mit PlanMaker für Windows lassen sich Originale direkt in ein Dokument einscannen. Sie müssen dazu
einen Scanner an Ihren Rechner angeschlossen und die mitgelieferte Software installiert haben.

Um etwas in das aktuelle Dokument einzuscannen, gehen Sie wie folgt vor:

1. Schalten Sie den Scanner ein und legen Sie die Vorlage ein.

2. Rufen Sie den Menübefehl Datei > Holen auf.

PlanMaker aktiviert nun die Scan-Software Ihres Scanners. Nehmen Sie darin die gewünschten Einstellun-
gen vor (siehe Handbuch zum Scanner) und starten Sie den Scanvorgang. Wenn dieser abgeschlossen ist, er-
scheint das Ergebnis als Grafik im PlanMaker Dokument.

Andere Quelle wählen

Wenn an Ihren PC mehrere Scanner angeschlossen sind, können Sie mit dem Menübefehl Datei > Quelle
wählen entscheiden, aus welcher dieser Quellen Sie beim Verwenden des Befehls Datei > Holen etwas ein-
scannen möchten.

Grafiken aus der Galerie/Kamera einfügen (Android)

Hinweis: Diese Funktion steht nur in der Android-Version zur Verfügung.

Bei der Android-Version können Sie Grafiken auch über die Galerie oder über die Kamera ihres Geräts ein-
fügen.

Gehen Sie dazu wie folgt vor:

Grafik aus der Galerie einfügen

1. Rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen aus der Galerie auf.

2. Ihr Android-Gerät öffnet automatisch seine Galerie-App. Wählen Sie darin die gewünschte Grafik durch
Antippen aus.

Die Grafik wird nun eingefügt.

Grafik von der Kamera einfügen

1. Rufen Sie den Menübefehl Objekt > Neuer Grafikrahmen von der Kamera auf.

2. Ihr Android-Gerät öffnet automatisch seine Kamera-App. Nehmen Sie ein Foto auf.

Die Grafik wird nun eingefügt.
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Eigenschaften von Grafiken ändern

Sämtliche Eigenschaften eines Objekts lassen sich zentral mit dem Menübefehl Objekt > Eigenschaften
bearbeiten. Zu den Eigenschaften zählt man beispielsweise Größe, Ränder und zahlreiche weitere Einstell-
möglichkeiten.

Um die Eigenschaften einer Grafik zu bearbeiten, selektieren Sie diese zunächst per Mausklick. Dann rufen
Sie den Menübefehl Objekt > Eigenschaften auf, worauf ein entsprechender Dialog erscheint.

Tipp: Sie können diesen Dialog auch über einen Doppelklick auf die Grafik aufrufen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

Karteikarten Format, Füllung, Linien etc.

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgen-
der Einstellungen:

¡ Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-
Eigenschaften, Karteikarte Format. 

¡ Füllung: Hier können Sie die Füllung ändern. Nur bei Grafiken mit transparenten Bereichen sichtbar. Sie-
he Abschnitt Objekt-Eigenschaften, Karteikarte Füllung.

¡ Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte
Linien.

¡ Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte
Schatten.

¡ Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt Objekt-Eigenschaften, Kartei-
karte Effekte.

¡ Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Außerdem werden Informationen zu
der verwendeten Grafik angezeigt. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte Eigenschaften.

Weiterhin erscheint bei Grafiken eine zusätzliche Karteikarte mit weiteren Optionen:

Karteikarte Grafik

Auf der Karteikarte Grafik können Sie Einstellungen zur Grafik selbst vornehmen. 

Tipp: Einen Teil dieser Einstellungen können Sie auch über die Grafikleiste ändern, die automatisch er-
scheint, wenn Sie eine Grafik selektieren. Siehe Abschnitt Verwenden der Grafikleiste.

Sie finden auf dieser Karteikarte folgende Optionen:

¡ Varianten 

In dieser Liste werden einige vorgefertigte Variationen der Grafik angeboten – zum Beispiel andere
Farbmodi (Graustufen, schwarz/weiß etc.) und Varianten, bei denen das Bild eingefärbt wurde.

Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog werden dann automatisch
auf entsprechende Einstellungen gesetzt.
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¡ Rubrik Optionen 

Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alternative Möglichkeit zum Än-
dern der Helligkeit) ändern.

¡ Schaltfläche Weiteres 

Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen:

Wenn Sie die Option Einfärben aktivieren und darunter eine Farbe auswählen, wird die Grafik entspre-
chend eingefärbt.

Mit den Optionen in der Rubrik Beschnitt können Sie die Grafik zuschneiden. Dies ist nützlich, wenn
Sie nur einen Ausschnitt der Grafik benötigen. Soll beispielsweise das obere Viertel der Grafik abge-
schnitten werden, wählen Sie zunächst Relative Werte verwenden und geben Sie bei Oben die Zahl
"25" (Prozent) ein.

Wählen Sie Absolute Werte verwenden aus, werden die Eingaben nicht prozentual, sondern in absolu-
ten Längeneinheiten abgeschnitten. Wenn Sie negative Werte eingeben, werden die Bereiche der Grafik
nicht abgeschnitten, sondern wird mit einem Rahmen erweitert.

¡ Rubrik Transparenz 

Hier können Sie Einstellungen zur Transparenz der Grafik vornehmen:

Automatisch erkennen: PlanMaker liest aus der Grafikdatei aus, welche Teile der Grafik als transpa-
rent gekennzeichnet wurden, und stellt die Grafik entsprechend dar. Hinweis: Nur Grafiken im GIF- oder
PNG-Format enthalten solche Transparenz-Informationen.

Keine Transparenz: Die Grafik wird nicht transparent dargestellt – selbst wenn es sich im eine Grafik-
datei mit Transparenz-Informationen handelt.

Farbe: Lässt Sie die Farbe auswählen, die als transparente Farbe verwendet werden soll. Wählen Sie
beispielsweise die Farbe Weiß, werden alle weißen Bereiche der Grafik transparent dargestellt.

¡ Schaltfläche Datei 

Über diese Schaltfläche können Sie eine andere Grafikdatei auswählen.

¡ Schaltfläche Exportieren 

Nur bei Grafiken verfügbar, die im Dokument gespeichert sind. Mit dieser Schaltfläche können Sie die
Grafikdatei exportieren, also eine Kopie der Grafik unter einem beliebigen Namen auf Festplatte spei-
chern.

Schalten Sie dabei die Option Verknüpfung zu Datei herstellen ein, ersetzt PlanMaker außerdem die
im Dokument gespeicherte Grafik durch einen Verweis auf die Zieldatei. Die Grafik ist dann also nicht
mehr im Dokument gespeichert.

Verwenden der Grafikleiste

Manche Eigenschaften von Grafiken können auch über die Grafikleiste geändert werden. 

Die Grafikleiste
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Diese Symbolleiste erscheint automatisch, wenn Sie eine Grafik selektieren. Sie enthält folgende Schaltflä-
chen (von links nach rechts):

¡ Menübefehl Objekt > Eigenschaften für die Grafik aufrufen 

¡ Grafik mit einem Fotorahmen-Effekt versehen 

¡ Originalfarben der Grafik verwenden 
¡ Farben auf Graustufen reduzieren
¡ Farben auf schwarz/weiß reduzieren

¡ Helligkeit erhöhen 
¡ Helligkeit reduzieren

¡ Kontrast erhöhen 
¡ Kontrast reduzieren

¡ Gamma erhöhen 
¡ Gamma reduzieren

¡ Um 90° nach rechts drehen 
¡ Um 90° nach links drehen

¡ Alle mit dieser Symbolleiste gemachten Änderungen verwerfen 

¡ Beschnittmodus aktivieren/deaktivieren. In diesem Modus erscheinen zusätzliche Greifer an den Rändern der Grafik. Wenn Sie
an diesen mit der Maus ziehen, wird die Grafik entsprechend beschnitten.

Alle obigen Einstellungen lassen sich alternativ auch mit dem Menübefehl Objekt > Eigenschaften vor-
nehmen. Siehe Abschnitt Eigenschaften von Grafiken ändern.

OLE-Objekte

Hinweis: Die Verwendung von OLE-Objekten ist nur mit der Windows-Version von PlanMaker mög-
lich.

Bei PlanMaker für Windows können Sie in Ihre Dokumente Objekte (Zeichnungen, Grafiken usw.) einbet-
ten, die mit einer anderen Applikation erzeugt wurden.

Ein Beispiel: Mit dem Menübefehl Objekt > Neuer OLE-Objektrahmen können Sie von PlanMaker aus
das Windows-Malprogramm Paint starten lassen und darin etwas zeichnen. Beenden Sie Paint, erscheint
diese Zeichnung im PlanMaker-Dokument. Sie ist jetzt in das Dokument eingebettet.

Vorteil: Sie müssen auf die Zeichnung im PlanMaker-Dokument nur einen Doppelklick ausführen – schon
wird Paint automatisch erneut gestartet. Wenn Sie die Zeichnung darin nun bearbeiten und Paint wieder be-
enden, werden die Änderungen auch von PlanMaker übernommen. 

Damit dies funktioniert, muss die aufzurufende Applikation OLE unterstützen. OLE steht für "Object Lin-
king and Embedding" ("Verknüpfen und Einbetten von Objekten"). Das Objekt, das von der anderen Appli-
kation zu PlanMaker gereicht wird, nennt man ein OLE-Objekt.

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit OLE-Objektrahmen. Folgende The-
men werden darin behandelt:

¡ OLE-Objekte einfügen 

¡ OLE-Objekte bearbeiten

¡ Verknüpfungen von OLE-Objekten bearbeiten
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¡ Eigenschaften von OLE-Objekten ändern

¡ Verwendung des SoftMaker Formeleditors

Lesen Sie dazu die nächsten Seiten.

OLE-Objekte einfügen

Hinweis: Die Verwendung von OLE-Objekten ist nur mit der Windows-Version von PlanMaker mög-
lich.

Mit dem Menübefehl Objekt > Neuer OLE-Objektrahmen können Sie ein OLE-Objekt in das Dokument
einbetten.

Der Befehl öffnet ein Dialogfenster. Dieses enthält eine Liste aller Anwendungen, mit denen sich OLE-Ob-
jekte erstellen lassen. Welche Einträge darin angeboten werden, hängt davon ab, welche OLE-fähigen Pro-
gramme auf Ihrem System installiert sind.

Wenn Sie beispielsweise den Eintrag "Paintbrush-Bild" wählen, öffnet sich das Windows-Malprogramm
Paintbrush (oder Paint) mit einem leeren Fenster. Zeichnen Sie darin ein Bild und beenden Sie Paint dann
einfach. Das Bild ist nun in Ihr Dokument eingebettet. Es wird nicht nur darin angezeigt, sondern kann je-
derzeit auch bearbeitet werden. Führen Sie zum Bearbeiten einfach einen Doppelklick auf das Bild im Do-
kument aus.

Im Einzelnen gehen Sie zum Einfügen eines OLE-Objekts in ein Dokument wie folgt vor:

1. Rufen Sie den Menübefehl Objekt > Neuer OLE-Objektrahmen auf.

2. Es erscheint ein Dialogfenster. Wählen Sie darin aus der Liste Objekttyp die Quellanwendung aus, von
der PlanMaker das OLE-Objekt erhalten soll.

3. Bestätigen Sie mit OK, worauf die zum gewählten Objekttyp gehörende Anwendung gestartet wird.

4. Erstellen Sie das Objekt in der Anwendung.

5. Beenden Sie die Anwendung.

6. Die Anwendung fragt nun möglicherweise nach, ob Sie das Objekt im PlanMaker-Dokument aktualisie-
ren möchten. Bestätigen Sie dies mit "Ja".

7. Das OLE-Objekt wird nun angelegt.

Wenn Sie möchten, können Sie das Objekt anschließend noch verschieben oder seine Größe ändern:

Zum Verschieben klicken Sie mit der Maus auf das Objekt und ziehen es dann (bei weiterhin gedrückter
Maustaste) an die gewünschte Position. 

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die das Objekt umge-
ben. 

OLE-Objekte aus einer Datei erstellen

Möchten Sie kein neues OLE-Objekt erstellen, sondern ein bereits vorhandenes Dokument einer anderen
Anwendung als OLE-Objekt einbetten, rufen Sie ebenfalls den Menübefehl Objekt > Neuer OLE-Objekt-
rahmen auf, wählen im Dialogfenster jedoch die Option Aus Datei erstellen. 
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Das Aussehen des Dialogs ändert sich: Statt der Liste Objekttyp finden Sie nunmehr das Eingabefeld Datei
vor. Geben Sie hier den kompletten Dateinamen an oder klicken Sie auf die Schaltfläche Durchsuchen, um
ein Dialogfenster zu erhalten, mit dem Sie Ihre Festplatte nach dem Dokument durchforsten können. 

Bestimmen Sie eine Datei und bestätigen Sie mit OK, wird diese als OLE-Objekt eingefügt. 

Dabei prüft Windows, ob es mit der Namenserweiterung dieser Datei etwas anfangen kann, und reagiert ent-
sprechend. Ist die Namenserweiterung nicht registriert, erscheint lediglich ein Symbol für die eingebettete
Datei. Kann Windows die Namenserweiterung hingegen einem OLE-fähigen Programm zuordnen, wird der
Inhalt der Datei angezeigt. 

Verknüpfung mit der Originaldatei herstellen

Im oben beschriebenen Dialogfenster können Sie zusätzlich auswählen, ob die einzufügende Datei eingebet-
tet oder verknüpft werden soll. Lassen Sie die Option Verknüpfen ausgeschaltet, fügt PlanMaker eine Ko-
pie der Datei als OLE-Objekt ein und speichert diese im Dokument – das OLE-Objekt wird also wie ge-
wohnt eingebettet. 

Schalten Sie hingegen die Option Verknüpfen ein, stellt PlanMaker eine Verknüpfung mit der Originalda-
tei für das OLE-Objekt her. Von der Bedienung her ändert sich dadurch nichts. Ändern Sie jedoch später
die Originaldatei des OLE-Objekts mit einem anderen Programm und öffnen das PlanMaker-Dokument er-
neut, hat sich auch das OLE-Objekt entsprechend geändert – das OLE-Objekt ist also mit der Originaldatei
verknüpft.

OLE-Objekte bearbeiten

Folgendermaßen bearbeiten Sie vorhandene OLE-Objekte:

Tipp: Um ein OLE-Objekt zu editieren, führen Sie einfach einen Doppelklick auf das OLE-Objekt durch.
Es wird sofort in der zugehörigen Applikation geöffnet und kann darin bearbeitet werden.

Alternativ können Sie auch das Menü verwenden, um ein OLE-Objekt zu editieren. Gehen Sie folgenderma-
ßen vor:

1. Klicken Sie das OLE-Objekt an, um es zu selektieren.

2. Rufen Sie das Menü Bearbeiten auf. Am Ende dieses Menüs finden Sie einen Menüeintrag mit dem Na-
men des Objekts (zum Beispiel Bitmap-Objekt). Das Auswählen dieses Menüeintrags öffnet ein Unter-
menü mit allen für dieses OLE-Objekt zuständigen OLE-Befehlen. Der Befehl Bearbeiten oder Edit ist
für das Bearbeiten zuständig. Rufen Sie diesen auf.

3. Die zu dem OLE-Objekt gehörende Quellanwendung wird nun gestartet. Nehmen Sie die gewünschten
Änderungen vor.

Um wieder zu PlanMaker zurückzukehren, beenden Sie die Anwendung einfach. Beim Beenden mancher
Quellanwendungen wird dabei nachgefragt, ob Sie das Objekt im PlanMaker-Dokument aktualisieren möch-
ten. Antworten Sie mit "Ja" – andernfalls werden Ihre Änderungen verworfen.
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Verknüpfungen von OLE-Objekten bearbeiten

Haben Sie ein OLE-Objekt aus einer Datei erstellt und dabei die Option Verknüpfung aktiviert, können Sie
diese Verknüpfung zu der Quelldatei mit dem Menübefehl Bearbeiten > Verknüpfungen bearbeiten. 

Rufen Sie diesen Befehl dazu auf. Es erscheint ein Dialogfenster, in dem alle im aktuellen Dokument vor-
handenen Verknüpfungen aufgelistet sind. Wenn Sie eine Verknüpfung selektieren, wird im unteren Teil
des Dialogfensters Dateiname und Typ der zugehörigen Quelldatei angezeigt.

Mit den Schaltflächen des Dialogfensters lassen sich folgende Aktionen ausführen:

Schaltfläche Funktion

Jetzt aktualisieren Aktualisiert das OLE-Objekt. Verwenden Sie diese Schaltfläche, falls die Quelldatei von
einem anderen Programm verändert wurde und die Änderungen im PlanMaker-Dokument
nicht sichtbar werden. 

Quelle öffnen Startet die zu dem OLE-Objekt gehörende Anwendung und lässt Sie das Objekt darin bear-
beiten. Tipp: Dies ist auch mit einem Doppelklick auf das Objekt erreichbar.

Quelle ändern Lässt Sie eine andere Datei als Quelle für das OLE-Objekt auswählen.

Verknüpfung lösen Trennt die Verbindung mit der Quelldatei. Das Objekt ist anschließend fest in das PlanMa-
ker-Dokument eingebettet; Änderungen an der Quelldatei wirken sich nicht mehr aus. Das
Objekt lässt sich aber nach wie vor per Doppelklick bearbeiten.

Eigenschaften von OLE-Objekten ändern

Sämtliche Eigenschaften eines Objekts lassen sich zentral mit dem Menübefehl Objekt > Eigenschaften
bearbeiten. Zu den Eigenschaften zählt man beispielsweise Größe, Ränder und zahlreiche weitere Einstell-
möglichkeiten.

Um die Eigenschaften eines OLE-Objekts zu bearbeiten, selektieren Sie dieses zunächst per Mausklick.
Dann rufen Sie den Menübefehl Objekt > Eigenschaften auf, worauf ein entsprechender Dialog erscheint.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

Karteikarten Format, Füllung, Linien etc.

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgen-
der Einstellungen:

¡ Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-
Eigenschaften, Karteikarte Format. 

¡ Füllung: Hier können Sie die Füllung ändern. Diese Funktion wird allerdings nicht von allen OLE-An-
wendungen unterstützt. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte Füllung.

¡ Linien: Hier können Sie Umrandungslinien anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte
Linien.
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¡ Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte
Schatten.

¡ Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt Objekt-Eigenschaften, Kartei-
karte Effekte.

¡ Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Weiterhin erscheint bei OLE-Objekten eine zusätzliche Karteikarte mit weiteren Optionen:

Karteikarte Grafik

Auf der Karteikarte Grafik können Sie Einstellungen zur grafischen Darstellung des Objekts vornehmen.

Hinweis: Abhängig vom Typ des OLE-Objekts sind manche dieser Optionen möglicherweise ohne Funk-
tion.

Verfügbare Optionen:

¡ Varianten 

In dieser Liste werden einige vorgefertigte Variationen angeboten – zum Beispiel andere Farbmodi
(Graustufen, schwarz/weiß etc.) und Varianten, bei denen das Objekt eingefärbt wurde.

Klicken Sie die gewünschte Variante einfach an. Die Optionen in dem Dialog werden dann automatisch
auf entsprechende Einstellungen gesetzt.

¡ Rubrik Optionen 

Hier können Sie Helligkeit, Kontrast, Sättigung und Gamma-Wert (eine alternative Möglichkeit zum Än-
dern der Helligkeit) ändern.

¡ Schaltfläche Weiteres 

Diese Schaltfläche öffnet einen Dialog mit zusätzlichen Einstellungen:

Wenn Sie die Option Einfärben aktivieren und darunter eine Farbe auswählen, wird das Objekt entspre-
chend eingefärbt.

Mit den Optionen in der Rubrik Beschnitt können Sie das Objekt zuschneiden. Dies ist nützlich, wenn
Sie nur einen Ausschnitt des Objekts benötigen. Soll beispielsweise das obere Viertel des Objekts abge-
schnitten werden, wählen Sie zunächst Relative Werte verwenden und geben Sie bei Oben die Zahl
"25" (Prozent) ein.

Wählen Sie Absolute Werte verwenden aus, werden die Eingaben nicht prozentual, sondern in absolu-
ten Längeneinheiten abgeschnitten. Wenn Sie negative Werte eingeben, werden die Bereiche des Ob-
jekts nicht abgeschnitten, sondern es wird mit einem Rahmen erweitert.

¡ Schaltfläche Exportieren 

Mit dieser Schaltfläche können Sie eine Kopie der grafischen Repräsentation des Objekts exportieren,
also ein Abbild des Objekts unter einem beliebigen Namen auf Festplatte speichern.
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Verwendung des SoftMaker Formeleditors

Hinweis: Der SoftMaker-Formeleditor ist nur unter Windows verfügbar und nicht in allen Versionen
von PlanMaker enthalten.

Mit dem SoftMaker Formeleditor können Sie mathematische und technische Formeln grafisch darstellen.

Den Formeleditor sprechen Sie, wie in den vorherigen Abschnitten beschrieben, über OLE an. Um also eine
Formel grafisch darzustellen, fügen Sie in das Dokument ein OLE-Objekt ein, das als Quellanwendung den
Formeleditor verwendet.

Dazu gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Objekt > Neuer OLE Objektrahmen auf.

2. Wählen Sie in der Liste Objekttyp den Eintrag SoftMaker Formeleditor.

3. Bestätigen Sie mit OK, worauf der Formeleditor gestartet wird.

4. Erstellen Sie die gewünschte Formel.

5. Wenn die Formel fertiggestellt ist, beenden Sie den Formeleditor einfach.

Die Formel ist nun als OLE-Objekt in das PlanMaker-Dokument eingebettet.

Sie können Formeleditor-Objekte jederzeit nachträglich bearbeiten, indem Sie einen Doppelklick darauf
ausführen. Der Formeleditor wird daraufhin wieder gestartet und öffnet die Formel. Nehmen Sie die ge-
wünschten Änderungen vor und beenden Sie den Formeleditor dann einfach wieder.

Mit dem Menübefehl Objekt > Eigenschaften können Sie weiterhin die Eigenschaften des Formeleditor-
Objekts ändern, nachdem Sie es mit einem (einfachen!) Mausklick selektiert haben.

Informationen vom Hersteller des Formeleditors

Der SoftMaker Formeleditor ist eine spezielle Version des Programms MathType der Firma Design Science. Falls Sie häufig Formeln in Ihren Doku-
menten verwenden, werden Sie in MathType eine Lösung finden, die Ihren Ansprüchen noch besser genügt. MathType ist genauso einfach zu bedie-
nen wie der SoftMaker Formeleditor, hat jedoch zahlreiche zusätzliche Funktionen, die Ihnen helfen, produktiver zu sein und anspruchsvollere For-
meln zu gestalten.

MathType ist in Deutsch, Englisch und anderen Sprachen erhältlich. Informationen über den Bezug von MathType erhalten Sie bei Ihrem Software-
händler oder direkt bei Design Science.

Design Science, Inc.
140 Pine Avenue, 4th Floor
Long Beach, CA 90802
USA

Telefon (USA): +1 (562) 432-2920 (für internationale Kunden)
+1 (800) 827-0685 (für Kunden aus USA und Kanada)

Telefax (USA): +1 (562) 432-2857

E-Mail (englisch): sales@dessci.com
Internet: www.dessci.com
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Zeichnungen
PlanMaker bietet mehrere Werkzeuge zum Erstellen von Zeichnungen an. Sie können in Ihre Dokumente
folgende Arten von Zeichnungsobjekten einfügen:

¡ Linien und Kurven (Linien, Pfeile, Verbindungslinien, Kurven) 
¡ Rechtecke und Ellipsen
¡ AutoFormen (vorgefertigte Formen unterschiedlichster Art)
¡ TextArt-Objekte (mit Effekten versehene Schriftzüge)

In diesem Abschnitt erfahren Sie alles Wissenswerte zum Arbeiten mit Zeichnungen. Folgende Themen
werden darin behandelt:

¡ Zeichnungen einfügen 

¡ Text zu AutoFormen hinzufügen

¡ Eigenschaften von Zeichnungen ändern

Lesen Sie dazu die nächsten Seiten.

Zeichnungen einfügen

Um eine Zeichnung einzufügen, zum Beispiel ein Rechteck, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Objekt > Neue Zeichnung auf. Es öffnet sich ein Untermenü, aus dem Sie
das gewünschte Zeichenwerkzeug auswählen können – in diesem Falle also das Werkzeug Rechteck.

Alternativ können Sie auch das entsprechende Symbol in der Objektleiste anklicken, sofern Sie den Ob-
jektmodus aktiviert haben.

2. Bei manchen Werkzeugen müssen Sie nun noch weitere Schritte durchführen (siehe unten). Bei Rechte-
cken ist dies jedoch nicht der Fall.

3. Das Rechteck wird nun eingefügt. 

Wenn Sie möchten, können Sie das Rechteck anschließend noch verschieben oder seine Größe ändern:

Zum Verschieben klicken Sie mit der Maus auf das Rechteck und ziehen es dann (bei weiterhin gedrück-
ter Maustaste) an die gewünschte Position. 

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die das Rechteck umge-
ben. 

Das Anbringen von Zeichnungen unterscheidet sich je nach verwendetem Zeichenwerkzeug etwas. Nachfol-
gend eine Liste aller verfügbaren Zeichnungsobjekte und Informationen zu deren Handhabung:
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Linie und Kurven

Mit dem Werkzeug  Linie in der Objektleiste können Sie Linien und Kurven zeichnen. 

Wenn Sie dieses Symbol anklicken, öffnet sich eine Liste mit verschiedenen Werkzeugen für Linien und
Kurven zur Auswahl. Wählen Sie darin das gewünschte Werkzeug und wenden Sie es dann wie folgt an:

¡ Linien 

Mit den Werkzeugen in der obersten Rubrik der Liste können Sie einfache Linien und Pfeile zeichnen.

Ziehen Sie dazu, nachdem Sie das gewünschte Werkzeug angeklickt haben, bei gedrückter Maustaste
einfach eine Linie im Dokument. 

Tipp: Wenn Sie dabei die Umschalttasteñ gedrückt halten, ist die Linie auf 45°-Winkel beschränkt.

Anmerkung: Pfeile sind nichts weiter als gewöhnliche Linien, bei denen in den Objekteigenschaften
(Karteikarte Linien) für die Option Startpunkt und/oder Endpunkt eine Pfeilspitze gewählt wurde.

¡ Verbindungslinien (gerade, gewinkelte und gekrümmte) 

Mit den Werkzeugen in den nächsten drei Rubriken können Sie Verbindungslinien zwischen zwei Ob-
jekten ziehen. Den Unterschied zwischen den drei Arten von Verbindungslinien sehen Sie in folgender
Abbildung:

Wählen Sie dazu eines dieser Werkzeuge und ziehen Sie dann den Mauszeiger bei gedrückter Maustaste
von einem Objekt zum einem anderen. 

Tipp: Es erscheinen hierbei kleine blaue Rechtecke am Objekt. Diese zeigen, an welchen Stellen des Ob-
jekts die Linie "andocken" kann.

¡ Kurven 

Die Werkzeuge in dieser Kategorie dienen zum Zeichnen von Kurven:

Mit dem Werkzeug  Kurve können Sie Bezierkurven zeichnen.

Klicken Sie dazu auf den Ausgangspunkt und anschließend auf beliebig viele andere Positionen. Die
Kurve "folgt" Ihren Mausklicks automatisch.

Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeichnung automatisch zu einer
geschlossenen Kurve. Möchten Sie hingegen eine offene Kurve erhalten, müssen Sie die Zeichnung
mit einem Doppelklick beenden.

Mit dem Werkzeug  Freihandform können Sie Kurven hingegen wie mit einem Zeichenstift zeich-
nen.
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Bewegen Sie die Maus dazu auf den gewünschten Ausgangspunkt und beginnen Sie bei gedrückter
Maustaste zu zeichnen – wie mit einem Stift. Alternativ können Sie die Maustaste auch loslassen und
eine andere Stelle anklicken, worauf eine gerade Linie dorthin gezeichnet wird.

Wenn Sie die Kurve an ihrem Ausgangspunkt enden lassen, wird die Zeichnung automatisch zu einer
geschlossenen Kurve. Möchten Sie hingegen eine offene Kurve erhalten, müssen Sie die Zeichnung
mit einem Doppelklick beenden.

Rechteck, abgerundetes Rechteck und Ellipse

Mit den drei Werkzeugen  Rechteck, Abgerundetes Rechteck und Ellipse können Sie Rechtecke
beziehungsweise Ellipsen einfügen.

Wenn Sie eines dieser Werkzeuge anklicken, wird das entsprechende Zeichnungsobjekt sofort (in einer
Standardgröße) eingefügt. Wenn Sie möchten, können Sie es anschließend mit der Maus verschieben oder
seine Größe ändern, indem Sie an einem der runden Greifer an seinen Ecken ziehen. 

Bei abgerundeten Rechtecken lässt sich zudem noch die Rundung der Ecken ändern. Selektieren Sie das
Rechteck dazu, worauf unter anderem ein gelber Greifer neben einer der Ecken erscheint. Ziehen Sie an die-
sem Greifer, ändert sich die Rundung entsprechend.

AutoForm

Mit dem Werkzeug  AutoForm können Sie AutoFormen einfügen. Das sind vorgefertigte Formen für
die unterschiedlichsten Einsatzzwecke – Standardformen wie etwa Rechtecke, aber auch Symbole für Fluss-
diagramme, Sterne, Sprechblasen und viele mehr.

Sobald Sie eine AutoForm ausgewählt haben, wird diese (in einer Standardgröße) eingefügt. Wenn Sie
möchten, können Sie die AutoForm anschließend mit der Maus verschieben oder ihre Größe ändern, indem
Sie an einem der runden Greifer an ihren Ecken ziehen. 

Hinweis: In manchen Arten von AutoFormen werden zusätzliche gelbe Greifer angezeigt, wenn diese selek-
tiert sind. Ziehen Sie an einem dieser Greifer, ändert die AutoForm bestimmte Parameter ihres Aussehens.
Bei Sternen lässt sich auf diese Weise beispielsweise die Länge der Zacken ändern.

Tipp: Sie können sogar Text innerhalb einer AutoForm eingeben – genau wie bei einem Textrahmen. Infor-
mationen dazu finden Sie im Abschnitt Text zu AutoFormen hinzufügen.

TextArt

Mit dem Werkzeug  TextArt können Sie TextArt-Objekte einfügen. Das sind Schriftzüge, die mit diver-
sen Effekten versehen werden können.

Wenn Sie dieses Werkzeug aktivieren, erscheint ein Dialog. Geben Sie darin den Text ein und klicken Sie
auf Varianten, um einen der vorgefertigten Effekte auszuwählen. Bestätigen Sie dann mit OK. 

Text zu AutoFormen hinzufügen

Sie können AutoFormen auf Wunsch Text hinzufügen. Dieser Text wird dann innerhalb der AutoForm an-
gezeigt – genau wie bei einem Textrahmen.

Gehen Sie dazu wie folgt vor:
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1. Selektieren Sie die gewünschte AutoForm.

2. Rechtsklicken Sie auf die AutoForm, um ihr Kontextmenü aufzurufen.

3. Wählen Sie darin den Befehl Text hinzufügen.

Nun blinkt die Schreibmarke in der AutoForm; Sie können jetzt also Text eingeben. 

Tipp: Es gibt noch einen schnelleren Weg, Text zu einer AutoForm hinzuzufügen: Selektieren Sie die
AutoForm dazu und beginnen Sie dann einfach mit dem Tippen.

Mit den Menübefehlen Format > Zeichen und Format > Absatz lässt sich bei Bedarf die gewünschte For-
matierung einstellen.

Wenn Sie mit der Eingabe fertig sind, klicken Sie auf eine beliebige Stelle außerhalb des Objekts. Möchten
Sie den Text später noch einmal bearbeiten, selektieren Sie die AutoForm erneut und wählen den Befehl
Text bearbeiten aus dem Kontextmenü.

Wichtig: Wenn PlanMaker am unteren Rand des Textes einen roten Balken anzeigt, zeigt dies an, dass
der Text nicht vollständig in den zur Verfügung stehenden Platz passt. Vergrößern Sie in diesem Falle al-
so das Objekt oder verringern Sie die Textmenge.

Hinweis: Die weiter vorne in diesem Kapitel vorgestellten Textrahmen sind übrigens nichts anderes als Au-
toFormen (in diesem Falle einfache Rechtecke), denen Text hinzugefügt wurde. Alle Informationen im Ab-
schnitt Textrahmen gelten also im gleichen Maße auch für AutoFormen, denen Text hinzugefügt wurde.

Eigenschaften von Zeichnungen ändern

Um die Eigenschaften einer Zeichnung zu bearbeiten, selektieren Sie diese zunächst per Mausklick. Dann
rufen Sie den Menübefehl Objekt > Eigenschaften auf, worauf ein entsprechender Dialog erscheint.

Tipp: Sie können diesen Dialog auch über einen Doppelklick auf die Zeichnung aufrufen.

In dem Dialog lassen sich folgende Einstellungen vornehmen:

Karteikarten Format, Füllung, Linien etc.

Diese Karteikarten sind bei praktisch allen Arten von Objekten vorhanden. Sie dienen zum Ändern folgen-
der Einstellungen:

¡ Format: Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-
Eigenschaften, Karteikarte Format. 

¡ Füllung: Hier können Sie die Füllung ändern. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte Füllung.

¡ Linien: Hier können Sie den Linienstil der Linien, mit denen das Objekt gezeichnet wird, ändern. Siehe
Abschnitt Objekt-Eigenschaften, Karteikarte Linien.

¡ Schatten: Hier können Sie einen Schatten anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte
Schatten.

¡ 3D: Hier können Sie einen 3D-Effekt anbringen. Siehe Abschnitt Objekt-Eigenschaften, Karteikarte 3D.
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¡ Effekte: Hier können Sie verschiedene Effekte anbringen. Siehe Abschnitt Objekt-Eigenschaften, Kartei-
karte Effekte.

¡ Eigenschaften: Hier können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Weiterhin erscheinen bei einigen Arten von Zeichnungen zusätzliche Karteikarten mit weiteren Optionen
(siehe nachfolgende Seiten).

Karteikarte AutoFormen (nur bei AutoFormen)

Diese Karteikarte erscheint nur bei AutoFormen.

Auf der Karteikarte AutoFormen können Sie dem Objekt eine andere AutoForm zuweisen, also beispiels-
weise aus einem Rechteck eine Sprechblase oder eine beliebige andere Form machen.

Wählen Sie dazu einfach die gewünschte AutoForm aus.

Ausführliche Informationen zu AutoFormen finden Sie im Abschnitt Zeichnungen einfügen.

Karteikarte Innentext (bei AutoFormen, denen Text hinzugefügt wurde)

Diese Karteikarte erscheint nur bei AutoFormen, denen Text hinzugefügt wurde (siehe Abschnitt Text zu
AutoFormen hinzufügen) und bei Textrahmen.

Auf dieser Karteikarte können Sie Einstellungen zu dem enthaltenen Text ändern.

Verfügbare Optionen:

¡ Rubrik Innenränder 

Hier können Sie die Innenränder für den Text ändern. Schalten Sie die Option Automatisch ein, ermit-
telt das Programm die Ränder automatisch.

¡ Rubrik Überlappende Objekte 

Diese Einstellung bestimmt, was passieren soll, wenn sich das Objekt mit einem anderen Objekt über-
lappt. 

Bei der Standardeinstellung Objekt ignorieren greift PlanMaker nicht ein. In dem sich überlappenden
Bereich wird also der Inhalt beider Objekte übereinander gedruckt. 

Wählen Sie hingegen die Option Text umbrechen, wird der in diesem Objekt enthaltene Text automa-
tisch neu umbrochen, so dass er die Überlappung umfließt.

¡ Rubrik Drehen um ... 

Hier können Sie den Text um den angegebenen Winkel drehen.

¡ Rubrik Vertikale Ausrichtung 

Diese Einstellung bestimmt, wie der enthaltene Text zwischen Ober- und Unterkante der Zeichnung aus-
gerichtet werden soll:

Option Erläuterung
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Oben Der Text wird an der Oberkante des Objekts ausgerichtet. (Dies ist die Stan-
dardeinstellung.)

Zentriert Der Text wird zwischen Ober- und Unterkante zentriert.

Unten Der Text wird an der Unterkante des Objekts ausgerichtet.

Vertikaler Blocksatz Der Abstand zwischen den Textzeilen wird gleichmäßig so erweitert, dass der
Text an der Oberkante des Objekts beginnt und an der Unterkante endet.

Karteikarte Text (nur bei TextArt-Objekten)

Diese Karteikarte erscheint nur bei TextArt-Objekten.

Sie können darin den gewünschten Effekt auswählen sowie den anzuzeigenden Text eingeben und formatie-
ren.

Verfügbare Optionen:

¡ Text 

Hier können Sie den Text eintippen, der angezeigt werden soll.

¡ Varianten 

In dieser Liste können Sie auswählen, mit welchem Effekt der Text dargestellt werden soll.

¡ Rubrik Schrift 

Hier können Sie die Schriftart ändern und die Textauszeichnungen Fett und Kursiv ein-/ausschalten.

Aktivieren Sie die Option Gleiche Höhe, werden alle Buchstaben (inklusive Kleinbuchstaben) auf eine
einheitliche Höhe gestreckt.

¡ Rubrik Abstände 

Die Option Zeichen ändert den Abstand zwischen den Zeichen. Bei Werten kleiner als 100% sind die
Zeichen enger zusammen, bei Werten größer als 100% weiter auseinander.

Die Option Zeilen ändert den Zeilenabstand. Dies wirkt sich nur auf Text aus, der aus mehreren Zeilen
besteht.

¡ Rubrik Ausrichtung 

Hier können Sie die Ausrichtung des Textes ändern. Dies wirkt sich nur auf Text aus, der aus mehreren
Zeilen besteht.

¡ Rubrik Platzierung 

Aktivieren Sie die Option Vertikaler Text, werden die Buchstaben des Textes um 90° gedreht.

Karteikarte Deformation (nur bei TextArt-Objekten)

Diese Karteikarte erscheint nur bei TextArt-Objekten.
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Sie können darauf festlegen, mit welcher Art von Verzerrung der Schriftzug dargestellt werden soll. Wählen
Sie dazu die gewünschte Art von Deformation aus der Liste.
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Diagramme
Mit Hilfe von Diagrammen können Sie die Zahlenwerte einer Tabelle grafisch darstellen und somit die
"nackten Zahlen" anschaulicher und übersichtlicher präsentieren. 

In diesem Kapitel finden Sie alles Wissenswerte dazu. Folgende Themen werden darin behandelt:

¡ Diagramme einfügen 

Als erstes erfahren Sie, wie man ein Diagramm anlegt: Zellen mit den darzustellenden Daten markieren,
den Menübefehl Objekt > Neuer Diagrammrahmen aufrufen, Diagrammtyp wählen – fertig.

¡ Diagramme bearbeiten 

Der nächste Abschnitt enthält alle Informationen zum Bearbeiten von Diagrammen. Sie erfahren darin,
wie man den Diagrammtyp und die Anordnung der Datenreihen ändert, wie man mit den einzelnen Dia-
grammelementen (Datenreihen, Achsen, Legende etc.) arbeitet und wie man die allgemeinen Diagramm-
eigenschaften verändert.

¡ Diagramme aktualisieren 

Ein Diagramm holt sich die darzustellenden Werte stets aus den Zellen, die beim Erstellen des Dia-
gramms markiert waren. Ändern sich also Werte in diesen Zellen, wird das Diagramm sofort aktualisiert.
Bei Bedarf können Sie diese automatische Aktualisierung jedoch abschalten.
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¡ Diagramme auf ein anderes Arbeitsblatt verschieben 

Mit dem Menübefehl Objekt > Diagramm > Position des Diagramms ändern können Sie ein Dia-
gramm auf ein anderes Arbeitsblatt verschieben oder gar ein eigenes Diagramm-Arbeitsblatt dafür anle-
gen. Dieses enthält keinerlei Tabellenzellen, sondern nur das Diagramm in voller Größe.

¡ Diagramme als Grafik speichern 

Der Menübefehl Objekt > Diagramm > Als Grafik speichern ermöglicht es Ihnen, ein Abbild eines
Diagramms in einer Grafikdatei zu speichern.

Diagramme einfügen
Mit dem Menübefehl Objekt > Neuer Diagrammrahmen können Sie neue Diagramme in das Dokument
einfügen.

Gehen Sie dazu wie folgt vor:

1. Markieren Sie die Zellen, deren Inhalte in dem Diagramm dargestellt werden sollen.

Tipp: Wenn Sie dabei Spalten- und Zeilenüberschriften mitmarkieren, werden diese automatisch zur Be-
schriftung der Achsen und der Legende herangezogen.

2. Rufen Sie den Menübefehl Objekt > Neuer Diagrammrahmen auf.

Alternativ können Sie diesen Befehl auch über das Symbol  in der Funktionsleiste aufrufen.

3. Es erscheint ein Dialog, in dem Sie bestimmen können, welche Art von Diagramm eingefügt werden
soll. Wählen Sie dazu den gewünschten Diagrammtyp und Untertyp. Informationen zu den einzelnen
Diagrammtypen finden Sie im Abschnitt Diagrammtyp ändern.

4. Bestätigen Sie mit OK.

5. Das Diagramm wird nun eingefügt. 

Wenn Sie möchten, können Sie das Diagramm anschließend noch verschieben oder seine Größe ändern:

Zum Verschieben klicken Sie mit der Maus auf das Diagramm und ziehen es dann (bei weiterhin ge-
drückter Maustaste) an die gewünschte Position. 

Um die Größe zu ändern, ziehen Sie mit der Maus an einem der runden Greifer, die das Diagramm um-
geben. 

Diagramme bearbeiten
In den nächsten Abschnitten erfahren Sie, wie Sie Diagramme bearbeiten können. Folgende Themen werden
darin behandelt:

¡ Diagrammtyp ändern 

¡ Anordnung der Datenreihen ändern
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¡ Diagrammelemente bearbeiten

¡ Diagrammeigenschaften ändern

Hinweis: Grundlegende Informationen zum Arbeiten mit Objekten finden Sie außerdem im Abschnitt Ob-
jekte. 

Tipp: Verwenden der Diagrammleiste

Wenn Sie ein Diagramm selektieren, erscheint automatisch ein nützlicher Helfer auf dem Bildschirm: die
Diagrammleiste.

Die Diagrammleiste

Diese Leiste enthält Symbole für die wichtigsten Funktionen zum Bearbeiten von Diagrammen. Von links
nach rechts:

¡ Diagrammtyp auswählen 
¡ Untertyp auswählen (nur bei einigen Diagrammtypen verfügbar)

¡ Liste aller Diagrammelemente, die das Diagramm enthält (klicken Sie auf ein Element, wird es im Diagramm selektiert) 
¡ Eigenschaften des gewählten Diagrammelements bearbeiten
¡ Allgemeine Eigenschaften des gesamten Diagramms bearbeiten

¡ Datenreihen spaltenweise anordnen 
¡ Datenreihen zeilenweise anordnen

¡ Trendlinie hinzufügen 

¡ Legende ein-/ausblenden 
¡ Vertikale Gitternetzlinien ein-/ausblenden
¡ Horizontale Gitternetzlinien ein-/ausblenden

Informationen zur Funktion der einzelnen Symbole folgen auf den nächsten Seiten.

Diagrammtyp ändern

Der Diagrammtyp bestimmt, in welcher Form die Daten im Diagramm dargestellt werden – zum Beispiel
als Balken, als Linien, in Form eines Tortendiagramms etc. etc.

Um den Diagrammtyp zu ändern, gehen Sie wie folgt vor.

1. Selektieren Sie das Diagramm per Mausklick.

2. Rufen Sie den Menübefehl Objekt > Eigenschaften auf.

3. Wechseln Sie auf die Karteikarte Diagrammtyp.

4. Wählen Sie den gewünschten Diagrammtyp und Untertyp.

Tipp: Alternativ können Sie die ersten beiden Symbole in der Diagrammleiste verwenden: das erste Sym-
bol bestimmt den Diagrammtyp, das zweite den Untertyp (nur bei bestimmten Diagrammtypen verfüg-
bar).

Es gibt folgende Diagrammtypen:
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   Säulendiagramm 

Säulendiagramme eignen sich gut dazu, Werte miteinander zu vergleichen. Jeder Wert wird durch eine
entsprechend hohe Säule dargestellt.

   Balkendiagramm

Balkendiagramme entsprechen Säulendiagrammen; die Werte werden allerdings nicht vertikal, sondern
horizontal abgebildet.

   Liniendiagramm

Bei einem Liniendiagramm werden die Werte als Punkte und/oder Linien zwischen diesen Punkten darge-
stellt.

   Flächendiagramm

Ein Flächendiagramm ist ein Liniendiagramm, bei dem der Zwischenraum zwischen X-Achse und den ein-
zelnen Linien ausgefüllt wird.

   XY-Punktdiagramm

XY-Punktdiagramme stellen die Werte als Punkte und/oder Linien dar. Anders als bei Liniendiagrammen
muss der Datenbereich dabei jedoch sowohl die x- als auch die y-Koordinaten der Datenpunkte enthalten.

   Blasendiagramm

Blasendiagramme stellen Daten als ausgefüllte Kreise ("Blasen") dar. Für ein Blasendiagramm verwendet
man üblicherweise Datenreihen mit drei Werten: x-Koordinate, y-Koordinate und Blasengröße.

   Netzdiagramm

Ein Netzdiagramm stellt die Werte auf einem Netz dar. Der Nullpunkt liegt dabei in der Mitte des Netzes.

   Oberflächendiagramm

Bei einem Oberflächendiagramm werden die Werte zu einer dreidimensional dargestellten Oberfläche
verbunden. Bereiche, die in der gleichen Farbe gezeichnet werden, zeigen an, dass sie ähnliche Werte ent-
halten. 

Die darzustellenden Daten sollten dabei folgende Struktur haben:
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(Die z-Werte sind die Höhenwerte.)

   Kreisdiagramm (Tortendiagramm)

Kreisdiagramme (oder Tortendiagramme) sind gut dazu geeignet, den Anteil von Einzelwerten am Ge-
samtwert darzustellen. Die Größe jedes einzelnen "Tortenstücks" zeigt das Verhältnis des Werts zur Ge-
samtsumme und zu den anderen Werten.

Tipp: Sie können Werte besonders hervorheben, indem Sie das dazugehörige Tortenstück aus der Torte her-
ausziehen. Selektieren Sie das Tortenstück dazu und ziehen Sie es mit der Maus heraus.

   Ringdiagramm

Ringdiagramme zeigen, genau wie Kreisdiagramme, den Anteil von Einzelwerten am Gesamtwert. Im Ge-
gensatz zu Kreisdiagramme können Sie jedoch nicht nur eine einzige Datenreihe darstellen, sondern beliebi-
ge viele Datenreihen (= Ringe).

   Zylinder-, Kegel- und Pyramidendiagramm

Zylinder-, Kegel- und Pyramidendiagramme entsprechen Säulen- und Balkendiagrammen. Anstelle von
Säulen/Balken verwenden sie jedoch Zylinder, Kegel oder Pyramiden zur Darstellung der Werte.

   Kursdiagramm

Kursdiagramme (auch Börsendiagramme oder allgemein Hoch-Tief-Diagramme genannt) eignen sich
unter anderem zum Darstellen von Aktienkursen. Es lassen sich darin beispielsweise der höchste Kurs, der
tiefste Kurs und der Schlusskurs auf einen Blick ablesen.

Es gibt folgende Untertypen:

¡ Kursdiagramm (Höchst-, Tiefst-, Schlusskurs) 

Stellt folgende Werte dar:

Höchstkurs, Tiefstkurs, Schlusskurs

Benötigt 3 Datenreihen in obiger Reihenfolge. 

Ein Beispiel für einen möglichen Aufbau der Daten (in Spalte A ist hier zusätzlich das Datum eingetra-
gen):
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¡ Kursdiagramm (Eröffnungs-, Höchst-, Tiefst-, Schlusskurs) 

Stellt folgende Werte dar:

Eröffnungskurs, Höchstkurs, Tiefstkurs, Schlusskurs

Benötigt 4 Datenreihen in obiger Reihenfolge.

¡ Kursdiagramm (Volumen; Höchst-, Tiefst-, Schlusskurs) 

Stellt folgende Werte dar:

Handelsvolumen, Höchstkurs, Tiefstkurs, Schlusskurs

Benötigt 4 Datenreihen in obiger Reihenfolge. 

Das Handelsvolumen wird dabei in einer zusätzlichen Säule dargestellt, die über ihre eigene Größenach-
se verfügt.

¡ Kursdiagramm (Volumen; Eröffnungs-, Höchst-, Tiefst-, Schlusskurs) 

Stellt folgende Werte dar:

Handelsvolumen, Eröffnungskurs, Höchstkurs, Tiefstkurs, Schlusskurs

Benötigt 5 Datenreihen in obiger Reihenfolge. 

Das Handelsvolumen wird dabei in einer zusätzlichen Säule dargestellt, die über ihre eigene Größenach-
se verfügt.

   Boxplot-Diagramm

Boxplots (oder Box-Whisker-Plots) sind hilfreich bei der Datenanalyse in der Statistik. Ihre Anwendung
hier im Detail zu erläutern würde den Rahmen dieses Handbuchs sprengen; bei Bedarf finden Sie weiterfüh-
rende Informationen mit der Suchmaschine Ihrer Wahl.

Es gibt zwei Untertypen: Horizontal und Vertikal.

Abhängig davon, wie viele Datenreihen Sie dem Diagramm übergeben, werden unterschiedliche Varianten
von Boxplots geliefert:

(Hinweis: Welche Arten von Werten Sie in einem Boxplot darstellen möchten, ist völlig Ihnen überlassen.
Die nachfolgenden Listen zeigen lediglich Beispiele.)

¡ 3 Punkte-Boxplot 

Stellt beispielsweise folgende Werte dar:
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Unteres Quartil (untere Kante der Box)
Median (Position des Strichs innerhalb der Box)
Oberes Quartil (obere Kante der Box)

Benötigt genau 3 Datenreihen in obiger Reihenfolge.

¡ 5 Punkte-Boxplot 

Stellt beispielsweise folgende Werte dar:

Unterer Whisker (Linie unter der Box)
Unteres Quartil (untere Kante der Box)
Median (Position des Strichs innerhalb der Box)
Oberes Quartil (obere Kante der Box)
Oberer Whisker (Linie oberhalb der Box)

Benötigt genau 5 Datenreihen in obiger Reihenfolge.

¡ 7 Punkte-Boxplot 

Stellt beispielsweise folgende Werte dar:

Minimum (als einzelner Marker)
Unterer Whisker (Linie unter der Box)
Unteres Quartil (untere Kante der Box)
Median (Position des Strichs innerhalb der Box)
Oberes Quartil (obere Kante der Box)
Oberer Whisker (Linie oberhalb der Box)
Maximum (als einzelner Marker)

Benötigt genau 7 Datenreihen in obiger Reihenfolge.

Anordnung der Datenreihen ändern

Mit den zwei Symbolen  in der Diagrammleiste können Sie festlegen, ob die darzustellenden Daten
spaltenweise oder zeilenweise ausgewertet werden sollen:

¡ Spaltenweise 

Normalerweise ist das erste Symbol aktiv, das Diagramm liest die markierten Werte also Spalte für Spal-
te. Die Werte aus der ersten Spalte bilden demnach Datenreihe 1, die aus der zweiten Spalte Datenreihe
2 etc.

¡ Zeilenweise 

Aktivieren Sie hingegen das zweite Symbol, werden die Daten zeilenweise ausgelesen. Die Zuordnung
der Zeilen/Spalten in der Tabelle zur X-Achse/Y-Achse im Diagramm wird also vertauscht.

Alternativ können Sie diese Einstellung auch über die Menübefehle Objekt > Diagramm > Daten in Spal-
ten beziehungsweise Daten in Zeilen festlegen. 
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Diagrammelemente bearbeiten

Diagramme bestehen aus mehreren Komponenten. So gibt es neben den Datenreihen selbst beispielsweise
die Achsen, eine Legende etc. Diese einzelnen Komponenten eines Diagramms nennt man die Diagramm-
elemente.

Die nachfolgende Abbildung zeigt, welche Diagrammelemente es gibt:

Reihe 1, Reihe 2 etc. sind dabei die Datenreihen.

Bei dreidimensionalen Diagrammtypen kommen noch ein paar zusätzliche Elemente (Bodenfläche, Wände
etc.) hinzu, die ebenfalls auf den nächsten Seiten beschrieben werden.

Jedes dieser Diagrammelemente lässt sich bei Bedarf per Mausklick selektieren und dann bearbeiten.

Selektieren von Diagrammelementen

Um ein Diagrammelement zu selektieren, selektieren Sie zunächst das Diagramm selbst (durch Anklicken)
und klicken dann auf das gewünschte Diagrammelement. Um beispielsweise eine Datenreihe zu selektieren,
klicken Sie auf einen beliebigen Wert innerhalb dieser Reihe. 

Hinweis: Wenn Sie einen einzelnen Wert innerhalb einer Datenreihe selektieren möchten, müssen Sie erst
auf die Datenreihe und dann auf den gewünschten Einzelwert klicken.

Tipp: Alternativ können Sie Diagrammelemente selektieren, indem Sie die Liste der Elemente in der Mit-
te der Diagrammleiste aufklappen und darin das gewünschte Element auswählen.
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Position und Größe von Diagrammelementen ändern

Bei machen Diagrammelementen (z.B. der Legende) lässt sich die Position und Größe ändern. Selektieren
Sie das Element dazu und ziehen Sie es anschließend an die gewünschte Position. Um die Größe zu ändern,
ziehen Sie an einem der runden Greifer, die das Element umgeben.

Eigenschaften von Diagrammelementen ändern

Sie können nicht nur, wie später im Abschnitt Diagrammeigenschaften ändern beschrieben, die Eigenschaf-
ten des Diagramms an sich ändern, sondern auch die Eigenschaften einzelner Diagrammelemente bearbei-
ten.

Um beispielsweise die Eigenschaften der Legende eines Diagramms zu ändern, gehen Sie wie folgt vor:

1. Selektieren Sie das Diagramm per Mausklick.

2. Rechtsklicken Sie auf die Legende, um ihr Kontextmenü aufzurufen.

Android: Bei der Android-Version können Sie das Kontextmenü auch mit dem Finger öffnen: Tippen Sie
dazu auf den Bildschirm und halten Sie den Finger für etwa eine Sekunde gedrückt.

3. Wählen Sie im Kontextmenü den Befehl Legende: Eigenschaften aus (nicht den Befehl Diagramm:
Eigenschaften).

Nun erscheint ein Dialog, in dem Sie die gewünschten Einstellungen vornehmen können.

Tipp: Alternativ können Sie diesen Dialog auch über das Symbol  in der Diagrammleiste aufrufen.
Noch schneller: Darüber hinaus können Sie den Dialog mit einem Doppelklick auf das gewünschte Ele-
ment öffnen.

Welche Eigenschaften sich in diesem Dialog ändern lassen, hängt davon ab, für welche Art von Diagramm-
element Sie ihn aufrufen. In den nächsten Abschnitten finden Sie Informationen zu allen verfügbaren Dia-
grammelementen und ihren jeweiligen Eigenschaften:

¡ Diagrammfläche  

¡ Zeichnungsfläche 

¡ Wände (nur bei dreidimensionalen Diagrammtypen) 

¡ Bodenfläche (nur bei dreidimensionalen Diagrammtypen) 

¡ Ecken (nur bei dreidimensionalen Diagrammtypen) 

¡ Datenreihen und Datenpunkte 

¡ Trendlinien 

¡ Rubrikenachse (X-Achse) 

¡ Größenachse (Y-Achse) 

¡ Reihenachse (Z-Achse) 

¡ Gitternetzlinien 

¡ Legende 
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Diagrammfläche

Als Diagrammfläche wird die gesamte Fläche eines Diagrammrahmens bezeichnet.

Eigenschaften bearbeiten: Um die Eigenschaften der Diagrammfläche zu ändern, selektieren Sie diese, öff-
nen mit einem Rechtsklick das Kontextmenü und rufen darin den Befehl Diagrammfläche: Eigenschaften
auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Diagrammfläche aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Umrandung 

Hier lässt sich das gesamte Diagramm mit einer Umrandung versehen. Wählen Sie dazu die gewünschte
Linienart. 

Wenn Sie die Option Schatten aktivieren, wird der Diagrammrahmen außerdem mit einem Schatten hin-
terlegt. Über die Schaltfläche Anpassen können Sie zusätzliche Einstellungen zum Aussehen des Schat-
teneffekts machen.

¡ Rubrik Füllung 

Hier können Sie die Füllung der Diagrammfläche ändern. Wählen Sie dazu die gewünschte Art von Fül-
lung. 

Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen klicken, erscheint ein Dialog,
über den Sie auch komplexere Füllungen (z.B. einen Farbverlauf) anbringen können. Die Bedienung die-
ses Dialogs ist im Abschnitt Objekt-Eigenschaften, Karteikarte Füllung beschrieben.

Karteikarte Schrift

Hier können Sie die Textformatierung für alle Diagrammelemente ändern.

Wählen Sie dazu die gewünschte Schriftart, Schriftgröße, Ausrichtung etc.

Wichtig: Änderungen wirken sich, wie gesagt, auf alle Diagrammelemente aus – auch wenn diese zuvor
in einer anderen Schrift formatiert waren.

Zeichnungsfläche

Als Zeichnungsfläche wird der Bereich eines Diagramms bezeichnet, in dem die Datenreihen, die Achsen
und die Gitternetzlinien gezeichnet werden.

Eigenschaften bearbeiten: Um die Eigenschaften der Zeichnungsfläche zu ändern, selektieren Sie diese, öff-
nen mit einem Rechtsklick das Kontextmenü und rufen darin den Befehl Zeichnungsfläche: Eigenschaften
auf. 
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Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Zeichnungsfläche aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Umrandung 

Hier lässt sich die Zeichnungsfläche mit einer Umrandung versehen. Wählen Sie dazu die gewünschte
Linienart. 

¡ Rubrik Füllung 

Hier können Sie die Füllung der Zeichnungsfläche ändern. Wählen Sie dazu die gewünschte Art von Fül-
lung. 

Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen klicken, erscheint ein Dialog,
über den Sie auch komplexere Füllungen (z.B. einen Farbverlauf) anbringen können. Die Bedienung die-
ses Dialogs ist im Abschnitt Objekt-Eigenschaften, Karteikarte Füllung beschrieben.

Wände (nur bei dreidimensionalen Diagrammtypen)

Als Wände bezeichnet man die rückwärtigen Wände von Diagrammen, die einen dreidimensionalen Dia-
grammtyp verwenden.

Eigenschaften bearbeiten: Um die Eigenschaften der Wände zu ändern, selektieren Sie diese, öffnen mit ei-
nem Rechtsklick das Kontextmenü und rufen darin den Befehl Wände: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Wände aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Umrandung 

Hier lassen sich die Wände mit einer Umrandung versehen. Wählen Sie dazu die gewünschte Linienart. 

¡ Rubrik Füllung 

Hier können Sie die Füllung der Wände ändern. Wählen Sie dazu die gewünschte Art von Füllung. 

Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen klicken, erscheint ein Dialog,
über den Sie auch komplexere Füllungen (z.B. einen Farbverlauf) anbringen können. Die Bedienung die-
ses Dialogs ist im Abschnitt Objekt-Eigenschaften, Karteikarte Füllung beschrieben.

Karteikarte 3D-Ansicht

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informationen dazu finden Sie im Ab-
schnitt Diagrammeigenschaften, Karteikarte 3D-Ansicht.
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Bodenfläche (nur bei dreidimensionalen Diagrammtypen)

Als Bodenfläche bezeichnet man den Boden von Diagrammen, die einen dreidimensionalen Diagrammtyp
verwenden.

Eigenschaften bearbeiten: Um die Eigenschaften der Bodenfläche zu ändern, selektieren Sie diese, öffnen mit
einem Rechtsklick das Kontextmenü und rufen darin den Befehl Bodenfläche: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Bodenfläche aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Umrandung 

Hier lässt sich die Bodenfläche mit einer Umrandung versehen. Wählen Sie dazu die gewünschte Linien-
art. 

¡ Rubrik Füllung 

Hier können Sie die Füllung der Bodenfläche ändern. Wählen Sie dazu die gewünschte Art von Füllung. 

Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen klicken, erscheint ein Dialog,
über den Sie auch komplexere Füllungen (z.B. einen Farbverlauf) anbringen können. Die Bedienung die-
ses Dialogs ist im Abschnitt Objekt-Eigenschaften, Karteikarte Füllung beschrieben.

Karteikarte 3D-Ansicht

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informationen dazu finden Sie im Ab-
schnitt Diagrammeigenschaften, Karteikarte 3D-Ansicht.

Ecken (nur bei dreidimensionalen Diagrammtypen)

Als Ecken bezeichnet man sämtliche Ecken von Diagrammen, die einen dreidimensionalen Diagrammtyp
verwenden.

Eigenschaften bearbeiten: Um die Eigenschaften der Ecken zu ändern, selektieren Sie diese, öffnen mit ei-
nem Rechtsklick das Kontextmenü und rufen darin den Befehl Ecken: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste aufrufen.

Es lassen sich folgende Einstellungen vornehmen:
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Karteikarte 3D-Ansicht

Hier können Sie den 3D-Effekt für das gesamte Diagramm einstellen. Informationen dazu finden Sie im Ab-
schnitt Diagrammeigenschaften, Karteikarte 3D-Ansicht.

Datenreihen und Datenpunkte

Die Datenreihen sind die wichtigsten Bestandteile eines Diagramms. Sie stellen die auszuwertenden Daten
dar – je nach gewähltem Diagrammtyp in Form von Säulen, Balken, Linien, Kreissegmenten etc.

Eine Datenreihe ist die grafische Repräsentation von einer Spalte beziehungsweise einer Zeile der Zellwer-
te, auf denen das Diagramm basiert. Jede Datenreihe besteht wiederum aus mehreren Datenpunkten, also
den einzelnen Zellwerten.

Eigenschaften bearbeiten: Um die Eigenschaften von Datenreihen und -punkten zu ändern, gehen Sie wie
folgt vor:

¡ Klicken Sie auf einen beliebigen Datenpunkt einer Datenreihe, wird zunächst die gesamte Datenreihe se-
lektiert. Mit dem Befehl Reihe: Eigenschaften im Kontextmenü können Sie nun die Eigenschaften die-
ser Datenreihe bearbeiten. 

¡ Klicken Sie den Datenpunkt jedoch erneut an, wird nur der einzelne Datenpunkt selektiert. Der Befehl
im Kontextmenü heißt dann dementsprechend Datenpunkt: Eigenschaften.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Umrandung (beziehungsweise Linie) 

Hier lässt sich das Aussehen der Linien ändern, mit denen die Daten gezeichnet werden. 

Wenn Sie dabei die Option Schatten aktivieren, wird der Graph außerdem mit einem Schatten hinterlegt.
Über die Schaltfläche Anpassen können Sie weitere Einstellungen zum Aussehen des Schatteneffekts
machen.

¡ Rubrik Füllung 

Hier können Sie die Füllung der Datenreihen/Datenpunkte ändern. Wählen Sie dazu die gewünschte Art
von Füllung. 

Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen klicken, erscheint ein Dialog,
über den Sie auch komplexere Füllungen (z.B. einen Farbverlauf) anbringen können. Die Bedienung die-
ses Dialogs ist im Abschnitt Objekt-Eigenschaften, Karteikarte Füllung beschrieben.

¡ Rubrik Markierung (nur bei bestimmten Diagrammtypen verfügbar) 

Bei Diagrammtypen, bei denen für die einzelnen Datenpunkte Markierungen gezeichnet werden, können
Sie hier das Aussehen dieser Markierungen anpassen.

Karteikarte 3D-Format

Hinweis: Die Optionen auf dieser Karteikarte sind nicht bei allen Diagrammtypen verfügbar. 
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Mit Hilfe dieser Karteikarte können Sie die darzustellenden Datenpunkte mit Beleuchtungseffekten und ab-
gerundeten Kanten versehen.

¡ Material 

Hier können Sie das Material wählen, das für die Darstellung der Datenpunkte simuliert werden soll.

¡ Beleuchtung 

Hier können Sie auswählen, welche Art von Beleuchtung simuliert werden soll.

¡ Drehwinkel 

Hier lässt sich der Winkel ändern, in dem das Licht einfallen soll.

Tipp: Obige Effekte kommen besser zur Geltung, wenn Sie zusätzlich die nachfolgenden Optionen
zum Abrunden der Kanten einsetzen.

¡ Rubrik Abgeschrägte Kanten 

Hier können Sie die Kanten der grafischen Repräsentation der Datenpunkte abrunden lassen. Wenden
Sie diese Optionen beispielsweise auf ein Balkendiagramm an, werden die Kanten der Balken abgerun-
det. Je größer der Wert, desto stärker die Abrundung.

Karteikarte Datenbeschriftungen

Auf dieser Karteikarte können Sie Datenpunkte mit Beschriftungen versehen, also beispielsweise den ge-
nauen Wert der Datenpunkte im Diagramm anzeigen lassen.

¡ Rubrik Anzeige 

Hier können Sie die Art der Beschriftung wählen. Voreingestellt ist die Option Keine, es wird also keine
Beschriftung angezeigt. Wählen Sie beispielsweise die Option Wert anzeigen, wird der Wert der betref-
fenden Datenpunkte angezeigt, bei der Option Datenpunkt anzeigen sein Name etc.

¡ Legendensymbol bei Beschriftung 

Wenn Sie diese Option aktivieren, werden vor den Beschriftungen die Legendensymbole der betreffen-
den Datenpunkte angezeigt – in der Regel also ein Kästchen in der Farbe des Datenpunkts.

¡ Rubrik Platzierung 

Hier können Sie bestimmen, wo die Beschriftung platziert werden soll (relativ zum jeweiligen Daten-
punkt).

Hinweis: Wenn Sie Datenpunkte mit einer Beschriftung versehen, sind diese Beschriftungen selbst eben-
falls im Diagramm anklickbar. Sie können also deren Eigenschaften verändern und beispielsweise eine an-
dere Schriftart wählen oder den anzuzeigenden Text ändern. 

Auch hier gilt: 1x anklicken selektiert alle Beschriftungen einer Datenreihe, nochmals anklicken selektiert
eine einzelne Beschriftung.

Karteikarte Fehlerindikator Y

Hinweis: Diese Karteikarte ist nur bei bestimmten zweidimensionalen Diagrammtypen (u.a. Säulen-,
Balken und Liniendiagrammen) verfügbar.
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Mit Hilfe dieser Karteikarte können Sie Fehlerindikatoren für die Datenpunkte einer Datenreihe zeichnen
lassen. Diese stellen den möglichen/zulässigen Fehler der Werte in Form einer Linie mit einem Querstrich
am Ende dar.

Diagramm mit Fehlerindikatoren "Plus" und "Minus"

Bestimmen Sie dazu in der Rubrik Anzeige, welche Art von Indikatoren angezeigt werden sollen: Plus
zeichnet eine Indikatorlinie nach oben, Minus nach unten, Plus und Minus zeichnet beide Linien.

Mit Anzeigen als... können Sie das Aussehen der Indikatorlinien bestimmen: mit oder ohne Querstrich am
Ende.

In der Rubrik Wert können Sie die Länge der Indikatorlinie ändern. Wählen Sie beispielsweise die Option
Fest, hat die Linie immer die angegebene Länge, bei der Option Prozentual entspricht ihre Länge dem an-
gegebenen prozentualen Anteil vom jeweiligen Y-Wert etc.

Karteikarte Fehlerindikator X

Hinweis: Diese Karteikarte ist nur bei XY-Punkt- und Blasendiagrammen verfügbar.

Entspricht Fehlerindikator Y (siehe oben), zeichnet jedoch Indikatorlinien für die X-Werte statt der Y-Wer-
te.

Karteikarte Hilfslinien

Hinweis: Diese Karteikarte ist nur bei bestimmten zweidimensionalen Diagrammtypen (u.a. Säulen-,
Balken und Liniendiagrammen) verfügbar.

Mit Hilfe dieser Karteikarte können Sie verschiedene Hilfslinien im Diagramm einblenden lassen. Schalten
Sie beispielsweise die Hilfslinie Durchschnitt ein, erscheint im Diagramm eine gestrichelte Linie, die an-
zeigt, wo der Durchschnitt der Werte dieser Datenreihe liegt.

Sie können Hilfslinien für Durchschnitt, Standardabweichung und Minimum/Maximum sowie eine
Ausgleichsgerade (linearer Trend) aktivieren. 

Tipp: Über den Menübefehl Objekt > Diagramm > Trendlinie hinzufügen lassen sich bei Bedarf noch
weitere Arten von Trendlinien im Diagramm einblenden. Siehe dazu Abschnitt Trendlinien.

Karteikarte Optionen

Auf dieser Karteikarte erscheinen je nach Diagrammtyp unterschiedliche Optionen zur Darstellung der Da-
tenreihen/Datenpunkte.
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Trendlinien

Hinweis: Trendlinien können nur in bestimmten zweidimensionalen Diagrammtypen (u.a. Säulen-, Bal-
ken und Liniendiagrammen) verwendet werden.

Sie können auf Wunsch zu jeder Datenreihe des Diagramms eine Trendlinie einblenden lassen. 

Eine Trendlinie stellt den Trend der Datenreihe grafisch dar, zeigt also beispielsweise an, in welchem Maße
die Werte im Mittel steigen/fallen. Sie können Trendlinien auch über die vorhandenen Daten hinaus verlän-
gern lassen und so beispielsweise eine Prognose für zukünftige Werte erhalten.

Die Position und Steigung der Trendlinie wird dabei mit Hilfe eines Regressionsverfahrens ermittelt.

Trendlinie hinzufügen: Um einer Datenreihe eine Trendlinie hinzuzufügen, selektieren Sie diese Datenreihe,
öffnen mit einem Rechtsklick das Kontextmenü und rufen darin den Befehl Trendlinie hinzufügen auf.

Tipp: Alternativ können Sie auch auf das Symbol  in der Diagrammleiste klicken oder den Menü-
befehl Objekt > Diagramm > Trendlinie hinzufügen aufrufen.

Trendlinie entfernen: Um eine Trendlinie wieder zu entfernen, selektieren Sie diese und drücken die Taste
Entf.

Eigenschaften bearbeiten: Um die Eigenschaften einer Trendlinie zu ändern, selektieren Sie diese, öffnen mit
einem Rechtsklick das Kontextmenü und rufen darin den Befehl Trendlinie: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Trendlinie aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Linie 

Hier lässt sich das Aussehen der Linie ändern. 

Karteikarte Trend

¡ Rubrik Typ 

Hier können Sie den Typ des darzustellenden Trends wählen. Neben linearen Trends (also einfachen
Ausgleichsgeraden) lassen sich beispielsweise auch exponentielle oder polynomische Trends darstellen.

Für die einzelnen Arten von Trends werden folgende Formeln verwendet:

Linear: y = ax + b

Polynomisch: y = b + c1x + c2x2 + c3x3 + ... + c6x6

Exponentiell: y = cebx   (e = Eulersche Zahl)
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Logarithmisch: y = c ln(x) + b

Potentiell: y = cxb

Gleitender Durchschnitt: f(xi) = (xi + xi-1 + xi-2 + ... + xi-n+1) / n

¡ Basiert auf Reihe 

Hier können Sie festlegen, für welche Datenreihe die Trendlinie gezeichnet werden soll.

¡ Rubrik Trend 

Hier können Sie die Trendlinie über die vorhandenen Datenpunkte hinaus verlängern.

Sind beispielsweise 3 Datenpunkte vorhanden (zum Beispiel die Verkaufsergebnisse für das 1., 2. und 3.
Jahr), können Sie bei Vorwärts eine 1 eingeben. Die Linie wird dann um eine zusätzliche Periode (=
einen Datenpunkt) verlängert, zeigt also eine Prognose für die Verkäufe im 4. Jahr an.

¡ Schnittpunkt 

Hier können Sie erzwingen, dass die Trendlinie die Y-Achse bei einer bestimmten y-Koordinate schnei-
den soll. Nur bei bestimmten Arten von Trendlinien verfügbar.

¡ Formel im Diagramm anzeigen 

Blendet im Diagramm die Gleichung an, auf der die Trendlinie basiert.

¡ Korrelationsmaß anzeigen 

Blendet im Diagramm das Korrelationsmaß (Bestimmtheitsmaß) R2 ein.

¡ Rubrik Name 

Hier können Sie auf Wunsch den Namen der Trendlinie ändern. Dieser wird in der Legende angezeigt.
Wählen Sie dazu die Option Benutzerdefiniert und tragen Sie den gewünschten Namen ein.

Rubrikenachse (X-Achse)

Die X-Achse eines Diagramms wird auch als Rubrikenachse bezeichnet.

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Diagramm, rufen den
Menübefehl Objekt > Eigenschaften auf und wechseln auf die Karteikarte Elemente. Klicken Sie nun auf
das Kontrollkästchen vor X-Achse, um beispielsweise die Anzeige der Rubrikenachse ein- oder auszuschal-
ten.

Eigenschaften bearbeiten: Um die Eigenschaften der Rubrikenachse zu ändern, selektieren Sie diese, öffnen
mit einem Rechtsklick das Kontextmenü und rufen darin den Befehl Rubrikenachse: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Achse aufrufen.

Es lassen sich folgende Einstellungen vornehmen:
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Karteikarte Format

¡ Rubrik Linie 

Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet wird.

¡ Rubriken Hauptstriche und Hilfsstriche 

Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche angezeigt werden sollen und
wie diese aussehen sollen.

¡ Rubrik Strichbeschriftungen 

Hier können Sie bestimmen, ob bei den Teilstrichen Beschriftungen angezeigt werden sollen und wo die-
se platziert werden sollen.

Karteikarte Skalierung

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern.

Erläuterung: Unter den Rubriken eines Diagramm versteht man jeweils den ersten, zweiten, dritten etc.
Datenpunkt aller Datenreihen.

¡ Rubrik Achse endet... 

Diese Option bestimmt, wo die beiden Enden des sichtbaren Abschnitts der Achse liegen sollen: Bei den
Rubriken oder Zwischen den Rubriken.

¡ Rubrik Anzahl der Rubriken zwischen... 

Standardmäßig macht PlanMaker bei jeder Rubrik einen Teilstrich auf der Achse und versieht diesen mit
einer Beschriftung. Über folgende Optionen können Sie diese Intervalle ändern:

Teilstrichen: Bestimmt, welche Rubriken mit einem Teilstrich versehen werden. Geben Sie 1 ein, wird
jede Rubrik mit einem Teilstrich versehen, bei 2 jede zweite etc. 

Teilstrichbeschriftungen: Bestimmt, welche Teilstriche beschriftet werden sollen. Geben Sie 1 ein,
wird jeder Teilstrich beschriftet, bei 2 jeder zweite Teilstrich etc.

¡ Rubrik Schnittpunkt zwischen X- und Y-Achse 

Mit dieser Option können Sie bestimmen, wo der Schnittpunkt zwischen X-Achse (Rubrikenachse) und
Y-Achse (Größenachse) liegen soll: Am unteren Ende (also am Beginn der Rubrikenachse), Am obe-
ren Ende (also am Ende der Rubrikenachse) oder bei einer bestimmten Rubrik.

¡ Achse in umgekehrter Richtung 

Wird diese Option aktiviert, läuft die Achse in umgekehrter Richtung. Dementsprechend wird auch die
Reihenfolge der Rubriken umgekehrt; das Diagramm beginnt also mit der letzten Rubrik und endet mit
der ersten Rubrik.

Karteikarte Schrift

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse ändern.

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Ausrichtung einstellen, die Be-
schriftungen drehen lassen und das Zahlenformat ändern.
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Größenachse (Y-Achse)

Die Y-Achse eines Diagramms wird auch als Größenachse bezeichnet.

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Diagramm, rufen den
Menübefehl Objekt > Eigenschaften auf und wechseln auf die Karteikarte Elemente. Klicken Sie nun auf
das Kontrollkästchen vor Y-Achse, um beispielsweise die Anzeige der Größenachse ein- oder auszuschal-
ten.

Eigenschaften bearbeiten: Um die Eigenschaften der Größenachse zu ändern, selektieren Sie diese, öffnen
mit einem Rechtsklick das Kontextmenü und rufen darin den Befehl Größenachse: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Achse aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Linie 

Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet wird.

¡ Rubriken Hauptstriche und Hilfsstriche 

Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche angezeigt werden sollen und
wie diese aussehen sollen.

¡ Rubrik Strichbeschriftungen 

Hier können Sie bestimmen, ob Achsenbeschriftungen angezeigt werden sollen und wo diese platziert
werden sollen.

Karteikarte Skalierung

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern.

¡ Rubriken Minimalwert und Maximalwert 

Diese Optionen bestimmen, wo der sichtbare Ausschnitt der Achse beginnen und wo er enden soll. Wäh-
len Sie entweder die Option Auto, worauf PlanMaker die geeignetsten Werte automatisch ermittelt oder
wählen Sie Benutzerdefiniert und geben den gewünschten Wert selbst ein.

¡ Rubrik Schnittpunkt zwischen X- und Y-Achse 

Mit dieser Option können Sie bestimmen, wo der Schnittpunkt zwischen X-Achse (Rubrikenachse) und
Y-Achse (Größenachse) liegen soll: 

Bei Auto ermittelt PlanMaker den geeignetsten Wert automatisch, bei Maximaler Wert wird die X-
Achse am Ende der Y-Achse platziert, bei Benutzerdefiniert bei dem von Ihnen angegebenen Y-Wert.

¡ Rubrik Hauptintervall 

Hier können Sie das Intervall für die Teilstriche und Beschriftungen auf der Achse festlegen. Bei der Op-
tion Auto ermittelt PlanMaker die geeignetsten Werte automatisch.
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¡ Rubrik Hilfsintervall 

Hier können Sie das Intervall für die Hilfsstriche auf der Achse festlegen. Bei der Option Auto ermittelt
PlanMaker die geeignetsten Werte automatisch.

¡ Achse in umgekehrter Richtung 

Wenn Sie diese Option aktivieren, läuft die Achse in umgekehrter Richtung. Bei einem Säulendiagramm
werden die Säulen also beispielsweise nicht mehr von unten nach oben, sondern von oben nach unten ge-
zeichnet.

¡ Logarithmische Skalierung 

Wenn Sie diese Option aktivieren, wird die Achse nicht mehr linear, sondern logarithmisch (also in Zeh-
nerpotenzen, z.B. 10, 100, 1000 etc.) eingeteilt.

Karteikarte Schrift

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse ändern.

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Ausrichtung einstellen, die Be-
schriftungen drehen lassen und das Zahlenformat ändern.

Reihenachse (Z-Achse)

Die Z-Achse eines Diagramms wird auch als Reihenachse bezeichnet. Sie ist nur bei bestimmten dreidimen-
sionalen Diagrammtypen vorhanden.

Achsen ein-/ausblenden: Um Achsen ein- oder auszublenden, selektieren Sie das Diagramm, rufen den
Menübefehl Objekt > Eigenschaften auf und wechseln auf die Karteikarte Elemente. Klicken Sie nun auf
das Kontrollkästchen vor Z-Achse, um beispielsweise die Anzeige der Reihenachse ein- oder auszuschalten.

Eigenschaften bearbeiten: Um die Eigenschaften der Reihenachse zu ändern, selektieren Sie diese, öffnen mit
einem Rechtsklick das Kontextmenü und rufen darin den Befehl Reihenachse: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Achse aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Linie 

Hier können Sie das Aussehen der Linie ändern, mit der die Achse gezeichnet wird.

¡ Rubriken Hauptstriche und Hilfsstriche 

Hier können Sie bestimmen, ob zur Einteilung der Achse kleine Teilstriche angezeigt werden sollen und
wie diese aussehen sollen.

¡ Rubrik Strichbeschriftungen 

Hier können Sie bestimmen, ob bei den Teilstrichen Beschriftungen angezeigt werden sollen und wo die-
se platziert werden sollen.
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Karteikarte Skalierung

Auf dieser Karteikarte können Sie die Skalierung der Achse ändern.

¡ Rubrik Anzahl der Reihen zwischen... 

Standardmäßig macht PlanMaker bei jeder Datenreihe einen Teilstrich auf der Achse und versieht diesen
mit einer Beschriftung. Über folgende Optionen können Sie diese Intervalle ändern:

Teilstrichen: Bestimmt, welche Datenreihen mit einem Teilstrich versehen werden. Geben Sie 1 ein,
wird jede Reihe mit einem Teilstrich versehen, bei 2 jede zweite etc. 

Teilstrichbeschriftungen: Bestimmt, welche Teilstriche beschriftet werden sollen. Geben Sie 1 ein,
wird jeder Teilstrich beschriftet, bei 2 jeder zweite Teilstrich etc.

¡ Achse in umgekehrter Richtung 

Wird diese Option aktiviert, läuft die Achse in umgekehrter Richtung. Dementsprechend wird auch die
Reihenfolge der Datenreihen umgekehrt; das Diagramm beginnt also mit der letzten Reihe und endet mit
der ersten Reihe.

Karteikarte Schrift

Auf dieser Karteikarte können Sie die Formatierung der Beschriftungen der Achse ändern.

Neben Schriftart, Schriftgröße und Textauszeichnungen können Sie auch die Ausrichtung einstellen, die Be-
schriftungen drehen lassen und das Zahlenformat ändern.

Gitternetzlinien

Sie können zum besseren Ablesen der Werte in einem Diagramm Gitternetzlinien einblenden lassen. Unter
Gitternetzlinien versteht man ein Netz aus Linien, die – ausgehend von einer der Achsen des Diagramms –
über die Zeichnungsfläche laufen.

Es gibt folgende Arten von Gitternetzen:

¡ Das Hauptgitternetz besteht aus Linien, die jeweils von den Teilstrichen auf der Achse ausgehen. 

¡ Das Hilfsgitternetz unterteilt das Hauptgitternetz bei Bedarf in ein noch feineres Gitternetz.

Gitternetzlinien ein-/ausblenden: Sie können Gitternetzlinien für jede Achse getrennt einschalten. Selektieren
Sie dazu das Diagramm, rufen Sie den Menübefehl Objekt > Eigenschaften auf, wechseln Sie auf die Kar-
teikarte Elemente und schalten Sie bei den gewünschten Achsen die Option Hauptgitternetz und/oder
Hilfsgitternetz ein.

Tipp: Alternativ können Sie auch die beiden Symbole  in der Diagrammleiste oder die Menü-
befehle Objekt > Diagramm > Vertikale Gitternetzlinien anzeigen beziehungsweise Horizontale Git-
ternetzlinien anzeigen verwenden, um Gitternetzlinien ein-/auszuschalten.

Eigenschaften bearbeiten: Um beispielsweise die Eigenschaften der Hauptgitternetzlinien der Größenachse
zu ändern, selektieren Sie eine dieser Linien, öffnen mit einem Rechtsklick das Kontextmenü und rufen dar-
in den Befehl Hauptgitternetz des Größenachse: Eigenschaften auf. 
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Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Linie 

Hier können Sie das Aussehen der Gitternetzlinien anpassen.

Skalierung der Gitternetzlinien ändern

Um die Abstände zwischen den Gitternetzlinien zu ändern, selektieren Sie die zugehörige Achse, rufen de-
ren Eigenschaften auf und nehmen die gewünschten Änderungen auf der Karteikarte Skalierung vor.

Legende

Auf Wunsch können Sie im Diagramm eine Legende einblenden. Dies ist ein kleiner Kasten, in dem ange-
zeigt wird, welche Datenreihen in welcher Farbe/Musterung dargestellt werden.

Legende ein-/ausblenden: Selektieren Sie das Diagramm, rufen Sie den Menübefehl Objekt > Eigenschaf-
ten auf und wechseln Sie auf die Karteikarte Elemente. Nun können Sie über die Option Legende bestim-
men, wo die Legende positioniert werden soll. Wenn Sie die Option Benutzerdefiniert wählen, lässt sich
die Legende frei mit der Maus verschieben. Wählen Sie die Option Keine, wird keine Legende mehr ange-
zeigt.

Tipp: Alternativ können Sie die Legende auch über das Symbol  in der Diagrammleiste oder über den
Menübefehl Objekt > Diagramm > Legende anzeigen ein-/ausschalten.

Eigenschaften bearbeiten: Um die Eigenschaften der Legende zu ändern, selektieren Sie diese, öffnen mit ei-
nem Rechtsklick das Kontextmenü und rufen darin den Befehl Diagrammfläche: Eigenschaften auf. 

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste oder per
Doppelklick auf die Legende aufrufen.

Es lassen sich folgende Einstellungen vornehmen:

Karteikarte Format

¡ Rubrik Umrandung 

Hier lässt sich die Linienart für die Umrandung der Legende ändern.

Wenn Sie die Option Schatten aktivieren, wird die Legende zusätzlich mit einem Schatten hinterlegt. 

¡ Rubrik Füllung 

Hier können Sie die Füllung der Legende ändern. Wählen Sie dazu die gewünschte Art von Füllung. 
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Wenn Sie die Füllart Effekte wählen und auf die Schaltfläche Anpassen klicken, erscheint ein Dialog,
über den Sie auch komplexere Füllungen (z.B. einen Farbverlauf) anbringen können. Die Bedienung die-
ses Dialogs ist im Abschnitt Objekt-Eigenschaften, Karteikarte Füllung beschrieben.

Karteikarte Schrift

Auf dieser Karteikarte können Sie das Zeichenformat für die Legende wählen (Schriftart, Schriftgröße und
Textauszeichnungen).

Karteikarte Legende

Hier können Sie bestimmen, an welcher Position die Legende angezeigt werden soll.

Wenn Sie die Option Benutzerdefiniert wählen, lässt sich die Legende nach Belieben mit der Maus ver-
schieben. 

Wenn Sie Keine wählen, wird die Legende ausgeblendet.

Diagrammeigenschaften ändern

In den vorherigen Abschnitten wurde beschrieben, wie sie die Eigenschaften einzelner Elemente eines Dia-
gramms bearbeiten. In diesem Abschnitt geht es um die Eigenschaften des Diagrammrahmens selbst. 

Um die Eigenschaften eines Diagramms zu ändern, selektieren Sie das Diagramm per Mausklick und rufen
den Menübefehl Objekt > Eigenschaften auf.

Tipp: Alternativ können Sie diesen Befehl auch über das Symbol  in der Diagrammleiste aufrufen.

Welche Einstellungen sich hier vornehmen lassen, erfahren Sie auf den nächsten Seiten.

Diagrammeigenschaften, Karteikarte Format

Auf der Karteikarte Format können Sie die Größe und Position des Diagramms ändern.

Siehe dazu Abschnitt Objekt-Eigenschaften, Karteikarte Format.

Diagrammeigenschaften, Karteikarte Eigenschaften

Auf der Karteikarte Eigenschaften können Sie allgemeine Einstellungen für das Diagramm ändern. 

Siehe dazu Abschnitt Objekt-Eigenschaften, Karteikarte Eigenschaften.



281Diagramme

Diagrammeigenschaften, Karteikarte Diagrammtyp

Auf der Karteikarte Diagrammtyp können Sie den Diagrammtyp ändern:

Wählen Sie zunächst links den gewünschten Diagrammtyp und dann rechts den gewünschten Untertyp.

Informationen zu den verfügbaren Diagrammtypen finden Sie im Abschnitt Diagrammtyp ändern.

Diagrammeigenschaften, Karteikarte Datenquelle

Auf der Karteikarte Datenquelle können Sie Einstellungen zu dem Datenbereich vornehmen, auf dem das
Diagramm basiert:

¡ Datenbereich 

Hier können Sie festlegen, welchen Zellbereich der Tabelle das Diagramm darstellen soll. Standardmä-
ßig wird der Zellbereich verwendet, den Sie beim Erstellen des Diagramms markiert hatten. Normaler-
weise müssen Sie hier also nichts ändern.

¡ Rubrik Anordnung der Daten 

Hier können Sie festlegen, ob der gewählte Datenbereich im Diagramm spaltenweise oder zeilenweise
dargestellt werden soll. Siehe auch Abschnitt Anordnung der Datenreihen ändern.

¡ Rubrik Datenbereich enthält 

Hier können Sie angeben, welche Arten von Daten der Datenbereich enthält.

Tipp: Besteht die oberste Zeile des Datenbereichs aus Überschriften (für die jeweils darunter liegenden
Werte), so sollte die Option Namen eingeschaltet werden. PlanMaker beschriftet die Datenreihen im
Diagramm dann automatisch mit diesen Überschriften.

¡ Auch verborgene Zellen verwenden 

Wenn der Datenbereich Zellen enthält, die verborgen wurden, werden diese normalerweise nicht im Dia-
gramm dargestellt. Schalten Sie diese Option ein, wenn Sie möchten, dass auch verborgene Zellen darge-
stellt werden sollen.

Diagrammeigenschaften, Karteikarte Datenreihen

Die Datenreihen sind die wichtigsten Bestandteile eines Diagramms. Sie stellen die auszuwertenden Daten
dar – je nach gewähltem Diagrammtyp in Form von Säulen, Balken, Linien etc.

Auf der Karteikarte Datenreihen können Sie Einstellungen zu den einzelnen Datenreihen eines Diagramms
vornehmen. 

Wählen Sie zunächst in der Liste Datenreihen die Datenreihe aus, deren Einstellungen Sie verändern
möchten. Nehmen Sie dann die gewünschten Einstellungen vor:
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¡ Datenreihen 

In der Liste Datenreihen sind alle Datenreihen aufgelistet, die das Diagramm momentan enthält. 

Mit Hilfe der Pfeil-Schaltflächen rechts der Liste können Sie die Reihenfolge der Datenreihen bei Be-
darf ändern. 

Mit den Schaltflächen Hinzufügen und Löschen können Sie Datenreihen hinzufügen beziehungswei-
se entfernen.

¡ Rubrik Datenquellen 

Hier lässt sich festlegen, welche Daten die gewählte Datenreihe darstellen soll. 

Die Felder in dieser Rubrik werden automatisch ausgefüllt (anhand des Zellbereichs, den Sie vor dem
Einfügen des Diagramms markiert hatten). Normalerweise müssen Sie sich um diese Einstellungen also
überhaupt nicht kümmern.

Folgende Felder gibt es hier:

Name: Hier lässt sich der Name der Datenreihe festlegen. Dies kann ein Zellbezug auf eine Zelle sein,
die den Namen enthält, oder einfach ein fest eingetragener Text. Dieses Feld kann auch leer gelassen
werden, worauf die Datenreihe einen automatisch erzeugten Namen erhält (z.B. "Reihe 1", "Reihe 2"
etc.).

Y-Werte: Hier lässt sich bestimmen, aus welchem Zellbereich die Datenreihe die Y-Werte für die Da-
tenpunkte beziehen soll.

Erläuterung: Bei den meisten Diagrammtypen sind die Y-Werte die Werte, die in dem Diagramm dar-
gestellt werden sollen. Sie bestimmen also beispielsweise die Höhe der Säule, die gezeichnet wird. 

X-Werte: Analog zur Option Y-Werte lässt sich hier bestimmen, aus welchem Zellbereich die X-Werte
für die Datenreihe stammen sollen.

Erläuterung: Bei den meisten Diagrammtypen sind die X-Werte irrelevant und auf "Auto" (also auto-
matisch) gesetzt, da sie lediglich zur Beschriftung der Rubrikenachse (X-Achse) dienen. Eine Aus-
nahme hiervon bilden z.B. XY-Punktdiagramme und Blasendiagramme: hier bestimmen die X- und
Y-Werte die Koordinaten der Datenpunkte.

Blasengrößen: Bei Blasendiagrammen gibt es neben X- und Y-Werten noch einen dritten Parameter: die
Größe der Blasen für die einzelnen Datenpunkte. Geben Sie dazu einen Zellbezug auf die Zellen ein, die
diese Werte enthalten. Wird dieses Feld leer gelassen, werden alle Blasen in der gleichen Größe gezeich-
net.

¡ Rubrik Diese Datenreihe darstellen als 

Hier können Sie festlegen, wie die Datenreihe dargestellt werden soll. Haben Sie als Diagrammtyp bei-
spielsweise ein Säulendiagramm gewählt, möchten aber, dass eine bestimmte Datenreihe darin als Lini-
endiagramm dargestellt wird, so wählen Sie für diese Datenreihe die Option Linien.

¡ Sekundäre Achse für diese Datenreihe 

Aktivieren Sie diese Option, wird dem Diagramm für diese Datenreihe eine sekundäre Größenachse (Y-
Achse) hinzugefügt. Die sekundäre Größenachse kann einen anderen Maßstab als die primäre Größen-
achse haben.

Erläuterung: Das Darstellen von bestimmten Datenreihen auf einer sekundären Achse ist sinnvoll,
wenn diese Datenreihen eine Achse mit einem völlig anderen Maßstab benötigen, da sie beispielswei-
se erheblich größere Werte enthalten als die anderen Datenreihen.
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Diagrammeigenschaften, Karteikarte Elemente

Auf der Karteikarte Elemente können Sie die verschiedenen Diagrammelemente ein-/ausblenden und be-
schriften:

¡ Diagrammtitel 

Hier können Sie dem Diagramm einen Titel geben. Dieser wird dann oberhalb des Diagramms angezeigt.

¡ Rubrik Primäre Achsen 

Hier können Sie Einstellungen zu den primären Achsen vornehmen:

Mit dem Kontrollkästchen vor der jeweiligen Achse können Sie die Anzeige dieser Achse ein-/ausschal-
ten.

Rechts daneben können Sie der Achse einen Namen geben. Dieser wird unterhalb/neben der Achse ange-
zeigt.

Die Optionen Hauptgitternetz und Hilfsgitternetz bestimmen, ob Gitternetzlinien im Hintergrund des
Diagramms angezeigt werden sollen. Diese erleichtern das Ablesen der Werte. Weitere Informationen
dazu finden Sie im Abschnitt Gitternetzlinien.

¡ Rubrik Sekundäre Achsen 

Sofern das Diagramm über sekundäre Achsen verfügt, können Sie diese hier, analog zu den primären
Achsen (siehe oben), konfigurieren.

¡ Legende 

Hier können Sie die Position der Legende bestimmen. Dies ist ein kleiner Kasten, in dem angezeigt wird,
welche Datenreihe in welcher Farbe/Musterung dargestellt wird. Weitere Informationen dazu finden Sie
im Abschnitt Legende.

Diagrammeigenschaften, Karteikarte 3D-Ansicht

Hinweis: Diese Karteikarte erscheint nur bei dreidimensionalen Diagrammtypen.

Auf der Karteikarte 3D-Ansicht können Sie (bei dreidimensionalen Diagrammtypen) den 3D-Effekt für das
Diagramm verändern.

¡ Drehwinkel und Betrachtungswinkel 

Hier können Sie den Blickwinkel (in Grad) einstellen, von dem aus der Betrachter das Diagramm sieht.
Drehwinkel dreht den Betrachter um die vertikale Achse, Betrachtungswinkel um die horizontale Ach-
se.

¡ Perspektive 

Ist diese Option aktiviert, wird das Diagramm perspektivisch verzerrt. Daneben können Sie die Stärke
der Verzerrung angeben (von 0 bis 100%).

¡ Höhe und Tiefe 

Hier können Sie die Höhe und Tiefe des Diagramms (in Prozent der Originalmaße) ändern.
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Diagrammeigenschaften, Karteikarte Netz

Hinweis: Diese Karteikarte erscheint nur bei Netzdiagrammen.

Auf der Karteikarte Netz können Sie (bei Netzdiagrammen) zusätzliche Einstellungen zur Darstellung des
Diagramms vornehmen.

¡ Startwinkel 

Rotiert das Diagramm um den angegebenen Winkel.

¡ Orientierung 

Bestimmt, ob die Werte im Uhrzeigersinn oder gegen den Uhrzeigersinn eingezeichnet werden sollen.

¡ Netz abrunden 

Zeichnet das Diagramm nicht mit Linien sondern mit Kreissegmenten zwischen den Achsen.

¡ Polarkoordinaten 

Verwendet Polarkoordinaten statt kartesischer Koordinaten. Nur verfügbar, wenn Netz abrunden (siehe
oben) aktiviert ist.

Setzen Sie dabei den Winkel zwischen Achsen auf x, wird alle x Grad eine Achse eingezeichnet.

Setzen Sie den Winkel zwischen Achsenbeschriftungen auf x, wird alle x Grad eine Achsenbeschrif-
tung eingezeichnet.

¡ Zeichnungsfläche auf Netzform begrenzen 

Ist diese Option aktiviert, wird nur die Fläche innerhalb des Netzes mit der Füllung der Zeichnungsflä-
che gefüllt. Ist sie deaktiviert, wird das gesamte Rechteck um das Netz herum gefüllt.

Diagramme aktualisieren
Ein Diagramm holt sich die darzustellenden Werte stets aus den Zellen, die beim Erstellen des Diagramms
markiert waren. Ändern sich also Werte in diesen Zellen, wird das Diagramm automatisch aktualisiert und
gibt sofort die veränderten Werte wieder.

Automatische Aktualisierung von Diagrammen deaktivieren

Bei Bedarf können Sie diese automatische Aktualisierung deaktivieren. Rufen Sie dazu den Menübefehl
Datei > Eigenschaften auf, wechseln Sie auf die Karteikarte Berechnen und deaktivieren Sie die Option
Automatisch aktualisieren in der Rubrik Diagramme.

Ist diese Option abgeschaltet, werden die Diagramme im aktuellen Dokument nur dann aktualisiert, wenn
Sie den Menübefehl Weiteres > Diagramme aktualisieren aufrufen.
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Diagramme auf ein anderes Arbeitsblatt verschieben
Wenn Sie ein neues Diagramm anlegen, wird dieses stets als Objekt in das aktuelle Arbeitsblatt eingefügt.
Sie können die Position eines Diagramms aber jederzeit ändern:

Um ein Diagramm innerhalb des aktuellen Arbeitsblatts zu verschieben, klicken Sie es einfach an und zie-
hen es mit der Maus an die gewünschte Position.

Wenn Sie das Diagramm hingegen auf ein anderes Arbeitsblatt verschieben möchten, gehen Sie wie folgt
vor:

1. Selektieren Sie das gewünschte Diagramm per Mausklick.

2. Rufen Sie den Menübefehl Objekt > Diagramm > Position des Diagramms ändernauf.

3. Treffen Sie die gewünschte Wahl (siehe unten) und bestätigen Sie mit OK.

Das Diagramm wird daraufhin entsprechend verschoben.

Verfügbare Optionen:

¡ Als neues Blatt 

Wählen Sie diese Option, erhält das Diagramm sein eigenes Diagramm-Arbeitsblatt. Dazu entfernt
PlanMaker das Diagramm aus dem aktuellen Blatt, legt ein neues Diagramm-Arbeitsblatt an und fügt das
Diagramm darin ein.

Ein "Diagramm-Arbeitsblatt" ist eine besondere Art von Arbeitsblatt, das keinerlei Tabellenzellen, son-
dern ausschließlich das Diagramm in seiner vollen Größe enthält. Es stehen darin auch nur Befehle zum
Bearbeiten von Diagrammen zur Verfügung.

¡ Als Objekt in ... 

Wählen Sie hingegen diese Option, erscheint das Diagramm wie üblich als ein Objekt im gewählten Ar-
beitsblatt.

Diagramme als Grafik speichern
Sie können jederzeit ein Abbild eines Diagramms als Grafikdatei speichern. Dies erleichtert die Weitergabe
an andere und das Einfügen in Webseiten oder andere Dokumente.

Gehen Sie dazu wie folgt vor:

1. Selektieren Sie das gewünschte Diagramm per Mausklick.

2. Rufen Sie den Menübefehl Objekt > Diagramm > Als Grafik speichern auf.

3. Wählen Sie in der Liste Dateityp das gewünschte Grafikformat.

Tipp: Das PNG-Format ist hier immer eine gute Wahl, da es eine gute und dabei völlig verlustfreie Komprimierung bietet.

4. Geben Sie den Dateinamen an, unter dem die Grafik gespeichert werden soll, und bestätigen Sie mit OK.
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5. Es erscheint ein weiterer Dialog. Wählen Sie darin die gewünschte Auflösung für die Grafik oder tragen
Sie eigene Werte für die Breite und Höhe von Hand ein. Bestätigen Sie dann mit OK.

PlanMaker legt nun eine entsprechende Grafikdatei mit einem Abbild des Diagramms an. 
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Formulare
Sie können in Ihre Tabellen Formularobjekte einfügen und auf diese Weise Formulare herstellen.

Es gibt folgende Arten von Formularobjekten:

¡ Kontrollkästchen zum Ankreuzen 

¡ Optionsfelder zur Auswahl einer von mehreren Alternativen

¡ Auswahllisten zur Auswahl aus einer aufklappbaren Liste

¡ Listen zur Auswahl aus einer Liste

¡ Schaltflächen zum Anklicken

¡ Drehfelder zum Erhöhen/Reduzieren von Werten per Mausklick

¡ Bildlaufleisten zum Erhöhen/Reduzieren von Werten per Mausklick

¡ Bezeichnungen für Beschriftungen
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¡ Gruppenfelder zum optischen Zusammenfassen zusammengehörender Optionen

Formularobjekte haben stets eine Ausgabezelle. In dieser Tabellenzelle wird der Wert abgelegt, den das
Formularobjekt zurückliefert. Welche Zelle dies ist, können Sie für jedes Formularobjekt getrennt festlegen.

Fügen Sie beispielsweise eine Liste mit einigen Einträgen ein, erscheint in der Ausgabezelle eine 1, wenn
der erste Eintrag angeklickt wurde, eine 2, wenn der zweite Eintrag gewählt wurde etc.

Ausführliche Informationen zum Arbeiten mit Formularen finden Sie in diesem Kapitel. Es besteht aus fol-
genden Abschnitten:

¡ Formularobjekte verwenden 

Der erste Abschnitt enthält allgemeine Informationen zum Arbeiten mit Formularobjekten. Sie erfahren
darin, wie man Formularobjekte einfügt, bearbeitet und auswertet.

¡ Formularobjekte im Detail 

Der zweite Abschnitt befasst sich mit den einzelnen Arten von Formularobjekten im Detail.

Formularobjekte verwenden
In den nächsten Abschnitten finden Sie zunächst allgemeine Informationen zum Arbeiten mit Formularob-
jekten:

¡ Formularobjekte einfügen 

¡ Formularobjekte bearbeiten

¡ Formularobjekte bedienen und auswerten

¡ Formularobjekte und Excel-Makros und -Scripts

Danach, im Abschnitt Formularobjekte im Detail, stellen wir Ihnen die einzelnen Arten von Formularobjek-
ten ausführlich vor.

Formularobjekte einfügen

Das Einfügen von Formularobjekten unterscheidet sich nicht wesentlich vom Einfügen anderer Arten von
Objekten (siehe dazu auch Kapitel Objekte).

Um ein Formularobjekt einzufügen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Objekt > Neues Formularobjekt auf. 

2. Es öffnet sich ein Untermenü. Wählen Sie darin die gewünschte Art von Objekt.

Das Objekt wird nun eingefügt.

Weitere Informationen zu den einzelnen Arten von Formularobjekten finden Sie im Abschnitt Formularob-
jekte im Detail.
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Verwenden der Formularleiste

Sie können zum Einfügen von Formularobjekten auch die Formularleiste verwenden. Um diese ein-/auszu-
schalten, rufen Sie den Menübefehl Ansicht > Symbolleisten auf und klicken auf das Kästchen vor Formu-
lar.

Die Formularleiste enthält folgende Symbole (von links nach rechts):

¡ Textrahmen einfügen 
¡ Kontrollkästchen einfügen
¡ Optionsfeld einfügen
¡ Auswahlliste einfügen
¡ Liste einfügen
¡ Schaltfläche einfügen
¡ Drehfeld einfügen
¡ Bildlaufleiste einfügen
¡ Bezeichnung einfügen
¡ Gruppenfeld einfügen

¡ Zelle schützen ein/aus (siehe auch Abschnitt Blattschutz)
¡ Blattschutz ein/aus (siehe auch Abschnitt Blattschutz)

Tipp: Wenn Sie mit der Maus auf eines der Symbole zeigen (ohne zu klicken), erscheint ein Infotext, der
die Funktion des Symbols angibt.

Formularobjekte bearbeiten

Das Bearbeiten von Formularobjekten unterscheidet sich nicht wesentlich vom Arbeiten mit anderen Arten
von Objekten (siehe dazu Kapitel Objekte).

Einen wichtigen Unterschied gibt es allerdings:

Wichtig: Formularobjekte können nicht per Linksklick mit der Maus selektiert werden. Um ein Formu-
larobjekt zu selektieren, klicken Sie mit der rechten Maustaste darauf. 
Alternativ können Sie auch mit dem Menübefehl Ansicht > Objektmodus in den Objektmodus wech-
seln, in dem sich auch Formularobjekte per Linksklick selektieren lassen.

Wenn Sie ein Formularobjekt selektiert haben, können Sie es wie jede andere Art von Objekt bearbeiten –
also beispielsweise mit der Maus verschieben, seine Größe ändern, mit dem Menübefehl Objekt > Eigen-
schaften seine Eigenschaften modifizieren etc.

Informationen zu den Eigenschaften von Formularobjekten finden Sie im Abschnitt Formularobjekte im De-
tail.
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Formularobjekte bedienen und auswerten

Die Bedienung von Formularobjekten entspricht der von Bedienungselementen in Dialogfenstern. In Kon-
trollkästchen lässt sich beispielsweise per Mausklick ein Häkchen setzen/entfernen. In Listen kann per
Mausklick einer der Einträge ausgewählt werden etc.

Auswerten von Formularobjekten

Das Auswerten von Formularobjekten geschieht über die Ausgabezelle des Objekts. In dieser Tabellenzelle
wird der Wert ausgegeben, den das Formularobjekt zurückliefert. 

Welche Zelle dies ist, können Sie für jedes Formularobjekt getrennt festlegen: Selektieren Sie das Objekt
dazu und rufen Sie den Menübefehl Objekt > Eigenschaften auf. Wechseln Sie in dem Dialog auf die Kar-
teikarte Formularelement und tragen Sie bei Ausgabezelle die gewünschte Zelladresse ein.

Ein Beispiel: Sie haben einer Liste die Ausgabezelle D4 zugewiesen. Klicken Sie nun in der Liste den ers-
ten Eintrag an, trägt PlanMaker in der Zelle D4 eine 1 ein, klicken Sie den fünften Listeneintrag an, er-
scheint darin eine 5 etc.

Die Beziehung zwischen einem Formularobjekt und seiner Ausgabezelle ist übrigens beidseitig: Tragen Sie
also in die Ausgabezelle von Hand eine 3 ein, wird in der Liste automatisch der dritte Eintrag selektiert.

Formularobjekte und Excel-Makros und -Scripts

Microsoft Excel-Dateien können Makros und VBA-Scripts enthalten, die sich auf Formularobjekte anwen-
den lassen. Dies ist in PlanMaker nicht möglich, aber:

Wichtig: Wenn Sie in PlanMaker eine Excel-Datei öffnen, die Makros oder Scripts enthält, können diese
zwar nicht ausgeführt werden, sie bleiben aber erhalten. Wenn Sie eine solche Excel-Datei also mit
PlanMaker öffnen und bearbeiten, gehen die Makros und Scripts beim Speichern nicht verloren.

Formularobjekte im Detail
In diesem Abschnitt stellen wir Ihnen die einzelnen Arten von Formularobjekten im Detail vor. 

Folgende Objekte werden darin behandelt:
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¡ Kontrollkästchen 

¡ Optionsfelder

¡ Auswahllisten

¡ Listen

¡ Schaltflächen

¡ Drehfelder

¡ Bildlaufleisten

¡ Bezeichnungen und Gruppenfelder

Kontrollkästchen

Mit dem Menübefehl Objekt > Neues Formularobjekt > Kontrollkästchen fügen Sie ein Kontrollkäst-
chen ein. 

Kontrollkästchen können in Formularen für Ja/Nein-Angaben verwendet werden. Wird das Kästchen ange-
kreuzt, steht das für Ja; wird es nicht angekreuzt, bedeutet das Nein.

Bedienung von Kontrollkästchen

Klicken Sie das Kästchen an, um es mit einem Häkchen zu versehen – sprich: es anzukreuzen. Wenn Sie es
erneut anklicken, wird das Häkchen wieder entfernt.

Eigenschaften von Kontrollkästchen ändern

Um die Eigenschaften eines Kontrollkästchens zu ändern, selektieren Sie es (zum Beispiel durch Anklicken
mit der rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigenschaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu dem Kontrollkästchen selbst vornehmen:
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¡ Text 

Hier können Sie den Text angeben, der rechts neben dem Kästchen angezeigt werden soll.

¡ Wert 

Hier können Sie festlegen, ob das Kästchen angekreuzt sein soll oder nicht. Entspricht dem Ankreuzen
des Kästchens direkt im Dokument.

¡ Ausgabezelle 

Hier bestimmen Sie, in welcher Tabellenzelle der Zustand des Kontrollkästchens ausgegeben werden
soll. 

In dieser Zelle erscheint dann einer der folgenden Werte:

WAHR, wenn das Kontrollkästchen angekreuzt ist.

FALSCH, wenn das Kontrollkästchen nicht angekreuzt ist.

Der Fehlerwert #NV, wenn der Zustand des Kontrollkästchen unbestimmt ist.

¡ Rubrik Aussehen 

Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text festlegen.

¡ 3D-Effekt 

Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet.

Optionsfelder

Mit dem Menübefehl Objekt > Neues Formularobjekt > Optionsfeld fügen Sie ein Optionsfeld ein. 

Optionsfelder können in Formularen zur Auswahl einer von mehreren Optionen verwendet werden.

Verwendung von Gruppenfeldern zum Kombinieren von Optionsfeldern

Wichtig: Optionsfelder müssen stets in Gruppen von mindestens zwei Optionsfeldern verwendet werden.

Damit PlanMaker hierbei weiß, welche Optionsfelder zu einer Gruppe gehören, umgeben Sie diese mit ei-
nem Gruppenfeld. 

Fügen Sie also erst die zusammengehörenden Optionsfelder in das Dokument ein (zum Beispiel untereinan-
der) und ziehen Sie dann mit dem Menübefehl Einfügen > Neues Formularobjekt > Gruppenfeld ein
Gruppenfeld um sie herum.
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Bedienung von Optionsfeldern

Klicken Sie eines der zusammengehörenden Optionsfelder an, um es auszuwählen. Innerhalb einer Gruppe
von Optionsfeldern kann immer nur ein Optionsfeld ausgewählt sein.

Eigenschaften von Optionsfeldern ändern

Um die Eigenschaften eines Optionsfelds zu ändern, selektieren Sie es (zum Beispiel durch Anklicken mit
der rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigenschaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu dem Optionsfeld selbst vornehmen:

¡ Text 

Hier können Sie den Text angeben, der in dem Optionsfeld angezeigt werden soll.

¡ Wert 

Hier können Sie festlegen, ob das Optionsfeld ausgewählt sein soll oder nicht. Entspricht dem Auswäh-
len des Optionsfelds direkt im Dokument.

¡ Ausgabezelle 

Hier bestimmen Sie, in welcher Tabellenzelle der Zustand des Optionsfelds ausgegeben werden soll. 

Wie eingangs erwähnt, müssen Optionsfelder immer in Gruppen von mindestens zwei Optionsfeldern
verwendet werden. In der Ausgabezelle wird dann ausgegeben, welches der Optionsfelder in der Gruppe
ausgewählt ist. Wenn das erste Feld gewählt ist, erscheint darin eine 1, wenn das zweite Feld gewählt ist,
erscheint eine 2, etc.

¡ Rubrik Aussehen 

Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text festlegen.

¡ 3D-Effekt 

Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet.
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Auswahllisten

Mit dem Menübefehl Objekt > Neues Formularobjekt > Auswahlliste fügen Sie eine aufklappbare Aus-
wahlliste ein.

Auswahllisten kennen Sie aus vielen Dialogfenstern. Wenn man sie aufklappt, zeigen Sie eine Liste von
Einträgen, von denen ein Eintrag ausgewählt werden kann. Dies ist natürlich ideal für Formulare, da es
beim Ausfüllen Tipparbeit spart und Tippfehler unmöglich macht.

Bedienung von Auswahllisten

Klicken Sie das Pfeilchen rechts der Liste an, um die Liste zu öffnen. Nun können Sie einen Eintrag aus-
wählen, indem sie ihn anklicken.

Eigenschaften von Auswahllisten ändern

Um die Eigenschaften einer Auswahlliste zu ändern, selektieren Sie diese (zum Beispiel durch Anklicken
mit der rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigenschaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu der Auswahlliste selbst vornehmen:

¡ Zeilen (max.) 

Hier können Sie festlegen, wie viele Einträge die Liste höchstens anzeigen soll, wenn sie aufgeklappt
wird.

¡ Listenbereich 

Hier bestimmen Sie, welcher Zellbereich der Tabelle die Listeneinträge enthält, die in der Auswahlliste
erscheinen sollen.

Wenn Sie beispielsweise die Zellen F5 bis F7 mit den Werten "Hund", "Katze" und "Maus" ausfüllen
und als Listenbereich F5:F7 angeben, erscheinen in der Liste genau diese drei Werte.
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¡ Ausgabezelle 

Hier bestimmen Sie, in welcher Tabellenzelle der Zustand der Auswahlliste ausgegeben werden soll. 

In der Ausgabezelle wird ausgegeben, welcher der Listeneinträge ausgewählt wurde. Wenn der erste Ein-
trag gewählt ist, erscheint darin eine 1, wenn der zweite Eintrag gewählt ist, erscheint eine 2, etc.

¡ Rubrik Aussehen 

Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text festlegen.

¡ 3D-Effekt 

Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet.

Listen

Mit dem Menübefehl Objekt > Neues Formularobjekt > Liste fügen Sie eine Liste ein.

Solche Listen kennen Sie aus vielen Dialogfenstern. Sie bieten mehrere Einträge zur Wahl, von denen per
Mausklick ein Eintrag ausgewählt werden kann. Dies ist natürlich ideal für Formulare, da es beim Ausfüllen
Tipparbeit spart und Tippfehler unmöglich macht.

Eigenschaften von Listen ändern

Um die Eigenschaften einer Liste zu ändern, selektieren Sie diese (zum Beispiel durch Anklicken mit der
rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigenschaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu der Liste selbst vornehmen:

¡ Markierungsart 

Verwenden Sie hier stets die Option Einfach.



296Formulare

Die beiden anderen Einträge Mehrfach und Erweitert erlauben Mehrfachselektionen in der Liste; es
wird dann aber kein Resultat mehr in der Ausgabezelle ausgegeben. Sie sind nur aus Gründen der Excel-
Kompatibilität vorhanden.

¡ Listenbereich 

Hier bestimmen Sie, welcher Zellbereich der Tabelle die Listeneinträge enthält, die in der Liste erschei-
nen sollen.

Wenn Sie beispielsweise die Zellen F5 bis F7 mit den Werten "Hund", "Katze" und "Maus" ausfüllen
und als Listenbereich F5:F7 angeben, erscheinen in der Liste genau diese drei Werte.

¡ Ausgabezelle 

Hier bestimmen Sie, in welcher Tabellenzelle der Zustand der Liste ausgegeben werden soll. 

In der Ausgabezelle wird ausgegeben, welcher der Listeneinträge ausgewählt wurde. Wenn der erste Ein-
trag gewählt ist, erscheint darin eine 1, wenn der zweite Eintrag gewählt ist, erscheint eine 2, etc.

¡ Rubrik Aussehen 

Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text festlegen.

¡ 3D-Effekt 

Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet.

Schaltflächen

Mit dem Menübefehl Objekt > Neues Formularobjekt > Schaltfläche fügen Sie eine Schaltfläche ein.

Hinweis: Schaltflächen können in PlanMaker nicht zum Starten von Makros oder VBA-Scripts verwendet
werden; sie sind lediglich aus Gründen der Excel-Kompatibilität vorhanden.

Eigenschaften von Schaltflächen ändern

Um die Eigenschaften einer Schaltfläche zu ändern, selektieren Sie diese (zum Beispiel durch Anklicken
mit der rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigenschaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.
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Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu der Schaltfläche selbst vornehmen:

¡ Text 

Hier können Sie den Text angeben, der auf der Schaltfläche erscheinen soll.

¡ Rubrik Aussehen 

Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) für den Text festlegen.

Drehfelder

Mit dem Menübefehl Objekt > Neues Formularobjekt > Drehfeld fügen Sie ein Drehfeld ein.

Mit Drehfeldern lassen sich Werte per Mausklick schrittweise erhöhen oder reduzieren. Ein Klick auf das
Pfeilchen nach oben erhöht den Wert in der Ausgabezelle; das Pfeilchen nach unten reduziert den Wert.

Eigenschaften von Drehfeldern ändern

Um die Eigenschaften eines Drehfelds zu ändern, selektieren Sie es (zum Beispiel durch Anklicken mit der
rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigenschaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu dem Drehfeld selbst vornehmen:

¡ Rubrik Parameter 

Hier können Sie folgende Parameter festlegen:

Aktueller Wert: Der aktuelle Wert (entspricht dem Wert in der Ausgabezelle).

Mindestwert: Der Mindestwert, der nicht unterschritten werden darf.

Maximalwert: Der Höchstwert, der nicht überschritten werden darf.
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Schrittweite: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn auf eines der beiden Pfeil-
chen geklickt wird.

¡ Ausgabezelle 

Hier bestimmen Sie, in welcher Tabellenzelle der resultierende Wert ausgegeben werden soll. 

¡ 3D-Effekt 

Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet.

Bildlaufleisten

Mit dem Menübefehl Objekt > Neues Formularobjekt > Bildlaufleiste fügen Sie eine Bildlaufleiste ein.

Mit Bildlaufleisten lassen sich Werte per Mausklick erhöhen oder reduzieren. Ein Klick auf das Pfeilchen
nach oben erhöht den Wert in der Ausgabezelle um die angegebene Schrittweite; das Pfeilchen nach unten
reduziert den Wert entsprechend. 

Weiterhin können Sie den "Schieber" in der Mitte der Bildlaufleiste mit der Maus verschieben, um größere
Sprünge machen.

Eigenschaften von Bildlaufleisten ändern

Um die Eigenschaften einer Bildlaufleiste zu ändern, selektieren Sie diese (zum Beispiel durch Anklicken
mit der rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigenschaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.

Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu der Bildlaufleiste selbst vornehmen:

¡ Rubrik Parameter 

Hier können Sie folgende Parameter festlegen:

Aktueller Wert: Der aktuelle Wert (entspricht dem Wert in der Ausgabezelle).

Mindestwert: Der Mindestwert, der nicht unterschritten werden darf.
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Maximalwert: Der Höchstwert, der nicht überschritten werden darf.

Schrittweite: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn Sie in der Bildlaufleiste auf
eines der beiden Pfeilchen klicken.

Seitenwechsel: Der Wert, der hinzugezählt bzw. abgezogen werden soll, wenn Sie in der Bildlaufleiste
in den Bereich zwischen dem Schieber in der Mitte und einem der Pfeilchen klicken.

¡ Ausgabezelle 

Hier bestimmen Sie, in welcher Tabellenzelle der resultierende Wert ausgegeben werden soll. 

¡ 3D-Effekt 

Schalten Sie diese Option ein, wird das Objekt mit einem 3D-Effekt gezeichnet.

Bezeichnungen und Gruppenfelder

Neben den zuvor beschriebenen Formularobjekten gibt es zusätzlich zwei Arten von Formularobjekten, die
sich nicht ausfüllen lassen, sondern lediglich für das Anbringen von Beschriftungen gedacht sind:

¡ Bezeichnungen 

In Bezeichnungen kann eine beliebige Beschriftung eingegeben werden, die im Formular angezeigt wer-
den soll.

¡ Gruppenfelder 

Gruppenfelder sind Rechtecke, die sich links oben mit einer Beschriftung versehen lassen. Sie können
dazu verwendet werden, zusammengehörige Teile eines Formulars optisch zu einer Gruppe zusammen-
zufassen. 

Um eine Bezeichnung oder ein Gruppenfeld einzufügen, rufen Sie den Menübefehl Objekt > Neues For-
mularobjekt > Bezeichnung beziehungsweise Objekt > Neues Formularobjekt > Gruppenfeld auf. 

Das entsprechende Formularobjekt wird daraufhin eingefügt. Verschieben Sie es nun mit der Maus an die
gewünschte Position. Sie können auch seine Größe ändern, indem Sie einem der runden Greifer ziehen, die
das Objekt umgeben. 

Eigenschaften von Bezeichnungen und Gruppenfeldern ändern

Um die Eigenschaften einer Bezeichnung oder eines Gruppenfelds zu ändern, selektieren Sie dieses (zum
Beispiel durch Anklicken mit der rechten Maustaste) und rufen dann den Menübefehl Objekt > Eigen-
schaften auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

Karteikarte Format

Auf dieser Karteikarte können Sie die Größe und Positionierung ändern. Siehe Abschnitt Objekt-Eigen-
schaften, Karteikarte Format.
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Karteikarte Eigenschaften

Auf dieser Karteikarte können Sie allgemeine Einstellungen ändern. Siehe Abschnitt Objekt-Eigenschaften,
Karteikarte Eigenschaften.

Karteikarte Formularelement

Auf dieser Karteikarte können Sie Einstellungen zu dem Text vornehmen, den die Bezeichnung beziehungs-
weise das Gruppenfeld anzeigen soll:

¡ Rubrik Text 

Hier geben Sie den anzuzeigenden Text ein.

¡ Rubrik Aussehen 

Hier können Sie das Zeichenformat (Schriftart, -größe, -farbe etc.) des Textes festlegen.

¡ 3D-Effekt 

Nur bei Gruppenfeldern verfügbar. Schalten Sie diese Option ein, wird das Gruppenfeld mit einem 3D-
Effekt gezeichnet.
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Sprachwerkzeuge
PlanMaker verfügt über eine leistungsfähige Rechtschreibprüfung. Diese ermöglicht es Ihnen, die Recht-
schreibung von Text überprüfen und korrigieren zu lassen. Außerdem steht eine automatische Silbentren-
nung zur Verfügung.

In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es besteht aus folgenden Abschnitten:

¡ Sprache einstellen 

Die Sprache für Rechtschreibprüfung und Silbentrennung lässt sich über den Menübefehl Weiteres >
Einstellungen (Karteikarte Sprache) einstellen.

¡ Rechtschreibprüfung 

Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler und macht bei Fehlern
Korrekturvorschläge.

¡ Silbentrennung 

Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach deren Sprechsilben. Sie wird
standardmäßig nur in Textrahmen aktiv, kann auf Wunsch aber auch mehrzeiligen Text in Tabellenzellen
trennen. 

¡ Textbausteine 

Über Textbausteine können Sie Ihre "Lieblingstippfehler" automatisch korrigieren lassen und Kürzel für
häufig benötigte Floskeln definieren – zum Beispiel "Lst" für "Lohnsteuer".

Sprache einstellen
Wenn Sie mehrere Sprachen installiert haben, können Sie die Sprache für Rechtschreibprüfung und Silben-
trennung jederzeit wechseln.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Einstellungen auf.

2. Wechseln Sie auf die Karteikarte Sprache.

3. Wählen Sie die gewünschte Sprache aus der Liste Sprache.

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser Liste gibt: 

¡ "Deutsch (Deutschland)" steht für die neue Rechtschreibung (gemäß der sogenannten "Rechtschreibre-
form" von 1996 in ihrer letzten Überarbeitung von 2006). 

¡ "Deutsch (Deutschland, alt)" steht hingegen für die alte Rechtschreibung.

Entsprechendes gilt für "Deutsch (Österreich)" und "Deutsch (Schweiz)".
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Rechtschreibprüfung
Die Rechtschreibprüfung überprüft den Text in einem Dokument auf Tippfehler und macht bei Fehlern Kor-
rekturvorschläge.

In diesem Abschnitt stellen wir Ihnen die einzelnen Werkzeuge der Rechtschreibprüfung ausführlich vor.
Folgende Themen werden darin behandelt:

¡ Rechtschreibprüfung nachträglich 

Die nachträgliche Rechtschreibprüfung lässt Sie das aktuelle Arbeitsblatt en bloc überprüfen und korri-
gieren.

¡ Rechtschreibprüfung während des Tippens 

Die Rechtschreibkorrektur während des Tippens prüft jedes Wort direkt nach der Eingabe. Bei Tippfeh-
lern meldet sich sofort ein Dialogfenster zur Korrektur.

¡ Benutzerwörterbücher bearbeiten 

Wenn Sie die Rechtschreibprüfung Wörter lernen lassen, werden diese in Ihr Benutzerwörterbuch aufge-
nommen. Dieses können Sie jederzeit bearbeiten, um beispielsweise fälschlicherweise aufgenommene
Wörter wieder zu löschen.

Ausführliche Informationen zu diesen Themen finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Rechtschreibprüfung nachträglich

Hinweis: Tabellenzellen, die mit einem Gleichheitszeichen = beginnen (also eine Berechnung enthalten),
werden von der Rechtschreibprüfung automatisch übersprungen.

Mit dem Menübefehl Weiteres > Rechtschreibprüfung starten Sie die nachträgliche Rechtschreibprüfung. 

Diese überprüft das aktuelle Arbeitsblatt Wort für Wort auf Rechtschreibfehler. Bei einem unbekannten
Wort hält die Rechtschreibprüfung an und zeigt das Wort in einem Dialogfenster an.
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Sie können nun wählen, ob Sie das Wort korrigieren, lernen oder den vermeintlichen Fehler einfach ignorie-
ren möchten. In der Liste unter Ändern auf finden Sie außerdem Vorschläge für die korrekte Schreibweise
des Wortes (sofern welche gefunden werden).

Verwenden Sie die Schaltflächen in dem Dialog, um zu bestimmen, was mit dem unbekannten Wort gesche-
hen soll:

Schaltfläche Funktion

Ändern Lässt Sie das Wort korrigieren. Tippen Sie, bevor Sie diese Schaltfläche betätigen, die korrek-
te Schreibweise im Eingabefeld Ändern auf ein oder wählen Sie einen der Wortvorschläge
aus der Liste.

Alle ändern Funktioniert wie Ändern, ändert jedoch alle Vorkommen des Wortes im gesamten Dokument
auf die angegebene Schreibweise.

Ignorieren Weist PlanMaker an, diesen Rechtschreibfehler zu ignorieren und die Rechtschreibprüfung
fortzuführen.

Alle ignorieren Weist PlanMaker an, fortan alle Vorkommen dieses Wortes zu ignorieren.

Hinweis: Die Liste der ignorierten Wörter merkt sich PlanMaker nur vorübergehend; beim
nächsten Programmstart hat er sie wieder vergessen. Wenn Sie PlanMaker Wörter permanent
lernen lassen möchten, verwenden Sie stattdessen den Befehl Lernen.

Lernen Weist PlanMaker an, das Wort in das Benutzerwörterbuch aufzunehmen und damit den ihm
bekannten Wortschatz zu vergrößern.

Verwenden Sie diese Option bei richtig geschriebenen Wörtern, die PlanMaker noch nicht
kennt. Diese Wörter merkt sich PlanMaker permanent, also auch nach einem Neustart.

Wenn Sie die Rechtschreibprüfung beenden möchten, bevor das Ende des Arbeitsblatts erreicht ist, klicken
Sie auf Schließen.
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Rechtschreibprüfung während des Tippens

Wenn Sie die Rechtschreibkorrektur während des Tippens aktivieren, überprüft PlanMaker unbemerkt
bei jedem Wort, das Sie eintippen, die Rechtschreibung und meldet sich bei einem Tippfehler sofort: Es er-
scheint ein Dialogfenster zum Korrigieren der Schreibweise.

Hinweis: Wenn Sie die Eingabe in eine Zelle mit einem Gleichheitszeichen (=) beginnen (also eine Be-
rechnung eingeben), werden die Eingaben in diese Zelle nicht geprüft. Das wäre bei Rechenformeln ja
auch nicht sinnvoll.

Um diese Form der Rechtschreibprüfung zu aktivieren, rufen Sie den Menübefehl Weiteres > Einstellun-
gen auf, wechseln auf die Karteikarte Sprache und schalten dort die Option Rechtschreibkorrektur wäh-
rend des Tippens ein.

PlanMaker sieht nun jedes Mal, wenn Sie ein Wort eintippen, blitzschnell in seinen Wörterbüchern nach, ob
es sich darin befindet. Solange Sie Wörter tippen, die die Rechtschreibprüfung kennt, passiert nichts Sicht-
bares. Kann PlanMaker mit einem Wort aber nichts anfangen, erscheint sofort ein Dialogfenster.

Dieses Dialogfenster entspricht dem der nachträglichen Rechtschreibprüfung, das im vorherigen Abschnitt
vorgestellt wurde Lesen Sie dort nach, wie das Dialogfenster bedient wird

Sie werden bemerken, dass es in dem Dialogfenster zusätzlich die Schaltfläche Textbaustein zum Anlegen
von Textbausteinen gibt. Was es damit auf sich hat, erfahren Sie im Abschnitt Textbausteine.

Benutzerwörterbücher bearbeiten

Wenn Sie die Rechtschreibprüfung Wörter lernen lassen, werden diese in Ihr Benutzerwörterbuch aufge-
nommen. Dieses können Sie jederzeit bearbeiten, um beispielsweise fälschlicherweise aufgenommene Wör-
ter wieder zu löschen.

Rufen Sie dazu den Menübefehl Weiteres > Wörterbücher bearbeiten auf. Es erscheint ein Dialogfenster
mit folgenden Schaltflächen und Optionen:

¡ Sprache 

Es gibt zu jeder Sprache ein eigenes Benutzerwörterbuch. Über die aufklappbare Liste Sprache können
Sie auswählen, welches Benutzerwörterbuch Sie bearbeiten möchten.

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser Liste gibt: "Deutsch
(Deutschland)" steht für die neue Rechtschreibung und "Deutsch (Deutschland, alt)" für die alte
Rechtschreibung. Entsprechendes gilt für "Deutsch (Österreich)" und "Deutsch (Schweiz)".

¡ Wörter 

Eine Liste aller Wörter, die sich in Ihrem Benutzerwörterbuch (für die gewählte Sprache) befinden.

¡ Schaltfläche "Schließen" 

Schließt den Dialog.
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¡ Schaltfläche "Hinzufügen" 

Diese Schaltfläche ermöglicht Ihnen, ein Wort manuell zu Ihrem Benutzerwörterbuch hinzuzufügen. Tip-
pen Sie das gewünschte Wort dazu in den Dialog ein, der nach dem Betätigen dieser Schaltfläche er-
scheint.

Auf diese Weise hinzugefügte Wörter werden genau so behandelt wie Wörter, die Sie dem Programm
über die Schaltfläche Lernen in der Rechtschreibprüfung beigebracht haben.

¡ Schaltfläche "Ändern" 

Mit dieser Schaltfläche können Sie das momentan in der Liste selektierte Wort editieren. Dies ist nütz-
lich bei Wörtern, die Sie versehentlich in falscher Schreibweise in Ihr Benutzerwörterbuch aufgenom-
men haben. Es erscheint dazu ein Dialog, in dem Sie die Schreibweise des Wortes korrigieren können. 

¡ Schaltfläche "Löschen" 

Diese Schaltfläche löscht das Wort, das momentan in der Liste ausgewählt ist, aus Ihrem Benutzerwör-
terbuch.

Die Rechtschreibprüfung wird dieses Wort künftig also wieder als falsch geschrieben ansehen.

Silbentrennung
Die automatische Silbentrennung trennt lange Wörter am Zeilenende nach deren Sprechsilben. Dies ge-
schieht völlig automatisch, während Sie tippen. 

Die Silbentrennung ist allerdings nur in zwei Fällen verfügbar:

¡ Silbentrennung in Textrahmen 

In Textrahmen ist die automatische Silbentrennung standardmäßig aktiviert.

¡ Silbentrennung in Tabellenzellen 

In Tabellenzellen ist die automatische Silbentrennung standardmäßig nicht aktiviert. Bei Zellen, die
mehrzeiligen Text enthalten, können Sie diese aber auf Wunsch einschalten. 

Ausführliche Informationen dazu finden Sie auf den nächsten Seiten.

Wichtig: Die Silbentrennung liefert natürlich nur dann korrekte Resultate, wenn Sie in den Programmein-
stellungen die richtige Sprache eingestellt haben. Um die Sprache einzustellen, rufen Sie den Menübefehl
Weiteres > Einstellungen auf, wechseln auf die Karteikarte Sprache und wählen die Sprache aus der
Liste Sprache.

Silbentrennung in Textrahmen

Wenn Sie Text in einen Textrahmen einfügen, führt PlanMaker darin automatisch Silbentrennungen durch.
Dies geschieht völlig automatisch im Hintergrund, Sie brauchen sich normalerweise also überhaupt nicht
darum zu kümmern. 
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Sie sollten lediglich darauf achten, dass Sie in den Einstellungen die korrekte Sprache gewählt haben, da die
Silbentrennung sonst natürlich fehlerhafte Resultate liefert (siehe Abschnitt Sprache einstellen).

Trennhäufigkeit einstellen

Auf Wunsch können Sie einstellen, wie häufig die Silbentrennungsfunktion Wörter trennen soll – oder die
Silbentrennung ganz abschalten. Diese Einstellung lässt sich für jeden Absatz in einem Textrahmen getrennt
festlegen.

Markieren Sie dazu die betreffenden Absätze in dem Textrahmen, rufen Sie den Menübefehl Format > Ab-
satz auf und wählen Sie bei Silbentrennung die gewünschte Einstellung.

Folgende Optionen stehen zur Wahl:

Einstellung Effekt

Keine Keine Silbentrennungen durchführen

Stets Beliebig viele aufeinander folgende Silbentrennungen versuchen. Dies ist die Standardein-
stellung.

2-Zeilen-Trennung Silbentrennung nur in jeder zweiten Zeile versuchen

3-Zeilen-Trennung Silbentrennung nur in jeder dritten Zeile versuchen

Mit Keine schalten Sie die Silbentrennung für die selektierten Absätze also ganz ab, wogegen Stets in jeder
beliebigen Zeile eines Absatzes versucht, eine Silbentrennung durchzuführen. 

Wozu aber dienen die zwei anderen Optionen? Nun, es ist nicht immer erstrebenswert, alle denkbaren Sil-
bentrennungen durchzuführen. Denn das kann beispielsweise bei schmalen Textspalten dazu führen, dass in
fast jeder Zeile getrennt wird, was die Lesbarkeit des Dokuments absenkt. Deshalb können Sie PlanMaker
mit Hilfe der Optionen 2- und 3-Zeilen-Trennung anweisen, eine Silbentrennung nur in jeder zweiten be-
ziehungsweise dritten Zeile zu versuchen.

Silbentrennung in Tabellenzellen

In Tabellenzellen ist die automatische Silbentrennung normalerweise nicht aktiviert, sie können Sie aber auf
Wunsch einschalten. Silbentrennungen werden dann aber natürlich nur in Zellen durchgeführt, die mehrzei-
ligen Text enthalten. 

Um Silbentrennungen in Zellen zu erhalten, sind also zwei Schritte erforderlich:

Schritt 1: Silbentrennung für Zellen aktivieren

Damit in Zellen überhaupt Silbentrennungen durchgeführt werden, müssen Sie erst die Silbentrennung für
Zellen aktivieren. Diese ist standardmäßig nämlich ausgeschaltet. Um sie einzuschalten, gehen Sie wie folgt
vor:

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf.

2. Wechseln Sie auf die Karteikarte Optionen.

3. Schalten Sie die Option Silbentrennung ein.
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Von nun an wird die Silbentrennung automatisch auch in Tabellenzellen aktiv.

Hinweis: Dies ist eine Dokumentoption, sie kann also für jedes Dokument individuell ein- oder ausgeschal-
tet werden.

Schritt 2: In den betreffenden Zellen den Zeilenumbruch einschalten

In Tabellenzellen werden nur dann Silbentrennungen durchgeführt, wenn für die betreffende Zelle die Opti-
on Zeilenumbruch eingeschaltet ist. Diese sorgt dafür, dass langer Text automatisch am rechten Zellenrand
umbrochen wird, um ihn auf mehrere Zeilen zu verteilen. 

Um die Option Zeilenumbruch zu aktivieren, geben Sie wie folgt vor:

1. Markieren Sie die gewünschten Zellen.

2. Rufen Sie den Menübefehl Format > Zelle auf.

3. Wechseln Sie auf die Karteikarte Ausrichtung.

4. Schalten Sie die Option Zeilenumbruch ein.

In diesen Zellen werden nun (sofern sie mehrzeiligen Text enthalten) bei Bedarf automatische Silbentren-
nungen durchgeführt.

Textbausteine
Textbausteine bieten eine enorme Arbeitserleichterung: Sie können sich Textbausteine für häufig benötigte
Floskeln anlegen und diese dann blitzschnell im Text abrufen.

Legen Sie beispielsweise einen Textbaustein namens "Lst" mit dem Inhalt "Lohnsteuer" an. Nun können Sie
diesen Baustein jederzeit abrufen. Tippen Sie dazu im Dokument einfach "Lst" und dann die Leertaste, die
Eingabetaste ¿ oder ein Satzzeichen. Sofort wird "Lst" durch "Lohnsteuer" ersetzt.

Auf diese Weise können Sie sich mit PlanMaker Ihr persönliches "Computersteno" zusammenstellen und
beim Tippen viel Zeit sparen.

In diesem Abschnitt erfahren Sie alles über das Arbeiten mit Textbausteinen:

¡ Textbausteine anlegen 

Neue Textbausteine können dialoggesteuert mit dem Menübefehl Einfügen > Textbaustein oder über
die Rechtschreibprüfung angelegt werden. Für jeden Textbaustein muss ein Name (z.B. "Lst") der ge-
wünschte Inhalt angegeben werden (z.B. "Lohnsteuer").

¡ Textbausteine abrufen 

Wenn in den Einstellungen die Option Textbausteine automatisch ersetzen aktiviert ist, lassen sich
Textbausteine ganz einfach abrufen: Tippen Sie dazu den Namen des Bausteins und anschließend die
Leertaste, die Eingabetaste ¿ oder ein Satzzeichen. Sofort wird der Name durch den Inhalt ersetzt.

Alternativ lassen sich Bausteine mit dem Menübefehl Einfügen > Textbaustein von Hand einfügen.

¡ Textbausteine bearbeiten 

Mit dem Menübefehl Einfügen > Textbaustein lassen sich nicht nur neue Textbausteine anlegen, son-
dern auch vorhandene Bausteine bearbeiten, umbenennen oder löschen.
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Ausführliche Informationen hierzu folgen auf den nächsten Seiten.

Textbausteine anlegen

Sie können Textbausteine wahlweise a) dialoggesteuert anlegen oder b) die Rechtschreibkorrektur während
des Tippens dazu verwenden:

A) Mit dem Befehl Einfügen > Textbaustein

Um beispielsweise einen Baustein mit dem Namen "Lst" und dem Inhalt "Lohnsteuer" anzulegen, gehen Sie
wie folgt vor:

1. Rufen Sie den Menübefehl Einfügen > Textbaustein auf.

2. Klicken Sie auf die Schaltfläche Neu, um einen neuen Baustein anzulegen.

3. Geben Sie dem Baustein einen Namen (in unserem Beispiel also "Lst"). 

Anhand seines Namens kann der Baustein später abgerufen werden.

4. Bestätigen Sie mit OK.

5. Tippen Sie nun in dem großen Eingabefeld rechts den Text für den Baustein ein (in unserem Beispiel al-
so "Lohnsteuer").

6. Klicken Sie auf Speichern, um Ihren neuen Textbaustein zu speichern.

7. Verlassen Sie den Dialog mit Schließen.

Der Baustein ist nun angelegt. Wie Sie ihn abrufen können, erfahren Sie im nächsten Abschnitt (Textbau-
steine abrufen).

B) Über die Rechtschreibkorrektur während des Tippens

Alternativ lassen sich Textbausteine auch über die Rechtschreibkorrektur während des Tippens anlegen. 

Der Vorteil dieser Methode ist, dass sich Bausteine damit schneller anlegen lassen, falls Sie die Recht-
schreibkorrektur während des Tippens ohnehin permanent eingeschaltet haben. Wenn Sie diese jedoch
nicht verwenden, ist die oben beschriebene Methode praktischer.

Gehen Sie wie folgt vor:

1. Vergewissern Sie sich, dass auf der Karteikarte Sprache im Dialogfenster des Menübefehls Weiteres >
Einstellungen die Option Rechtschreibkorrektur während des Tippens aktiviert ist.

2. Tippen Sie die drei Buchstaben "Lst" und betätigen Sie die Leertaste.

3. Es erscheint das Dialogfenster der Rechtschreibkorrektur, da PlanMaker das Wort "Lst" nicht kennt.

4. Klicken Sie auf die Schaltfläche Textbaustein.

5. Tippen Sie "Lohnsteuer" ein.

6. Bestätigen Sie mit OK.

Das Ergebnis ist das Gleiche: Der Baustein "Lst" ist nun angelegt worden.
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Weitere Informationen zur Rechtschreibkorrektur während des Tippens finden Sie im Abschnitt Recht-
schreibprüfung während des Tippens.

Textbausteine abrufen

Jetzt können Sie den im vorherigen Abschnitt definierten Textbaustein jederzeit abrufen. 

Dies geht denkbar einfach: Tippen Sie in einer Zelle oder einem Textrahmen den Namen des Bausteins – in
unserem Beispiel also "Lst" – und dann ein Leerzeichen, ein Satzzeichen oder die Eingabetaste ¿. Sofort
ersetzt PlanMaker "Lst" durch den Inhalt des Bausteins: "Lohnsteuer".

Hinweis: Sollte dies nicht funktionieren, haben Sie die Option Textbausteine automatisch ersetzen de-
aktiviert. Rufen Sie den Menübefehl Weiteres > Einstellungen auf, wechseln Sie auf die Karteikarte
Sprache und schalten Sie diese Option wieder ein.

Alternativ können Sie den Baustein auch per Dialog in den Text einfügen, indem Sie den Menübefehl Ein-
fügen > Textbaustein aufrufen, den gewünschten Baustein auswählen und dann die Schaltfläche Einfügen
betätigen.

Textbausteine bearbeiten

Mit dem Menübefehl Einfügen > Textbaustein können Sie weiterhin die bereits angelegten Textbausteine
bearbeiten:

¡ Neuen Baustein anlegen 

Betätigen Sie die Schaltfläche Neu, um einen neuen Textbaustein anzulegen (siehe Abschnitt Textbau-
steine anlegen).

¡ Baustein löschen 

Um einen Textbaustein zu löschen, selektieren Sie ihn in der Liste Textbausteine und betätigen dann die
Schaltfläche Löschen.

¡ Baustein umbenennen 

Möchten Sie den Namen eines Bausteins ändern, selektieren Sie ihn in der Liste und klicken auf die
Schaltfläche Umbenennen. Es erscheint ein Dialogfenster, in das Sie den neuen Namen eingeben kön-
nen.

¡ Baustein bearbeiten 

Um einen Baustein zu bearbeiten, selektieren Sie ihn in der Liste und klicken dann in das große Eingabe-
feld rechts daneben. Nun können Sie den Inhalt des Bausteins abändern.

Wenn Sie die gewünschten Änderungen angebracht haben, klicken Sie auf die Schaltfläche Speichern.

¡ Baustein einfügen 

Um einen Baustein in den Text einzufügen, selektieren Sie ihn in der Liste und klicken auf die Schaltflä-
che Einfügen (siehe auch Abschnitt Textbausteine abrufen).
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¡ Dialog schließen 

Mit der Schaltfläche Schließen können Sie den Dialog schließlich verlassen.
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Dokumentverwaltung
PlanMaker verfügt über Funktionen, die es Ihnen erleichtern, Ihre Dokumente zu verwalten und schneller
auf sie zuzugreifen:

¡ Schnellwahlpfade 

Sie können in PlanMaker Schnellwahlpfade anlegen, um beim Öffnen oder Speichern von Dateien blitz-
schnell in häufig verwendete Ordner wechseln zu können.

¡ Dokumentinfos 

In jedem Dokument können Sie Dokumentinfos ablegen, die sich über die Karteikarte Infos im Dialog-
fenster des Menübefehls Datei > Eigenschaften anzeigen und bearbeiten lassen. Sie können Titel, The-
ma und Autor des Dokuments eintragen, Stichwörter für die Suchfunktion des Dateimanagers angeben
und eine kurze Inhaltsangabe verfassen.

¡ Dateimanager 

Mit dem integrierten Dateimanager können Sie bequem auf Ihre Dokumente zugreifen. Sie sehen darin
die Namen und Dokumentinfos aller Dokumente auf einen Blick und können Dokumente auf Knopf-
druck betrachten, öffnen, ausdrucken oder löschen. Die Suchfunktion lässt Sie Dokumente nicht nur an-
hand des Dateinamens finden, sondern erlaubt auch die Suche nach Thema, Titel, Autor etc.

¡ Sicherungskopien 

PlanMaker legt auf Wunsch bei jedem Speichervorgang automatisch eine Sicherungskopie mit der vor-
herigen Version des Dokuments an. Sie können das Programm sogar anweisen, mehrere Generationen
von Sicherungskopien aufzuheben.

Ausführliche Informationen zu diesen Themen finden Sie auf den nächsten Seiten.

Schnellwahlpfade
Sie können mit PlanMaker bis zu zwanzig Schnellwahlpfade anlegen, um beim Öffnen oder Speichern von
Dateien blitzschnell in einen bestimmten Ordner wechseln zu können.

Ein Schnellwahlpfad ist eine symbolische Angabe wie "Reisekosten", die für einen bestimmten Ordner auf
der Festplatte steht (zum Beispiel den Ordner c:\buchhaltung\reisekosten). 

Wenn Sie nun eine Datei aus diesem Ordner öffnen möchten, brauchen Sie im Dialogfenster des Men-
übefehls Datei > Öffnen nur auf die Schaltfläche Schnellwahlpfad zu klicken und den Schnellwahlpfad
"Reisekosten" auszuwählen. Der Dialog wechselt sofort in den Ordner c:\buchhaltung\reisekosten.

Schnellwahlpfade stehen nicht nur im Dialogfenster des Menübefehls Datei > Öffnen zur Verfügung, son-
dern in allen Dialogfenstern, die zum Öffnen oder Speichern von Dateien dienen.

Ausführlichere Informationen folgen auf den nächsten Seiten.
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Anlegen von Schnellwahlpfaden

Um einen neuen Schnellwahlpfad anzulegen, gehen Sie wie folgt vor:

1. Rufen Sie einen beliebigen Dateidialog auf (zum Beispiel mit dem Menübefehl Datei > Öffnen).

2. Betätigen Sie die Schaltfläche Schnellwahlpfad.

3. Es öffnet sich ein Menü unter der Schaltfläche. Wählen Sie darin die Funktion Schnellwahlpfad neu
anlegen.

4. Tragen Sie bei Name einen beliebigen Namen für den Schnellwahlpfad ein – zum Beispiel "Reisekos-
ten".

5. Tragen Sie bei Pfad den gewünschten Ordner ein – zum Beispiel "c:\buchhaltung\reisekosten".

Tipp: Sie können auch auf die drei Punkte neben diesem Eingabefeld klicken. Dies öffnet einen Datei-
dialog, in dem Sie den gewünschten Ordner bequem auswählen können.

6. Bestätigen Sie mit OK.

PlanMaker weiß nun, dass der Schnellwahlpfad "Reisekosten" in den Ordner c:\buchhaltung\reise-
kosten wechseln soll.

Schnellwahlpfade mit Dateimasken: Sie können nicht nur reine Pfadangaben wie "c:\buchhaltung\reisekosten"
machen, sondern zusätzlich auch eine Dateimaske angeben. Definieren Sie beispielsweise einen Schnell-
wahlpfad auf "c:\buchhaltung\reisekosten\a*.*", wird damit in den Ordner c:\buchhaltung\reisekos-
ten gewechselt und darin alle Dateien angezeigt, die mit "a" beginnen.

Kennbuchstaben: Im Namen für Schnellwahlpfade kann das &-Zeichen verwendet werden, um dem Pfad
einen Kennbuchstaben zu geben. Wird als Name beispielsweise "&Finanzen" eingetragen, kann der Pfad in
der geöffneten Liste der Schnellwahlpfade durch Drücken der Taste F aufgerufen werden.

Verwenden von Schnellwahlpfaden

Schnellwahlpfade stehen in allen Dateidialogen zur Verfügung – zum Beispiel im Dialog des Menübefehls
Datei > Öffnen.

Um einen Schnellwahlpfad einzusetzen, gehen Sie wie folgt vor:

1. Klicken Sie in einem Dateidialog auf die Schaltfläche Schnellwahlpfad.

2. Es öffnet sich ein Menü mit allen bisher eingerichteten Schnellwahlpfaden. Wählen Sie den gewünsch-
ten Schnellwahlpfad aus.

PlanMaker wechselt nun in den im Schnellwahlpfad festgelegten Ordner.
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Schnellwahlpfade bearbeiten und löschen

Um einen vorhandenen Schnellwahlpfad zu bearbeiten oder ihn zu entfernen, gehen Sie wie folgt vor:

1. Klicken Sie in einem Dateidialog auf die Schaltfläche Schnellwahlpfad.

2. Es öffnet sich ein Menü. Wählen Sie darin den Befehl Schnellwahlpfade ändern.

3. Es erscheint ein Dialogfenster. Selektieren Sie darin den gewünschten Schnellwahlpfad. 

4. Klicken Sie auf Ändern, um den Namen und Pfad zu bearbeiten oder auf Löschen, um den Schnellwahl-
pfad zu entfernen.

Dokumentinfos
Über den Menübefehl Datei > Eigenschaften lassen sich nicht nur dokumentspezifische Einstellungen vor-
nehmen, sondern auch die Dokumentinfos eintragen.

Dokumentinfos sind Zusatzinformationen (wie Thema, Autor, Stichwörter etc.) zu einem Dokument. Um
diese einzusehen oder sie zu bearbeiten, rufen Sie den Menübefehl Datei > Eigenschaften auf und wech-
seln auf die Karteikarte Infos.

Nehmen Sie die gewünschten Eintragungen vor und bestätigen Sie mit OK.

Tipp: Im Dateimanager (siehe nächster Abschnitt) können Sie Dokumente nach den Dokumentinfos
durchsuchen lassen, um beispielsweise alle Dokumente zu einem bestimmten Thema zu finden.

Beim Speichern automatisch nach Dokumentinfo fragen: Auf Wunsch bittet Sie PlanMaker bei jedem neuen
Dokument automatisch um das Ausfüllen der Dokumentinfos. Rufen Sie dazu den Menübefehl Weiteres >
Einstellungen auf, wählen Sie die Karteikarte Dateien und schalten Sie die Option Beim Speichern nach
Dokumentinfo fragen ein. Nun erscheint jedes Mal, wenn Sie ein neues Dokument zum ersten Mal spei-
chern, das Dialogfenster zur Eingabe der Dokumentinfos.

Dateimanager
Der Dateimanager zeigt eine Liste von Dokumenten aus einem oder mehreren Ordnern an und lässt Sie die-
se per Mausklick öffnen, drucken, löschen oder ansehen. 

Sie starten den Dateimanager mit dem Menübefehl Datei > Dateimanager.
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Mit der Maus können Sie das Fenster des Dateimanagers jederzeit verschieben und es größer oder kleiner
ziehen. Außerdem können Sie die Spaltenbreiten durch Ziehen an den Trennlinien zwischen den Spalten-
überschriften ändern. 

Durch Klicken auf eine der Spaltenüberschriften können Sie bestimmen, nach welcher Spalte die Dateien
sortiert werden sollen.

Über die Schaltfläche Suchen... können Sie in einen anderen Ordner wechseln. Weiterhin erlaubt die Such-
funktion, die sich hinter dieser Schaltfläche verbirgt, auch die Suche innerhalb der Dokumentinfos, so dass
Sie nach einem bestimmen Titel, Thema, Autor, Schlagwort etc. suchen können.

Um eine Aktion mit einer Datei durchzuführen, selektieren Sie diese und klicken dann auf eine der Schalt-
flächen. Deren genaue Funktionen sind im nächsten Abschnitt Schaltflächen im Dateimanager beschrieben.

Schaltflächen im Dateimanager

Die Schaltflächen im Dateimanager haben folgende Funktionen:

¡ Öffnen 

Klicken Sie auf diese Schaltfläche, öffnet PlanMaker die selektierte Datei.

Tipp: Sie können alternativ auch einen Doppelklick auf einen Dateinamen ausführen, um die Datei zu
öffnen.

¡ Schließen 

Diese Schaltfläche beendet den Dateimanager.

¡ Suchen 

Klicken Sie diese Schaltfläche an, um nach bestimmten Dateien zu suchen oder einfach nur den Ordner
auszuwählen, der im Dateimanager angezeigt werden soll. Ausführliche Informationen zum Thema Su-
chen mit dem Dateimanager finden Sie im nächsten Abschnitt.

¡ Ausgabe 

Verwenden Sie diese Schaltfläche, um das selektierte Dokument auszugeben. Es öffnet sich dazu ein
kleines Menü, das folgende Funktionen enthalten kann (anhängig vom verwendeten Betriebssystem):
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E-Mail: Dokument per E-Mail versenden

Drucken: Dokument ausdrucken

¡ Umbenennen 

Klicken Sie diese Schaltfläche an, können Sie die selektierte Datei umbenennen.

¡ Löschen 

Klicken Sie diese Schaltfläche an, wird die selektierte Datei (nach Rückfrage) gelöscht.

¡ Vorschau 

Ein Mausklick auf diese Schaltfläche öffnet ein Fenster, in dem Sie das selektierte Dokument betrachten
können, ohne es dazu öffnen zu müssen.

Um dieses Dokument dann tatsächlich zu öffnen, klicken Sie auf die Schaltfläche Öffnen in der Vor-
schau. Um das Vorschaufenster hingegen zu verlassen, betätigen Sie die Schaltfläche Abbrechen.

Suchen mit dem Dateimanager

Mit Hilfe der Schaltfläche Suchen im Dateimanager können Sie PlanMaker nach bestimmten Dateien su-
chen lassen oder einfach nur den Ordner wählen, der im Dateimanager angezeigt werden soll.

Sie können Dateien nach folgenden Kriterien suchen lassen: Dateiname, Ordner, Dateityp und den Angaben
in den Dokumentinfos (Titel, Thema, Autor, Schlüsselwörter). 

Dabei lassen sich auch mehrere Suchkriterien kombinieren. Wählen Sie im Suchen-Dialog beispielsweise
einen bestimmten Ordner, zeigt PlanMaker alle Dokumente in diesem Ordner an. Tragen Sie zusätzlich im
Feld Titel einen Suchbegriff ein, findet PlanMaker alle Dokumente, die 1. im gewählten Ordner sind und 2.
den angegebenen Suchbegriff im Feld Titel der Dokumentinfos enthalten.

Mit dem oben abgebildeten Dialogfenster steuern Sie die Suchfunktion:

¡ Dateiname 

Mit Hilfe dieses Eingabefelds können Sie nach bestimmten Dateien suchen.

Wenn Sie hier nichts eintragen (also die Vorgabe übernehmen), findet die Suchfunktion alle Dokumente
des gewählten Dateityps im gewählten Ordner.
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Wenn Sie einen eindeutigen Dateinamen wie Lohnsteuer.pmdx eintippen, werden nur Dokumente mit
exakt diesem Namen gefunden.

Wenn Sie einen mehrdeutigen Dateinamen wie Lohn*.pmdx eintippen, findet die Suche alle Dokumen-
te, deren Dateiname mit "Lohn" beginnt. 

¡ Dateityp 

Über diese Liste können Sie wählen, nach welchem Typ von Dateien gesucht werden soll. Möchten Sie
beispielsweise nach Dateien im Excel-Format suchen, wählen Sie dieses Format in der Liste Dateityp.

¡ Titel, Thema, Autor etc. 

Durch Eingaben in diese Felder können Sie die Dokumentinfos (siehe hierzu auch Abschnitt Dokument-
infos) Ihrer Dokumente durchsuchen lassen. 

Wenn Sie mehrere Felder ausfüllen, sucht PlanMaker nach Dokumenten in denen alle diese Bedingun-
gen zutreffen. Tragen Sie beispielsweise bei Schlüsselwörter "Steuer" und bei Autor "Schmidt" ein,
werden nur Dokumente gefunden, bei denen die entsprechenden Felder der Dokumentinfos diese Texte
enthalten.

Sie können auch nur Teile des gesuchten Begriffs angeben. Haben Sie also beim Feld Schlüsselwörter
den Suchbegriff "Steuer" eingetippt, werden alle Dokumente gefunden, bei denen Schlüsselwörter den
Begriff "Steuer" enthält – "Steuererhöhung" wird also genauso gefunden wie "Meine Steuererklärung".

Groß/Kleinschreibung spielt bei Ihren Eingaben keine Rolle – Dokumente mit dem Schlüsselwort "Ein-
kommenssteuererklärung" werden also auch gefunden, wenn der Suchbegriff "Steuer" lautet.

¡ Ordner 

Hier können Sie wählen, in welchem Ordner PlanMaker die Suche durchführen soll.

¡ Untergeordnete Ordner einbeziehen 

Ist dieser Schalter aktiviert, durchsucht PlanMaker nicht nur den aktuellen Ordner, sondern auch alle ihm
untergeordneten Ordner.

¡ Schaltfläche Neue Dateiliste 

Startet eine neue Suche mit den aktuellen Einstellungen. 

¡ Schaltfläche Liste ergänzen 

Hier wird ebenfalls mit der Suche begonnen – mit dem Unterschied, dass die Liste der bei der letzten Su-
che gefundenen Dateien nicht zuvor geleert wird.

Sicherungskopien

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar. Unter Android werden lediglich
einfache Sicherungskopien unterstützt (Option Backupdateien erzeugen in den Einstellungen).

PlanMaker legt auf Wunsch bei jedem Speichervorgang automatisch eine Sicherungskopie mit der vorheri-
gen Version des Dokuments an. Sie können das Programm sogar anweisen, mehrere Generationen von Si-
cherungskopien aufzuheben.
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Die Einstellungen dazu finden Sie im Dialog des Menübefehl Weiteres > Einstellungen, Karteikarte Datei-
en. In der aufklappbaren Liste unter Sicherungskopien können Sie wählen, ob und wie Sicherungskopien
angelegt werden sollen:

¡ Keine Sicherungskopien 

Wenn Sie diese Option wählen, werden keine Sicherungskopien beim Speichern von Dokumenten ange-
legt. (Nicht empfohlen.)

¡ Einfache Sicherungskopien 

Hier wird pro Dokument genau eine Sicherungskopie angelegt. Diese enthält die vorherige Version des
Dokuments. Sie hat die Namenserweiterung .bak und befindet sich im gleichen Ordner wie das Doku-
ment selbst.

Im Detail passiert hierbei folgendes: Wenn Sie beispielsweise ein Dokument namens test.pmdx spei-
chern, wird zunächst die vorhandene Datei test.pmdx in test.bak umbenannt. Erst dann wird das
Dokument test.pmdx gespeichert. 

(Diese Option entspricht dem Kontrollkästchen .BAK-Dateien anlegen in früheren Versionen von
SoftMaker Office.)

¡ Fortgeschrittene Sicherungskopien 

Hier werden mehrere Generationen von Sicherungskopien für jedes Dokument angelegt. Diese werden
allesamt in einem speziellen Backup-Ordner gespeichert. 

Tipp: Wenn diese Option gewählt ist, steht außerdem der Menübefehl Datei > Zurück zu vorheriger
Version zur Verfügung, mit dem Sie bequem zu einer früheren Version des derzeit geöffneten Doku-
ments zurückkehren können (siehe unten).

Zusätzliche Optionen:

Verzeichnis für Sicherungskopien: Hier können Sie den Pfad für den Backup-Ordner ändern, in dem
alle Sicherungskopien abgelegt werden.

Anzahl der Sicherungskopien pro Dokument: Hier können Sie bestimmen, wie viele Sicherungskopi-
en (= Generationen) maximal pro Dokument aufgehoben werden sollen.

Schaltfläche "Bereinigen": Bietet die folgenden zwei Befehle zum Löschen von Sicherungskopien: 

Verwaiste Sicherungskopien löschen entfernt alle Sicherungskopien, bei denen das zugehörige Ori-
ginaldokument nicht mehr existiert. 

Alle Sicherungskopien löschen entfernt sämtliche Sicherungskopien im Verzeichnis für Sicherungs-
kopien. 

Wie verwende ich den Befehl "Datei > Zurück zu vorheriger Version"?

Wenn Sie die Option Fortgeschrittene Sicherungskopien verwenden (siehe oben), landen alle Sicherungs-
kopien in einem speziellen Backup-Ordner. Dieser wird vom Programm automatisch verwaltet. Es wird
nicht empfohlen, die Dateien in diesem Ordner manuell zu verschieben oder umzubenennen.

Um zu einer vorherigen Version eines Dokuments zurückzukehren, muss Sie dieser Ordner auch überhaupt
nicht interessieren – denn es gibt hierfür einen eigenen Menübefehl: Datei > Zurück zu vorheriger Versi-
on. 

Mit diesem Befehl können Sie folgendermaßen zu einer vorherigen Version eines Dokuments zurückkehren:

1. Öffnen Sie das gewünschte Dokument (falls es nicht bereits geöffnet ist).
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2. Rufen Sie den Menübefehl Datei > Zurück zu vorheriger Version auf. 

3. Es erscheint ein Dialog, der alle verfügbaren Sicherungskopien für das aktuelle Dokument auflistet. Fin-
den Sie anhand der Zeitangaben die Version, die Sie wiederherstellen möchten, und wählen Sie diese
aus. 

Tipp: Mit der Schaltfläche Vorschau können Sie sich eine Vorschau auf die gewählte Version anzeigen
lassen.

4. Klicken Sie auf die Schaltfläche Wiederherstellen, wird die gewählte vorherige Version des Dokuments
im aktuellen Fenster wiederhergestellt. 

Beachten Sie: Das aktuell geöffnete Dokument wird nun durch die gewählte vorherige Version er-
setzt. Wenn Sie es jetzt speichern, überschreiben Sie also die aktuelle Version mit einer älteren Versi-
on!

Alternativ können Sie auch auf die Schaltfläche Als Kopie öffnen klicken. Diese öffnet die Sicherungs-
kopie in einem neuen Dokumentfenster (anstatt das Dokument im aktuellen Fenster zu ersetzen). Dies ist
nützlich, wenn Sie die aktuelle Version mit einer älteren Version vergleichen möchten.

Was aber mache ich, wenn ich die Originaldatei verloren habe?

Wenn die Originaldatei für ein Dokument einmal verlorengegangen sein sollte, weil sie beispielsweise ge-
löscht wurde, funktioniert die oben beschrieben Vorgehensweise nicht. Was nun?

Auch in diesem Fall können Sie noch immer auf die Sicherungskopien für das Dokument zugreifen (sofern
diese natürlich nicht ebenfalls gelöscht wurden). Öffnen Sie dazu einfach die Sicherungskopie selbst. 

Wo sich die Sicherungskopien befinden, können Sie im Dialog des Menübefehls Weiteres > Einstellungen
auf der Karteikarte Dateien nachsehen. Der Ordner ist dort bei Verzeichnis für Sicherungskopien einge-
tragen. Standardmäßig ist dies ein Ordner namens Backup unterhalb des SoftMaker-Ordners in Ihrem Do-
kument-Ordner.

Die Sicherungskopien in diesem Ordner lassen sich direkt in PlanMaker öffnen. Gehen Sie dazu beispiels-
weise wie folgt vor: 

1. Navigieren Sie im Windows-Explorer zu dem Backup-Ordner (siehe oben).

2. Suchen Sie in diesem Ordner nach Dateien, deren Name mit dem Namen der Originaldatei beginnt. Eine
Sicherungskopie für die Datei Test.pmdx kann beispielsweise Test.pmdx.135.pmbak heißen. (Es
wird an den Dateinamen also immer eine laufende Nummer und die Erweiterung .pmbak angehängt.)

Tipp: Je höher die laufende Nummer im Dateinamen, desto aktueller ist die Sicherungskopie.

3. Doppelklicken Sie im Windows-Explorer auf die Sicherungskopie, die Sie öffnen möchten.

4. PlanMaker erkennt, dass Sie versuchen, eine Sicherungskopie zu öffnen. Er fragt nach, was genau Sie
nun tun möchten. Dazu erscheint ein Dialog mit den folgenden Optionen:

Die Sicherungskopie öffnen: Öffnet die Sicherungskopie.

Den Versionsmanager aufrufen: Ruft den Menübefehl Datei > Zurück zu vorheriger Version auf. Dieser
bietet dann alle verfügbaren früheren Versionen des Originaldokuments zur Wahl an. Die Bedienung
dieses Befehls wurde weiter oben beschrieben.

Die Originaldatei öffnen: Öffnet die Originaldatei zu dieser Sicherungskopie. (Dies funktioniert natürlich
nur, wenn die Originaldatei noch existiert.)

5. Treffen Sie Ihre Wahl, und klicken Sie dann auf OK.
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Es sei noch einmal darauf hingewiesen, dass PlanMaker die Dateien im Backup-Ordner automatisch anlegt
und verwaltet. Sie sollten daher keine Änderungen an diesen Dateien von Hand vornehmen, also beispiels-
weise Dateien umbenennen oder verschieben. 

Wenn Sie mehr Platz auf dem Datenträger benötigen, können Sie jederzeit alle Dateien in diesem Ordner lö-
schen, verlieren dann aber natürlich sämtliche Sicherungskopien.
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Gliederungen
Bei umfangreichen Tabellen kann es sich lohnen, diese mit einer Gliederung zu versehen. Sie können dann
nämlich bequem per Mausklick bestimmen, ob nur die wichtigsten Daten oder auch Detaildaten angezeigt
werden sollen.

Um eine Tabelle zu gliedern, gruppieren Sie die zusammengehörenden Detaildaten. Enthält die Tabelle bei-
spielsweise die Umsätze für mehrere Jahre, jeweils unterteilt in die Umsätze pro Monat, selektieren Sie je-
weils die Zeilen mit den Monaten eines Jahres und fassen diese zu einer Gruppe zusammen. Fortan können
Sie diese per Mausklick ein- und ausblenden – je nachdem, ob Sie nur die Jahresumsätze oder auch die Mo-
natsumsätze betrachten möchten.

Gliederungen dürfen übrigens auch mehrere Ebenen enthalten – Sie können also innerhalb einer Gruppe von
Daten nochmals Daten gruppieren.

Das Gliederungsfeld

Sobald eine Tabelle gruppierte Daten enthält, erscheint links der Tabelle ein Gliederungsfeld:

Über dieses Gliederungsfeld können Sie nun per Mausklick bestimmen, welche Detaildaten angezeigt wer-
den sollen:



321Gliederungen

¡ Durch Anklicken der Plus-Symbole  und Minus-Symbole  im Gliederungsfeld können Sie beliebige
Gruppen von Detaildaten individuell ein- und ausblenden. 

¡ Mit Hilfe der Schaltflächen  ganz oben können Sie bestimmen, dass generell nur Detaildaten ab
einer bestimmten Ebene angezeigt werden sollen. Klicken Sie beispielsweise auf die 2, werden nur Zei-
len der ersten und zweiten Gliederungsebene angezeigt.

Eine Gliederung kann übrigens nicht nur zeilenweise, sondern auch spaltenweise erfolgen. Sie gruppieren
dabei also nicht Zeilen, sondern Spalten. Das Gliederungsfeld erscheint in diesem Falle oberhalb der Tabel-
le.

Verwenden der Gliederungsleiste

Sobald eine Tabelle gruppierte Zellen enthält, erscheint nicht nur das Gliederungsfeld, sondern auch eine
Gliederungsleiste.

Diese enthält die wichtigsten Symbole zum Arbeiten mit Gliederungen (von links nach rechts):

¡ Gliederungsfeld einschalten (funktioniert nur, wenn die Tabelle gruppierte Zellen enthält) oder ausschal-
ten 

¡ Die markierten Zellen gruppieren

¡ Gruppierung der markierten Zellen aufheben

¡ Gliederung für die markierten Zellen gänzlich entfernen

¡ Details einblenden (entspricht einem Klick auf das Plus-Symbol im Gliederungsfeld)

¡ Details ausblenden (entspricht einem Klick auf das Minus-Symbol im Gliederungsfeld)

Ausführlichere Informationen zum Arbeiten mit Gliederungen finden Sie auf den nächsten Seiten.

Gruppieren von Zellen
Um eine Tabelle mit einer Gliederung zu versehen, gruppieren Sie die Zeilen (oder wahlweise Spalten), die
Detaildaten enthalten. Diese können Sie später dann je nach Bedarf per Mausklick ein- und ausblenden.

Um Tabellenzellen zu gruppieren, gehen Sie wie folgt vor:

1. Markieren Sie die Zeilen oder Spalten, die gruppiert werden sollen.

2. Rufen Sie den Menübefehl Arbeitsblatt > Gliederung > Gruppieren auf.

Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliederungsleiste aufrufen.

Die Zellen sind nun gruppiert.

Anmerkung: Nicht gruppierte Zellen haben eine Gliederungsebene von 1. Gruppieren Sie Zellen, wird deren
Gliederungsebene auf 2 erhöht. Sie können sogar einen Teil einer Gruppe von Zellen nochmals gruppieren,
worauf diese auf Gliederungsebene 3 gesetzt werden etc. Insgesamt sind maximal 8 Ebenen zulässig.
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Aufheben der Gruppierung von Zellen

Sie können die Gruppierung von Zellen jederzeit wieder aufheben. 

Gehen Sie dazu wie folgt vor:

1. Markieren Sie die Zeilen oder Spalten, deren Gruppierung aufgehoben werden soll.

2. Rufen Sie den Menübefehl Arbeitsblatt > Gliederung > Gruppierung aufheben auf.

Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliederungsleiste aufrufen.

Die Zellen sind nun nicht mehr gruppiert – genauer gesagt: ihre Gliederungsebene wird um eine Stufe redu-
ziert. Wenden Sie diesen Befehl also auf Zellen mit Gliederungsebene 3 an (sprich: gruppierte Zellen inner-
halb bereits gruppierter Zellen), wird ihre Gliederungsebene auf 2 reduziert.

Komplettes Entfernen der Gliederung von Zellen

Möchten Sie die Gliederung von Zellen komplett entfernen, gehen Sie wie folgt vor:

1. Markieren Sie die Zeilen oder Spalten, deren Gruppierung aufgehoben werden soll. Hinweis: Wenn Sie
nichts markieren, wird die Gliederung der gesamten Tabelle entfernt.

2. Rufen Sie den Menübefehl Arbeitsblatt > Gliederung > Gliederung entfernen auf.

Alternativ können Sie diesen Befehl auch über das Symbol  in der Gliederungsleiste aufrufen.

Die Gliederung der Zellen wurde nun vollständig entfernt, ihre Gliederungsebene ist also wieder auf 1 ge-
setzt.

Ein- und Ausblenden von gruppierten Zellen
Wenn Sie, wie im vorherigen Abschnitt beschrieben, eine Tabelle mit einer Gliederung versehen haben,
können Sie Detaildaten (also gruppierte Zellen) bei Bedarf jederzeit ein- oder ausblenden.

Verwenden Sie dazu das Gliederungsfeld, das automatisch links (beziehungsweise oberhalb) der Tabelle an-
gezeigt wird, wenn die Tabelle gruppierte Zellen enthält. Sollte das Feld nicht eingeblendet werden, rufen
Sie den Menübefehl Arbeitsblatt > Gliederung > Gliederungsfeld automatisch einblenden auf.

Folgendermaßen blenden Sie mit dem Gliederungsfeld gruppierte Zellen ein und aus:

¡ Neben gruppierten Zellen erscheint ein Balken mit einem Minus-Symbol  im Gliederungsfeld. Klicken
Sie dieses an, werden die gruppierten Zellen ausgeblendet. 

¡ Neben ausgeblendeten Zellen erscheint ein Plus-Symbol  im Gliederungsfeld. Klicken Sie dieses an,
werden die gruppierten Zellen wieder eingeblendet.

¡ Mit Hilfe der Schaltflächen  ganz oben können Sie bestimmen, dass generell nur Detaildaten ab
einer bestimmten Ebene angezeigt werden sollen. Klicken Sie beispielsweise auf die 2, werden nur Zei-
len der ersten und zweiten Gliederungsebene angezeigt.

Hinweis: Wenn Sie gruppierte Zellen ausblenden, werden diese nicht nur auf dem Bildschirm ausgeblendet,
sondern auch in Diagrammen nicht mehr berücksichtigt.
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Einstellungen zur Gliederung ändern
Mit dem Menübefehl Arbeitsblatt > Gliederung > Optionen können Sie folgende Einstellungen zur Glie-
derung der aktuellen Tabelle vornehmen:

¡ Titelzeile unterhalb Gruppenzeilen 

Als Titelzeile bezeichnet man eine Zeile direkt oberhalb oder unterhalb von gruppierten Zellen, die bei-
spielsweise eine Überschrift oder eine Zusammenfassung (zum Beispiel die Summe der Werte) enthalten
kann. 

Schalten Sie diese Option ein, wenn sich diese Titelzeile unterhalb der gruppierten Zellen befindet.
Schalten Sie sie aus, wenn diese sich oberhalb der Zellen befindet.

Diese Option bestimmt im Prinzip lediglich, ob im Gliederungsfeld die Minussymbole oberhalb oder un-
terhalb des Balkens für gruppierte Zellen angezeigt werden sollen.

¡ Titelspalte rechts von Gruppenspalten 

Diese Option entspricht der obigen Option; sie bezieht sich jedoch auf Tabellen, bei denen nicht Zeilen,
sondern Spalten gruppiert wurden. Sie können damit festlegen, ob sich die Titelspalte links oder rechts
der gruppierten Zellen befindet.

¡ Gliederungsfeld automatisch anzeigen 

Diese Option bestimmt, ob automatisch das Gliederungsfeld angezeigt werden soll, wenn die Tabelle
gruppierte Zellen enthält. 

Ist diese Option aktiviert, erscheint dieses Feld automatisch, sobald die Tabelle mindestens eine Gruppe
von Zellen enthält. Ist sie deaktiviert, erscheint das Gliederungsfeld nicht.

Tipp: Alternativ können Sie diese Option über den Menübefehl Arbeitsblatt > Gliederung > Gliede-
rungsfeld automatisch anzeigen ein- und ausschalten.

¡ Gliederungsansicht schützen 

Wenn diese Option aktiviert ist, wird die Gliederung geschützt, wenn Sie den Blattschutz für das Ar-
beitsblatt aktivieren (siehe dazu auch Abschnitt Blattschutz).

Bei aktiviertem Blattschutz wird also der aktuelle Zustand der Gliederung "eingefroren". Der Anwender
kann weder gruppierte Zellen ein- oder ausblenden, noch Zellen gruppieren oder ihre Gruppierung auf-
heben.
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Internet-Funktionen
In diesem Kapitel lernen Sie die wichtigsten Internet-Funktionen von PlanMaker kennen:

¡ Hyperlinks verwenden 

Sie können in Ihren Dokumenten jederzeit Hyperlinks (Verknüpfungen) an beliebigen Textstellen an-
bringen, die dann per Mausklick beispielsweise eine Webseite oder ein anderes PlanMaker-Dokument
öffnen.

¡ Dokumente im HTML-Format speichern 

PlanMaker-Dokumente lassen sich auch in das HTML-Format exportieren. Rufen Sie dazu den Menü-
befehl Datei > Speichern unter auf und wählen Sie in der Liste Dateityp das Format HTML.

Ausführliche Informationen dazu folgen auf den nächsten Seiten.

Hyperlinks verwenden
Mit dem Menübefehl Format > Hyperlink können Sie Zellinhalte oder komplette Zellen jederzeit mit ei-
nem Hyperlink versehen. Hyperlinks sind Verknüpfungen auf z.B. Webseiten oder andere Dokumente, die
sich dann einfach per Mausklick aufrufen lassen.

Wenn Sie eine Zelle beispielsweise mit einem Link auf eine Webseite versehen, wird künftig beim Ankli-
cken dieses Links automatisch der Internet-Browser gestartet und diese Seite darin aufgerufen. 

Als Ziel für Hyperlinks ist übrigens auch der Dateiname eines anderen Dokuments erlaubt. Dieses wird
dann beim Anklicken des Links automatisch geöffnet.

Hyperlink erstellen

Um einen Hyperlink zu erzeugen, gehen Sie wie folgt vor:

1. Markieren Sie die Zelle(n) oder Zellinhalte, an die Sie einen Hyperlink anbringen möchten. 

2. Rufen Sie den Menübefehl Format > Hyperlink auf.

3. Geben Sie bei URL oder Datei das Ziel für den Hyperlink an: Tragen Sie dazu den Pfad und Namen der
Internet-Ressource oder Datei ein, auf die der markierte Text verweisen soll.

Für Links auf Internet-Seiten muss "http://" und die Adresse der Seite eingetragen werden – zum Bei-
spiel "http://www.example.com/index.htm". 

4. Darunter können Sie auf Wunsch noch ein Sprungziel (eine Textmarke oder eine Zelladresse) in dem zu
öffnenden Dokument angeben (siehe unten). Normalerweise lassen Sie dieses Feld jedoch leer.

5. Bestätigen Sie mit OK.

Der Hyperlink wird nun erstellt. Sie erkennen das daran, dass sich die Farbe des Textes ändert, um das Vor-
handensein eines Links anzuzeigen.
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Tipp: Alternativ können Links auch mit der Tabellenfunktion HYPERLINK eingefügt werden, die we-
sentlich flexibler in der Anwendung ist

Springen zu einer bestimmten Textmarke oder Zelladresse

Im obigen Dialog können Sie bei Bedarf auch ein Sprungziel im zu öffnenden Dokument angeben. Tragen
Sie dazu bei Sprungziel die Textmarke (bei HTML-Dokumenten) beziehungsweise die Zelladresse (bei
PlanMaker-Dokumenten) ein, zu der gesprungen werden soll.

Tragen Sie beispielsweise bei Datei oder URL "Umsätze.pmdx" ein und bei Sprungziel die Adresse D42,
wird beim Aufrufen dieses Links die Datei Umsätze.pmdx geöffnet und der Zellrahmen darin auf die Zelle
D42 gesetzt.

Platzhalter in Hyperlinks

Tipp: Sie können in Hyperlinks den Platzhalter * verwenden. Dieser steht stellvertretend für den Zellinhalt.

Beispiel:

Sie rufen bei einer noch leeren Zelle den Menübefehl Format > Hyperlink auf und tragen bei Datei oder
URL http://* ein. Geben Sie in diese Zelle nun beispielsweise www.example.com ein, zeigt der Link nun-
mehr auf die Internet-Adresse http://www.example.com.

Dies funktioniert auch mit anderen Protokollen, zum Beispiel mailto:* für E-Mail-Adressen.

Hyperlink aufrufen

Um einen Hyperlink aufzurufen, klicken Sie die mit dem Hyperlink versehene Zelle oder Textstelle einfach
mit der Maustaste an. PlanMaker öffnet daraufhin das verknüpfte Dokument.

Alternativ können Sie auch die Schreibmarke auf eine beliebige Position innerhalb des Linktextes setzen
und dann den Menübefehl Bearbeiten > Gehe zu Hyperlink aufrufen. 

Hyperlinks bearbeiten oder entfernen

Bestehende Hyperlinks lassen sich wie folgt bearbeiten:

¡ Ziel ändern 

Um das Ziel eines Hyperlinks zu ändern, markieren Sie die Zelle(n) oder den Text mit dem Link und ru-
fen dann den Menübefehl Format > Hyperlink auf. Es erscheint wieder das eingangs beschriebene Dia-
logfenster, in dem Sie das Ziel für den Link editieren können.

Um einen Hyperlink zu entfernen, gehen Sie wie folgt vor:

¡ Linktext/Zelle samt Hyperlink löschen 

Wenn Sie eine Zelle oder einen Textabschnitt löschen, die einen Hyperlink enthält, wird auch der Link
entfernt.

¡ Nur den Hyperlink entfernen 

Soll nur der Hyperlink entfernt werden, die damit versehene Zelle oder Textstelle jedoch erhalten blei-
ben, markieren Sie diese und rufen den Menübefehl Format > Hyperlink entfernen auf.
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Dokumente im HTML-Format speichern
Um ein Dokument im HTML-Format zu speichern, gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Datei > Speichern unter auf.

2. Wählen Sie in der Liste Dateityp das Format HTML.

3. Geben Sie den Dateinamen an, unter dem die Datei gespeichert werden soll, und bestätigen Sie mit OK.

Das Dokument wird nun im HTML-Format gespeichert. 

Dabei werden alle nicht vom HTML-Format unterstützten Formatierungen und Funktionen entfernt. Unter
anderem bedeutet dies:

¡ Formatierungen, die das HTML-Format nicht kennt, werden nicht gespeichert. 

¡ Weiterhin sind HTML-Dateien nicht in der Lage, selbstständig Berechnungen durchzuführen. Deshalb
rechnet PlanMaker beim Speichern im HTML-Format das komplette Arbeitsblatt durch und ersetzt alle
Rechenformeln durch ihre Ergebnisse.

Tipp: Öffnen Sie das Dokument nach dem Speichern mit Ihrem Internet-Browser, um das endgültige
Aussehen zu prüfen.
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Ausgeben von Dokumenten
In diesem Kapitel finden Sie Informationen darüber, wie Sie Ihre Dokumente mit PlanMaker ausgeben kön-
nen.

Das Kapitel enthält folgende Abschnitte:

¡ Druckvorschau 

Im ersten Abschnitt geht es um den Menübefehl Datei > Druckvorschau. Dieser stellt das Dokument
exakt so auf dem Bildschirm dar, wie es beim Ausdruck erscheinen wird, und erspart so unnötige Probe-
drucke.

¡ Drucken eines Dokuments 

Um das aktuelle Dokument dann tatsächlich auf dem Drucker auszugeben, rufen Sie den Menübefehl
Datei > Drucken auf.

¡ Exportieren eines Dokuments als PDF-Datei 

Sie können ein Dokument auch in eine PDF-Datei ausgeben, indem Sie den Menübefehl Datei > Als
PDF-Dokument exportieren aufrufen.

PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort ein geeignetes Anzeige-
programm installiert ist. Alle Formatierungen und Objekte des Dokuments werden dabei originalgetreu
wiedergegeben.

¡ Versenden eines Dokuments per E-Mail 

Schließlich lassen sich Dokumente auch per E-Mail versenden. Hierfür ist der Menübefehl Datei > Ver-
senden zuständig.

Ausführliche Informationen zu diesen Funktionen folgen auf den nächsten Seiten.

Druckvorschau
Die Druckvorschau gibt ein Dokument exakt so auf dem Bildschirm wieder, wie es im Ausdruck aussehen
wird. Dies erspart unnötige Probeausdrucke.

Um die Druckvorschau zu starten, rufen Sie den Menübefehl Datei > Druckvorschau auf. 

Um sie wieder zu beenden, klicken Sie auf die Schaltfläche Schließen oder betätigen die Taste Esc.

Die Symbolleiste der Druckvorschau

Die Druckvorschau erscheint in einem eigenen Fenster. Dieses enthält eine Symbolleiste mit folgenden
Funktionen:
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Diese Schaltflächen dienen zum Blättern von Seite zu Seite. Die erste Schaltfläche ruft die erste Seite auf,
die Schaltfläche ganz rechts die letzte Seite. Die beiden Schaltflächen mit einfachen Pfeilen blättern je eine
Seite vor oder zurück. 

Das Eingabefeld in der Mitte erlaubt das gezielte Aufschlagen einer bestimmten Seite. Klicken Sie dazu in
dieses Eingabefeld, tippen Sie die Seitenzahl ein und drücken Sie die Eingabetaste ¿.

Die nächsten drei Schaltflächen haben folgende Funktionen:

¡ Die linke Schaltfläche ruft den Menübefehl Datei > Seite einrichten auf, mit dem Sie das Seitenformat
(Papiergröße, Ausrichtung, Kopf- und Fußzeilen etc.) festlegen können. Siehe auch Abschnitt Seitenfor-
mat einstellen. 

¡ Die mittlere Schaltfläche ruft den Menübefehl Datei > Drucken auf, mit dem Sie das Dokument ausdru-
cken können. Siehe auch Abschnitt Drucken eines Dokuments.

¡ Die rechte Schaltfläche ruft den Menübefehl Datei > Als PDF-Dokument exportieren auf, mit dem Sie
aus dem Dokument eine PDF-Datei erzeugen können. Siehe auch Abschnitt Exportieren eines Doku-
ments als PDF-Datei.

In diesem Bereich können Sie die Vergrößerungsstufe ändern. Tragen Sie dazu in das Eingabefeld den ge-
wünschten Prozentwert ein und drücken Sie die Eingabetaste ¿. Oder verwenden Sie die Schaltflächen
rechts daneben, mit denen Sie folgende Vergrößerungsstufen einstellen können:

¡ Originalgröße (Vergrößerungsstufe 100%) 

¡ Auf Seitenhöhe zoomen

¡ Auf Seitenbreite zoomen

Die Schaltfläche Schließen beendet die Druckvorschau.

Drucken eines Dokuments
Um das aktuelle Dokument auszudrucken, rufen Sie den Menübefehl Datei > Drucken auf.
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Es erscheint ein Dialogfenster, in dem folgende Einstellungen gemacht werden können:

Drucker

Wählen Sie hier, auf welchem der installierten Drucker der Ausdruck erfolgen soll.

Die Schaltfläche Einrichten öffnet ein Fenster zum Einrichten und Konfigurieren von Druckern. Informa-
tionen hierzu finden Sie im Handbuch zu Ihrem Drucker. 

Linux-Anwender können hier außerdem das Kommando eintragen, das den Druckvorgang einleiten soll.

Drucken

Bestimmen Sie hier, welcher Teil des Dokuments gedruckt werden soll:

¡ Gesamtes Dokument 

Das gesamte Dokument (mit allen Arbeitsblättern) drucken.

¡ Nur markierte Zellen 

Nur die Zellen drucken, die derzeit im aktuellen Arbeitsblatt markiert sind.

¡ Aktuelles Arbeitsblatt 

Nur das aktuelle Arbeitsblatt drucken.
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¡ Nur markierte Arbeitsblätter 

Nur diejenigen Arbeitsblätter drucken, die derzeit im Arbeitsblattregister markiert sind.

¡ Nur folgende Arbeitsblätter 

Nur bestimmte Arbeitsblätter drucken. Um diese auszuwählen, verwenden Sie die Liste unterhalb dieser
Option. Setzen Sie darin per Mausklick ein Häkchen vor jedes Arbeitsblatt, das gedruckt werden sollen.

Druckbereich ignorieren

Wenn Sie diese Option einschalten, ignoriert PlanMaker beim Drucken alle im Dokument definierten
Druckbereiche. 

Hintergrundinformationen: Sie können bei Bedarf für jedes Arbeitsblatt einen Druckbereich definieren.
Beim Drucken des Arbeitsblatts werden dann nur noch diejenigen Zellen ausgegeben, die sich innerhalb
dieses Zellbereichs befinden. Der Rest wird weggelassen. 

Diese Funktion können Sie jederzeit vorübergehend deaktivieren, indem Sie diese Option einschalten.

Mehr Informationen zu Druckbereichen finden Sie im Abschnitt Optionen zum Seitenformat einstellen.

Seiten

Bestimmen Sie hier, welche Seiten gedruckt werden sollen:

¡ Alle 

Alle Seiten drucken.

¡ Seiten: 

Nur die angegebenen Seiten drucken. Tragen Sie dazu die gewünschten Seitennummern ein. Einige Bei-
spiele:

12 Drucke nur Seite 12

12-15 Drucke die Seiten 12 bis 15

12- Drucke alle Seiten ab Seite 12

-12 Drucke die Seiten 1 bis 12

Sie auch mehrere solche Seitenangaben eintragen, indem Sie diese durch Kommata trennen:

2-5, 12 Drucke die Seiten 2 bis 5 und die Seite 12

etc.

¡ Außerdem können Sie über die Option Zu druckende Seiten festlegen, ob alle gewählten Seiten oder
nur die Seiten mit gerader beziehungsweise ungerader Seitennummer gedruckt werden sollen. 

¡ Bei Seiten pro Blatt können Sie bestimmen, wie viele Seiten auf ein Blatt Papier gedruckt werden sol-
len. Normalerweise druckt PlanMaker pro Blatt nur eine Seite aus, Sie können das Programm aber an-
weisen, pro Blatt beispielsweise vier (entsprechend verkleinerte) Seiten auf einmal auszugeben.
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Optionen

Dieser Bereich enthält zusätzliche Optionen zum Drucken:

¡ Exemplare 

Hier lässt sich einstellen, wie viele Kopien des Dokuments gedruckt werden sollen.

¡ Kopien sortieren 

Diese Option bestimmt, ob die Druckausgabe beim Drucken mehrerer Kopien eines Dokuments nach
Seitennummern sortiert werden soll.

Ist die Option eingeschaltet, werden beim Drucken mehrerer Kopien eines z.B. dreiseitigen Dokuments
folgende Seiten ausgegeben: 1-2-3, 1-2-3, 1-2-3, ...

Wird sie ausgeschaltet, ist die Reihenfolge hingegen: 1-1-1..., 2-2-2..., 3-3-3...

Hinweis: Einige Drucker unterstützen diese Funktion nicht.

¡ In Datei drucken 

Lenkt die Druckausgabe in eine Datei um.

¡ Ohne Bilder 

Überspringt beim Ausdruck alle Grafiken und Zeichnungen (nützlich für schnelle Testausdrucke).

¡ Umgekehrte Reihenfolge 

Druckt erst die letzte zu druckende Seite, dann die vorletzte etc.

Den Ausdruck starten Sie mit OK.

Tipp: Bevor Sie etwas tatsächlich ausdrucken, können Sie den Menübefehl Datei > Druckvorschau auf-
rufen, um eine Vorschau des Ausdrucks auf dem Bildschirm zu erhalten. Dies erspart Ihnen unnötige Pro-
bedrucke.

Exportieren eines Dokuments als PDF-Datei
Sie können ein Dokument auch in eine PDF-Datei ausgeben.

PDF-Dateien lassen sich auf praktisch jedem Computer betrachten, sofern dort ein geeignetes Anzeigepro-
gramm (zum Beispiel der "Adobe Reader") installiert ist. Alle Formatierungen und Objekte (Grafiken etc.)
des Dokuments werden dabei originalgetreu wiedergegeben.

Um von einem Dokument eine PDF-Datei zu erzeugen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Datei > Als PDF-Dokument exportieren auf.

2. Es erscheint ein Dialogfenster. Nehmen Sie darin die gewünschten Einstellungen vor (siehe unten) und
bestätigen Sie mit OK.

3. Nun erscheint ein weiterer Dialog. Geben Sie darin den Dateinamen an, unter dem die PDF-Datei gespei-
chert werden soll, und bestätigen Sie mit OK.
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Die PDF-Datei wird nun erzeugt. Um sie zu betrachten, starten Sie ein geeignetes Anzeigeprogramm und
öffnen die Datei darin.

Tipp: Falls auf Ihrem Gerät kein Anzeigeprogramm für PDF-Dokumente installiert ist, suchen Sie mit
Ihrem Web-Browser einfach nach "PDF Viewer". Sie werden zahlreiche geeignete Programme finden;
viele davon sind kostenlos.

Das Dialogfenster des obigen Befehls erlaubt es Ihnen, folgende Einstellungen zum PDF-Export vorzuneh-
men:

Karteikarte Allgemein

Auf dieser Karteikarte können Sie festlegen, ob nur Teile des Dokuments ausgegeben werden sollen, und
weitere Einstellungen machen. Die Optionen entsprechen weitgehend denen des Befehls Drucken, der im
Abschnitt Drucken eines Dokuments beschrieben wurde.

Darüber hinaus sind folgende Optionen zusätzlich verfügbar:

¡ Lesezeichen für Arbeitsblätter anlegen 

Wenn diese Option aktiviert ist, legt PlanMaker in der PDF-Datei automatisch ein Lesezeichen für jedes
Arbeitsblatt an, das das Dokument enthält. 

In Ihrem PDF-Betrachter werden diese Lesezeichen dann in einer Leiste links vom Dokument angezeigt.
Sie können diese Leiste wie ein interaktives Inhaltsverzeichnis verwenden: Klicken Sie eines der Lese-
zeichen an, springt ihr PDF-Betrachter blitzschnell zum entsprechenden Arbeitsblatt in der PDF-Datei.

Tipp: Falls diese Leiste bei Ihrem PDF-Betrachter nicht angezeigt werden sollte, suchen Sie darin nach
einem Befehl zum Anzeigen von Lesezeichen und aktivieren Sie diesen.

¡ Tagged PDF erzeugen 

Wenn diese Option aktiviert ist, werden in der PDF-Datei Informationen über die logische Struktur des
Dokuments gespeichert. 

Diese Informationen sorgen dafür, dass Ihre PDF-Dateien barrierefrei sind und beispielsweise auch mit
PDF-Betrachtern verwendet werden können, die den Inhalt des Dokuments in Blindenschrift wiederge-
ben oder ihn vorlesen.

Karteikarte Einstellungen

Auf dieser Karteikarte können Sie Einstellungen zur Ausgabequalität machen:

¡ AutoForm-Optionen 

Hier lässt sich die Qualitätsstufe (sprich: Auflösung) einstellen, mit der AutoFormen und alle anderen
Arten von Zeichnungen exportiert werden. Je höher die Qualitätsstufe, desto größer wird die erzeugte
PDF-Datei.

¡ Grafikoptionen 

Hier können Sie festlegen, ob Bilder mit einer verlustfreien Komprimierung oder der verlustbehafteten
JPEG-Komprimierung gespeichert werden sollen. Bei der JPEG-Komprimierung lässt sich weiterhin
die Qualitätsstufe einstellen.
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Tipp: Normalerweise sollten Sie hier die verlustfreie Komprimierung wählen, da sie optimale Qualität
gewährleistet. Enthält Ihr Dokument allerdings viele Bilder (speziell Fotos), kann dies zu einer sehr
großen PDF-Datei führen. In diesem Falle ist die Verwendung der JPEG-Komprimierung zu empfeh-
len, da diese Fotos erheblich stärker komprimieren kann.

Die Option Für Transparenzen Alphakanal verwenden bestimmt, ob für die Darstellung von Transpa-
renzen in Grafiken und Zeichnungen ein "Alphakanal" verwendet werden soll. Normalerweise sehen die-
se am besten aus, wenn diese Option eingeschaltet ist. Manche PDF-Betrachter stellen Alphakanäle je-
doch fehlerhaft dar, weshalb Sie diese Option auch abschalten können. 

¡ Weitere Optionen 

PlanMaker-Dokument einbetten: Speichert eine Kopie des PlanMaker-Dokuments innerhalb der PDF-
Datei. Sie können diese PDF-Datei dann direkt in PlanMaker öffnen, worauf das Programm die PlanMa-
ker-Datei daraus extrahiert und anzeigt.

Die Datei nach dem Export im PDF-Betrachter öffnen: Startet nach dem Erzeugen der PDF-Datei au-
tomatisch Ihren PDF-Betrachter (sofern einer installiert ist) und zeigt die Datei darin an.

Für Hyperlinks relative Pfade verwenden: Wandelt den Dateipfad von Hyperlinks (Verknüpfungen)
auf Dateien automatisch in einen relativen Pfad (statt eines absoluten Pfads) um. Wenn Sie also bei-
spielsweise einen Link auf die Datei c:\Dokumente\Listen\test.txt eingefügt haben und die
PDF-Datei in den Ordner c:\Dokumente exportieren, wird dieser Link automatisch in "Listen\test.txt"
umgewandelt.

¡ Schriftoptionen 

Über die Option Schriften einbetten können Sie festlegen, ob die im Dokument verwendeten Schriftar-
ten in die PDF-Datei eingebettet werden sollen. 

Ist das Einbetten von Schriften eingeschaltet, wird die erzeugte PDF-Datei auf jedem Computer in den
ursprünglich verwendeten Schriften angezeigt – auch wenn diese Schriften dort nicht installiert sind. Ist
die Option hingegen ausgeschaltet, wird die PDF-Datei mit automatisch gewählten Ersatzschriften dar-
gestellt. 

Die Option Nur verwendete Zeichen einbetten bestimmt, ob beim Einbetten von Schriften jeweils alle
Zeichen einer Schrift oder nur die tatsächlich im Dokument vorkommenden Zeichen eingebettet werden
sollen. Das Einschalten dieser Option hat den Vorteil, dass die Dateigröße der PDF-Datei nicht so stark
anwächst.

Karteikarte Ansicht

Diese Karteikarte enthält erweiterte Optionen zur Darstellung der PDF-Datei in einem PDF-Betrachter:

¡ Navigationsfenster 

Bestimmt, was im Navigationsfenster des PDF-Betrachters angezeigt werden soll. (Das Navigationsfens-
ter ist die Leiste, die links von der PDF-Datei angezeigt wird.)

Verfügbare Optionen:

Standard: Standardeinstellung des PDF-Betrachters verwenden

Keine Navigation: Im Navigationsfenster nichts anzeigen

Lesezeichen: Im Navigationsfenster alle Lesezeichen des Dokuments anzeigen

Miniaturseiten: Im Navigationsfenster Miniaturansichten aller Seiten des Dokuments anzeigen
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¡ Vergrößerungsstufe 

Bestimmt, mit welcher Vergrößerungsstufe (Zoom) die PDF-Datei angezeigt werden soll:

Standard: Standardeinstellung des PDF-Betrachters verwenden

Ganze Seite: Vergrößerungsstufe so einstellen, dass die gesamte Seite zu sehen ist

Seitenbreite: Auf die Seitenbreite zoomen

Seitenhöhe: Auf die Seitenhöhe zoomen

Benutzerdefiniert: Eigene Vergrößerungsstufe in Prozent festlegen

¡ Seitenlayout 

Bestimmt, mit welchem Layout die Seiten dargestellt werden sollen:

Standard: Standardeinstellung des PDF-Betrachters verwenden

Einzelne Seiten: Als einzelne Seiten anzeigen

Doppelseiten - ungerade Seiten links: Als Doppelseiten anzeigen (mit den ungeraden Seiten auf der
linken Seite)

Doppelseiten - ungerade Seiten rechts: Als Doppelseiten anzeigen (mit den ungeraden Seiten auf der
rechten Seite)

¡ Weitere Einstellungen 

Hier finden Sie folgende zusätzliche Optionen:

Dokumententitel anzeigen: Zeigt in der Titelleiste des PDF-Betrachters den Titel des Dokuments (statt
seines Dateinamens) an. Tipp: Den Titel können Sie auf der Karteikarte Infos im Dialogfenster des Men-
übefehls Datei > Eigenschaften eintragen.

PDF-Betrachter auf Bildschirm zentrieren: Zentriert das Programmfenster des PDF-Betrachters nach
dem Öffnen der PDF-Datei automatisch in der Bildschirmmitte.

Vollbildmodus: Schaltet den PDF-Betrachter nach dem Öffnen der PDF-Datei automatisch in den Voll-
bildmodus.

Menüleiste verbergen: Blendet die Menüleiste des PDF-Betrachters aus.

Symbolleisten verbergen: Blendet sämtliche Symbolleisten des PDF-Betrachters aus.

Steuerelemente verbergen: Blendet die Steuerelemente für das Navigationsfenster aus.

Karteikarte Schutz

Mit Hilfe dieser Karteikarte können Sie die zu erzeugende PDF-Datei verschlüsseln und mit einem Kenn-
wort vor dem Öffnen oder Abändern durch Unberechtigte schützen.

¡ Art der Verschlüsselung 

Hier können Sie bestimmen, ob die PDF-Datei verschlüsselt werden soll. Neben einer 40 Bit-Verschlüs-
selung, die mit relativ wenig Zeitaufwand zu knacken ist, ist auch die erheblich sicherere 128 Bit-Ver-
schlüsselung verfügbar.

Hinweis: Die anderen Optionen in diesem Dialog werden erst verfügbar, wenn Sie eine Verschlüsse-
lungsart ausgewählt haben.
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¡ Kennwort zum Öffnen des Dokuments 

Wenn Sie hier ein Kennwort eingeben, fragt der PDF-Betrachter beim Öffnen der PDF-Datei nach die-
sem Kennwort. Wird ein falsches Kennwort eingegeben, kann der Anwender die Datei nicht öffnen.

Wenn Sie nichts eingeben, kann jedermann die Datei ohne Kennwort öffnen.

¡ Kennwort zum Setzen von Zugriffsrechten 

Des Weiteren können Sie die Zugriffsrechte für die PDF-Datei einschränken. Geben Sie dazu ein Kenn-
wort für das Ändern der Rechte ein. Legen Sie dann mit Hilfe der Optionen im Bereich Zugriffsrechte
fest, welche Rechte Anwender haben sollen.

Hintergrundinformation: Manche PDF-Betrachter verfügen über einen Befehl zum Ändern der Zugriffs-
rechte. Ruft ein Anwender diesen Befehl auf, darf er nur fortfahren, wenn er das Kennwort eingibt, das
Sie hier festgelegt haben.

¡ Zugriffsrechte 

Hier können Sie bestimmen, welche Zugriffsrechte Anwender auf die PDF-Datei haben sollen, wenn sie
diese in einem PDF-Betrachter öffnen. (Nur verfügbar, wenn Sie oben ein Kennwort für das Setzen von
Zugriffsrechten eingegeben haben.)

Versenden eines Dokuments per E-Mail
Sofern auf Ihrem Gerät ein geeignetes E-Mail-Programm installiert ist, können Sie Dokumente direkt von
PlanMaker aus per E-Mail versenden.

Gehen Sie dazu wie folgt vor:

1. Erstellen oder öffnen Sie das zu versendende Dokument.

2. Rufen Sie in PlanMaker den Menübefehl Datei > Versenden auf. 

3. Wählen Sie das Format, in dem das Dokument verschickt werden soll. 

Hinweis: Wenn Sie hier das Format PlanMaker-Dokument auswählen, erhält der Empfänger eine E-Mail mit der PlanMaker-Datei als Anhang.
Um diesen Anhang öffnen zu können, muss er also ebenfalls PlanMaker installiert haben.

PlanMaker erzeugt nun eine E-Mail mit dem Dokument als Anhang und übergibt diese Ihrem E-Mail-Pro-
gramm.
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Schützen von Zellen und Tabellen
Es gibt mehrere Möglichkeiten, Schutzmechanismen in Dokumente einzubauen. So können Sie beispiels-
weise das Editieren bestimmter Zellen verbieten oder gar das gesamte Dokument mit einem Kennwort ge-
gen unberechtigtes Lesen schützen.

Im Einzelnen stehen folgende Schutzmechanismen zur Verfügung:

¡ Blattschutz 

Mit dem Blattschutz können Sie bestimmte Zellen des Arbeitsblatts schützen. Wird der Blattschutz akti-
viert, lassen sich diese Zellen beispielsweise nicht mehr ändern oder ihr Inhalt wird nicht mehr ange-
zeigt.

¡ Arbeitsmappenschutz 

Mit dem Arbeitsmappenschutz können Sie verhindern, dass Anwender Arbeitsblätter hinzufügen, lö-
schen oder ein-/ausblenden können.

¡ Dokumentschutz 

Der Dokumentschutz schützt das komplette Dokument mit einem Kennwort gegen unberechtigtes Lesen
oder Speichern. Beim Leseschutz wird das Dokument zusätzlich verschlüsselt.

Mehr zu den einzelnen Schutzarten erfahren Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Blattschutz
Schalten Sie den Blattschutz für ein Arbeitsblatt ein, um dieses vor ungewollten Änderungen zu schützen.
Bei aktiviertem Blattschutz werden alle entsprechend gekennzeichneten Zellen auf dem aktuellen Arbeits-
blatt mit einem Schutz versehen. Weiterhin sind zahlreiche Menübefehle ausgegraut (also nicht mehr auf-
rufbar) und es lassen sich keine Objekte mehr einfügen.

Bevor Sie den Blattschutz aktivieren, müssen Sie jedoch mit dem Menübefehl Format > Zelle festlegen,
welche Zellen geschützt werden sollen, und wie umfangreich der Schutz sein soll.

Das Schützen von Zellen erfolgt also in zwei Schritten:

¡ Erster Schritt: Schutzeinstellungen für Zellen festlegen 

¡ Zweiter Schritt: Blattschutz aktivieren

Lesen Sie dazu die nächsten Seiten.
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Erster Schritt: Schutzeinstellungen für Zellen festlegen

Um Zellen zu schützen, legen Sie zunächst fest, welche Zellen geschützt werden sollen und wie umfang-
reich der Schutz sein soll. 

Dazu gehen Sie wie folgt vor:

1. Markieren Sie die Zelle(n), deren Schutzeinstellungen geändert werden sollen.

2. Rufen Sie den Menübefehl Format > Zelle auf.

3. Wechseln Sie auf die Karteikarte Schutz.

4. Wählen Sie die gewünschten Schutzeinstellungen (siehe unten).

5. Bestätigen Sie mit OK.

Die einzelnen Schutzeinstellungen im Dialogfenster dieses Befehls haben folgende Bedeutung:

¡ Zelle schützen 

Schützt die Zelle gegen Änderungen.

Bei aktiviertem Blattschutz kann also weder ihr Inhalt noch ihre Formatierung verändert werden.

Wichtig: Standardmäßig ist diese Option bei allen Zellen aktiviert. Wenn Sie also möchten, dass be-
stimmte Zellen bei aktiviertem Blattschutz noch editierbar sein sollen, müssen Sie die Option Zellen
schützen für diese Zellen ausschalten.

¡ Formel nicht anzeigen 

Zeigt bei Zellen, die eine Berechnung enthalten, die enthaltene Formel nicht mehr an, sondern nur ihr Er-
gebnis.

Bei aktiviertem Blattschutz kann also nicht mehr herausgefunden werden, welche Berechnung diese Zel-
le enthält.

¡ Zelle nicht anzeigen 

Verbirgt den Inhalt der Zelle auf dem Bildschirm.

Bei aktiviertem Blattschutz wird die Zelle also unsichtbar. Sie erscheint jedoch weiterhin im Ausdruck
(siehe nächste Option).

¡ Zelle nicht ausdrucken 

Unterdrückt den Inhalt der Zelle im Ausdruck.

Bei aktiviertem Blattschutz erscheint die Zelle also im Ausdruck nicht, wenn Sie das Dokument drucken.

Zweiter Schritt: Blattschutz aktivieren

Der zweite Schritt beim Schützen von Zellen besteht darin, den Blattschutz für das aktuelle Arbeitsblatt zu
aktivieren.
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Denn wenn Sie (wie im ersten Schritt "Schutzeinstellungen für Zellen festlegen" beschrieben) die
Schutzeinstellungen von Zellen geändert haben, hat dies noch keine Auswirkungen auf das Dokument. Sie
müssen den Blattschutz erst aktivieren, damit diese Einstellungen wirksam werden.

Hinweis: Der Aktivieren des Blattschutzes wirkt sich nur auf das aktuelle Arbeitsblatt aus.

Um den Blattschutz für ein Arbeitsblatt zu aktivieren, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Blattschutz auf.

2. Nun können Sie auf Wunsch das Kennwort eingeben, das der Anwender eingeben muss, wenn er den
Blattschutz wieder deaktivieren will.

Wenn Sie kein Kennwort vergeben möchten, lassen Sie das Eingabefeld einfach leer.

3. Bestätigen Sie mit OK.

Der Blattschutz ist nun aktiviert; die Schutzeinstellungen der Zellen werden jetzt also wirksam.

Sie merken dies unter anderem daran, dass sich nur noch Zellen editieren lassen, bei denen die Einstellung
Zelle schützen nicht aktiviert wurde. Diese Zellen werden mit einem kleinen grünen Dreieck in der linken
unteren Ecke gekennzeichnet. Dadurch sieht man sofort, welche Zellen sich bei aktiviertem Blattschutz
noch verändern lassen.

Tipp: Wenn Sie den Blattschutz aktivieren, können beim Bewegen in der Tabelle mit der Tabulatortaste
Tab ausschließlich editierbare Zellen angefahren werden können. Geschützte Zellen werden übersprun-
gen.

Bei aktiviertem Blattschutz gibt es außerdem folgende Einschränkungen: 

¡ Die meisten Menübefehle zum Bearbeiten des Blattes sind gesperrt. 

¡ Bei Objekten lassen sich Position, Größe und auch alle anderen Eigenschaften nicht mehr verändern (au-
ßer bei Objekten, bei denen Sie die Eigenschaft Sperren deaktiviert haben).

¡ Text in Textrahmen lässt sich nicht mehr verändern (außer bei Objekten, bei denen Sie die Eigenschaft
Text sperren deaktiviert haben).

¡ Es lassen sich keine Objekte mehr auf dem Arbeitsblatt einfügen.

Blattschutz deaktivieren

Wenn Sie den Blattschutz aktiviert haben, können Sie diesen jederzeit wieder aufheben, indem Sie den
Menübefehl Weiteres > Blattschutz aufheben aufrufen.

Der Blattschutz wird dadurch wieder ausgeschaltet.

Die über den Menübefehl Format > Zelle festgelegten Schutzeinstellungen sind nun also wieder unwirk-
sam. PlanMaker merkt sie sich aber weiterhin. Wenn Sie den Blattschutz also erneut aktivieren, werden die-
selben Schutzeinstellungen wieder aktiv.

Tipp: Wenn Sie ein Dokument bei aktiviertem Blattschutz speichern, wird der Blattschutz automatisch
wieder aktiviert, wenn das Dokument das nächste Mal geöffnet wird. Wenn der Blattschutz weiterhin mit
einem Kennwort gesichert ist, kann er nur mit dem korrekten Kennwort deaktiviert werden. So können
Sie Dokumente gegen Veränderungen durch Unbefugte schützen.
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Arbeitsmappenschutz
Wenn Sie in einem Dokument den Arbeitsmappenschutz aktivieren, bewirkt das, dass sich darin ab sofort
keinerlei Änderungen am Arbeitsblattregister mehr durchführen lassen. Auch der Menübefehl Arbeitsblatt
> Blatt ist nicht mehr verfügbar. 

Dies hat vor allem folgende Auswirkungen:

¡ Der Anwender kann keine Arbeitsblätter mehr hinzufügen. 

¡ Arbeitsblätter lassen sich nicht mehr kopieren, löschen oder umbenennen.

¡ Arbeitsblätter lassen sich nicht mehr ein- oder ausblenden.

Um den Arbeitsmappenschutz einzuschalten, rufen Sie den Menübefehl Weiteres > Arbeitsmappenschutz
auf. Mit dem gleichen Befehl können Sie ihn auch wieder ausschalten.

Weitere Informationen dazu finden Sie auf den nächsten Seiten.

Arbeitsmappenschutz aktivieren

Um den Arbeitsmappenschutz für das aktuelle Dokument zu aktivieren, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Arbeitsmappenschutz auf.

2. Nun können Sie auf Wunsch das Kennwort eingeben, das der Anwender eingeben muss, wenn er den
Arbeitsmappenschutz wieder deaktivieren will. 

Wenn Sie kein Kennwort vergeben möchten, lassen Sie das Eingabefeld einfach leer.

3. Bestätigen Sie mit OK.

Der Arbeitsmappenschutz ist nun aktiviert; es lassen sich nun also keine Arbeitsblätter mehr einfügen, lö-
schen, ein-/ausblenden etc.

Darüber hinaus ist der größte Teil der Optionen im Dialogfenster des Menübefehls Datei > Eigenschaften
nicht mehr verfügbar.

Arbeitsmappenschutz deaktivieren

Wenn im aktuellen Dokument der Arbeitsmappenschutz aktiviert wurde, können Sie diesen jederzeit wieder
deaktivieren, indem Sie den Menübefehl Weiteres > Arbeitsmappenschutz aufheben aufrufen.

Der Arbeitsmappenschutz wird dadurch wieder ausgeschaltet; das Einfügen, Löschen, Ein-/Ausblenden von
Arbeitsblättern etc. ist also wieder möglich.
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Tipp: Wenn Sie ein Dokument mit aktiviertem Arbeitsmappenschutz speichern, wird der Arbeitsmappen-
schutz künftig bei jedem Öffnen dieses Dokuments automatisch erneut aktiviert. Wenn der Schutz außer-
dem mit einem Kennwort gesichert ist, kann er nur mit dem korrekten Kennwort deaktiviert werden.

Dokumentschutz
Sie können Dokumente gegen unberechtigtes Lesen oder Speichern schützen, indem Sie sie mit einem Do-
kumentschutz – genauer gesagt einem Lese- und/oder Schreibschutz – versehen. Öffnen beziehungsweise
Speichern eines geschützten Dokuments ist nur nach Eingabe des korrekten Kennworts möglich.

Um ein Dokument zu schützen, rufen Sie darin den Menübefehl Datei > Eigenschaften auf, wechseln auf
die Karteikarte Schutz und wählen die Art des Dokumentschutzes. Tragen Sie außerdem das gewünschte
Lese- und/oder Schreibkennwort ein.

Es gibt folgende Arten von Dokumentschutz:

¡ Kein Schutz 

¡ Schreibschutz (Dokument kann geöffnet werden, lässt sich aber nur mit Kennwort speichern)

¡ Leseschutz (Dokument kann nur mit Kennwort geöffnet werden)

¡ Schutz abhängig vom Kennwort (Kombination aus Lese- und Schreibschutz)

Ausführliche Informationen folgen auf den nächsten Seiten.

Dokumentschutz aktivieren

Sie können Dokumente vor unberechtigtem Lesen oder Speichern schützen, indem Sie sie mit einem Doku-
mentschutz – genauer gesagt einem Lese- und/oder Schreibschutz – versehen. Öffnen beziehungsweise Spei-
chern eines geschützten Dokuments ist nur nach Eingabe des Kennworts möglich.

Beim Leseschutz wird das Dokument zusätzlich verschlüsselt, damit es auch mit anderen Programmen nicht
eingesehen werden kann.

Um ein Dokument zu schützen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf. 

2. Wechseln Sie auf die Karteikarte Schutz.

3. Wählen Sie die gewünschte Art von Dokumentschutz (siehe unten).

4. Im Gegensatz zu Blattschutz und Arbeitsmappenschutz müssen Sie beim Dokumentschutz immer ein
Kennwort vergeben. Tragen Sie nun also ein Lese- und/oder Schreibkennwort ein (mindestens 4, maxi-
mal 15 Zeichen).

Wichtig: Wenn Sie ein Kennwort vergessen, kann das Dokument nicht mehr geöffnet beziehungswei-
se gespeichert werden. Es ist daher ratsam, sich das Kennwort zu notieren. Achten Sie dabei genau auf
die Groß-/Kleinschreibung!
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5. Bestätigen Sie mit OK.

6. Es erscheint ein Dialog, in dem Sie das Lese- und/oder Schreibkennwort zur Kontrolle noch einmal ein-
geben müssen.

7. Bestätigen Sie mit OK.

8. Verlassen Sie das Dialogfenster mit OK.

9. Speichern Sie das Dokument, damit die Änderungen wirksam werden.

Zukünftig wird beim Öffnen dieses Dokuments automatisch das Kennwort erfragt. Wenn das richtige Kenn-
wort angegeben wird, wird der Schutz vorübergehend außer Kraft gesetzt.

Sie können im obigen Dialog zwischen folgenden Arten von Dokumentschutz wählen:

¡ Kein Schutz 

Das Dokument wird nicht geschützt. Dies ist die Standardeinstellung.

¡ Schreibschutz 

Beim Öffnen des Dokuments wird der Anwender dazu aufgefordert, das Schreibkennwort einzugeben.
Das Dokument kann nur dann gespeichert werden, wenn hier das korrekte Schreibkennwort angegeben
wird. 

Wird ein falsches Kennwort oder überhaupt nichts eingegeben, wird das Dokument schreibgeschützt ge-
öffnet. Es kann dann nicht gespeichert werden – auch nicht unter einem anderen Namen.

¡ Leseschutz 

Versucht ein Anwender, das Dokument zu öffnen, wird er dazu aufgefordert, das Lesekennwort anzuge-
ben. Wird ein falsches Kennwort eingegeben, lässt sich das Dokument nicht öffnen. 

Das Dokument wird hierbei außerdem verschlüsselt gespeichert, damit es auch mit anderen Programmen
nicht eingesehen werden kann.

¡ Schutz abhängig vom Kennwort 

Hier erscheinen beim Öffnen des Dokuments zwei Kennwortabfragen hintereinander. Erst wird nach
dem Lesekennwort gefragt, dann nach dem Schreibkennwort.

Gibt der Anwender nur das Lesekennwort ein, darf er das Dokument öffnen, aber nicht speichern. 

Gibt er außerdem das Schreibkennwort ein, hat er vollen Zugriff, kann das Dokument also auch spei-
chern.

Gibt er ein falsches Kennwort oder überhaupt nichts ein, wird der Zugriff auf das Dokument komplett
verweigert.

Verschlüsselungsmethode: "Höchste Kompatibilität" oder "Höchste Sicherheit"?

Bei Dokumenten mit Leseschutz oder einem Schutz abhängig vom Kennwort können Sie zusätzlich die
gewünschte Verschlüsselungsmethode auswählen. 

Hinweis: Diese Einstellung betrifft in erster Linie neu erstellte Dokumente. Beim Öffnen eines bestehen-
den verschlüsselten Dokuments wird die darin verwendete Verschlüsselungsmethode automatisch ermit-
telt und diese Einstellung dann entsprechend gesetzt. 

Die Wahl der Verschlüsselungsmethode ist insbesondere für Dokumente im Microsoft Excel-Dateiformat
(.xls und .xlsx) wichtig. Manche alten Versionen von Microsoft Office können nämlich Dokumente, die mit
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der neuen Verschlüsselungsmethode "Höchste Sicherheit" verschlüsselt wurden, möglicherweise nicht öff-
nen.

Verfügbare Optionen:

¡ Höchste Kompatibilität 

Beim Speichern des Dokuments wird eine alte Verschlüsselungsmethode verwendet, die von allen Ver-
sionen von Microsoft Office gelesen werden kann. Diese ist allerdings weniger sicher als die andere
Methode.

¡ Höchste Sicherheit 

Es wird eine modernere und sicherere Verschlüsselungsmethode verwendet. Diese kann allerdings von
einigen alten Versionen von Microsoft Office möglicherweise nicht gelesen werden. 

Ausführlichere Details zur derzeit gewählten Verschlüsselungsmethode werden im unteren Teil des Dialogs
angezeigt.

Dokumentschutz deaktivieren

Wenn Sie ein lese- oder schreibgeschütztes Dokument öffnen und dabei das korrekte Kennwort angeben,
wird der Schutz deaktiviert – allerdings nur vorübergehend. Wenn Sie dieses Dokument nämlich schließen,
wird der Schutz wieder "scharfgemacht"; beim nächsten Öffnen erscheint also erneut die Abfrage für das
Kennwort.

Um den Schutz eines Dokuments permanent zu entfernen, gehen Sie wie folgt vor:

1. Öffnen Sie das Dokument.

2. Rufen Sie den Menübefehl Datei > Eigenschaften auf. 

3. Wechseln Sie auf die Karteikarte Schutz.

4. Wählen Sie die Option Kein Schutz.

5. Bestätigen Sie mit OK.

6. Speichern Sie das Dokument, damit die Änderung wirksam wird.

Der Dokumentschutz ist nun dauerhaft deaktiviert.

Beim nächsten Öffnen des Dokuments erscheint keine Kennwortabfrage mehr. Jeder Anwender kann das
Dokument nun wieder öffnen/speichern.
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Fremdformate
PlanMaker speichert Dokumente normalerweise in seinem "hauseigenen" Dateiformat namens PlanMaker-
Dokument ab. PlanMaker-Dokumente können leicht an der Namenserweiterung .pmdx erkannt werden.
Wenn Sie zum Beispiel ein Dokument unter dem Namen "Lohnsteuer" speichern, lautet sein vollständiger
Dateiname Lohnsteuer.pmdx.

Sie können PlanMaker aber auch anweisen, Dateien in einem anderen Dateiformat zu speichern. Dies ist nö-
tig, wenn Sie beispielsweise ein PlanMaker-Dokument mit einem anderen Programm weiterbearbeiten
möchten. Umgekehrt können Sie mit PlanMaker auch Dokumente öffnen, die mit anderen Tabellenkalkula-
tionen erstellt wurden, also in einem Fremdformat vorliegen.

In diesem Kapitel erfahren Sie alles Wissenswerte dazu. Es enthält folgende Abschnitte:

¡ Speichern und Öffnen von Fremdformaten 

Im ersten Abschnitt erfahren Sie, wie Sie Dokumente in einem anderen Dateiformat speichern oder öff-
nen: Einfach den Menübefehl Datei > Speichern unter beziehungsweise Datei > Öffnen aufrufen und
in der Liste der Dateitypen das gewünschte Format einstellen.

¡ Anmerkungen zum Textformat 

Beim Öffnen oder Speichern von Textdateien erscheint ein Dialogfenster mit zusätzlichen Optionen.
Hier finden Sie alle Informationen dazu.

¡ Anmerkungen zum Excel-Format 

Der letzte Abschnitt widmet sich dem Dateiformat von Microsoft Excel. Sie erfahren darin alles Wis-
senswerte über den Datenaustausch zwischen PlanMaker und Excel.

Lesen Sie dazu die nächsten Seiten.

Speichern und Öffnen von Fremdformaten
Folgendermaßen speichern oder öffnen Sie Dokumente in einem anderen Dateiformat:

Speichern eines Dokuments in einem Fremdformat

Um das aktuelle Dokument in einem anderen Dateiformat zu speichern, rufen Sie den Menübefehl Datei >
Speichern unter auf und öffnen die aufklappbare Liste Dateityp. Wählen Sie darin das gewünschte For-
mat, geben Sie bei Bedarf einen anderen Dateinamen an und bestätigen Sie mit OK.

Öffnen eines in einem Fremdformat vorliegenden Dokuments

Um ein Dokument, das in einem anderen Dateiformat vorliegt, zu öffnen, rufen Sie den Menübefehl Datei >
Öffnen auf, öffnen die Liste der Dateitypen und wählen das Format aus, in dem die Datei vorliegt. Wählen
Sie dann die zu öffnende Datei und bestätigen Sie mit OK.
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Unterstützte Dateiformate

In den Dialogen zum Öffnen und Speichern von Dokumenten werden in der Liste der Dateitypen unter an-
derem folgende Dateiformate angeboten:

¡ PlanMaker-Dokument 

Das Hausformat für PlanMaker-Dokumente, in dem Sie Ihre Dokumente üblicherweise speichern (Na-
menserweiterung: .pmdx).

¡ PlanMaker-Vorlage 

Dokumentvorlage für PlanMaker-Dokumente (Namenserweiterung: .pmvx). Siehe Abschnitt Dokument-
vorlagen

¡ Microsoft Excel-Dokument 

Sie können auch Dokumente im Dateiformat von Microsoft Excel öffnen und speichern. Unterstützt wer-
den sowohl .xls-Dateien (Excel 5.0 bis 2003) als auch .xlsx-Dateien (Excel ab 2007).

Weitere Informationen zum Arbeiten mit Excel-Dateien finden Sie im Abschnitt Anmerkungen zum Ex-
cel-Format.

¡ Microsoft Excel-Vorlage 

Dokumentvorlage für Microsoft Excel-Dokumente

¡ PlanMaker 2012-Datei 

Speichert das Dokument im Dateiformat von PlanMaker 2012, einer älteren Version von PlanMaker
(Namenserweiterung: .pmd).

¡ TextMaker-Datei (nur Speichern) 

Speichert das Dokument in einem von der Textverarbeitung TextMaker lesbaren Dateiformat.

¡ dBase 

dBase-Datenbank, wahlweise mit DOS-, Windows- oder Unicode-Zeichensatz. Vor dem Öffnen/Spei-
chern der Datenbank erscheint ein Dialog, in dem Sie den Zeichensatz auswählen können.

Beachten Sie: Die meisten Datenbanken liegen im Format dBase/DOS vor – nicht im Format dBa-
se/Windows. Selbst Windows-Datenbankprogramme verwenden in der Regel das DOS-Format.

¡ Textdatei 

Textdatei, zum Beispiel mit Tabulatoren oder Strichpunkten als Trenner zwischen den einzelnen Zell-
werten. Siehe Abschnitt Anmerkungen zum Textformat.

Anmerkungen zum Textformat
Wie im vorherigen Abschnitt erwähnt, können Sie mit PlanMaker auch reine Textdateien (unter anderem
auch CSV-Dateien) öffnen und speichern:

¡ Um eine Textdatei zu öffnen, rufen Sie den Menübefehl Datei > Öffnen auf, wählen einfach die ge-
wünschte Datei und bestätigen mit Öffnen. 
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¡ Um ein Dokument als Textdatei zu speichern, rufen Sie den Menübefehl Datei > Speichern unter auf,
wählen bei Dateityp den Eintrag Textdatei, geben den gewünschten Dateinamen ein und bestätigen mit
Speichern.

In beiden Fällen erscheint daraufhin ein zusätzlicher Dialog, in dem sich das Format der Textdatei genau
festlegen lässt.

Der Dialog enthält folgende Optionen:

Optionen beim Speichern einer Textdatei

Wenn Sie ein Dokument als Textdatei speichern, können Sie in dem Dialog folgende Einstellungen vorneh-
men:

¡ Zeichensatz 

Hier können Sie festlegen, mit welchem Zeichensatz die Textdatei gespeichert werden soll.

Hinweis: PlanMaker schlägt automatisch einen geeigneten Zeichensatz vor. In der Regel können Sie die-
se Vorgabe übernehmen.

¡ Datenformat 

Hier können Sie einstellen, in welchem Format die Zellinhalte in der Textdatei gespeichert werden sol-
len. Folgende Optionen stehen zur Wahl:

Trennzeichen zwischen den Feldern: Hier werden die Zellinhalte jeweils durch ein bestimmtes Trenn-
zeichen voneinander getrennt (zum Beispiel einem Strichpunkt oder einem Tabulator).

Beispiel:

Peter;Müller-Lüdenscheidt;12345;Buxtehude

Thomas;Meier;54321;Neustadt

Feste Feldbreiten: Hier hingegen werden die Zellinhalte auf Spalten mit festen Breiten verteilt. Zwi-
schenräume werden dabei mit Leerzeichen aufgefüllt. 

Beispiel:

Peter   Müller-Lüdenscheidt  12345  Buxtehude

Thomas  Meier                54321  Neustadt

¡ Trennzeichen 

Hier können Sie bestimmen, welches Trennzeichen PlanMaker verwenden soll, um die einzelnen Zellin-
halte einer Zeile voneinander abzugrenzen (zum Beispiel Strichpunkte oder Tabulatoren).

Hinweis: Das Trennzeichen sollte innerhalb der Zellinhalte natürlich nicht vorkommen, da PlanMaker
dort sonst aus einer entsprechenden Zelle zwei Einträge machen würde.

¡ Texterkennungszeichen 

Auf Wunsch kann PlanMaker alle Zellen, die Text enthalten, mit einem bestimmten Zeichen umgeben
(zum Beispiel Anführungszeichen). 

Falls Sie das möchten, wählen Sie das gewünschte Zeichen aus der Liste.

¡ Zeilen beenden mit ... 

Hier können Sie auswählen, welche Steuerzeichen am Ende jeder Zeile eingefügt werden sollen (um den
Beginn einer neuen Zeile zu kennzeichnen).
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Hinweis: PlanMaker schlägt automatisch geeignete Steuerzeichen vor. In der Regel können Sie diese
Vorgabe übernehmen.

Folgende Optionen stehen zur Wahl:

CR+LF: Dies ist die empfohlene Einstellung für Windows.

LF: Dies ist die empfohlene Einstellung für Linux und Mac.

CR: Dieses Steuerzeichen war auf älteren Apple Mac-Systemen (vor Mac OS X) üblich.

Optionen beim Öffnen einer Textdatei

Beim Öffnen einer Textdatei werden die gleichen Optionen angeboten wie beim Speichern. Verwenden Sie
diese, um PlanMaker mitzuteilen, welches Format die Textdatei hat, die geöffnet werden soll.

Eine Option gibt es beim Öffnen zusätzlich:

¡ Anzahl der Überschriftzeilen 

Falls die Textdatei in den ersten Zeilen eine Überschrift (oder erläuternden Text o.ä.) enthält, können Sie
hier einstellen, um wie viele Zeilen es sich handelt. PlanMaker wird diese Zeilen dann nicht auf mehrere
Spalten verteilen, wie den Rest der Daten, sondern sie unverändert in jeweils einer Tabellenzelle able-
gen.

Der Standardwert ist 0 (sprich: keine Überschriftzeilen vorhanden).

Anmerkungen zum Excel-Format
Wenn Sie vor dem Einsatz von PlanMaker die Tabellenkalkulation Microsoft Excel verwendet haben, wird
Sie freuen, dass PlanMaker praktisch alle Excel-Dateien anstandslos öffnen kann. Umgekehrt ist mit
PlanMaker auch das Speichern von Dokumenten im Excel-Format möglich.

Auf den nächsten Seiten erfahren Sie, was Sie beim Öffnen und Speichern von Excel-Dokumenten beachten
sollten.

Öffnen und Speichern von Excel-Dokumenten

Wie im Abschnitt Speichern und Öffnen von Fremdformaten erwähnt, kann PlanMaker auch Excel-Doku-
mente öffnen und speichern.

Dies funktioniert in fast allen Fällen reibungslos. Manche Rechenfunktionen lassen sich jedoch nicht ohne
manuellen Eingriff konvertieren, da sie a) Excel beziehungsweise PlanMaker unbekannt sind oder b) in Ex-
cel beziehungsweise PlanMaker unterschiedlich arbeiten.

Was in diesem Fall zu tun ist, erfahren Sie hier:
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Warnmeldung beim Öffnen eines Excel-Dokuments

Falls Sie beim Öffnen einer Excel-Datei die nachfolgende Hinweismeldung erhalten, konnte PlanMaker
nicht alle Rechenformeln umsetzen:

Gehen Sie dann wie folgt vor:

1. Aktivieren Sie mit dem Menübefehl Ansicht > Syntaxhervorhebung die Syntaxhervorhebung.

2. Alle Zellen, die mit einer farblichen Hinterlegung versehen worden sind, konnten nicht konvertiert wer-
den. 

Diese Zellen müssen von Hand nachbearbeitet werden. Vergleichen Sie ihren Inhalt mit dem der entspre-
chenden Zelle im Excel-Dokument. Versuchen Sie, die inkompatiblen Rechenfunktionen durch PlanMa-
ker-Funktionen zu ersetzen. Ausführliche Informationen zu allen von PlanMaker unterstützten Rechen-
funktionen finden Sie im Abschnitt Funktionen von A-Z.

3. Wenn alle Korrekturen erledigt sind, können Sie die Syntaxhervorhebung wieder ausschalten.

Nun können Sie das überarbeitete Dokument gegebenenfalls noch im PlanMaker-Format speichern.

Warnmeldung beim Speichern eines Dokuments im Excel-Format

Wenn Sie ein PlanMaker-Dokument im Excel-Format speichern, erscheint die folgende Warnmeldung, falls
das Dokument Rechenformeln enthält, die nicht Excel-kompatibel sind:

Gehen Sie dann wie folgt vor:

1. Aktivieren Sie mit dem Menübefehl Ansicht > Syntaxhervorhebung die Syntaxhervorhebung.

2. Korrigieren Sie alle Zellen, die nun mit einem farbigen Hintergrund gekennzeichnet worden sind, von
Hand. Versuchen Sie, für die darin verwendeten Rechenfunktionen eine entsprechende Excel-Funktion
zu finden. Informationen dazu finden Sie in der Hilfe zur betreffenden Rechenfunktion.

3. Wenn alle Korrekturen erledigt sind, können Sie die Syntaxhervorhebung wieder ausschalten.
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Speichern Sie das Dokument nun erneut im Excel-Format. Erscheint dabei keine Warnmeldung mehr, sind
alle Inkompatibilitäten beseitigt.

Unterschiede zwischen PlanMaker und Excel

In diesem Abschnitt finden Sie eine Liste aller Funktionen, die in PlanMaker und Microsoft Excel unter-
schiedlich implementiert sind:

Allgemeines

¡ PlanMaker kann in Excel-Dokumenten enthaltene Makros und VBA-Scripts nicht ausführen. Diese
bleiben jedoch im Dokument erhalten und werden korrekt abgespeichert, wenn Sie ein Dokument mit
PlanMaker im Excel-Format speichern. 

Rechenfunktionen

¡ Einige Rechenfunktionen von PlanMaker werden von Excel nicht unterstützt (und umgekehrt). Beim
Öffnen oder Speichern einer Excel-Datei, die solche Funktionen enthält, erscheint daher automatisch ein
entsprechender Hinweis. Siehe dazu Abschnitt Öffnen und Speichern von Excel-Dokumenten. 
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Arbeiten mit arabischem Text
Sie können in Ihren PlanMaker-Dokumenten auch arabische Schrift verwenden. In diesem Kapitel erfahren
Sie alles Wissenswerte dazu. Es enthält folgende Abschnitte:

¡ Aktivieren der Unterstützung für arabischen Text 

¡ Ändern der Schreibrichtung in Tabellenzellen

¡ Ändern der Schreibrichtung in Textrahmen

¡ Ändern der Richtung von Arbeitsblättern

Lesen Sie dazu die nächsten Seiten.

Wichtig: Die in diesem Kapitel beschriebenen Funktionen stehen nur zur Verfügung, wenn in den Ein-
stellungen die Option Erweiterte Unterstützung für arabischen Text aktiviert wurde. Lesen Sie dazu
den nächsten Abschnitt.

Aktivieren der Unterstützung für arabischen Text
PlanMaker verfügt über eine "erweiterte Unterstützung für arabischen Text", die einige zusätzliche Funktio-
nen für das Bearbeiten von Text in arabischer Schrift bereitstellt.

Um diese Option zu aktivieren, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Einstellungen auf.

2. Wechseln Sie auf die Karteikarte Allgemein.

3. Schalten Sie darin die Option Erweiterte Unterstützung für arabischen Text ein.

Wichtig: Nur wenn diese Option aktiviert ist, stehen die auf den nächsten Seiten beschriebenen Funktio-
nen zur Verfügung.

Ändern der Schreibrichtung in Tabellenzellen
Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellungen aktiviert, können Sie
in einer Tabellenzelle jederzeit die Schreibrichtung zwischen links-nach-rechts und rechts-nach-links um-
schalten.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie in der Zelle den Menübefehl Format > Zelle auf.
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2. Wechseln Sie auf die Karteikarte Ausrichtung.

3. Wählen Sie bei Schreibrichtung die gewünschte Option: kontextabhängig, links-nach-rechts oder
rechts-nach-links.

Tipp: Bei der Standardeinstellung Kontextabhängig ermittelt PlanMaker die geeignete Schreibrichtung
selbstständig: Wenn Sie in die Zelle also Text in Arabisch eingeben, wird die Schreibrichtung automatisch
auf rechts-nach-links gesetzt, andernfalls auf links-nach-rechts.

Ändern der Schreibrichtung in Textrahmen
In Textrahmen können Sie die Schreibrichtung für den aktuellen Absatz jederzeit zwischen links-nach-
rechts und rechts-nach-links umschalten – sofern in den Einstellungen die Option Erweiterte Unterstüt-
zung für arabischen Text aktiviert ist.

Gehen Sie dazu wie folgt vor:

1. Setzen Sie die Schreibmarke in den gewünschten Absatz des Textrahmens.

2. Rufen Sie den Menübefehl Format > Absatz auf.

3. Wechseln Sie auf die Karteikarte Absatz.

4. Schalten Sie unter Schreibrichtung die Option Rechts nach links ein, um die Schreibrichtung auf
rechts-nach-links zu setzen. 

Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts gesetzt werden soll.

Tipp: Verwenden der Tastatur

Viel schneller geht das Ändern der Schreibrichtung eines Absatzes in einem Textrahmen, wenn Sie dafür
die folgenden Tastenkürzel verwenden:

¡ Wenn Sie gleichzeitig Strg und die linke Umschalttasteñ drücken, wird die Schreibrichtung auf links-
nach-rechts gesetzt. 

¡ Wenn Sie gleichzeitig Strg und die rechte Umschalttasteñ drücken, wird die Schreibrichtung auf
rechts-nach-links gesetzt.

Mac/Linux: Auf manchen Systemen (inklusive macOS und einigen Linux-Distributionen) funktionieren
diese Tastenkombinationen nicht. Hier können Sie alternativ die Tastenkombinationen Strg+Umschalt+A
(links-nach-rechts) und Strg+Umschalt+D (rechts-nach-links) verwenden.

Ändern der Richtung von Arbeitsblättern
Ist die Option Erweiterte Unterstützung für arabischen Text in den Einstellungen aktiviert, können Sie
die Schreibrichtung eines Arbeitsblatts jederzeit ändern.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie in dem Arbeitsblatt den Menübefehl Arbeitsblatt > Eigenschaften auf.
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2. Schalten Sie unter Schreibrichtung die Option Rechts nach links ein, um die Schreibrichtung auf
rechts-nach-links zu setzen. 

Schalten Sie die Option aus, wenn die Schreibrichtung auf links-nach-rechts gesetzt werden soll.

Die Richtung des Arbeitsblatts ändert sich nun entsprechend. 

Wenn Sie die Schreibrichtung eines Arbeitsblatts also auf rechts-nach-links ändern, ist nicht mehr die Ta-
bellenspalte ganz links die erste Spalte, sondern die Tabellenspalte ganz rechts. 

Die Tabelle wird also horizontal gespiegelt – wie in folgender Abbildung zu sehen:

Links: Tabelle mit Schreibrichtung links-nach-rechts
Rechts: Tabelle mit Schreibrichtung rechts-nach-links

Hinweis: Die Schreibrichtung jeder einzelnen Tabellenzelle lässt sich natürlich auch weiterhin individuell
festlegen (wie im Abschnitt Ändern der Schreibrichtung in Tabellenzellen beschrieben).
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Scripts (BasicMaker)

Hinweis: BasicMaker ist nur unter Windows verfügbar und nicht in allen Versionen von SoftMaker Offi-
ce enthalten.

Mit dem Programm BasicMaker können Sie Scripts in der Programmiersprache SoftMaker Basic schreiben
und ausführen. SoftMaker Basic orientiert sich an Visual Basic für Applikationen (VBA), der Programmier-
sprache von Microsoft Office.

Mit Hilfe von Scripts lassen sich Arbeitsabläufe in der Textverarbeitung TextMaker und der Tabellenkal-
kulation PlanMaker automatisieren. 

Starten von BasicMaker

Um BasicMaker zu starten oder ein BasicMaker-Script ausführen zu lassen, können Sie eine der folgenden
Vorgehensweisen verwenden:

¡ BasicMaker über das Start-Menü starten 

Sie können BasicMaker starten, indem Sie im Start-Menü auf Start > Programme > SoftMaker Office
> Hilfsprogramme > BasicMaker klicken.

¡ BasicMaker von TextMaker/PlanMaker aus starten 

Alternativ können Sie BasicMaker auch von TextMaker oder PlanMaker aus starten. Rufen Sie dazu in
TextMaker/PlanMaker den Menübefehl Weiteres > Script bearbeiten auf.

¡ Scripts von TextMaker/PlanMaker aus ausführen lassen 

Um ein Script ausführen zu lassen, rufen Sie in TextMaker/PlanMaker den Menübefehl Weiteres >
Script starten auf. Es erscheint ein Dateidialog. Wählen Sie darin das Script, das ausgeführt werden
soll, und bestätigen Sie mit OK.

Alle weiteren Informationen zu BasicMaker und zum "Programmieren" von TextMaker und PlanMaker fin-
den Sie in der Online-Hilfe von BasicMaker, die Sie in BasicMaker über das Menü Hilfe aufrufen können.
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Mehrere Dokumente gleichzeitig bearbeiten
Sie können jederzeit mehrere Dokumente gleichzeitig geöffnet haben – um diese miteinander zu verglei-
chen, sie gleichzeitig zu bearbeiten, Daten zwischen ihnen auszutauschen etc. 

Folgendermaßen arbeiten Sie mit mehreren Dokumenten gleichzeitig:

¡ Mehrere Dokumente im gleichen Programmfenster öffnen 

Sie können im aktuellen Programmfenster beliebig viele Dokumente gleichzeitig geöffnet haben. 

Zum Wechseln zwischen diesen Dokumenten gibt es zahlreiche Möglichkeiten, unter anderem eine Leis-
te mit Registerkarten für jedes momentan geöffnete Dokument, die über dem aktuellen Dokument ange-
zeigt wird: 

  

¡ Dokumente in einem neuen Programmfenster öffnen 

Darüber hinaus können Sie Dokumente auf Wunsch auch in einem neuen Programmfenster öffnen. Dies
ermöglicht es Ihnen, Dokumente beispielsweise nebeneinander auf dem Monitor zu platzieren. 

Kreuzen Sie dazu im Dialogfenster des Menübefehls Datei > Neu oder Datei > Öffnen die Option Neu-
es Programmfenster an, wenn Sie das Dokument anlegen/öffnen. (Hinweis: Diese Option steht in der
Android-Version nicht zur Verfügung.)

Diese beiden Methoden lassen sich nach Belieben kombinieren. Sie können also beliebig viele Programm-
fenster öffnen und in jedem dieser Programmfenster wiederum beliebig viele Dokumente öffnen. Oder alle
Dokumente in nur einem Programmfenster öffnen. Oder für jedes Dokument ein eigenes Programmfenster
anlegen lassen. Ganz wie Sie möchten.

In diesem Kapitel erfahren Sie alles Wissenswerte zum Arbeiten mit mehreren Dokumenten gleichzeitig.
Lesen Sie dazu die nächsten Seiten.

Dokument neu anlegen oder öffnen
Um ein Dokument neu anzulegen oder zu öffnen, gehen Sie wie folgt vor:

¡ Zum Anlegen eines neuen Dokuments rufen Sie den Menübefehl Datei > Neu auf. 

¡ Zum Öffnen eines bestehenden Dokuments verwenden Sie den Menübefehl Datei > Öffnen. 

Diese beiden Befehle werden im Kapitel Grundlagen ausführlich beschrieben.

Option "Neues Programmfenster"

Die Option Neues Programmfenster im Dialogfenster dieser beiden Befehle hat dabei folgende Bedeu-
tung: Wenn sie eingeschaltet ist, erscheint das Dokument in einem neuen Programmfenster. Ist sie ausge-
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schaltet, wird das Dokument im bestehenden Programmfenster mit einer neuen Registerkarte geöffnet. (Hin-
weis: Diese Option steht in der Android-Version nicht zur Verfügung.)

Wechseln zwischen geöffneten Dokumenten
Wenn Sie mehrere Dokumente gleichzeitig geöffnet haben, stehen Ihnen folgende Möglichkeiten zur Verfü-
gung, um zu einem bestimmten Dokument zu wechseln und es dadurch zum aktiven Dokument zu machen:

¡ Menü: Menüeintrag "Fenster" 

Im Menü Fenster finden Sie eine Liste aller momentan geöffneten Dokumente. Wählen Sie darin den
Eintrag für das Dokument, zu dem Sie wechseln möchten.

¡ Ribbon: Symbol "Fenster" 

Im Ribbon finden Sie auf der Karteikarte Ansicht ein Symbol namens Fenster, das ähnlich funktioniert:
Wenn Sie es anklicken, erscheint eine Liste aller geöffneten Dokumente. Klicken Sie darin das ge-
wünschte Dokument an. 

¡ Maus: Anklicken der Registerkarte für das Dokument 

Unter den Symbolleisten beziehungsweise dem Ribbon finden Sie eine Leiste mit Registerkarten für alle
momentan geöffneten Dokumente. Klicken Sie darin die Registerkarte für das Dokument an, zu dem Sie
wechseln möchten.

 

¡ Maus: Klicken in das Programmfenster mit dem Dokument 

Wenn Sie Dokumente in mehreren Programmfenstern geöffnet haben (siehe vorheriger Abschnitt), kön-
nen Sie natürlich auch einfach in das Programmfenster mit dem gewünschten Dokument klicken, um die-
ses Dokument zum aktiven Dokument zu machen.

¡ Tastatur: Strg+F6 

Sie können auch die Tastatur verwenden, um zwischen den momentan geöffneten Dokumenten zu wech-
seln: Strg+F6 wechselt zum nächsten Dokument und Strg+Umschalt+F6 zum vorherigen.

Mac: Beim Mac sind hierfür die Tasten Cmd+F6 und Cmd+Umschalt+F6 zu verwenden.

Dokument schließen
Wenn Sie die Arbeit an einem Dokument beenden möchten, können Sie dieses jederzeit schließen. Hierfür
gibt es folgende Möglichkeiten:

¡ Menü: Rufen Sie den Menübefehl Datei > Schließen auf, um das aktuelle Dokument zu schließen. 

Tipp: Mit dem Menübefehl Fenster > Alle schließen können Sie alle derzeit geöffneten Dokumente
auf einmal schließen.
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¡ Ribbon: Die Karteikarte Datei enthält ein Symbol namens Schließen, mit dem sich aktuelle Dokument
schließen lässt. 

¡ Registerkarten für Dokumente: Unter den Symbolleisten beziehungsweise dem Ribbon sehen Sie eine
Leiste mit Registerkarten für alle momentan geöffneten Dokumente. Wenn Sie mit der mittleren
Maustaste auf eine dieser Registerkarten klicken, wird das entsprechende Dokument geschlossen. 

Alternativ können Sie zum Schließen auch mit der linken Maustaste auf das x-Symbol klicken, das ganz
rechts in der Registerkarte angezeigt wird.

Außerdem: Wenn Sie mit der rechten Maustaste auf eine Registerkarte klicken, erscheint ein kleines Me-
nü. Dieses enthält Befehle zum Schließen des aktuellen Dokuments (Tab schließen) oder aller anderen
geöffneten Dokumente (Alle anderen Tabs schließen).

 

¡ Tastatur: Sie können weiterhin das Tastenkürzel Strg+F4 oder wahlweise Strg+W verwenden, um das
aktuelle Dokument zu schließen. 

Mac: Beim Mac sind hierfür die Tasten Cmd+F4 beziehungsweise Cmd+W zu verwenden.

Wenn Sie ein Dokument schließen, das seit dem letzten Speichern verändert wurde, fragt das Programm zu-
vor automatisch nach, ob Sie das Dokument erst speichern möchten.

Dokumente auf dem Bildschirm anordnen

Android: Die Funktion Fenster nebeneinander anzeigen ist in der Android-Version nicht verfügbar.

Wenn Sie Dokumente in mehreren Programmfenstern geöffnet haben, können Sie diese wie folgt auf dem
Bildschirm anordnen:

¡ Sie können die einzelnen Programmfenster natürlich manuell verschieben und deren Größe ändern – ge-
nau so, wie dies bei allen Arten von Programmfenstern möglich ist. 

¡ Wenn Sie den Menübefehl Fenster > Nebeneinander anzeigen aufrufen, werden das aktuelle Pro-
grammfenster und ein weiteres (bereits geöffnetes) Programmfenster nebeneinander auf dem Bildschirm
angeordnet. Falls derzeit mehr als zwei Programmfenster geöffnet sind, fragt das Programm erst nach,
welches andere Fenster verwendet werden soll. 
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Anpassen von PlanMaker
PlanMaker lässt Sie über eine Vielzahl von Programmeinstellungen bestimmen, so dass Sie das Programm
ganz an Ihren persönlichen Arbeitsstil anpassen können:

¡ Einstellungen von PlanMaker ändern 

Mit dem Menübefehl Weiteres > Einstellungen können Sie die Programmeinstellungen ändern. Diese
gelten für das gesamte Programm, also für alle Dokumente.

¡ Dokumenteigenschaften ändern 

Die Dokumenteigenschaften sind hingegen Einstellungen, die nur das aktuelle Dokument betreffen und
auch in diesem gespeichert werden. Sie können mit dem Menübefehl Datei > Eigenschaften geändert
werden.

¡ Arbeitsblatteigenschaften ändern 

Die Arbeitsblatteigenschaften sind schließlich Einstellungen, die für jedes Arbeitsblatt eines Dokuments
anders eingestellt werden können. Sie können mit dem Menübefehl Arbeitsblatt > Eigenschaften geän-
dert werden.

¡ Bildschirmdarstellung ändern 

In diesem Abschnitt wird beschrieben, wie Sie die Darstellung des Dokuments auf dem Bildschirm an-
passen können. Die meisten dazu benötigten Befehle finden Sie im Menü Ansicht.

¡ Symbolleisten anpassen 

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den
Einstellungen ausgewählt haben, dass sie das Programm mit "klassischen Menüs und Symbolleisten" be-
dienen möchten. 

Sie erfahren hier, wie Sie die Symbolleisten (Funktionsleiste, Formatleiste etc.) mit dem Menübefehl An-
sicht > Symbolleisten konfigurieren und mit Weiteres > Anpassen nach Ihren Wünschen anpassen kön-
nen. 

¡ Ribbon (Menüband) anpassen 

Nur bei "Ribbons": Dieser Abschnitt ist hingegen nur für Anwender interessant, die in den Einstellun-
gen ausgewählt haben, dass sie das Programm lieber mit dem "Ribbon" (Menüband) bedienen möchten. 

Sie erfahren hier, wie Sie das Ribbon konfigurieren und anpassen können.

¡ Benutzerdefinierte Symbole erstellen 

Sie können jederzeit benutzerdefinierte Symbole anlegen und diese dann einer Symbolleiste oder dem
Ribbon hinzufügen. Mit solchen Symbolen lassen sich beliebige Programme starten.

¡ Tastenkürzel anpassen 

Auch die Tastenkürzel für das Aufrufen häufig benötigter Befehle lassen sich anpassen. Hierfür ist aber-
mals der Menübefehl Weiteres > Anpassen zuständig.
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¡ Listen für das automatische Füllen editieren 

Mit dem Menübefehl Weiteres > Listen editieren können Sie eigene Listen für die Funktion Ausfüllen
herstellen.

¡ Installieren zusätzlicher Wörterbücher 

In diesem Abschnitt erfahren Sie, wie Sie bei Bedarf zusätzliche Wörterbücher (zum Beispiel Hunspell)
installieren können.

Ausführliche Informationen zu diesen Themen folgen auf den nächsten Seiten.

Einstellungen von PlanMaker ändern
Allgemeine Einstellungen lassen sich mit dem Menübefehl Weiteres > Einstellungen ändern. Diese Ein-
stellungen gelten für alle Dokumente.

Die Optionen im Dialogfenster dieses Befehls sind nach Themen geordnet auf mehrere Karteikarten verteilt.
Klicken Sie beispielsweise auf den Karteikartenreiter Dateien, können Sie Einstellungen zum Öffnen und
Speichern von Dateien vornehmen.

Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren Einstellungen.

Einstellungen, Karteikarte Ansicht

Auf der Karteikarte Ansicht im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie Ein-
stellungen zum Aussehen von Tabellen vornehmen:

Anzeiger

Hier können Sie das Aussehen der kleinen Dreiecke ändern, die in Zellen angezeigt werden, die einen Kom-
mentar enthalten oder geschützt sind:

¡ Farbe der Kommentaranzeiger 

Ändert die Farbe des kleinen Dreiecks, das in Zellen angezeigt wird, wenn diese einen Kommentar ent-
halten.

¡ Farbe der Schutzanzeiger 

Ändert die Farbe des kleinen Dreiecks, das bei aktiviertem Blattschutz in allen Zellen angezeigt wird, die
nicht geschützt sind.

¡ Größe 

Ändert die Größe obiger Anzeiger.
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Ausrichten

Hier können Sie die verfügbaren Positionierungshilfen für das Verschieben von Objekten (Textrahmen,
Grafikrahmen etc.) mit der Maus konfigurieren:

¡ An Zellen ausrichten 

Diese Option ist normalerweise ausgeschaltet. Wenn Sie Objekte mit der Maus verschieben, lassen sich
diese also frei bewegen. 

Schalten Sie die Option hingegen ein, springen Objekte beim Verschieben mit der Maus von Tabellen-
zelle zu Tabellenzelle. 

Diese Funktion temporär aktivieren oder deaktivieren: Wenn die Option An Zellen ausrichten eingeschal-
tet ist, können Sie diese jederzeit temporär deaktivieren, indem Sie beim Verschieben eines Objekts mit
der Maus die Taste Alt drücken und gedrückt halten. Das gleiche geht auch umgekehrt: Ist die Option
deaktiviert, kann sie mit der Taste Alt während des Verschiebens temporär aktiviert werden.

¡ An anderen Objekten ausrichten 

Wenn diese Option eingeschaltet ist, erzeugt das Programm automatisch "magische" Hilfslinien für die
Kanten von jedem Objekt im aktuellen Arbeitsblatt. Diese erleichtern das bündige und gleichmäßige
Platzieren von Objekten erheblich. 

Diese "magischen" Hilfslinien sind normalerweise unsichtbar. Sie zeigen sich erst, wenn Sie ein Objekt
mit der Maus in die Nähe einer solchen Hilfslinie ziehen. Die Linie wird dann sichtbar, und das Objekt
springt automatisch darauf. Ähnliches passiert beim Ändern der Größe eines Objekts mit der Maus. 

Einige Beispiele für solche Hilfslinien: 

Ziehen Sie ein Objekt an eine Position, an der seine linke Kante ungefähr bündig mit einem vorhan-
denen Objekt ist, erscheint automatisch eine Hilfslinie, die für die linke Kante des anderen Objekts
steht. Lassen Sie Ihr Objekt darauf springen, wird es exakt linksbündig zu dem vorhandenen Objekt
ausgerichtet.

Entsprechendes gilt auch für die rechte Kante von Objekten. 

Ziehen Sie ein Objekt an eine Position, an der es ungefähr zentriert zu einem vorhandenen Objekt ist,
erscheint automatisch eine Hilfslinie, die für das Zentrum des vorhandenen Objekts steht. Lassen Sie
Ihr Objekt darauf springen, wird es exakt zentriert zu dem vorhandenen Objekt ausgerichtet.

Ziehen Sie ein Objekt unter zwei andere Objekte, erscheint außerdem eine horizontale Hilfslinie ge-
nau dort, wo dieses dritte Objekt den gleichen Abstand wie die beiden anderen Objekte zueinander
hätte. (Die drei Objekte wären dann also gleichmäßig verteilt.) 

All dies funktioniert in beide Richtungen (horizontal und vertikal) – es wird also beispielsweise auch für
die obere und untere Kante jedes Objekts eine magische Hilfslinie generiert. 

¡ Toleranz 

Hier können Sie die Toleranz für die Option An anderen Objekten ausrichten ändern. Je höher der ein-
gestellte Wert, umso eher springt ein Objekt beim Verschieben auf eine der "magischen" Hilfslinien um
die vorhandenen Objekte.

Der Standardwert ist eine Entfernung von 8 Pixeln.
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Gitternetzlinien hinter den Zellen zeichnen

Schalten Sie diese Option ein, werden die grauen Gitternetzlinien, die auf dem Bildschirm zwischen den
Zellen angezeigt werden, im Hintergrund der Zellen (und nicht mehr im Vordergrund) gezeichnet. Dies be-
wirkt, dass bei Zellbereichen, die mit einem farbigen Hintergrund versehen wurden, keine Gitternetzlinien
mehr zu sehen sind.

Zellmarkierung

Hier können Sie die Farbe und Liniendicke des Zellrahmens ändern. Das ist der dunkle Rahmen, der die
momentan aktive Zelle im Arbeitsblatt kennzeichnet:

Arbeitsblattregister

Im Arbeitsblattregister am unteren Rand des Dokumentfensters werden Registerkarten für alle im aktuellen
Dokument vorhandenen Arbeitsblätter angezeigt.

Hier können Sie einstellen, in welcher Schriftgröße die Namen der Arbeitsblätter darin angezeigt werden
sollen.

Einstellungen, Karteikarte Allgemein

Auf der Karteikarte Allgemein im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie
allgemeine Einstellungen zu PlanMaker vornehmen:

Schaltfläche "Benutzerdaten"

Hier können Sie Ihre persönlichen Daten (Name, Adresse etc.) angeben. Diese Angaben können dann mit
der Funktion BENUTZERFELD in die Tabelle eingefügt werden

Maximal widerrufbare Aktionen

Hier können Sie einstellen, wie viele Aktionen sich mit dem Menübefehl Bearbeiten > Rückgängig maxi-
mal widerrufen lassen. Sie können diese Einstellung auf maximal 999 erhöhen. 

Hinweis: Das Programm verbraucht mehr Hauptspeicher, wenn Sie diesen Wert erhöhen. Auf Geräten
mit wenig Speicher sollte hier also kein allzu hoher Wert eingestellt werden.

Informationen zum Befehl Rückgängig finden Sie im Abschnitt Änderungen rückgängig machen.

Erweiterte Unterstützung für asiatische Schriften

Hinweis: Das Einschalten dieser Option wirkt sich nur auf die Schriftauswahl in Textrahmen aus. In Ta-
bellenzellen kann immer nur eine Schrift gewählt werden.
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Ist diese Option aktiviert, erscheinen – nur bei Text in einem Textrahmen – im Dialogfenster des Men-
übefehls Format > Zeichen nicht nur eine, sondern drei Listen zur Auswahl von Schriftart, Schriftgröße,
Schriftstil und Sprache:

¡ Für lateinische Schriftzeichen (z.B. Deutsch, Englisch) 
¡ Für ostasiatische Schriftzeichen (Chinesisch, Japanisch, Koreanisch) 
¡ Für komplexe Schriftzeichen (z.B. Arabisch)

Sie können diese Einstellungen in Textrahmen also für jede Art von Schriftzeichen getrennt vornehmen. 

Setzen Sie beispielsweise die Schriftart für lateinische Zeichen auf "Arial" und die Schriftart für asiatische
Zeichen auf "SimHei", erscheinen alle lateinischen Zeichen, die Sie eintippen, automatisch in Arial und alle
asiatischen Zeichen in SimHei.

PlanMaker erkennt dabei selbsttätig, ob es sich bei den eingegebenen Zeichen um lateinische, asiatische
oder komplexe (z.B. arabische) Schriftzeichen handelt.

Erweiterte Unterstützung für arabischen Text

Wenn Sie diese Option aktivieren, werden einige zusätzliche Funktionen für das Bearbeiten von Text in
arabischer Schrift verfügbar. Informationen dazu finden Sie im Kapitel Arbeiten mit arabischem Text.

Warnung beim Laden von OLE-Objekten

Nur bei Mac, Linux und Android: Ist diese Option eingeschaltet, erscheint beim Öffnen eines Dokuments,
das OLE-Objekte enthält, eine Warnmeldung. Diese Meldung soll Sie darauf hinweisen, dass diese Objekte
nicht angezeigt werden können, da OLE-Objekte nur unter Windows funktionieren.

Einstellungen, Karteikarte Bearbeiten

Auf der Karteikarte Bearbeiten im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie
Einstellungen zum Bearbeiten von Tabellenzellen vornehmen:

Markierung nach Eingabe ... bewegen

Bestimmt, in welche Richtung sich der Zellrahmen (der dunkle Rahmen, der auf dem Bildschirm die aktuel-
le Zelle kennzeichnet) bewegen soll, wenn Sie etwas in die Zelle eingeben und die Eingabetaste ¿ betäti-
gen.

Zelle direkt in der Tabelle editieren

Diese Option ist standardmäßig eingeschaltet. Sie können den Inhalt einer Zelle nach dem Drücken der Tas-
te F2 also direkt in der Tabelle editieren. Schalten Sie die Option aus, lässt sich der Zellinhalt mit F2 nur
noch in der Bearbeitungsleiste editieren, die oberhalb des Dokuments angezeigt wird.

Automatische Prozentwerteingabe

Bestimmt das Verhalten von PlanMaker beim Eintippen von Zahlen in Zellen, die Prozentwerte enthalten
oder im Zahlenformat "Prozent" formatiert sind. Ist diese Option aktiviert, wird Ihrer Eingabe dabei automa-
tisch ein Prozentzeichen angefügt.
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Zellen automatisch vervollständigen

Wenn diese Option aktiviert ist, macht PlanMaker beim Eintippen von Text in eine Zelle automatisch Vor-
schläge aus den Texteinträgen in den Zellen oberhalb und unterhalb dieser Zelle.

Ein Beispiel: Sie haben in drei Tabellenzellen untereinander "New York", "Rio" und "Tokyo" eingetragen.
Wenn Sie nun in der Zelle unterhalb dieser Einträge ein "N" eintippen, schlägt das Programm automatisch
"New York" vor. Tippen Sie hingegen ein "T" ein, wird "Tokyo" vorgeschlagen etc.

Um den Vorschlag zu übernehmen, drücken Sie die Eingabetaste ¿. Um ihn abzulehnen, tippen Sie einfach
weiter oder drücken die Taste Entf.

Falls Sie nicht möchten, dass PlanMaker beim Tippen solche Vorschläge macht, können Sie diese Option
jederzeit ausschalten.

Zellbearbeitung wird nie mit linker Pfeiltaste verlassen

Diese Option bestimmt, was passieren soll, wenn Sie eine Zelle ansteuern, einen Wert eintippen und dann
die Pfeiltaste ß betätigen:

¡ Ein: Die Schreibmarke wird nach links bewegt (innerhalb Ihrer Eingabe). 

¡ Aus: Der Zellrahmen wird nach links bewegt. Der eingegebene Wert wird also übernommen, und die
Zelle links von der aktuellen Zelle wird zur aktiven Zelle gemacht.

Meldung bei fehlerhaften Formeln

Wenn Sie eine Formel eingeben, die fehlerhaft formuliert ist (weil beispielsweise eine schließende Klam-
mer fehlt), gibt PlanMaker eine Fehlermeldung aus, sobald Sie Ihre Eingabe mit der Eingabetaste ¿ ab-
schließen. Wünschen Sie dies nicht, schalten Sie diese Option ab.

Hinweis: Unabhängig von dieser Option werden fehlerhafte Formeln beim Speichern stets durch den Text
#FEHLER! ersetzt.

Quickinfos für Formeln

Wenn diese Option aktiviert ist, erscheint bei der manuellen Eingabe von Rechenfunktionen in eine Zelle
automatisch ein kleines Infofenster unter der Tabellenzelle. Dieses listet alle Parameter, die von der Funkti-
on benötigt werden.

Zeichenformatierung auf das ganze Wort anwenden

Wenn diese Option aktiviert ist, hat das folgende Auswirkungen:

Wenn sich die Schreibmarke innerhalb eines Wortes befindet und Sie die Zeichenformatierung ändern (also
beispielsweise eine andere Schrift wählen oder Fettdruck einschalten), wirkt sich dies auf das komplette
Wort aus. 
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So können Sie schnell die Formatierung eines einzelnen Wortes ändern, ohne dieses erst markieren zu müs-
sen.

Rahmen und Zeichnungen direkt einfügen

Diese Option bestimmt, was passieren soll, wenn Sie einen Rahmen oder eine Zeichnung in ein Dokument
einfügen (Textrahmen, Grafikrahmen, Autoform, etc.) – zum Beispiel mit dem Menübefehl Objekt > Neu-
er Textrahmen:

¡ Immer: Das entsprechende Objekt wird sofort eingefügt. Seine Position und Größe werden dabei ohne
weiteres Zutun fest vorgegeben. 

(Sie können das Objekt nach dem Einfügen natürlich nach Belieben verschieben, indem Sie es mit der
Maus an die gewünschte Position ziehen. Auch können Sie seine Größe ändern, indem Sie an einem der
runden Greifer ziehen, die das Objekt umgeben.) 

¡ Nie: Bevor das Objekt tatsächlich eingefügt wird, ändert sich der Mauszeiger in ein Fadenkreuz. Um
fortzufahren, ziehen Sie mit der Maus ein Rechteck im Dokument auf, um die gewünschte Position und
Größe festzulegen. Das Objekt wird dann genau nach Ihren Vorgaben eingefügt. 

¡ Automatisch: Eine intelligente Kombination aus den beiden obigen Optionen, die in PlanMaker für den
jeweiligen Objekttyp bereits voreingestellt ist. Die Objekte Autoform und Textrahmen werden direkt
eingefügt (wie bei Immer), alle anderen Objekte werden per Steuerung über den Mauszeiger eingefügt
(wie bei Nie). 

Tabellen automatisch erweitern

Wie im Abschnitt Tabellen in Arbeitsblättern beschrieben, bietet Ihnen der Menübefehl Arbeitsblatt >
Neue Tabelle die Möglichkeit, "Tabellen in Arbeitsblättern" anzulegen. 

Diese Option hat folgende Auswirkung auf solche Tabellen:

¡ An: Wenn Sie in eine der Zellen direkt rechts neben der Tabelle etwas eintippen, erweitert sich die Ta-
belle automatisch um eine Spalte. Das gleiche gilt für Zeilen: Wenn Sie etwas in eine Zelle direkt unter-
halb der Tabelle eintippen, erweitert sich diese automatisch um eine Zeile. 

¡ Aus: Die Tabelle erweitert sich nicht automatisch. 

Mittlere Maustaste

Nur bei Mac und Linux: Diese Option bestimmt, was passieren soll, wenn Sie einen Mausklick mit der
mittleren Maustaste durchführen. Verfügbare Optionen:

¡ Nichts: Die mittlere Maustaste hat keine Funktion. 

¡ Markierten Inhalt einfügen: Wenn Sie mit der mittleren Maustaste in das Dokument klicken, wird an
dieser Stelle eine Kopie des aktuellen Inhalts der Selektion eingefügt (also beispielsweise der momentan
selektierte Text). 

Textbausteine automatisch ersetzen

Wie im Abschnitt Textbausteine beschrieben, können Sie mit PlanMaker Textbausteine anlegen (z.B. "Lst"
für "Lohnsteuer"). 

Wenn diese Option eingeschaltet ist, können Textbausteine direkt bei der Texteingabe ausgelöst werden.
Dazu muss einfach das Kürzel für den Baustein (z.B. "Lst") und dann Leertaste, Eingabetaste oder ein
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Satzzeichen getippt werden, worauf PlanMaker das Kürzel automatisch durch den Inhalt des Bausteins er-
setzt. 

Ist die Option deaktiviert, können Textbausteine hingegen nur über den Menübefehl Einfügen > Textbau-
stein abgerufen werden.

Linke Alt-Taste für Tastenkürzel verwenden

Nur beim Mac: Diese Option bestimmt, welche Funktion die linke Alt-Taste Ihrer Tastatur haben soll:

¡ Aus: Die linke Alt-Taste macht das Gleiche wie die rechte Alt-Taste: Sie fügt Symbole in den Text ein. 

Alt+E liefert beispielsweise ein Eurozeichen.

¡ Ein: Die linke Alt-Taste kann dazu verwendet werden, Menüs im klassischen Menü zu öffnen. (Hin-
weis: Dies funktioniert nur, wenn Sie das Programm mit klassischen Menüs anstelle des Ribbons ver-
wenden.) 

Alt+E liefert dann kein Eurozeichen mehr, sondern öffnet stattdessen das Einfügen-Menü.

Trennzeichen für Zahlen

Hier können Sie einstellen, welches Zeichen als Dezimaltrenner und welches als Tausendertrenner für Zah-
len verwendet werden soll.

Erläuterung: Der Dezimaltrenner ist das Zeichen, das man zwischen die Vor- und die Nachkommastellen ei-
ner Zahl setzt (z.B. das Komma in 17,50). Der Tausendertrenner ist das Zeichen, das zum Gruppieren lan-
ger Ziffern verwendet werden kann (z.B. die Punkte in 1.000.000).

¡ Bei der Einstellung Aus Systemeinstellung verwendet PlanMaker automatisch das Dezimaltrennzeichen
und Tausendertrennzeichen, das in den Systemeinstellungen Ihres Rechners festgelegt ist. (Dies ist die
Standardeinstellung.) 

¡ Wählen Sie hingegen Benutzerdefiniert, können Sie selbst angeben, welche Zeichen als Dezimaltrenner
und Tausendertrenner verwendet werden sollen.

Warnung: Wenn Sie hier manuelle Einstellungen vornehmen, die fehlerhaft sind, können Berechnun-
gen ungültige oder falsche Ergebnisse liefern!

Online-Berechnung in Statuszeile

Wenn Sie mehrere Zellen markieren, wird in der Statuszeile automatisch eine "Online-Berechnung" für die-
se Zellen angezeigt – zum Beispiel die Summe der Zellen. Mit dieser Option können Sie bestimmen, welche
Berechnung dort angezeigt werden soll.

Einstellungen, Karteikarte Aussehen

Auf der Karteikarte Aussehen im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie
Einstellungen vornehmen, die das Aussehen der Benutzeroberfläche von PlanMaker betreffen:
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Dialogsprache

Hier können Sie die Sprache wählen, in die Benutzeroberfläche (Menüs, Dialoge etc.) angezeigt werden
soll. 

Benutzeroberfläche

Wenn Sie die Schaltfläche Benutzeroberfläche anklicken, erscheint ein Dialog, in dem Sie wählen können,
welche Art von Benutzeroberfläche die Programme von SoftMaker Office nutzen sollen:

¡ Ribbon (obere Zeile) 

Wenn Sie einen der Einträge aus der oberen Zeile auswählen, verwenden die Programme ein "Rib-
bon" (also ein Menüband) als Benutzeroberfläche. Die Unterschiede zwischen den einzelnen Einträgen
liegen nur in der Farbgebung.

¡ Klassische Menüs und Symbolleisten (untere Zeile) 

Wenn Sie einen der Einträge aus der unteren Zeile auswählen, verwenden die Programme klassische
Menüs und Symbolleisten. Auch hier haben Sie die Wahl zwischen verschiedenen Farbvarianten.

Darüber hinaus lassen sich in dem Dialog noch folgende Einstellungen vornehmen:

¡ Schnellzugriffsleiste 

Nur bei Ribbons: Bestimmt, wo die Schnellzugriffsleiste, die Symbole für einige besonders häufig be-
nötigte Befehle enthält, angezeigt werden soll: links von den Registerkarten für die momentan geöffne-
ten Dokumente – oder in einer eigenen Leiste direkt unter dem Ribbon.

¡ Fingereingabemodus 

Wenn Sie diese Option aktivieren, werden alle Symbole im Ribbon beziehungsweise in Menüs und Sym-
bolleisten leicht vergrößert. Dies ist nützlich, wenn Sie die Software mit dem Finger bedienen (beispiels-
weise auf einem Tablet).

Tipp: Sie können den Fingereingabemodus alternativ auch mit folgenden Befehlen ein-/ausschalten:

Menü: Befehl Ansicht > Fingereingabemodus

Schnellzugriffsleiste: Befehl Fingereingabemodus

Android: Falls Sie die Android-Version verwenden, haben Sie für die Einstellungen der Benutzerober-
fläche keine Schaltfläche mit Dialog, sondern eine aufklappbare Liste. Die Optionen Schnellzugriffsleiste
und Fingereingabemodus (für größere Symbole und Menüeinträge) sind separat an anderen Stellen dieser
Karteikarte Aussehen zu finden und bewirken dasselbe wie oben beschrieben.

Statuszeile im Ribbonmodus anzeigen

Gilt nur für den Ribbonmodus: Sie können hier die Anzeige der Statuszeile ein-/ausschalten. Um die Anzei-
ge der Statuszeile für das klassische Menü zu ändern, siehe Abschnitt Symbolleisten anzeigen/verbergen.

Schriftenliste mit echten Schriften

Ist diese Option aktiviert, zeigt PlanMaker in Schriftenlisten (zum Beispiel der Schriftenliste in der Format-
leiste) alle Schriftnamen in der jeweiligen Schriftart an. So können Sie gleich sehen, wie die Schriften tat-
sächlich aussehen. 
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Quickinfos

Bestimmt, ob Quickinfos angezeigt werden sollen.

Bei den Quickinfos handelt es sich um kurze Infotexte, die neben dem Mauszeiger angezeigt werden, wenn
Sie mit der Maus auf ein Bildschirmelement wie beispielsweise eine Schaltfläche in der Funktionsleiste zei-
gen. 

Warnton bei Meldungen

Ist diese Option aktiviert, gibt PlanMaker bei Hinweis- und Fehlermeldungen einen Signalton aus.

Echtzeitvorschau

Hier können Sie eine Echtzeitvorschau für die aufklappbaren Listen in der Formatleiste ein-/ausschalten. 

Ist diese aktiviert, können Sie beispielsweise Text markieren, die Schriftenliste in der Formatleiste öffnen
und dann mit der Maus über die Schriftarten darin fahren. Sofort wird "in Echtzeit" im Dokument angezeigt,
wie der markierte Text in der entsprechenden Schrift aussehen würde.

Um die Schrift dann tatsächlich anzuwenden, klicken Sie sie einfach an. Um die Änderung zu verwerfen,
klicken Sie auf eine beliebige Stelle außerhalb der Schriftenliste oder drücken die Taste Esc. 

Systemmenüs verwenden

Nur beim Mac: Diese Option bestimmt, ob das Programm sein Hauptmenü in der Menüleiste am oberen
Bildschirmrand anzeigen soll (wie dies bei Mac-Anwendungen üblich ist) oder nicht.

Je nachdem, welche Art von Benutzeroberfläche Sie ausgewählt haben ("Ribbon" oder "Klassische Menüs
und Symbolleisten"), hat diese Option folgende Auswirkung: 

¡ Aus: Das Hauptmenü wird nicht in der Menüzeile am oberen Bildschirmrand angezeigt.  

Details:

Klassische Menüs und Symbolleisten: Bei der klassischen Benutzeroberfläche wird das Hauptmenü
nun nicht mehr am oberen Bildschirmrand, sondern in seiner eigenen Leiste (unterhalb der Titelleis-
te) angezeigt.

Ribbon: Wenn Sie als Benutzeroberfläche das "Ribbon" ausgewählt haben, steht Ihnen nun lediglich

das "Hamburgermenü" (das Symbol  in der Schnellzugriffsleiste) zur Verfügung, falls Sie doch
einmal auf das klassische Hauptmenü zugreifen möchten.

¡ Ein: Das Hauptmenü wird in der Menüzeile am oberen Bildschirmrand angezeigt.  

Details:

Klassische Menüs und Symbolleisten: Das Hauptmenü wird nun in der Menüleiste am oberen Bild-
schirmrand angezeigt – und nicht in seiner eigenen Leiste unterhalb der Titelleiste.

Ribbon: Ribbon-Anwender haben nun nicht nur Zugriff auf die Ribbon-Benutzeroberfläche, sondern
können bei Bedarf zusätzlich das klassische Menü in der Menüleiste verwenden.
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System-Dateidialoge verwenden

Nur bei Windows, Mac und Linux: Diese Option bestimmt, welche Art von Dialogen bei Befehlen, die
mit dem Öffnen und Speichern von Dateien zu tun haben, erscheinen sollen:

¡ Aus: Es erscheinen PlanMakers eigene Dateidialoge. 

¡ Ein: Es erscheinen die Standard-Dateidialoge des Betriebssystems, wie Sie sie von den meisten anderen
Applikationen her kennen.

Erstere sind etwas übersichtlicher, letztere bieten mehr Optionen.

Bildschirmschriftarten glätten

Wenn Sie diese Option aktivieren, wendet PlanMaker eine Technologie an, die die Kanten von Schriften auf
dem Bildschirm glättet und so das Schriftbild verbessert – das sogenannte "Antialiasing".

Je nach Betriebssystem stehen unterschiedliche Optionen zur Verfügung.

Hintergrundfarbe des Programms

Hier können Sie die Hintergrundfarbe für Dokumentfenster ändern.

Größe der Benutzeroberfläche

Nur bei Mac, Linux und Android: Diese Schaltfläche öffnet einen Dialog, mit dem Sie die Benutzerober-
fläche (Menü, Symbolleisten, Dialoge etc.) des Programms verkleinern oder vergrößern können. 

Wählen Sie hier eine kleinere Einstellung, werden alle Bedienelemente verkleinert, was für mehr Übersicht
sorgt. Eine größere Einstellung hingegen erhöht die Lesbarkeit.

Die Option Größe der Dialogelemente ändert die Größe der Benutzeroberfläche dabei in groben Schritten.
Die Option Anpassung der Schriftgröße erlaubt zusätzlich etwas "Feintuning" in kleineren Schritten. 

Als kleine Hilfe zeigt Ihnen das Feld Beispiel an, wie groß beispielsweise ein Kontrollkästchen in einem
Dialog nach dem Anwenden Ihrer Änderungen aussehen würde.

Hinweis: Bei ungeeigneten Einstellungen kann es passieren, dass die Benutzeroberfläche deutlich zu
klein oder zu groß dargestellt wird, insbesondere auf Geräten mit einer relativ niedrigen Auflösung. Falls
dies passieren sollte, können Sie jederzeit die Schaltfläche Zurücksetzen in der linken unteren Ecke die-
ses Dialogs betätigen, um zu den Standardeinstellungen zurückzukehren.

Skalierung von Dokumenten (DPI)

Nur bei Mac, Linux und Android: Sie können das Dokument für eine größere/kleinere Ansicht höher oder
niedriger skalieren. Wählen Sie dazu Benutzerdefiniert und geben Sie einen gewünschten Wert ein.

Maßeinheit

Nur bei Mac, Linux und Android: Hier können Sie einstellen, welche Maßeinheiten PlanMaker standard-
mäßig verwenden soll: Metrisch (Zentimeter) oder U.S. (Zoll).
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(Unter Windows ist diese Option nicht erforderlich, da das Programm dort automatisch die Einstellung
übernimmt, die in den Regions- und Sprachoptionen der Systemsteuerung von Windows gewählt wurde.)

Tipp: Unabhängig von dieser Einstellung können Sie in Dialogen jederzeit Werte in anderen Maßeinheiten
eingeben, indem sie hinter dem Wert eine der folgenden Maßeinheiten eintippen:

Einheit Bemerkung

cm Zentimeter

in Inch (Zoll) – 1 in entspricht 2,54 cm.

pt Punkt – 72 pt entsprechen 1 in.

pi Pica (Zeichen)

Tippen Sie also beispielsweise für den linken Seitenrand "2 in" ein, setzt PlanMaker diesen auf 2 Zoll
(=5,08 cm).

Ribbon-Animationen verwenden

Nur bei Android: Die Sektionen der Ribbon-Karteikarten sind ein- und ausklappbar, wenn Sie mit dem
Finger darauf tippen (nur im Ribbonmodus). Durch Aktivieren der Option wird das Ein- und Ausklappen im
animierten Modus vollzogen.

Einstellungen, Karteikarte Sprache

Auf der Karteikarte Sprache im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie Ein-
stellungen zu Rechtschreibprüfung und Silbentrennung vornehmen:

Sprache

Hier legen Sie die Sprache für Rechtschreibprüfung und Silbentrennung fest. Öffnen Sie die Liste dazu und
wählen Sie die gewünschte Sprache darin aus.

Hinweis: Beachten Sie dabei, dass es für Deutsch jeweils zwei Einträge in dieser Liste gibt: 

¡ "Deutsch (Deutschland)" steht für die neue Rechtschreibung (gemäß der sogenannten "Rechtschreibre-
form" von 1996 in ihrer letzten Überarbeitung von 2006). 

¡ "Deutsch (Deutschland, alt)" steht hingegen für die alte Rechtschreibung. 

Entsprechendes gilt für "Deutsch (Österreich)" und "Deutsch (Schweiz)".

Rubrik "Rechtschreibprüfung"

Hier können Sie folgende Einstellungen zur Rechtschreibprüfung vornehmen:

¡ Rechtschreibkorrektur während des Tippens 

Wenn Sie diese Option aktiveren, prüft PlanMaker die Rechtschreibung bereits während der Eingabe
von Text. Bei Tippfehlern erscheint sofort ein Dialogfenster zur Korrektur. Siehe dazu Abschnitt Recht-
schreibprüfung während des Tippens.
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Hinweis: Wenn diese Option ausgeschaltet ist, müssen Sie natürlich nicht gänzlich auf eine Recht-
schreibprüfung verzichten – Sie können diese jederzeit mit dem Menübefehl Weiteres > Rechtschreib-
prüfung manuell starten. Siehe dazu Abschnitt Rechtschreibprüfung nachträglich.

¡ Warnton bei Tippfehlern 

Diese Option bestimmt, ob PlanMaker einen Signalton ausgeben soll, wenn die Rechtschreibkorrektur
während des Tippens ein unbekanntes Wort findet.

¡ Ignoriere Wörter, die mit einer Zahl beginnen 

Wenn Sie diese Option aktivieren, ignoriert die Rechtschreibprüfung alle Wörter, die mit einer Zahl be-
ginnen (zum Beispiel "1980er").

¡ Hunspell-Wörterbücher 

Neben seinen eigenen Wörterbüchern unterstützt SoftMaker Office auch die Verwendung von Hunspell-
Wörterbüchern. Diese sind als kostenlose Downloads erhältlich. Sie wurden größtenteils von engagierten
Anwendern und nicht-kommerziellen Einrichtungen erstellt. 

Mit der Schaltfläche Hunspell-Wörterbücher können Sie heruntergeladene Hunspell-Wörterbücher in-
stallieren und außerdem einstellen, für welche Sprachen Hunspell-Wörterbücher verwendet werden sol-
len.

Siehe dazu Abschnitt Installieren zusätzlicher Wörterbücher.

Einstellungen, Karteikarte Dateien

Auf der Karteikarte Dateien im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie Ein-
stellungen zum Öffnen und Speichern von Dateien vornehmen:

Vorlagenpfad

Hier lässt sich der Ordner einstellen, in dem sich die Dokumentvorlagen für neue PlanMaker-Dokumente
befinden. Der Dialog, der beim Aufruf des Menübefehls Datei > Neu erscheint, um Sie eine Dokumentvor-
lage auswählen zu lassen, zeigt entsprechend alle Vorlagen an, die sich in diesem Ordner befinden.

Hinweis: Normalerweise sollten Sie diese Einstellung nicht verändern. Ändern Sie diese nur, wenn Sie
den Vorlagenordner tatsächlich an einen anderen Ort verschoben haben.

Standard-Dateiformat

Hier können Sie das Dateiformat wählen, in dem PlanMaker neu angelegte Dokumente standardmäßig spei-
chern soll.

Wenn Sie ein Dokument mit dem Menübefehl Datei > Neu neu anlegen und es dann zum ersten Mal abspei-
chern, schlägt Ihnen der Speichern-Dialog als Vorgabe stets das hier eingestellte Dateiformat vor.

Zur Wahl stehen das PlanMaker-Format und das Microsoft Excel-Format in mehreren Versionen.
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Hinweis: Beachten Sie, dass das Excel-Format nicht alle Funktionen von PlanMaker kennt. Wenn Sie al-
so ein mit PlanMaker erstelltes Dokument im Excel-Format speichern, können unter Umständen Forma-
tierungen oder Funktionen verloren gehen. Es empfiehlt sich daher, hier die Standardeinstellung
"PlanMaker" zu verwenden.

Rubrik "Speichern"

In der Rubrik Speichern können Sie Einstellungen zum Speichern von Dokumenten vornehmen:

¡ Backupdateien erzeugen 

Nur bei Android: Ist diese Option aktiviert, wird bei jedem Speichern eines Dokuments automatisch ei-
ne Sicherungskopie mit der vorherigen Fassung des Dokuments angelegt. (Namenserweiterung: .bak.)

(Bei SoftMaker Office für Windows, Mac und Linux gibt es umfassendere Optionen für Sicherungskopi-
en, siehe Rubrik Sicherungskopien weiter unten).

¡ Beim Speichern nach Dokumentinfo fragen 

Schalten Sie diese Option ein, erscheint beim ersten Speichern eines neuen Dokuments automatisch das
Dialogfenster zum Eintragen der Dokumentinfos (siehe Kapitel Dokumentinfos).

¡ Automatische Wiederherstellung: Zustand sichern alle ... Minuten 

Wenn diese Option aktiviert ist, macht PlanMaker im eingetragenen Zeitabstand (1-100 Minuten) auto-
matisch eine temporäre Sicherungskopie von jedem momentan geöffneten Dokument. 

Hinweis: Diese temporären Sicherungskopien funktionieren völlig unabhängig von den regulären Si-
cherungskopien, die Sie in der Rubrik Sicherungskopien auf dieser Karteikarte konfigurieren können
(siehe unten).

Wenn PlanMaker korrekt beendet wird, löscht er diese temporären Sicherungskopien wieder. Wird er je-
doch nicht korrekt beendet (zum Beispiel aufgrund eines Absturzes), erkennt PlanMaker dies beim
nächsten Programmstart. Er öffnet dann (nach Rückfrage) die temporären Sicherungskopien aller Doku-
mente, die bei dem Absturz geöffnet waren und noch nicht gespeicherte Änderungen enthielten. 

Überprüfen Sie nun bei jedem der wiederhergestellten Dokumente, ob möglicherweise einige Ihrer zu-
letzt gemachten Änderungen verlorengegangen sind, und speichern Sie das Dokument dann.

Rubrik Öffnen

In der Rubrik Öffnen können Sie Einstellungen zum Öffnen von Dokumenten vornehmen:

¡ Einträge im Datei-Menü 

Im Menü Datei zeigt PlanMaker eine Liste der zuletzt von Ihnen geöffneten Dateien an. Wählen Sie
einen dieser Einträge, wird die entsprechende Datei sofort geöffnet. Hier lässt sich einstellen, wie viele
Dateien dort angezeigt werden sollen.

Rubrik Sicherungskopien

Hinweis: Diese Funktion ist in der Android-Version nicht verfügbar. Unter Android werden lediglich
einfache Sicherungskopien unterstützt (über die weiter oben beschrieben Option Backupdateien erzeu-
gen).
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Hier können Sie festlegen, ob das Programm beim Speichern von Dokumenten automatisch eine Siche-
rungskopie mit der vorherigen Version des Dokuments anlegen soll. 

Die aufklappbare Liste in dieser Rubrik bietet hierfür folgende Optionen zur Wahl:

¡ Keine Sicherungskopien 

Wenn Sie diese Option wählen, werden keine Sicherungskopien beim Speichern von Dokumenten ange-
legt. (Nicht empfohlen.)

¡ Einfache Sicherungskopien 

Hier wird pro Dokument genau eine Sicherungskopie angelegt. Diese enthält die vorherige Version des
Dokuments. Sie hat die Namenserweiterung .bak und befindet sich im gleichen Ordner wie das Doku-
ment selbst.

¡ Fortgeschrittene Sicherungskopien 

Hier werden mehrere Generationen von Sicherungskopien für jedes Dokument angelegt. Diese werden
allesamt in einem speziellen Backup-Ordner gespeichert. 

Tipp: Wenn diese Option gewählt ist, steht außerdem der Menübefehl Datei > Zurück zu vorheriger
Version zur Verfügung, mit dem Sie bequem zu einer früheren Version des derzeit geöffneten Doku-
ments zurückkehren können.

Zusätzliche Optionen:

Verzeichnis für Sicherungskopien: Hier können Sie den Pfad für den Backup-Ordner ändern, in dem
alle Sicherungskopien abgelegt werden.

Anzahl der Sicherungskopien pro Dokument: Hier können Sie bestimmen, wie viele Sicherungskopi-
en (= Generationen) maximal pro Dokument aufgehoben werden sollen.

Ausführliche Informationen zum Verwenden von Sicherungskopien finden Sie im Abschnitt Sicherungsko-
pien.

Einstellungen, Karteikarte System

Auf der Karteikarte System im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie fol-
gende System-Einstellungen vornehmen:

Grafiken im Speicher komprimieren

Ist diese Option aktiviert, legt PlanMaker eingefügte Grafiken stets (verlustfrei) komprimiert im Speicher
ab. Vorteil: Bei Dokumenten, die viele Bilder enthalten, wird erheblich weniger Arbeitsspeicher verbraucht.
Nachteil: Das Komprimieren kostet natürlich etwas Rechenzeit.

In der Regel sollten Sie diese Option eingeschaltet lassen.

Hinweis: Eine Änderung an dieser Einstellung wird erst wirksam, wenn Sie das Programm beenden und neu
starten.
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Internen Grafikcache begrenzen

PlanMaker besitzt einen Zwischenspeicher, der die Anzeige von Grafiken in Dokumenten erheblich be-
schleunigt. Ist diese Option aktiviert, begrenzt PlanMaker diesen Zwischenspeicher auf maximal 20% des
Arbeitsspeichers. 

In der Regel sollten Sie diese Option eingeschaltet lassen.

Wenn Sie häufig Dokumente mit vielen hochaufgelösten Bildern verwenden, können Sie diese Option test-
halber deaktivieren. Die Anzeige von Grafiken ist dann möglicherweise flüssiger, allerdings kann es dabei
passieren, dass PlanMaker einen Großteil des verfügbaren Arbeitsspeichers für sich beansprucht.

Kantenglättung von Grafiken

Wenn diese Option aktiviert ist, wendet PlanMaker bei Grafiken eine Technologie zum Glätten von Kanten
und Linien an. Vorteil: Skalierte Grafiken werden schöner dargestellt. Nachteil: Dieses Verfahren kostet na-
türlich Rechenzeit beim Anzeigen von Grafiken.

Nach Produktaktualisierungen suchen

Nur bei Windows, Mac und Linux: Hier können Sie festlegen, wie häufig die Software nachsehen soll, ob
es Aktualisierungen (Updates) für SoftMaker Office gibt. Aktualisierungen enthalten Fehlerkorrekturen und
Funktionsverbesserungen.

Hinweis: Das Prüfen auf Aktualisierungen funktioniert nur, wenn Ihr Gerät auf das Internet zugreifen kann.

Sie können die automatische Überprüfung auch abschalten (nicht empfohlen), indem Sie den Eintrag Nie
auswählen. Das Prüfen auf Aktualisierungen kann dann nur noch manuell (über die Schaltfläche Jetzt prü-
fen) durchgeführt werden.

Tipp: Auf www.softmaker.de können Sie außerdem unseren Newsletter abonnieren. Dieser benachrich-
tigt Sie bei neuen Updates per E-Mail und versorgt Sie regelmäßig mit weiteren nützlichen Informationen
und Angeboten rund um SoftMaker Office.

Android: Bei Applikationen, die vom Google Play Store aus installiert wurden, benachrichtigt Sie Ihr Gerät
automatisch über Updates (sofern dies nicht in den Einstellungen des Play Store deaktiviert wurde).

Dateierweiterungen verknüpfen

Nur bei Windows: Diese Schaltfläche öffnet einen Dialog, in dem Sie einige Dateitypen mit PlanMaker
verknüpfen können. Für diese Arten von Dateien ist PlanMaker dann die Standardanwendung.

Verknüpfen Sie beispielsweise den Dateityp "Microsoft Excel-Dokumente" mit PlanMaker, werden Dateien
dieses Typs künftig immer in PlanMaker geöffnet, wenn Sie im Windows Explorer einen Doppelklick auf
eine solche Datei durchführen.

Tastatur automatisch ein-/ausblenden

Nur bei Android: Ist diese Option aktiviert, wird die Bildschirmtastatur automatisch geöffnet, wenn Sie et-
was eingeben können (wenn Sie also beispielsweise eine Zelle doppelt antippen oder in einem Dialog in ein
Eingabefeld tippen).

http://www.softmaker.de/
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Tastaturlayout automatisch anpassen

Nur bei Android: Ist diese Option aktiviert, wird das Layout der Bildschirmtastatur je nach Situation auto-
matisch geändert. Tippen Sie beispielsweise in einem Dialog in ein Eingabefeld, in das nur Zahlen eingege-
ben werden dürfen, zeigt auch die Bildschirmtastatur nur ein Zahlenfeld an.

Darüber hinaus merkt sich PlanMaker bei der Eingabe von Werten in Tabellenzellen den aktuellen Modus
der Tastatur, wenn diese Option eingeschaltet ist. Ist die Option hingegen deaktiviert, springt die Tastatur
bei jeder neuen Zelle wieder in den normalen (alphanumerischen) Modus zurück.

OpenGL-Bibliothek verwenden

Nur bei Linux: Ist diese Option aktiviert, nutzt das Programm die OpenGL-Grafikbibliothek. Diese be-
schleunigt die Bildschirmdarstellung. Sie sollten diese Option daher normalerweise eingeschaltet lassen.

Hinweis: Auf Systemen mit einer stark veralteten oder fehlerhaften OpenGL-Installation kann es dabei zu
Darstellungsfehlern innerhalb der Applikation kommen. Dies hängt von Ihrer individuellen Systemkonfigu-
ration und insbesondere dem verwendeten Grafiktreiber ab. In so einem Fall sollten Sie die Option deakti-
vieren und die Applikation neu starten. 

Außerdem: Wenn das Programm beim Starten Probleme mit der installierten OpenGL-Bibliothek erkennt,
schaltet es diese Option automatisch ab. 

SHM-Erweiterungen verwenden

Nur bei Linux: Diese Option ist nur verfügbar, wenn die Option OpenGL-Bibliothek verwenden deakti-
viert wurde (nicht empfohlen). 

Wenn die SHM-Erweiterungen eingeschaltet sind, verwendet das Programm Shared Memory-Speicher (so-
fern verfügbar), was die Bildschirmausgabe beschleunigen kann.

XIM verwenden

Nur bei Linux: Ist diese Option aktiviert, unterstützt PlanMaker das Zusammensetzen von Akzentzeichen
(à, ô, é etc.) mit Hilfe von "XIM".

Auf einer deutschen Tastatur kann dann beispielsweise das Zeichen "ô" erzeugt werden, indem Sie erst die
Taste ^ und danach die Taste O betätigen.

Schalten Sie die Option aus, ist das Zusammensetzen von Zeichen auf diese Weise nicht mehr möglich. 

Hinweis: Auf manchen Systemen gibt es kleine Eingabeverzögerungen beim schnellen Tippen von Text,
wenn diese Option aktiviert ist.

Verborgene Dateien und Ordner anzeigen

Nur bei Mac, Linux: Ist diese Option aktiviert, werden in Dateidialogen (z.B. dem des Menübefehls Datei
> Öffnen) auch verborgene Dateien und Ordner angezeigt.

Mausrad

Nur bei Mac, Linux: Wenn Ihre Maus mit einem Mausrad ausgestattet ist, können Sie hier einstellen, wie
weit beim Verwenden des Mausrads geblättert werden soll: seitenweise (also eine komplette Bildschirmsei-
te) oder nur eine bestimmte Anzahl an Zeilen.
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Externe Programme

Nur bei Mac, Linux: Diese Schaltfläche öffnet einen Dialog, in dem Sie die externen Programme festlegen
können, die bei bestimmten Ereignissen automatisch gestartet werden. Der Eintrag PDF-Betrachter be-
stimmt beispielsweise, welche Applikation nach dem Erzeugen einer PDF-Datei automatisch aufgerufen
wird, um das Ergebnis darin anzuzeigen.

Hinweis: Sie müssen diese Felder nicht ausfüllen. Bei allen Feldern, die Sie leer lassen, wird automatisch
das im System festgelegte Standardprogramm für diese Aktion verwendet. Nehmen Sie in diesem Dialog
nur dann Änderungen vor, wenn Sie möchten, dass nicht das Standardprogramm aufgerufen wird, sondern
ein anderes Programm. Tragen Sie dazu einfach den Dateinamen der ausführbaren Datei ein (inklusive
Pfad, falls nötig).

Zusätzliche Schriftenpfade

Nur bei Mac, Linux und Android: Hier können Sie Pfade für zusätzliche Schriftarten angeben, die
PlanMaker verwenden soll. Tragen Sie dazu das Unterverzeichnis ein, in dem sich die Schriftdateien befin-
den. Falls Sie mehrere Verzeichnisse eintragen möchten, trennen Sie diese durch einen Doppelpunkt.

PlanMaker kann diese Schriftarten dann zusätzlich zu den in Ihrem System verfügbaren Schriften verwen-
den. 

Hinweis: Änderungen an dieser Einstellung werden erst wirksam, wenn Sie das Programm beenden und neu
starten.

Einstellungen, Karteikarte Schriften

Auf der Karteikarte Schriften im Dialogfenster des Menübefehls Weiteres > Einstellungen können Sie
festlegen, welche Schriften in Schriftenlisten (z.B. der Schriftenliste im Dialogfenster des Menübefehls
Format > Zeichen) angezeigt werden sollen.

Die Karteikarte präsentiert dazu eine Liste aller Schriften, die auf Ihrem System installiert sind. Um darin
eine Schrift zu aktivieren oder zu deaktivieren, klicken Sie auf das Kästchen vor dem Namen der Schriftart.
Alle Schriften, bei denen Sie das Häkchen entfernen, werden nicht mehr in Schriftenlisten angezeigt.

Hintergrund: Unter den Schriftarten, die auf Ihrem System standardmäßig installiert sind, befinden sich ei-
nige Schriften, die Sie vermutlich nie benötigen – weil diese beispielsweise ausschließlich Schriftzeichen
für eine Sprache enthalten, die Sie nicht verwenden. Wenn Sie möchten, können Sie solche Schriften wie
oben beschrieben ausblenden.

Schriftenfilterung des Betriebssystems verwenden

Nur unter Windows: Windows-Anwender finden auf dieser Karteikartei außerdem eine Option namens
Schriftenfilterung des Betriebssystems verwenden. Wenn diese eingeschaltet ist, verbirgt Windows in
Schriftenlisten automatisch alle Schriften, die ausschließlich fremdsprachige Schriftzeichen enthalten.
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Dokumenteigenschaften ändern
Über den Menübefehl Datei > Eigenschaften können Sie Einstellungen ändern, die nur das aktuelle Doku-
ment betreffen und mit diesem gespeichert werden. Man nennt diese Einstellungen Dokumenteigenschaften.

Die verfügbaren Dokumenteigenschaften sind nach Themen geordnet auf mehrere Karteikarten verteilt. Kli-
cken Sie beispielsweise auf den Karteikartenreiter Infos, können Sie die Dokumentinfos bearbeiten.

Auf den nächsten Seiten finden Sie detaillierte Erläuterungen aller verfügbaren Dokumenteigenschaften.

Dokumenteigenschaften, Karteikarte Infos

Auf der Karteikarte Infos im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie die Doku-
mentinfos für das aktuelle Dokument eintragen. 

In den Dokumentinfos lassen sich erläuternde Angaben zum aktuellen Dokument machen (Thema, Autor,
Schlüsselwörter etc.), nach denen mit dem Dateimanager auch gesucht werden kann.

Informationen hierzu finden Sie im Abschnitt Dokumentinfos.

Dokumenteigenschaften, Karteikarte Farben

Auf der Karteikarte Farben im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie die
Farbpalette des aktuellen Dokuments bearbeiten.

Wenn Sie eine Farbenliste – zum Beispiel die Farbenliste in der Formatleiste – öffnen, sehen Sie nur einen
kleinen Ausschnitt aus den bis zu 16 Millionen verfügbaren Farben. Man nennt diesen Ausschnitt die Farb-
palette des Dokuments.

Diese Farbpalette kann jederzeit von Ihnen modifiziert werden. Sie können neue Farben hinzufügen und von
Ihnen hinzugefügte Farben abändern. Die ersten 24 Farben in der Farbpalette sind allerdings Standardfar-
ben, die sich nicht verändern lassen.

Wichtig: Änderungen an der Farbpalette werden im Dokument gespeichert. Sie können also zu jedem Do-
kument eine eigene Farbpalette zusammenstellen.

Hinzufügen einer Farbe

Um der Farbpalette des aktuellen Dokuments eine Farbe hinzuzufügen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf und wechseln Sie auf die Karteikarte Farben.

Tipp: Alternativ können Sie diesen Dialog von jedem beliebigen Dialogfenster aus aufrufen, das eine
Farbenliste enthält. Wählen Sie dazu in der Farbenliste den Eintrag Andere... am Ende der Liste.
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2. Stellen Sie die gewünschte Farbe ein (siehe Abschnitt "Bedienung der Kontrollen zum Einstellen von
Farben" weiter unten). 

3. Klicken Sie auf die Schaltfläche Neu.

4. Geben Sie der neuen Farbe im Feld Name einen beliebigen Namen und bestätigen Sie diesen mit OK.

5. Verlassen Sie den Dialog mit OK.

PlanMaker fügt die neue Farbe nun der Farbpalette des Dokuments hinzu. Die Farbe ist ab sofort in allen
Dialogfenstern verfügbar, in denen eine Farbe ausgewählt werden kann.

Ändern einer Farbe

Hinweis: Sie können nur Farben ändern, die von Ihnen hinzugefügt wurden. Die ersten 24 Farben der
Farbpalette sind Standardfarben, die sich nicht verändern lassen.

Um eine Farbe zu ändern, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Datei > Eigenschaften auf und wechseln Sie auf die Karteikarte Farben.

Oder: Alternativ können Sie auch den Eintrag Andere... in einer beliebigen Farbenliste verwenden, um
diesen Dialog aufzurufen.

2. Wählen Sie die zu verändernde Farbe in der Liste Farbpalette.

3. Nehmen Sie die gewünschten Änderungen vor (siehe Abschnitt "Bedienung der Kontrollen zum Einstel-
len von Farben" weiter unten).

4. Klicken Sie auf Ändern.

Die Farbe wurde nun für das aktuelle Dokument verändert.

Löschen oder Umbenennen einer Farbe

Sie können selbstdefinierte Farben jederzeit löschen oder ihren Namen ändern. Rufen Sie dazu den Farben-
dialog auf, selektieren Sie eine Farbe in der Liste Farbpalette und betätigen Sie die Schaltfläche Löschen
beziehungsweise Umbenennen.

Bedienung der Kontrollen zum Einstellen von Farben

Die Kontrollen in obigem Dialog lassen Sie Farben auf vielfältige Arten einstellen. Alle Wege führen zum
gleichen Ergebnis – wählen Sie einfach die Methode, die Ihnen am meisten zusagt:

¡ Verwenden des Farbfeldes und Helligkeitsreglers 

Am einfachsten geht das Einstellen von Farben mit dem großen Farbfeld und dem Helligkeitsregler
rechts daneben. Das Farbfeld stellt alle verfügbaren Farbtöne in allen verfügbaren Sättigungen dar, der
Helligkeitsregler daneben ist für die Helligkeit der Farbe zuständig.

Um eine Farbe einzustellen, klicken Sie zunächst in dem großen Farbfeld auf die gewünschte Farbe.
Dann klicken Sie in dem Helligkeitsregler auf die gewünschte Helligkeit.

¡ Verwenden der Regler für Ton, Sättigung und Helligkeit 

Alternativ können Sie Farben mit den darunter befindlichen Reglern Ton (=Farbton), Sätt (=Sättigung)
und Hell (=Helligkeit) einstellen. Zulässig sind Werte zwischen 0 und 240.
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¡ Verwenden der Regler für Rot, Grün und Blau 

Farben lassen sich alternativ auch über ihre Rot-, Grün- und Blauanteile einstellen. Dazu dienen die Reg-
ler Rot, Grün und Blau. Zulässig sind Werte zwischen 0 und 255.

¡ Eintippen des Hexcodes für eine Farbe 

Sie können eine Farbe auch durch Eintippen ihres Hexcodes in das Eingabefeld mit dem Doppelkreuz #
spezifizieren. 

Solche Hexcodes sind beispielsweise im HTML-Code von Webseiten gebräuchlich. Sie setzen sich aus
drei zweistelligen hexadezimalen Werten für die Farben Rot, Grün und Blau zusammen (RRGGBB).
00FF00 steht beispielsweise für reines Grün.

Dokumenteigenschaften, Karteikarte Statistik

Auf der Karteikarte Statistik im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie statisti-
sche Informationen über das aktuelle Dokument abrufen:

¡ In der Rubrik Zellen wird ausgegeben, wie viele Zellen ausgefüllt sind, und wie viele davon Text, Zah-
len, Formeln beziehungsweise Kommentare enthalten. 

¡ In der Rubrik Allgemeines wird die Zahl der Arbeitsblätter und die Zahl der Druckseiten ausgegeben.

¡ In der Rubrik Objekte wird ausgegeben, wie viele Objekte (Diagramme, Grafiken etc.) das Dokument
enthält.

¡ In der Rubrik Aktionen können Sie ablesen, wann das Dokument erstellt, zuletzt gespeichert und zuletzt
gedruckt wurde.

Dokumenteigenschaften, Karteikarte Optionen

Auf der Karteikarte Optionen im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie allge-
meine Einstellungen zum aktuellen Dokument vornehmen:

Rubrik "Textrahmen"

¡ Tabulatorbreite 

Hier können Sie die Tabulatorbreite für Text in Textrahmen einstellen.

Rubrik "Zellinhalte"

¡ Syntaxhervorhebung 

Ist diese Option aktiviert, werden die Tabellenzellen je nach Inhalt unterschiedlich eingefärbt. Entspricht
dem Menübefehl Ansicht > Syntaxhervorhebung (siehe Abschnitt Syntaxhervorhebung).
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¡ Formelanzeige 

Ist diese Option aktiviert, werden bei allen Formeln die Rechenformeln statt der Ergebnisse angezeigt.
Entspricht dem Menübefehl Ansicht > Formelanzeige (siehe Abschnitt Formelanzeige).

¡ Schutzanzeiger 

Ist diese Option aktiviert, wird – sofern der Blattschutz für das Arbeitsblatt aktiviert wurde – ein kleines
grünes Dreieck bei allen Zellen eingeblendet, die nicht geschützt sind. Dadurch kann man besser erken-
nen, welche Zellen noch editiert werden dürfen. Siehe auch Abschnitt Blattschutz.

¡ Silbentrennung 

Ist diese Option aktiviert, werden in allen Zellen, bei denen mit dem Menübefehl Format > Zelle die
Option Zeilenumbruch aktiviert wurde, bei Bedarf automatische Silbentrennungen durchgeführt. Siehe
auch Abschnitt Silbentrennung.

Rubrik "Kommentare"

¡ Marken anzeigen 

Ist diese Option aktiviert, wird bei allen Zellen, die mit dem Menübefehl Einfügen > Kommentar mit
einem Kommentar versehen wurden, ein kleines gelbes Dreieck eingeblendet. Siehe auch Abschnitt
Kommentare einfügen.

¡ Kommentare immer anzeigen 

Wenn Sie eine Zelle mit einem Kommentar versehen, wird dieser normalerweise nur dann eingeblendet,
wenn Sie mit der Maus auf diese Zelle zeigen. Aktivieren Sie diese Option, werden hingegen alle Kom-
mentare im Dokument permanent angezeigt.

Rubrik "Dezimaltrenner nach Zahleneingabe"

¡ Verschieben um ... Stellen 

Aktivieren Sie diese Option, wird jede ganze Zahl, die Sie in eine Zelle eingeben, automatisch um die
angegebene Zahl an Stellen verschoben.

Diese Option ist nützlich, wenn Sie beispielsweise viele kleine Geldbeträge eingeben müssen. Setzen Sie
nämlich die Zahl der Stellen auf den Wert 2 und geben die Zahl 42 ein, wird dies automatisch in 0,42 ge-
wandelt; die Eingabe 234 wird in 2,34 gewandelt etc. So können Sie sich die Eingabe des Dezimalkom-
mas sparen, wenn Sie eine lange Kolonne von Zahlen mit zwei Dezimalstellen eingeben möchten.

Rubrik "Fenster"

¡ Vertikale Bildlaufleiste 

Hier können Sie wählen, ob die vertikale Bildlaufleiste für das Dokument angezeigt werden soll.

¡ Horizontale Bildlaufleiste 

Hier können Sie wählen, ob die horizontale Bildlaufleiste für das Dokument angezeigt werden soll.

¡ Arbeitsblattregister 

Hier können Sie wählen, ob das Arbeitsblattregister unter der Tabelle angezeigt werden soll. Dieses
dient zum Anlegen und Verwalten von Arbeitsblättern.
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Rubrik "Objekte"

¡ Textrahmen-Hilfslinien 

Hier können Sie wählen, ob um Textrahmen graue Linien angezeigt werden sollen. Diese dienen ledig-
lich dazu, die Position und Größe des Textrahmens anzuzeigen; sie werden nicht ausgedruckt.

¡ Verborgene Objekte anzeigen 

Wie Sie im Abschnitt Verbergen von Objekten nachlesen können, lassen sich Objekte verbergen, sprich:
unsichtbar machen.

Schalten Sie jedoch die Option Verborgene Objekte anzeigen ein, werden auch verborgene Objekte
wieder sichtbar.

Standardwährung

Hier können Sie die Standardwährung für das Dokument ändern. 

Hinweis: Normalerweise sollte diese Option immer auf Aus Systemeinstellung gesetzt sein. Das bedeu-
tet, dass PlanMaker die Standardwährung aus den Ländereinstellungen Ihres Systems verwendet. 

Wenn Sie eine andere Währung auswählen, hat das folgende Auswirkung: 

Wann immer PlanMaker eine Zelle automatisch im Zahlenformat Währung formatiert (weil Sie beispiels-
weise eine Rechenfunktion enthält, die einen Geldbetrag zurückliefert), wird dafür die hier eingestellte
Währung verwendet.

Schaltfläche "Kompatibilität"

Hier können programminterne Einstellungen zur Kompatibilität mit älteren PlanMaker-Dokumenten und
Excel-Dokumenten vorgenommen werden. Diese werden beim Öffnen des Dokuments automatisch gesetzt
und sollten normalerweise nicht verändert werden.

Dokumenteigenschaften, Karteikarte Berechnen

Auf der Karteikarte Berechnen im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie Ein-
stellungen zu den Berechnungen im aktuellen Dokument vornehmen:

Rubrik "Neuberechnung"

Hier können Sie bestimmen, ob die Berechnungen in der Tabelle automatisch aktualisiert werden sollen,
wenn Sie Änderungen am Tabelleninhalt vornehmen:

¡ Automatisch berechnen 

Wählen Sie diese Option, werden alle Berechnungen im Dokument automatisch erneut durchgeführt,
wenn Sie etwas an der Tabelle ändern, also beispielsweise den Inhalt einer Tabellenzelle ändern.

Dies ist die Standardeinstellung. Sie sorgt dafür, dass alle Berechnungen stets aktuelle Ergebnisse lie-
fern.
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¡ Neuberechnen nur vor dem ... 

Wählen Sie hingegen diese Option, werden die Berechnungen nur dann automatisch neu berechnet,
wenn Sie das Dokument speichern, es drucken und/oder Zellen kopieren – je nachdem, welche Opti-
on(en) Sie hier wählen. Schalten Sie alle drei Optionen ab, werden Berechnungen überhaupt nicht mehr
automatisch aktualisiert.

Sie können die Berechnungen allerdings jederzeit manuell aktualisieren lassen: Rufen Sie dazu den
Menübefehl Weiteres > Neu berechnen auf oder drücken Sie die Taste F9.

Rubrik "Externe Bezüge"

Hier können Sie Einstellungen zu externen Zellbezügen vornehmen. Das sind Bezüge, die sich auf Zellen in
anderen Arbeitsmappen beziehen. Details dazu finden Sie im Abschnitt Externe Zellbezüge.

Verfügbare Optionen:

¡ Daten nach dem Öffnen aktualisieren 

Hier können Sie festlegen, ob beim Öffnen eines Dokuments alle darin enthaltenen externen Bezüge
(einmalig) aktualisiert werden sollen:

Immer: Beim Öffnen externe Bezüge automatisch aktualisieren

Niemals: Beim Öffnen externe Bezüge nicht aktualisieren

Nachfragen: Beim Öffnen den Anwender fragen, ob die externen Bezüge aktualisiert werden sollen.

¡ Externe Daten im Dokument speichern 

Ist diese Option aktiviert, speichert PlanMaker eine Kopie aller Werte, die von externen Zellbezügen ge-
liefert werden, im Dokument. Fehlt die Datei für einen externen Bezug beim Aktualisieren, wird auch
weiterhin der Wert angezeigt, den sich PlanMaker zuletzt gemerkt hat.

Schalten Sie die Option aus, wird stattdessen ein Fehlerwert angezeigt, wenn Sie einen externen Bezug
aktualisieren und auf die zugehörige Datei nicht zugegriffen werden kann.

Rubrik "Rundung"

Aufgrund der Tatsache, dass wir Menschen ein anderes Zahlensystem als Computer verwenden, kann es
beim Rechnen auf einem Computer gelegentlich zu (sehr kleinen) Rundungsfehlern kommen. Dies ist kein
PlanMaker-spezifisches Problem, sondern prinzipbedingt und bei allen Computerprogrammen festzustellen.

PlanMaker hat jedoch zwei Optionen, mit denen diese Rundungsfehler weitgehend ausgemerzt werden kön-
nen:

¡ Schalten Sie die Option Endergebnisse runden ein, rundet PlanMaker das Endergebnis jeder Berech-
nung in einer Zelle automatisch auf 15 Stellen.  

¡ Schalten Sie die Option Zwischenergebnisse runden ein, werden auch sämtliche Zwischenergebnisse
einer Berechnung auf 15 Stellen gerundet. 

Die erste Option reduziert die Wahrscheinlichkeit, einen Rundungsfehler zu erhalten, bereits erheb-
lich, die zweite Option macht dies nochmals unwahrscheinlicher. Der Nachteil beider Optionen ist al-
lerdings, dass das Neuberechnen von Tabellen etwas länger dauert.

Ein klassisches Beispiel für dieses Rundungsproblem:
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Sind beide Optionen ausgeschaltet, ergibt die Berechnung (0,1+0,2-0,3)=0 den Wert FALSCH, ob-
wohl WAHR das korrekte Ergebnis wäre. Schalten Sie die beiden Optionen ein, liefert die Berech-
nung ein korrektes Ergebnis.

¡ Eine dritte Option ist Genauigkeit wie angezeigt: Wenn Sie diese Option aktivieren, werden alle Zahlen
so übernommen, wie sie Ihnen nach Rundung auf Dezimalstellen angezeigt werden. Die eingegebenen
Werte werden auf die Dezimalstellen gekürzt, die in den Zelloptionen für das Zahlenformat eingestellt
sind. 

Ein Beispiel:

Sie haben die Summe aus 2,3 + 2,4. Das exakte Ergebnis ist hier 4,7. Sie entscheiden sich aber dafür,
die Dezimalstellen nach dem Komma nicht anzeigen zu lassen. Die Dezimalstellen in den Zelloptio-
nen setzen Sie daher auf  0. In der Tabelle steht jetzt 2 + 2.

Ohne Aktivierung der Option Genauigkeit wie angezeigt: Sie erhalten das Ergebnis 5 (weil die Werte
2,3 + 2,4 im Hintergrund nach wie vor existieren und auf 5 gerundet werden). Sie können auch wei-
terhin mit dem exakten Ergebnis 4,7 weiterrechnen.

Mit Aktivierung der Option Genauigkeit wie angezeigt: Sie erhalten das Ergebnis 4 (weil nur noch
die Werte 2 + 2 existieren, genau wie sie in der Zelle angezeigt werden). Das exakte Ergebnis 4,7 ist
zum Weiterrechnen allerdings verloren gegangen.

Hinweis zur Option Genauigkeit wie angezeigt: Bei längeren Dezimalzahlen als die Nachkommastel-
len, die Sie für das Zahlenformat in den Zelloptionen eingestellt haben, gehen die ursprünglichen, ge-
naueren Werte dauerhaft verloren. Sie sollten sich daher sicher sein, dass Sie diese Option bei Ihrer
Berechnung verwenden wollen. 

Rubrik "Diagramme"

Genau wie Berechnungen werden standardmäßig auch Diagramme automatisch aktualisiert, wenn Sie etwas
am Tabelleninhalt ändern.

Möchten Sie das nicht, dann können Sie die Option Automatisch aktualisieren in der Rubrik Diagramme
ausschalten.

Diagramme müssen dann bei Bedarf von Hand aktualisiert werden. Rufen Sie dazu den Menübefehl Weite-
res > Diagramme aktualisieren auf.

Rubrik "Iterationen"

Diese Einstellung betrifft Zellen, die einen zirkulären Bezug enthalten. Von einem zirkulären Bezug spricht
man, wenn eine Zelle beispielsweise eine Berechnung mit sich selbst durchführt, also zum Beispiel in der
Zelle A1 die Formel =A1+A2 steht.

Aktivieren Sie die Option Iterationen durchführen, werden solche Berechnungen bei jedem Neuberech-
nen des Arbeitsblatts so oft wiederholt, bis entweder die Maximale Anzahl erreicht ist oder das Ergebnis
der Berechnung vom vorherigen Ergebnis um weniger als die Maximale Änderung abweicht.

Normalerweise sollten Tabellen jedoch keine zirkulären Bezüge enthalten, weshalb diese Option standard-
mäßig ausgeschaltet ist.

Hinweis: Sofern Sie nicht bewusst zirkuläre Bezüge in der Tabelle verwenden, um beispielsweise Werte
mit einem Iterationsverfahren zu ermitteln, sollten Sie diese Option nicht aktivieren, da sie die für das
Neuberechnen der Tabelle erforderliche Zeit deutlich erhöhen kann.
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Dokumenteigenschaften, Karteikarte Schutz

Auf der Karteikarte Schutz im Dialogfenster des Menübefehls Datei > Eigenschaften können Sie Doku-
mente mit einem Dokumentschutz versehen.

Öffnen beziehungsweise Speichern eines geschützten Dokuments ist nur nach Eingabe des korrekten Kenn-
worts möglich. Dokumente mit Leseschutz werden dabei zusätzlich verschlüsselt, damit sie auch mit ande-
ren Programmen nicht eingesehen werden können.

Informationen zu diesem Thema finden Sie im Abschnitt Dokumentschutz.

Dokumenteigenschaften, Karteikarte Schriften

Auf der Karteikarte Schriften im Dialogfenster des Menübefehls Datei > Eigenschaften wird eine Liste al-
ler im aktuellen Dokument verwendeten Schriftarten angezeigt.

Die Liste ist aufgeteilt nach Schriften, die auf dem aktuell verwendeten Gerät verfügbar sind, und solchen,
die nicht verfügbar (sprich: installiert) sind.

Arbeitsblatteigenschaften ändern
Über den Menübefehl Arbeitsblatt > Eigenschaften können Sie Einstellungen festlegen, die nur das aktu-
elle Arbeitsblatt betreffen. 

Besteht ein Dokument also aus mehreren Arbeitsblättern, können Sie diese Einstellungen für jedes Blatt ge-
trennt vornehmen. Wechseln Sie dazu auf das gewünschte Arbeitsblatt und rufen Sie dann obigen Befehl
auf.

Es erscheint ein Dialogfenster mit folgenden Optionen:

¡ Zeilenköpfe 

Ist diese Option aktiviert, werden Zeilenköpfe (mit 1, 2, 3... beschriftete Schaltflächen links der Tabelle)
in dem Arbeitsblatt angezeigt.

¡ Spaltenköpfe 

Ist diese Option aktiviert, werden Spaltenköpfe (mit A, B, C... beschriftete Schaltflächen oberhalb der
Tabelle) in dem Arbeitsblatt angezeigt.

Tipp: Sie können auch den Menübefehl Ansicht > Zeilen- & Spaltenköpfe verwenden, um die Zeilen-
und die Spaltenköpfe gemeinsam ein- oder auszuschalten.

¡ Seitenumbrüche 

Ist diese Option aktiviert, wird eine dunkle Linie zwischen denjenigen Zellen angezeigt, bei denen beim
Ausdruck ein Seitenumbruch stattfinden wird.
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¡ Nullwerte anzeigen 

Eine Zelle enthält einen Nullwert, wenn dort entweder die Zahl 0 (Null) eingetragen wurde oder die Zel-
le eine Berechnung enthält, die Null ergibt. 

Ist diese Option aktiviert, wird in solchen Zellen wie üblich die Zahl "0" angezeigt. Schalten Sie sie aus,
wird darin nichts mehr angezeigt.

¡ Gitternetzlinien 

Ist diese Option aktiviert, wird ein Raster aus grauen Gitternetzlinien zwischen den Tabellenzellen ange-
zeigt. Darunter können Sie auf Wunsch die Farbe dieser Linien ändern.

Die Gitternetzlinien werden normalerweise nicht ausgedruckt. Wenn Sie möchten, dass diese Linien
auch im Ausdruck erscheinen, rufen Sie den Menübefehl Datei > Seite einrichten auf, wechseln auf die
Karteikarte Optionen und aktivieren darin die Option Gitternetz.

¡ Arbeitsblattregister 

Am unteren Fensterrand wird ein Arbeitsblattregister angezeigt, mit dem Sie zwischen den Arbeitsblät-
tern eines Dokuments wechseln können. 

Mit dieser Option lässt sich die Farbe der Registerkarte für das aktuelle Blatt ändern.

¡ Hintergrund 

Wenn Sie hier die Option Abwechselnde Schattierung aktivieren, werden die Zeilen der Tabelle mit
abwechselnden Schattierungen versehen: Jede ungerade Zeile erhält die Schattierung, die Sie mit der
Schaltfläche Schattierung 1 festlegen; jede gerade Zeile erhält die mit Schattierung 2 festgelegte
Schattierung.

¡ Blattrichtung 

Für Tabellen in arabischer Schrift können Sie hier die Richtung des Arbeitsblatts auf rechts-nach-links
ändern. 

Das Arbeitsblatt wird dann horizontal gespiegelt – die Zelle A1 befindet sich also nicht mehr links oben,
sondern rechts oben. 

Siehe auch Kapitel Arbeiten mit arabischem Text.

Bildschirmdarstellung ändern
In diesem Abschnitt erfahren Sie, wie Sie die Darstellung der Tabelle auf dem Bildschirm anpassen können.
Die dazu benötigten Befehle finden Sie im Menü Ansicht.

Folgende Themen werden in diesem Abschnitt behandelt:

¡ Vergrößerungsstufe 

Mit den Menübefehl Ansicht > Originalgröße und Ansicht > Vergrößerungsstufe können Sie die Ver-
größerungsstufe einstellen, in der das Dokument angezeigt wird.

¡ Vollbildansicht 

Der Menübefehl Ansicht > Vollbild maximiert das Programmfenster und blendet die meisten Bestand-
teile der Benutzeroberfläche aus, damit möglichst viel vom Dokument zu sehen ist. 
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Lesen Sie dazu die nächsten Seiten.

Vergrößerungsstufe

Mit den Befehlen des Menüs Ansicht können Sie unter anderem die Vergrößerungsstufe für das aktuelle
Dokument wählen.

Während der Menübefehl Ansicht > Originalgröße das Dokument stets auf eine Vergrößerungsstufe von
100% bringt, erlaubt Ansicht > Vergrößerungsstufe eine genaue Auswahl der gewünschten Vergröße-
rungsstufe:

Vergrößerungsstufe Erläuterung

An Selektion anpassen Wählt automatisch die Vergrößerungsstufe, bei der die momentan selektierten Zel-
len genau in das Arbeitsfenster passen.

Vorherige Vergrößerungsstufe Stellt die zuletzt gewählte Vergrößerungsstufe wieder her.

50%, 75% etc. Wählt eine der vorgegebenen Vergrößerungsstufen.

Alternativ können Sie auch eine beliebige Vergrößerungsstufe in das Eingabefeld oberhalb der Liste eintra-
gen (50 bis 400 Prozent).

Tipp: Verwenden des Zoomreglers

Sie können die Vergrößerungsstufe auch mit dem Zoomregler in der rechten unteren Bildschirmecke än-
dern.

Ziehen Sie dazu entweder an dem Schieber in der Mitte, oder klicken Sie auf das Minus- oder Plussymbol,
um die Vergrößerungsstufe zu verändern.

Tipp: Wenn Sie auf die Prozentangabe rechts neben dem Zoomregler klicken, öffnet sich der Dialog des
oben erwähnten Befehls Ansicht > Vergrößerungsstufe.

Vollbildansicht

Mit dem Menübefehl Ansicht > Vollbild können Sie in die Vollbildansicht schalten, in der das Programm
den gesamten Bildschirm zur Darstellung des Dokuments nutzt. PlanMaker vergrößert dazu sein Programm-
fenster auf die volle Bildschirmgröße und blendet sämtliche Symbolleisten aus.

Um diesen Ansichtsmodus wieder zu verlassen, drücken Sie die Taste Esc oder rufen den Menübefehl An-
sicht > Vollbild noch einmal auf.

Verwenden der Symbolleiste der Vollbildansicht

Wenn Sie den Vollbildmodus aktivieren, erscheint eine zusätzliche Symbolleiste auf dem Bildschirm.



384Anpassen von PlanMaker

Die Symbolleiste "Vollbildmodus"

Diese hat folgende Funktionen (von links nach rechts):

¡ Menüleiste ein-/ausblenden 

¡ Seitenleiste ein-/ausblenden

¡ Modus "Blatt verschieben" aktivieren/deaktivieren

Wenn Sie diesen Modus aktivieren, können Sie das Dokument mit der Maus verschieben. Klicken Sie
dazu in das Dokument und ziehen Sie es bei weiterhin gedrückter Maustaste in die gewünschte Richtung.

Hinweis: Das Anklicken von Zellen, um die Schreibmarke zu setzen, sowie das Selektieren von Text
oder Objekten ist in diesem Modus nicht mehr möglich.

Um den Modus "Blatt verschieben" wieder zu verlassen, klicken Sie dieses Symbol noch einmal an.

¡ Die Schaltfläche Schließen beendet den Vollbildmodus. 

Symbolleisten anpassen

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den
Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten be-
dienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menü-
band) anpassen.)

Tipp: Die Benutzeroberfläche lässt sich jederzeit zwischen Ribbon und klassischen Menüs mit Symbol-
leisten umschalten. Rufen Sie dazu im Menü den Befehl Weiteres > Einstellungen auf (beziehungsweise
im Ribbon den Befehl Datei > Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Ausse-
hen und klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein weiterer Dialog, in
dem Sie die gewünschte Art von Benutzeroberfläche wählen können.

In diesem Abschnitt erfahren Sie, wie Sie die Symbolleisten (Funktionsleiste, Formatleiste etc.) mit dem
Menübefehl Ansicht > Symbolleisten konfigurieren und mit Weiteres > Anpassen nach Ihren Wünschen
anpassen können. 

Eine Symbolleiste (hier: die Funktionsleiste)

Folgende Themen werden darin behandelt:

¡ Symbolleisten anzeigen/verbergen 

¡ Symbolleisten auf dem Bildschirm positionieren

¡ Symbolleisten verwalten (Symbolleisten erstellen, löschen, umbenennen, zurücksetzen)

¡ Symbole einer Symbolleiste anpassen (Symbole hinzufügen, entfernen, verschieben)

¡ Verwenden des Symbolleisten-Menüs (für besonders schnellen Zugriff auf obige Funktionen)

Informationen dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.
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Symbolleisten anzeigen/verbergen

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den
Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten be-
dienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menü-
band) anpassen.)

Sie können die verfügbaren Symbolleisten jederzeit ein- oder ausschalten, um diese sichtbar zu machen be-
ziehungsweise zu verbergen.

Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl Ansicht > Symbolleisten auf.

2. Klicken Sie in das Kästchen vor der gewünschten Symbolleiste, um sie ein- beziehungsweise auszuschal-
ten. Wenn die Symbolleiste eingeschaltet ist, erscheint ein Häkchen in dem Kästchen.

3. Verlassen Sie das Dialogfenster mit Schließen.

Die entsprechende Symbolleiste wurde nun ein- beziehungsweise ausgeschaltet.

Tipp: Hierfür gibt es eine Abkürzung: Wenn Sie mit der rechten Maustaste auf eine beliebige Symbol-
leiste klicken, erscheint ein Menü mit einer Liste aller verfügbaren Symbolleisten. Klicken Sie einen die-
ser Menüeinträge an, wird die entsprechende Leiste ein- beziehungsweise ausgeschaltet.

Sichtbar in Modus ...

Manche Symbolleisten werden nur in bestimmten Situationen angezeigt. Zum Beispiel erscheint die Grafi-
kleiste nur dann, wenn Sie ein Bild selektieren.

Zuständig hierfür ist die Option Sichtbar in Modus, die bestimmt, wann eine Symbolleiste sichtbar sein
soll. Einige Beispiele:

Option Bedeutung

Alle Die gewählte Symbolleiste ist immer sichtbar (sofern sie natürlich nicht ausgeschaltet wurde).
Beispiel: Funktionsleiste

Editiermodus Die Leiste ist nur im normalen Editiermodus sichtbar, nicht jedoch im Objektmodus (siehe
auch Abschnitt Der Objektmodus). Beispiel: Formatleiste

Objekt Die Leiste ist nur im Objektmodus sichtbar, nicht jedoch im normalen Editiermodus (siehe
auch Abschnitt Der Objektmodus). Beispiel: Objektleiste

Diagramm Die Leiste erscheint nur, wenn im Dokument ein Diagramm selektiert wird. Beispiel: Dia-
grammleiste

Gliederung Die Leiste erscheint nur, wenn die Gliederung des Dokuments angezeigt wird (siehe auch Ab-
schnitt Gliederungen). Beispiel: Gliederungsleiste

Grafik Die Leiste erscheint nur, wenn im Dokument eine Grafik selektiert wird. Beispiel: Grafikleiste
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Um diese Einstellung für eine der Symbolleisten zu ändern, rufen Sie den Menübefehl Ansicht > Symbol-
leisten auf, selektieren die Leiste in der Liste Symbolleisten und wählen die gewünschte Option bei Sicht-
bar in Modus.

Hinweis: Es ist normalerweise nicht empfehlenswert, diese Einstellung bei den Standard-Symbolleisten
(Funktionsleiste, Formatleiste etc.) zu ändern. Diese Option ist in erster Linie für selbsterstellte Symbol-
leisten gedacht.

Symbolleisten auf dem Bildschirm positionieren

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den
Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten be-
dienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menü-
band) anpassen.)

Sie können jede einzelne Symbolleiste nach Belieben auf dem Bildschirm positionieren. Verwenden Sie da-
zu eines der folgenden Verfahren:

Ändern der Position mit dem Befehl Ansicht > Symbolleisten

Sie können die Position einer Symbolleiste jederzeit mit dem Menübefehl Ansicht > Symbolleisten ändern.
Gehen Sie dazu wie folgt vor:

1. Rufen Sie den Menübefehl Ansicht > Symbolleisten auf.

2. Selektieren Sie die gewünschte Symbolleiste per Mausklick in der Liste.

3. Wählen Sie bei Position, wo die Symbolleiste platziert werden soll.

Hinweis: Wenn Sie die Option Frei wählen, werden die Symbole der Symbolleiste in einem Fenster ange-
zeigt, das wie ein Programmfenster frei bewegt, vergrößert und verkleinert werden kann.

Ändern der Position mit der Maus

Manche Symbolleisten lassen sich außerdem mit der Maus verschieben. Gehen Sie dazu wie folgt vor:

1. Zeigen Sie mit der Maus auf einen leeren Bereich der Symbolleiste.

2. Drücken Sie die linke Maustaste und halten Sie diese gedrückt.

3. Ziehen Sie die Symbolleiste bei weiterhin gedrückter Maustaste an die gewünschte Position.

4. Lassen Sie die Maustaste los, um die Symbolleiste dort abzusetzen.

Hinweis: Die meisten Symbolleisten sind gegen das Verschieben mit der Maus verriegelt, um unbeab-
sichtigtes Verschieben zu verhindern. Sie können diese Verriegelung aber jederzeit lösen: Rufen Sie dazu
den Menübefehl Ansicht > Symbolleisten auf, selektieren Sie die Leiste und schalten Sie die Option
Nicht verschiebbar aus. Von nun an ist diese Leiste auch mit der Maus verschiebbar.

Beim Verschieben ist übrigens eine Positionierhilfe aktiv: Wenn Sie die Symbolleiste in die Nähe einer der
Kanten des Programmfensters ziehen, springt diese automatisch auf die entsprechende Kante. Lassen Sie
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die Leiste beispielsweise an der oberen Kante los, entspricht dies dem Wählen der Position Oben im Dia-
logfenster des Menübefehls Ansicht > Symbolleisten. 

Symbolleisten verwalten

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den
Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten be-
dienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menü-
band) anpassen.)

Sie können jederzeit neue Symbolleisten erstellen und vorhandene Leisten löschen, umbenennen etc. Ver-
wenden Sie hierzu die Schaltflächen im Dialogfenster des Menübefehls Ansicht > Symbolleisten.

Neue Symbolleiste erstellen

Das Programm lässt Sie jederzeit eigene Symbolleisten erstellen. 

Benötigen Sie beispielsweise häufig die Befehle des Menüs Fenster, die in der Standard-Funktionsleiste
nicht vorhanden sind, wäre es überlegenswert, sich hierfür eine eigene Symbolleiste anzulegen.

Folgendermaßen erstellen Sie eine neue Symbolleiste:

1. Betätigen Sie die Schaltfläche Neu (im Dialogfenster des Menübefehls Ansicht > Symbolleisten).

2. Es erscheint ein Dialogfenster, in das Sie einen Namen für die neue Leiste eingeben – zum Beispiel
"Meine Symbolleiste". Bestätigen Sie dann mit OK.

3. Die neue Symbolleiste wurde angelegt. Schließen Sie das Dialogfenster oder klicken Sie auf die Schalt-
fläche Anpassen, um sie gleich mit Symbolen zu füllen. Lesen Sie dazu den Abschnitt Symbole einer
Symbolleiste anpassen.

Symbole einer Symbolleiste anpassen

Mit der Schaltfläche Anpassen können Sie die Symbole auf Symbolleisten bearbeiten. Informationen hierzu
finden Sie im nächsten Abschnitt.

Symbolleiste löschen

Mit der Schaltfläche Löschen entfernen Sie eine selbsterstellte Symbolleiste:

1. Selektieren Sie die zu löschende Symbolleiste in der Liste.

2. Betätigen Sie die Schaltfläche Löschen.

Hinweis: Sie können nur selbsterstellte Symbolleisten löschen. Die Standard-Symbolleisten (Funktionsleis-
te, Formatleiste etc.) lassen sich nicht entfernen. 

Sie können eine Standard-Symbolleiste jedoch jederzeit ausschalten, wenn Sie sie nicht benötigen (siehe
Abschnitt Symbolleisten anzeigen/verbergen).
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Symbolleiste umbenennen

Mit der Schaltfläche Umbenennen geben Sie einer selbsterstellten Symbolleiste einen anderen Namen:

1. Selektieren Sie die gewünschte Symbolleiste in der Liste.

2. Betätigen Sie die Schaltfläche Umbenennen.

3. Tippen Sie den neuen Namen ein und bestätigen Sie mit OK.

Hinweis: Sie können nur selbsterstellte Symbolleisten umbenennen. Die Standard-Symbolleisten (Funkti-
onsleiste, Formatleiste etc.) lassen sich nicht umbenennen.

Symbolleiste zurücksetzen

Mit der Schaltfläche Zurücksetzen machen Sie alle Änderungen an einer der Standard-Symbolleisten rück-
gängig:

1. Selektieren Sie die gewünschte Symbolleiste in der Liste.

2. Betätigen Sie die Schaltfläche Zurücksetzen.

Nun enthält die Symbolleiste wieder die Standard-Symbole. Außerdem wurden die Optionen Sichtbar in
Modus... und Position auf die Standardeinstellung zurückgesetzt.

Hinweis: Dieser Befehl ist nur auf die Standard-Symbolleisten (Funktionsleiste, Formatleiste etc.) anwend-
bar, nicht jedoch auf selbsterstellte Symbolleisten.

Alle Symbolleisten zurücksetzen

Mit der Schaltfläche Alle zurücksetzen machen Sie alle Änderungen an allen Standard-Symbolleisten rück-
gängig. 

Hinweis: Dieser Befehl wirkt sich nur auf die Standard-Symbolleisten aus. Selbsterstellte Symbolleisten
bleiben unverändert erhalten.

Symbole einer Symbolleiste anpassen

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den
Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten be-
dienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menü-
band) anpassen.)

Der Menübefehl Weiteres > Anpassen erlaubt es Ihnen, die Symbole auf einer Symbolleiste nach Ihren
Wünschen anzupassen. Sie können unter anderem Symbole hinzufügen und vorhandene Symbole entfernen
oder verschieben. 

Gehen Sie folgendermaßen vor:

1. Rufen Sie den Menübefehl Weiteres > Anpassen auf.

2. Verwenden Sie eines der unten beschriebenen Verfahren, um Symbole hinzuzufügen, zu entfernen, zu
verschieben etc.
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3. Verlassen Sie den Dialog mit Schließen.

Tipp: Dieser Befehl lässt sich auch durch einen Doppelklick auf einen leeren Bereich in einer beliebigen
Symbolleiste aufrufen. 

Beim Aufruf des Befehls erscheint ein Dialogfenster.

Dieses Dialogfenster enthält zwei Listen:

¡ Linke Liste: alle verfügbaren Befehle 

Die linke Liste zeigt sämtliche im Programm verfügbaren Befehle an. 

Tipp: Über die Option Kategorien (oberhalb der linken Liste) können Sie die Liste nach einer bestimm-
ten Kategorie filtern lassen (zum Beispiel alle Kommandos der Kategorie "Datei"). 

Außerdem können Sie in das Feld Schnellsuche etwas eintippen, um die Liste danach durchsuchen zu
lassen.

¡ Rechte Liste: Symbole der momentan ausgewählten Symbolleiste 

Die rechte Liste zeigt die Symbole an, die sich in der momentan ausgewählten Symbolleiste befinden.

Welche Symbolleiste hier angezeigt werden soll, lässt sich über die aufklappbare Liste Anpassen (ober-
halb der rechten Liste) festlegen. 

In dem Dialog lassen sich folgende Aktionen durchführen:

Hinzufügen eines Symbols

Um ein Symbol zu einer bestimmten Symbolleiste hinzuzufügen, führen Sie im Dialogfenster des Befehls
Weiteres > Anpassen folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen (oberhalb der rechten Liste) die Symbolleiste, zu der
Sie ein Symbol hinzufügen möchten.

Die rechte Liste zeigt nun alle Symbole an, die sich momentan in der gewählten Symbolleiste befinden.

2. Optional: Selektieren Sie in der rechten Liste das Symbol, hinter dem das neue Symbol eingefügt werden
soll.

3. Selektieren Sie in der linken Liste das Symbol, das Sie hinzufügen möchten.

4. Klicken Sie auf die Schaltfläche >> (zwischen den Listen).

Das Symbol wird der Symbolleiste nun hinzugefügt.

Tipp: Alternativ können Sie ein Symbol auch folgendermaßen einer (beliebigen) Symbolleiste hinzufü-
gen: Rufen Sie den Befehl Weiteres > Anpassen auf. Ziehen Sie dann das Symbol einfach mit der Maus
aus dem Dialogfenster heraus und lassen sie es an der gewünschten Position in der Symbolleiste fallen
(in der Symbolleiste selbst, nicht im Dialog!). Dies setzt natürlich voraus, dass die Symbolleiste derzeit
auf dem Bildschirm sichtbar ist.

Entfernen eines Symbols

Um ein Symbol aus einer Symbolleiste zu entfernen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen (oberhalb der rechten Liste) die gewünschte Symbol-
leiste.
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2. Selektieren Sie in der rechten Liste das zu entfernende Symbol.

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen).

Das Symbol wird nun aus der Symbolleiste entfernt.

Tipp: Alternativ können Sie ein Symbol auch folgendermaßen aus einer Symbolleiste entfernen: Rufen
Sie den Befehl Weiteres > Anpassen auf. Ziehen Sie dann das Symbol einfach mit der Maus aus der
Symbolleiste nach unten heraus (in der Symbolleiste selbst, nicht im Dialog!).

Verschieben eines Symbols

Um ein Symbol in einer Symbolleiste zu verschieben, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Symbolleiste.

2. Selektieren Sie in der rechten Liste das zu verschiebende Symbol.

3. Verwenden Sie die Schaltflächen mit dem Pfeil nach oben beziehungsweise unten (links neben der rech-
ten Liste), um das Symbol innerhalb der Symbolleiste zu verschieben.

Hinweis: Wenn Sie ein Symbol auf eine andere Symbolleiste verschieben möchten, müssen Sie dieses
erst aus seiner bisherigen Symbolleiste entfernen und es dann der anderen Symbolleiste hinzufügen.

Tipp 1: Alternativ können Sie ein Symbol auch folgendermaßen verschieben: Rufen Sie den Befehl Wei-
teres > Anpassen auf. Ziehen Sie das Symbol dann direkt in der Symbolleiste mit der Maus an die ge-
wünschte Position (in der Symbolleiste selbst, nicht im Dialog!). Bei dieser Methode können Sie ein
Symbol übrigens auch direkt von einer Symbolleiste in eine andere verschieben.

Tipp 2: Das Verschieben von Symbolen funktioniert übrigens auch, wenn dieser Dialog nicht geöffnet
ist: Wenn Sie nämlich die Taste Alt gedrückt halten und dann auf ein Symbol in einer Symbolleiste kli-
cken, können Sie dieses (bei weiterhin gedrückter Maustaste) nach Belieben verschieben.

Einfügen einer Trennlinie (Separator)

Um in einer Symbolleiste eine Trennlinie vor einem Symbol einzufügen, führen Sie in dem Dialog folgende
Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Symbolleiste.

2. Selektieren Sie in der rechten Liste das Symbol, vor dem die Trennlinie eingefügt werden soll.

3. Klicken Sie auf die Schaltfläche Neuer Trenner (unterhalb der rechten Liste).

Die Trennlinie wird nun eingefügt.

Tipp: Alternativ können Sie auch folgende Vorgehensweise verwenden: Rufen Sie den Befehl Weiteres
> Anpassen auf. Um nun eine Trennlinie links von einem Symbol in einer beliebigen Symbolleiste ein-
zufügen, ziehen Sie dieses Symbol einfach mit der Maus einige Millimeter nach rechts (in der Symbol-
leiste selbst, nicht im Dialog!). 

Entfernen einer Trennlinie

Um eine Trennlinie aus einer Symbolleiste zu entfernen, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Symbolleiste.



391Anpassen von PlanMaker

2. Selektieren Sie in der rechten Liste die zu entfernende Trennlinie.

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen).

Die Trennlinie wird nun aus der Symbolleiste entfernt.

Tipp: Alternativ können Sie auch folgende Vorgehensweise verwenden: Rufen Sie den Befehl Weiteres
> Anpassen auf. Wenn Sie nun (in der Symbolleiste selbst, nicht im Dialog!) ein Symbol, das sich rechts
von einer Trennlinie befindet, an das Symbol links davon heranziehen, wird diese Trennlinie entfernt.

Zuweisen von Tastenkürzeln

Wenn Sie in dem Dialog die Schaltfläche Tastenkürzel anklicken, erweitert sich der Dialog um eine zusätz-
liche Sektion namens Tastenkürzel, die zum Bearbeiten von Tastenkürzeln für Befehle verwendet werden
kann. 

Kurzfassung: Sie können hier einem beliebigen Befehl ein Tastenkürzel Ihrer Wahl zuweisen: Selektieren
Sie den Befehl dazu in einer der beiden Listen, klicken Sie in das Feld Bitte Tastenkürzel drücken und be-
tätigen Sie dann die Tastenkombination, mit der Sie diesen Befehl künftig aufrufen möchten.

Ausführliche Informationen dazu finden Sie im Abschnitt Tastenkürzel anpassen.

Verwalten von Symbolleisten

Das Dialogfenster des Befehls Weiteres > Anpassen verfügt außerdem über Schaltflächen zum Verwalten
von Symbolleisten:

¡ Neu 

Legt eine neue, leere Symbolleiste an.

¡ Umbenennen 

Benennt die in der Liste Anpassen gewählte Symbolleiste um (nur bei selbsterstellten Symbolleisten
möglich).

¡ Zurücksetzen 

Setzt die in der Liste Anpassen gewählte Symbolleiste wieder auf ihren Auslieferungszustand zurück. 

¡ Löschen 

Löscht die in der Liste Anpassen gewählte Symbolleiste (nur bei selbsterstellten Symbolleisten mög-
lich).

¡ Alle zurücksetzen (unterhalb der rechten Liste) 

Setzt alle Symbolleisten wieder auf ihren Auslieferungszustand zurück. 

Weitere Möglichkeiten zum Verwalten und Konfigurieren von Symbolleisten bietet der Menübefehl An-
sicht > Symbolleisten (siehe Abschnitt Symbolleisten verwalten).
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Verwenden des Symbolleisten-Menüs

Nur bei "klassischen Menüs und Symbolleisten": Dieser Abschnitt betrifft nur Anwender, die in den
Einstellungen ausgewählt haben, dass sie das Programm mit klassischen Menüs und Symbolleisten be-
dienen möchten. (Informationen zum Anpassen des Ribbons finden Sie im Abschnitt Ribbon (Menü-
band) anpassen.)

Einige Symbolleisten enden mit einem doppelten Pfeil » nach rechts, wie in folgender Abbildung zu sehen:

Wenn Sie diesen Doppelpfeil anklicken, öffnet sich das Symbolleisten-Menü für diese Leiste. 

Dieses Menü ermöglicht schnellen Zugriff auf alle Befehle zum Arbeiten mit Symbolleisten, die in den vor-
herigen Abschnitten beschrieben wurden. Im Einzelnen gibt es im Symbolleisten-Menü folgende Befehle:

¡ Schaltflächen hinzufügen/entfernen 

Dieser Befehl zeigt eine Liste aller Symbole für eine Symbolleiste an. Klicken Sie einen der Einträge an,
wird das entsprechende Symbol in der Leiste ein- beziehungsweise ausgeschaltet.

(Dieser Befehl soll nur zum schnellen Ein- oder Ausschalten von Symbolen dienen. Wie Sie die Symbo-
le auf einer Leiste individuell konfigurieren, ist im Abschnitt Symbole einer Symbolleiste anpassen be-
schrieben.)

¡ Position 

Mit diesem Befehl können Sie die Position der Symbolleiste ändern. Verfügbare Optionen: oben, unten,
links, rechts oder frei (in einem kleinen Fenster, dessen Position und Größe sich mit der Maus beliebig
ändern lassen).

¡ Symbolleisten 

Ruft den Menübefehl Ansicht > Symbolleisten auf, mit dem Sie Symbolleisten ein-/ausschalten, konfi-
gurieren und verwalten können.

Siehe Abschnitt Symbolleisten anpassen.

¡ Anpassen 

Ruft den Menübefehl Weiteres > Anpassen auf, mit dem Sie die Symbole einer Symbolleiste bearbeiten
können (Symbole hinzufügen, entfernen, verschieben etc.).

Siehe Abschnitt Symbole einer Symbolleiste anpassen.

¡ Diese Symbolleiste zurücksetzen 

Setzt die Symbolleiste zurück. Die Leiste zeigt dann wieder ihre Standardsymbole an. Außerdem werden
alle Einstellungen, die zu der Leiste gemacht wurden, verworfen.



393Anpassen von PlanMaker

Ribbon (Menüband) anpassen

Nur bei "Ribbons": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt ha-
ben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpas-
sen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)

Tipp: Die Benutzeroberfläche lässt sich jederzeit zwischen Ribbon und klassischen Menüs mit Symbol-
leisten umschalten. Rufen Sie dazu im Menü den Befehl Weiteres > Einstellungen auf (beziehungsweise
im Ribbon den Befehl Datei > Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Ausse-
hen und klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein weiterer Dialog, in
dem Sie die gewünschte Art von Benutzeroberfläche wählen können.

In diesem Abschnitt erfahren Sie, wie Sie das Ribbon (Menüband) konfigurieren und um zusätzliche Sym-
bole erweitern können. 

Das "Ribbon" (Ausschnitt) und die Schnellzugriffsleiste (unten)

Folgende Themen werden darin behandelt:

¡ Ribbon anzeigen/verbergen 

¡ Position der Schnellzugriffsleiste ändern

¡ Symbole im Ribbon anpassen

¡ Symbole der Schnellzugriffsleiste anpassen

Informationen dazu finden Sie, in obiger Reihenfolge, auf den nächsten Seiten.

Ribbon anzeigen/verbergen

Nur bei "Ribbons": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt ha-
ben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpas-
sen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)

Normalerweise ist das Ribbon-Menüband immer vollständig zu sehen:
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Das "Ribbon" (Ausschnitt) und die Schnellzugriffsleiste (unten)

Sie können das Ribbon aber jederzeit ausblenden, indem Sie es minimieren. Dies ist hilfreich, wenn Sie auf
dem Bildschirm möglichst viel Platz für die Anzeige des Dokuments erhalten möchten.

Gehen Sie wie folgt vor:

1. Klicken Sie im Ribbon auf das Symbol Anpassen in der Karteikarte Datei.

2. Es öffnet sich ein Menü. Darin finden Sie eine Option namens Minimiertes Ribbon, die sich durch
Anklicken ein- beziehungsweise ausschalten lässt. (Ein Häkchen erscheint vor der Option, wenn sie der-
zeit eingeschaltet ist.) 

Wenn Sie diese Option einschalten, wird das Ribbon minimiert dargestellt. Es sind dann nur noch seine
Karteikartenreiter zu sehen.

Tipp: Sie können alternativ auch das Symbol  in der rechten oberen Ecke des Programmfensters ankli-
cken, um das Ribbon zu minimieren. Wenn Sie das Symbol erneut anklicken, wird das Minimieren wie-
der aufgehoben.
Darüber hinaus können Sie die Tastenkombination Strg+F1 (beim Mac: Cmd+F1) verwenden, um das
Minimieren ein-/auszuschalten.

Arbeiten mit einem minimierten Ribbon

Folgendermaßen arbeiten Sie mit einem minimierten Ribbon:

¡ Wenn Sie einen der Karteikartenreiter des minimierten Ribbons anklicken, wird das Ribbon vorüberge-
hend wieder vollständig sichtbar und zeigt die entsprechende Karteikarte an. Sobald Sie darin aber ein
Kommando auslösen (also z.B. das Symbol für einen Befehl anklicken), wird das Ribbon automatisch
wieder minimiert. 

¡ Wenn Sie auf einen der Karteikartenreiter doppelklicken, wird das Ribbon dauerhaft wieder sichtbar,
das Minimieren wird also aufgehoben. 

¡ Wie oben bereits als Tipp erwähnt, können Sie außerdem das Symbol  in der rechten oberen Ecke des
Programmfensters verwenden, um das Minimieren des Ribbons ein-/auszuschalten.
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Position der Schnellzugriffsleiste ändern

Nur bei "Ribbons": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt ha-
ben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpas-
sen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)

Unter dem Ribbon wird die Schnellzugriffsleiste angezeigt. Diese bietet eine Auswahl an besonders häufig
benötigten Befehlen.

Das "Ribbon" (Ausschnitt) und die Schnellzugriffsleiste (unten)

Die Schnellzugriffsleiste kann sich wahlweise den Platz mit den Registerkarten für Dokumente teilen – oder
in seiner eigenen Leiste untergebracht sein. Um dies zu ändern, gehen Sie folgendermaßen vor:

1. Klicken Sie im Ribbon auf das Symbol Anpassen in der Karteikarte Datei.

2. Es öffnet sich ein Menü, das einen der folgenden beiden Befehle enthält:

Schnellzugriffsleiste als separate Leiste anzeigen: Standardmäßig wird die Schnellzugriffsleiste in der
Leiste angezeigt, in der sich auch die Registerkarten für Dokumente befinden. Wenn Sie diesen Befehl
aufrufen, wandert die Schnellzugriffsleiste stattdessen in seine eigene Leiste.

Schnellzugriffsleiste links der Dokumentregisterkarten anzeigen: Dieser Befehl macht genau das
Gegenteil: Wenn die Schnellzugriffsleiste derzeit als separate Symbolleiste angezeigt wird, bewirkt das
Aufrufen dieses Befehls, dass die Schnellzugriffsleiste nun wieder in die Leiste mit den Registerkarten
für Dokumente befördert wird.

Symbole im Ribbon anpassen

Nur bei "Ribbons": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt ha-
ben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpas-
sen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)

Der Ribbonbefehl Datei > Anpassen > Ribbon anpassen ermöglicht es Ihnen, das Ribbon in einem gewis-
sen Rahmen anzupassen. In erster Linie soll dieser Befehl dazu dienen, dem Ribbon zusätzliche Symbole,
Sektionen oder gar komplette Karteikarten hinzuzufügen. 
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Wichtig: Die Symbole in den vorgegebenen Sektionen auf dem Ribbon lassen sich nicht verändern. Sie
können in den vorhandenen Sektionen also weder Symbole hinzufügen, noch Symbole entfernen, noch
deren Reihenfolge ändern. Zusätzliche Symbole lassen sich nur in neuen Sektionen am Ende einer Kar-
teikarte einfügen (oder wahlweise in einer komplett neuen Karteikarte).

Gehen Sie zum Anpassen des Ribbons wie folgt vor:

1. Rufen Sie im Ribbon den Befehl Datei > Anpassen > Ribbon anpassen auf.

2. Verwenden Sie eines der unten beschriebenen Verfahren, um die Symbole auf einer Karteikarte des Rib-
bons zu bearbeiten.

3. Verlassen Sie den Dialog mit Schließen.

Tipp: Dieser Befehl lässt sich auch durch einen Doppelklick auf einen beliebigen leeren Bereich inner-
halb des Ribbons aufrufen. 

Beim Aufruf des Befehls erscheint ein Dialogfenster.

Dieses Dialogfenster enthält zwei Listen:

¡ Linke Liste: alle verfügbaren Befehle 

Die linke Liste zeigt sämtliche im Programm verfügbaren Befehle an. 

Tipp: Über die Option Kategorien (oberhalb der linken Liste) können Sie die Liste nach einer bestimm-
ten Kategorie filtern lassen (zum Beispiel alle Kommandos der Kategorie "Datei"). 

Außerdem können Sie in das Feld Schnellsuche etwas eintippen, um die Liste danach durchsuchen zu
lassen.

¡ Rechte Liste: Symbole der momentan ausgewählten Karteikarte des Ribbons 

Die rechte Liste zeigt die Symbole an, die sich in der ausgewählten Karteikarte des Ribbons befinden.

Welche Karteikarte hier angezeigt werden soll, lässt sich über die aufklappbare Liste Anpassen (ober-
halb der rechten Liste) festlegen. 

In dem Dialog lassen sich folgende Aktionen durchführen:

Hinzufügen eines Symbols

Hinweis: Sie können Symbole nur in selbst hinzugefügten Sektionen (oder komplett neuen Karteikarten)
hinzufügen. Das Einfügen eines Symbols innerhalb der vorgegebenen Sektionen ist nicht möglich. 

Um ein Symbol zu einer bestimmten Karteikarte des Ribbons hinzuzufügen, führen Sie im Dialogfenster des
Ribbonbefehls Datei > Anpassen > Ribbon anpassen folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen (oberhalb der rechten Liste) die Karteikarte, zu der Sie
ein Symbol hinzufügen möchten.

Die rechte Liste zeigt nun alle Symbole an, die sich momentan auf dieser Karteikarte befinden.

2. Selektieren Sie in der linken Liste das Symbol, das Sie hinzufügen möchten.

3. Klicken Sie auf die Schaltfläche >> (zwischen den Listen).

Das Symbol wird der Karteikarte nun hinzugefügt. Falls nötig, legt das Programm dazu automatisch eine
neue Sektion am Ende der Karteikarte an.
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Entfernen eines Symbols

Hinweis: Sie können nur selbst hinzugefügte Symbole entfernen. Das Löschen eines der vorgegebenen
Symbole ist nicht möglich. 

Um eines der von Ihnen hinzugefügten Symbole von einer Karteikarte zu entfernen, führen Sie in dem Dia-
log folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die Karteikarte, auf der sich das Symbol befindet.

2. Selektieren Sie in der rechten Liste das zu entfernende Symbol.

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen).

Das Symbol wird nun von der Karteikarte entfernt.

Verschieben eines Symbols

Hinweis: Sie können nur selbst hinzugefügte Symbole verschieben. Das Ändern der Position eines der
vorgegebenen Symbole ist nicht möglich. 

Um ein Symbol in einer Karteikarte zu verschieben, führen Sie in dem Dialog folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die Karteikarte, auf der sich das Symbol befindet.

2. Selektieren Sie in der rechten Liste das zu verschiebende Symbol.

3. Verwenden Sie die Schaltflächen mit dem Pfeil nach oben beziehungsweise unten (links neben der rech-
ten Liste), um das Symbol innerhalb der Karteikarte zu verschieben.

Hinweis: Wenn Sie ein Symbol auf eine andere Karteikarte verschieben möchten, müssen Sie dieses erst
aus seiner bisherigen Karteikarte entfernen und es dann der anderen Karteikarte hinzufügen.

Hinzufügen einer neuen Sektion

Hinweis: Neue Sektionen lassen sich nur hinter den vorgegebenen Sektionen hinzufügen. Das Einfügen
einer selbsterstellten Sektion zwischen den vorgegebenen Sektionen ist nicht möglich.

Um einer Karteikarte eine neue Sektion (einen neuen Abschnitt) hinzuzufügen, führen Sie in dem Dialog
folgende Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Karteikarte.

2. Klicken Sie auf die Schaltfläche Neue Sektion (unterhalb der rechten Liste).

Die neue Sektion wird nun (am Ende der Karteikarte) angelegt.

Umbenennen einer Sektion

Hinweis: Nur selbsterstellte Sektionen lassen sich umbenennen. Das Umbenennen einer der vorgegebe-
nen Sektionen ist nicht möglich. 
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Um eine selbsterstellte Sektion in einer Karteikarte umzubenennen, führen Sie in dem Dialog folgende
Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Karteikarte.

2. Selektieren Sie in der rechten Liste die gewünschte Sektion.

3. Klicken Sie auf die Schaltfläche Umbenennen (unterhalb der rechten Liste).

4. Tippen Sie den neuen Namen ein und bestätigen Sie ihn.

Die Sektion wird nun entsprechend umbenannt.

Entfernen einer Sektion

Hinweis: Nur selbsterstellte Sektionen lassen sich entfernen. Das Löschen einer der vorgegebenen Sek-
tionen ist nicht möglich.

Um eine selbsterstellte Sektion von einer Karteikarte zu entfernen, führen Sie in dem Dialog folgende
Schritte durch:

1. Wählen Sie in der aufklappbaren Liste Anpassen die gewünschte Karteikarte.

2. Selektieren Sie in der rechten Liste die gewünschte Sektion.

3. Klicken Sie auf die Schaltfläche << (zwischen den Listen).

Die Sektion wird nun aus der Karteikarte entfernt.

Zuweisen von Tastenkürzeln

Wenn Sie in dem Dialog die Schaltfläche Tastenkürzel anklicken, erweitert sich der Dialog um eine zusätz-
liche Sektion namens Tastenkürzel, die zum Bearbeiten von Tastenkürzeln verwendet werden kann. 

Kurzfassung: Sie können darin einem beliebigen Befehl ein Tastenkürzel Ihrer Wahl zuweisen: Selektieren
Sie den Befehl dazu in einer der beiden Listen, klicken Sie in das Feld Bitte Tastenkürzel drücken und be-
tätigen Sie dann die Tastenkombination, mit der Sie diesen Befehl künftig aufrufen möchten.

Ausführliche Informationen dazu finden Sie im Abschnitt Tastenkürzel anpassen.

Verwalten der Karteikarten des Ribbons

Das Dialogfenster dieses Befehls verfügt außerdem über Schaltflächen zum Verwalten der Karteikarten des
Ribbons:

¡ Neu 

Legt eine neue, leere Karteikarte an.

¡ Umbenennen 

Benennt die in der Liste Anpassen gewählte Karteikarte um (nur bei selbsterstellten Karteikarten mög-
lich).

¡ Zurücksetzen 

Setzt die in der Liste Anpassen gewählte Karteikarte wieder auf ihren Auslieferungszustand zurück. 
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¡ Löschen 

Löscht die in der Liste Anpassen gewählte Karteikarte (nur bei selbsterstellten Karteikarten möglich).

¡ Alle zurücksetzen (unterhalb der rechten Liste) 

Setzt alle Karteikarten wieder auf den Auslieferungszustand zurück. 

Symbole der Schnellzugriffsleiste anpassen

Nur bei "Ribbons": Dieser Abschnitt betrifft nur Anwender, die in den Einstellungen ausgewählt ha-
ben, dass sie das Programm mit dem Ribbon (Menüband) bedienen möchten. (Informationen zum Anpas-
sen der klassischen Menüs und Symbolleisten finden Sie im Abschnitt Symbolleisten anpassen.)

Unter dem Ribbon wird die Schnellzugriffsleiste angezeigt. Diese bietet eine Auswahl an besonders häufig
benötigten Befehlen.

Das "Ribbon" (Ausschnitt) und die Schnellzugriffsleiste (unten)

Wenn Sie möchten, können Sie die Symbole auf der Schnellzugriffsleiste jederzeit anpassen, also beispiels-
weise Symbole hinzufügen, entfernen, verschieben etc. 

Rufen Sie dazu im Ribbon den Befehl Datei > Anpassen > Schnellzugriffsleiste anpassen auf. Es er-
scheint daraufhin ein Dialog zum Anpassen von Symbolleisten, in dem Sie die gewünschten Änderungen
vornehmen können. 

Die Schnellzugriffsleiste verhält sich dabei exakt wie eine klassische Symbolleiste. Zum Anpassen ihrer
Symbole können Sie also genau so vorgehen, wie es im Abschnitt Symbole einer Symbolleiste anpassen be-
schrieben ist. Alle dort gemachten Erläuterungen treffen auch auf die Schnellzugriffsleiste zu – bis auf den
Abschnitt "Verwalten von Symbolleisten". 

Benutzerdefinierte Symbole erstellen
Sie können jederzeit benutzerdefinierte Symbole anlegen und diese dann einer Symbolleiste oder dem Rib-
bon hinzufügen. Mit solchen Symbolen lassen sich beliebige Programme starten.

Um ein benutzerdefiniertes Symbol anzulegen – zum Beispiel eines zum Starten des Windows-Editors –,
gehen Sie folgendermaßen vor:
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1. Rufen Sie im Menü beziehungsweise im Ribbon den folgenden Befehl auf:

Menü: Weiteres > Anpassen

Ribbon: Datei > Anpassen > Ribbon anpassen

2. Wählen Sie in der aufklappbaren Liste Kategorien den Eintrag Benutzer.

3. Wählen Sie eines der Symbole in der Liste Befehle. 

Die ersten drei Symbole sind (als Beispiele) mit dem Windows-Taschenrechner, der Windows-Zeichen-
tabelle und der Windows-Systemsteuerung vorbelegt. Wählen Sie beispielsweise das vierte Symbol.

4. Klicken Sie auf die Schaltfläche Bearbeiten unter der Liste. Er erscheint daraufhin ein weiteres Dialog-
fenster.

5. Tragen Sie in dem neuen Dialogfenster bei Beschreibung eine kurze Beschreibung für das zu startende
Programm ein – zum Beispiel "Windows-Editor".

6. Bei Befehlszeile geben Sie den vollständigen Pfad und Dateinamen des zu startenden Programms an –
zum Beispiel c:\windows\notepad.exe.

7. Optional: Falls Sie möchten, dass für das Programm ein anderes Symbol als sein Standardsymbol ange-
zeigt werden soll, tragen Sie bei Symboldatei den Pfad und Dateinamen der gewünschten Symboldatei
ein. 

Beachten Sie dabei, dass Symbole in Symbolleisten etwas kleiner sind als die üblichen Windows-Sym-
bole.

Sobald Sie mit OK bestätigen, wird das benutzerdefinierte Symbol angelegt. 

Falls Sie das benutzerdefinierte Symbol nun gleich einer Symbolleiste beziehungsweise dem Ribbon hinzu-
fügen möchten, gehen Sie vor wie in den folgenden Abschnitten beschrieben:

¡ Symbolleisten: Abschnitt Symbole einer Symbolleiste anpassen 

¡ Ribbon: Abschnitt Symbole im Ribbon anpassen 

Tastenkürzel anpassen
Die in einem Programm am häufigsten benötigten Befehle können auch über Tastenkürzel aufgerufen wer-
den. So lässt sich der Befehl zum Speichern des aktuellen Dokuments beispielsweise blitzschnell mit der
Tastenkombination Strg+S ausführen. 

Die vorgegebenen Tastenkürzel lassen sich im Dialogfenster des Menübefehls Weiteres > Anpassen jeder-
zeit anpassen. Sie können beliebigen Befehlen ein Tastenkürzel zuordnen und vorhandene Tastenkürzel än-
dern oder entfernen. 

Gehen Sie dazu folgendermaßen vor:

Tastenkürzel hinzufügen

Um einem Befehl ein Tastenkürzel zuzuweisen, führen Sie folgende Schritte durch:

1. Rufen Sie im Menü beziehungsweise im Ribbon den folgenden Befehl auf:

Menü: Weiteres > Anpassen
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Ribbon: Datei > Anpassen > Ribbon anpassen

2. Klicken Sie auf die Schaltfläche Tastenkürzel. 

Der Dialog erweitert sich nun um eine zusätzliche Sektion namens Tastenkürzel, die zum Bearbeiten
von Tastenkürzeln verwendet werden kann. 

3. Wählen Sie wahlweise in der linken oder rechten Liste den Befehl, dem Sie ein Tastenkürzel zuweisen
möchten. 

Die linke Liste zeigt dabei alle im Programm verfügbaren Befehle an. (Über die Option Kategorien kön-
nen Sie diese Liste nach einer bestimmten Kategorie filtern und über das Feld Schnellsuche eine Suche
durchführen).

Die rechte Liste zeigt nur die Symbole an, die sich in der momentan ausgewählten Symbolleiste bezie-
hungsweise Ribbon-Karteikarte befinden.

4. Nachdem Sie den gewünschten Befehl ausgewählt haben, klicken Sie in das Eingabefeld Bitte Tasten-
kürzel drücken und betätigen die Tastenkombination, die Sie dem Befehl geben möchten.

Tipp: Falls Sie sich dabei vertippen, können Sie das eingegebene Tastenkürzel mit der RücktasteÕ wie-
der löschen.

5. Nicht vergessen: Klicken Sie auf Hinzufügen, um dem Befehl dieses Tastenkürzel jetzt zuzuweisen. 

6. Verlassen Sie den Dialog mit Schließen.

Der gewählte Befehl kann von nun an mit der angegebenen Tastenkombination aufgerufen werden.

Tastenkürzel bearbeiten (entfernen, ändern etc.)

Sie können außerdem die vorhandenen Tastenkürzel für Befehle jederzeit bearbeiten, also Kürzel beispiels-
weise löschen oder ändern. Gehen Sie wie folgt vor:

1. Rufen Sie den folgenden Befehl im Menü oder im Ribbon auf:

Menü: Weiteres > Anpassen

Ribbon: Datei > Anpassen > Ribbon anpassen

2. Klicken Sie auf die Schaltfläche Tastenkürzel. 

Der Dialog erweitert sich nun um eine zusätzliche Sektion namens Tastenkürzel, die zum Bearbeiten
von Tastenkürzeln verwendet werden kann. 

3. Wählen Sie wahlweise in der linken oder rechten Liste den Befehl, dessen Tastenkürzel Sie bearbeiten
möchten. 

4. Führen Sie in der Sektion Tastenkürzel eine der folgenden Aktionen durch:

Tastenkürzel entfernen: Die Liste Aktuelle Tastenkürzel zeigt alle Tastenkürzel an, die dem ausgewähl-
ten Befehl derzeit zugewiesen sind. Um ein Kürzel zu entfernen, selektieren Sie es in dieser Liste und
klicken auf Entfernen.

Tastenkürzel ändern: Um das Tastenkürzel für einen Befehl abzuändern, entfernen Sie dieses erst (wie ge-
rade beschrieben) und weisen ihm dann ein neues Kürzel zu (wie am Anfang dieses Abschnitts beschrie-
ben).

Tastenkürzel zurücksetzen: Um alle Tastenkürzel für das komplette Programm auf die Vorgaben zurück-
zusetzen, klicken Sie auf die Schaltfläche Alle Tastenkürzel zurücksetzen und bestätigen die Sicher-
heitsabfrage. Sämtliche Änderungen, die Sie an Tastenkürzeln vorgenommen haben, werden dann ver-
worfen. 
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Liste aller Tastenkürzel ansehen: Wenn Sie die Schaltfläche Exportieren anklicken, erscheint eine Tabel-
le mit allen momentan zugewiesenen Tastenkürzeln. Mit den Schaltflächen neben der Tabelle können
Sie diese unter anderem in die Zwischenablage kopieren.

5. Verlassen Sie den Dialog mit Schließen.

Verfügbare Tastenkürzel

Beachten Sie, dass nicht alle Tastenkombinationen, die Sie auf Ihrer Tastatur erzeugen können, auch für
Tastenkürzel erlaubt sind.

In der Regel sollten Sie für Tastenkürzel Buchstabentasten, Zahlentasten oder Funktionstasten verwen-
den und diese mit den Tasten Strg, Alt und/oder der Umschalttasteñ kombinieren.

Sie können ganz einfach überprüfen, ob die von Ihnen gewünschte Tastenkombination zulässig ist: Betäti-
gen Sie diese Tastenkombination im Feld Bitte Tastenkürzel drücken des oben beschrieben Dialogs.
Wenn sie nicht erscheint, ist sie nicht zulässig. 

Einige Beispiele für gültige Tastenkürzel:

¡ Strg+A 

¡ Alt+A (Tastenkombinationen mit der Alt-Taste sind allerdings nicht zu empfehlen – Alt+A ist beispiels-
weise für den Aufruf des Menüs Ansicht zuständig!)

¡ Strg+Alt+A

¡ Strg+Umschalt+A

¡ Strg+Alt+Umschalt+A

¡ Strg+F2

¡ etc.

Hinweis: Buchstaben allein sind natürlich nicht zulässig. Sie können also nicht A oder Umschalt+A als
Tastenkürzel verwenden.

Tastenkürzel bereits belegt: Wenn Sie ein Tastenkürzel drücken, das bereits vergeben ist, wird unter dem
Eingabefeld angezeigt, womit dieses Kürzel momentan belegt ist. Sie sollten dann die RücktasteÕ betäti-
gen, um das Tastenkürzel wieder zu löschen und ein anderes Tastenkürzel nehmen. Andernfalls überschrei-
ben Sie die bisherige Zuordnung dieses Kürzels.

Zweiteilige Tastenkürzel: Sie können auch zweiteilige Tastenkürzel verwenden (entsprechend dem WordStar-
Standard) – zum Beispiel Strg+K+X. Hierbei sind allerdings nur Tastenkürzel nach dem Schema "Strg +
Buchstabe + Buchstabe" zulässig.

Listen für das automatische Füllen editieren
Wie im Abschnitt Automatisches Füllen von Zellen beschrieben, können Sie mit dem Menübefehl Bearbei-
ten > Ausfüllen einen Zellbereich mit einem gleichbleibenden Wert oder einer Sequenz von Werten füllen.

Mit dem Menübefehl Weiteres > Listen editieren können Sie eigene Listen für diese Funktion erstellen
und bearbeiten.
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Erzeugen Sie beispielsweise eine Liste mit dem Inhalt "Rot", "Grün" und "Blau" und füllen dann, ausge-
hend von einer Zelle mit dem Inhalt "Rot", weitere Zellen, so werden diese mit Grün, Blau, Rot, Grün, Blau
etc. gefüllt.

Das Dialogfenster des Menübefehl Weiteres > Listen editieren verfügt dazu über Schaltflächen mit folgen-
den Funktionen:

¡ Schaltfläche "Neu": Neue Liste erstellen 

¡ Schaltfläche "Bearbeiten": Liste bearbeiten

¡ Schaltfläche "Löschen": Liste löschen

¡ Schaltfläche "Importieren": Aus den derzeit markierten Zellen eine Liste erzeugen

Ausführliche Informationen dazu finden Sie auf den nächsten Seiten.

Liste für das automatische Füllen erstellen

Um eine neue Liste für die Funktion Ausfüllen zu erstellen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Listen editieren auf.

2. Betätigen Sie die Schaltfläche Neu.

3. Es erscheint ein Dialogfenster. Geben Sie darin die gewünschten Listeneinträge ein. Beachten Sie dabei,
dass in jeder Zeile nur ein Eintrag stehen darf. Sie können jederzeit die Eingabetaste ¿ betätigen, um ei-
ne neue Zeile einzufügen. 

4. Klicken Sie dann auf OK.

Die neue Liste wurde nun angelegt.

Liste für das automatische Füllen bearbeiten

Um eine von Ihnen erstellte Liste für die Funktion Ausfüllen zu bearbeiten, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Listen editieren auf.

2. Selektieren Sie die zu bearbeitende Liste per Mausklick.

Hinweis: Die vorgegebenen Beispiellisten können nicht bearbeitet werden.

3. Betätigen Sie die Schaltfläche Bearbeiten.

4. Es erscheint ein Dialogfenster mit den Listeneinträgen. Bearbeiten Sie diese nach Wunsch. Beachten Sie
dabei, dass in jeder Zeile nur ein Eintrag stehen darf. Sie können jederzeit die Eingabetaste ¿ betätigen,
um eine neue Zeile einzufügen. 

5. Klicken Sie dann auf OK.

Die Liste wurde nun entsprechend geändert.
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Liste für das automatische Füllen löschen

Um eine von Ihnen erstellte Liste für die Funktion Ausfüllen zu löschen, gehen Sie wie folgt vor:

1. Rufen Sie den Menübefehl Weiteres > Listen editieren auf.

2. Selektieren Sie die zu bearbeitende Liste per Mausklick.

Hinweis: Die vorgegebenen Beispiellisten können nicht gelöscht werden.

3. Betätigen Sie die Schaltfläche Löschen.

Die Liste wurde nun entfernt.

Liste für das automatische Füllen importieren

Wenn ein PlanMaker-Dokument eine Reihe von Zellen hat, die Sie gerne als Liste zum automatischen Fül-
len speichern möchten, gehen Sie vor folgt vor:

1. Markieren Sie die Zellen, aus denen eine Liste erstellt werden soll.

2. Rufen Sie den Menübefehl Weiteres > Listen editieren auf.

3. Betätigen Sie die Schaltfläche Importieren.

PlanMaker liest die markierten Zellen nun aus und erstellt eine neue Liste aus deren Inhalten. Jede markier-
te Zelle wird dabei ein Listeneintrag.

Wenn Sie dabei mehrere Zeilen und Spalten markiert haben, legt PlanMaker entsprechend auch mehrere
Listen an. Zuvor erscheint eine Rückfrage, ob Sie die Daten zeilenweise oder spaltenweise importieren
möchten. Wählen Sie Zeilenweise, wenn jede Zeile zu einer Liste werden soll, beziehungsweise Spalten-
weise, wenn jede Spalte zu einer Liste werden soll.

Installieren zusätzlicher Wörterbücher
Sie können bei Bedarf weitere Wörterbücher für die Rechtschreibprüfung installieren. Wie das geht, ist in
den nachfolgenden Abschnitten beschrieben:

¡ Installieren zusätzlicher SoftMaker-Wörterbücher 

In diesem Abschnitt erfahren Sie, wie Sie momentan nicht installierte SoftMaker-Wörterbücher nachin-
stallieren.

Hinweis: Dies ist nur für die Android-Version relevant, denn bei SoftMaker Office für Windows, Mac
und Linux werden stets alle SoftMaker-Wörterbücher installiert.
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¡ Installieren von Hunspell-Wörterbüchern 

Neben den SoftMaker-Wörterbüchern lassen sich in SoftMaker Office auch freie Hunspell-Wörterbücher
verwenden. Lesen Sie dazu diesen Abschnitt.

¡ Wählen eines anderen Wörterbuchs für eine Sprache 

Wenn Sie für eine Sprache mehrere Wörterbücher installiert haben (z.B. eines von SoftMaker und eines
von Hunspell), können Sie außerdem festlegen, welches dieser Wörterbücher verwendet werden soll.
Dieser Abschnitt verrät, wie Sie dazu vorgehen.

Alle Details zu diesen Themen finden Sie auf nächsten Seiten.

Installieren zusätzlicher SoftMaker-Wörterbücher

SoftMaker Office wird mit hochwertigen Wörterbüchern für zahlreiche Sprachen ausgeliefert. In diesem
Abschnitt erfahren Sie, wie Sie Wörterbücher, die momentan nicht installiert sind, nachinstallieren können:

Windows, Mac und Linux

Bei der Installation von SoftMaker Office für Windows, Mac oder Linux werden stets alle SoftMaker-
Wörterbücher installiert – hier ist ein Nachinstallieren also nicht nötig.

Android

Anders sieht es bei SoftMaker Office für Android aus: Hier können Sie SoftMaker-Wörterbücher, die mo-
mentan nicht installiert sind, jederzeit kostenlos von unserem Server herunterladen und automatisch instal-
lieren lassen. 

Gehen Sie dazu wie folgt vor:

1. Starten Sie eine der Apps (TextMaker, PlanMaker oder Presentations) auf Ihrem Android-Gerät.

2. Rufen Sie darin den Menübefehl Weiteres > Einstellungen auf und wechseln Sie auf die Karteikarte
Sprache.

3. Tippen Sie auf die Schaltfläche Wörterbücher hinzufügen.

4. Es erscheint ein Dialog mit einer Liste aller verfügbaren Sprachen. Um eine Sprache herunterzuladen,
tippen Sie auf das Download-Symbol rechts von ihr.

Sobald der Download abgeschlossen ist, wird das Wörterbuch automatisch installiert und steht fortan in al-
len Applikationen von SoftMaker Office zur Verfügung.

Installieren von Hunspell-Wörterbüchern

Neben den SoftMaker-Wörterbüchern lassen sich in SoftMaker Office auch Hunspell-Wörterbücher ver-
wenden. Diese wurden größtenteils von engagierten Anwendern und nicht-kommerziellen Einrichtungen er-
stellt und dann kostenlos zur Verfügung gestellt. 
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Hunspell-Wörterbücher gibt es für sehr viele Sprachen. Falls Sie also für eine Sprache kein Wörterbuch in
SoftMaker Office finden, lohnt es sich nachzusehen, ob ein Hunspell-Wörterbuch dafür existiert.

Eine Liste aller für SoftMaker Office verfügbaren Hunspell-Wörterbücher finden Sie im Bereich "Down-
loads" auf unserer Website www.softmaker.de. Dort können Sie die Wörterbücher auch kostenlos herunter-
laden.

Um ein Hunspell-Wörterbuch herunterzuladen und zu installieren, gehen Sie folgendermaßen vor:

1. Gehen Sie mit Ihrem Webbrowser auf unsere Website www.softmaker.de

2. Wählen Sie im Menü der Webseite "Downloads" aus, und klicken Sie dann auf "Wörterbücher".

3. Ihr Browser zeigt nun eine Seite mit einer Liste aller von SoftMaker Office unterstützten Hunspell-Wör-
terbücher an. Laden Sie das gewünschte Wörterbuch herunter.

4. Starten Sie eines der Programme von SoftMaker Office (TextMaker, PlanMaker oder Presentations).

5. Rufen Sie darin den Menübefehl Weiteres > Einstellungen auf und wechseln Sie auf die Karteikarte
Sprache.

6. Klicken Sie auf die Schaltfläche Hunspell-Wörterbücher.

7. Es erscheint ein Dialog mit einer Liste aller installierten Sprachen/Wörterbücher. Klicken Sie darin auf
die Schaltfläche Hunspell-Wörterbuch hinzufügen.

8. Es erscheint ein Dateidialog. Wechseln Sie darin in den Ordner, in den das heruntergeladene Wörterbuch
gespeichert wurde. 

9. Wählen Sie die Wörterbuchdatei in der Dateiliste aus und klicken Sie auf Öffnen.

Das Wörterbuch wird nun installiert und steht fortan in allen Applikationen von SoftMaker Office zur Ver-
fügung.

Wählen eines anderen Wörterbuchs für eine Sprache

Wenn Sie für eine Sprache mehrere Wörterbücher installiert haben (zum Beispiel ein SoftMaker-Wörter-
buch und ein Hunspell-Wörterbuch), können Sie jederzeit wählen, welches dieser Wörterbücher für die
Sprache verwendet werden soll. Gehen Sie dazu wie folgt vor: 

1. Rufen Sie den Menübefehl Weiteres > Einstellungen auf und wechseln Sie auf die Karteikarte Spra-
che.

2. Klicken Sie auf die Schaltfläche Hunspell-Wörterbücher.

3. Es erscheint ein Dialog mit einer Liste aller installierten Sprachen/Wörterbücher. Wählen Sie zuerst in
dieser Liste die gewünschte Sprache aus.

4. Wählen Sie dann in der aufklappbaren Liste Wörterbuch aus, welches Wörterbuch für die selektierte
Sprache verwendet werden soll. Die Liste kann, je nachdem welche Wörterbücher installiert sind, fol-
gende Einträge haben:

SoftMaker: Das bei SoftMaker Office mitgelieferte Wörterbuch.

Hunspell: Ein Hunspell-Wörterbuch (kostenlos herunterladbares, freies Wörterbuch, siehe vorheriger
Abschnitt)

5. Bestätigen Sie mit OK.

http://www.softmaker.de/
http://www.softmaker.de/
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Die Rechtschreibprüfung wird von nun an für diese Sprache das gewählte Wörterbuch verwenden.
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Formeln und Funktionen
Dieses Kapitel widmet sich dem wohl wichtigsten Thema bei einer Tabellenkalkulation: dem Arbeiten mit
Rechenformeln.

Das Kapitel besteht aus folgenden Abschnitten:

¡ Grundlegendes zu Berechnungen 

Im ersten Abschnitt erfahren Sie, wie Formeln aufgebaut sein müssen und welche Rechenoperatoren dar-
in verwendet werden können.

¡ Berechnungen eingeben 

Hier erfahren Sie, wie Sie Rechenformeln in eine Zelle eingeben und welche Hilfsmittel dafür zur Verfü-
gung stehen.

¡ Relative und absolute Zellbezüge 

Dieser Abschnitt erläutert den Unterschied zwischen relativen Zellbezügen (z.B. =A1) und absoluten
Zellbezügen (z.B. =$A$1) in Rechenformeln.

¡ Externe Zellbezüge 

Im nächsten Abschnitt geht es um externe Zellbezüge in Rechenformeln. Das sind Bezüge, die sich auf
Zellen in anderen Arbeitsmappen beziehen.

¡ Fehlerwerte 

Liefert eine Berechnung einen Fehler, ist das Ergebnis dieser Formel ein sogenannter Fehlerwert. Dieser
Abschnitt beschreibt alle Fehlerwerte.

¡ Arbeiten mit Matrizen 

Hier erfahren Sie, wie Sie Matrizen und Matrixfunktionen einsetzen.

¡ Anmerkungen zu den Datenbankfunktionen 

Hier erfahren Sie Wissenswertes zum Umgang mit Datenbankfunktion wie dbAnzahl, dbSumme etc.

¡ Funktionen von A-Z 

Der größte Teil dieses Kapitels besteht aus einer alphabetisch sortierten Liste aller verfügbaren Rechen-
funktionen mit einer ausführlichen Beschreibung, wie man die einzelnen Funktionen anwendet.

Tipp für Einsteiger: Eine kleine Einführung zum Durchführen von Berechnungen finden Sie auch im Kapi-
tel Die PlanMaker-Tour.

Grundlegendes zu Berechnungen
Wenn Sie in PlanMaker eine Berechnung durchführen möchten, setzen Sie zunächst den Zellrahmen auf die
Zelle, in der das Ergebnis erscheinen soll. Dann tippen Sie die gewünschte Berechnung in diese Zelle ein.
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Wichtig: Beim Eintippen einer Formel müssen Sie stets mit einem Gleichheitszeichen = beginnen, denn
sonst wird Ihre Eingabe von PlanMaker als Text beziehungsweise Zahlenwert betrachtet. 

Rechenformeln können bestehen aus:

¡ Festen Werten (zum Beispiel einer Zahl oder Text) 
¡ Zellbezüge (zum Beispiel A1 oder D2:D3)
¡ Matrizen (siehe auch Abschnitt Arbeiten mit Matrizen)
¡ Rechenoperatoren (zum Beispiel + und -, siehe auch Abschnitt Operatoren in Berechnungen)
¡ Rechenfunktionen (zum Beispiel SUMME)

Das Ergebnis einer Berechnung kann sowohl einen Endwert als auch ein Zwischenergebnis darstellen, denn
jede Zelle, die das Ergebnis einer Berechnung enthält, kann in einer anderen Zelle wieder verwendet wer-
den.

Eine gültige Rechenformel kann also beispielsweise folgendermaßen aussehen:

= 67 + (A3 * Summe(B1:C5))

Operatoren in Berechnungen

Sie können in Berechnungen die nachfolgend aufgelisteten Rechenoperatoren verwenden.

Beachten Sie bei Berechnungen mit mehreren verschiedenen Operatoren, dass es eine Rangfolge für Opera-
toren gibt: Teilberechnungen mit einem Operator höheren Rangs werden vor Teilberechnungen mit einem
Operator niedrigeren Rangs durchgeführt. 

Diese Rangfolge kann durch die Verwendung von Klammern außer Kraft gesetzt werden: 

1+2*2 ergibt beispielsweise 5, da die Multiplikation einen höheren Rang hat als die Addition und deshalb
zuerst berechnet wird. (1+2)*2 ergibt hingegen 6, da die Klammern diese Rangfolge außer Kraft setzen.

Es gilt folgende Rangfolge bei den Operatoren (höchste zuerst):

1. Rang: Leertaste Schnittbereich (siehe auch Funktion SCHNITTBEREICH)

2. Rang: % Prozent

3. Rang: + Positives Vorzeichen (nicht Addition!)

– Negatives Vorzeichen* (nicht Subtraktion!)

4. Rang: ^ Potenzierung*

5. Rang: * Multiplikation

/ Division

6. Rang: + Addition

– Subtraktion

7. Rang: & Verkettung von Zeichenketten ("Plan" & "Maker" ergibt beispielsweise "PlanMa-
ker")

8. Rang: = Gleich

<> Ungleich
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< Kleiner

> Größer

<= Kleiner oder gleich

>= Größer oder gleich

* Hinweis: Um die Kompatibilität mit Microsoft Excel zu gewährleisten, ist die Rangfolge der Operatoren Potenzierung (^) und Negatives Vorzei-
chen (-) vertauscht, aber mathematisch nicht korrekt. Die richtige mathematische Reihenfolge (erst Potenz, dann Vorzeichen) würde beispielswei-
se für die Formel -2^2 zum mathematisch korrekten Ergebnis -4 führen. Das tatsächliche Ergebnis in PlanMaker (und in Excel) ist aber 4.

Berechnungen eingeben
Es gibt mehrere Möglichkeiten, eine Rechenformel in eine Zelle einzugeben. Diese lassen sich nach Belie-
ben kombinieren.

Eingeben von Rechenformeln per Hand

Sie können Rechenformeln einfach von Hand in die gewünschte Tabellenzelle eintragen.

Wichtig: Wenn Sie Formeln direkt in eine Tabellenzelle eingeben, müssen Sie zuerst immer das Gleich-
heitszeichen = eintippen, damit PlanMaker weiß, dass nun kein Text, sondern eine Formel folgt.

Wenn Sie die Formel eingegeben haben, betätigen Sie die Eingabetaste ¿, um Ihre Eingabe zu bestätigen –
oder Esc, um sie zu verwerfen.

Alternativ können Sie Eingaben auch über die folgenden Schaltflächen der Bearbeitungsleiste abschließen:

¡ Klicken Sie auf , um die Eingabe zu übernehmen. 

¡ Oder klicken Sie auf , um die Eingabe zu verwerfen.

Um die Formel in einer Zelle nachträglich zu bearbeiten, steuern Sie die Zelle an und betätigen die Taste
F2. Alternativ können Sie auch einen Doppelklick auf die Zelle ausführen, um die Formel zu bearbeiten.

Verwenden der Maus beim Eingeben von Formeln

Sie können beim Eingeben von Rechenformeln die Maus verwenden, um Zellbereiche oder einzelne Zellen
in die Formel zu übernehmen. Ziehen Sie dazu einfach ein Rechteck in der Tabelle auf beziehungsweise kli-
cken Sie die gewünschte Zelle an.

Ein Beispiel:

Sie möchten in eine Zelle die Formel =SUMME(B2:D4) eingeben. Dazu können Sie wie folgt vorgehen:

1. Geben Sie =SUMME( ein.

2. Selektieren Sie die Zellen B2 bis D4 mit der Maus. Ziehen Sie dazu bei gedrückter linker Maustaste ein
Rechteck auf, das in Zelle B2 beginnt und in Zelle D4 endet.

3. In der Zelle erscheint nun automatisch der Bereich B2:D4, so dass die Formel lautet: =SUMME(B2:D4

4. Geben Sie die schließende Klammer ein und betätigen Sie die Eingabetaste ¿.



411Formeln und Funktionen

Die vollständige Formel =SUMME(B2:D4) ist nun in die Zelle eingetragen.

Der Befehl Einfügen > Funktion

Wenn Sie in einer Formel Rechenfunktionen verwenden möchten, können Sie diese einfach eintippen oder
aber den Menübefehl Einfügen > Funktion verwenden. Dieser erlaubt es Ihnen, Rechenfunktionen komfor-
tabel per Maus auszuwählen.

Das Dialogfenster für diesen Befehl hat folgende Bestandteile:

¡ Eingabefeld Berechnung 

Hier können Sie die Formel, die in die Zelle eingetragen wird, editieren.

¡ Kategorie 

In dieser Liste können Sie wählen, welche Arten von Rechenfunktionen in der Liste Funktion angezeigt
werden sollen.

In der Kategorie Benannte Bereiche am Ende der Liste können Sie auf Ihre benannten Zellbereiche zu-
greifen, um sie in Formeln einzusetzen (siehe Abschnitt Namen in der Praxis einsetzen).

¡ Funktion 

In dieser Liste werden alle Funktionen der gewählten Kategorie angezeigt. Führen Sie einen Doppelklick
auf eine Funktion durch, um sie in das Eingabefeld Berechnung zu übertragen.

Tipp: Wenn Sie eine Funktion selektieren, wird im unteren Teil des Dialogs automatisch eine Kurzbe-
schreibung dazu eingeblendet. Bei der Windows-Version von PlanMaker können Sie außerdem eine
Hilfeseite zu jeder Rechenfunktion abrufen, indem Sie die Funktion antippen und dann die Taste F1
drücken.
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¡ Operator 

Hier werden die wichtigsten Rechenoperatoren angezeigt. Klicken Sie einen Operator an, wird er in das
Eingabefeld eingefügt.

¡ Schaltfläche Einfügen 

Fügt den Inhalt des Eingabefelds Berechnung in die Zelle ein und schließt den Dialog.

¡ Schaltfläche Schließen 

Schließt den Dialog, ohne die Berechnung einzufügen.

Relative und absolute Zellbezüge
Wenn Sie sich in einer Rechenformel auf andere Zellen beziehen möchten, können Sie diesen Zellbezug
entweder als relativ (z.B. =A1) oder als absolut (z.B. =$A$1) eintragen.

Dieser Abschnitt erläutert die Unterschiede zwischen diesen beiden Adressierungsarten:

Relative Zellbezüge

Wenn Sie in einer Formel die Adresse einer anderen Zelle eintippen, wird dieser Zellbezug von PlanMaker
stets als relativer Zellbezug interpretiert.

Ein Beispiel: Sie geben in Zelle B3 folgende Formel ein:

=B1+B2

Dies interpretiert PlanMaker nicht als "Addiere B1 und B2", sondern vielmehr als "Addiere die Werte in
den beiden Zellen, die direkt über der Zelle B3 liegen". 

Sie merken dies, wenn Sie die Zelle B3 nach C3 kopieren oder verschieben. PlanMaker passt die Formel
dann nämlich sofort an:

=C1+C2

Absolute Zellbezüge

Wenn Sie verhindern möchten, dass die Formel automatisch angepasst wird, müssen Sie den Zellbezug als
absolut eintippen, indem Sie vor die Spalten- und/oder Zeilenadresse ein Dollarzeichen ($) setzen. Wahl-
weise können ganze Zelladressen (zum Beispiel $B$1) oder nur ein Teil davon (zum Beispiel $B1 oder
B$1) als absolut klassifiziert werden.

Ein absoluter Zellbezug bezieht sich immer auf die ursprüngliche Zelladresse, ganz egal, wohin Sie die Zel-
le mit der Formel später verschieben.

Beispiel: =$B$1 + $B$2

Tragen Sie diese Formel in die Zelle B3 ein und verschieben diese Zelle nach C3, bezieht sich PlanMaker
danach immer noch auf die Zellen B1 und B2.
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Tipp: Verwenden der F4-Taste zum Ändern der Adressierung

Wenn Sie einen Zellbezug in eine Formel eingeben, können Sie anschließend mit der Taste F4 zwischen re-
lativer und absoluter Adressierung umschalten. 

Tippen Sie also beispielsweise in eine Zelle =A4 ein, ändert PlanMaker dies auf:

=$A4, wenn Sie einmal F4 drücken,

=A$4, wenn Sie noch einmal F4 drücken,

=$A$4, wenn Sie noch einmal F4 drücken.

... und wieder =A4, wenn Sie noch einmal F4 drücken.

Externe Zellbezüge
Sie können sich in Rechenformeln auch auf Zellen beziehen, die sich in anderen PlanMaker- oder Excel-
Dokumenten befinden. Solche Zellbezüge nennt man externe Zellbezüge.

In diesem Abschnitt erfahren Sie alles Wissenswerte dazu. Folgende Themen werden darin behandelt:

¡ Eingeben von externen Zellbezügen 

¡ Aktualisieren und Verwalten von externen Zellbezügen

Lesen Sie dazu die nächsten Seiten.

Eingeben von externen Zellbezügen

Zellbezüge, die sich auf Zellen in einem anderen Dokument beziehen, müssen wie folgt in Rechenformeln
eingegeben werden:

='C:\Mein Verzeichnis\[Meine Arbeitsmappe.pmdx]Tabelle1'!A1

Dieses Beispiel liefert einen Bezug auf die Zelle A1 im Arbeitsblatt "Tabelle1" im PlanMaker-Dokument
"Meine Arbeitsmappe.pmdx" im Verzeichnis "C:\Mein Verzeichnis".

Wie Sie sehen, bestehen externe Zellbezüge immer aus folgenden Komponenten:

¡ Anführungszeichen 

Externe Zellbezüge sollten stets mit einem Anführungszeichen beginnen. Sie können wahlweise einfache
Anführungszeichen (') oder doppelte Anführungszeichen (") verwenden.

¡ Ordner 

Als nächstes ist der vollständige Pfad zu dem Ordner anzugeben, in dem sich die externe Datei befindet
– zum Beispiel: C:\Mein Verzeichnis\

Tipp: Falls sich die externe Datei im gleichen Verzeichnis wie Ihr Dokument befindet, kann der Pfad
auch weggelassen werden.
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¡ Dateiname in eckigen Klammern 

Dahinter kommt der Dateiname, umgeben von eckigen Klammern. Es muss sich bei der Datei um ein
PlanMaker- oder ein Exceldokument handeln.

¡ Name des Arbeitsblatts 

Die nächste Komponente ist der Name des Arbeitsblatts, in dem sich die gewünschte Zelle befindet.

¡ Anführungszeichen 

Dahinter ist ein weiteres Anführungszeichen zu schreiben.

¡ Ausrufezeichen 

Als nächstes muss ein Ausrufezeichen getippt werden.

¡ Zellbezug 

Die letzte Komponente ist die Adresse der Zelle(n), auf die Sie sich beziehen möchten. Es sind natürlich
auch Zellbereiche zulässig.

Schließen Sie Ihre Eingabe mit der Eingabetaste ¿ ab. PlanMaker liest daraufhin den Inhalt der Zelle aus
der angegebenen Datei aus.

Informationen zum Aktualisieren und Verwalten externer Zellbezüge finden Sie im Anschluss.

Anmerkungen

¡ Wenn PlanMaker die angegebene Datei nicht findet, erscheint nach dem Betätigen der Eingabetaste au-
tomatisch ein Dialog, in dem Sie die Datei auswählen können. 

Tipp: Wenn Sie den Pfad und Dateinamen nicht von Hand eintippen möchten, können Sie folgenden
Trick anwenden: Tippen Sie als Pfad und Dateinamen einfach nur [x.pmdx] ein – also beispielsweise
[x.pmdx]Tabelle1!A1. So können Sie das Erscheinen des Dateidialogs nach dem Drücken der Eingabe-
taste absichtlich auslösen und die Datei bequem aus dem Dialog auswählen.

¡ Wenn PlanMaker das angegebene Arbeitsblatt nicht findet, erscheint nach dem Betätigen der Eingabe-
taste automatisch ein Dialog, in dem Sie das Arbeitsblatt auswählen können. 

¡ Der Pfad auf die externe Datei wird normalerweise absolut gespeichert. Falls sich das externe Dokument
allerdings im gleichen Ordner befindet wie Ihre Arbeitsmappe (oder einem Unterordner davon), spei-
chert PlanMaker nur den relativen Pfad. 

In der Praxis bedeutet das: Wenn sich Dokument und externe Datei im gleichen Ordner befinden und Sie
beide gemeinsam in einen anderen Ordner verschieben, funktionieren Bezüge auf diese externe Datei
auch weiterhin.

¡ Tipp: Wenn Sie sich die komplette Tipparbeit sparen möchten, können Sie einen externen Zellbezug
auch auf folgende Art einfügen: 

1. Öffnen Sie das Dokument mit der Zelle, auf die Sie sich beziehen möchten.

2. Kopieren Sie darin die gewünschte Zelle in die Zwischenablage.

3. Wechseln Sie zurück zum aktuellen Dokument.

4. Navigieren Sie zu der Zelle, in die der Bezug eingefügt werden soll.

5. Rufen Sie den Menübefehl Bearbeiten > Inhalte einfügen auf.

6. Klicken Sie auf die Schaltfläche Bezüge einfügen.
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PlanMaker fügt nun einen externen Zellbezug auf diese Zelle ein.

Aktualisieren und Verwalten von externen Zellbezügen

Mit dem Menübefehl Arbeitsblatt > Externe Bezüge können Sie die externen Bezüge in einem Dokument
aktualisieren und verwalten.

Der Befehl öffnet ein Dialogfenster, in dem alle Dateien aufgelistet sind, zu denen es externe Bezüge gibt.

Mit Hilfe der Schaltflächen in diesem Dialog können Sie folgende Aktionen durchführen:

¡ Aktualisieren 

Aktualisiert nur diejenigen externen Bezüge, die sich auf die Datei beziehen, die momentan in der Liste
selektiert ist. 

(Siehe auch Hinweise zum Aktualisieren weiter unten.)

¡ Alles aktualisieren 

Aktualisiert alle externen Bezüge im gesamten Dokument.

Tipp: Das Kommando Alles aktualisieren können Sie alternativ auch über den Menübefehl Weiteres
> Externe Bezüge aktualisieren auslösen.

¡ Öffnen 

Öffnet die in der Liste selektierte externe Datei.

¡ Ändern 

Lässt Sie für die in der Liste selektierte externe Datei eine andere Datei auswählen. Alle Bezüge auf die-
se Datei werden daraufhin im Dokument entsprechend angepasst.

¡ Vorherige 

Springt zur vorherigen Zelle, die einen Bezug auf die in der Liste selektierte Datei enthält.

¡ Nächste 

Springt zur nächsten Zelle, die einen Bezug auf die in der Liste selektierte Datei enthält.

Die Schaltfläche Schließen beendet den Dialog.

Hinweise zum Aktualisieren von externen Zellbezügen

Wichtig: Die Werte, die von externen Zellbezügen zurückgeliefert werden, werden nicht bei jedem Neu-
berechnen der Arbeitsmappe automatisch aktualisiert. 

Externe Zellbezüge werden nur in folgenden Fällen aktualisiert:

¡ Wenn Sie ein Dokument öffnen, werden alle darin enthaltenen externen Bezüge (einmalig) automatisch
aktualisiert.  

Dieses automatische Update können Sie auf Wunsch abschalten – siehe Optionen weiter unten.
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¡ Danach können Sie die externen Bezüge jederzeit manuell aktualisieren: 

Rufen Sie dazu den Menübefehl Arbeitsblatt > Externe Bezüge auf und verwenden in dem Dialog, wie
oben beschrieben, die Schaltfläche Aktualisieren oder Alles aktualisieren. 

Alternativ können Sie auch den Menübefehl Weiteres > Externe Bezüge aktualisieren verwenden, der
das Gleiche macht wie die Schaltfläche Alles aktualisieren.

Optionen zum Aktualisieren von externen Zellbezügen

Für das Aktualisieren von externen Zellbezügen gibt es nachfolgende Optionen in den Dokumenteigen-
schaften. 

Um diese zu ändern, rufen Sie den Menübefehl Datei > Eigenschaften auf und wechseln auf die Karteikar-
te Berechnen. In der Rubrik Externe Bezüge finden Sie dort folgende Optionen:

¡ Daten nach dem Öffnen aktualisieren 

Hier können Sie festlegen, ob beim Öffnen eines Dokuments alle darin enthaltenen externen Bezüge
(einmalig) aktualisiert werden sollen:

Immer: Beim Öffnen externe Bezüge automatisch aktualisieren

Niemals: Beim Öffnen externe Bezüge nicht aktualisieren

Nachfragen: Beim Öffnen den Anwender fragen, ob die externen Bezüge aktualisiert werden sollen.

¡ Externe Daten im Dokument speichern 

Ist diese Option aktiviert, speichert PlanMaker eine Kopie aller Werte, die von externen Zellbezügen ge-
liefert werden, im Dokument. Fehlt die Datei für einen externen Bezug beim Aktualisieren, wird auch
weiterhin der Wert angezeigt, den sich PlanMaker zuletzt gemerkt hat.

Schalten Sie die Option aus, wird stattdessen ein Fehlerwert angezeigt, wenn Sie einen externen Bezug
aktualisieren und auf die zugehörige Datei nicht zugegriffen werden kann.

Hinweis: Die obigen Optionen sind keine globalen Einstellungen, sondern Dokumenteigenschaften. Sie
lassen sich also für jedes Dokument unterschiedlich einstellen.

Fehlerwerte
Tritt in einer Berechnung ein Fehler auf, liefert sie als Ergebnis einen sogenannten Fehlerwert. 

Ein Beispiel: In einer Zelle ist eine Division durch den Inhalt einer anderen Zelle durchzuführen. Diese an-
dere Zelle nimmt nun den Wert 0 an. PlanMaker kann diese Division durch Null, die ja in der Mathematik
nicht zulässig ist, nicht durchführen. Das Ergebnis der Rechenformel ist deshalb der Fehlerwert #DIV/0!,
der anzeigt, dass hier eine Division durch Null stattfindet.

Es gibt folgende Fehlerwerte:

Fehlerwert Erläuterung

#BEZUG! Ungültiger Zellbezug. Erscheint, wenn die Formel einen Zellbezug enthält, der ungültig ist oder
nach dem Löschen von Zellen (z.B. mit dem Menübefehl Arbeitsblatt > Zellen löschen) nicht
mehr existiert.
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#DIV/0! Division durch Null. Erscheint, wenn die Formel eine Division durch Null enthält, die in der Ma-
thematik ja bekanntermaßen nicht zulässig ist.

#FEHLER! Ungültige Rechenformel. Erscheint unter anderem bei falsch geschriebenen oder unbekannten
Funktionsnamen, wenn geöffnete Klammern nicht geschlossen werden oder wenn eine Funktion
mit zu vielen oder zu wenigen Argumenten aufgerufen wird.

#NAME? Bezug mit einem ungültigen Namen. Erscheint, wenn sich ein Zellbezug auf einen Blattnamen
oder Bereichsnamen bezieht, der nicht existiert.

#NV "Nicht vorhanden". Erscheint, wenn die Zelle einen #NV-Fehlerwert oder einen Bezug auf eine
Zelle mit einem #NV-Fehlerwert enthält. Siehe auch Beschreibung der Funktion NV (Nicht vor-
handen).

#WERT! Ungültiger Wert. Erscheint, wenn eine Funktion mit einem nicht geeigneten Wertetyp aufgerufen
wird, sie also beispielsweise eine Zahl als Argument erwartet, ihr aber eine Zeichenkette überge-
ben wird.

#ZAHL! Ungültige Zahl. Erscheint, wenn eine Funktion mit einem Wert aufgerufen wird, der außerhalb des
für die Funktion zulässigen Wertebereichs liegt (zum Beispiel WURZEL(-2)).

Tipp: Mit den Funktionen ISTFEHLER und ISTFEHL können Sie bei Bedarf prüfen, ob die Berechnung in
einer bestimmten Zelle einen Fehlerwert ergibt

Tipp: Weiterhin können Sie den Menübefehl Weiteres > Formelüberwachung verwenden, um alle Zel-
len mit einem Fehlerwert aufzuspüren und zu analysieren. Siehe dazu Abschnitt Analysieren von Tabel-
len.

Arbeiten mit Matrizen
Sie können in PlanMaker auch Matrizen eingeben und Berechnungen damit durchführen. Unter einer Matrix
A versteht man ein rechteckiges Zahlenschema in folgender Form:

a11 bis amn nennt man die Elemente der Matrix. Diese sind auf m Zeilen und n Spalten aufgeteilt. Man

spricht daher auch von einer m x n-Matrix.

Eingabe von Matrizen in entsprechende Zellbereiche

Um eine Matrix in PlanMaker einzugeben, verteilt man die Zeilen und Spalten der Matrix einfach auf Zei-
len und Spalten der Tabelle. 

Wenn Sie also die folgende Matrix verwenden möchten...
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...so ist diese in PlanMaker folgendermaßen einzutragen:

Wie Sie sehen kann jeder (rechteckige) Zellbereich auch als Matrix angesehen werden – und umgekehrt.
Dementsprechend können Sie bei Rechenfunktionen, die als Argument eine Matrix erwarten, stets auch
einen Zellbereich angeben, der die Elemente der Matrix enthält.

Eingabe von Matrixformeln

PlanMaker verfügt über sogenannte Matrixfunktionen, mit denen Sie Berechnungen mit Matrizen durchfüh-
ren können – zum Beispiel die Inverse einer Matrix finden. Eine Rechenformel mit einer Matrixfunktion
nennen wir auch Matrixformel.

Im Unterschied zu "gewöhnlichen" Formeln liefern Matrixformeln keinen Einzelwert zurück, sondern eine
komplette Matrix. Aus diesem Grund müssen solche Matrixformeln anders eingegeben werden als sonst üb-
lich. Sehen wir uns dies anhand eines Beispiels einmal an:

Sie möchten die Inverse der oben abgebildeten 3x3-Matrix ermitteln. Dazu gehen Sie wie folgt vor:

1. Markieren des Bereichs für die Ergebnismatrix

Schon vor der Eingabe einer Matrixformel müssen Sie den Zellbereich markieren, der von der Ergebnis-
matrix belegt werden soll. Die Inverse einer Matrix hat stets genau so viele Zeilen und Spalten wie die
Ausgangsmatrix. Markieren Sie also einen Bereich mit 3x3 Zellen – zum Beispiel die Zellen E10:G12.

2. Eingabe der Matrixformel

Geben Sie nun die gewünschte Matrixformel ein. In unserem Beispiel wäre das die Formel
=MINV(E6:G8).

3. Strg+Umschalt+Eingabetaste

Wichtig: Zum Abschluss der Formel drücken Sie nicht die Eingabetaste ¿, sondern die Tastenkombina-
tion Strg+Umschalt+¿.

In den Zellen E10:G12 wird nun das Ergebnis der Berechnung, also die Inverse der Ausgangsmatrix, abge-
legt:
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Anmerkungen:

¡ Wenn Sie einen Bereich markiert hatten, der größer ist als der von der Ergebnismatrix benötigte, wird in
den überflüssigen Zellen der Fehlerwert #NV ("nicht vorhanden") angezeigt. Vorsicht: Ist der markierte
Bereich hingegen zu klein, werden nicht alle Elemente der Matrix angezeigt. 

¡ Zum nachträglichen Editieren von Matrixformeln ist erneut obiges Verfahren anzuwenden: Alle Zellen
der Ergebnismatrix markieren, Formel abändern, Strg+Umschalt+¿ drücken. Gehen Sie nicht so vor, er-
halten Sie von PlanMaker eine Warnmeldung und werden gefragt, ob Sie die Matrix überschreiben
möchten.

¡ Tipp: Um alle von einer Matrixformel belegten Zellen zu markieren, klicken Sie eine dieser Zellen an
und drücken dann Strg+7.

Eingabe von Matrizen mit festen Werten

Bei Bedarf können Sie statt eines Zellbezugs auch eine aus festen Werten bestehende Matrix in Formeln
eingeben. Umgeben Sie die Werte dazu mit geschweiften Klammern { }. Trennen Sie die Spalten durch
Punkte und die Zeilen durch Strichpunkte.

Für die oben bereits als Beispiel verwendete Matrix...

...könnte man in PlanMaker also auch schreiben:

={1.2.3;3.-1.1;2.2.4}

Anmerkungen:

¡ Obige Schreibweise ist nur für Matrizen zulässig, die ausschließlich aus festen Werten bestehen; For-
meln oder Zellbezüge sind darin nicht erlaubt. 

¡ Mit obiger Schreibweise können natürlich auch Vektoren eingegeben werden: für einen Zeilenvektor wie
a = (1, 2, 3) schreibt man {1.2.3}; für einen entsprechenden Spaltenvektor schreibt man {1;2;3}.
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Anmerkungen zu den Datenbankfunktionen
PlanMaker verfügt über eine Reihe von Datenbankfunktionen, mit denen Sie einen Tabellenbereich, der wie
eine Datenbank aufgebaut ist, abfragen und auswerten können.

Alle Datenbankfunktionen erwarten folgende Argumente:

FUNKTIONSNAME(Datenbankbereich; Spalte; Suchkriterienbereich)

So berechnet die Funktion DBSUMME beispielsweise die Summe all derjenigen Zellen in einem Daten-
bankbereich, die sich in der angegebenen Spalte befinden und den im Suchkriterienbereich angegebenen
Bedingungen entsprechen.

Um die Datenbankfunktionen einsetzen zu können, müssen folgende Schritte durchgeführt werden:

Anlegen eines Datenbankbereichs

Ein Datenbankbereich ist ein beliebiger Zellbereich mit den auszuwertenden Daten. Er muss wie folgt auf-
gebaut sein:

¡ Die erste Zeile muss jeweils eine eindeutige Beschriftung für die darunter liegende Spalte enthalten (zum
Beispiel Menge, Preis etc.). 

¡ Die Daten müssen zeilenweise eingetragen werden.

Jede Zeile des Datenbankbereichs entspricht also dem, was man bei Datenbankprogrammen als Datensatz
bezeichnet, die Spalten entsprechen den Datenbankfeldern.

Anlegen eines Suchkriterienbereichs

Der Suchkriterienbereich ist ein weiterer Zellbereich. In diesen können Sie beliebige viele Suchkriterien
eingetragen.

Der Suchkriterienbereich muss wie folgt aufgebaut sein:

¡ Wichtig: Der Suchkriterienbereich muss sich oberhalb des Datenbankbereichs befinden. Weiterhin darf
er den Datenbankbereich nicht überlappen. 

¡ Auch hier muss die erste Zeile Beschriftungen für die Spalten enthalten. Wenn Sie beispielsweise Such-
kriterien für die Spalten festlegen wollen, die Sie im Datenbankbereich mit den Überschriften Menge
und Preis versehen haben, müssen Sie auch hier Menge und Preis eintragen.

¡ Unter den Beschriftungen sind die zu erfüllenden Bedingungen einzutragen. Dies können sowohl Einzel-
werte als auch Vergleiche wie ">42" oder "<10" sein.

¡ Sind mehrere Suchbedingungen in der gleichen Zeile eingetragen, müssen die Bedingungen in Spalte 1
und Spalte 2 und Spalte 3 etc. erfüllt werden.

¡ Sind mehrere Zeilen mit Suchbedingungen eingetragen, müssen die Bedingungen in Zeile 1 oder Zeile 2
oder Zeile 3 etc. erfüllt werden.
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Anwenden der Datenbankfunktionen

Nachdem Sie Datenbankbereich und Suchkriterienbereich ausgefüllt haben, können Sie die Datenbankfunk-
tionen einsetzen.

Nachfolgend einige Beispiele. Nehmen wir an, Sie haben folgende Tabelle erstellt:

Hier können beispielsweise folgende Berechnungen durchgeführt werden:

DBANZAHL(A11:C16; ; A2:A3) ergibt 2. Hier wird die Anzahl aller Datensätze berechnet, bei denen gilt:
Farbe = blau.

DBANZAHL(A11:C16; ; A6:B7) ergibt 3. Hier wird die Anzahl aller Datensätze berechnet, bei denen gilt:
(Menge > 25 und Menge < 75).

DBANZAHL(A11:C16; ; A6:C8) ergibt 4. Hier wird die Anzahl aller Datensätze berechnet, bei denen gilt:
(Menge > 25 und Menge < 75) oder (Farbe = rot).

DBSUMME(A11:C16; "Menge"; A2:A3) ergibt 150. Hier wird die Summe der Spalte "Menge" für die Da-
tensätze berechnet, bei denen gilt: Farbe = blau.

DBSUMME(A11:C16; 1; A2:A3) ergibt 150. Diese Formel entspricht der obigen, denn statt der Bezeich-
nung der Spalte können Sie auch die Nummer der Spalte (innerhalb der Tabellenbereichs) angeben.

Funktionen von A-Z
Auf den nun folgenden Seiten finden Sie Beschreibungen aller Rechenfunktionen von PlanMaker in alpha-
betischer Reihenfolge.
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ABRUNDEN (Abrunden auf n Stellen)

Syntax:

ABRUNDEN(Zahl; n)

Beschreibung:

Rundet eine Zahl betragsmäßig auf n Nachkommastellen ab.

n ist die gewünschte Anzahl an Nachkommastellen. 

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen abgerundet.

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl abgerundet wird: Ist n beispiels-
weise -2, wird die Zahl auf ein Vielfaches von Hundert abgerundet (siehe letztes Beispiel).

Beispiel:

ABRUNDEN(1,234; 2) ergibt 1,23

ABRUNDEN(1,235; 2) ergibt 1,23

ABRUNDEN(888,999; 0) ergibt 888

ABRUNDEN(888,999; -2) ergibt 800

Siehe auch:

AUFRUNDEN, RUNDEN, VRUNDEN, KÜRZEN, FEST, GANZZAHL, GERADE, UNGERADE,
OBERGRENZE, UNTERGRENZE

ABS (Absolutbetrag)

Syntax:

ABS(Zahl)

Beschreibung:

Liefert den Absolutbetrag einer Zahl, entfernt also ihr Vorzeichen.

Beispiel:

ABS(42) ergibt 42

ABS(0) ergibt 0
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ABS(-42) ergibt 42

Siehe auch:

VORZEICHEN, NEG

ACHSENABSCHNITT (Achsenabschnitt einer Regressionsgeraden)

Syntax:

ACHSENABSCHNITT(y_Werte; x_Werte)

Beschreibung:

Ermittelt den y-Achsenabschnitt einer Regressionsgeraden. Das ist die y-Koordinate des Punktes, an dem
die Regressionsgerade die y-Achse schneidet.

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter versteht man das Anpassen ei-
ner linearen Funktion (Regressionsgerade oder Ausgleichsgerade genannt) an eine Menge von Punkten
(zum Beispiel den Messpunkten einer Messreihe).

Mit der Funktion ACHSENABSCHNITT können Sie voraussagen, welchen Wert y (die abhängige Varia-
ble) ungefähr haben wird, wenn x (die unabhängige Variable) Null ist.

Sie können somit zum Beispiel abschätzen, welchen Widerstand ein temperaturabhängiger Widerstand bei
0° haben wird, nachdem Sie den Widerstand bei verschiedenen anderen Temperaturen gemessen haben.

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbereich an.

y_Werte sind die abhängigen Variablen (in obigem Beispiel also der Widerstand).

x_Werte sind die unabhängigen Variablen (in obigem Beispiel also die Temperatur).

Hinweis:

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwartet – nicht umgekehrt.

Anmerkung:

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleinsten Quadrate durchgeführt.

Beispiel:

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Widerstand bei verschiedenen
Temperaturen vorliegt.

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also die unabhängigen Varia-
blen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 28

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen Variablen; in unserem
Beispiel ist dies der Widerstand): 261, 508, 608, 680
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Mit der folgenden Formel können Sie abschätzen, welcher Widerstand bei 0°C geliefert werden wird:

ACHSENABSCHNITT(B1:B4; A1:A4) ergibt 93,69817

Bei 0° wäre also ein Widerstand von 93,69817 (Ohm) zu erwarten.

Anmerkung:

ACHSENABSCHNITT(y_Werte; x_Werte) entspricht SCHÄTZER(0; y_Werte; x_Werte).

Siehe auch:

SCHÄTZER, SCHIEFE, STEIGUNG, STFEHLERYX, PEARSON

ADRESSE (Zelladresse als Text ausgeben)

Syntax:

ADRESSE(Zeile; Spalte [; Abs] [; Modus] [; Blattname])

Beschreibung:

Liefert die Adresse einer Zelle als Text.

Für Zeile und Spalte ist die Zeilennummer und Spaltennummer der Zelle anzugeben.

Das optionale Argument Abs bestimmt, ob eine absolute oder relative Adresse geliefert werden soll:

1 oder nicht angegeben: Zeile und Spalte absolut

2: Zeile absolut, Spalte relativ

3: Zeile relativ, Spalte absolut

4: Zeile und Spalte relativ

Über den optionalen Wahrheitswert Modus können Sie bestimmen, in welchem Format die Zelladresse aus-
gegeben werden soll:

WAHR oder nicht angegeben: Normale Zelladresse ausgeben (z.B. A1)

FALSCH: Zelladresse im Format "Z1S1" ausgeben (eine alternative Art der Zelladressierung, die nur von
Microsoft Excel unterstützt wird)

Wird die optionale Zeichenkette Blattname angegeben, so wird das Ergebnis im Format Blattname!Adresse
ausgegeben (siehe Beispiel).

Beispiel:

ADRESSE(1; 5) ergibt $E$1

ADRESSE(1; 5; 4) ergibt E1

ADRESSE(1; 5; 4; ; "Tabelle1") ergibt Tabelle1!E1
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Siehe auch:

INDIREKT, BEREICH.VERSCHIEBEN, SPALTE, ZEILE

ANZAHL (Wie viele Zellen mit Zahlen ausgefüllt?)

Syntax:

ANZAHL(Bereich1 [; Bereich2; Bereich3 ...])

Beschreibung:

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit Zahlen gefüllt sind. Datumsangaben sind
ebenfalls Zahlen; sie werden also mitgezählt.

Beispiel:

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die Zelle A4 ist leer. Dann
gilt:

ANZAHL(A1:A4) ergibt 1

Zum Vergleich: ANZAHL2(A1:A4) ergibt 3

Anmerkung:

Die Funktion ANZAHL2 arbeitet ähnlich, sie zählt jedoch Zellen mit beliebigem Inhalt

Siehe auch:

ANZAHL2, ANZAHLLEEREZELLEN, ANZAHLP, HÄUFIGKEIT, ISTLEER, ISTZAHL,
ZÄHLENWENN, ZÄHLENWENNS

ANZAHL2 (Wie viele Zellen ausgefüllt?)

Syntax:

ANZAHL2(Bereich1 [; Bereich2; Bereich3 ...])

Beschreibung:

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit beliebigen Werten gefüllt sind. 

Die Zellen dürfen beliebige Zahlen, Zeichenketten, Wahrheitswerte oder Fehlerwerte enthalten.
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Beispiel:

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die Zelle A4 ist leer. Dann
gilt:

ANZAHL2(A1:A4) ergibt 3

Zum Vergleich: ANZAHL(A1:A4) ergibt 1

Anmerkung:

Die Funktion ANZAHL arbeitet ähnlich, sie zählt jedoch nur Zellen mit Zahlen.

Siehe auch:

ANZAHL, ISTLEER

ANZAHLLEEREZELLEN (Wie viele Zellen leer?)

Syntax:

ANZAHLLEEREZELLEN(Bereich)

Beschreibung:

Ermittelt, wie viele Zellen in einem Bereich leer sind.

Beispiel:

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die Zelle A4 ist leer. Dann
gilt:

ANZAHLLEEREZELLEN(A1:A4) ergibt 1

Siehe auch:

ISTLEER, ANZAHL

ANZAHLP (PlanMaker 97-Kompatibilitätsfunktion)

Syntax:

ANZAHLP(Bereich1 [; Bereich2; Bereich3 ...])
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Beschreibung:

Ermittelt, wie viele Zellen in einem oder mehreren Bereichen mit Zahlen oder Wahrheitswerten gefüllt
sind. 

Hinweis:

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhanden. Verwenden Sie diese
Funktion möglichst nicht mehr, sondern benutzen Sie stattdessen die Excel-kompatiblen Funktionen
ANZAHL und ANZAHL2.

Der Unterschied zwischen diesen Funktionen:

ANZAHL2 zählt alle Zellen, die nicht leer sind (unabhängig von deren Inhalt).

ANZAHL zählt alle Zellen, die Zahlen enthalten.

ANZAHLP zählt alle Zellen, die Zahlen oder Wahrheitswerte enthalten.

Beispiel:

Angenommen, die Zellen A1 bis A3 enthalten die Werte 42, "Test" und WAHR; die Zelle A4 ist leer. Dann
gilt:

ANZAHL2(A1:A4) ergibt 3

ANZAHL(A1:A4) ergibt 1

ANZAHLP(A1:A4) ergibt 2

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Siehe auch:

ANZAHL, ANZAHL2

ARBEITSTAG (Datum nach x Arbeitstagen)

Syntax:

ARBEITSTAG(Ausgangsdatum; Tage [; FreieTage])

Beschreibung:

Ermittelt das Datum, das x Arbeitstage vor oder hinter dem Ausgangsdatum liegt.

Samstage und Sonntage werden dabei übersprungen. Weiterhin kann der Funktion optional eine Liste mit
freien Tagen (z.B. Feiertagen) übergeben werden. Diese werden dann ebenfalls übersprungen.
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Ausgangsdatum ist das Startdatum.

Tage ist die Zahl der Tage. Tage darf auch ein negativer Wert sein – in diesem Falle wird kein zukünftiges,
sondern ein vergangenes Datum geliefert.

Für FreieTage kann optional eine Liste mit freien Tagen angegeben werden. (Hierfür verwendet man übli-
cherweise einen Zellbereich oder eine Matrix, die die entsprechenden Datumswerte enthält.)

Beispiel:

ARBEITSTAG("1.10.2016"; 9) ergibt den 13.10.2016.

Das Datum, das 9 Arbeitstage hinter dem 1.10.2016 liegt, ist also der 13.10.2016.

Der 3.10.2016 war allerdings ein Feiertag. Wollte man dies berücksichtigen, so müsste man schreiben:

ARBEITSTAG("1.10.2016"; 9; "3.10.2016") – und das ergibt den 14.10. statt des 13.10, da der Feiertag am
3.10. auf einen Wochentag fiel, in der Zählung also übersprungen wird.

Siehe auch:

FEIERTAG, NETTOARBEITSTAGE

ARCCOS (Arcuscosinus)

Syntax:

ARCCOS(Zahl)

Beschreibung:

Die Funktion ARCCOS (= Arcuscosinus) ist die Umkehrfunktion der Funktion COS: Sie liefert den inver-
sen Cosinus einer Zahl – also den Winkel, dessen Cosinus Zahl ist.

Der zulässige Wertebereich für Zahl ist: -1 £ Zahl £ 1

Das Ergebnis wird im Bogenmaß (Radiant) geliefert.

Beispiel:

ARCCOS(1) ergibt 0

ARCCOS(COS(0,1234)) ergibt 0,1234

Tipp:

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad umrechnen.

Siehe auch:

COS, ARCSIN, ARCTAN
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ARCCOSHYP (Arcuscosinus Hyperbolicus)

Syntax:

ARCCOSHYP(Zahl)

Beschreibung:

Die Funktion ARCCOSHYP (= Arcuscosinus Hyperbolicus) ist die Umkehrfunktion der Funktion
COSHYP: Sie liefert den inversen hyperbolischen Cosinus einer Zahl – also den Wert, dessen hyperboli-
scher Cosinus Zahl ist.

Beispiel:

ARCCOSHYP(1,1) ergibt 0,44357

ARCCOSHYP(COSHYP(0,1234)) ergibt 0,1234

Siehe auch:

COSHYP

ARCCOT (Arcuscotangens)

Syntax:

ARCCOT(Zahl)

Beschreibung:

Die Funktion ARCCOT (= Arcuscotangens) ist die Umkehrfunktion der Funktion COT: Sie liefert den in-
versen Cotangens einer Zahl – also den Winkel, dessen Cotangens Zahl ist.

Das Ergebnis wird im Bogenmaß (Radiant) geliefert.

Beispiel:

ARCCOT(1) ergibt 0,7854 (entspricht PI()/4, also 45°)

ARCCOT(COT(0,1234)) ergibt 0,1234

Tipp:

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad umrechnen.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

COT

ARCCOTHYP (Arcuscotangens Hyperbolicus)

Syntax:

ARCCOTHYP(Zahl)

Beschreibung:

Die Funktion ARCCOTHYP (= Arcuscotangens Hyperbolicus) ist die Umkehrfunktion der Funktion
COTHYP: Sie liefert den inversen hyperbolischen Cotangens einer Zahl – also den Wert, dessen COTHYP
Zahl ist.

Beispiel:

ARCCOTHYP(2) ergibt 0,54931

ARCCOTHYP(COTHYP(0,1234)) ergibt 0,1234

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

COTHYP

ARCSIN (Arcussinus)

Syntax:

ARCSIN(Zahl)
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Beschreibung:

Die Funktion ARCSIN (= Arcussinus) ist die Umkehrfunktion der Funktion SIN: Sie liefert den inversen
Sinus einer Zahl – also den Winkel, dessen Sinus Zahl ist.

Der zulässige Wertebereich für Zahl ist: -1 £ Zahl £ 1

Das Ergebnis wird im Bogenmaß (Radiant) geliefert.

Beispiel:

ARCSIN(1) ergibt 1,5708... (entspricht PI()/2, also 90°)

ARCSIN(SIN(0,1234)) ergibt 0,1234

Tipp:

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad umrechnen.

Siehe auch:

SIN, ARCCOS, ARCTAN

ARCSINHYP (Arcussinus Hyperbolicus)

Syntax:

ARCSINHYP(Zahl)

Beschreibung:

Die Funktion ARCSINHYP (= Arcussinus Hyperbolicus) ist die Umkehrfunktion der Funktion SINHYP:
Sie liefert den inversen hyperbolischen Sinus einer Zahl – also den Wert, dessen SINHYP Zahl ist.

Beispiel:

ARCSINHYP(1,1) ergibt 0,9503

ARCSINHYP(SINHYP(0,1234)) ergibt 0,1234

Siehe auch:

SINHYP
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ARCTAN (Arcustangens)

Syntax:

ARCTAN(Zahl)

Beschreibung:

Die Funktion ARCTAN (= Arcustangens) ist die Umkehrfunktion der Funktion TAN: Sie liefert den inver-
sen Tangens einer Zahl – also den Winkel, dessen Tangens Zahl ist.

Das Ergebnis wird im Bogenmaß (Radiant) geliefert.

Beispiel:

ARCTAN(1) ergibt 0,7854 (entspricht PI()/4, also 45°)

ARCTAN(TAN(0,1234)) ergibt 0,1234

Tipp:

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad umrechnen.

Siehe auch:

ARCTAN2, TAN, ARCCOS, ARCSIN

ARCTAN2 (Arcustangens 2)

Syntax:

ARCTAN2(x; y)

Beschreibung:

Liefert den Winkel zwischen der x-Achse und einer Geraden vom Nullpunkt (0; 0) zu einem Punkt P (x; y).

Als Argumente sind die x- und die y-Koordinate dieses Punktes anzugeben.

Das Ergebnis wird in Bogenmaß (Radiant) geliefert.

Beispiel:

ARCTAN2(1; 1) ergibt 0,7854 (entspricht PI()/4, also 45°)
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Tipp:

Mit der Funktion GRAD können Sie das Ergebnis vom Bogenmaß in Grad umrechnen.

Siehe auch:

ARCTAN, TAN

ARCTANHYP (Arcustangens Hyperbolicus)

Syntax:

ARCTANHYP(Zahl)

Beschreibung:

Die Funktion ARCTANHYP (= Arcustangens Hyperbolicus) ist die Umkehrfunktion der Funktion
TANHYP: Sie liefert den inversen hyperbolischen Tangens einer Zahl – also den Wert, dessen TANHYP
Zahl ist.

Der zulässige Wertebereich für Zahl ist: -1 < Zahl < 1

Beispiel:

ARCTANHYP(0,5) ergibt 0,54931

ARCTANHYP(TANHYP(0,1234)) ergibt 0,1234

Siehe auch:

TANHYP

AUFRUNDEN (Aufrunden auf n Stellen)

Syntax:

AUFRUNDEN(Zahl; n)

Beschreibung:

Rundet eine Zahl betragsmäßig auf n Nachkommastellen auf.

n ist die gewünschte Anzahl an Nachkommastellen. 

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen aufgerundet.
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n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl aufgerundet wird: Ist n beispiels-
weise -2, wird die Zahl auf ein Vielfaches von Hundert aufgerundet (siehe letztes Beispiel).

Beispiel:

AUFRUNDEN(1,234; 2) ergibt 1,24

AUFRUNDEN(1,235; 2) ergibt 1,24

AUFRUNDEN(444,222; 0) ergibt 445

AUFRUNDEN(444,222; -2) ergibt 500

Siehe auch:

ABRUNDEN, RUNDEN, VRUNDEN, KÜRZEN, FEST, GANZZAHL, GERADE, UNGERADE,
OBERGRENZE, UNTERGRENZE

AUSWAHL (Ist x>0, x=0 oder x<0?)

Syntax:

AUSWAHL(Zahl; WennGrößer [; WennNull; WennKleiner])

Beschreibung:

Liefert einen der folgenden Werte zurück:

WennGrößer, wenn Zahl größer als Null ist.

WennNull, wenn Zahl gleich Null ist.

WennKleiner, wenn Zahl kleiner als Null ist.

Die letzten beiden Argumente sind dabei optional.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

AUSWAHL(42; "Größer"; "Null"; "Kleiner") ergibt Größer

AUSWAHL(0; "Größer"; "Null"; "Kleiner") ergibt Null

AUSWAHL(-42; "Größer"; "Null"; "Kleiner") ergibt Kleiner

Siehe auch:

WENN
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B (Kompatibilitätsfunktion)

Syntax:

B(n; p; k1 [; k2])

wobei:

n = Anzahl der Versuche

p = Trefferwahrscheinlichkeit eines Versuchs (0 bis 100%)

k1 = Untere Schranke

k2 = Obere Schranke (optional)

Beschreibung:

Liefert die Wahrscheinlichkeit, mit der bei n unabhängigen Versuchen ein Ereignis genau k1 mal bezie-
hungsweise zwischen k1 und k2 mal auftritt.

Hinweis:

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhanden. Verwenden Sie diese
Funktion möglichst nicht mehr, sondern benutzen Sie stattdessen die folgenden Excel-kompatiblen Funktio-
nen:

B(n; p; k1) entspricht BINOMVERT(k1; n; p; FALSCH) bzw. BINOM.VERT(k1; n; p; FALSCH) 

B(n; p; k1; k2) entspricht BINOM.VERT.BEREICH(n; p; k1; k2)

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

In Excel 2013 wurde eine neue Funktion eingeführt, die mit der Funktion B identisch ist:
BINOM.VERT.BEREICH. PlanMaker unterstützt diese Funktion ebenfalls. Beachten Sie jedoch, dass älte-
re Versionen von Excel (und PlanMaker) diese Funktion noch nicht kennen.

Siehe auch:

BINOM.VERT.BEREICH/BINOM.VERT/BINOMVERT



436Formeln und Funktionen

BASIS (Dezimalzahl in anderes Zahlensystem wandeln)

Syntax:

BASIS(Zahl; Basis [; Stellen])

Beschreibung:

Wandelt eine Dezimalzahl (Basis 10) in eine Zahl mit einer anderen Basis um – zum Beispiel eine Binärzahl
(Basis 2) oder eine Hexadezimalzahl (Basis 16).

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, keine Zahl. 

Zahl ist die umzuwandelnde Zahl. Es sind nur positive Zahlen erlaubt.

Basis ist die Basis, in die Zahl umgewandelt werden soll. Es sind nur ganze Zahlen zwischen 2 und 36 er-
laubt.

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen dabei mindestens angezeigt
werden sollen. Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch. Stellen
muss eine positive ganze Zahl sein. 

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

BASIS(42; 2) ergibt 101010 (die Dezimalzahl 42 als Binärzahl)

BASIS(42; 2; 8) ergibt 00101010 (dito, aber mit mindestens 8 Stellen)

Siehe auch:

DEZIMAL, DEZINBIN, DEZINHEX, DEZINOKT 

BENUTZERFELD (Benutzerdaten ausgeben)

Syntax:

BENUTZERFELD(Feldname)

Beschreibung:

Liefert das angegebene Feld aus den eingetragenen Benutzerdaten (Name, Adresse etc.).
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Hinweis: Sie können Ihre Benutzerdaten bearbeiten, indem Sie den Menübefehl Weiteres > Einstellungen
aufrufen, auf die Karteikarte Allgemein wechseln und die Schaltfläche Benutzerdaten anklicken.

Das Argument Feldname ist der Feldname der gewünschten Information entsprechend der nachfolgenden
Tabelle. 

Die Groß-/Kleinschreibung von Feldname spielt keine Rolle. Beachten Sie aber, dass feste Zeichenketten
in Funktionsparametern stets mit doppelten Anführungszeichen (") umgeben werden müssen – also bei-
spielsweise BENUTZERFELD("Benutzer.Ort").

Für Feldname sind folgende Zeichenketten zulässig:

Benutzerdaten-Feld Feldname

Anrede Benutzer.Anrede

Name Benutzer.Name

Initialen Benutzer.Initialen

Firma Benutzer.Firma

Abteilung Benutzer.Abteilung

Adresse 1 Benutzer.Adresse 1

Adresse 2 Benutzer.Adresse 2

PLZ Benutzer.PLZ

Ort Benutzer.Ort

Land Benutzer.Land

Telefon 1 Benutzer.Telefon 1

Telefon 2 Benutzer.Telefon 2

Telefon 3 Benutzer.Telefon 3

Telefax Benutzer.Telefax

E-Mail 1 Benutzer.E-Mail 1

E-Mail 2 Benutzer.E-Mail 2

E-Mail 3 Benutzer.E-Mail 3

Website Benutzer.Website

Kompatibilitätshinweis 1:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Kompatibilitätshinweis 2:

In älteren Versionen von PlanMaker (bis inklusive PlanMaker 2016) gab es noch zwei Sätze von Benutzer-
daten: "Benutzer privat" und "Benutzer Firma". Diese wurden bei PlanMaker 2018 auf einen Satz reduziert.
Wenn Sie ein altes Dokument öffnen, das diese Funktion verwendet, werden deren Parameter automatisch
entsprechend konvertiert.
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Beispiel:

BENUTZERFELD("Benutzer.Ort") ergibt Nürnberg

BEREICHE (Zahl der Bereiche)

Syntax:

BEREICHE(Bezug)

Beschreibung:

Ermittelt, wie viele Bereiche der übergebene Zellbezug enthält.

Beispiel:

BEREICHE(A1:B2) ergibt 1

BEREICHE((A1:B2; E5:G7)) ergibt 2

Siehe auch:

INDEX, SPALTEN, ZEILEN

BEREICH.VERSCHIEBEN (Versetzter Zellbezug)

Syntax:

BEREICH.VERSCHIEBEN(Bezug; Zeilen; Spalten [; Höhe] [; Breite])

Beschreibung:

Liefert einen Zellbezug, der gegenüber dem ursprünglichen Zellbezug um die angegebene Zahl an Zeilen
und/oder Spalten versetzt ist. Optional kann auch die Größe von Bezug geändert werden.

Hinweis: Hierbei werden weder physikalisch Tabellenzellen verschoben, noch wird die Markierung ver-
setzt. Die Funktion liefert lediglich einen versetzten Zellbezug zurück.

Bezug ist der ursprüngliche Zellbezug. Sie können wahlweise eine einzelne Zelle oder einen Zellbereich (in
der Schreibweise Startzelle:Endzelle) angeben.

Bei Zeilen geben Sie die Zahl der Zeilen an, um die Bezug versetzt werden soll. Es ist auch ein negativer
Wert erlaubt – hier wird Bezug nach oben statt nach unten versetzt.

Bei Spalten geben Sie die Zahl der Spalten an, um die Bezug versetzt werden soll. Es ist auch ein negativer
Wert erlaubt – hier wird Bezug nach links statt nach rechts versetzt.
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Wenn Sie das optionale Argument Höhe angeben, wird die Höhe des Bezugs auf die entsprechende Anzahl
an Zeilen geändert.

Wenn Sie das optionale Argument Breite angeben, wird die Breite des Bezugs auf die entsprechende An-
zahl an Spalten geändert.

Beispiel:

BEREICH.VERSCHIEBEN(A1; 2; 0) liefert einen Zellbezug auf die Zelle A3

BEREICH.VERSCHIEBEN(A1:C3; 1; 1) liefert einen Zellbezug auf den Zellbereich B2:D4

BEREICH.VERSCHIEBEN(A1:C3; 1; 1; 5; 3) liefert einen Zellbezug auf den Zellbereich B2:D6

SUMME(BEREICH.VERSCHIEBEN(A1:C3; 1; 1; 5; 3)) liefert die Summe der Zellen im Bereich B2:D6

Siehe auch:

ADRESSE, INDIREKT, SPALTE, ZEILE

BESSELI (Modifizierte Besselfunktion erster Art)

Syntax:

BESSELI(x; n)

Beschreibung:

Liefert die modifizierte Besselfunktion erster Art In(x).

x ist der auszuwertende Wert.

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet wird eine ganze Zahl; ist
dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Siehe auch:

BESSELJ, BESSELK, BESSELY

BESSELJ (Besselfunktion erster Art)

Syntax:

BESSELJ(x; n)
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Beschreibung:

Liefert die Besselfunktion erster Art Jn(x).

x ist der auszuwertende Wert.

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet wird eine ganze Zahl; ist
dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Siehe auch:

BESSELI, BESSELK, BESSELY

BESSELK (Modifizierte Besselfunktion zweiter Art)

Syntax:

BESSELK(x; n)

Beschreibung:

Liefert die modifizierte Besselfunktion zweiter Art Kn(x).

x ist der auszuwertende Wert.

n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet wird eine ganze Zahl; ist
dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Siehe auch:

BESSELI, BESSELJ, BESSELY

BESSELY (Besselfunktion zweiter Art)

Syntax:

BESSELY(x; n)

Beschreibung:

Liefert die Besselfunktion zweiter Art Yn(x) (auch Weberfunktion oder Neumannfunktion genannt).

x ist der auszuwertende Wert.
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n ist die Ordnung der Besselfunktion. n muss größer gleich Null sein. Erwartet wird eine ganze Zahl; ist
dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Siehe auch:

BESSELI, BESSELJ, BESSELK

BESTIMMTHEITSMASS (Bestimmtheitskoeffizient)

Syntax:

BESTIMMTHEITSMASS(Bereich1; Bereich2)

Beschreibung:

Liefert den Bestimmtheitskoeffizienten zweier Datengruppen. 

Dieser ist ein Maß für den linearen Zusammenhang der Datengruppen. Je näher er an 1 liegt, desto größer
ist der Zusammenhang. 

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müssen Zahlen enthalten. Lee-
re Zellen sowie Zeichenketten und Wahrheitswerte werden ignoriert.

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert die Funktion den Feh-
lerwert #NV.

Beispiel:

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den Werten 2, 7, 4 gefüllt, so
gilt:

BESTIMMTHEITSMASS(A1:A3; B1:B3) ergibt 0,99436

Anmerkung:

BESTIMMTHEITSMASS ist das Quadrat von PEARSON (Pearsonscher Korrelationskoeffizient).

Siehe auch:

PEARSON

BETAINV (Quantile einer Betaverteilung)

Hinweis: BETAINV wird durch die neue identische Funktion BETA.INV ergänzt, die in neueren Versio-
nen von Microsoft Excel (ab 2010) verwendet wird.
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Syntax:

BETAINV(Wahrscheinlichkeit; Alpha; Beta [; A; B])

Beschreibung:

Liefert Quantile einer Betaverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Betaverteilung. Zulässig sind nur Werte
mit 0 < Wahrscheinlichkeit £ 1.

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein. 

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte nicht angeben, wird A auf
0 und B auf 1 gesetzt (entspricht der Normalverteilung).

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Siehe auch:

BETA.INV, BETA.VERT/BETAVERT 

BETA.INV (Quantile einer Betaverteilung)

Syntax:

BETA.INV(Wahrscheinlichkeit; Alpha; Beta [; A; B])

Beschreibung:

Liefert Quantile einer Betaverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Betaverteilung. Zulässig sind nur Werte
mit 0 < Wahrscheinlichkeit £ 1.

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein. 

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte nicht angeben, wird A auf
0 und B auf 1 gesetzt (entspricht der Normalverteilung).

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

BETA.INV ist die Umkehrfunktion von BETA.VERT

Siehe auch:

BETAINV, BETA.VERT/BETAVERT 

BETAVERT (Betaverteilung)

Hinweis: BETAVERT wird durch die neue Funktion BETA.VERT mit zusätzlicher Funktionalität er-
gänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

BETAVERT(X; Alpha; Beta [; A; B])

Beschreibung:

Liefert Werte der kumulierten Verteilungsfunktion einer betaverteilten Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. 

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein. 

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte nicht angeben, wird A auf
0 und B auf 1 gesetzt (entspricht der Normalverteilung).

X muss im Intervall zwischen A und B liegen.

Siehe auch:

BETA.VERT, BETA.INV/BETAINV

BETA.VERT (Betaverteilung)

Syntax:

BETA.VERT(X; Alpha; Beta; Kumuliert [; A; B])
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Beschreibung:

Liefert Werte der (kumulierten) Verteilungsfunktion einer betaverteilten Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll.

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein.

Kumuliert bestimmt als Schalter die Art der Funktion: Gibt man den Wert WAHR ein, wird die kumulierte
Verteilungsfunktion der Betaverteilung berechnet. Durch Eingabe von Wert FALSCH berechnet sich die
Dichtefunktion der Betaverteilung.

A und B (optional) bestimmen die Grenzen des Intervalls. Wenn Sie diese Werte nicht angeben, wird A auf
0 und B auf 1 gesetzt (entspricht der Normalverteilung).

X muss im Intervall zwischen A und B liegen.

Hinweis:

Die Funktion BETA.VERT ergänzt mit dem zusätzlichen Argument Kumuliert die bisherige Funktion
BETAVERT.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist BETA.INV

Siehe auch:

BETAVERT, BETA.INV/BETAINV 

BININDEZ (Binärzahl in Dezimalzahl wandeln)

Syntax:

BININDEZ(Zahl)

Beschreibung:

Wandelt eine Binärzahl (Basis 2) in eine Dezimalzahl (Basis 10) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel).

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also:
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-(2^31) £ Zahl £ (2^31)-1

Beispiel:

BININDEZ("101010") ergibt 42

BININDEZ("00101010") ergibt ebenfalls 42

BININDEZ("11111111111111111111111111010110") ergibt -42

Siehe auch:

DEZINBIN, BININHEX, BININOKT, DEZIMAL 

BININHEX (Binärzahl in Hexadezimalzahl wandeln)

Syntax:

BININHEX(Zahl [; Stellen])

Beschreibung:

Wandelt eine Binärzahl (Basis 2) in eine Hexadezimalzahl (Basis 16) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also:

-(2^31) £ Zahl £ (2^31)-1

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert.

Beispiel:

BININHEX("101010") ergibt 2A

BININHEX("00101010") ergibt ebenfalls 2A

BININHEX("101010"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindestens 2 Stellen darge-
stellt werden kann

BININHEX("11111111111111111111111111010110") ergibt FFFFFFD6 (negative Zahl)
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Siehe auch:

HEXINBIN, BININDEZ, BININOKT

BININOKT (Binärzahl in Oktalzahl wandeln)

Syntax:

BININOKT(Zahl [; Stellen])

Beschreibung:

Wandelt eine Binärzahl (Basis 2) in eine Oktalzahl (Basis 8) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Zahl darf maximal 32 Stellen umfassen, der zulässige Wertebereich ist also:

-(2^31) £ Zahl £ (2^31)-1

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert.

Beispiel:

BININOKT("101010") ergibt 52

BININOKT("00101010") ergibt ebenfalls 52

BININOKT("101010"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindestens 2 Stellen darge-
stellt werden kann

BININOKT("11111111111111111111111111010110") ergibt 37777777726 (negative Zahl)

Siehe auch:

OKTINBIN, BININDEZ, BININHEX
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BINOM.INV (Binomialverteilung)

Syntax:

BINOM.INV(n; p; Alpha)

Beschreibung:

Liefert den kleinsten Wert für eine binomialverteilte Zufallsvariable, bei dem die angegebene Irrtumswahr-
scheinlichkeit Alpha nicht überschritten wird.

Es wird also berechnet, wie oft ein bestimmtes Ereignis mit der Wahrscheinlichkeit p beim Durchführen ei-
ner Stichprobe mit n Wiederholungen höchstens eintreten darf, bevor seine kumulierten Wahrscheinlichkei-
ten einen Wert größer oder gleich der Irrtumswahrscheinlichkeit Alpha annehmen.

Diese Funktion ist nur bei Binomialverteilungen anwendbar (siehe auch Funktion
BINOM.VERT/BINOMVERT); es muss sich also um unabhängige Ziehungen handeln, bei denen nur zwei
Ergebnisse möglich sind: Erfolg (Ereignis tritt ein) oder Fehlschlag (Ereignis tritt nicht ein)

n ist die Anzahl der durchgeführten Versuche.

p ist die Wahrscheinlichkeit des Erfolgs pro Wiederholung. Zulässig sind nur Werte aus dem Intervall
[0..1].

Alpha ist die Irrtumswahrscheinlichkeit, die nicht überschritten werden darf. Zulässig sind nur Werte aus
dem Intervall [0..1].

Beispiel:

Aus früheren Lieferungen ist ihnen bekannt, dass normalerweise 7% eines bestimmten elektronischen Bau-
teils defekt sind. Um diese Aussage zu überprüfen, führen Sie bei einer neuen Lieferung eine Stichprobe
von 100 Bauteilen durch. Wie viele davon dürfen höchstens defekt sein, wenn die Irrtumswahrscheinlich-
keit 1% nicht überschreiten soll?

BINOM.INV(100; 7%; 1%) ergibt 2

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

KRITBINOM, BINOM.VERT/BINOM.VERT.BEREICH/BINOMVERT
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BINOMVERT (Binomialverteilung)

Hinweis: BINOMVERT wird durch die neue identische Funktion BINOM.VERT und die gänzlich neue
Funktion BINOM.VERT.BEREICH ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010)
verwendet werden.

Syntax:

BINOMVERT(k; n; p; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer binomialverteilten Zufallsvariablen.

Die Binomialverteilung ist die Wahrscheinlichkeitsverteilung für die Anzahl Treffer (k) bei einem Zufalls-
experiment, das n mal unabhängig wiederholt wird und nur zwei mögliche Ergebnisse hat (Treffer oder
Fehlschlag), wobei die Wahrscheinlichkeit für einen Treffer pro Wiederholung p beträgt.

Sie können mit dieser Funktion beispielsweise ermitteln, wie groß die Wahrscheinlichkeit ist, bei 10
Münzwürfen genau 4 Mal "Kopf" zu erhalten.

k ist die Anzahl an Treffern, hier also 4. k muss größer gleich Null und kleiner gleich n sein.

n ist die Zahl der Wiederholungen, hier also 10.

n und k sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen automa-
tisch weg.

p ist die Trefferwahrscheinlichkeit pro Wiederholung, hier also die Wahrscheinlichkeit "Kopf" zu erhalten,
sprich 50%.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert. BINOMVERT ermittelt also die Wahrscheinlichkeit, dass
es genau k Treffer gibt.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert. BINOMVERT ermittelt also die Wahrschein-
lichkeit, dass es höchstens k Treffer gibt. 

Beispiel:

Greifen wir obiges Beispiel auf: 

Wie groß ist die Wahrscheinlichkeit, bei 10 Münzwürfen genau 4 Mal "Kopf" zu werfen (bei p=50%)?

BINOM.VERT(4; 10; 50%; FALSCH) ergibt 0,20508 =20,5%

Wie groß ist die Wahrscheinlichkeit, höchstens 4 Mal "Kopf" zu werfen?

Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument Kumuliert mit WAHR
angeben):

BINOM.VERT(4; 10; 50%; WAHR) ergibt 0,37695 =37,7%
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Siehe auch:

BINOM.VERT/BINOM.VERT.BEREICH, BINOM.INV/KRITBINOM, B, KOMBINATIONEN,
NEGBINOM.VERT/NEGBINOMVERT, POISSON.VERT/POISSON

BINOM.VERT (Binomialverteilung)

Syntax:

BINOM.VERT(k; n; p; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer binomialverteilten Zufallsvariablen.

Die Binomialverteilung ist die Wahrscheinlichkeitsverteilung für die Anzahl Treffer (k) bei einem Zufalls-
experiment, das n mal unabhängig wiederholt wird und nur zwei mögliche Ergebnisse hat (Treffer oder
Fehlschlag), wobei die Wahrscheinlichkeit für einen Treffer pro Wiederholung p beträgt.

Sie können mit dieser Funktion beispielsweise ermitteln, wie groß die Wahrscheinlichkeit ist, bei 10
Münzwürfen genau 4 Mal "Kopf" zu erhalten.

k ist die Anzahl an Treffern, hier also 4. k muss größer gleich Null und kleiner gleich n sein.

n ist die Zahl der Wiederholungen, hier also 10.

n und k sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen automa-
tisch weg.

p ist die Trefferwahrscheinlichkeit pro Wiederholung, hier also die Wahrscheinlichkeit "Kopf" zu erhalten,
sprich 50%.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert. BINOM.VERT ermittelt also die Wahrscheinlichkeit, dass
es genau k Treffer gibt.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert. BINOM.VERT ermittelt also die Wahr-
scheinlichkeit, dass es höchstens k Treffer gibt. 

Beispiel:

Greifen wir obiges Beispiel auf: 

Wie groß ist die Wahrscheinlichkeit, bei 10 Münzwürfen genau 4 Mal "Kopf" zu werfen (bei p=50%)?

BINOM.VERT(4; 10; 50%; FALSCH) ergibt 0,20508 =20,5%

Wie groß ist die Wahrscheinlichkeit, höchstens 4 Mal "Kopf" zu werfen?

Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument Kumuliert mit WAHR
angeben):

BINOM.VERT(4; 10; 50%; WAHR) ergibt 0,37695 =37,7%
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

BINOMVERT/BINOM.VERT.BEREICH, BINOM.INV/KRITBINOM, B, KOMBINATIONEN,
NEGBINOM.VERT/NEGBINOMVERT, POISSON.VERT/POISSON

BINOM.VERT.BEREICH (Binomialverteilung)

Syntax:

BINOM.VERT.BEREICH(n; p; k1 [;k2])

Beschreibung:

Liefert die Erfolgswahrscheinlichkeit eines Versuchs als Binomialverteilung.

n ist die Zahl der Wiederholungen. n muss größer gleich Null sein.

p ist die Trefferwahrscheinlichkeit pro Wiederholung. p muss größer gleich Null und kleiner gleich 1 sein.
(0=0% ; 1=100%)

k1 ist die Anzahl an Treffern. k1 muss größer gleich Null und kleiner gleich n sein.

k2 ist optional und errechnet die Wahrscheinlichkeit, mit der die Anzahl von Treffern zwischen k1 und k2
liegt. k2 muss größer gleich k1 und kleiner gleich n sein.

n und k1;k2 sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen auto-
matisch weg.

Anmerkung:

Wenn das optionale Argument k2 weggelassen wird, errechnet sich die Wahrscheinlichkeit der genauen
Anzahl an Treffern.

Beispiel:

Wie groß ist die Wahrscheinlichkeit, bei 10 Münzwürfen genau 4 Mal "Kopf" zu werfen (bei p=50%)?

BINOM.VERT.BEREICH(10; 50%; 4) ergibt 0,20508 =20,5%

Wie groß ist die Wahrscheinlichkeit, zwischen 4 und 8 Mal "Kopf" zu werfen?

BINOM.VERT.BEREICH(10; 50%; 4; 8) ergibt 0,81738 =81,7%



451Formeln und Funktionen

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

BINOMVERT/BINOM.VERT, BINOM.INV/KRITBINOM, B, KOMBINATIONEN,
NEGBINOM.VERT/NEGBINOMVERT, POISSON.VERT/POISSON

BLATT (Laufende Nummer eines Arbeitsblatts)

Syntax:

BLATT([Blattname])

Beschreibung:

Liefert die laufende Nummer eines Arbeitsblatts in der Arbeitsmappe zurück. Das erste Blatt hat die Num-
mer 1, das zweite die Nummer 2 etc.

Wenn das optionale Argument Blattname nicht angegeben ist, liefert die Funktion die Nummer des aktuel-
len Arbeitsblatts, ansonsten die des Blatts mit dem angegebenen Namen.

Hinweis:

Die Funktion BLATT ersetzt die (nahezu) identische Funktion BLATTNUMMER

Hintergrund: Die Funktion BLATTNUMMER war früher nur in PlanMaker, nicht aber in Excel vorhanden.
In Excel 2013 hat Microsoft ebenfalls eine solche Funktion eingeführt – allerdings unter einem anderen Na-
men: BLATT.

Es gibt nur einen Unterschied: Wenn der übergebene Parameter ein Zellbezug ist, so liefert BLATT die
Nummer des Arbeitsblatts, das diesen Bezug enthält. BLATTNUMMER hingegen liest den Inhalt der refe-
renzierten Zelle aus und liefert dann die Nummer des Arbeitsblatts mit diesem Namen.

Beispiel:

Beim dritten Arbeitsblatt in einer Arbeitsmappe gilt: BLATT() ergibt 3.

BLATT("Kosten") liefert die laufende Nummer des Arbeitsblatts mit dem Namen "Kosten".

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.
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Siehe auch:

BLATTNUMMER, BLATTNAME, DATEINAME 

BLATTNAME (Name eines Arbeitsblatts)

Syntax:

BLATTNAME([n])

Beschreibung:

Liefert den Namen eines Arbeitsblatts.

Wenn das optionale Argument n nicht angegeben ist, liefert die Funktion den Namen des aktuellen Arbeits-
blatts, ansonsten den des n-ten Blattes (von links nach rechts).

Beispiel:

Ein Dokument erhält vier Arbeitsblätter: "Frühling", "Sommer", "Herbst" und "Winter" (in dieser Reihen-
folge). Die Schreibmarke befindet sich gerade in einer Zelle der dritten Tabelle ("Herbst"). Dann gilt:

BLATTNAME() ergibt Herbst

BLATTNAME(1) ergibt Frühling

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Siehe auch:

BLATT, DATEINAME

BLATTNUMMER (Kompatibilitätsfunktion)

Syntax:

BLATTNUMMER([Blattname])

Beschreibung:

Kompatibilitätsfunktion für ältere PlanMaker-Dokumente. 
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Diese Funktion wurde durch die (nahezu) identische Funktion BLATT ersetzt 

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Tipp: Verwenden Sie statt dieser Funktion künftig die Excel 2013-kompatible Funktion BLATT. 

Siehe auch:

BLATT, BLATTNAME

BOGENMASS (Grad in Bogenmaß umwandeln)

Syntax:

BOGENMASS(Zahl)

Beschreibung:

Wandelt einen in Grad vorliegenden Winkel ins Bogenmaß (Radiant) um.

Die Formel für die Umrechnung lautet: 

BOGENMASS(x) = x * PI() / 180

Beispiel:

BOGENMASS(180) ergibt 3,14159... (den Wert der Kreiszahl Pi)

Siehe auch:

GRAD

BW (Barwert)

Syntax:

BW(Zins; Zzr; Rmz [; Zw] [; Fälligkeit])

Beschreibung:

Liefert den Barwert einer Einlage, basierend auf einer Investition mit regelmäßigen konstanten Zahlungen
und feststehendem Zins.
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Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Rmz = Annuität (Betrag, der pro Periode gezahlt wird)

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zahlung erreichen möchten.
Wenn Sie das Argument Zw nicht angeben, wird es auf Null gesetzt.

Fälligkeit (optional) = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Beispiel:

BW(6,5%/12; 12*10; 650) ergibt -57244,52

Diese Formel berechnet den Barwert eines Darlehens mit einem Zinssatz von 6,5% (pro Jahr, deshalb die
Teilung durch 12), einer Laufzeit von 10 Jahren (=12*10 Monate) und einer Annuität von 650 Euro (pro
Monat).

Siehe auch:

KAPZ, NBW, RMZ, ZINS, ZINSZ, ZW, ZZR

CHIINV (Quantile einer Chi-Quadrat-Verteilung)

Hinweis: CHIINV wird durch die neue identische Funktion CHIQU.INV.RE ergänzt, die in neueren Ver-
sionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

CHIINV(Wahrscheinlichkeit; Freiheitsgrade)

Beschreibung:

Liefert Quantile einer rechtsseitigen Chi-Quadrat-Verteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Chi-Quadrat-Verteilung. Zulässig sind nur
Werte aus dem Intervall [0..1].

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 oder größer als
10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastel-
len automatisch ab.
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Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Siehe auch:

CHIQU.INV.RE, CHIQU.TEST/CHITEST, CHIQU.VERT.RE/CHIVERT

CHIQU.INV.RE (Quantile einer Chi-Quadrat-Verteilung)

Syntax:

CHIQU.INV.RE(Wahrscheinlichkeit; Freiheitsgrade)

Beschreibung:

Liefert Quantile einer rechtsseitigen Chi-Quadrat-Verteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Chi-Quadrat-Verteilung. Zulässig sind nur
Werte aus dem Intervall [0..1].

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 oder größer als
10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastel-
len automatisch ab.

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

CHIINV, CHIQU.TEST/CHITEST, CHIQU.VERT.RE/CHIVERT 
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CHIQU.TEST (Chi-Quadrat-Unabhängigkeitstest)

Syntax:

CHIQU.TEST(BeobachteteWerte; ErwarteteWerte)

Beschreibung:

Liefert die Teststatistik eines Chi-Quadrat-Unabhängigkeitstests. 

Ein Chi-Quadrat-Test liefert ein allgemeines Kriterium für die Übereinstimmung der Grundgesamtheit mit
einer Stichprobe.

Für BeobachteteWerte sind die beobachteten Werte anzugeben; für ErwarteteWerte die erwarteten Wer-
te.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

CHITEST, CHIQU.INV.RE/CHIINV, CHIQU.VERT.RE/CHIVERT 

CHIQU.VERT.RE (Chi-Quadrat-Verteilung)

Syntax:

CHIQU.VERT.RE(X; Freiheitsgrade)

Beschreibung:

Liefert Werte der rechtsseitigen Verteilungsfunktion einer Chi Quadrat-verteilten Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 oder größer als
10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastel-
len automatisch ab.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.



457Formeln und Funktionen

Siehe auch:

CHIVERT, CHIQU.INV.RE/CHIINV, CHIQU.TEST/CHITEST

CHITEST (Chi-Quadrat-Unabhängigkeitstest)

Hinweis: CHITEST wird durch die neue identische Funktion CHIQU.TEST ergänzt, die in neueren Ver-
sionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

CHITEST(BeobachteteWerte; ErwarteteWerte)

Beschreibung:

Liefert die Teststatistik eines Chi-Quadrat-Unabhängigkeitstests. 

Ein Chi-Quadrat-Test liefert ein allgemeines Kriterium für die Übereinstimmung der Grundgesamtheit mit
einer Stichprobe.

Für BeobachteteWerte sind die beobachteten Werte anzugeben; für ErwarteteWerte die erwarteten Wer-
te.

Siehe auch:

CHIQU.TEST, CHIQU.INV.RE/CHIINV, CHIQU.VERT.RE/CHIVERT

CHIVERT (Chi-Quadrat-Verteilung)

Hinweis: CHIVERT wird durch die neue identische Funktion CHIQU.VERT.RE ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

CHIVERT(X; Freiheitsgrade)

Beschreibung:

Liefert Werte der rechtsseitigen Verteilungsfunktion einer Chi Quadrat-verteilten Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.
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Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 oder größer als
10^10 sein. Erwartet wird eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastel-
len automatisch ab.

Siehe auch:

CHIQU.VERT.RE, CHIQU.INV.RE/CHIINV, CHIQU.TEST/CHITEST 

CODE (ANSI-Code eines Zeichens)

Syntax:

CODE(Zeichenkette)

Beschreibung:

Liefert den ANSI-Code des ersten Zeichens der übergebenen Zeichenkette.

Beispiel:

CODE("A") ergibt 65

CODE("Arthur") ergibt ebenfalls 65

CODE(ZEICHEN(123)) ergibt 123

CODE("") ergibt 0

Siehe auch:

ZEICHEN

COS (Cosinus)

Syntax:

COS(Zahl)

Beschreibung:

Liefert den Cosinus eines Winkels. 

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben.
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Tipp:

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel ins Bogenmaß umrechnen.

Beispiel:

COS(PI()) ergibt -1

COS(BOGENMASS(180)) ergibt -1

Siehe auch:

ARCCOS, SIN, TAN

COSHYP (Cosinus Hyperbolicus)

Syntax:

COSHYP(Zahl)

Beschreibung:

Die Funktion COSHYP (= Cosinus Hyperbolicus) liefert den hyperbolischen Cosinus einer Zahl.

Beispiel:

COSHYP(0,1) ergibt 1,005

Siehe auch:

ARCCOSHYP, SINHYP, TANHYP

COT (Cotangens)

Syntax:

COT(Zahl)

Beschreibung:

Liefert den Cotangens eines Winkels. 

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben.
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Tipp:

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel ins Bogenmaß umrechnen.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

COT(PI()/4) ergibt 1

COT(BOGENMASS(45)) ergibt 1

Siehe auch:

TAN, ARCCOT

COTHYP (Cotangens Hyperbolicus)

Syntax:

COTHYP(Zahl)

Beschreibung:

Die Funktion COTHYP (= Cotangens Hyperbolicus) liefert den hyperbolischen Cotangens einer Zahl.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

COTHYP(0,45) ergibt 2,37024

Siehe auch:

ARCCOTHYP, TANHYP



461Formeln und Funktionen

DATEDIF (Datumsdifferenz)

Syntax:

DATEDIF(Ausgangsdatum; Enddatum; Modus)

Beschreibung:

Berechnet die Differenz zwischen zwei Daten, wahlweise in Tagen, Monaten oder Jahren.

Ausgangsdatum und Enddatum sind die beiden Daten. Das Ausgangsdatum muss vor dem Enddatum lie-
gen.

Modus bestimmt, auf welche Weise und in welcher Einheit die Differenz zwischen Ausgangsdatum und
Enddatum berechnet werden soll:

"y" Zahl der vergangenen Jahre

"m" Zahl der vergangenen Monate

"d" Zahl der vergangenen Tage

"ym" Zahl der Monate, wenn man die Tage und Jahre der Datumsangaben ignoriert

"yd" Zahl der Tage, wenn man die Jahre der Datumsangaben ignoriert

"md" Zahl der Tage, wenn man die Monate und Jahre der Datumsangaben ignoriert

Hinweis:

Dies ist eine undokumentierte Excel-Funktion. Sie wurde aus der Hilfe von Microsoft Excel wieder entfernt
und wird von daher – zumindest offiziell – nicht mehr von Excel unterstützt.

Beispiel:

In A1 steht das Geburtsdatum einer Person (z.B. der 3.4.1970). In A2 steht das zu vergleichende Datum
(z.B. der 8.6.2012). 

Folgendermaßen berechnen Sie das Alter der Person:

In Jahren:
DATEDIF(A1; A2; "y") ergibt 42 (Jahre)

In Monaten:
DATEDIF(A1; A2; "m") ergibt 506 (Monate)

In Tagen:
DATEDIF(A1; A2; "d") ergibt 15407 (Tage)

In Jahren, Monaten und Tagen:
DATEDIF(A1; A2; "y") ergibt 42 (Jahre)
DATEDIF(A1; A2; "ym") ergibt 2 (Monate)
DATEDIF(A1; A2; "md") ergibt 5 (Tage)
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(Die Person ist also 42 Jahre, 2 Monate und 5 Tage alt.)

Siehe auch:

JETZT, NETTOARBEITSTAGE, TAGE/TAGEP

DATEINAME (Dateiname des Dokuments)

Syntax:

DATEINAME([Mit_Pfad])

Beschreibung:

Liefert den Dateinamen des aktuellen Dokuments.

Der Wahrheitswert Mit_Pfad bestimmt, ob auch der Pfad (Laufwerk und Verzeichnis) ausgegeben werden
sollen:

FALSCH oder nicht angegeben: ohne Pfad

WAHR: mit Pfad

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

Speichern Sie ein Dokument im Verzeichnis c:\Dokumente unter dem Dateinamen Umsätze.pmdx ab, so
gilt in diesem Dokument:

DATEINAME() ergibt Umsätze.pmdx

DATEINAME(WAHR) ergibt c:\Dokumente\Umsätze.pmdx

Siehe auch:

BENUTZERFELD, BLATT, BLATTNAME, ZELLE

DATUM (Datumswert bilden)

Syntax:

DATUM(Jahr; Monat; Tag)
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Beschreibung:

Bildet einen Datumswert aus den Argumenten Jahr, Monat und Tag.

Beispiel:

DATUM(2013; 9; 25) ergibt 41542

Dieser Datumswert wird von PlanMaker allerdings automatisch im Zahlenformat "Datum/Zeit" formatiert,
so dass in der Zelle steht: 25.09.2013.

Siehe auch:

DATWERT, ZEIT, ZEITWERT

DATWERT (Text in Datum wandeln)

Syntax:

DATWERT(Zeichenkette)

Beschreibung:

Wandelt eine als Zeichenkette übergebene Datumsangabe in ein Datum (genauer gesagt: in eine serielle Da-
tumszahl) um. 

Hinweis:

Diese Funktion ist nur aus Kompatibilitätsgründen zu älteren Tabellenkalkulationen noch vorhanden.
PlanMaker selbst benötigt sie nicht mehr, da er Daten, die als Text angegeben sind, bei Bedarf automatisch
in ein Datum umwandelt.

Beispiel:

DATWERT("25.09.2013") ergibt die serielle Datumszahl 41542.

Formatieren Sie diese nun mit dem Menübefehl Format > Zelle in einem der Datum/Zeit-Formate (zum
Beispiel T.M.JJ), so wird in der Zelle das Datum angezeigt, das sich hinter diesem Wert verbirgt: der
25.9.2013. 

Siehe auch:

ZEITWERT, DATUM, ZEIT
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DBANZAHL (Datenbankfunktion)

Syntax:

DBANZAHL(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Ermittelt die Anzahl der Zellen in einem Datenbankbereich, die den im Suchkriterienbereich angegebenen
Bedingungen entsprechen.

Berücksichtigt werden dabei nur Zellen, die Zahlen enthalten. Zellen mit Zeichenketten und Wahrheitswer-
ten werden ignoriert.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Wenn das Argument Spalte nicht leer ist, berücksichtigt die Funktion nur Zellen aus der entsprechenden
Spalte. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszei-
chen angeben (zum Beispiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

DBANZAHL2

DBANZAHL2 (Datenbankfunktion)

Syntax:

DBANZAHL2(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Ermittelt die Anzahl der Zellen in einem Datenbankbereich, die den im Suchkriterienbereich angegebenen
Bedingungen entsprechen.

Im Gegensatz zur Datenbankfunktion DBANZAHL berücksichtigt DBANZAHL2 nicht nur Zellen mit Zah-
lenwerten, sondern beliebige Zellen – also auch Zellen mit Zeichenketten und Wahrheitswerten.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.
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Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Wenn das Argument Spalte nicht leer ist, berücksichtigt die Funktion nur Zellen aus der entsprechenden
Spalte. Sie können entweder die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszei-
chen angeben (zum Beispiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

DBANZAHL

DBAUSZUG (Datenbankfunktion)

Syntax:

DBAUSZUG(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert genau den Wert aus einer Spalte eines Datenbankbereichs, der den im Suchkriterienbereich angege-
benen Bedingungen entspricht.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Hinweis:

Es darf nur eine einzige Zeile die Suchbedingungen erfüllen; andernfalls liefert die Funktion den Fehlerwert
#ZAHL.
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DBMAX (Datenbankfunktion)

Syntax:

DBMAX(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert den größten Wert aus einer Spalte eines Datenbankbereichs, der den im Suchkriterienbereich ange-
gebenen Bedingungen entspricht.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

MAX, DBMIN

DBMIN (Datenbankfunktion)

Syntax:

DBMIN(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert den kleinsten Wert aus einer Spalte eines Datenbankbereichs, der den im Suchkriterienbereich ange-
gebenen Bedingungen entspricht.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).



467Formeln und Funktionen

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

MIN, DBMAX

DBMITTELWERT (Datenbankfunktion)

Syntax:

DBMITTELWERT(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert den Mittelwert der Werte aus einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich
angegebenen Bedingungen entsprechen.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

MITTELWERT, DBPRODUKT, DBSUMME

DBPRODUKT (Datenbankfunktion)

Syntax:

DBPRODUKT(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert das Produkt der Werte aus einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich
angegebenen Bedingungen entsprechen.
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Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

PRODUKT, DBMITTELWERT, DBSUMME

DBSTDABW (Datenbankfunktion)

Syntax:

DBSTDABW(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert einen Schätzwert für die Standardabweichung der Grundgesamtheit, basierend auf den Werten aus
einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich angegebenen Bedingungen entspre-
chen.

Die Funktion geht davon aus, dass die ermittelten Werte eine Stichprobe aus der Grundgesamtheit darstel-
len. Ausgehend davon wird die Standardabweichung geschätzt.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

STABW.S/STABW, DBSTDABWN
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DBSTDABWN (Datenbankfunktion)

Syntax:

DBSTDABWN(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert die Standardabweichung einer Grundgesamtheit, basierend auf den Werten aus einer Spalte eines
Datenbankbereichs, die den im Suchkriterienbereich angegebenen Bedingungen entsprechen.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

STABW.N/STABWN, DBSTDABW 

DBSUMME (Datenbankfunktion)

Syntax:

DBSUMME(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert die Summe der Werte aus einer Spalte eines Datenbankbereichs, die den im Suchkriterienbereich an-
gegebenen Bedingungen entsprechen.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).
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Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

SUMME, DBMITTELWERT, DBSUMME

DBVARIANZ (Datenbankfunktion)

Syntax:

DBVARIANZ(Datenbankbereich; Spalte; Suchkriterienbereich)

Beschreibung:

Liefert einen Schätzwert für die Varianz der Grundgesamtheit, basierend auf den Werten aus einer Spalte
eines Datenbankbereichs, die den im Suchkriterienbereich angegebenen Bedingungen entsprechen.

Die Funktion geht davon aus, dass die ermittelten Werte eine Stichprobe aus der Grundgesamtheit darstel-
len. Ausgehend davon wird die Varianz geschätzt.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

VAR.S/VARIANZ, DBVARIANZEN

DBVARIANZEN (Datenbankfunktion)

Syntax:

DBVARIANZEN(Datenbankbereich; Spalte; Suchkriterienbereich)
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Beschreibung:

Liefert die Varianz einer Grundgesamtheit, basierend auf den Werten aus einer Spalte eines Datenbankbe-
reichs, die den im Suchkriterienbereich angegebenen Bedingungen entsprechen.

Ausführliche Informationen zur Verwendung der Datenbankfunktionen finden Sie im Abschnitt Anmerkun-
gen zu den Datenbankfunktionen.

Datenbankbereich ist der Zellbereich, der die Datenbank enthält. Die erste Zeile muss Beschriftungen für
die Spalten enthalten (zum Beispiel Menge, Preis etc.).

Spalte gibt die Spalte des Datenbankbereichs an, aus der Daten geliefert werden sollen. Sie können entwe-
der die Spaltennummer oder die Spaltenbeschriftung in doppelten Anführungszeichen angeben (zum Bei-
spiel "Menge", "Preis" etc.).

Suchkriterienbereich ist der Zellbereich, der die zu erfüllenden Suchbedingungen enthält. Auch hier muss
die erste Zeile Beschriftungen für die Spalten enthalten (also ebenfalls Menge, Preis etc.).

Siehe auch:

VAR.P/VARIANZEN, DBVARIANZ

DELTA (Prüfen auf Gleichheit zweier Werte)

Syntax:

DELTA(Wert1; Wert2)

Beschreibung:

Prüft, ob zwei Zahlenwerte gleich sind. Ist dies der Fall, liefert die Funktion 1, ansonsten 0.

Wert1 und Wert2 müssen Zahlen sein. Auch Zeichenketten, die ausschließlich eine Zahl enthalten, sind zu-
lässig. 

Beispiel:

DELTA(1; 2) ergibt 0

DELTA(2; 2) ergibt 1

DELTA(2; "2") ergibt 1

DELTA("Text"; "Text") ergibt den Fehlerwert #WERT!

Siehe auch:

IDENTISCH



472Formeln und Funktionen

DEZIBEL (Dezibelwert zweier Größen)

Syntax:

DEZIBEL(P2 [; P1])

Beschreibung:

Berechnet den Dezibelwert (dB) für das Verhältnis zweier Größen. 

Der Berechnung liegt folgende Formel zugrunde:

DEZIBEL(P2; P1) = 10 * LOG10(P2/P1)

Hinweis: Achten Sie dabei auf die Reihenfolge der Parameter: Erst muss der Zähler P2 des Quotienten
übergeben werden, dann der Nenner P1 – nicht umgekehrt.

P2 und P1 müssen Zahlen sein. Ihr Quotient muss größer als Null sein.

Der Parameter P1 ist optional. Wird er nicht angegeben, setzt PlanMaker ihn automatisch auf 1 (eins).

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

DEZIBEL(1000; 10) ergibt 20

DEZIMAL (Zahl aus anderem Zahlensystem umwandeln)

Syntax:

DEZIMAL(Zahl; Basis)

Beschreibung:

Wandelt eine Zahl von einem Zahlensystem mit einer anderen Basis in eine Dezimalzahl (Basis 10) um – al-
so beispielsweise eine Binärzahl (Basis 2) oder eine Hexadezimalzahl (Basis 16). 

Zahl ist die umzuwandelnde Zahl.

Basis ist die Basis der umzuwandelnden Zahl. Es sind nur ganze Zahlen zwischen 2 und 36 erlaubt.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

DEZIMAL("00101010"; 2) ergibt 42

DEZIMAL("FF"; 16) ergibt 255

Siehe auch:

BASIS, BININDEZ, HEXINDEZ, OKTINDEZ 

DEZINBIN (Dezimalzahl in Binärzahl wandeln)

Syntax:

DEZINBIN(Zahl [; Stellen])

Beschreibung:

Wandelt eine Dezimalzahl (Basis 10) in eine Binärzahl (Basis 2) um.

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, keine Zahl. 

Zahl ist die umzuwandelnde Zahl.

Der zulässige Wertebereich für Zahl ist:

-(2^31) £ Zahl £ (2^31)-1

Das entspricht:

-2.147.483.648 £ Zahl £ 2.147.483.647

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert (siehe letztes Beispiel).
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Beispiel:

DEZINBIN(42) ergibt 101010

DEZINBIN(42; 8) ergibt 00101010

DEZINBIN(42; 4) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 binär nur mit mindestens 6 Stellen darge-
stellt werden kann

DEZINBIN(-42) ergibt 11111111111111111111111111010110

Siehe auch:

BININDEZ, DEZINHEX, DEZINOKT, BASIS 

DEZINHEX (Dezimalzahl in Hexadezimalzahl wandeln)

Syntax:

DEZINHEX(Zahl [; Stellen])

Beschreibung:

Wandelt eine Dezimalzahl (Basis 10) in eine Hexadezimalzahl (Basis 16) um.

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, keine Zahl. 

Zahl ist die umzuwandelnde Zahl.

Der zulässige Wertebereich für Zahl ist:

-(2^31) £ Zahl £ (2^31)-1

Das entspricht:

-2.147.483.648 £ Zahl £ 2.147.483.647

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert (siehe letztes Beispiel).

Beispiel:

DEZINHEX(42) ergibt 2A
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DEZINHEX(42; 8) ergibt 0000002A

DEZINHEX(42; 1) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 hexadezimal nur mit mindestens 2 Stel-
len dargestellt werden kann

DEZINHEX(-42) ergibt FFFFFFD6

Siehe auch:

HEXINDEZ, DEZINBIN, DEZINOKT, BASIS 

DEZINOKT (Dezimalzahl in Oktalzahl wandeln)

Syntax:

DEZINOKT(Zahl [; Stellen])

Beschreibung:

Wandelt eine Dezimalzahl (Basis 10) in eine Oktalzahl (Basis 8) um.

Hinweis: Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist, keine Zahl. 

Zahl ist die umzuwandelnde Zahl.

Der zulässige Wertebereich für Zahl ist:

-(2^31) £ Zahl £ (2^31)-1

Das entspricht:

-2.147.483.648 £ Zahl £ 2.147.483.647

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert (siehe letztes Beispiel).

Beispiel:

DEZINOKT(42) ergibt 52

DEZINOKT(42; 8) ergibt 00000052

DEZINOKT(42; 1) ergibt den Fehlerwert #ZAHL!, da die Zahl 42 oktal nur mit mindestens 2 Stellen darge-
stellt werden kann



476Formeln und Funktionen

DEZINOKT(-42) ergibt 37777777726

Siehe auch:

OKTINDEZ, DEZINBIN, DEZINHEX, BASIS 

DIA (Arithmetisch-degressive Abschreibung)

Syntax:

DIA(AW; RW; ND; ZR)

Beschreibung:

Liefert die arithmetisch-degressive Abschreibung eines Objekts über einen bestimmten Zeitraum.

Die Funktion erwartet folgende Argumente:

AW = Anschaffungskosten des Objekts

RW = Restwert des Objekts am Ende der Nutzungsdauer

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben wird)

ZR = Zeitraum (in der gleichen Einheit wie ND anzugeben)

Hinweis:

Diese Funktion ist auf das deutsche Steuerrecht nur bedingt anwendbar!

Beispiel:

Bei einer für € 200.000,- erworbenen Maschine, die 10 Jahre genutzt wird und einen Restwert von €
10.000,- hat, gilt für das erste Jahr folgender jahresbezogener Abschreibungsbetrag:

DIA(200000; 10000; 10; 1) ergibt 34545,45 Euro

Siehe auch:

GDA, GDA2, LIA

EDATUM (Datum in/vor n Monaten)

Syntax:

EDATUM(Ausgangsdatum; m)
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Beschreibung:

Ermittelt das Datum, das m Monate vor/nach dem Datum Ausgangsdatum liegt. Sie können damit Termine
ermitteln, die auf denselben Tag eines anderen Monats fallen.

Mit dem Argument m geben Sie die Zahl der Monate an.

Wenn m positiv ist, wird das Datum berechnet, das m Monate hinter dem Ausgangsdatum liegt.

Wenn m negativ ist, erhalten Sie das Datum, das m Monate vor dem Ausgangsdatum liegt.

m sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nachkommastellen automa-
tisch.

Beispiel:

EDATUM("30.03.2018"; 1) ergibt 30.04.2018

EDATUM("31.03.2018"; 1) ergibt ebenfalls 30.04.2018, da der April nur 30 Tage hat.

Siehe auch:

MONATSENDE

EFFEKTIV (Effektivzins)

Syntax:

EFFEKTIV(NomZins; Zinsgutschriften)

Beschreibung:

Ermittelt den effektiven Jahreszins, ausgehend vom nominalen Jahreszins und der Zahl der Zinsgutschriften
pro Jahr.

NomZins ist der nominale Jahreszins.

Zinsgutschriften ist die Zahl der Zinsgutschriften pro Jahr (muss mindestens 1 sein).

Hinweis:

Diese Funktion berechnet nicht den effektiven Jahreszins gemäß der deutschen Preisangabenverordnung
(PAngV). Sie berücksichtigt keinerlei Gebühren, Provisionen etc., sondern schlägt lediglich die über das
Jahr anfallenden Zinseszinsen auf den Nominalzins auf.

Beispiel:

Eine Geldanlage bietet 5% nominalen Jahreszins, Zinsen werden 4x pro Jahr gutgeschrieben. Wie hoch liegt
der effektive Jahreszins?

EFFEKTIV(5%; 4) ergibt ca. 5,09%
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Siehe auch:

NOMINAL

ERSETZEN (Text in Zeichenkette ersetzen)

Syntax:

ERSETZEN(Zeichenkette; Start; Anzahl; Ersatztext)

Beschreibung:

Ersetzt einen bestimmten Teil einer Zeichenkette durch anderen Text.

Zeichenkette ist die ursprüngliche Zeichenkette.

Start ist die Position des ersten Zeichens, das ersetzt werden soll.

Anzahl ist die Zahl der Zeichen, die ersetzt werden.

Ersatztext ist der neue Text.

Beispiel:

ERSETZEN ("aaaaaa"; 3; 2; "bb") ergibt aabbaa

ERSETZEN ("aaaaaa"; 3; 4; "bb") ergibt aabb

ERSETZEN ("cccccc"; 3; 2; "dddddddd") ergibt ccddcc

ERSETZEN ("cccccc"; 3; 4; "dddddddd") ergibt ccdddd

ERSETZEN ("cccccc"; 3; 6; "dddddddd") ergibt ccdddddd

Siehe auch:

FINDEN, SUCHEN, TEIL, WECHSELN, LINKS, RECHTS, WIEDERHOLEN

ERSTELLDATUM (Datum des Erstellens eines Dokuments)

Syntax:

ERSTELLDATUM()

Beschreibung:

Liefert das Datum und die Uhrzeit des Zeitpunkts, an dem das aktuelle Dokument erstellt wurde.
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Beispiel:

Wurde ein Dokument am 31.07.2018 um 16:03 erstellt, so gilt:

ERSTELLDATUM() = 31.07.18 16:03

Tipp: Über die Auswahl eines geeigneten Datumsformats mit dem Menübefehl Format > Zelle können Sie
bestimmen, ob nur das Datum, nur die Uhrzeit oder beides angezeigt werden soll.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Siehe auch:

JETZT, HEUTE

EUROCONVERT (Euro-Währungen konvertieren)

Syntax:

EUROCONVERT(Zahl; Quellwährung; Zielwährung)

Beschreibung:

Diese Funktion kann die alten Währungen aller EU-Mitgliedsländer umrechnen, die der Währungsunion
beigetreten sind, also die Einheitswährung Euro eingeführt haben.

Sie können mit dieser Funktion folgende Arten von Umrechnungen durchführen:

a) Einen Betrag von einer dieser Währungen in Euro umrechnen – zum Beispiel DM in Euro.

b) Einen Betrag von Euro in eine dieser Währungen umrechnen – zum Beispiel Euro in DM.

c) Einen Betrag von einer dieser Währungen in eine andere umrechnen – und zwar über den Zwischen-
schritt der Umrechnung in den Euro ("Triangulation"). Beispiel: Peseten -> Euro -> DM. Beachten Sie: Bei
dieser Methode können Rundungsfehler (von maximal 0,01) auftreten.

Die Argumente Quellwährung und Zielwährung geben Sie mit Hilfe der Codes in der nachfolgenden Ta-
belle an. Sie können entweder PM-Codes oder ISO-Codes verwenden. 

Hinweis: Microsoft Excel unterstützt bei dieser Funktion nur ISO-Codes. Wenn Ihr Dokument also Excel-
kompatibel sein soll, müssen Sie für die Währungscodes also ausschließlich ISO-Codes (rechte Spalte) ver-
wenden.

Die Groß-/Kleinschreibung der Codes spielt keine Rolle.

Land PM-Code ISO-Code

Alle Euro-Länder (Euro) € EUR

Belgien (Franc) BF BEF
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Deutschland (Mark) DM DEM

Estland (Krone) kr EEK

Finnland (Markka) mk FIM

Frankreich (Franc) F FRF

Griechenland (Drachme) Dr GRD

Irland (Pfund) IR£ IEP

Italien (Lira) L ITL

Lettland (Lats) Ls LVL

Litauen (Litas) Lt LTL

Luxemburg (Franc) LF LUF

Malta (Lira) Lm MTL

Niederlande (Gulden) fl NLG

Österreich (Schilling) öS ATS

Portugal (Escudo) esc PTE

Slowakei (Krone) Sk SKK

Slowenien (Tolar) SIT SIT

Spanien (Peseta) pts ESP

Beispiel:

EUROCONVERT (100; "DM"; "€") rechnet 100 DM in Euro um, ergibt also 51,13 (Euro)

EUROCONVERT (100; "DEM"; "EUR") ist die Excel-kompatible Schreibweise des obigen Beispiels. Das
Ergebnis ist natürlich das Gleiche: 51,13 (Euro)

EUROCONVERT (100; "DEM"; "ATS") ergibt 703,55 (öS)

EXP (e hoch x)

Syntax:

EXP(Zahl)

Beschreibung:

Führt eine Potenzierung der Konstanten e mit der angegebenen Zahl durch, berechnet also ex.

Bei e handelt es sich um die Eulersche Zahl (2,71828...), die Basis des natürlichen Logarithmus.
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Beispiel:

EXP(5) ergibt 148,4132

EXP(LN(0,1234)) ergibt 0,1234

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist LN (natürlicher Logarithmus).

Siehe auch:

LN, LOG, LOG10, POTENZ

EXPONVERT (Exponentialverteilung)

Hinweis: EXPONVERT wird durch die neue identische Funktion EXPON.VERT ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

EXPONVERT(x; Lambda; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer exponentialverteilten Zufallsvariablen.

Mit der Exponentialverteilung können die Zeitintervalle zwischen unabhängigen Ereignissen modelliert
werden (also beispielsweise Wartezeiten).

Wenn beispielsweise bekannt ist, dass durchschnittlich alle drei Minuten ein Kunde an einem Bankschalter
eintrifft, können Sie mit dieser Funktion die Wahrscheinlichkeit berechnen, dass sich nach spätestens zwei
Minuten ein Kunde einfindet.

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer gleich Null sein.

Lambda (l) ist die mittlere Anzahl von Ereignissen pro Zeitintervall. Lambda muss größer als Null sein.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

Siehe auch:

EXPON.VERT, POISSON.VERT/POISSON, WEIBULL.VERT/WEIBULL
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EXPON.VERT (Exponentialverteilung)

Syntax:

EXPON.VERT(x; Lambda; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer exponentialverteilten Zufallsvariablen.

Mit der Exponentialverteilung können die Zeitintervalle zwischen unabhängigen Ereignissen modelliert
werden (also beispielsweise Wartezeiten).

Wenn beispielsweise bekannt ist, dass durchschnittlich alle drei Minuten ein Kunde an einem Bankschalter
eintrifft, können Sie mit dieser Funktion die Wahrscheinlichkeit berechnen, dass sich nach spätestens zwei
Minuten ein Kunde einfindet.

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer gleich Null sein.

Lambda (l) ist die mittlere Anzahl von Ereignissen pro Zeitintervall. Lambda muss größer als Null sein.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

EXPONVERT, POISSON.VERT/POISSON, WEIBULL.VERT/WEIBULL

FAKULTÄT (Fakultät)

Syntax:

FAKULTÄT(Zahl)

Beschreibung:

Liefert x! (die Fakultät von x).

Als Fakultät bezeichnet man das Produkt aller positiven ganzen Zahlen von 1 bis zur angegebenen Zahl.
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Die übergebene Zahl muss größer gleich Null sein. Nachkommastellen werden automatisch abgeschnitten.

Beispiel:

FAKULTÄT(9) entspricht 1*2*3*4*5*6*7*8*9, ergibt also 362880

Siehe auch:

ZWEIFAKULTÄT, MULTINOMIAL, POLYNOMIAL

FALSCH (Wahrheitswert)

Syntax:

FALSCH()

Beschreibung:

Liefert den Wahrheitswert FALSCH.

Siehe auch:

WAHR

FEHLER.TYP (Fehlerwerte abfragen)

Syntax:

FEHLER.TYP(Zelle)

Beschreibung:

Mit dieser Funktion kann abgefragt werden, welche Art von Fehler in einer Zelle auftritt.

Als Argument erwartet die Funktion die Adresse der zu überprüfenden Zelle.

Die Funktion liefert folgende Ergebnisse:

Fehlerwert in der Zelle Ergebnis

Kein Fehler #NV

#FEHLER! 1

#DIV/0! 2
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#WERT! 3

#BEZUG! 4

#NAME? 5

#ZAHL! 6

#NV 7

Informationen zu den einzelnen Fehlerwerten finden Sie im Abschnitt Fehlerwerte.

Beispiel:

In Zelle A1 steht die Berechnung 1/0, in Zelle A2 wird 1/1 berechnet. Hier gilt:

FEHLER.TYP(A1) ergibt 2 (also #DIV/0!)

FEHLER.TYP(A2) ergibt #NV (also kein Fehler)

Die folgende Formel liefert den Text "Fehler!" zurück, wenn in Zelle A1 ein beliebiger Fehler auftritt, an-
sonsten wird der Wert in A1 zurückgeliefert:

WENN(ISTNV(FEHLER.TYP(A1)); A1; "Fehler!")

Siehe auch:

ISTFEHL, ISTFEHLER, ISTNV, NV(), WENNFEHLER, TYP, Abschnitt über Fehlerwerte 

FEIERTAG (Datum von beweglichen Feiertagen)

Syntax:

FEIERTAG(Jahr; Typ)

Beschreibung:

Liefert das Datum von beweglichen christlichen Feiertagen im angegebenen Jahr.

Jahr ist das gewünschte Jahr (als ganze Zahl).

Typ ist eine ganze Zahl, die bestimmt, für welchen Feiertag das Datum geliefert werden soll:

0: Karfreitag

1: Ostersonntag

2: Ostermontag

3: Christi Himmelfahrt

4: Pfingstsonntag

5: Pfingstmontag
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6: Fronleichnam

7: Aschermittwoch 

8: Buß- und Bettag

9: Erster Adventssonntag

Beispiel:

FEIERTAG(2014; 1) ergibt den 20.4.2014 (Ostersonntag 2014)

FEIERTAG(JAHR(HEUTE()); 5) liefert das Datum für den Pfingstmontag im aktuellen Jahr

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Siehe auch:

ARBEITSTAG, NETTOARBEITSTAGE

FEST (Zahl mit festen Nachkommastellen formatieren)

Syntax:

FEST(Zahl [; n] [; Keine_Tausenderpunkte])

Beschreibung:

Konvertiert eine Zahl in eine Zeichenkette. Diese enthält die auf n Stellen gerundete Zahl mit Tausender-
punkten.

Zahl ist die umzuwandelnde Zahl.

Das optionale Argument n bestimmt gewünschte Anzahl an Nachkommastellen. Wird es nicht angegeben,
wird die Zahl auf 2 Nachkommastellen gerundet.

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet wird: Ist n beispielswei-
se -2, wird die Zahl auf ein Vielfaches von Hundert gerundet (siehe letztes Beispiel).

Der optionale Wahrheitswert Keine_Tausenderpunkte bestimmt, ob die Zahl mit Tausenderpunkten for-
matiert werden soll: 

FALSCH oder nicht angegeben: Mit Tausenderpunkten

WAHR: Ohne Tausenderpunkte

Hinweis:

Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist. Um eine Zahl zu runden, ohne sie in
eine Zeichenkette zu wandeln, verwenden Sie eine der Rundungsfunktionen (siehe unten).
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Um eine Zahl nur gerundet anzuzeigen, ohne sie tatsächlich zu runden, können Sie auch den Menübefehl
Format > Zelle verwenden.

Beispiel:

FEST(1234,5678; 2) ergibt die Zeichenkette 1.234,57

FEST(1234,5678; 2; WAHR) ergibt die Zeichenkette 1234,57 (ohne Tausenderpunkte)

FEST(1234,5678; -2) ergibt die Zeichenkette 1.200

Siehe auch:

RUNDEN, ABRUNDEN, AUFRUNDEN, KÜRZEN, TEXT, GANZZAHL

FINDEN (Text in Zeichenkette suchen)

Syntax:

FINDEN(Suchbegriff; Zeichenkette [; Startposition])

Beschreibung:

Ermittelt die Position von Suchbegriff in Zeichenkette.

Mit dem optionalen Argument Startposition können Sie festlegen, ab welcher Position der Zeichenkette ge-
sucht werden soll. Wird es nicht angegeben, beginnt die Suche mit dem ersten Zeichen.

Die Groß-/Kleinschreibung muss hierbei exakt übereinstimmen. Verwenden Sie die Funktion SUCHEN,
wenn die Groß-/Kleinschreibung nicht beachtet werden soll

Beispiel:

FINDEN("a"; "Banane") ergibt 2

FINDEN("A"; "Banane") ergibt den Fehlerwert #WERT!, da ein großes "A" in der Zeichenkette nicht vor-
kommt.

FINDEN("a"; "Banane"; 3) ergibt 4

Siehe auch:

SUCHEN, ERSETZEN, WECHSELN, IDENTISCH, TEIL
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FINV (Quantile einer F-Verteilung)

Hinweis: FINV wird durch die neue identische Funktion F.INV.RE ergänzt, die in neueren Versionen
von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

FINV(Wahrscheinlichkeit; Freiheitsgrade1; Freiheitsgrade2)

Beschreibung:

Liefert Quantile einer rechtsseitigen F-Verteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der F-Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].

Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler.

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner.

Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet wird jeweils eine ganze
Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Siehe auch:

F.INV.RE, F.TEST/FTEST, F.VERT.RE/FVERT

F.INV.RE (Quantile einer F-Verteilung)

Syntax:

F.INV.RE(Wahrscheinlichkeit; Freiheitsgrade1; Freiheitsgrade2)

Beschreibung:

Liefert Quantile einer rechtsseitigen F-Verteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der F-Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].
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Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler.

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner.

Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet wird jeweils eine ganze
Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

FINV, F.TEST/FTEST, F.VERT.RE/FVERT

FISHER (Fisher-Transformation)

Syntax:

FISHER(Zahl)

Beschreibung:

Liefert die Fisher-Transformation für die übergebene Zahl.

Der zulässige Wertebereich für Zahl ist: -1 < Zahl < 1

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist FISHERINV.

Siehe auch:

FISHERINV, KORREL, KOVARIANZ.P/KOVARIANZ.S/KOVAR
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FISHERINV (Umkehrung der Fisher-Transformation)

Syntax:

FISHERINV(Zahl)

Beschreibung:

Liefert die umgekehrte Fisher-Transformation für die übergebene Zahl.

Anmerkung:

Diese Funktion ist die Umkehrfunktion der Funktion FISHER.

Siehe auch:

FISHER, KORREL, KOVARIANZ.P/KOVARIANZ.S/KOVAR

FORMELTEXT (Formel einer Zelle anzeigen)

Syntax:

FORMELTEXT(Zelle)

Beschreibung:

Zeigt die Formel an, die sich in der angegebenen Zelle befindet.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

Wenn die Zelle A1 die Formel =SUMME(D2:D4) enthält, dann liefert FORMELTEXT(A1) den Text
"=SUMME(D2:D4)" zurück.

Siehe auch:

ISTFORMEL 
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FTEST (F-Test)

Hinweis: FTEST wird durch die neue identische Funktion F.TEST ergänzt, die in neueren Versionen von
Microsoft Excel (ab 2010) verwendet wird.

Syntax:

FTEST(Werte1; Werte2)

Beschreibung:

Liefert die Teststatistik eines F-Tests. 

Mit einem F-Test kann die Konsistenz der Varianzen zweier Stichproben geprüft werden.

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben).

Es müssen jeweils mindestens zwei Werte angegeben sein; andernfalls liefert die Funktion den Fehlerwert
#DIV/0! (Division durch Null).

Liegt die Varianz von Werte1 oder Werte2 bei 0, liefert diese Funktion den Fehlerwert #DIV/0!.

Siehe auch:

F.TEST, F.INV.RE/FINV, F.VERT.RE/FVERT 

F.TEST (F-Test)

Syntax:

F.TEST(Werte1; Werte2)

Beschreibung:

Liefert die Teststatistik eines F-Tests. 

Mit einem F-Test kann die Konsistenz der Varianzen zweier Stichproben geprüft werden.

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben).

Es müssen jeweils mindestens zwei Werte angegeben sein; andernfalls liefert die Funktion den Fehlerwert
#DIV/0! (Division durch Null).

Liegt die Varianz von Werte1 oder Werte2 bei 0, liefert diese Funktion den Fehlerwert #DIV/0!.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

FTEST, F.INV.RE/FINV, F.VERT.RE/FVERT 

FVERT (F-Verteilung)

Hinweis: FVERT wird durch die neue identische Funktion F.VERT.RE ergänzt, die in neueren Versio-
nen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

FVERT(X; Freiheitsgrade1; Freiheitsgrade2)

Beschreibung:

Liefert Werte der Verteilungsfunktion einer rechtsseitigen F-verteilten Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.

Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler.

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner.

Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet wird jeweils eine ganze
Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Siehe auch:

F.VERT.RE, F.INV.RE/FINV, F.TEST/FTEST 

F.VERT.RE (F-Verteilung)

Syntax:

F.VERT.RE(X; Freiheitsgrade1; Freiheitsgrade2)

Beschreibung:

Liefert Werte der Verteilungsfunktion einer rechtsseitigen F-verteilten Zufallsvariablen.



492Formeln und Funktionen

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.

Freiheitsgrade1 bestimmt die Zahl der Freiheitsgrade im Zähler.

Freiheitsgrade2 bestimmt die Zahl der Freiheitsgrade im Nenner.

Die Freiheitsgrade dürfen nicht kleiner als 1 oder größer als 10^10 sein. Erwartet wird jeweils eine ganze
Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

FVERT, F.INV.RE/FINV, F.TEST/FTEST 

GAMMA (Gammafunktion)

Syntax:

GAMMA(Zahl)

Beschreibung:

Liefert die Gammafunktion für die übergebene Zahl. 

Zahl muss größer als Null sein.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

GAMMALN, GAMMA.VERT/GAMMAVERT, GAMMA.INV/GAMMAINV

GAMMAINV (Quantile einer Gammaverteilung)

Hinweis: GAMMAINV wird durch die neue identische Funktion GAMMA.INV ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.
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Syntax:

GAMMAINV(Wahrscheinlichkeit; Alpha; Beta)

Beschreibung:

Liefert Quantile einer Gammaverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Gammaverteilung. Zulässig sind nur Wer-
te aus dem Intervall [0..1].

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein.

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Siehe auch:

GAMMA.INV, GAMMA.VERT/GAMMAVERT, GAMMA, GAMMALN

GAMMA.INV (Quantile einer Gammaverteilung)

Syntax:

GAMMA.INV(Wahrscheinlichkeit; Alpha; Beta)

Beschreibung:

Liefert Quantile einer Gammaverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Gammaverteilung. Zulässig sind nur Wer-
te aus dem Intervall [0..1].

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein.

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Anmerkung:

GAMMA.INV ist die Umkehrfunktion von GAMMA.VERT
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Siehe auch:

GAMMAINV, GAMMA.VERT/GAMMAVERT, GAMMA, GAMMALN

GAMMALN (Logarithmus der Gammafunktion)

Syntax:

GAMMALN(Zahl)

Beschreibung:

Liefert den natürlichen Logarithmus der Gammafunktion. 

Zahl muss größer als Null sein.

Siehe auch:

GAMMA, GAMMA.VERT/GAMMAVERT, GAMMA.INV/GAMMAINV

GAMMAVERT (Gammaverteilung)

Hinweis: GAMMAVERT wird durch die neue identische Funktion GAMMA.VERT ergänzt, die in
neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

GAMMAVERT(X; Alpha; Beta; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer gammaverteilten Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X muss größer gleich Null sein.

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.
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Siehe auch:

GAMMA.VERT, GAMMA.INV/GAMMAINV, GAMMA, GAMMALN

GAMMA.VERT (Gammaverteilung)

Syntax:

GAMMA.VERT(X; Alpha; Beta; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer gammaverteilten Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X muss größer gleich Null sein.

Alpha und Beta sind die Formparameter der Funktion. Beide müssen größer als Null sein. 

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist GAMMA.INV

Siehe auch:

GAMMAVERT, GAMMA.INV/GAMMAINV, GAMMA, GAMMALN

GANZZAHL (Runden auf ganze Zahl)

Syntax:

GANZZAHL(Zahl)
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Beschreibung:

Rundet eine Zahl betragsmäßig auf die nächstkleinere ganze Zahl ab.

Hinweis:

Beachten Sie beim Anwenden dieser Funktion auf negative Zahlen den Unterschied zu anderen Rundungs-
funktionen wie zum Beispiel ABRUNDEN:

ABRUNDEN(-1,234; 0) ergibt -1, da hier der Betrag von Zahl auf die nächstkleinere ganze Zahl abgerundet
wird

GANZZAHL(-1,234) ergibt -2, da hier die negative Zahl selbst auf die nächstkleinere ganze Zahl abgerun-
det wird.

Beispiel:

GANZZAHL(5,9) ergibt 5

GANZZAHL(-5,1) ergibt -6

Siehe auch:

KÜRZEN, ABRUNDEN, AUFRUNDEN, RUNDEN, VRUNDEN, FEST, GERADE, UNGERADE,
OBERGRENZE, UNTERGRENZE

GAUSS (Standardnormalverteilung)

Syntax:

GAUSS(x)

Beschreibung:

Liefert das Integral der Funktion PHI (Dichtefunktion einer Standardnormalverteilung) abzüglich 0,5.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Wir empfehlen Ihnen daher, stattdessen die Funktion STANDNORMVERT zu verwenden, da diese von al-
len Excel-Versionen unterstützt wird:

GAUSS(x) entspricht STANDNORMVERT(x) - 0,5

Siehe auch:

PHI, NORM.VERT/NORMVERT, NORM.S.VERT/STANDNORMVERT
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GAUSSFEHLER (Gaußsche Fehlerfunktion)

Syntax:

GAUSSFEHLER(Untergrenze [; Obergrenze])

Beschreibung:

Liefert die Gaußsche Fehlerfunktion.

Untergrenze und Obergrenze (optional) bestimmen die Grenzen des Intervalls, dessen Integralfläche be-
rechnet werden soll. Wird Obergrenze nicht angegeben, wird die Integralfläche von 0 bis Untergrenze be-
rechnet.

Siehe auch:

GAUSSFKOMPL

GAUSSFKOMPL (Komplement zur Gaußschen Feh­ler­funk­tion)

Syntax:

GAUSSFKOMPL(Untergrenze)

Beschreibung:

Liefert das Komplement zur Gaußschen Fehlerfunktion.

Für Untergrenze ist die untere Grenze des Integrals anzugeben. Es sind nur Werte größer gleich Null zuläs-
sig.

Siehe auch:

GAUSSFEHLER

GDA (Geometrisch-degressive Abschreibung)

Syntax:

GDA(AW; RW; ND; P [; Faktor])
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Beschreibung:

Berechnet den Abschreibungsbetrag eines Objekts für eine bestimmte Periode nach der Methode der geome-
trisch-degressiven Doppelraten-Abschreibung.

AW = Anschaffungswert des Objekts

RW = Restwert des Objekts am Ende der Nutzungsdauer

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben wird)

P = Periode, deren Abschreibungsbetrag berechnet werden soll (in der gleichen Einheit wie ND anzugeben)

Faktor (optional) = Rate, um die der jeweilige Buchwert verringert wird. Fehlt dieses Argument, wird Fak-
tor auf 2 gesetzt (Doppelraten-Abschreibung).

Beispiel:

Bei einer für € 200.000,- erworbenen Maschine, die 10 Jahre genutzt wird und dann einen Restwert von €
10.000,- hat, muss für das erste Jahr folgender jahresbezogener Abschreibungsbetrag angesetzt werden:

GDA(200000; 10000; 10; 1) ergibt 40000,- Euro

Siehe auch:

GDA2, DIA, LIA

GDA2 (Geometrisch-degressive Abschreibung)

Syntax:

GDA2(AW; RW; ND; P [; M])

Beschreibung:

Berechnet den Abschreibungsbetrag eines Objekts für eine bestimmte Periode nach der Methode der geome-
trisch-degressiven Abschreibung. 

AW = Anschaffungswert des Objekts

RW = Restwert des Objekts am Ende der Nutzungsdauer

ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben wird)

P = Periode, deren Abschreibungsbetrag berechnet werden soll (in der gleichen Einheit wie ND anzugeben)

M = Zahl der Monate im ersten Jahr (optional). Wird diese nicht angegeben, wird M auf 12 gesetzt.

Beispiel:

GDA2(200000; 10000; 6; 1; 7) ergibt 45850,00
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Siehe auch:

GDA, DIA, LIA

GEOMITTEL (Geometrisches Mittel)

Syntax:

GEOMITTEL(Zahl1 [; Zahl2; Zahl3...])

Beschreibung:

Liefert das einfache geometrische Mittel der übergebenen Zahlen.

Dieses wird durch Ziehen der n-ten Wurzel aus dem Produkt der Einzelwerte ermittelt (n ist die Anzahl der
Werte).

Alle übergebenen Werte müssen größer als Null sein.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Beispiel:

GEOMITTEL(1; 2; 6) ergibt 2,28943

Siehe auch:

HARMITTEL, GESTUTZTMITTEL, MITTELWERT

GERADE (Aufrunden auf eine gerade Zahl)

Syntax:

GERADE(Zahl)

Beschreibung:

Rundet Zahl auf die betragsmäßig nächstgrößere gerade Zahl auf.

Beispiel:

GERADE(42) ergibt 42

GERADE(43) ergibt 44
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GERADE(-43) ergibt -44

Siehe auch:

UNGERADE, AUFRUNDEN, RUNDEN, VRUNDEN, FEST, GANZZAHL, KÜRZEN, OBERGRENZE,
UNTERGRENZE

GESTUTZTMITTEL (Mittelwert ohne Randwerte)

Syntax:

GESTUTZTMITTEL(Datenbereich; Prozentwert)

Beschreibung:

Liefert den Mittelwert einer Datenmenge, blendet dabei jedoch den angegebenen Prozentsatz an Randwer-
ten aus.

Unter "Randwerten" sind die kleinsten und größten Werte einer Datenmenge zu verstehen. Dies sind häufig
"Ausreißer" (untypisch niedrige oder hohe Werte, die zum Beispiel aufgrund eines Messfehlers entstanden
sind). 

Datenbereich ist ein Zellbezug auf die zu untersuchende Datenmenge.

Mit Prozentwert geben Sie an, wie viel Prozent der Randwerte nicht berücksichtigt werden sollen.

Wenn beispielsweise 100 Werte vorliegen und Prozentwert auf 10% gesetzt wurde, werden 10 Werte igno-
riert: die 5 niedrigsten und die 5 höchsten.

Die Zahl der nicht zu berücksichtigen Werte wird stets auf ein Vielfaches von 2 abgerundet, damit gleich
viele niedrige und hohe Werte ausgeblendet werden. Bei einer Datenmenge mit 30 Werten würden bei Pro-
zentwert = 10 also nicht 3, sondern 2 Werte ignoriert.

Beispiel:

In den Zellen A1 bis A10 befinden sich die folgenden 10 Werte: 43, 45, 42, 0, 44, 45, 42, 1234, 40, 41

Wie Sie sehen, befinden sich zwei Ausreißer unter diesen Werten: 0 und 1234. Mit der Funktion
MITTELWERT würden Sie deshalb einen unbrauchbaren Mittelwert erhalten:

MITTELWERT(A1:A10) ergibt 159,2

Verwenden Sie hingegen GESTUTZTMITTEL und blenden beispielsweise 20% der Werte an den Rändern
aus – in diesem Fall sind das günstigerweise genau die beiden Ausreißer unter den 10 Werten –, wird ein
brauchbarer Mittelwert geliefert:

GESTUTZTMITTEL(A1:A10; 20%) ergibt: 42,75

Siehe auch:

MITTELWERT, GEOMITTEL, HARMITTEL
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GGANZZAHL (Zahl größer gleich Schwellenwert?)

Syntax:

GGANZZAHL(Zahl; Schwelle)

Beschreibung:

Diese Funktion liefert 1, wenn Zahl ³ Schwelle ist, ansonsten liefert sie 0.

Beispiel:

GGANZZAHL(41; 42) ergibt 0

GGANZZAHL(42; 42) ergibt 1

GGANZZAHL(42,1; 42) ergibt 1

Siehe auch:

DELTA

GGT (Größter gemeinsamer Teiler)

Syntax:

GGT(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Ermittelt den ggT ("größter gemeinsamer Teiler") einer Menge von Zahlen. Der ggT ist die größte all derje-
nigen ganzen Zahlen, durch die alle Argumente ohne Rest teilbar sind.

Als Argumente können Zahlen oder Zellbezüge übergeben werden.

Alle übergebenen Zahlen müssen größer als Null sein. Weiterhin sollten nur ganze Zahlen verwendet wer-
den. Ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Beispiel:

GGT(25; 100; 250) ergibt 25

GGT(25; 105; 250) ergibt 5

Sind die Zellen A1 bis A3 mit den Werten 4, 8 und 6 gefüllt, so gilt:

GGT(A1:A3) ergibt 2
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Siehe auch:

KGV

GLÄTTEN (Überflüssige Leerzeichen entfernen)

Syntax:

GLÄTTEN(Zeichenkette)

Beschreibung:

Entfernt alle Leerzeichen am Beginn und am Ende einer Zeichenkette.

Beispiel:

GLÄTTEN("    Text  ") ergibt Text

Siehe auch:

SÄUBERN

GRAD (Bogenmaß in Grad umwandeln)

Syntax:

GRAD(Zahl)

Beschreibung:

Wandelt eine Winkelangabe, die im Bogenmaß (Radiant) gegeben ist, in Grad um.

Die Formel für die Umrechnung lautet: 

GRAD(x) = x * 180 / PI()

Beispiel:

GRAD(PI()) ergibt 180

Siehe auch:

BOGENMASS
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GROSS (In Großbuchstaben wandeln)

Syntax:

GROSS(Zeichenkette)

Beschreibung:

Wandelt alle Buchstaben einer Zeichenkette in Großbuchstaben um.

Beispiel:

GROSS("PlanMaker") ergibt PLANMAKER

Siehe auch:

GROSS2, KLEIN

GROSS2 (In Groß-/Kleinbuchstaben wandeln)

Syntax:

GROSS2(Zeichenkette)

Beschreibung:

Wandelt eine Zeichenkette wie folgt um: Buchstaben am Wortanfang werden groß, alle anderen Buchstaben
klein geschrieben.

Beispiel:

GROSS2("guten tag") ergibt Guten Tag

GROSS2("Guten Tag") ergibt Guten Tag

GROSS2("GuTeN TaG") ergibt Guten Tag

Siehe auch:

GROSS, KLEIN
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GTEST (Gauß-Test)

Hinweis: GTEST wird durch die neue identische Funktion G.TEST ergänzt, die in neueren Versionen
von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

GTEST(Datenbereich; x [; Sigma])

Beschreibung:

Liefert die einseitige Prüfstatistik für einen Gauß-Test.

Sie können mit dieser Funktion prüfen, mit welcher Wahrscheinlichkeit eine Stichprobe aus einer bestimm-
ten Grundgesamtheit stammt.

Datenbereich ist ein Zellbezug auf den Datenbereich, gegen den x getestet werden soll. Es sollten mindes-
tens 30 Werte vorliegen.

x ist der zu testende Wert.

Das optionale Argument Sigma ist die Standardabweichung s der Grundgesamtheit (sofern bekannt). Falls
diese nicht angegeben wird, verwendet PlanMaker automatisch die Standardabweichung der gegebenen
Stichprobe (also der Werte in Datenbereich).

Siehe auch:

G.TEST, STANDARDISIERUNG, NORM.VERT/NORMVERT, NORM.S.VERT/STANDNORMVERT

G.TEST (Gauß-Test)

Syntax:

G.TEST(Datenbereich; x [; Sigma])

Beschreibung:

Liefert die einseitige Prüfstatistik für einen Gauß-Test.

Sie können mit dieser Funktion prüfen, mit welcher Wahrscheinlichkeit eine Stichprobe aus einer bestimm-
ten Grundgesamtheit stammt.

Datenbereich ist ein Zellbezug auf den Datenbereich, gegen den x getestet werden soll. Es sollten mindes-
tens 30 Werte vorliegen.

x ist der zu testende Wert.
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Das optionale Argument Sigma ist die Standardabweichung s der Grundgesamtheit (sofern bekannt). Falls
diese nicht angegeben wird, verwendet PlanMaker automatisch die Standardabweichung der gegebenen
Stichprobe (also der Werte in Datenbereich).

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

GTEST, STANDARDISIERUNG, NORM.VERT/NORMVERT, NORM.S.VERT/STANDNORMVERT

HARMITTEL (Harmonisches Mittel)

Syntax:

HARMITTEL(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert das harmonische Mittel der übergebenen Zahlen. 

Dieses ist definiert als der Kehrwert des arithmetischen Mittels der Kehrwerte der Einzelwerte.

Alle übergebenen Werte müssen größer Null sein.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Beispiel:

HARMITTEL(1; 2; 6) ergibt 1,8

Siehe auch:

GEOMITTEL, GESTUTZTMITTEL, MITTELWERT

HÄUFIGKEIT (Häufigkeitsverteilung)

Syntax:

HÄUFIGKEIT(Daten; Grenzen)
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Beschreibung:

Liefert eine Häufigkeitsverteilung. Sie können damit ermitteln, wie viele Werte aus einer Datenmenge sich
innerhalb bestimmter Intervalle befinden.

Das Ergebnis wird in Form einer einspaltigen Matrix geliefert.

Bei Daten sind die auszuwertenden Daten einzutragen. Leere Zellen und Zeichenketten werden ignoriert.

Mit Klassen definieren Sie die zu betrachtenden Intervalle. Geben Sie als Klassen beispielsweise die Ma-
trix {10; 15; 42} ein, liefert die Funktion eine Matrix mit folgenden vier Werten:

1. Die Anzahl der Werte, die <=10 sind.

2. Die Anzahl der Werte, die >10 und <=15 sind.

3. Die Anzahl der Werte, die >15 und <=42 sind.

4. Die Anzahl der Werte, die >42 sind.

Daten und Klassen müssen jeweils eine einspaltige Matrix sein; sie dürfen also nicht mehr als eine Spalte
an Daten enthalten.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Beachten Sie dabei, dass die von dieser Funktion gelieferte Matrix ein Element mehr hat als die Matrix
Klassen. 

Siehe auch:

ANZAHL

HEUTE (Aktuelles Datum)

Syntax:

HEUTE()

Beschreibung:

Liefert das aktuelle Systemdatum (ohne Uhrzeit).

Hinweis:

Das Ergebnis ist – wie alle Datumsangaben in einer Tabellenkalkulation – eine Zahl. PlanMaker weist ihr
automatisch das Datumsformat TT.MM.JJJJ zu, damit sie als Datumswert angezeigt wird. Über den Menü-
befehl Format > Zelle können Sie das angezeigte Datumsformat auf Ihre Wünsche anpassen.
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Beispiel:

HEUTE() ergibt 31.07.2018

Siehe auch:

JETZT, ERSTELLDATUM

HEXINBIN (Hexadezimalzahl in Binärzahl wandeln)

Syntax:

HEXINBIN(Zahl [; Stellen])

Beschreibung:

Wandelt eine Hexadezimalzahl (Basis 16) in eine Binärzahl (Basis 2) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise):

80000000 £ Zahl £ 7FFFFFFF

Das entspricht in Dezimalschreibweise:

-2.147.483.648 £ Zahl £ 2.147.483.647

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert.

Beispiel:

HEXINBIN("2A") ergibt 101010

HEXINBIN("2A"; 8) ergibt 00101010

HEXINBIN("2A"; 2) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindestens 5 Stellen dargestellt
werden kann

HEXINBIN("FFFFFFD6") ergibt 11111111111111111111111111010110 (negative Zahl)
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Siehe auch:

BININHEX, HEXINDEZ, HEXINOKT

HEXINDEZ (Hexadezimalzahl in Dezimalzahl wandeln)

Syntax:

HEXINDEZ(Zahl)

Beschreibung:

Wandelt eine Hexadezimalzahl (Basis 16) in eine Dezimalzahl (Basis 10) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise):

80000000 £ Zahl £ 7FFFFFFF

Das entspricht in Dezimalschreibweise:

-2.147.483.648 £ Zahl £ 2.147.483.647

Beispiel:

HEXINDEZ("2A") ergibt 42

HEXINDEZ("FFFFFFD6") ergibt -42

Siehe auch:

DEZINHEX, HEXINBIN, HEXINOKT, DEZIMAL 

HEXINOKT (Hexadezimalzahl in Oktalzahl wandeln)

Syntax:

HEXINOKT(Zahl [; Stellen])

Beschreibung:

Wandelt eine Hexadezimalzahl (Basis 16) in eine Oktalzahl (Basis 8) um.

Zahl ist die umzuwandelnde Zahl.
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Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Der zulässige Wertebereich für Zahl ist (in hexadezimaler Schreibweise):

80000000 £ Zahl £ 7FFFFFFF

Das entspricht in Dezimalschreibweise:

-2.147.483.648 £ Zahl £ 2.147.483.647

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert.

Beispiel:

HEXINOKT("2A") ergibt 52

HEXINOKT("2A"; 4) ergibt 0052

HEXINOKT("2A"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindestens 2 Stellen dargestellt
werden kann

HEXINOKT("FFFFFFD6") ergibt 37777777726 (negative Zahl)

Siehe auch:

OKTINHEX, HEXINBIN, HEXINDEZ

HYPERLINK (Hyperlink)

Syntax:

HYPERLINK(Zieladresse [; Beschriftung])

Beschreibung:

Zeigt in der Zelle einen Hyperlink (eine Verknüpfung) auf die angegebene Zieladresse an. Als Beschriftung
wird die Zieladresse oder wahlweise der mit dem Parameter Beschriftung übergebene Text angezeigt.

Sie können mit dieser Funktion beispielsweise einen Hyperlink auf eine Webseite einfügen. Klickt der An-
wender diesen an, wird automatisch sein Internet-Browser gestartet und diese Seite darin aufgerufen. 

Weiterhin lassen sich unter anderem Links auf ein anderes PlanMaker-Dokument einfügen, das beim Ankli-
cken dieses Links automatisch geöffnet wird. Siehe Beispiele.
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Zieladresse ist die Adresse, auf die der Link zeigen soll. Zulässig hierfür ist eine feste Zeichenkette, eine
Berechnung oder ein Bezug auf die Zelle, in der sich die gewünschte Zieladresse befindet. Siehe Beispiele.

Beschriftung (optional) ist der Text, der in der Zelle erscheinen soll. Wenn dieser nicht angegeben wird, er-
scheint stattdessen die Zieladresse als Text in der Zelle.

Beispiel:

=HYPERLINK("http://www.softmaker.de")

Obiger Hyperlink öffnet die Adresse www.softmaker.de im Browser.

=HYPERLINK("http://www.softmaker.de"; "Unsere Homepage")

Dito, allerdings wird als Linktext nicht die Zieladresse, sondern der Text "Unsere Homepage" angezeigt.

=HYPERLINK("http://www.softmaker.de#Sprungziel")

Öffnet die Adresse www.softmaker.de im Browser und springt zu der Sprungmarke (dem Anker) namens
"Sprungziel" auf der Seite. Alternativ können Sie hierfür auch die Schreibweise
=HYPERLINK("[http://www.softmaker.de]Sprungziel") verwenden.

=HYPERLINK("c:\Mein Ordner\Dateiname.pmdx")

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmdx in PlanMaker.

Hinweis: Sie können mit dieser Funktion nicht nur PlanMaker-Dateien öffnen, sondern auch beliebige ande-
re Arten von Dokumenten, sofern diesen ein Programm zugewiesen ist, mit dem sie geöffnet werden sollen.

=HYPERLINK("[c:\Mein Ordner\Dateiname.pmdx]Tabelle1!A5")

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmdx in PlanMaker und springt zu der Zelle A5 auf
dem Arbeitsblatt "Tabelle1". Wichtig: Der komplette Dateiname muss dabei mit eckigen Klammern umge-
ben werden. Direkt dahinter ist der Name des Arbeitsblatts, ein Ausrufezeichen und die Zielzelle anzuge-
ben.

=HYPERLINK("[c:\Mein Ordner\Dateiname.pmdx]Tabelle1!MeinBereich")

Obiger Link öffnet die Datei c:\Mein Ordner\Dateiname.pmdx in PlanMaker und springt zur linken oberen
Ecke des benannten Bereichs "MeinBereich" auf dem Arbeitsblatt "Tabelle1".

=HYPERLINK(E1; E2)

Obiger Link öffnet die Zieladresse, die in der Zelle E1 eingetragen ist. Als Linktext wird der Inhalt der Zelle
E2 angezeigt.

Siehe auch:

Der Abschnitt Hyperlinks verwenden beschreibt eine alternative Methode zum Anbringen von Hyperlinks.
Die HYPERLINK-Funktion ist allerdings flexibler in der Anwendung.

HYPGEOMVERT (Hypergeometrische Verteilung)

Hinweis: HYPGEOMVERT wird durch die neue Funktion HYPGEOM.VERT mit zusätzlicher Funktio-
nalität ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.
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Syntax:

HYPGEOMVERT(k; n; K; N)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer hypergeometrisch verteilten Zufallsvariablen.

Die hypergeometrische Verteilung ist die Wahrscheinlichkeitsverteilung für beispielsweise das Ziehen von
k roten Kugeln in einem Zufallsexperiment nach dem Modell der zufälligen Entnahme von n Kugeln (ohne
Zurücklegen) aus einer Urne, die zu Beginn N Kugeln enthält, davon K rote.

k ist die Zahl der Treffer (Treffer = Ziehen einer roten Kugel).

n ist der Umfang der Stichprobe (Zahl der Kugeln, die gezogen werden sollen).

K ist die Zahl der möglichen Treffer innerhalb der Grundgesamtheit (Zahl der anfänglich vorhandenen ro-
ten Kugeln).

N ist der Umfang der Grundgesamtheit (Zahl der anfänglich vorhandenen Kugeln insgesamt).

Alle Argumente sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen
automatisch weg.

Beispiel:

Eine Urne enthält insgesamt 10 Kugeln (N=10), davon 2 rote (K=2). Wie groß ist die Wahrscheinlichkeit,
beim Ziehen von 5 Kugeln (n=5) genau 1 rote Kugel zu erhalten (k=1)?

HYPGEOMVERT(1; 5; 2; 10) ergibt 0,55556

Siehe auch:

HYPGEOM.VERT, NEGBINOM.VERT/NEGBINOMVERT

HYPGEOM.VERT (Hypergeometrische Verteilung)

Syntax:

HYPGEOM.VERT(k; n; K; N; Kumuliert)

Beschreibung:

Liefert die (kumulierten) Wahrscheinlichkeiten einer hypergeometrisch verteilten Zufallsvariablen.

Die hypergeometrische Verteilung ist die Wahrscheinlichkeitsverteilung für beispielsweise das Ziehen von
k roten Kugeln in einem Zufallsexperiment nach dem Modell der zufälligen Entnahme von n Kugeln (ohne
Zurücklegen) aus einer Urne, die zu Beginn N Kugeln enthält, davon K rote.

k ist die Zahl der Treffer (Treffer = Ziehen einer roten Kugel).

n ist der Umfang der Stichprobe (Zahl der Kugeln, die gezogen werden sollen).
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K ist die Zahl der möglichen Treffer innerhalb der Grundgesamtheit (Zahl der anfänglich vorhandenen ro-
ten Kugeln).

N ist der Umfang der Grundgesamtheit (Zahl der anfänglich vorhandenen Kugeln insgesamt).

Kumuliert bestimmt als Schalter die Art der Funktion: Gibt man den Wert WAHR ein, wird die kumulierte
Verteilungsfunktion der hypergeometrischen Verteilung berechnet. Durch Eingabe von Wert FALSCH be-
rechnet sich die Dichtefunktion der hypergeometrischen Verteilung.

Alle Argumente sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen
automatisch weg.

Beispiel:

Eine Urne enthält insgesamt 10 Kugeln (N=10), davon 2 rote (K=2). Wie groß ist die Wahrscheinlichkeit,
beim Ziehen von 5 Kugeln (n=5) genau bzw. höchstens 1 rote Kugel zu erhalten (k=1)?

HYPGEOM.VERT(1; 5; 2; 10; FALSCH) ergibt 0,55556

HYPGEOM.VERT(1; 5; 2; 10; WAHR) ergibt 0,77778

Die Wahrscheinlichkeit, genau 1 rote Kugel zu erhalten, beträgt 55,6% (Dichtefunktion). Die Wahrschein-
lichkeit, höchstens 1 rote Kugel zu erhalten, beträgt 77,8% (kumulierte Verteilungsfunktion)

Hinweis:

Die Funktion HYPGEOM.VERT ergänzt mit dem zusätzlichen Argument Kumuliert die bisherige Funkti-
on HYPGEOMVERT.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

HYPGEOMVERT, NEGBINOM.VERT/NEGBINOMVERT

IDENTISCH (Zeichenketten identisch?)

Syntax:

IDENTISCH(Zeichenkette1; Zeichenkette2)

Beschreibung:

Liefert WAHR, wenn Zeichenkette1 mit Zeichenkette2 übereinstimmt.

Auch die Groß-/Kleinschreibung muss exakt übereinstimmen. 
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Beispiel:

IDENTISCH("aaa"; "aaa") ergibt WAHR

IDENTISCH("aaa"; "Aaa") ergibt FALSCH

IDENTISCH(GROSS("aaa"); GROSS("Aaa")) ergibt WAHR

Siehe auch:

FINDEN, SUCHEN, DELTA

IKV (Interner Zinsfuß)

Syntax:

IKV(Werte [; Schätzwert])

Beschreibung:

Liefert einen Schätzwert für den internen Zinsfuß einer Investition. Im Gegensatz zur Funktion QIKV wer-
den dabei keine Finanzierungskosten oder Reinvestitionsgewinne berücksichtigt. 

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Werte) und Einzahlungen
(positive Werte). Die Zahlungen dürfen unterschiedlich groß sein, müssen jedoch in gleichmäßigen Zeitin-
tervallen (z.B. monatlich oder jährlich) auftreten.

Die Funktion erwartet folgende Argumente:

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wurden. Es muss mindestens ei-
ne Auszahlung und eine Einzahlung vorliegen.

Für Schätzwert können Sie (optional) einen Schätzwert für das Ergebnis der Berechnung angeben (siehe
Hinweis).

Hinweis:

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). Falls die Funktion nach
20 Näherungsschritten noch kein Ergebnis mit einer Genauigkeit von 0,00001% oder besser findet, bricht
sie die Näherung ab und liefert als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen
anderen Wert für Schätzwert anzugeben.

Siehe auch:

QIKV, XINTZINSFUSS, ZINS, NBW
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IMABS (Absolutbetrag einer komplexen Zahl)

Syntax:

IMABS(KomplexeZahl)

Beschreibung:

Liefert den Absolutbetrag (Modul) einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMABS("2+4i") ergibt 4,47214

Siehe auch:

KOMPLEXE, IMARGUMENT, IMEXP, IMKONJUGIERTE

IMAGINÄRTEIL (Imaginärteil einer komplexen Zahl)

Syntax:

IMAGINÄRTEIL(KomplexeZahl)

Beschreibung:

Liefert den Imaginärteil einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMAGINÄRTEIL("2+4i") ergibt 4

Siehe auch:

KOMPLEXE, IMREALTEIL
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IMAPOTENZ (Potenz einer komplexen Zahl)

Syntax:

IMAPOTENZ(KomplexeZahl; Exponent)

Beschreibung:

Potenziert die komplexe Zahl KomplexeZahl mit dem Exponenten Exponent.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMAPOTENZ("2+4i"; 2) ergibt -12+16i

Siehe auch:

KOMPLEXE, IMWURZEL

IMARGUMENT (Winkel einer komplexen Zahl)

Syntax:

IMARGUMENT(KomplexeZahl)

Beschreibung:

Liefert den Winkel (Bogenmaß) zur Darstellung der komplexen Zahl in trigonometrischer Schreibweise.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMARGUMENT("2+4i") ergibt 1,10715

Siehe auch:

KOMPLEXE, IMABS, IMEXP, IMKONJUGIERTE
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IMCOS (Cosinus einer komplexen Zahl)

Syntax:

IMCOS(KomplexeZahl)

Beschreibung:

Liefert den Cosinus einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMCOS("2+4i") ergibt -11,3642347064011 - 24,8146514856342i

Siehe auch:

KOMPLEXE, IMSIN

IMDIV (Division komplexer Zahlen)

Syntax:

IMDIV(KomplexeZahl1; KomplexeZahl2)

Beschreibung:

Liefert das Ergebnis der Division der komplexen Zahl KomplexeZahl1 durch die komplexe Zahl Komple-
xeZahl2.

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMDIV("4+12i"; "2+4i") ergibt 2,8+0,4i

Siehe auch:

KOMPLEXE, IMPRODUKT, IMSUB, IMSUMME



517Formeln und Funktionen

IMEXP (Algebraische Form einer komplexen Zahl)

Syntax:

IMEXP(KomplexeZahl)

Beschreibung:

Liefert die algebraische Form einer in exponentieller Schreibweise vorliegenden komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMEXP("2+4i") ergibt -4,82980938326939 - 5,59205609364098i

Siehe auch:

KOMPLEXE, IMABS, IMARGUMENT, IMKONJUGIERTE, IMLN

IMKONJUGIERTE (Konjugiert komplexe Zahl)

Syntax:

IMKONJUGIERTE(KomplexeZahl)

Beschreibung:

Liefert die konjugiert komplexe Zahl zu einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMKONJUGIERTE("2+4i") ergibt 2-4i

Siehe auch:

KOMPLEXE, IMABS, IMARGUMENT, IMEXP
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IMLN (Natürlicher Logarithmus einer komplexen Zahl)

Syntax:

IMLN(KomplexeZahl)

Beschreibung:

Liefert den Logarithmus einer komplexen Zahl zur Basis e (natürlicher Logarithmus).

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMLN("2+4i") ergibt 1,497866136777 + 1,10714871779409i

Siehe auch:

KOMPLEXE, IMEXP, IMLOG10, IMLOG2

IMLOG10 (Zehnerlogarithmus einer komplexen Zahl)

Syntax:

IMLOG10(KomplexeZahl)

Beschreibung:

Liefert den Logarithmus einer komplexen Zahl zur Basis 10 (Zehnerlogarithmus oder dekadischer Logarith-
mus).

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMLOG10("2+4i") ergibt 0,650514997831991 + 0,480828578784234i

Siehe auch:

KOMPLEXE, IMLN, IMLOG2
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IMLOG2 (Zweierlogarithmus einer komplexen Zahl)

Syntax:

IMLOG2(KomplexeZahl)

Beschreibung:

Liefert den Logarithmus einer komplexen Zahl zur Basis 2 (Zweierlogarithmus).

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMLOG2("2+4i") ergibt 2,16096404744368 + 1,59727796468811i

Siehe auch:

KOMPLEXE, IMLN, IMLOG10

IMNEG (Negativer Wert einer komplexen Zahl)

Syntax:

IMNEG(KomplexeZahl)

Beschreibung:

Liefert den negativen Wert einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMNEG("2+4i") ergibt -2-4i

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Tipp: Alternativ zu z.B. IMNEG(A1) können Sie auch die folgende Formel verwenden:

KOMPLEXE(-IMREALTEIL(A1); -IMAGINÄRTEIL(A1))
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Siehe auch:

KOMPLEXE

IMPRODUKT (Produkt komplexer Zahlen)

Syntax:

IMPRODUKT(KomplexeZahl1 [; KomplexeZahl2; KomplexeZahl3 ...])

Beschreibung:

Liefert das Produkt der übergebenen komplexen Zahlen.

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMPRODUKT("2+4i"; "1+2i") ergibt -6+8i

Siehe auch:

KOMPLEXE, IMDIV, IMSUB, IMSUMME

IMREALTEIL (Realteil einer komplexen Zahl)

Syntax:

IMREALTEIL(KomplexeZahl)

Beschreibung:

Liefert den Realteil einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMREALTEIL("2+4i") ergibt 2
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Siehe auch:

KOMPLEXE, IMAGINÄRTEIL

IMSIN (Sinus einer komplexen Zahl)

Syntax:

IMSIN(KomplexeZahl)

Beschreibung:

Liefert den Sinus einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMSIN("2+4i") ergibt 24,8313058489464 - 11,3566127112182i

Siehe auch:

KOMPLEXE, IMCOS

IMSUB (Differenz komplexer Zahlen)

Syntax:

IMSUB(KomplexeZahl1; KomplexeZahl2)

Beschreibung:

Liefert die Differenz zweier komplexer Zahlen, subtrahiert also KomplexeZahl2 von KomplexeZahl1.

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMSUB("2+4i"; "1+2i") ergibt 1+2i
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Siehe auch:

KOMPLEXE, IMDIV, IMPRODUKT, IMSUMME

IMSUMME (Summe komplexer Zahlen)

Syntax:

IMSUMME(KomplexeZahl1 [; KomplexeZahl2; KomplexeZahl3 ...])

Beschreibung:

Liefert die Summe der übergebenen komplexen Zahlen.

Die Argumente müssen komplexe Zahlen im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMSUMME("2+4i"; "1+2i") ergibt 3+6i

Siehe auch:

KOMPLEXE, IMDIV, IMPRODUKT, IMSUB

IMWURZEL (Quadratwurzel einer komplexen Zahl)

Syntax:

IMWURZEL(KomplexeZahl)

Beschreibung:

Liefert die Quadratwurzel einer komplexen Zahl.

KomplexeZahl muss eine komplexe Zahl im Format x+yi oder x+yj sein. Tipp: Komplexe Zahlen können
mit der Funktion KOMPLEXE gebildet werden

Beispiel:

IMWURZEL("2+4i") ergibt 1,79890743994787 + 1,11178594050284i
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Siehe auch:

KOMPLEXE, IMAPOTENZ

INDEX (Zelle in einem Bereich)

Syntax:

INDEX(Bereich; Zeile; Spalte [; Teilbereich])

Beschreibung:

Liefert einen Bezug auf die Zelle, die sich in der angegebenen Zeile und Spalte von Bereich befindet.

Für Bereich ist der gewünschte Zellbereich anzugeben.

Mit Zeile und Spalte bestimmen Sie, in welcher Zeile und Spalte von Bereich sich die zu liefernde Zelle
befindet (ausgehend von der linken oberen Ecke von Bereich).

Wenn Zeile oder Spalte zu groß ist, liefert die Funktion den Fehlerwert #BEZUG.

Das optionale Argument Teilbereich ist nur aus Gründen der Excel-Kompatibilität vorhanden. Es kann an-
gegeben werden, wird von PlanMaker aber nicht ausgewertet.

Kompatibilitätshinweise:

Diese Funktion ist nicht vollständig kompatibel zur gleichnamigen Excel-Funktion:

Beim Argument Bereich werden Mehrfachmarkierungen (unzusammenhängende Zellbereiche) nicht unter-
stützt.

Das Argument Teilbereich wird nicht ausgewertet.

Beispiel:

INDEX(B2:D4; 2; 2) liefert einen Bezug auf die Zelle C3

Siehe auch:

VERGLEICH, SVERWEIS, WVERWEIS, VERWEIS, BEREICHE, WAHL

INDIREKT (Bezug aus Zeichenkette bilden)

Syntax:

INDIREKT(Zeichenkette [; Modus])
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Beschreibung:

Bildet aus einer Zeichenkette einen Zellbezug.

Die übergebene Zeichenkette kann beispielsweise eine Zelladresse (z.B. "A1" oder "$A$1") oder einen Be-
reichsnamen enthalten.

Der optionale Wahrheitswert Modus bestimmt, in welchem Format die übergebene Zelladresse vorliegen
muss:

WAHR oder nicht angegeben: Normale Zelladresse (z.B. A1)

FALSCH: Zelladresse im Format "Z1S1" (eine alternative Art der Zelladressierung, die nur von Microsoft
Excel unterstützt wird)

Beispiel:

INDIREKT("A1") liefert einen Bezug auf die Zelle A1.

Steht in Zelle D2 der Text "E5", so liefert INDIREKT(D2) einen Bezug auf die Zelle E5. Mit
GANZZAHL(INDIREKT(D2)) könnten Sie beispielsweise den Inhalt der Zelle E5 auf eine ganze Zahl ab-
runden.

Weisen Sie einem Zellbereich den Namen "Name1" zu, so liefert INDIREKT("Name1") einen Bezug auf
diesen benannten Bereich.

Siehe auch:

ADRESSE, BEREICH.VERSCHIEBEN, SPALTE, ZEILE 

ISOKALENDERWOCHE (Kalenderwoche nach ISO-Norm)

Syntax:

ISOKALENDERWOCHE(Datum)

Beschreibung:

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet.

Im Gegensatz zur Funktion KALENDERWOCHE verwendet diese Funktion nicht die in den USA und vie-
len anderen Teilen der Welt übliche Rechenmethode Sie richtet sich vielmehr nach der u.a. in Deutschland,
Österreich und der Schweiz verbindlichen ISO-Norm 8601 Diese legt folgendes fest:

1. Wochenbeginn ist stets ein Montag (nicht Sonntag).

2. Die erste Kalenderwoche eines Jahres ist diejenige, die den 4. Januar enthält.
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Hinweis:

Hierbei kann es vorkommen, dass der 29., 30. und 31. Dezember bereits zur ersten Kalenderwoche des
nächsten Jahres gezählt werden – oder der 1., 2., 3. Januar zur letzten Kalenderwoche des vorherigen Jahrs.
Siehe Beispiele.

Tipp: In PlanMaker gibt es deshalb als Alternative eine (nicht Excel-kompatible) Funktion namens
ISOWOCHE Diese liefert exakt die gleichen Ergebnisse, kann aber optional das Jahr zurückgeben, dem das
Datum gemäß ISO-Norm zugerechnet wird 

Beispiel:

ISOKALENDERWOCHE("01.01.2014") ergibt 1.

ISOKALENDERWOCHE("01.01.2011") ergibt 52, denn dieser Tag war ein Samstag.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

ISOWOCHE, KALENDERWOCHE, JAHR, MONAT, TAG, WOCHENTAG

ISOWOCHE (Kalenderwoche nach ISO-Norm)

Syntax:

ISOWOCHE(Datum [; JahrZurückgeben])

Beschreibung:

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet.

Im Gegensatz zur Funktion KALENDERWOCHE verwendet diese Funktion nicht die in den USA und vie-
len anderen Teilen der Welt übliche Rechenmethode Sie richtet sich vielmehr nach der unter anderem in
Deutschland, Österreich und der Schweiz verbindlichen ISO-Norm 8601. Diese legt folgendes fest:

1. Wochenbeginn ist stets ein Montag (nicht Sonntag).

2. Die erste Kalenderwoche eines Jahres ist diejenige, die den 4. Januar enthält.

Hinweis:

Hierbei kann es vorkommen, dass der 29., 30. und 31. Dezember bereits zur ersten Kalenderwoche des
nächsten Jahres gezählt werden – oder der 1., 2., 3. Januar zur letzten Kalenderwoche des vorherigen Jahrs. 

Deshalb verfügt die Funktion zusätzlich über den Parameter JahrZurückgeben, der folgende Auswirkung
hat:
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Ist dieser 0 oder nicht angegeben, liefert die Funktion die Wochennummer zurück.

Ist dieser 1, liefert die Funktion stattdessen das Jahr zurück, dem das Datum gemäß ISO-Norm zugerechnet
wird. Siehe Beispiele.

Beispiel:

ISOWOCHE("01.01.2014") ergibt 1.

ISOWOCHE("01.01.2011") ergibt 52, denn dieser Tag war ein Samstag. 

ISOWOCHE("01.01.2011"; 1) ergibt dementsprechend 2010 – nicht 2011.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Tipp: Als Alternative für diese Funktion können Sie die Excel-kompatible Funktion
ISOKALENDERWOCHE verwenden Diese liefert identische Ergebnisse; ihr fehlt allerdings der optionale
Parameter zum Anzeigen des Jahres

Siehe auch:

ISOKALENDERWOCHE, KALENDERWOCHE, JAHR, MONAT, TAG, WOCHENTAG

ISPMT (Zinszahlung)

Syntax:

ISPMT(Zins; Zr; Zzr; Bw)

Beschreibung:

Liefert die im angegebenen Zeitraum gezahlten Zinsen für eine Investition mit gleichbleibenden Raten.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Zr = die zu betrachtende Periode

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Bw = Barwert (der anfängliche Betrag)

Siehe auch:

KAPZ, RMZ, ZINSZ
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ISTBEZUG (Ist ein Zellbezug?)

Syntax:

ISTBEZUG(Wert)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn der übergebene Wert ein gültiger Zellbezug ist.

Beispiel:

ISTBEZUG(A1) ergibt WAHR

ISTBEZUG($A$1) ergibt WAHR

ISTBEZUG(A1:C7) ergibt WAHR

ISTBEZUG("beliebiger Text") ergibt FALSCH

ISTBEZUG(Quartal1) ergibt so lange FALSCH, bis Sie einem Zellbereich den Namen "Quartal1" zuweisen
– ab dann ergibt auch diese Berechnung WAHR.

Siehe auch:

ISTFORMEL, ISTFEHLER, ISTLOG, ISTZAHL, ISTTEXT

ISTFEHL (Ist Fehlerwert außer #NV?)

Syntax:

ISTFEHL(Zelle)

Beschreibung:

Im Unterschied zur Funktion ISTFEHLER liefert ISTFEHL nur dann den Wahrheitswert WAHR, wenn die
übergebene Zelle einen Fehlerwert außer #NV liefert

Beispiel:

ISTFEHL(A1) ergibt WAHR, wenn der Inhalt der Zelle A1 einen Fehlerwert außer #NV ergibt.

ISTFEHL(A1) ergibt FALSCH, wenn Zelle A1 keinen Fehler zurückliefert oder dort die Funktion NV() ein-
getragen ist.
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Siehe auch:

ISTFEHLER, ISTNV, NV(), FEHLERTYP, WENNFEHLER, Abschnitt über Fehlerwerte

ISTFEHLER (Ist ein Fehler?)

Syntax:

ISTFEHLER(Zelle)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle einen beliebigen Fehlerwert liefert.

Beispiel:

ISTFEHLER(A1) ergibt WAHR, wenn der Inhalt der Zelle A1 einen beliebigen Fehlerwert zurückliefert.

Siehe auch:

ISTFEHL, ISTNV, NV(), FEHLERTYP, ISTBEZUG, WENNFEHLER, Abschnitt über Fehlerwerte

ISTFORMEL (Ist eine Formel?)

Syntax:

ISTFORMEL(Zelle)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Formel enthält.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

Steht in der Zelle A1 eine Formel, in Zelle C7 beispielsweise ein fester Zahlenwert oder Klartext, so gilt:

ISTFORMEL(A1) ergibt WAHR

ISTFORMEL(C7) ergibt FALSCH
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Siehe auch:

ISTBEZUG, FORMELTEXT

ISTGERADE (Ist eine gerade Zahl?)

Syntax:

ISTGERADE(Zahl)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn Zahl eine gerade Zahl ist. 

Hinweis:

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nachkommastellen automa-
tisch.

Beispiel:

ISTGERADE(2) ergibt WAHR

ISTGERADE(2,75) ergibt WAHR

ISTGERADE(3) ergibt FALSCH

ISTGERADE(3,75) ergibt FALSCH

Siehe auch:

ISTUNGERADE

ISTKTEXT (Ist kein Text?)

Syntax:

ISTKTEXT(Zelle)

Beschreibung:

Die Funktion ISTKTEXT (sprich: "Ist kein Text") liefert nur dann den Wahrheitswert WAHR, wenn die
übergebene Zelle keine Zeichenkette enthält.
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Beispiel:

Enthält Zelle A1 eine feste Zeichenkette oder eine Berechnung, die eine Zeichenkette liefert, Zelle C7 hin-
gegen eine Zahl, so gilt:

ISTKTEXT(A1) ergibt FALSCH

ISTKTEXT(C7) ergibt WAHR

Anmerkung:

ISTTEXT ist das Gegenstück zu dieser Funktion: Sie liefert WAHR, wenn sich in der Zelle eine Zeichen-
kette befindet.

Siehe auch:

ISTTEXT, ISTLOG, ISTZAHL

ISTLEER (Ist leer?)

Syntax:

ISTLEER(Zelle)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle leer ist.

Beispiel:

Enthält Zelle A1 beispielsweise einen beliebigen Wert, Zelle C7 ist hingegen leer, so gilt:

ISTLEER(A1) ergibt FALSCH

ISTLEER(C7) ergibt WAHR

Siehe auch:

ISTNV, ANZAHL, ANZAHL2

ISTLOG (Ist Wahrheitswert?)

Syntax:

ISTLOG(Zelle)
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Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle einen Wahrheitswert (WAHR oder
FALSCH) enthält.

Beispiel:

Enthält Zelle A1 einen Wahrheitswert, oder eine Berechnung, die einen Wahrheitswert liefert, Zelle C7 hin-
gegen Text, so gilt:

ISTLOG(A1) ergibt WAHR

ISTLOG(C7) ergibt FALSCH

Siehe auch:

ISTTEXT, ISTZAHL, ISTBEZUG, ISTKTEXT

ISTNV (Ist nicht vorhanden?)

Syntax:

ISTNV(Zelle)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle den Fehlerwert #NV ("nicht vorhanden") lie-
fert. 

Eine Zelle liefert diesen Fehlerwert dann, wenn darin die Funktion NV() eingetragen wurde oder die Zelle
eine Berechnung enthält, die den Fehler #NV liefert

Informationen über die Verwendung des Fehlerwerts #NV finden Sie bei der Beschreibung der Funktion
NV (Nicht vorhanden).

Beispiel:

In Zelle A1 wurde die Funktion NV() eingetragen, um zu kennzeichnen, dass hier ein für eine andere Be-
rechnung zwingend erforderlicher Wert noch nicht vorhanden ist. 

Zelle C7 führt eine Berechnung mit Zelle A1 durch, zum Beispiel A1*2. Da Zelle A1 aber den Fehlerwert
#NV liefert, ist das Ergebnis dieser Berechnung ebenfalls der Fehlerwert #NV.

Hier gilt also:

ISTNV(A1) ergibt WAHR

ISTNV(C7) ergibt ebenfalls WAHR
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Siehe auch:

NV(), FEHLERTYP, ISTFEHL, ISTFEHLER, WENNFEHLER, Abschnitt über Fehlerwerte

ISTTEXT (Ist eine Zeichenkette?)

Syntax:

ISTTEXT(Zelle)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zeichenkette enthält.

Beispiel:

Enthält Zelle A1 eine feste Zeichenkette oder eine Berechnung, die eine Zeichenkette liefert, Zelle C7 hin-
gegen eine Zahl, so gilt:

ISTTEXT(A1) ergibt WAHR

ISTTEXT(C7) ergibt FALSCH

Anmerkung:

ISTKTEXT ist das Gegenstück zu dieser Funktion: Sie liefert WAHR, wenn sich in der Zelle keine Zei-
chenkette befindet.

Siehe auch:

ISTKTEXT, ISTLOG, ISTZAHL, ISTBEZUG

ISTUNGERADE (Ist eine ungerade Zahl?)

Syntax:

ISTUNGERADE(Zahl)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn Zahl eine ungerade Zahl ist. 
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Hinweis:

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nachkommastellen automa-
tisch.

Beispiel:

ISTUNGERADE(1) ergibt WAHR

ISTUNGERADE(1,75) ergibt WAHR

ISTUNGERADE(2) ergibt FALSCH

ISTUNGERADE(2,75) ergibt FALSCH

Siehe auch:

ISTGERADE

ISTZAHL (Ist eine Zahl?)

Syntax:

ISTZAHL(Zelle)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zahl enthält.

Datumsangaben werden ebenfalls als Zahlen betrachtet; Wahrheitswerte (WAHR und FALSCH) hingegen
nicht.

Beispiel:

Die Zellen A1 bis A4 enthalten folgende Werte: 

"Text", 42, 25.09.2018 und WAHR

Hier gilt:

ISTZAHL(A1) ergibt FALSCH

ISTZAHL(A2) ergibt WAHR

ISTZAHL(A3) ergibt WAHR

ISTZAHL(A4) ergibt FALSCH

Siehe auch:

ISTZAHLP, ISTLOG, ISTTEXT, ISTKTEXT, ISTBEZUG, ANZAHL
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ISTZAHLP (PlanMaker 97-Kompatibilitätsfunktion)

Syntax:

ISTZAHLP(Zelle)

Beschreibung:

Liefert den Wahrheitswert WAHR, wenn die übergebene Zelle eine Zahl oder einen Wahrheitswert enthält.

Datumsangaben werden ebenfalls als Zahlen betrachtet.

Hinweis:

Diese Funktion ist nur aus Kompatibilitätsgründen zu PlanMaker 97 noch vorhanden. Verwenden Sie diese
Funktion möglichst nicht mehr, sondern stattdessen die Excel-kompatible Funktion ISTZAHL (ohne "P").

Der Unterschied:

ISTZAHLP betrachtet auch Wahrheitswerte als Zahlen, ISTZAHL hingegen nicht.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

Die Zellen A1 bis A4 enthalten folgende Werte: 

"Text", 42, 25.09.2018 und WAHR

Hier gilt:

ISTZAHLP(A1) ergibt FALSCH

ISTZAHLP(A2) ergibt WAHR

ISTZAHLP(A3) ergibt WAHR

ISTZAHLP(A4) ergibt WAHR (!)

Zum Vergleich: ISTZAHL(A4) ergibt hingegen FALSCH

Siehe auch:

ISTZAHL
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JAHR (Jahr aus einem Datumswert ermitteln)

Syntax:

JAHR(Datum)

Beschreibung:

Liefert die Jahreszahl eines Datumswerts.

Beispiel:

JAHR("25.9.2018") ergibt 2018

Siehe auch:

ISOKALENDERWOCHE, ISOWOCHE, KALENDERWOCHE, MONAT, TAG, TAGEIMJAHR,
WOCHENTAG

JETZT (Aktuelles Datum, aktuelle Uhrzeit)

Syntax:

JETZT()

Beschreibung:

Liefert das aktuelle Datum und die aktuelle Uhrzeit.

Hinweis:

Das Ergebnis ist – wie alle Datumsangaben in einer Tabellenkalkulation – eine Zahl. PlanMaker weist ihr
automatisch das Zahlenformat "Datum/Zeit" im Format hh:mm:ss zu, damit sie als Uhrzeit angezeigt wird.

Das Ergebnis enthält allerdings auch das Datum. Formatieren Sie die Zelle also über den Menübefehl For-
mat > Zelle zum Beispiel in das Zahlenformat TT.MM.JJJJ hh:mm um, wird das aktuelle Datum und die
aktuelle Uhrzeit angezeigt.

Siehe auch:

HEUTE, ERSTELLDATUM
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KALENDERWOCHE (Kalenderwoche)

Syntax:

KALENDERWOCHE(Datum [; Wochenbeginn])

Beschreibung:

Ermittelt, in der wievielten Kalenderwoche eines Jahres sich ein Datum befindet.

Hierbei wird die in den USA und vielen anderen Teilen der Welt übliche Rechenmethode angewandt: Als
erste Kalenderwoche des Jahres gilt stets die Woche, die den 1. Januar enthält.

Hinweis:

In Deutschland wird normalerweise nach einer anderen Methode gerechnet; hier folgt man der ISO-Norm
(siehe Funktion ISOKALENDERWOCHE)

Wichtig:

Beachten Sie außerdem, dass diese Funktion standardmäßig den Sonntag als Wochenbeginn ansieht – nicht
den Montag.

Mit dem optionalen Argument Wochenbeginn können Sie dies allerdings ändern. Für Wochenbeginn sind
folgende Werte zulässig:

1 oder nicht angegeben: Woche beginnt am Sonntag

2: Woche beginnt am Montag

Beispiel:

Am 5.1.2014 (einem Sonntag) gilt:

KALENDERWOCHE("5.1.2014"; 1) ergibt 2

KALENDERWOCHE("5.1.2014"; 2) ergibt 1

Siehe auch:

ISOKALENDERWOCHE, ISOWOCHE, JAHR, MONAT, TAG, WOCHENTAG

KAPZ (Kapitalrückzahlung)

Syntax:

KAPZ(Zins; Zr; Zzr; Bw [; Zw] [; Fälligkeit])
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Beschreibung:

Liefert den Tilgungsanteil der Zahlung in der angegebenen Periode, basierend auf einer Investition mit re-
gelmäßigen konstanten Zahlungen und feststehendem Zins.

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kredit der Tilgungsanteil der
Annuität in einer bestimmten Periode ist. 

"Periode" bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen Rückzahlungen ist die
dritte Periode beispielsweise der dritte Monat.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Zr = die zu betrachtende Periode

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Bw = Barwert (der anfängliche Betrag)

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zahlung erreichen möchten.
Wenn Sie das Argument Zw nicht angeben, wird es auf Null gesetzt.

Fälligkeit (optional) = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Beispiel:

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen:

Jahreszins: 10%

Rückzahlungen: monatlich

Laufzeit: 6 Jahre

Wie groß ist der Tilgungsanteil der Zahlung in Monat 32?

KAPZ(10%/12; 32; 6*12; 100000) ergibt -1.318 Euro.

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müssen – hier also auf Mona-
ten, da die Rückzahlungen monatlich erfolgen. 

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins pro Monat zu erhalten)
und die Laufzeit mit 12 multipliziert (um die Laufzeit in Monaten zu erhalten).

Anmerkung:

Die Funktion ZINSZ ist das Gegenstück zu KAPZ: Sie liefert den Zinsanteil der Zahlung in dieser Periode. 

Die Funktion RMZ hingegen liefert den Gesamtbetrag der Zahlung (Annuität) pro Periode, also die Summe
von Tilgungsanteil und Zinsanteil.

Siehe auch:

BW, ISPMT, KUMKAPITAL, KUMZINSZ, RMZ, ZINS, ZINSZ, ZW, ZZR
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KGRÖSSTE (k-größter Wert)

Syntax:

KGRÖSSTE(Bereich; k)

Beschreibung:

Liefert den k-größten Wert einer Zahlenmenge. Der 1-größte Wert ist der größte Wert, der 2-größte ist der
zweitgrößte Wert etc.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

k bestimmt, die "wievielt-größte" Zahl geliefert werden soll.

k darf nicht kleiner als 1 oder größer als die Anzahl an Zahlen in Bereich sein, andernfalls liefert die Funk-
tion den Fehlerwert #ZAHL!.

Beispiel:

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt:

KGRÖSSTE(A1:A5; 1) ergibt 9

KGRÖSSTE(A1:A5; 2) ergibt 6

KGRÖSSTE(A1:A5; 3) ergibt 5

etc.

Siehe auch:

KKLEINSTE, MAX, QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG,
RANG.GLEICH/RANG.MITTELW/RANG

KGV (Kleinstes gemeinsames Vielfaches)

Syntax:

KGV(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Ermittelt das kgV ("kleinstes gemeinsames Vielfaches") einer Menge von Zahlen. Das kgV ist die kleinste
all derjenigen ganzen Zahlen, die ein Vielfaches der Argumente sind.
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Als Argumente können Zahlen oder Zellbezüge übergeben werden.

Alle übergebenen Zahlen müssen größer gleich 1 sein. Weiterhin sollten nur ganze Zahlen verwendet wer-
den. Ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Beispiel:

KGV(5; 10; 15) ergibt 30

Sind die Zellen A1 bis A3 mit den Werten 4, 8 und 6 gefüllt, so gilt:

KGV(A1:A3) ergibt 24

Siehe auch:

GGT

KKLEINSTE (k-kleinster Wert)

Syntax:

KKLEINSTE(Bereich; k)

Beschreibung:

Liefert den k-kleinsten Wert einer Zahlenmenge. Der 1-kleinste Wert ist der kleinste Wert, der 2-kleinste ist
der zweitkleinste Wert etc.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

k bestimmt, die "wievielt-kleinste" Zahl geliefert werden soll.

k darf nicht kleiner als 1 oder größer als die Anzahl an Zahlen in Bereich sein, andernfalls liefert die Funk-
tion den Fehlerwert #ZAHL!.

Beispiel:

Sind in den Zellen A1:A5 die Zahlen 4, 2, 6, 5, 9 eingetragen, so gilt:

KKLEINSTE(A1:A5; 1) ergibt 2

KKLEINSTE(A1:A5; 2) ergibt 4

KKLEINSTE(A1:A5; 3) ergibt 5

etc.

Siehe auch:

KGRÖSSTE, MIN, QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG,
RANG.GLEICH/RANG.MITTELW/RANG
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KLEIN (In Kleinbuchstaben wandeln)

Syntax:

KLEIN(Zeichenkette)

Beschreibung:

Wandelt alle Buchstaben einer Zeichenkette in Kleinbuchstaben um.

Beispiel:

KLEIN("PlanMaker") ergibt planmaker

Siehe auch:

GROSS, GROSS2

KOMBINATIONEN (Kombinationen)

Syntax:

KOMBINATIONEN(n; k)

Beschreibung:

Ermittelt die Anzahl der ungeordneten Stichproben vom Umfang k, die man einer Gesamtheit von n ver-
schiedenen Elementen ohne Zurücklegen entnehmen kann.

Im Klartext: Es stehen insgesamt n Elemente zur Verfügung. Aus diesen soll eine Teilmenge von genau k
Elementen gezogen werden. Diese Funktion berechnet, wie viele unterschiedliche Teilmengen es hierbei ge-
ben kann.

n gibt an, aus wie vielen Elementen die Gesamtheit besteht. n muss größer als k sein.

k gibt an, wie viele Elemente in einer Stichprobe gezogen werden sollen. k muss größer als 0 und kleiner als
n sein.

n und k sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen automa-
tisch weg.

Beispiel:

Betrachten wir eine Lotterie, bei der 6 aus 49 verschiedenen Kugeln gezogen werden.

Um zu berechnen, wie viele Kombinationen hierbei möglich sind, würde man schreiben:
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KOMBINATIONEN(49; 6)

Es gibt also 13.983.816 Kombinationsmöglichkeiten.

Siehe auch:

VARIATIONEN, BINOM.VERT.BEREICH/BINOM.VERT/BINOMVERT

KOMPLEXE (Komplexe Zahl bilden)

Syntax:

KOMPLEXE(Realteil; Imaginärteil [; Suffix])

Beschreibung:

Bildet aus dem angegebenen Realteil und Imaginärteil eine komplexe Zahl in der Form x+yi oder x+yj.

Mit Suffix können Sie bei Bedarf bestimmen, welcher Buchstabe für die imaginäre Einheit verwendet wer-
den soll: entweder "i" oder "j" (Kleinbuchstabe!). Wird Suffix nicht angegeben, wird automatisch "i" ver-
wendet.

Tipp:

Um komplexe Zahlen in Tabellenzellen einzugeben, benötigen Sie die Funktion KOMPLEXE eigentlich
nicht, sondern können den Wert auch einfach eintippen. Wenn Sie in eine Zelle also zum Beispiel die kom-
plexe Zahl 2+4i eintragen möchten, müssen Sie nicht =KOMPLEXE(2;4) eingeben, sondern können einfach
2+4i tippen.

Auch in Formeln lassen sich komplexe Zahlen einfach eintippen. Wichtig: Umgeben Sie die komplexe Zahl
dabei mit doppelten Anführungszeichen. Statt =IMAPOTENZ(KOMPLEXE(2;4)) können Sie also auch
einfach =IMAPOTENZ("2+4i") schreiben.

Beispiel:

KOMPLEXE(2;4) ergibt 2+4i

KOMPLEXE(2;4;"i") ergibt ebenfalls 2+4i

KOMPLEXE(2;4;"j") ergibt 2+4j

Siehe auch:

IMAGINÄRTEIL, IMREALTEIL
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KONFIDENZ.NORM (Konfidenzintervall)

Syntax:

KONFIDENZ.NORM(Alpha; Sigma; n)

Beschreibung:

Ermöglicht die Bestimmung des 1-Alpha-Konfidenzintervalls für den Erwartungswert (= Mittelwert) einer
Wahrscheinlichkeitsverteilung.

Das 1-Alpha-Konfidenzintervall ist ein symmetrischer Bereich um den Mittelwert einer Stichprobe, das den
Mittelwert der Grundgesamtheit mit einer Wahrscheinlichkeit von 1-Alpha enthält.

Alpha ist die Irrtumswahrscheinlichkeit. Zulässig sind nur Werte aus dem Intervall [0..1].

Ist Alpha beispielsweise 0,05 (also 5%), so ist die Wahrscheinlichkeit, dass der tatsächliche Mittelwert au-
ßerhalb des mit Hilfe der KONFIDENZ-Funktion ermittelten Intervalls liegt, 5%. Man spricht hier vom
95%-Konfidenzintervall.

Sigma ist die Standardabweichung der Grundgesamtheit. Sie muss größer als Null sein.

n gibt den Umfang der Stichprobe an. Dieser muss größer als Null sein.

Beispiel:

In einem Schweinezuchtbetrieb soll das Durchschnittsgewicht von 1000 Ferkeln bestimmt werden. Dazu
wird eine Stichprobe (mit Zurücklegen) vom Umfang n=65 genommen. Das dabei ermittelte Durchschnitts-
gewicht liegt bei 30 kg. Die Standardabweichung beträgt 1,6 kg.

Es soll nun das 95%-Konfidenzintervall (Alpha ist hier also 0,05) ermittelt werden. Man würde also berech-
nen:

KONFIDENZ.NORM(0,05; 1,6; 65) ergibt 0,38897 (kg)

Das Durchschnittsgewicht der Grundgesamtheit (= aller 1000 Schweine) liegt also mit einer Wahrschein-
lichkeit von 95% zwischen 30-0,38897 kg und 30+0,38897 kg.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

KONFIDENZ
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KONFIDENZ (Konfidenzintervall)

Hinweis: KONFIDENZ wird durch die neue identische Funktion KONFIDENZ.NORM ergänzt, die in
neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

KONFIDENZ(Alpha; Sigma; n)

Beschreibung:

Ermöglicht die Bestimmung des 1-Alpha-Konfidenzintervalls für den Erwartungswert (= Mittelwert) einer
Wahrscheinlichkeitsverteilung.

Das 1-Alpha-Konfidenzintervall ist ein symmetrischer Bereich um den Mittelwert einer Stichprobe, das den
Mittelwert der Grundgesamtheit mit einer Wahrscheinlichkeit von 1-Alpha enthält.

Alpha ist die Irrtumswahrscheinlichkeit. Zulässig sind nur Werte aus dem Intervall [0..1].

Ist Alpha beispielsweise 0,05 (also 5%), so ist die Wahrscheinlichkeit, dass der tatsächliche Mittelwert au-
ßerhalb des mit Hilfe der KONFIDENZ-Funktion ermittelten Intervalls liegt, 5%. Man spricht hier vom
95%-Konfidenzintervall.

Sigma ist die Standardabweichung der Grundgesamtheit. Sie muss größer als Null sein.

n gibt den Umfang der Stichprobe an. Dieser muss größer als Null sein.

Beispiel:

In einem Schweinezuchtbetrieb soll das Durchschnittsgewicht von 1000 Ferkeln bestimmt werden. Dazu
wird eine Stichprobe (mit Zurücklegen) vom Umfang n=65 genommen. Das dabei ermittelte Durchschnitts-
gewicht liegt bei 30 kg. Die Standardabweichung beträgt 1,6 kg.

Es soll nun das 95%-Konfidenzintervall (Alpha ist hier also 0,05) ermittelt werden. Man würde also berech-
nen:

KONFIDENZ(0,05; 1,6; 65) ergibt 0,38897 (kg)

Das Durchschnittsgewicht der Grundgesamtheit (= aller 1000 Schweine) liegt also mit einer Wahrschein-
lichkeit von 95% zwischen 30-0,38897 kg und 30+0,38897 kg.

Siehe auch:

KONFIDENZ.NORM
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KORREL (Korrelationskoeffizient)

Syntax:

KORREL(Bereich1; Bereich2)

Beschreibung:

Berechnet den Korrelationskoeffizienten von zwei Datengruppen.

Der Korrelationskoeffizient ist ein Maß für die wechselseitige Beziehung zwischen den Datengruppen.

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Leere Zellen sowie Zeichenketten
und Wahrheitswerte werden ignoriert.

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert die Funktion den Feh-
lerwert #NV.

Beispiel:

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den Werten 2, 7, 4 gefüllt, so
gilt:

KORREL(A1:A3; B1:B3) ergibt 0,99718

Siehe auch:

FISHER, FISHERINV, KOVARIANZ.P/KOVARIANZ.S/KOVAR

KOVAR (Kovarianz Grundgesamtheit)

Hinweis: KOVAR wird durch die neue identische Funktion KOVARIANZ.P (Kovarianz der Grundge-
samtheit) und die gänzlich neue Funktion KOVARIANZ.S (Kovarianz der Stichprobe) ergänzt, die in
neueren Versionen von Microsoft Excel (ab 2010) verwendet werden.

Syntax:

KOVAR(Bereich1; Bereich2)

Beschreibung:

Berechnet die Kovarianz zweier Datengruppen einer Grundgesamtheit.

Die Kovarianz ist ein Maß für die gemeinsame lineare Streuung der Datengruppen. Sie wird aus dem Mittel-
wert der Produkte der Abweichungen der Wertepaare um das arithmetische Mittel gebildet.
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Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müssen ganze Zahlen enthal-
ten. Leere Zellen sowie Zeichenketten und Wahrheitswerte werden ignoriert.

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert die Funktion den Feh-
lerwert #NV.

Beispiel:

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den Werten 2, 7, 4 gefüllt, so
gilt:

KOVAR(A1:A3; B1:B3) ergibt 2,55556

Siehe auch:

KOVARIANZ.P/KOVARIANZ.S, FISHER, FISHERINV, KORREL

KOVARIANZ.P (Kovarianz Grundgesamtheit)

Syntax:

KOVARIANZ.P(Bereich1; Bereich2)

Beschreibung:

Berechnet die Kovarianz zweier Datengruppen einer Grundgesamtheit.

Die Kovarianz ist ein Maß für die gemeinsame lineare Streuung der Datengruppen. Sie wird aus dem Mittel-
wert der Produkte der Abweichungen der Wertepaare um das arithmetische Mittel gebildet.

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müssen ganze Zahlen enthal-
ten. Leere Zellen sowie Zeichenketten und Wahrheitswerte werden ignoriert.

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert die Funktion den Feh-
lerwert #NV.

Beispiel:

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den Werten 2, 7, 4 gefüllt, so
gilt:

KOVARIANZ.P(A1:A3; B1:B3) ergibt 2,55556

Hinweis:

Die Funktion KOVARIANZ.P ergänzt zusammen mit KOVARIANZ.S die bisherige Funktion KOVAR ,
wobei KOVARIANZ.P genau wie KOVAR die Kovarianz einer Grundgesamtheit liefert und
KOVARIANZ.S die Kovarianz einer Stichprobe.



546Formeln und Funktionen

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

KOVARIANZ.S/KOVAR, FISHER, FISHERINV, KORREL

KOVARIANZ.S (Kovarianz Stichprobe)

Syntax:

KOVARIANZ.S(Bereich1; Bereich2)

Beschreibung:

Berechnet die Kovarianz zweier Datengruppen einer Stichprobe.

Die Kovarianz ist ein Maß für die gemeinsame lineare Streuung der Datengruppen. Sie wird aus dem Mittel-
wert der Produkte der Abweichungen der Wertepaare um das arithmetische Mittel gebildet.

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese müssen ganze Zahlen enthal-
ten. Leere Zellen sowie Zeichenketten und Wahrheitswerte werden ignoriert.

Die Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert die Funktion den Feh-
lerwert #NV.

Beispiel:

Sind die Zellen A1 bis A3 mit den Werten 2, 5, 3 und die Zellen B1 bis B3 mit den Werten 2, 7, 4 gefüllt, so
gilt:

KOVARIANZ.S(A1:A3; B1:B3) ergibt 3,83333

Hinweis:

Die Funktion KOVARIANZ.S ergänzt zusammen mit KOVARIANZ.P die bisherige Funktion KOVAR ,
wobei KOVARIANZ.S die Kovarianz einer Stichprobe liefert und KOVARIANZ.P genau wie KOVAR die
Kovarianz einer Grundgesamtheit.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

KOVARIANZ.P/KOVAR, FISHER, FISHERINV, KORREL
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KRITBINOM (Binomialverteilung)

Hinweis: KRITBINOM wird durch die neue identische Funktion BINOM.INV ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

KRITBINOM(n; p; Alpha)

Beschreibung:

Liefert den kleinsten Wert für eine binomialverteilte Zufallsvariable, bei dem die angegebene Irrtumswahr-
scheinlichkeit Alpha nicht überschritten wird.

Es wird also berechnet, wie oft ein bestimmtes Ereignis mit der Wahrscheinlichkeit p beim Durchführen ei-
ner Stichprobe mit n Wiederholungen höchstens eintreten darf, bevor seine kumulierten Wahrscheinlichkei-
ten einen Wert größer oder gleich der Irrtumswahrscheinlichkeit Alpha annehmen.

Diese Funktion ist nur bei Binomialverteilungen anwendbar (siehe auch Funktion
BINOM.VERT/BINOMVERT); es muss sich also um unabhängige Ziehungen handeln, bei denen nur zwei
Ergebnisse möglich sind: Erfolg (Ereignis tritt ein) oder Fehlschlag (Ereignis tritt nicht ein)

n ist die Anzahl der durchgeführten Versuche.

p ist die Wahrscheinlichkeit des Erfolgs pro Wiederholung. Zulässig sind nur Werte aus dem Intervall
[0..1].

Alpha ist die Irrtumswahrscheinlichkeit, die nicht überschritten werden darf. Zulässig sind nur Werte aus
dem Intervall [0..1].

Beispiel:

Aus früheren Lieferungen ist ihnen bekannt, dass normalerweise 7% eines bestimmten elektronischen Bau-
teils defekt sind. Um diese Aussage zu überprüfen, führen Sie bei einer neuen Lieferung eine Stichprobe
von 100 Bauteilen durch. Wie viele davon dürfen höchstens defekt sein, wenn die Irrtumswahrscheinlich-
keit 1% nicht überschreiten soll?

KRITBINOM(100; 7%; 1%) ergibt 2

Siehe auch:

BINOM.INV, BINOM.VERT.BEREICH/BINOM.VERT/BINOMVERT



548Formeln und Funktionen

KUMKAPITAL (Kumulierte Kapitalrückzahlungen)

Syntax:

KUMKAPITAL(Zins; Zzr; Bw; z1; z2; Fälligkeit)

Beschreibung:

Ermittelt die Summe der zwischen Periode z1 und z2 fälligen Kapitalrückzahlungen (Tilgungsanteile), ba-
sierend auf einer Investition mit regelmäßigen konstanten Zahlungen und feststehendem Zins.

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kredit der Tilgungsanteil der
Annuitäten in den angegebenen Perioden ist. 

"Periode" bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen Rückzahlungen ist die
dritte Periode beispielsweise der dritte Monat.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode).

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Bw = Barwert (der anfängliche Betrag)

z1; z2 = der zu betrachtende Zeitraum: z1 ist die erste zu berücksichtigende Periode, z2 die letzte. (Die Peri-
oden sind mit 1 beginnend durchnummeriert.)

Fälligkeit = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Beispiel:

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen:

Jahreszins: 10%

Zahlungen: monatlich, jeweils am Monatsende

Laufzeit: 6 Jahre

Wie groß ist der Tilgungsanteil der Zahlungen in den Perioden (=Monaten) 24 bis 36 insgesamt?

KUMKAPITAL(10%/12; 6*12; 100000; 24; 36; 0) ergibt -16863,71 Euro.

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müssen – hier also auf Mona-
ten, da die Zahlungen monatlich erfolgen. 

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins pro Monat zu erhalten)
und die Laufzeit mit 12 multipliziert (um die Laufzeit in Monaten zu erhalten).
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Anmerkung:

Die Funktion KUMZINSZ ist das Gegenstück zu KUMKAPITAL: Sie liefert die Summe der Zinsanteile.

Siehe auch:

KUMZINSZ, KAPZ, ZINSZ, RMZ

KUMZINSZ (Kumulierte Zinszahlungen)

Syntax:

KUMZINSZ(Zins; Zzr; Bw; z1; z2; Fälligkeit)

Beschreibung:

Ermittelt die Summe der zwischen Periode z1 und z2 fälligen Zinszahlungen, basierend auf einer Investition
mit regelmäßigen konstanten Zahlungen und feststehendem Zins.

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kredit der Zinsanteil der An-
nuitäten in den angegebenen Perioden ist. 

"Periode" bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen Rückzahlungen ist die
dritte Periode beispielsweise der dritte Monat.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode).

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Bw = Barwert (der anfängliche Betrag)

z1; z2 = der zu betrachtende Zeitraum: z1 ist die erste zu berücksichtigende Periode, z2 die letzte. (Die Peri-
oden sind mit 1 beginnend durchnummeriert.)

Fälligkeit = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Beispiel:

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen:

Jahreszins: 10%

Zahlungen: monatlich, jeweils am Monatsende

Laufzeit: 6 Jahre

Wie groß ist der Zinsanteil der Zahlungen in den Perioden (=Monaten) 24 bis 36 insgesamt?
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KUMZINSZ(10%/12; 6*12; 100000; 24; 36; 0) ergibt -7219,88 Euro.

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müssen – hier also auf Mona-
ten, da die Zahlungen monatlich erfolgen. 

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins pro Monat zu erhalten)
und die Laufzeit mit 12 multipliziert (um die Laufzeit in Monaten zu erhalten).

Anmerkung:

Die Funktion KUMKAPITAL ist das Gegenstück zu KUMZINSZ: Sie liefert die Summe der Tilgungsantei-
le.

Siehe auch:

KUMKAPITAL, KAPZ, ZINSZ, RMZ

KURT (Kurtosis einer Verteilung)

Syntax:

KURT(Zahl1; Zahl2; Zahl3; Zahl4 [; Zahl5 ...])

oder

KURT(Bereich1 [; Bereich2; Bereich3 ...])

Beschreibung:

Berechnet die Kurtosis ("Gipfligkeit") einer Wahrscheinlichkeitsverteilung.

Die Kurtosis ist ein Maß für die Wölbung der Dichtefunktion einer Verteilung im Vergleich zur Dichtefunk-
tion der Normalverteilung.

Bei einer steiler gewölbten ("schmalgipfligen") Verteilung ist die Kurtosis ein positiver Wert, bei flacher
gewölbten ("breitgipfligen") Kurve ein negativer Wert. 

Wenn sich die Kurtosis Null annähert, entspricht die betrachtete Verteilung in guter Näherung einer Nor-
malverteilung (siehe Funktion NORM.VERT/NORMVERT)

Zahl1, Zahl2, Zahl3, Zahl4 etc. sind die Werte der Verteilung, deren Kurtosis berechnet werden soll. Lee-
re Zellen sowie Zeichenketten und Wahrheitswerte werden ignoriert.

Es müssen mindestens vier Werte angegeben sein; andernfalls liefert die Funktion den Fehlerwert #DIV/0!
(Division durch Null).

Hinweis:

Diese Funktion erwartet als Argumente keine Wertepaare (x-Wert und y-Wert), sondern nur die Werte der
Verteilung. Mehrmals vorkommende Werte müssen entsprechend oft wiederholt werden (siehe Beispiel).
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Beispiel:

Sie messen die Körpergrößen einer Gruppe von Personen und erhalten dabei folgende Ergebnisse: 1 x
1,60m, 2 x 1,65m, 4 x 1,70m, 2 x 1,75m und 1x1,80m. 

Die Verteilung (Dichtefunktion) dieser Messergebnisse hat folgende Gipfligkeit:

KURT(1,60; 1,65; 1,65; 1,70; 1,70; 1,70; 1,70; 1,75; 1,75; 1,80) ergibt 0,08036.

Siehe auch:

SCHIEFE, NORM.VERT/NORMVERT

KÜRZEN (Zahl auf n Nachkommastellen kürzen)

Syntax:

KÜRZEN(Zahl [; n])

Beschreibung:

Kürzt eine Zahl auf n Nachkommastellen (ohne zu runden).

n ist die gewünschte Anzahl an Nachkommastellen. 

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gekürzt.

n darf auch ein negativer Wert sein, worauf auch der ganzzahlige Teil der Zahl gekürzt wird (siehe letztes
Beispiel).

Beispiel:

KÜRZEN(5,779) ergibt 5

KÜRZEN(5,779; 2) ergibt 5,77

KÜRZEN(1234; -2) ergibt 1200

Anmerkung:

Die Nachkommastellen erhalten Sie mit der Funktion NACHKOMMA.

Siehe auch:

ABRUNDEN, AUFRUNDEN, NACHKOMMA, RUNDEN
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LÄNGE (Länge einer Zeichenkette)

Syntax:

LÄNGE(Wert)

Beschreibung:

Ermittelt, aus wie vielen Zeichen der übergebene Wert besteht. 

Wenn der übergebene Wert eine Zahl, ein Datum oder ein Wahrheitswert ist, wird er in eine Zeichenkette
konvertiert.

Beachten Sie: Bei Datumsangaben wird die serielle Datumszahl in eine Zeichenkette konvertiert, nicht das
formatierte Datum selbst (siehe letztes Beispiel).

Beispiel:

LÄNGE("Text") ergibt 4

LÄNGE(42) ergibt 2

LÄNGE(-42) ergibt 3

LÄNGE(42,5) ergibt 4

LÄNGE(42,50) ergibt ebenfalls 4 (die überflüssige Null wird automatisch entfernt!)

LÄNGE(WAHR) ergibt 4

Beachten Sie bei Datumsangaben: Wenn in Zelle A1 das Datum 25.09.2014 in einer beliebigen Formatie-
rung steht, so gilt:

LÄNGE(A1) ergibt 5

Grund: Datumswerte werden in einer Tabellenkalkulation stets als Zahlen gespeichert – das Datum
25.09.2014 beispielsweise als 41907. Insofern ist das Ergebnis der Berechnung zwar unerwartet, aber völlig
korrekt – denn:

LÄNGE(41907) ergibt ebenfalls 5

Siehe auch:

LINKS, RECHTS, TEIL

LAUFZEIT (Laufzeit)

Syntax:

LAUFZEIT(Zins; Bw; Zw)



553Formeln und Funktionen

Beschreibung:

Ermittelt den Zeitraum (die Anzahl an Perioden), der benötigt wird, um mit einer festverzinslichen Anlage
einen bestimmten Betrag zu erreichen. 

Es werden keine regelmäßigen Zahlungen geleistet; es gibt also nur eine einzige Einzahlung am Beginn der
Laufzeit.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Bw = Barwert (der anfängliche Betrag)

Zw = Zukünftiger Wert (der Zielwert)

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Tipp: Sie können Berechnungen mit der Funktion LAUFZEIT wie folgt mit Excel-kompatiblen Funktionen
durchführen:

Laufzeit(Zins; Bw; Zw) entspricht ZZR(Zins; 0; Bw; -Zw)

Beachten Sie dabei das Minuszeichen vor Zw!

Beispiel:

Sie möchten mit einer Anlage von € 3000,- auf eine Auszahlung von € 5000,- kommen. Der Zinssatz beträgt
6% pro Jahr. Wie viele Perioden (= Jahre) werden dafür benötigt?

LAUFZEIT(6%; 3000; 5000) ergibt 8,76669 (Jahre)

Siehe auch:

ZSATZINVEST

LIA (Lineare Abschreibung)

Syntax:

LIA(AW; RW; ND)

Beschreibung:

Liefert den Wert der linearen Abschreibung eines Objekts pro Periode.

AW = Anschaffungskosten des Objekts

RW = Restwert des Objekts am Ende der Nutzungsdauer
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ND = Nutzungsdauer (Anzahl der Perioden, über die das Objekt abgeschrieben wird)

Beispiel:

LIA(6000; 3000; 5) ergibt 600

Siehe auch:

DIA, GDA, GDA2

LINKS (Teil einer Zeichenkette)

Syntax:

LINKS(Zeichenkette [; n])

Beschreibung:

Liefert die ersten n Zeichen einer Zeichenkette.

Ist n nicht angegeben, liefert die Funktion nur das erste Zeichen.

Beispiel:

LINKS("Tiergarten"; 4) ergibt Tier

LINKS("Tiergarten") ergibt T

Siehe auch:

RECHTS, TEIL, ERSETZEN, LÄNGE

LN (Natürlicher Logarithmus)

Syntax:

LN(Zahl)

Beschreibung:

Liefert den natürlichen Logarithmus (Basis e) einer Zahl.

Die übergebene Zahl muss größer als Null sein.
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Beispiel:

LN(0,7) ergibt -0,3567

LN(EXP(1,234)) ergibt 1,234

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist EXP.

Siehe auch:

EXP, LOG, LOG10, POTENZ

LOG (Logarithmus)

Syntax:

LOG(Zahl [; Basis])

Beschreibung:

Liefert den Logarithmus einer Zahl zur angegebenen Basis. 

Die übergebene Zahl muss größer als Null sein.

Ist das Argument Basis nicht angegeben, wird als Basis 10 verwendet.

Beispiel:

LOG(100) entspricht log 10 (100), ergibt also 2

LOG(10 ^ 0,1234) ergibt 0,1234

LOG(8; 2) entspricht log 2 (8), ergibt also 3

Siehe auch:

LOG10, LN, EXP, POTENZ

LOG10 (Zehnerlogarithmus)

Syntax:

LOG10(Zahl)
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Beschreibung:

Liefert den Zehnerlogarithmus (dekadischer Logarithmus) einer Zahl, also den Logarithmus zur Basis 10.

Die übergebene Zahl muss größer als Null sein.

Beispiel:

LOG10(100) ergibt 2

LOG10(10 ^ 0,1234) ergibt 0,1234

Siehe auch:

LOG, LN, EXP

LOGINV (Quantile einer Lognormalverteilung)

Hinweis: LOGINV wird durch die neue identische Funktion LOGNORM.INV ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

LOGINV(Wahrscheinlichkeit; Mittelwert; Standardabweichung)

Beschreibung:

Liefert Quantile einer logarithmischen Normalverteilung ("Lognormalverteilung").

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Lognormalverteilung. Zulässig sind nur
Werte aus dem Intervall [0..1].

Mittelwert ist der Mittelwert von LN(x).

Standardabweichung ist die Standardabweichung von LN(x). Diese muss größer als Null sein.

Siehe auch:

LOGNORM.INV, LN, LOGNORM.VERT/LOGNORMVERT, NORM.VERT/NORMVERT,
NORM.S.VERT/STANDNORMVERT
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LOGNORM.INV (Quantile einer Lognormalverteilung)

Syntax:

LOGNORM.INV(Wahrscheinlichkeit; Mittelwert; Standardabweichung)

Beschreibung:

Liefert Quantile einer logarithmischen Normalverteilung ("Lognormalverteilung").

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Lognormalverteilung. Zulässig sind nur
Werte aus dem Intervall [0..1].

Mittelwert ist der Mittelwert von LN(x).

Standardabweichung ist die Standardabweichung von LN(x). Diese muss größer als Null sein.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

LOGNORM.INV ist die Umkehrfunktion von LOGNORM.VERT

Siehe auch:

LOGINV, LN, LOGNORM.VERT/LOGNORMVERT, NORM.VERT/NORMVERT,
NORM.S.VERT/STANDNORMVERT

LOGNORMVERT (Logarithmische Normalverteilung)

Hinweis: LOGNORMVERT wird durch die neue Funktion LOGNORM.VERT mit zusätzlicher Funktio-
nalität ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

LOGNORMVERT(x; E; S)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer kumulierten logarithmisch normalverteilten Zufallsvariablen.

Sie können mit dieser Funktion Wahrscheinlichkeitsverteilungen betrachten, bei denen nicht die Zufallsva-
riable selbst, sondern ihr natürlicher Logarithmus normalverteilt ist.
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x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als Null sein.

Für E ist der Erwartungswert m (My) der Verteilung anzugeben.

Für S ist die Standardabweichung s (Sigma) der Verteilung anzugeben. S muss größer als Null sein.

Siehe auch:

LOGNORM.VERT, LN, LOGNORM.INV/LOGINV, NORM.VERT/NORMVERT,
NORM.S.VERT/STANDNORMVERT

LOGNORM.VERT (Logarithmische Normalverteilung)

Syntax:

LOGNORM.VERT(x; E; S; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer (kumulierten) logarithmisch normalverteilten Zufallsvariablen.

Sie können mit dieser Funktion Wahrscheinlichkeitsverteilungen betrachten, bei denen nicht die Zufallsva-
riable selbst, sondern ihr natürlicher Logarithmus normalverteilt ist.

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als Null sein.

Für E ist der Erwartungswert m (My) der Verteilung anzugeben.

Für S ist die Standardabweichung s (Sigma) der Verteilung anzugeben. S muss größer als Null sein.

Kumuliert bestimmt als Schalter die Art der Funktion: Gibt man den Wert WAHR ein, wird die kumulierte
Verteilungsfunktion der logarithmischen Normalverteilung berechnet. Durch Eingabe von Wert FALSCH
berechnet sich die Dichtefunktion der logarithmischen Normalverteilung.

Hinweis:

Die Funktion LOGNORM.VERT ergänzt mit dem zusätzlichen Argument Kumuliert die bisherige Funkti-
on LOGNORMVERT.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist LOGNORM.INV
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Siehe auch:

LOGNORMVERT, LN, LOGNORM.INV/LOGINV, NORM.VERT/NORMVERT,
NORM.S.VERT/STANDNORMVERT

MAX (Maximalwert)

Syntax:

MAX(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert den größten Wert innerhalb der angegebenen Zahlen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Beispiel:

MAX(5; 7; 4; 9) ergibt 9

Wenn die Zellen A1 bis A3 mit den Werten -1, -2 und WAHR gefüllt sind, so gilt:

MAX(A1:A3) ergibt -1 (der Wahrheitswert WAHR wird ignoriert)

Siehe auch:

MAXA, MIN, KGRÖSSTE

MAXA (Maximalwert)

Syntax:

MAXA(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Die Funktion MAXA entspricht nahezu der Funktion MAX (siehe Hinweis). Sie liefert also den größten
Wert innerhalb der angegebenen Zahlen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.
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Hinweis:

Im Gegensatz zu MAX berücksichtigt die Funktion MAXA auch Werte, die keine Zahlen sind: Beliebige
Zeichenketten und der Wahrheitswert FALSCH werden als 0 interpretiert, WAHR als 1.

Leere Zellen werden hingegen auch hier ignoriert.

Beispiel:

MAXA(5; 7; 4; 9) ergibt 9

Wenn die Zellen A1 bis A3 mit den Werten -1, -2 und WAHR gefüllt sind, so gilt:

MAXA(A1:A3) ergibt 1 (denn WAHR = 1)

MAX(A1:A3) ergibt hingegen -1 (denn der Wahrheitswert WAHR wird bei der Funktion MAX ignoriert)

Siehe auch:

MAX

MDET (Determinante einer Matrix)

Syntax:

MDET(Matrix)

Beschreibung:

Liefert die Determinante einer quadratischen Matrix.

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. Matrix muss numerische Werte enthalten
und quadratisch sein, also die gleiche Anzahl an Zeilen und Spalten besitzen.

Beispiel:

MDET({9.8.8; 2.4.6; 1.2.1}) ergibt -40

Siehe auch:

Abschnitt Arbeiten mit Matrizen, MINV, MMULT, MSOLVE, MTRANS
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MEDIAN (Median)

Syntax:

MEDIAN(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert den Median der angegebenen Zahlen.

Der Median ist die Zahl, die in der Mitte einer Reihe von Zahlen liegt. Die Hälfte dieser Zahlen hat also
Werte, die kleiner sind als der Median, die andere Hälfte Werte, die größer sind.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Beachten Sie:

Ist eine ungerade Anzahl an Werten gegeben, liefert MEDIAN die Zahl in der Mitte.

Ist eine ungerade Anzahl an Werten gegeben, liefert MEDIAN den Mittelwert der beiden in der Mitte lie-
genden Zahlen (siehe zweites Beispiel).

Beispiel:

MEDIAN(1; 2; 3; 4; 5) ergibt 3

MEDIAN(1; 2; 3; 4; 5; 1000) ergibt 3,5

Siehe auch:

MITTELWERT, MODUS.EINF/MODALWERT, QUANTIL.EXKL/QUANTIL.INKL/QUANTIL

MILLISEKUNDEN (Millisekunden aus einem Datumswert ermitteln)

Syntax:

MILLISEKUNDEN(Uhrzeit)

Beschreibung:

Liefert den Millisekundenanteil aus einem Datumswert.
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Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

MILLISEKUNDEN("12:34:56,555") ergibt 555

MILLISEKUNDEN("25.09.2018 12:34:56,555") ergibt 555

Siehe auch:

STUNDE, MINUTE, SEKUNDE

MIN (Minimalwert)

Syntax:

MIN(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert den kleinsten Wert innerhalb der angegebenen Zahlen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Beispiel:

MIN(5; 7; 4; 9) ergibt 4

Wenn die Zellen A1 bis A3 mit den Werten 5, 2 und WAHR gefüllt sind, so gilt:

MIN(A1:A3) ergibt 2 (der Wahrheitswert WAHR wird ignoriert)

Siehe auch:

MINA, MAX, KKLEINSTE
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MINA (Minimalwert)

Syntax:

MINA(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Die Funktion MINA entspricht nahezu der Funktion MIN (siehe Hinweis). Sie liefert also den kleinsten
Wert innerhalb der angegebenen Zahlen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Hinweis:

Im Gegensatz zu MIN berücksichtigt die Funktion MINA auch Werte, die keine Zahlen sind: Beliebige Zei-
chenketten und der Wahrheitswert FALSCH werden als 0 interpretiert, WAHR als 1.

Leere Zellen werden hingegen auch hier ignoriert.

Beispiel:

MINA(5; 7; 4; 9) ergibt 4

Wenn die Zellen A1 bis A3 mit den Werten 5, 2 und WAHR gefüllt sind, so gilt:

MINA(A1:A3) ergibt 1 (denn WAHR = 1) 

MIN(A1:A3) ergibt hingegen 2 (denn der Wahrheitswert WAHR wird hier ignoriert)

Siehe auch:

MIN

MINUTE (Minute aus einem Datumswert ermitteln)

Syntax:

MINUTE(Uhrzeit)

Beschreibung:

Liefert den Minutenanteil aus einem Datumswert.
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Beispiel:

MINUTE("12:34:56") ergibt 34

MINUTE("25.09.2018 10:30:56") ergibt 30

Siehe auch:

STUNDE, SEKUNDE, MILLISEKUNDEN

MINV (Inverse einer Matrix)

Syntax:

MINV(Matrix)

Beschreibung:

Liefert die Inverse einer quadratischen Matrix. 

Die Inverse A-1 einer Matrix A ist die Matrix, mit der A multipliziert werden muss, um die Einheitsmatrix 1
zu erhalten.

Matrix kann eine Matrix oder ein entsprechender Zellbezug sein. Matrix muss numerische Werte enthalten
und quadratisch sein, also die gleiche Anzahl an Zeilen und Spalten besitzen.

Anmerkung:

Singuläre Matrizen (Matrizen, deren Determinante Null ist) haben keine Inverse. Hier liefert MINV den
Fehlerwert #ZAHL.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Beispiel:

MINV({9.8.8;2.4.6;1.2.1}) ergibt:

{0,2.-0,2.-0,4;-0,1.-0,025.0,95;0.0,25.-0,5}

Siehe auch:

Abschnitt Arbeiten mit Matrizen, MDET, MMULT, MSOLVE, MTRANS
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MITTELABW (Mittlere Abweichung vom Mittelwert)

Syntax:

MITTELABW(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Berechnet die durchschnittliche Abweichung der angegebenen Zahlen von ihrem Mittelwert.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Beispiel:

MITTELABW(2; 2; 2; 2) ergibt 0

MITTELABW(2; 2; 2; 3) ergibt 0,375

Siehe auch:

SUMQUADABW, STABW.S/STABW, VAR.S/VARIANZ

MITTELWERT (Arithmetisches Mittel)

Syntax:

MITTELWERT(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert das einfache arithmetische Mittel der übergebenen Zahlen. 

Dieses wird durch Teilen der Summe der Einzelwerte durch deren Anzahl berechnet.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Beispiel:

MITTELWERT(1; 2; 6) entspricht (1+2+6) / 3, ergibt also 3

Wenn die Zellen A1 bis A4 die Werte 0, 1, 2 und den Wahrheitswert WAHR enthalten, so gilt:
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MITTELWERT(A1:A4) entspricht (0+1+2) / 3, ergibt also 1. Die Zelle mit dem Wahrheitswert wird hierbei
nicht berücksichtigt – auch nicht beim Ermitteln der Anzahl der Werte.

Siehe auch:

MITTELWERTA, GEOMITTEL, HARMITTEL, GESTUTZTMITTEL, MEDIAN

MITTELWERTA (Arithmetisches Mittel)

Syntax:

MITTELWERTA(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Die Funktion MITTELWERTA entspricht nahezu der Funktion MITTELWERT (siehe Hinweis). Sie lie-
fert also das arithmetische Mittel der übergebenen Zahlen. 

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Hinweis:

Im Gegensatz zu MITTELWERT berücksichtigt die Funktion MITTELWERTA auch Werte, die keine Zah-
len sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH werden als 0 interpretiert, WAHR als 1.

Leere Zellen werden hingegen auch hier ignoriert.

Beispiel:

MITTELWERTA(1; 2; 6) entspricht (1+2+6) / 3, ergibt also 3

Wenn die Zellen A1 bis A4 die Werte 0, 1, 4 und den Wahrheitswert WAHR enthalten, so gilt:

MITTELWERTA(A1:A4) entspricht (0+1+4+1) / 4, ergibt also 1,5. Der Wahrheitswert WAHR wird hier
als 1 interpretiert.

Zum Vergleich:

MITTELWERT(A1:A4) entspricht (0+1+4) / 3, ergibt also etwa 1,66667. Der Wahrheitswert wird hier
ignoriert.

Siehe auch:

MITTELWERT
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MITTELWERTWENN (Mittelwert ausgewählter Werte)

Syntax:

MITTELWERTWENN(Suchbereich; Suchkriterium [; Mittelwertbereich])

Beschreibung:

Liefert den Mittelwert (einfaches arithmetisches Mittel) derjenigen Werte in einem Bereich, für die die an-
gegebene Bedingung zutrifft. 

Suchbereich ist der zu durchsuchende Bereich.

Suchkriterium ist die zu erfüllende Bedingung:

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder "Schrauben"). In diesem
Fall wird der Mittelwert aller Posten geliefert, die diesem Wert entsprechen.

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier wird der Mittelwert aller Posten
geliefert, die dieser Bedingung entsprechen.

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") umgeben werden.

Das optionale Argument Mittelwertbereich bestimmt, das Mittel welcher Werte geliefert werden soll.
Wenn Mittelwertbereich nicht angegeben ist, werden die Werte im Suchbereich verwendet.

Kompatibilitätshinweise:

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 2003 und früher. Wenn Sie
ein Dokument in diesem Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch
ihr aktuelles Ergebnis als fester Wert ersetzt. 

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht im Dateiformat "Microsoft
Excel 97-2003 (.xls)" speichern, sondern eines der folgenden Formate verwenden:

¡ "PlanMaker-Dokument (.pmdx oder .pmd)" 

¡ oder: "Microsoft Excel 2007-2016 (.xlsx)"

Beispiel:

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt:

MITTELWERTWENN(A1:A5; "2") ergibt 2

MITTELWERTWENN(A1:A5; ">=2") ergibt (2+3+2)/3, also 2,33333

Siehe auch:

MITTELWERT, MITTELWERTWENNS, SUMMEWENN, SUMMEWENNS, ZÄHLENWENN,
ZÄHLENWENNS
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MITTELWERTWENNS (Mittelwert ausgewählter Werte)

Syntax:

MITTELWERTWENNS(Mittelwertbereich; Suchbereich1; Suchkriterium1 [; Suchbereich2; Suchkriteri-
um2 ...])

Beschreibung:

Liefert den Mittelwert (einfaches arithmetisches Mittel) derjenigen Werte in einem Bereich, für die alle an-
gegebenen Bedingungen zutreffen. 

Entspricht der Funktion MITTELWERTWENN, erlaubt allerdings die Verwendung mehrerer Suchbereiche
(inklusive eines Suchkriteriums für jeden Bereich)

Beachten Sie: Die Reihenfolge der Parameter ist hier anders als bei MITTELWERTWENN: Bei
MITTELWERTWENNS ist der Mittelwertbereich der erste Parameter und nicht der letzte. 

Mittelwertbereich ist der Bereich mit den Werten, deren Mittelwert berechnet werden soll. 

Suchbereich1 ist der erste zu durchsuchende Bereich. Dieser muss die gleichen Ausmaße haben wie der
Mittelwertbereich.

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müssen:

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder "Schrauben"). In diesem
Fall wird der Mittelwert aller Posten geliefert, die diesem Wert entsprechen.

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier wird der Mittelwert aller Posten
geliefert, die dieser Bedingung entsprechen.

Hinweis: Die Suchkriterien sollten stets mit doppelten Anführungszeichen (") umgeben werden.

Im Gegensatz zur Funktion MITTELWERTWENN können Sie bei MITTELWERTWENNS auch mehrere
Suchbereiche mit jeweils dazugehörendem Suchkriterium angeben. Es werden dann nur diejenigen Werte in
die Berechnung einbezogen, bei denen alle Kriterien erfüllt sind.

Kompatibilitätshinweise:

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 2003 und früher. Wenn Sie
ein Dokument in diesem Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch
ihr aktuelles Ergebnis als fester Wert ersetzt. 

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht im Dateiformat "Microsoft
Excel 97-2003 (.xls)" speichern, sondern eines der folgenden Formate verwenden:

¡ "PlanMaker-Dokument (.pmdx oder .pmd)" 

¡ oder: "Microsoft Excel 2007-2016 (.xlsx)"

Beispiel:

MITTELWERTWENNS(A1:A10; C1:C10; ">1"; C1:C10; "<2") 
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Diese Formel liefert den Mittelwert all derjenigen Zellen im Bereich A1:A10, bei denen die entsprechende
Zelle im Bereich C1:C10 größer als 1 und kleiner als 2 ist.

Siehe auch:

MITTELWERT, MITTELWERTWENN, SUMMEWENN, SUMMEWENNS, ZÄHLENWENN,
ZÄHLENWENNS

MMULT (Multiplikation zweier Matrizen)

Syntax:

MMULT(Matrix1; Matrix2)

Beschreibung:

Liefert das Produkt zweier Matrizen.

Matrix1 und Matrix2 können Matrizen oder entsprechende Zellbezüge sein. Beide Matrizen müssen nume-
rische Werte enthalten. 

Beachten Sie: Die Spaltenzahl von Matrix1 muss mit der Zeilenzahl von Matrix2 übereinstimmen; andern-
falls ist eine Multiplikation nicht möglich.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Beispiel:

MMULT({1.2;3.4}; {5.6;7.8}) ergibt {19.22;43.50}

Siehe auch:

Abschnitt Arbeiten mit Matrizen, MDET, MINV, MSOLVE, MTRANS

MODALWERT (Häufigster Wert)

Hinweis: MODALWERT wird durch die neue identische Funktion MODUS.EINF ergänzt, die in neue-
ren Versionen von Microsoft Excel (ab 2010) verwendet wird.
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Syntax:

MODALWERT(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Ermittelt den häufigsten Wert (auch Modalwert oder dichtester Wert genannt) innerhalb der angegebenen
Zahlenwerte.

Bei der Dichtefunktion einer Wahrscheinlichkeitsverteilung entspricht der Modalwert dem "Gipfel" des
Graphen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Wenn die Werte mehrere Modalwerte enthalten, wird der kleinste Modalwert geliefert.

Enthalten die Werte keinen mehrfach vorkommenden Wert, liefert die Funktion den Fehlerwert #NV.

Beispiel:

MODALWERT(1; 2; 4; 4; 4; 2; 1) ergibt 4

MODALWERT(1; 2; 4; 4; 2; 1) ergibt 1 (hier wird der kleinste der drei Modalwerte geliefert)

MODALWERT(1; 4; 2) ergibt #NV, da kein Wert mehr als ein Mal vorkommt.

Siehe auch:

MODUS.EINF, MEDIAN, NORM.VERT/NORMVERT

MODUS.EINF (Häufigster Wert)

Syntax:

MODUS.EINF(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Ermittelt den häufigsten Wert (auch Modalwert oder dichtester Wert genannt) innerhalb der angegebenen
Zahlenwerte.

Bei der Dichtefunktion einer Wahrscheinlichkeitsverteilung entspricht der Modalwert dem "Gipfel" des
Graphen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte.

Wenn die Werte mehrere Modalwerte enthalten, wird der kleinste Modalwert geliefert.

Enthalten die Werte keinen mehrfach vorkommenden Wert, liefert die Funktion den Fehlerwert #NV.
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Beispiel:

MODUS.EINF(1; 2; 4; 4; 4; 2; 1) ergibt 4

MODUS.EINF(1; 2; 4; 4; 2; 1) ergibt 1 (hier wird der kleinste der drei Modalwerte geliefert)

MODUS.EINF(1; 4; 2) ergibt #NV, da kein Wert mehr als ein Mal vorkommt.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

MODALWERT, MEDIAN, NORM.VERT/NORMVERT

MONAT (Monat aus einem Datumswert ermitteln)

Syntax:

MONAT(Datum)

Beschreibung:

Liefert die Monatszahl eines Datumswerts.

Beispiel:

MONAT("25.9.2018") ergibt 9

MONAT("17. August") ergibt 8

Siehe auch:

ISOKALENDERWOCHE, ISOWOCHE, KALENDERWOCHE, JAHR, TAG, WOCHENTAG

MONATSENDE (Monatsende in/vor n Monaten)

Syntax:

MONATSENDE(Ausgangsdatum; m)
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Beschreibung:

Liefert das Monatsende, das m Monate vor/nach dem Ausgangsdatum liegt. 

Das Argument Ausgangsdatum muss ein gültiger Datumswert sein, andernfalls liefert die Funktion den
Fehlerwert #WERT!.

Mit dem Argument m geben Sie die Zahl der Monate an.

Wenn m Null ist, wird das Monatsende des gleichen Monats ermittelt.

Wenn m positiv ist, wird das Monatsende berechnet, das m Monate hinter dem Ausgangsdatum liegt.

Wenn m negativ ist, erhalten Sie das Monatsende, das m Monate vor dem Ausgangsdatum liegt.

m sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker die Nachkommastellen automa-
tisch.

Beispiel:

MONATSENDE("25.09.2018"; 0) ergibt den 30.09.2018

MONATSENDE("25.09.2018"; 1) ergibt den 31.10.2018

MONATSENDE("25.09.2018"; -1) ergibt den 31.08.2018

Siehe auch:

EDATUM

MSOLVE (Lösung eines linearen Gleichungssystems)

Syntax:

MSOLVE(A_Matrix; B_Vektor)

Beschreibung:

Liefert die Lösung eines linearen Gleichungssystem Ax=B.

A_Matrix ist die Matrix A. Sie können hierfür eine Matrix oder einen entsprechenden Zellbezug angeben.
A_Matrix muss numerische Werte enthalten und quadratisch sein, also die gleiche Anzahl an Zeilen und
Spalten besitzen. 

Weiterhin darf die Determinante dieser Matrix nicht Null sein, da diese Funktion sonst keine oder unendlich
viele Lösungen liefern würde.

B_Vektor ist der Vektor B. Auch hierfür können Sie einen Zellbereich oder eine Matrix angeben. Es muss
sich dabei um einen Vektor (also einen eindimensionalen Bereich) handeln, was bedeutet, dass B_Vektor
nur eine Spalte umfassen darf.

Das Ergebnis dieser Funktion ist ein Lösungsvektor.
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Bitte beachten Sie: Die Funktion MSOLVE berechnet nur dann korrekt, wenn der Lösungsvektor als Spal-
te angeordnet ist. Für die Anordnung des Lösungsvektors in einer Zeile müssen Sie zusätzlich noch die
Funktion MTRANS einsetzen, mit folgender Syntax:

MTRANS(MSOLVE(A_Matrix; B_Vektor))

Anmerkung:

Die Lösung wird bei dieser Funktion mit der Methode der Singulärwertzerlegung ermittelt. Bei größeren
Matrizen (mehr als 10-20 Zeilen) kann es hierbei unter Umständen zu signifikanten Rundungsfehlern kom-
men.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen. 

Beispiel:

Sie möchten folgendes lineares Gleichungssystem lösen:

2x + 3y = 4
2x + 2y = 8

Dazu würden Sie folgende Formel formulieren:

MSOLVE({2.3;2.2};{4;8})

Als Ergebnis wird der Vektor {8;-4} geliefert. x ist also 8, y ist -4.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Siehe auch:

Abschnitt Arbeiten mit Matrizen, MDET, MINV, MMULT, MTRANS

MTRANS (Transponieren einer Matrix)

Syntax:

MTRANS(Matrix)

Beschreibung:

Transponiert die übergebene Matrix, vertauscht also die Zeilen mit den Spalten. Wenn Sie beispielsweise
eine 2x4-Matrix transponieren, erhalten Sie eine 4x2-Matrix.
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Matrix kann eine Matrix oder ein entsprechender Zellbezug sein.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen. 

Beachten Sie dabei insbesondere, dass der vor der Eingabe der Formel zu markierende Bereich die korrek-
ten Ausmaße haben muss. Wenn die Matrix aus x Spalten und y Zeilen besteht, muss dieser Bereich y Spal-
ten und x Zeilen umfassen.

Beispiel:

MTRANS({1.2.3;4.5.6}) ergibt {1.4;2.5;3.6}

Siehe auch:

Abschnitt Arbeiten mit Matrizen, MDET, MINV, MMULT, MSOLVE

MULTINOMIAL (Multinomialkoeffizient)

Syntax:

MULTINOMIAL(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert den Multinomialkoeffizienten (auch: "Polynomialkoeffizient") einer Gruppe von Zahlen.

Alle übergebenen Zahlen müssen größer gleich 1 sein.

Beispiel:

MULTINOMIAL(1; 2; 3; 4; 5) ergibt 37837800

Hinweis:

Die Funktionen MULTINOMIAL und POLYNOMIAL sind komplett identisch.

Siehe auch:

POLYNOMIAL, FAKULTÄT
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N (Wert in Zahl umwandeln)

Syntax:

N(Wert)

Beschreibung:

Wandelt den übergebenen Wert in eine Zahl.

Der übergebene Wert muss eine Zahl, ein Datumswert oder ein Wahrheitswert sein, andernfalls liefert N
den Wert Null zurück. 

Hinweis:

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkulationen noch vorhanden.
PlanMaker selbst benötigt sie nicht mehr, da er Werte bei Bedarf automatisch in Zahlen umwandelt.

Beispiel:

N("Text") ergibt 0

N("42") ergibt 0

N(42) ergibt 42

N(WAHR) ergibt 1

Steht in Zelle A1 das Datum 25.09.2014, so gilt:

N(A1) ergibt 41907, die serielle Datumszahl für dieses Datum

Siehe auch:

T, WERT, TEXT

NACHKOMMA (Nachkommastellen einer Zahl)

Syntax:

NACHKOMMA(Zahl)

Beschreibung:

Liefert den Nachkommaanteil der angegebenen Zahl.
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Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

NACHKOMMA(5,779) ergibt 0,779

Anmerkung:

Die Vorkommastellen erhalten Sie mit der Funktion KÜRZEN.

Siehe auch:

KÜRZEN

NBW (Nettobarwert)

Syntax:

NBW(Zins; Zahlung1 [; Zahlung2; Zahlung3 ...])

Beschreibung:

Liefert den Nettobarwert (Kapitalwert) einer Investition, basierend auf einer Investition mit regelmäßigen
Zahlungen und feststehendem Zins.

Die Funktion erwartet folgende Argumente:

Zins ist der Zinssatz für die Dauer einer Periode.

Zahlung1, Zahlung2 etc. sind die Zahlungsvorgänge. Sie können entweder einzelne Werte oder ganze Zell-
bereiche mit Werten angeben. Wichtig: Die Zahlungen müssen jeweils an Ende einer Periode erfolgen. 

Die Zahlungen können unterschiedlich groß sein und aus Einzahlungen (positive Werte) und Auszahlungen
(negative Werte) bestehen. Sie müssen jedoch in gleichbleibenden Zeitabständen (jeweils am Ende einer
Periode) erfolgen und in genau der Reihenfolge eingetragen werden, in der sie tatsächlich erfolgt sind. 

Ausgelassene Zahlungen müssen mit 0 (Null) eingetragen werden.

Die Unterschiede zur Funktion BW:

1. Bei NBW sind unterschiedlich große Zahlungen möglich, bei BW nur gleichbleibende.

2. Bei NBW müssen Zahlungen stets am Ende der Periode erfolgen, bei BW können sie auch am Beginn der
Periode erfolgen.

Beispiel:

NBW(6,5%; 4000; 5000) ergibt 8164,16
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Siehe auch:

BW, XKAPITALWERT, IKV

NEG (Negativer Wert einer Zahl)

Syntax:

NEG(Zahl)

Beschreibung:

Kehrt das Vorzeichen einer Zahl um. 

Beispiel:

NEG(42) ergibt -42

NEG(-42) ergibt 42

NEG(0) ergibt 0

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Als Alternative können Sie einfach die Multiplikation mit dem Wert -1 verwenden. NEG(x) entspricht (-1) *
x.

Siehe auch:

ABS, VORZEICHEN

NEGBINOMVERT (Negative Binomialverteilung)

Hinweis: NEGBINOMVERT wird durch die neue Funktion NEGBINOM.VERT mit zusätzlicher Funk-
tionalität ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

NEGBINOMVERT(k; r; p)



578Formeln und Funktionen

Beschreibung:

Liefert die Wahrscheinlichkeiten einer negativ-binomialverteilten Zufallsvariablen.

Die negative Binomialverteilung (auch Pascal-Verteilung genannt) liefert die Wahrscheinlichkeit für das Er-
halten von k Fehlschlägen vor dem r-ten Treffer bei einem Zufallsexperiment mit voneinander unabhängi-
gen Wiederholungen und nur zwei möglichen Ergebnissen (Treffer oder Fehlschlag), wobei die Wahr-
scheinlichkeit für einen Treffer pro Wiederholung p beträgt.

k ist die Anzahl an Misserfolgen.

r ist die Anzahl an Treffern.

k und r sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen automa-
tisch weg.

p ist die Trefferwahrscheinlichkeit pro Wiederholung.

Beispiel:

In einer Urne befinden sich 1 rote und 5 schwarze Kugeln. Wie groß ist die Wahrscheinlichkeit (mit Zu-
rücklegen der Kugeln), genau 10 schwarze Kugeln (=Misserfolge) zu ziehen, bevor die 2-te rote Kugel
(=Erfolg) gezogen wird?

NEGBINOMVERT(10; 2; 1/6) ergibt 0,04935.

Siehe auch:

NEGBINOM.VERT, BINOM.VERT.BEREICH/BINOM.VERT/BINOMVERT,
HYPGEOM.VERT/HYPGEOMVERT

NEGBINOM.VERT (Negative Binomialverteilung)

Syntax:

NEGBINOM.VERT(k; r; p; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer negativ-binomialverteilten Zufallsvariablen.

Die negative Binomialverteilung (auch Pascal-Verteilung genannt) liefert die Wahrscheinlichkeit für das Er-
halten von k Fehlschlägen vor dem r-ten Treffer bei einem Zufallsexperiment mit voneinander unabhängi-
gen Wiederholungen und nur zwei möglichen Ergebnissen (Treffer oder Fehlschlag), wobei die Wahr-
scheinlichkeit für einen Treffer pro Wiederholung p beträgt.

k ist die Anzahl an Misserfolgen.

r ist die Anzahl an Treffern.

k und r sollten ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen automa-
tisch weg.
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p ist die Trefferwahrscheinlichkeit pro Wiederholung.

Kumuliert bestimmt als Schalter die Art der Funktion: Gibt man den Wert WAHR ein, wird die kumulierte
Verteilungsfunktion der negativen Binomialverteilung berechnet. Durch Eingabe von Wert FALSCH be-
rechnet sich die Dichtefunktion der negativen Binomial-Verteilung.

Beispiel:

In einer Urne befinden sich 1 rote und 5 schwarze Kugeln. Wie groß ist die Wahrscheinlichkeit (mit Zu-
rücklegen der Kugeln), genau bzw. höchstens 10 schwarze Kugeln (=Misserfolge) zu ziehen, bevor die 2-te
rote Kugel (=Erfolg) gezogen wird?

NEGBINOM.VERT(10; 2; 1/6; FALSCH) ergibt 0,04935

NEGBINOM.VERT(10; 2; 1/6; WAHR) ergibt 0,61867

Die Wahrscheinlichkeit, genau 10 schwarze Kugeln ziehen zu müssen, beträgt 4,9% (Dichtefunktion). Die
Wahrscheinlichkeit, höchstens 10 schwarze Kugeln ziehen zu müssen, beträgt 61,9% (kumulierte Vertei-
lungsfunktion)

Hinweis:

Die Funktion NEGBINOM.VERT ergänzt mit dem zusätzlichen Argument Kumuliert die bisherige Funkti-
on NEGBINOMVERT.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

NEGBINOMVERT, BINOM.VERT.BEREICH/BINOM.VERT/BINOMVERT,
HYPGEOM.VERT/HYPGEOMVERT

NETTOARBEITSTAGE (Zahl der Arbeitstage)

Syntax:

NETTOARBEITSTAGE(Ausgangsdatum; Enddatum [; FreieTage])

Beschreibung:

Ermittelt die Zahl der Arbeitstage zwischen Ausgangsdatum und Enddatum.

Samstage und Sonntage werden dabei übersprungen. Weiterhin kann der Funktion optional eine Liste mit
freien Tagen (z.B. Feiertagen) übergeben werden. Diese werden dann ebenfalls übersprungen.

Ausgangsdatum und Enddatum sind der erste beziehungsweise der letzte Tag des zu betrachtenden Zeitin-
tervalls.
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Für FreieTage kann optional eine Liste mit freien Tagen angegeben werden. (Hierfür verwendet man übli-
cherweise einen Zellbereich oder eine Matrix, die die entsprechenden Datumswerte enthält.)

Beispiel:

NETTOARBEITSTAGE("1.1.2010"; "31.1.2010") ergibt 22. 

Der Januar 2010 hatte also 22 Arbeitstage (ohne Berücksichtigung der Feiertage).

Möchte man dabei die Feiertage am 1.1.2010 und am 6.1.2010 berücksichtigen, kann man diese beiden Da-
ten beispielsweise in die Zellen A1 und A2 eintragen und dann schreiben:

NETTOARBEITSTAGE("1.1.2010"; "31.1.2010"; A1:A2) 

Das Ergebnis ist 20, da diese Feiertage im Jahr 2010 beide auf Wochentage fielen, also 2 Tage abzuziehen
sind.

Siehe auch:

ARBEITSTAG, TAGE/TAGEP, TAGE360, DATEDIF, FEIERTAG

NICHT (Logisches NICHT)

Syntax:

NICHT(Wahrheitswert)

Beschreibung:

Kehrt den übergebenen Wahrheitswert um. WAHR wird zu FALSCH und FALSCH wird zu WAHR.

Beispiel:

NICHT(WAHR) ergibt FALSCH

NICHT(A1=0) ergibt WAHR, wenn der Inhalt der Zelle A1 verschieden von Null ist.

Siehe auch:

ODER, UND, XODER

NOMINAL (Nominalverzinsung)

Syntax:

NOMINAL(EffZins; Zinsgutschriften)
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Beschreibung:

Ermittelt den nominalen Jahreszins, ausgehend vom effektiven Jahreszins und der Zahl der Zinsgutschriften
pro Jahr.

EffZins ist der effektive Jahreszins.

Zinsgutschriften ist die Zahl der Zinsgutschriften pro Jahr (muss mindestens 1 sein).

Beispiel:

Eine Geldanlage bietet 5% effektiven Jahreszins, Zinsen werden 4x pro Jahr gutgeschrieben. Wie hoch liegt
der nominale Jahreszins?

NOMINAL(5%; 4) ergibt ca. 4,91%

Siehe auch:

EFFEKTIV

NORMINV (Quantile einer Normalverteilung)

Hinweis: NORMINV wird durch die neue identische Funktion NORM.INV ergänzt, die in neueren Ver-
sionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

NORMINV(Wahrscheinlichkeit; Mittelwert; Standardabweichung)

Beschreibung:

Liefert Quantile einer Normalverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].

Mittelwert ist der Mittelwert der Verteilung.

Standardabweichung ist die Standardabweichung der Verteilung. Diese muss größer als Null sein.

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Siehe auch:

NORM.INV, NORM.VERT/NORMVERT, NORM.S.VERT/STANDNORMVERT,
NORM.S.INV/STANDNORMINV
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NORM.INV (Quantile einer Normalverteilung)

Syntax:

NORM.INV(Wahrscheinlichkeit; Mittelwert; Standardabweichung)

Beschreibung:

Liefert Quantile einer Normalverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].

Mittelwert ist der Mittelwert der Verteilung.

Standardabweichung ist die Standardabweichung der Verteilung. Diese muss größer als Null sein.

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

NORM.INV ist die Umkehrfunktion von NORM.VERT.

Siehe auch:

NORMINV, NORM.VERT/NORMVERT, NORM.S.VERT/STANDNORMVERT,
NORM.S.INV/STANDNORMINV

NORM.S.INV (Quantile einer Standardnormalverteilung)

Syntax:

NORM.S.INV(Wahrscheinlichkeit)
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Beschreibung:

Liefert Quantile einer Standardnormalverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].

Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

NORM.S.INV ist die Umkehrfunktion von NORM.S.VERT.

Siehe auch:

STANDNORMINV, NORM.INV/NORMINV, NORM.VERT/NORMVERT,
NORM.S.VERT/STANDNORMVERT

NORM.S.VERT (Standardnormalverteilung)

Syntax:

NORM.S.VERT(x; Kumuliert)

Beschreibung:

Liefert die (kumulierten) Wahrscheinlichkeiten einer standardnormalverteilten Zufallsvariablen.

Die Standardnormalverteilung (auch "standardisierte Normalverteilung" genannt) ist eine Normalverteilung
(siehe Funktion NORM.VERT/NORMVERT), deren arithmetisches Mittel m gleich Null und deren Stan-
dardabweichung s gleich 1 ist

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll.

Kumuliert bestimmt als Schalter die Art der Funktion: Gibt man den Wert WAHR ein, wird die kumulierte
Verteilungsfunktion der Standardnormalverteilung berechnet. Durch Eingabe von Wert FALSCH berechnet
sich die Dichtefunktion der Standardnormalverteilung.
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Hinweis:

Die Funktion NORM.S.VERT ergänzt mit dem zusätzlichen Argument Kumuliert die bisherige Funktion
STANDNORMVERT.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist NORM.S.INV

Siehe auch:

STANDNORMVERT, NORM.INV/NORMINV, NORM.S.INV/STANDNORMINV,
STANDARDISIERUNG, GAUSS, LOGNORM.INV/LOGINV, LOGNORM.VERT/LOGNORMVERT

NORMVERT (Normalverteilung)

Hinweis: NORMVERT wird durch die neue identische Funktion NORM.VERT ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

NORMVERT(x; E; S; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer normalverteilten Zufallsvariablen.

Die Normalverteilung (auch Gauß-Verteilung oder Gaußsche Glockenkurve genannt) ist in der Wahrschein-
lichkeitsrechnung von großer Bedeutung, da viele Zufallsvariablen normalverteilt oder zumindest annähernd
normalverteilt sind.

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll.

Für E ist der Erwartungswert m (My) der Verteilung anzugeben.

Für S ist die Standardabweichung s (Sigma) der Verteilung anzugeben.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion (also die Gaußsche Glockenkurve) geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.
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Dichtefunktion (links) und Verteilungsfunktion (rechts)

Siehe auch:

NORM.VERT, NORM.INV/NORMINV, NORM.S.VERT/STANDNORMVERT,
NORM.S.INV/STANDNORMINV

NORM.VERT (Normalverteilung)

Syntax:

NORM.VERT(x; E; S; Kumuliert)

Beschreibung:

Liefert die Wahrscheinlichkeiten einer normalverteilten Zufallsvariablen.

Die Normalverteilung (auch Gauß-Verteilung oder Gaußsche Glockenkurve genannt) ist in der Wahrschein-
lichkeitsrechnung von großer Bedeutung, da viele Zufallsvariablen normalverteilt oder zumindest annähernd
normalverteilt sind.

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll.

Für E ist der Erwartungswert m (My) der Verteilung anzugeben.

Für S ist die Standardabweichung s (Sigma) der Verteilung anzugeben.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion (also die Gaußsche Glockenkurve) geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

     

Dichtefunktion (links) und Verteilungsfunktion (rechts)
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Anmerkung:

Die Umkehrfunktion zu dieser Funktion ist NORM.INV

Siehe auch:

NORMVERT, NORM.INV/NORMINV, NORM.S.VERT/STANDNORMVERT,
NORM.S.INV/STANDNORMINV

NOTIERUNGBRU (Geldbetrag in Dezimalbruch wandeln)

Syntax:

NOTIERUNGBRU(Zahl; Teiler)

Beschreibung:

Wandelt einen Geldbetrag, der als Dezimalzahl ausgedrückt ist, in einen Dezimalbruch um.

(In den USA ist es bei manchen Arten von Geldgeschäften üblich, Geldbeträge als Bruchzahlen darzustellen
– zum Beispiel 27 4/8 statt 27,50.)

Zahl ist die umzuwandelnde Zahl.

Teiler ist der gewünschte Teiler. Er muss größer gleich 1 sein. Weiterhin sollte Teiler eine ganze Zahl sein.
Ist dies nicht der Fall, entfernt PlanMaker automatisch alle Nachkommastellen.

Beispiel:

NOTIERUNGBRU(27,5; 8) ergibt 27,4 (da 27,5 dem Bruch 27 4/8 entspricht)

Siehe auch:

NOTIERUNGDEZ

NOTIERUNGDEZ (Geldbetrag in Dezimalzahl wandeln)

Syntax:

NOTIERUNGDEZ(Zahl; Teiler)
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Beschreibung:

Wandelt einen Geldbetrag, der als Dezimalbruch ausgedrückt ist, in eine Dezimalzahl um.

(In den USA ist es bei manchen Arten von Geldgeschäften üblich, Geldbeträge als Bruchzahlen darzustellen
– zum Beispiel 27 4/8 statt 27,50.)

Zahl ist die umzuwandelnde Zahl.

Teiler ist der verwendete Teiler. Er muss größer gleich 1 sein. Weiterhin sollte Teiler eine ganze Zahl sein.
Ist dies nicht der Fall, entfernt PlanMaker automatisch alle Nachkommastellen.

Beispiel:

NOTIERUNGDEZ(27,4; 8) wandelt die Bruchzahl 27 4/8 in die Dezimalzahl 27,5 um.

Siehe auch:

NOTIERUNGBRU

NV (Nicht vorhanden)

Syntax:

NV()

Beschreibung:

Liefert den Fehlerwert #NV ("nicht vorhanden").

Mit Hilfe dieser Funktion können Sie leere Zellen, die erst später ausgefüllt werden sollen, als noch nicht
vorhanden kennzeichnen. Alle Berechnungen, die sich auf eine solche Zelle beziehen, haben stets den Feh-
lerwert #NV als Ergebnis.

Auf diese Weise können Sie verhindern, dass Berechnungen mit leeren Zellen durchgeführt werden, obwohl
diese Zellen zwingend mit Werten gefüllt sein müssten, damit ein korrektes Ergebnis geliefert werden
kann. 

Anmerkung:

Statt =NV() können Sie auch #NV in die Zelle eingeben, was das gleiche Resultat liefert.

Beispiel:

Sie möchten Ihren Jahresumsatz anhand der Summe der vier Quartalsergebnisse berechnen. Diese werden in
die Zellen A1 bis A4 eingetragen; der Jahresumsatz ließe sich also mit der Formel SUMME(A1:A4) berech-
nen.

Es gibt nur ein Problem: Das Ergebnis für das vierte Quartal liegt noch nicht vor; die Zelle A4 ist also leer.
Der Jahresumsatz darf also noch nicht ausgerechnet werden.
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PlanMaker berechnet jedoch stur die Summe von A1 bis A4 – auch dann, wenn einer der Werte fehlt. Er-
gebnis: ein scheinbar miserables Jahresergebnis, schreiend davonlaufende Aktionäre.

Wesentlich gesünder ist es, die Zelle A4 nicht einfach leer zu lassen, sondern dort NV() einzutragen. Damit
kennzeichnen Sie die Zelle als noch "nicht vorhanden". Das bewirkt, dass die Summenformel jetzt als Er-
gebnis keinen falschen Zahlenwert mehr hat, sondern den Fehlerwert #NV. Das signalisiert, dass eines der
Quartalsergebnisse noch nicht vorhanden ist, der Jahresumsatz also noch nicht berechnet werden kann. Er-
gebnis: keine schreiend davonlaufenden Aktionäre.

Siehe auch:

ISTNV, ISTFEHL, ISTFEHLER, FEHLERTYP, Abschnitt über Fehlerwerte

OBERGRENZE (Aufrunden auf ein Vielfaches von n)

Syntax:

OBERGRENZE(Zahl; Basis)

Beschreibung:

Rundet Zahl auf ein Vielfaches von Basis auf.

Bei positiven Zahlen wird auf das nächstgrößere Vielfache von Basis aufgerundet, bei negativen Zahlen hin-
gegen auf das nächstkleinere Vielfache abgerundet.

Zahl und Basis müssen das gleiche Vorzeichen haben, sonst liefert die Funktion den Fehlerwert #ZAHL!

Beispiel:

OBERGRENZE(42,5; 1) ergibt 43

OBERGRENZE(-42,5; -1) ergibt -43

OBERGRENZE(21; 5) ergibt 25

OBERGRENZE(12,3456; 0,01) ergibt 12,35

Siehe auch:

UNTERGRENZE, VRUNDEN, RUNDEN, KÜRZEN

ODER (Logisches ODER)

Syntax:

ODER(Wahrheitswert1 [; Wahrheitswert2; Wahrheitswert3 ...])
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Beschreibung:

Diese Funktion liefert WAHR, wenn mindestens einer der übergebenen Wahrheitswerte WAHR ist, ansons-
ten liefert sie FALSCH.

Sie können damit beispielsweise prüfen, ob von mehreren Bedingungen mindestens eine zutrifft.

Beispiel:

ODER(WAHR; WAHR) ergibt WAHR

ODER(WAHR; FALSCH) ergibt WAHR

ODER(FALSCH; FALSCH) ergibt FALSCH

ODER(A1=0; A1>10) ergibt WAHR; wenn A1 entweder Null oder größer als Zehn ist.

Siehe auch:

XODER, UND, NICHT

OKTINBIN (Oktalzahl in Binärzahl wandeln)

Syntax:

OKTINBIN(Zahl [; Stellen])

Beschreibung:

Wandelt eine Oktalzahl (Basis 8) in eine Binärzahl (Basis 2) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise):

20000000000 £ Zahl £ 17777777777

Das entspricht in Dezimalschreibweise:

-2.147.483.648 £ Zahl £ 2.147.483.647

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert.
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Beispiel:

OKTINBIN("52") ergibt 101010

OKTINBIN("52"; 8) ergibt 00101010

OKTINBIN("52"; 2) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindestens 6 Stellen dargestellt
werden kann

OKTINBIN("37777777726") ergibt 11111111111111111111111111010110 (negative Zahl)

Siehe auch:

BININOKT, OKTINDEZ, OKTINHEX

OKTINDEZ (Oktalzahl in Dezimalzahl wandeln)

Syntax:

OKTINDEZ(Zahl)

Beschreibung:

Wandelt eine Oktalzahl (Basis 8) in eine Dezimalzahl (Basis 10) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise):

20000000000 £ Zahl £ 17777777777

Das entspricht in Dezimalschreibweise:

-2.147.483.648 £ Zahl £ 2.147.483.647

Beispiel:

OKTINDEZ("52") ergibt 42

OKTINDEZ("0052") ergibt ebenfalls 42

OKTINDEZ("37777777726") ergibt -42

Siehe auch:

DEZINOKT, OKTINBIN, OKTINHEX, DEZIMAL 
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OKTINHEX (Oktalzahl in Hexadezimalzahl wandeln)

Syntax:

OKTINHEX(Zahl [; Stellen])

Beschreibung:

Wandelt eine Oktalzahl (Basis 8) in eine Hexadezimalzahl (Basis 16) um.

Zahl ist die umzuwandelnde Zahl.

Negative Zahlen müssen im 32 Bit-Zweier-Komplement notiert sein (siehe letztes Beispiel). 

Der zulässige Wertebereich für Zahl ist (in Oktalschreibweise):

20000000000 £ Zahl £ 17777777777

Das entspricht in Dezimalschreibweise:

-2.147.483.648 £ Zahl £ 2.147.483.647

Mit dem optionalen Argument Stellen kann festgelegt werden, wie viele Stellen angezeigt werden sollen.
Wird es nicht angegeben, ermittelt PlanMaker die benötigte Stellenzahl automatisch.

Stellen muss größer Null sein. Weiterhin sollte Stellen eine ganze Zahl sein. Ist dies nicht der Fall, schnei-
det PlanMaker die Nachkommastellen automatisch ab.

Wenn Stellen kleiner als die für die Darstellung der Zahl benötigte Mindestanzahl an Stellen ist, liefert die
Funktion den Fehlerwert #ZAHL!.

Wenn Zahl negativ ist, wird das Ergebnis im 32 Bit-Zweier-Komplement dargestellt; das Argument Stellen
wird in diesem Fall ignoriert.

Beispiel:

OKTINHEX("52") ergibt 2A

OKTINHEX("0052") ergibt ebenfalls 2A

OKTINHEX("52"; 1) ergibt den Fehlerwert #ZAHL!, da diese Zahl nur mit mindestens 2 Stellen dargestellt
werden kann

OKTINHEX("37777777726") ergibt FFFFFFD6 (negative Zahl)

Siehe auch:

HEXINOKT, OKTINBIN, OKTINDEZ
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PEARSON (Pearsonscher Korrelationskoeffizient)

Syntax:

PEARSON(Bereich1; Bereich2)

Beschreibung:

Berechnet den Pearsonschen Korrelationskoeffizienten r zweier Datengruppen.

Dieser ist ein Maß für die lineare Abhängigkeit der Datengruppen.

PEARSON kann Werte zwischen -1 und 1 annehmen. 1 bedeutet perfekte lineare Abhängigkeit. -1 zeigt per-
fekte reziproke Abhängigkeit (die Werte in Bereich2 nehmen so ab, wie die Werte in Bereich1 zunehmen).

Bereich1 und Bereich2 sind Zellbezüge auf die beiden Datengruppen. Diese sollten Zahlen enthalten. Leere
Zellen sowie Zeichenketten und Wahrheitswerte werden ignoriert.

Die beiden Datengruppen müssen die gleiche Anzahl an Werten besitzen, ansonsten liefert die Funktion den
Fehlerwert #NV.

Beispiel:

Sind die Zellen A1 bis A3 mit den Werten 1, 2, 3 und die Zellen B1 bis B3 mit den Werten 2, 3, 4 gefüllt, so
gilt:

PEARSON(A1:A3; B1:B3) ergibt 1

Sind die Zellen A1 bis A3 mit den Werten 1, 2, 3 und die Zellen B1 bis B3 mit den Werten 4, 3, 2 gefüllt, so
gilt:

PEARSON(A1:A3; B1:B3) ergibt -1

Siehe auch:

BESTIMMTHEITSMASS, STEIGUNG, ACHSENABSCHNITT

PHI (Standardnormalverteilung)

Syntax:

PHI(x)

Beschreibung:

Liefert die Dichtefunktion einer Standardnormalverteilung.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Wir empfehlen Ihnen daher, stattdessen die Funktion NORMVERT zu verwenden, da diese von allen Excel-
Versionen unterstützt wird:

PHI(x) entspricht NORMVERT(x; 0; 1; FALSCH)

Siehe auch:

NORM.VERT/NORMVERT, GAUSS

PI (Kreiszahl Pi)

Syntax:

PI()

Beschreibung:

Liefert die Kreiszahl p (Pi), die das Verhältnis vom Umfang eines Kreises (2rp) zu seinem Durchmesser
(2r) angibt. 

Beispiel:

PI() ergibt 3,14159265...

PIVOTDATENZUORDNEN

Syntax:

PIVOTDATENZUORDNEN(Wertefeld; Pivotbereich [; Feld1; Beschriftung1; Feld2; Beschriftung2;...])

Beschreibung:

Liefert die Werte einer vorhandenen Pivot-Tabelle, indem bestimmte Felder aus der Pivot-Tabellenstruktur
abgerufen werden.

Wertefeld: Der Name des Feldes, das Sie in der Pivot-Tabelle im Bereich Werte abgelegt haben und dessen
Daten Sie über die Funktion abrufen können. Das Argument muss in doppelten Anführungszeichen angege-
ben werden.
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Pivotbereich: Die referenzierte Pivot-Tabelle. Es genügt, eine beliebige Zelle des Pivot-Tabellen Zielbe-
reichs anzusteuern. Das Argument wird ohne Anführungszeichen angegeben.

Feld1, Beschriftung1, Feld2, Beschriftung2,...: Sie können die Ausgabe der Werte eingrenzen, indem Sie
ein bestimmtes Feld in Verbindung mit einem Element aus dem Feld abrufen. Die Aneinanderreihung meh-
rerer Kombinationen ist möglich. Das Argument muss in doppelten Anführungszeichen angegeben werden.

Wertefeld und Pivotbereich sind als Argumente erforderlich, Felder/Beschriftungen optional.

Anmerkung:

Für den Pivotbereich ist auch die Eingabe eines Benannten Bereichs möglich, dazu müssen Sie allerdings
dem Zellbereich des Pivot-Tabellen-Berichts zuvor einen Namen vergeben haben. Markieren Sie dazu eine
Zelle des Pivot-Tabellen-Berichts (Sie müssen nicht den gesamten Bereich markieren) und folgen Sie der
Beschreibung im Abschnitt Bereiche benennen.

Den automatisch von PlanMaker generierten Namen (z.B. "Pivot Tabelle 1") können Sie nicht als Benann-
ten Bereich verwenden. Nur Namen, die über den Menübefehl Arbeitsblatt > Namen > Bearbeiten erstellt
wurden, können für den Pivotbereich auch tatsächlich als Namen zugewiesen werden.

Beispiel:

Hier sind Beispieldaten aus dem Abschnitt Pivot-Tabellen. Vorausgesetzt, Ihr Pivot-Tabellen-Bericht befin-
det sich im Zellbereich F1:G12 und das Feld "Betrag" ist im Bereich Werte, die Felder "Mitarbeiter" und
"Artikel" im Bereich Zeilenbeschriftungen:

PIVOTDATENZUORDNEN("Betrag"; F1) ergibt 200, da das Gesamtergebnis für alle Werte von Betrag
angezeigt wird.

PIVOTDATENZUORDNEN("Betrag"; F1; "Mitarbeiter"; "Anna") ergibt 123, da das Ergebnis für Betrag
auf das Feld Mitarbeiter mit dem darin enthaltenen Element Anna eingeschränkt wird.

PIVOTDATENZUORDNEN("Betrag"; F1; "Mitarbeiter"; "Anna"; "Artikel"; "Kaffee") ergibt 75, da das
Ergebnis für Betrag auf das Feld Mitarbeiter/Element Anna in Kombination mit dem Feld Artikel/Element
Kaffee eingeschränkt wird.
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POISSON (Poisson-Verteilung)

Hinweis: POISSON wird durch die neue identische Funktion POISSON.VERT ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

POISSON(x; Lambda; Kumuliert)

Beschreibung:

Liefert Wahrscheinlichkeiten einer Poisson-verteilten Zufallsvariablen.

Die Poisson-Verteilung beschreibt das Eintreffen voneinander unabhängiger, gleichartiger Ereignisse in ei-
nem Zeitraum (zum Beispiel das Eintreffen von Kunden an einem Schalter oder das Eingehen von Telefon-
anrufen). 

Sie eignet sich besonders für Wahrscheinlichkeitsverteilungen, bei denen sehr viele Ergebnisse aus einer
Stichprobe vorliegen und die Wahrscheinlichkeit, dass das zu untersuchende Ereignis eintritt, sehr klein ist.
Hier nähert sich die Poisson-Verteilung nämlich der Binomialverteilung (mit Lambda = n*p) an. Im Gegen-
satz zur Binomialverteilung benötigt sie (abgesehen von x) jedoch nur einen Parameter: den Erwartungswert
Lambda (siehe Beispiel).

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als Null sein. Weiterhin
sollte x eine ganze Zahl sein. Ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Lambda (l) ist der erwartete Wert (Mittelwert) für x. Lambda muss größer als Null sein.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

Beispiel:

Bei einem bestimmten Reifentyp für Pkws treten bei 100.000 km Fahrt durchschnittlich 4 Reifenschäden
auf. 

Wie groß ist die Wahrscheinlichkeit, dass nur 3 Reifenschäden auftreten?

Möchte man dies mit der Binomialverteilung berechnen (Funktion BINOM.VERT/BINOMVERT), müsste
man schreiben:

BINOMVERT(3; 100000; 4/100000; FALSCH) ergibt 0,195368768

Verwendet man hingegen die Poisson-Verteilung, kann man auf die Parameter n und p verzichten und
schreibt schlicht und ergreifend:

POISSON(3; 4; FALSCH) ergibt 0,195366815

Die beiden Ergebnisse sind (wie oben beschrieben) erwartungsgemäß sehr ähnlich.

Weiteres Beispiel: Wie groß ist die Wahrscheinlichkeit, dass höchstens 3 Schäden auftreten?
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Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument Kumuliert mit WAHR
angeben):

POISSON(3; 4; WAHR) ergibt 0,43347

Siehe auch:

POISSON.VERT, BINOM.VERT.BEREICH/BINOM.VERT/BINOMVERT,
EXPON.VERT/EXPONVERT 

POISSON.VERT (Poisson-Verteilung)

Syntax:

POISSON.VERT(x; Lambda; Kumuliert)

Beschreibung:

Liefert Wahrscheinlichkeiten einer Poisson-verteilten Zufallsvariablen.

Die Poisson-Verteilung beschreibt das Eintreffen voneinander unabhängiger, gleichartiger Ereignisse in ei-
nem Zeitraum (zum Beispiel das Eintreffen von Kunden an einem Schalter oder das Eingehen von Telefon-
anrufen). 

Sie eignet sich besonders für Wahrscheinlichkeitsverteilungen, bei denen sehr viele Ergebnisse aus einer
Stichprobe vorliegen und die Wahrscheinlichkeit, dass das zu untersuchende Ereignis eintritt, sehr klein ist.
Hier nähert sich die Poisson-Verteilung nämlich der Binomialverteilung (mit Lambda = n*p) an. Im Gegen-
satz zur Binomialverteilung benötigt sie (abgesehen von x) jedoch nur einen Parameter: den Erwartungswert
Lambda (siehe Beispiel).

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer als Null sein. Weiterhin
sollte x eine ganze Zahl sein. Ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Lambda (l) ist der erwartete Wert (Mittelwert) für x. Lambda muss größer als Null sein.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

Beispiel:

Bei einem bestimmten Reifentyp für Pkws treten bei 100.000 km Fahrt durchschnittlich 4 Reifenschäden
auf. 

Wie groß ist die Wahrscheinlichkeit, dass nur 3 Reifenschäden auftreten?

Möchte man dies mit der Binomialverteilung berechnen (Funktion BINOM.VERT/BINOMVERT), müsste
man schreiben:

BINOM.VERT(3; 100000; 4/100000; FALSCH) ergibt 0,195368768
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Verwendet man hingegen die Poisson-Verteilung, kann man auf die Parameter n und p verzichten und
schreibt schlicht und ergreifend:

POISSON.VERT(3; 4; FALSCH) ergibt 0,195366815

Die beiden Ergebnisse sind (wie oben beschrieben) erwartungsgemäß sehr ähnlich.

Weiteres Beispiel: Wie groß ist die Wahrscheinlichkeit, dass höchstens 3 Schäden auftreten?

Hier verwendet man statt der Dichtefunktion die Verteilungsfunktion (Argument Kumuliert mit WAHR
angeben):

POISSON.VERT(3; 4; WAHR) ergibt 0,43347

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

POISSON, BINOM.VERT.BEREICH/BINOM.VERT/BINOMVERT, EXPON.VERT/EXPONVERT 

POLYNOMIAL (Polynomialkoeffizient)

Syntax:

POLYNOMIAL(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert den Polynomialkoeffizienten (auch: "Multinomialkoeffizient") einer Gruppe von Zahlen.

Alle übergebenen Zahlen müssen größer gleich 1 sein.

Beispiel:

POLYNOMIAL(1; 2; 3; 4; 5) ergibt 37837800

Hinweis:

Die Funktionen POLYNOMIAL und MULTINOMIAL sind komplett identisch.

Siehe auch:

MULTINOMIAL, FAKULTÄT
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POTENZ (Potenzierung)

Syntax:

POTENZ(x; y)

Beschreibung:

Berechnet x hoch y.

Anmerkung:

Mit dem Operator ^ können Sie genau das Gleiche erreichen: 

POTENZ(x; y) entspricht x^y.

Beispiel:

POTENZ(2; 4) entspricht 2^4, ergibt also 16

Siehe auch:

LOG, LN, EXP, POTENZREIHE, WURZEL, WURZELN, Abschnitt Operatoren in Berechnungen

POTENZREIHE (Potenzreihe)

Syntax:

POTENZREIHE(x; n; m; Koeffizienten)

Beschreibung:

Liefert eine Potenzreihe gemäß folgender Formel:

POTENZREIHE(x,n,m,a) = 

a1*x^n + a2*x^(n+m) + a3*x^(n+2m) + a4*x^(n+3m) + ...

x ist die Basis.

n ist der Exponent für das erste Glied der Reihe.

m ist das Inkrement für n.

Koeffizienten sind die Koeffizienten, mit denen die einzelnen Glieder der Reihe multipliziert werden. Ko-
effizienten kann entweder ein Zellbezug oder eine einspaltige Matrix sein.
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Die Zahl der Koeffizienten bestimmt gleichzeitig, aus wie vielen Gliedern die Reihe bestehen wird. Sind
beispielsweise 10 Koeffizienten angegeben, wird eine Reihe mit 10 Gliedern gebildet.

Beispiel:

POTENZREIHE(2; 2; 1; {1; 2; 3; 4; 5}) ergibt 516

Siehe auch:

POTENZ

PRODUKT (Produkt)

Syntax:

PRODUKT(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Liefert das Produkt der angegebenen Zahlen, multipliziert sie also miteinander.

Anmerkung:

Beachten Sie: Normalerweise berücksichtigt diese Funktion nur Zahlen und ignoriert Zeichenketten und
Wahrheitswerte. Anders sieht es allerdings aus, wenn Sie ihr feste Werte übergeben: Hier werden Zeichen-
ketten, die Zahlen enthalten, mitgezählt. Weiterhin werden die Wahrheitswerte WAHR als 1 und FALSCH
als 0 behandelt. Siehe Beispiele:

Beispiel:

PRODUKT(2; 3; 4) entspricht 2*3*4, ergibt also 24

Wenn die Zellen A1 bis A3 mit den Werten 2, 3 und 4 gefüllt sind, gilt:

PRODUKT(A1:A3) entspricht 2*3*4, ergibt also 24

Beachten Sie:

PRODUKT(2; "5"; WAHR) ergibt 2*5*1, also 10

Aber: Sind die Zellen A1 bis A3 mit 2, "5" und WAHR gefüllt, liefert die Formel PRODUKT(A1:A3) ein
anderes Ergebnis: Es kommt 2 heraus, da Zeichenketten und Wahrheitswerte nur berücksichtigt werden,
wenn sie als feste Werte übergeben werden.

Siehe auch:

SUMME
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QIKV (Modifizierter interner Zinsfuß)

Syntax:

QIKV(Werte; Investition; Reinvestition)

Beschreibung:

Liefert ein modifiziertes Modell des IKV (interner Zinsfuß), das Sollzins (für Investitionen) und Habenzins
(für Reinvestitionen) berücksichtigt. 

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Werte) und Einzahlungen
(positive Werte). Die Zahlungen dürfen unterschiedlich groß sein, müssen jedoch in gleichmäßigen Zeitin-
tervallen (z.B. monatlich oder jährlich) auftreten.

Die Funktion erwartet folgende Argumente:

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wurden. Es muss mindestens ei-
ne Auszahlung und eine Einzahlung vorliegen.

Für Investition ist der Sollzins (für Investitionen) anzugeben.

Für Reinvestition ist der Habenzins (für Reinvestitionen) anzugeben. 

Siehe auch:

IKV, NBW, XINTZINSFUSS, ZINS

QUADRATESUMME (Summe der Quadrate)

Syntax:

QUADRATESUMME(Zahl1 [; Zahl2; Zahl3 ...])

Beschreibung:

Ermittelt die Summe der Quadrate der übergebenen Zahlenwerte.

Beispiel:

QUADRATESUMME(1; 2; 3) entspricht 1^2 + 2^2 + 3^2, ergibt also 14.

Siehe auch:

SUMME, SUMMENPRODUKT, SUMMEXMY2, SUMMEX2MY2, SUMMEX2PY2
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QUANTIL (Quantile einer Datenmenge)

Hinweis: QUANTIL wird durch die neue identische Funktion QUANTIL.INKL und die gänzlich neue
Funktion QUANTIL.EXKL ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet
werden.

Syntax:

QUANTIL(Bereich; Alpha)

Beschreibung:

Ermittelt das Alpha-Quantil einer Datenmenge. 

Geben Sie für Alpha beispielsweise 0,5 an, wird das 0,5-Quantil (der Median) geliefert.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

Alpha ist der gewünschte Prozentwert. Zulässig sind Werte zwischen 0 bis 1 (einschließlich), mit 0=0%
und 1=100%.

Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1 bis 9 eingetragen, so gilt:

QUANTIL(A1:A9; 0,75) ergibt 7

Siehe auch:

QUANTIL.INKL/QUANTIL.EXKL, QUARTILE.EXKL/QUARTILE.INKL/QUARTILE,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG, MEDIAN,
MODUS.EINF/MODALWERT, RANG.GLEICH/RANG.MITTELW/RANG

QUANTIL.EXKL (Quantile einer Datenmenge)

Syntax:

QUANTIL.EXKL(Bereich; Alpha)

Beschreibung:

Ermittelt das Alpha-Quantil einer Datenmenge. 

Geben Sie für Alpha beispielsweise 0,5 an, wird das 0,5-Quantil (der Median) geliefert.
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Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

Alpha ist der gewünschte Prozentwert. Zulässig sind Werte zwischen 0 bis 1 (ausschließlich), mit 0=0%
und 1=100%.

Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1 bis 9 eingetragen, so gilt:

QUANTIL.EXKL(A1:A9; 0,75) ergibt 7,5

Hinweis:

Die Funktion QUANTIL.EXKL ergänzt zusammen mit QUANTIL.INKL die bisherige Funktion
QUANTIL.

QUANTIL.INKL liefert dasselbe Ergebnis wie QUANTIL (einschließliche Werte 0 bis 1).

QUANTIL.EXKL (ausschließliche Werte 0 bis 1) ist gänzlich neu.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

QUARTILE.EXKL/QUARTILE.INKL/QUARTILE,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG, MEDIAN,
MODUS.EINF/MODALWERT, RANG.GLEICH/RANG.MITTELW/RANG

QUANTIL.INKL (Quantile einer Datenmenge)

Syntax:

QUANTIL.INKL(Bereich; Alpha)

Beschreibung:

Ermittelt das Alpha-Quantil einer Datenmenge. 

Geben Sie für Alpha beispielsweise 0,5 an, wird das 0,5-Quantil (der Median) geliefert.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

Alpha ist der gewünschte Prozentwert. Zulässig sind Werte zwischen 0 bis 1 (einschließlich), mit 0=0%
und 1=100%.
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Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1 bis 9 eingetragen, so gilt:

QUANTIL.INKL(A1:A9; 0,75) ergibt 7

Hinweis:

Die Funktion QUANTIL.INKL ergänzt zusammen mit QUANTIL.EXKL die bisherige Funktion
QUANTIL.

QUANTIL.INKL liefert dasselbe Ergebnis wie QUANTIL (einschließliche Werte 0 bis 1).

QUANTIL.EXKL (ausschließliche Werte 0 bis 1) ist gänzlich neu.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

QUARTILE.EXKL/QUARTILE.INKL/QUARTILE,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG, MEDIAN,
MODUS.EINF/MODALWERT, RANG.GLEICH/RANG.MITTELW/RANG

QUANTILSRANG (Prozentrang eines Wertes)

Hinweis: QUANTILSRANG wird durch die neue identische Funktion QUANTILSRANG.INKL und die
gänzlich neue Funktion QUANTILSRANG.EXKL ergänzt, die in neueren Versionen von Microsoft Ex-
cel (ab 2010) verwendet werden.

Syntax:

QUANTILSRANG(Bereich; Zahl [; Stellen])

Beschreibung:

Liefert den prozentualen Rang (zwischen 0 und 1 einschließlich) eines Werts innerhalb einer Datenmenge.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

Zahl ist der Wert, dessen Rang bestimmt werden soll. Wenn Zahl nicht in der angegebenen Datenmenge
enthalten ist, wird eine Interpolation durchgeführt.

Mit dem optionalen Argument Stellen können Sie bestimmen, auf wie viele Nachkommastellen das Ergeb-
nis berechnet werden soll. Geben Sie dazu die gewünschte Anzahl an Nachkommastellen an. Wenn Sie
nichts angeben, werden drei Nachkommastellen verwendet.
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Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt:

QUANTILSRANG(A1:A9; 5) ergibt 0,5(=50%) Mitte der gegebenen Werte; Median

QUANTILSRANG(A1:A9; 1) ergibt 0 (=0%) minimaler Wert

QUANTILSRANG(A1:A9; 9) ergibt 1 (=100%) maximaler Wert

Siehe auch:

QUANTILSRANG.INKL/QUANTILSRANG.EXKL, QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUARTILE.EXKL/QUARTILE.INKL/QUARTILE, RANG.GLEICH/RANG.MITTELW/RANG

QUANTILSRANG.EXKL (Prozentrang eines Wertes)

Syntax:

QUANTILSRANG.EXKL(Bereich; Zahl [; Stellen])

Beschreibung:

Liefert den prozentualen Rang (zwischen 0 und 1 ausschließlich) eines Werts innerhalb einer Datenmenge.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

Zahl ist der Wert, dessen Rang bestimmt werden soll. Wenn Zahl nicht in der angegebenen Datenmenge
enthalten ist, wird eine Interpolation durchgeführt.

Mit dem optionalen Argument Stellen können Sie bestimmen, auf wie viele Nachkommastellen das Ergeb-
nis berechnet werden soll. Geben Sie dazu die gewünschte Anzahl an Nachkommastellen an. Wenn Sie
nichts angeben, werden drei Nachkommastellen verwendet.

Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt:

QUANTILSRANG.EXKL(A1:A9; 5) ergibt 0,5 (=50%) Mitte der gegebenen Werte; Median

QUANTILSRANG.EXKL(A1:A9; 1) ergibt 0,1 (=10%) minimaler Wert

QUANTILSRANG.EXKL(A1:A9; 9) ergibt 0,9 (=90%) maximaler Wert

Hinweis:

Die Funktion QUANTILSRANG.EXKL ergänzt zusammen mit QUANTILSRANG.INKL die bisherige
Funktion QUANTILSRANG.

QUANTILSRANG.INKL liefert dasselbe Ergebnis wie QUANTILSRANG (einschließliche Werte 0 bis 1).

QUANTILSRANG.EXKL (ausschließliche Werte 0 bis 1) ist gänzlich neu.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

QUANTIL.EXKL/QUANTIL.INKL/QUANTIL, QUARTILE.EXKL/QUARTILE.INKL/QUARTILE,
RANG.GLEICH/RANG.MITTELW/RANG

QUANTILSRANG.INKL (Prozentrang eines Wertes)

Syntax:

QUANTILSRANG.INKL(Bereich; Zahl [; Stellen])

Beschreibung:

Liefert den prozentualen Rang (zwischen 0 bis 1 einschließlich) eines Werts innerhalb einer Datenmenge.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
Zahlen eingetragen sind.

Zahl ist der Wert, dessen Rang bestimmt werden soll. Wenn Zahl nicht in der angegebenen Datenmenge
enthalten ist, wird eine Interpolation durchgeführt.

Mit dem optionalen Argument Stellen können Sie bestimmen, auf wie viele Nachkommastellen das Ergeb-
nis berechnet werden soll. Geben Sie dazu die gewünschte Anzahl an Nachkommastellen an. Wenn Sie
nichts angeben, werden drei Nachkommastellen verwendet.

Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt:

QUANTILSRANG.INKL(A1:A9; 5) ergibt 0,5 (=50%) Mitte der gegebenen Werte; Median

QUANTILSRANG.INKL(A1:A9; 1) ergibt 0 (=0%) minimaler Wert

QUANTILSRANG.INKL(A1:A9; 9) ergibt 1 (=100%) maximaler Wert

Hinweis:

Die Funktion QUANTILSRANG.INKL ergänzt zusammen mit QUANTILSRANG.EXKL die bisherige
Funktion QUANTILSRANG.

QUANTILSRANG.INKL liefert dasselbe Ergebnis wie QUANTILSRANG (einschließliche Werte 0 bis 1).

QUANTILSRANG.EXKL (ausschließliche Werte 0 bis 1) ist gänzlich neu.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

QUANTIL.EXKL/QUANTIL.INKL/QUANTIL, QUARTILE.EXKL/QUARTILE.INKL/QUARTILE,
RANG.GLEICH/RANG.MITTELW/RANG

QUARTILE (Quartile einer Datenmenge)

Hinweis: QUARTILE wird durch die neue identische Funktion QUARTILE.INKL und die gänzlich neue
Funktion QUARTILE.EXKL ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwen-
det werden.

Syntax:

QUARTILE(Bereich; n)

Beschreibung:

Liefert eines der Quartile einer Datenmenge, basierend auf Quantilwerten von 0 bis 1 (einschließlich).

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
auszuwertende Zahlen eingetragen sind.

n bestimmt, welches Quartil geliefert werden soll. Zulässig sind folgende Werte:

0: das Minimum (also der kleinste Wert)

1: das untere Quartil (also das 0,25-Quantil)

2: das mittlere Quartil (also das 0,5-Quantil, der Median)

3: das obere Quartil (also das 0,75-Quantil)

4: das Maximum (also der größte Wert)

Ist n < 0 oder > 4, liefert die Funktion den Fehlerwert #ZAHL.

Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt:

QUARTILE(A1:A9; 3) entspricht QUANTIL(A1:A9; 0,75) und ergibt 7
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Siehe auch:

QUARTILE.INKL/QUARTILE.EXKL, QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG, MEDIAN,
MODUS.EINF/MODALWERT 

QUARTILE.EXKL (Quartile einer Datenmenge)

Syntax:

QUARTILE.EXKL(Bereich; n)

Beschreibung:

Liefert eines der Quartile einer Datenmenge, basierend auf Quantilwerten von 0 bis 1 (ausschließlich).

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
auszuwertende Zahlen eingetragen sind.

n bestimmt, welches Quartil geliefert werden soll. Zulässig sind folgende Werte:

0: das Minimum (also der kleinste Wert)

1: das untere Quartil (also das 0,25-Quantil)

2: das mittlere Quartil (also das 0,5-Quantil, der Median)

3: das obere Quartil (also das 0,75-Quantil)

4: das Maximum (also der größte Wert)

Ist n < 0 oder > 4, liefert die Funktion den Fehlerwert #ZAHL.

Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt:

QUARTILE.EXKL(A1:A9; 3) entspricht QUANTIL.EXKL(A1:A9; 0,75) und ergibt 7,5

Hinweis:

Die Funktion QUARTILE.EXKL ergänzt zusammen mit QUARTILE.INKL die bisherige Funktion
QUARTILE.

QUARTILE.INKL liefert dasselbe Ergebnis wie QUARTILE (einschließliche Werte 0 bis 1).

QUARTILE.EXKL (ausschließliche Werte 0 bis 1) ist gänzlich neu.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.
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Siehe auch:

QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG, MEDIAN,
MODUS.EINF/MODALWERT 

QUARTILE.INKL (Quartile einer Datenmenge)

Syntax:

QUARTILE.INKL(Bereich; n)

Beschreibung:

Liefert eines der Quartile einer Datenmenge, basierend auf Quantilwerten von 0 bis 1 (einschließlich).

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
auszuwertende Zahlen eingetragen sind.

n bestimmt, welches Quartil geliefert werden soll. Zulässig sind folgende Werte:

0: das Minimum (also der kleinste Wert)

1: das untere Quartil (also das 0,25-Quantil)

2: das mittlere Quartil (also das 0,5-Quantil, der Median)

3: das obere Quartil (also das 0,75-Quantil)

4: das Maximum (also der größte Wert)

Ist n < 0 oder > 4, liefert die Funktion den Fehlerwert #ZAHL.

Beispiel:

Sind in den Zellen A1 bis A9 die Werte 1, 2, 3, 4, 5, 6, 7, 8, 9 eingetragen, so gilt:

QUARTILE.INKL(A1:A9; 3) entspricht QUANTIL.INKL(A1:A9; 0,75) und ergibt 7

Hinweis:

Die Funktion QUARTILE.INKL ergänzt zusammen mit QUARTILE.EXKL die bisherige Funktion
QUARTILE.

QUARTILE.INKL liefert dasselbe Ergebnis wie QUARTILE (einschließliche Werte 0 bis 1).

QUARTILE.EXKL (ausschließliche Werte 0 bis 1) ist gänzlich neu.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.
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Siehe auch:

QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG, MEDIAN,
MODUS.EINF/MODALWERT 

QUOTIENT (Ganzzahliger Teil einer Division)

Syntax:

QUOTIENT(x; y)

Beschreibung:

Ermittelt den ganzzahligen Teil der Division von x durch y.

Beispiel:

QUOTIENT(6; 4) ergibt 1

Siehe auch:

REST, RESTP

RANG (Rang eines Wertes in einer Wertemenge)

Hinweis: RANG wird durch die neue identische Funktion RANG.GLEICH und die gänzlich neue Funkti-
on RANG.MITTELW ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet wer-
den.

Syntax:

RANG(Zahl; Bereich [; Aufsteigend])

Beschreibung:

Liefert den Rang einer Zahl in einer Menge von Zahlen. Die größte Zahl hat den Rang 1, die zweitgrößte
Zahl den Rang 2 etc. Wenn mehrere Werte die gleiche Rangzahl aufweisen, wird der oberste Rang dieser
Wertegruppe zurückgegeben.

Zahl ist die Zahl, deren Rang ermittelt werden soll. Wenn Zahl in Bereich nicht vorhanden ist, liefert die
Funktion den Fehlerwert #NV.
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Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
die vorliegenden Zahlen eingetragen sind.

Der optionale Wahrheitswert Aufsteigend bestimmt, ob eine aufsteigende oder eine absteigende Reihenfol-
ge verwendet werden soll:

FALSCH oder nicht angegeben: absteigende Reihenfolge (die größte Zahl hat Rang 1)

WAHR: aufsteigende Reihenfolge (die kleinste Zahl hat Rang 1)

Beispiel:

Sind in den Zellen A1:A6 die Zahlen 3, 2, 7, 5, 9, 7 eingetragen, so gilt:

RANG(9; A1:A6) ergibt 1

RANG(9; A1:A6; WAHR) ergibt 6

RANG(5; A1:A6) ergibt 4

RANG(7; A1:A6) ergibt 2

Siehe auch:

RANG.GLEICH/RANG.MITTELW, KKLEINSTE, KGRÖSSTE,
QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG

RANG.GLEICH (Rang eines Wertes in einer Wertemenge)

Syntax:

RANG.GLEICH(Zahl; Bereich [; Aufsteigend])

Beschreibung:

Liefert den Rang einer Zahl in einer Menge von Zahlen. Die größte Zahl hat den Rang 1, die zweitgrößte
Zahl den Rang 2 etc. Wenn mehrere Werte die gleiche Rangzahl aufweisen, wird der oberste Rang dieser
Wertegruppe zurückgegeben.

Zahl ist die Zahl, deren Rang ermittelt werden soll. Wenn Zahl in Bereich nicht vorhanden ist, liefert die
Funktion den Fehlerwert #NV.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
die vorliegenden Zahlen eingetragen sind.

Der optionale Wahrheitswert Aufsteigend bestimmt, ob eine aufsteigende oder eine absteigende Reihenfol-
ge verwendet werden soll:

FALSCH oder nicht angegeben: absteigende Reihenfolge (die größte Zahl hat Rang 1)

WAHR: aufsteigende Reihenfolge (die kleinste Zahl hat Rang 1)
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Beispiel:

Sind in den Zellen A1:A6 die Zahlen 3, 2, 7, 5, 9, 7 eingetragen, so gilt:

RANG.GLEICH(9; A1:A6) ergibt 1

RANG.GLEICH(9; A1:A6; WAHR) ergibt 6

RANG.GLEICH(5; A1:A6) ergibt 4

RANG.GLEICH(7; A1:A6) ergibt 2

Hinweis:

Die Funktion RANG.GLEICH ergänzt zusammen mit RANG.MITTELW die bisherige Funktion RANG.

RANG.GLEICH liefert dasselbe Ergebnis wie RANG (bei gleicher Rangzahl oberster Rang).

RANG.MITTELW (bei gleicher Rangzahl gemittelter Rang) ist gänzlich neu.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

RANG/RANG.MITTELW, KKLEINSTE, KGRÖSSTE, QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG

RANG.MITTELW (Rang eines Wertes in einer Wertemenge)

Syntax:

RANG.MITTELW(Zahl; Bereich [; Aufsteigend])

Beschreibung:

Liefert den Rang einer Zahl in einer Menge von Zahlen. Die größte Zahl hat den Rang 1, die zweitgrößte
Zahl den Rang 2 etc. Wenn mehrere Werte die gleiche Rangzahl aufweisen, wird der gemittelte Rang zu-
rückgegeben.

Zahl ist die Zahl, deren Rang ermittelt werden soll. Wenn Zahl in Bereich nicht vorhanden ist, liefert die
Funktion den Fehlerwert #NV.

Bereich ist ein Bereich mit numerischen Daten – in der Regel also ein Bezug auf einen Zellbereich, in dem
die vorliegenden Zahlen eingetragen sind.

Der optionale Wahrheitswert Aufsteigend bestimmt, ob eine aufsteigende oder eine absteigende Reihenfol-
ge verwendet werden soll:

FALSCH oder nicht angegeben: absteigende Reihenfolge (die größte Zahl hat Rang 1)
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WAHR: aufsteigende Reihenfolge (die kleinste Zahl hat Rang 1)

Beispiel:

Sind in den Zellen A1:A6 die Zahlen 3, 2, 7, 5, 9, 7 eingetragen, so gilt:

RANG.MITTELW(9; A1:A6) ergibt 1

RANG.MITTELW(9; A1:A6; WAHR) ergibt 6

RANG.MITTELW(5; A1:A6) ergibt 4

RANG.MITTELW(7; A1:A6) ergibt 2,5

Hinweis:

Die Funktion RANG.MITTELW ergänzt zusammen mit RANG.GLEICH die bisherige Funktion RANG.

RANG.GLEICH liefert dasselbe Ergebnis wie RANG (bei gleicher Rangzahl oberster Rang).

RANG.MITTELW (bei gleicher Rangzahl gemittelter Rang) ist gänzlich neu.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

RANG/RANG.GLEICH, KKLEINSTE, KGRÖSSTE, QUANTIL.EXKL/QUANTIL.INKL/QUANTIL,
QUANTILSRANG.EXKL/QUANTILSRANG.INKL/QUANTILSRANG

RECHTS (Teil einer Zeichenkette)

Syntax:

RECHTS(Zeichenkette [; n])

Beschreibung:

Liefert die letzten n Zeichen einer Zeichenkette.

Ist n nicht angegeben, liefert die Funktion nur das letzte Zeichen.

Beispiel:

RECHTS("Tiergarten"; 6) ergibt garten

RECHTS("Tiergarten") ergibt n



613Formeln und Funktionen

Siehe auch:

LINKS, TEIL, ERSETZEN, LÄNGE

REST (Rest einer Division)

Syntax:

REST(x; y)

Beschreibung:

Ermittelt den Rest der Division von x durch y nach der "Excel-Methode".

Wichtig: Diese Funktion liefert teilweise falsche Ergebnisse (siehe Anmerkung)!

Beispiel:

REST(5; 3) ergibt 2

REST(5; 0) ergibt den Fehlerwert #DIV/0!

REST(5; -3) ergibt -1 (falsch! – siehe Anmerkung)

Anmerkung:

Die Tabellenkalkulation Microsoft Excel liefert bei dieser Funktion falsche Ergebnisse, wenn entweder
Zähler oder Nenner negativ sind.

PlanMaker liefert aus Kompatibilitätsgründen ebenfalls falsche Ergebnisse, verfügt aber zusätzlich über
die Funktion RESTP, die korrekte Ergebnisse zurückgibt

Den Unterschied zwischen REST und RESTP können Sie dieser Tabelle entnehmen (die grün hinterlegten
Ergebnisse sind falsch):

Kompatibilitätshinweise:

Hinweis: Die Funktion RESTP ist in Excel nicht vorhanden. Wenn Sie ein Dokument mit dieser Funktion
im Excel-Format speichern, wird sie durch ihren letzten Wert ersetzt.
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Siehe auch:

RESTP, QUOTIENT

RESTP (Rest einer Division)

Syntax:

RESTP(x; y)

Beschreibung:

Ermittelt den Rest der Division von x durch y nach der "PlanMaker-Methode" (siehe Anmerkung).

Beispiel:

RESTP(5; 3) ergibt 2

RESTP(5; 0) ergibt den Fehlerwert #DIV/0!

RESTP(5; -3) ergibt 2 (siehe Anmerkung)

Anmerkung:

Die Tabellenkalkulation Microsoft Excel liefert bei der Funktion REST falsche Ergebnisse, wenn entweder
Zähler oder Nenner negativ sind 

Wenn Sie korrekte Ergebnisse erhalten möchten, sollten Sie statt REST die hier beschriebene Funktion
RESTP verwenden.

Den Unterschied zwischen REST und RESTP können Sie dieser Tabelle entnehmen (die grün hinterlegten
Ergebnisse sind falsch):

Kompatibilitätshinweise:

Hinweis: Die Funktion RESTP ist in Excel nicht vorhanden. Wenn Sie ein Dokument mit dieser Funktion
im Excel-Format speichern, wird sie durch ihren letzten Wert ersetzt.
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Siehe auch:

REST, QUOTIENT

RGP (Kenngrößen einer linearen Regression)

Syntax:

RGP(y_Werte [; x_Werte] [; Konstante] [; Statistik])

Beschreibung:

Liefert verschiedene Kenngrößen einer linearen Regression.

Unter einer linearen Regression versteht man das Anpassen einer linearen Funktion (Regressionsgerade
oder Ausgleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunkten einer Messrei-
he).

Die Funktionsgleichung für diese Regressionsgerade lautet:

y = m*x + b 

RGP erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen x-Werte) und liefert als
Ergebnis eine Matrix in der Form {m.b}. m ist die Steigung der Geraden, b ist der y-Achsenabschnitt (also
die y-Koordinate des Punktes, an dem die Gerade die y-Achse schneidet).

Liegen mehrere Bereiche mit x-Werten vor, lautet die Funktionsgleichung:

y = (m1*x1) + (m2*x2) + ... + (mn*xn) + b

In diesem Fall liefert die Funktion RGP eine Matrix in der Form {mn . mn-1 . ... . m2 . m1 . b}. 

Wird das optionale Argument Statistik verwendet, wird die resultierende Matrix um weitere Kenngrößen
(Standardfehler, Bestimmtheitsmaß etc.) erweitert.

Die Funktion RGP erwartet folgende Argumente:

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen Werte, an. y_Werte kann
entweder ein Zellbezug oder eine Matrix sein.

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte angegeben werden. Auch
x_Werte kann entweder ein Zellbezug oder eine Matrix sein. Wird x_Werte nicht angegeben, verwendet
die Funktion automatisch die Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte).

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die Konstante b (der y-Ach-
senabschnitt) auf Null gesetzt werden soll:

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch berechnet.

FALSCH: b wird auf Null gesetzt. Die Regressionsgerade wird dadurch gezwungen, durch den Nullpunkt
zu laufen. Dies geschieht durch entsprechendes Anpassen des Koeffizienten m.

Statistik: Das optionale Argument Statistik bestimmt, ob zusätzliche Kenngrößen geliefert werden sollen:

FALSCH oder nicht angegeben: keine zusätzlichen Kenngrößen liefern.
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WAHR: zusätzliche Kenngrößen liefern. In diesem Falle wird eine Matrix zurückgeliefert, die nicht nur m
und b, sondern folgende Werte enthält:

{mn . mn-1 . ... . m2 . m1 . b ; smn . smn-1 . ... . sm2 . sm1 . sb ; R2 . sey ; F. df ; ssreg . ssresid}

Grafisch dargestellt sieht diese Matrix also wie folgt aus:

Bei obigen Kürzeln handelt es sich um folgende Kenngrößen:

Kürzel Erläuterung

sm1, sm2 etc. Standardfehler für die Koeffizienten m1, m2 etc.

sb Standardfehler für die Konstante b

R2 Bestimmtheitsmaß R2 (Korrelationskoeffizient)

sey Standardfehler für y

F F-Wert

df Freiheitsgrade

ssreg Regressions-Quadratsumme

ssresid Residual-Quadratsumme

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Anmerkung:

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleinsten Quadrate durchgeführt.

Beispiel:

RGP({4; 5; 6}) liefert die Matrix {1.3}. Die Steigung m beträgt also 1 und der y-Achsenabschnitt b ist 3.
(Da die x-Werte nicht angegeben wurden, hat die RGP-Funktion dafür automatisch die Werte 1, 2, 3, ... ver-
wendet.)
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Siehe auch:

RKP, TREND, VARIATION

RKP (Kenngrößen einer exponentiellen Regression)

Syntax:

RKP(y_Werte [; x_Werte] [; Konstante] [; Statistik])

Beschreibung:

Liefert verschiedene Kenngrößen einer exponentiellen Regression.

Unter einer exponentiellen Regression versteht man das Anpassen einer Exponentialkurve an eine Menge
von Punkten (zum Beispiel den Messpunkten einer Messreihe).

Die Funktionsgleichung für diese Exponentialkurve lautet:

y = b*m^x

beziehungsweise (wenn mehrere Bereiche mit x-Werten vorliegen):

y = b * (m1^x1) * (m2^x2) * ... * (mn^xn)

RKP erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen x-Werte) und liefert als
Ergebnis eine Matrix in der Form {mn . mn-1 . ... . m2 . m1 . b}. 

Wird das optionale Argument Statistik verwendet, wird die resultierende Matrix um weitere Kenngrößen
(Standardfehler, Bestimmtheitsmaß etc.) erweitert.

Die Funktion RKP erwartet folgende Argumente:

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen Werte, an. y_Werte kann
entweder ein Zellbezug oder eine Matrix sein.

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte angegeben werden. Auch
x_Werte kann entweder ein Zellbezug oder eine Matrix sein. Wird x_Werte nicht angegeben, verwendet
die Funktion automatisch die Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte).

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die Konstante b auf Eins
gesetzt werden soll:

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch berechnet.

FALSCH: b wird fest auf Eins gesetzt, und die Kurve wird entsprechend "hingebogen". Dies geschieht
durch Anpassen des Koeffizienten m.

Statistik: Das optionale Argument Statistik bestimmt, ob zusätzliche Kenngrößen geliefert werden sollen:

FALSCH oder nicht angegeben: keine zusätzlichen Kenngrößen liefern.

WAHR: zusätzliche Kenngrößen liefern. In diesem Falle wird eine Matrix zurückgeliefert, die nicht nur m
und b, sondern folgende Werte enthält:
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{mn . mn-1 . ... . m2 . m1 . b ; smn . smn-1 . ... . sm2 . sm1 . sb ; R2 . sey ; F. df ; ssreg . ssresid}

Grafisch dargestellt sieht diese Matrix also wie folgt aus:

Bei obigen Kürzeln handelt es sich um folgende Kenngrößen:

Kürzel Erläuterung

sm1, sm2 etc. Standardfehler für die Koeffizienten m1, m2 etc.

sb Standardfehler für die Konstante b

R2 Bestimmtheitsmaß R2 (Korrelationskoeffizient)

sey Standardfehler für y

F F-Wert

df Freiheitsgrade

ssreg Regressions-Quadratsumme

ssresid Residual-Quadratsumme

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Siehe auch:

RGP, TREND, VARIATION

RMZ (Regelmäßige Zahlung)

Syntax:

RMZ(Zins; Zzr; Bw [; Zw] [; Fälligkeit])
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Beschreibung:

Liefert die Höhe der Zahlung (Annuität) pro Periode, basierend auf einer Investition mit regelmäßigen kon-
stanten Zahlungen und feststehendem Zins.

Sie können mit dieser Funktion beispielsweise berechnen, wie hoch die (konstanten) Zahlungen pro Periode
ausfallen. Diese Zahlungen ("Annuitäten") bestehen stets aus einem Tilgungsanteil (siehe Funktion KAPZ)
und einem Zinsanteil (siehe Funktion ZINSZ).

"Periode" bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen Rückzahlungen ist die
dritte Periode beispielsweise der dritte Monat.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Bw = Barwert (der anfängliche Betrag)

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zahlung erreichen möchten.
Wenn Sie das Argument Zw nicht angeben, wird es auf Null gesetzt.

Fälligkeit (optional) = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Beispiel:

RMZ(6,5%; 10; 1000) ergibt -139,10

Siehe auch:

BW, ISPMT, KAPZ, KUMKAPITAL, KUMZINSZ, ZINS, ZINSZ, ZW, ZZR

RÖMISCH (Römische Schreibweise einer Zahl)

Syntax:

RÖMISCH(Zahl [; Darstellung])

Beschreibung:

Wandelt eine Zahl in eine Zeichenkette mit der römischen Schreibweise dieser Zahl um.

Der zulässige Wertebereich für Zahl ist: 0 £ Zahl < 4000.

Zahl sollte eine ganze Zahl sein. Ist dies nicht der Fall, entfernt PlanMaker automatisch alle Nachkommas-
tellen.

Wenn Zahl Null ist, wird eine leere Zeichenkette zurückgeliefert.
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Wird das optionale Argument Darstellung angegeben, versucht PlanMaker, die römische Zahl in verkürzter
Schreibweise darzustellen (siehe Beispiele). Für Darstellung sind Werte von 0 (nicht kürzen) bis 4 (so kurz
wie möglich) zulässig.

Beispiel:

RÖMISCH(1999) ergibt MCMXCIX

RÖMISCH(1999; 0) ergibt ebenfalls MCMXCIX

RÖMISCH(1999; 1) ergibt MLMIL

RÖMISCH(1999; 2) ergibt MXMIX

RÖMISCH(1999; 3) ergibt MVMIV

RÖMISCH(1999; 4) ergibt MIM

RUNDEN (Runden auf n Stellen)

Syntax:

RUNDEN(Zahl; n)

Beschreibung:

Rundet eine Zahl auf n Nachkommastellen.

n ist die gewünschte Anzahl an Nachkommastellen. 

Wird n nicht angegeben, wird die Zahl auf 0 Nachkommastellen gerundet.

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet wird: Ist n beispielswei-
se -2, wird die Zahl auf ein Vielfaches von Hundert gerundet (siehe letztes Beispiel).

Beispiel:

RUNDEN(1,234; 2) ergibt 1,23

RUNDEN(1,235; 2) ergibt 1,24

RUNDEN(444,222; 0) ergibt 444

RUNDEN(444,222; -2) ergibt 400

Siehe auch:

ABRUNDEN, AUFRUNDEN, VRUNDEN, KÜRZEN, FEST, GANZZAHL, GERADE, UNGERADE,
OBERGRENZE, UNTERGRENZE
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SÄUBERN (Nicht-druckbare Zeichen entfernen)

Syntax:

SÄUBERN(Zeichenkette)

Beschreibung:

Entfernt alle nicht-druckbaren Zeichen aus einer Zeichenkette (alle Zeichen mit einem ANSI-Code < 32).

Siehe auch:

GLÄTTEN

SCHÄTZER (Schätzwert für einen linearen Trend)

Syntax:

SCHÄTZER(x; y_Werte; x_Werte)

Beschreibung:

Liefert zum angegebenen x-Wert x den y-Wert auf einer Regressionsgeraden, die anhand der übergebenen
x- und y-Werte gebildet wird.

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter versteht man das Anpassen ei-
ner linearen Funktion (Regressionsgerade oder Ausgleichsgerade genannt) an eine Menge von Punkten
(zum Beispiel den Messpunkten einer Messreihe).

Mit der Funktion SCHÄTZER können Sie voraussagen, welchen Wert y (der abhängigen Variable) bei ei-
nem bestimmten Wert x (der unabhängigen Variable) ungefähr haben wird.

Sie können somit beispielsweise abschätzen, welchen Widerstand ein temperaturabhängiger Widerstand bei
einer bestimmten Temperatur haben wird, nachdem Sie den Widerstand bei verschiedenen anderen Tempe-
raturen gemessen haben.

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbereich an.

y_Werte sind die abhängigen Variablen (in obigem Beispiel also der Widerstand).

x_Werte sind die unabhängigen Variablen (in obigem Beispiel also die Temperatur).

Hinweis:

Beachten Sie, dass diese Funktion als zweites und drittes Argument erst die y_Werte und dann die x_Wer-
te erwartet – nicht umgekehrt.
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Anmerkung:

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleinsten Quadrate durchgeführt.

Beispiel:

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Widerstand bei verschiedenen
Temperaturen vorliegt.

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also die unabhängigen Varia-
blen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 28

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen Variablen; in unserem
Beispiel ist dies der Widerstand): 261, 508, 608, 680

Mit der folgenden Formel können Sie abschätzen, welcher Widerstand bei 15°C geliefert werden wird:

SCHÄTZER(15; B1:B4; A1:A4) ergibt 405,21805 (Ohm)

Anmerkung:

ACHSENABSCHNITT(y_Werte; x_Werte) entspricht SCHÄTZER(0; y_Werte; x_Werte).

Siehe auch:

ACHSENABSCHNITT, STEIGUNG, SCHIEFE, STFEHLERYX, TREND

SCHIEFE (Schiefe einer Verteilung)

Syntax:

SCHIEFE(Zahl1; Zahl2; Zahl3 [; Zahl4 ...])

oder

SCHIEFE(Bereich1 [; Bereich2; Bereich3 ...])

Beschreibung:

Berechnet die Schiefe der Dichtefunktion einer Wahrscheinlichkeitsverteilung.

Die Schiefe ist ein Maß für den Grad der Asymmetrie dieser Funktion.

Befinden sich mehr Werte rechts des arithmetischen Mittels der Verteilung, spricht man von einer "rechts-
schiefen" Verteilung. SCHIEFE liefert hier einen positiven Wert.

Den umgekehrten Fall bezeichnet man als "linksschiefe" Verteilung. Hier liefert SCHIEFE einen negativen
Wert.

Wenn sich die SCHIEFE Null annähert, so ist die betrachtete Dichtefunktion in guter Näherung symme-
trisch.
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Zahl1, Zahl2, Zahl3 etc. sind die Werte der Verteilung, deren Schiefe berechnet werden soll. Leere Zellen
sowie Zeichenketten und Wahrheitswerte werden ignoriert.

Es müssen mindestens drei Werte angegeben sein; andernfalls liefert die Funktion den Fehlerwert #DIV/0!
(Division durch Null).

Hinweis:

Diese Funktion erwartet als Argumente keine Wertepaare (x-Wert und y-Wert), sondern nur die Werte der
Verteilung. Mehrmals vorkommende Werte müssen entsprechend oft wiederholt werden (siehe Beispiel).

Beispiel:

Sie messen die Körpergrößen von Menschen und erhalten dabei folgende Ergebnisse: 1 x 1,60m, 2 x 1,65m,
4 x 1,70m, 2 x 1,75m und 1x1,80m. 

Die Dichtefunktion der Verteilung dieser Messergebnisse hat folgende Schiefe:

SCHIEFE(1,60; 1,65; 1,65; 1,70; 1,70; 1,70; 1,70; 1,75; 1,75; 1,80) ergibt 4,66562E-15; liegt also nahezu
bei Null.

Siehe auch:

ACHSENABSCHNITT, SCHÄTZER, KURT, NORM.VERT/NORMVERT

SCHNITTBEREICH (Schnittmenge zweier Bereiche)

Syntax:

SCHNITTBEREICH(Bereich1; Bereich2)

Beschreibung:

Liefert einen Bezug auf den Schnittbereich von Bereich1 und Bereich2 (also den Zellbereich, an dem sich
Bereich1 und Bereich2 überlappen).

Anmerkung:

Alternativ zu dieser Funktion können Sie auch den Operator Leerzeichen verwenden, um den Schnittbereich
zweier Bereiche zu erhalten. Beispiel:

SUMME(SCHNITTBEREICH(A1:D4; C3:E6)) 

ist gleichbedeutend mit:

SUMME(A1:D4 C3:E6).
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Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, wird da-
her jedes Vorkommen dieser Funktion durch den Schnittbereichoperator (also ein Leerzeichen) ersetzt (sie-
he Anmerkung oben).

Beispiel:

SCHNITTBEREICH(A1:D4; C3:E6) liefert einen Bezug auf C3:D4

SEKUNDE (Sekunde aus einem Datumswert ermitteln)

Syntax:

SEKUNDE(Uhrzeit)

Beschreibung:

Liefert den Sekundenanteil aus einem Datumswert.

Beispiel:

SEKUNDE("12:34:56") ergibt 56

SEKUNDE("25.09.2018 10:30:56") ergibt 56

Siehe auch:

STUNDE, MINUTE, MILLISEKUNDEN

SIN (Sinus)

Syntax:

SIN(Zahl)

Beschreibung:

Liefert den Sinus eines Winkels. 

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben.
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Tipp:

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel ins Bogenmaß umrechnen.

Beispiel:

SIN(PI()/2) ergibt 1

SIN(BOGENMASS(90)) ergibt 1

Siehe auch:

ARCSIN, COS, TAN

SINHYP (Sinus Hyperbolicus)

Syntax:

SINHYP(Zahl)

Beschreibung:

Die Funktion SINHYP (Sinus Hyperbolicus) liefert den hyperbolischen Sinus einer Zahl.

Beispiel:

SINHYP(0,45) ergibt 0,4653

Siehe auch:

ARCSINHYP, COSHYP, TANHYP

SORTIERENM (Sortieren)

Syntax:

SORTIERENM(Bereich; Schlüssel [; GroßKlein] [; Spaltenweise] [; Spaltennummer])

Beschreibung:

Diese Funktion sortiert einen Zellbereich oder eine Matrix nach einem oder mehreren Kriterien. Als Ergeb-
nis liefert sie eine Matrix mit den sortierten Werten.
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Bereich bestimmt den Datenbereich, der sortiert werden soll. Sie können einen hierfür ein- oder zweidimen-
sionalen Zellbereich oder eine Matrix angeben.

Schlüssel bestimmt, nach welchen Zeilen der Datenbereich sortiert werden soll. Geben Sie dazu einen zwei-
zeiligen Zellbereich oder eine zweizeilige Matrix mit folgendem Inhalt an:

In der ersten Zeile müssen die Nummern der Zeilen im Datenbereich angegeben werden, nach denen sortiert
werden soll. Geben Sie also als Sortierschlüssel {1.3} an, wird nach der ersten und der dritten Zeile sor-
tiert. 

In der zweiten Zeile kann (optional) anhand eines Wahrheitswerts angegeben werden, dass absteigend sor-
tiert werden soll: 

FALSCH oder nicht angegeben: aufsteigend sortieren

WAHR: absteigend sortieren

Geben Sie also als Sortierschlüssel {1.3; wahr.falsch} an, wird nach der ersten Zeile absteigend und der
dritten Zeile aufsteigend sortiert.

Das optionale Argument GroßKlein bestimmt, ob bei Zeichenketten auch nach Groß-/Kleinschreibung sor-
tiert werden soll:

FALSCH oder nicht angegeben: Groß-/Kleinschreibung ignorieren

WAHR: Groß-/Kleinschreibung beachten, also Begriffe, bei denen der erste Buchstabe klein geschrieben
ist, vor Begriffe sortieren, die mit demselben Buchstaben in Großschreibung beginnen.

Das optionale Argument Spaltenweise bestimmt, ob die Sortierung zeilen- oder spaltenweise erfolgen soll:

FALSCH oder nicht angegeben: zeilenweise sortieren

WAHR: spaltenweise sortieren

Wenn Sie das optionale Argument Spaltennummer verwenden, liefert die Funktion statt der gesamten Da-
ten nur eine bestimmte Spalte (beziehungsweise Zeile – bei spaltenweiser Sortierung) zurück:

Wird dieses Argument nicht angegeben, liefert die Funktion alle Spalten des Datenbereichs zurück.

Wird es auf n gesetzt, wird nur die n-te Spalte des Datenbereichs zurückgeliefert.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Beispiel:

SORTIERENM({4;2;3}; {1}) ergibt {2;3;4}

SORTIERENM({4;2;3}; {1; WAHR}) ergibt {4;3;2}

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.
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Siehe auch:

SORTIERENV, Abschnitt Sortieren

SORTIERENV (Sortieren)

Syntax:

SORTIERENV(Bereich [; Absteigend] [; GroßKlein] [; Datenbereich])

Beschreibung:

Diese Funktion sortiert einen eindimensionalen Zellbereich oder Vektor. Als Ergebnis liefert sie einen Vek-
tor mit den sortierten Werten.

Der Unterschied zur Funktion SORTIERENM liegt darin, dass SORTIERENV nur auf eindimensionale Be-
reiche angewandt werden kann. Das sind Bereiche, die entweder nur eine Zeile oder nur eine Spalte umfas-
sen.

Bereich ist der eindimensionale Bereich, der sortiert werden soll.

Das optionale Argument Absteigend bestimmt, ob absteigend sortiert werden soll:

FALSCH oder nicht angegeben: aufsteigend sortieren

WAHR: absteigend sortieren

Das optionale Argument GroßKlein bestimmt, ob bei Zeichenketten auch nach Groß-/Kleinschreibung sor-
tiert werden soll:

FALSCH oder nicht angegeben: Groß-/Kleinschreibung ignorieren

WAHR: Groß-/Kleinschreibung beachten, also Begriffe, bei denen der erste Buchstabe klein geschrieben
ist, vor Begriffe sortieren, die mit demselben Buchstaben in Großschreibung beginnen.

Wenn Sie das optionale Argument Datenbereich verwenden, liefert die Funktion als Ergebnis nicht die Da-
ten aus Bereich, sondern die Daten aus Datenbereich zurück. Datenbereich muss genau die gleichen Aus-
maße wie Bereich haben.

Dies ist praktisch, wenn Sie beispielsweise eine Tabelle erstellen, die eine Spalte mit den Namen von Sport-
lern und daneben eine Spalte mit deren Punktzahl enthält. Geben Sie hier als Bereich die Spalte mit den
Punktzahlen ein, als Datenbereich jedoch die Spalte mit den Namen, erhalten Sie als Ergebnis eine Na-
mensliste, die nach Punktzahlen sortiert ist.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Beispiel:

SORTIERENV({4;2;3}) ergibt {2;3;4}
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SORTIERENV({4;2;3}; WAHR) ergibt {4;3;2}

SORTIERENV({4.2.3}) ergibt {2.3.4}

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Siehe auch:

SORTIERENM, Abschnitt Sortieren

SPALTE (Spaltennummer von Zellen)

Syntax:

SPALTE([Bezug])

Beschreibung:

Liefert die Spaltennummer(n) einer Zelle oder eines Bereichs von Zellen:

Ist Bezug eine einzelne Zelle, liefert die Funktion die Spaltennummer dieser Zelle.

Ist Bezug ein Bereich von Zellen, liefert die Funktion die darin enthaltenen Spaltennummern als horizontale
Matrix. Hinweis: In diesem Fall muss die Formel als Matrixformel eingegeben werden (siehe Abschnitt Ar-
beiten mit Matrizen).

Wird das Argument Bezug nicht angegeben, liefert die Funktion die Spaltennummer der Zelle, in der sie
aufgerufen wurde.

Beispiel:

SPALTE(D2) ergibt 4

SPALTE(D2:F4) ergibt {4.5.6}

SPALTE() ergibt 3, wenn Sie die Funktion SPALTE() beispielsweise in der Zelle C5 aufrufen

Siehe auch:

SPALTEN, ZEILE, ZELLE, ADRESSE, BEREICH.VERSCHIEBEN, INDIREKT
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SPALTEN (Anzahl Spalten)

Syntax:

SPALTEN(Bereich)

Beschreibung:

Liefert die Zahl der Spalten im angegebenen Bereich.

Beispiel:

SPALTEN(A1:D5) ergibt 4

Siehe auch:

ZEILEN, SPALTE, BEREICHE

STABW (Standardabweichung einer Stichprobe)

Hinweis: STABW wird durch die neue identische Funktion STABW.S ergänzt, die in neueren Versionen
von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

STABW(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert einen Schätzwert für die Standardabweichung der Grundgesamtheit anhand einer Stichprobe.

Die Standardabweichung gibt an, um welchen Betrag die übergebenen Werte durchschnittlich vom Mittel-
wert abweichen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe). 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Anmerkung:

Die Standardabweichung wird nach der Methode "Erwartungstreue Schätzung" oder "n-1" berechnet.
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Beispiel:

STABW(2; 2; 3; 4; 1) ergibt 1,14018

Siehe auch:

STABW.S, STABWA, STABW.N/STABWN, VAR.P/VARIANZEN, VAR.S/VARIANZ, MITTELABW,
STANDARDISIERUNG, SUMQUADABW

STABWA (Standardabweichung)

Syntax:

STABWA(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Die Funktion STABWA entspricht nahezu der Funktion STABW (siehe Hinweis). Sie liefert also einen
Schätzwert für die Standardabweichung der Grundgesamtheit anhand einer Stichprobe.

Die Standardabweichung gibt an, um welchen Betrag die übergebenen Werte durchschnittlich vom Mittel-
wert abweichen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe). 

Hinweis:

Im Gegensatz zu STABW berücksichtigt die Funktion STABWA auch Werte, die keine Zahlen sind: Belie-
bige Zeichenketten und der Wahrheitswert FALSCH werden als 0 interpretiert, WAHR als 1.

Leere Zellen werden hingegen auch hier ignoriert.

Anmerkung:

Die Standardabweichung wird nach der Methode "Erwartungstreue Schätzung" oder "n-1" berechnet.

Beispiel:

STABWA(2; 2; 3; 4; 1) ergibt 1,14018

Siehe auch:

STABW.S/STABW, STABWNA
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STABWN (Standardabweichung einer Grundgesamtheit)

Hinweis: STABWN wird durch die neue identische Funktion STABW.N ergänzt, die in neueren Versio-
nen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

STABWN(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert die Standardabweichung einer Grundgesamtheit.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte. Es müssen alle Werte der Grundgesamtheit angegeben
werden. Falls nur eine Stichprobe aus der Grundgesamtheit vorliegt, ist statt STABWN die Funktion
STABW.S/STABW zu verwenden. Diese liefert einen Schätzwert für die Standardabweichung.

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Anmerkung:

Die Standardabweichung wird nach der Methode "n" berechnet.

Beispiel:

STABWN(2; 2; 3; 4; 1) ergibt 1,0198

Siehe auch:

STABW.N, STABWNA, STABW.S/STABW, VAR.P/VARIANZEN, VAR.S/VARIANZ

STABW.N (Standardabweichung einer Grundgesamtheit)

Syntax:

STABW.N(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert die Standardabweichung einer Grundgesamtheit.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte. Es müssen alle Werte der Grundgesamtheit angegeben
werden. Falls nur eine Stichprobe aus der Grundgesamtheit vorliegt, ist statt STABW.N die Funktion
STABW.S/STABW zu verwenden. Diese liefert einen Schätzwert für die Standardabweichung.
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Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Anmerkung:

Die Standardabweichung wird nach der Methode "n" berechnet.

Beispiel:

STABW.N(2; 2; 3; 4; 1) ergibt 1,0198

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

STABWN, STABWNA, STABW.S/STABW, VAR.P/VARIANZEN, VAR.S/VARIANZ

STABWNA (Standardabweichung)

Syntax:

STABWNA(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Die Funktion STABWNA entspricht nahezu der Funktion STABWN (siehe Hinweis). Sie liefert also die
Standardabweichung einer Grundgesamtheit.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte. Es müssen alle Werte der Grundgesamtheit angegeben
werden. Falls nur eine Stichprobe aus der Grundgesamtheit vorliegt, ist statt STABWNA die Funktion
STABWA zu verwenden Diese liefert einen Schätzwert für die Standardabweichung

Hinweis:

Im Gegensatz zu STABWN berücksichtigt die Funktion STABWNA auch Werte, die keine Zahlen sind: Be-
liebige Zeichenketten und der Wahrheitswert FALSCH werden als 0 interpretiert, WAHR als 1.

Leere Zellen werden hingegen auch hier ignoriert.

Anmerkung:

Die Standardabweichung wird nach der Methode "n" berechnet.
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Beispiel:

STABWNA(2; 2; 3; 4; 1) ergibt 1,0198

Siehe auch:

STABW.N/STABWN

STABW.S (Standardabweichung einer Stichprobe)

Syntax:

STABW.S(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert einen Schätzwert für die Standardabweichung der Grundgesamtheit anhand einer Stichprobe.

Die Standardabweichung gibt an, um welchen Betrag die übergebenen Werte durchschnittlich vom Mittel-
wert abweichen.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe). 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Anmerkung:

Die Standardabweichung wird nach der Methode "Erwartungstreue Schätzung" oder "n-1" berechnet.

Beispiel:

STABW.S(2; 2; 3; 4; 1) ergibt 1,14018

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

STABW, STABW.N/STABWN, VAR.P/VARIANZEN, VAR.S/VARIANZ
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STANDARDISIERUNG (Standardisierung)

Syntax:

STANDARDISIERUNG(x; Mittelwert; Standardabweichung)

Beschreibung:

Berechnet den standardisierten Wert von x, basierend auf einer durch Mittelwert und Standardabweichung
definierten Verteilung.

x ist der zu standardisierende Wert.

Mittelwert ist das arithmetische Mittel der Verteilung.

Standardabweichung ist die Standardabweichung der Verteilung.

Beispiel:

STANDARDISIERUNG(5; 4; 1,25) ergibt 0,8

Siehe auch:

MITTELWERT, STABW.S/STABW, NORM.VERT/NORMVERT,
NORM.S.VERT/STANDNORMVERT

STANDNORMINV (Quantile einer Standardnormalverteilung)

Hinweis: STANDNORMINV wird durch die neue identische Funktion NORM.S.INV ergänzt, die in
neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

STANDNORMINV(Wahrscheinlichkeit)

Beschreibung:

Liefert Quantile einer Standardnormalverteilung. 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].
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Hinweis:

Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet PlanMaker nach
100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit abweicht, zeigt er den
Fehlerwert #NV an und bricht die Näherung ab.

Siehe auch:

NORM.S.INV, NORM.INV/NORMINV, NORM.VERT/NORMVERT,
NORM.S.VERT/STANDNORMVERT

STANDNORMVERT (Standardnormalverteilung)

Hinweis: STANDNORMVERT wird durch die neue Funktion NORM.S.VERT mit zusätzlicher Funktio-
nalität ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

STANDNORMVERT(x)

Beschreibung:

Liefert die kumulierten Wahrscheinlichkeiten einer standardnormalverteilten Zufallsvariablen.

Die Standardnormalverteilung (auch "standardisierte Normalverteilung" genannt) ist eine Normalverteilung
(siehe Funktion NORM.VERT/NORMVERT), deren arithmetisches Mittel m gleich Null und deren Stan-
dardabweichung s gleich 1 ist

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll.

Anmerkung:

Geliefert wird die kumulierte Verteilungsfunktion.

Siehe auch:

NORM.S.VERT, NORM.INV/NORMINV, NORM.S.INV/STANDNORMINV, STANDARDISIERUNG,
GAUSS, LOGNORM.INV/LOGINV, LOGNORM.VERT/LOGNORMVERT

STEIGUNG (Steigung einer Regressionsgeraden)

Syntax:

STEIGUNG(y_Werte; x_Werte)
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Beschreibung:

Ermittelt die Steigung einer Regressionsgeraden. Als Steigung bezeichnet man den Wert, um den die y-
Koordinate wächst, wenn man die x-Koordinate um Eins erhöht.

Eine Regressionsgerade ist das Resultat einer linearen Regression. Darunter versteht man das Anpassen ei-
ner linearen Funktion (Regressionsgerade oder Ausgleichsgerade genannt) an eine Menge von Punkten
(zum Beispiel den Messpunkten einer Messreihe).

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbereich an.

y_Werte sind die abhängigen Variablen.

x_Werte sind die unabhängigen Variablen.

Hinweis:

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwartet – nicht umgekehrt.

Anmerkung:

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleinsten Quadrate durchgeführt.

Beispiel:

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Widerstand bei verschiedenen
Temperaturen vorliegt.

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also die unabhängigen Varia-
blen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 28

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen Variablen; in unserem
Beispiel ist dies der Widerstand): 261, 508, 608, 680

Mit der folgenden Formel können Sie die Steigung der Regressionsgeraden ermitteln, die obigen Messwer-
ten zugrunde liegt:

STEIGUNG(B1:B4; A1:A4) ergibt 20,76799

Siehe auch:

ACHSENABSCHNITT, SCHÄTZER, PEARSON, STFEHLERYX

STFEHLERYX (Standardfehler einer linearen Regression)

Syntax:

STFEHLERYX(y_Werte; x_Werte)
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Beschreibung:

Liefert den Standardfehler einer linearen Regression.

Der Standardfehler ist ein Maß für die Zuverlässigkeit einer linearen Regression: Je größer der Standardfeh-
ler, desto stärker weichen die geschätzten Werte von den tatsächlichen Werten ab.

Für die Argumente y_Werte und x_Werte geben Sie in der Regel einen Zellbereich an.

y_Werte sind die abhängigen Variablen.

x_Werte sind die unabhängigen Variablen.

Hinweis:

Beachten Sie, dass diese Funktion erst die y_Werte und dann die x_Werte erwartet – nicht umgekehrt.

Anmerkung:

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleinsten Quadrate durchgeführt.

Beispiel:

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Widerstand bei verschiedenen
Temperaturen vorliegt.

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also die unabhängigen Varia-
blen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 28

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen Variablen; in unserem
Beispiel ist dies der Widerstand): 261, 508, 608, 680

Mit der folgenden Formel ermitteln Sie den Standardfehler der Regression, die obigen Messwerten zugrun-
de liegt:

STFEHLERYX(B1:B4; A1:A4) ergibt 4,97351

Siehe auch:

ACHSENABSCHNITT, STEIGUNG, SCHÄTZER

STUNDE (Stunde aus einem Datumswert ermitteln)

Syntax:

STUNDE(Uhrzeit)

Beschreibung:

Liefert den Stundenanteil aus einem Datumswert.
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Beispiel:

STUNDE("12:34:56") ergibt 12

STUNDE("25.09.2018 10:30:56") ergibt 10

Siehe auch:

MINUTE, SEKUNDE, MILLISEKUNDEN

SUCHEN (Text in Zeichenkette suchen)

Syntax:

SUCHEN(Suchbegriff; Zeichenkette [; Startposition])

Beschreibung:

Ermittelt die Position von Suchbegriff in Zeichenkette.

Mit dem optionalen Argument Startposition können Sie festlegen, ab welchem Zeichen der Zeichenkette
gesucht werden soll. Wird er nicht angegeben, beginnt die Suche mit dem ersten Zeichen.

Die Groß-/Kleinschreibung des Suchbegriffs spielt dabei keine Rolle. Verwenden Sie die Funktion
FINDEN, wenn die Groß-/Kleinschreibung beachtet werden soll

Beispiel:

SUCHEN("a"; "Banane") ergibt 2

SUCHEN("A"; "Banane") ergibt 2

SUCHEN("a"; "Banane"; 3) ergibt 4

SUCHEN("x"; "Banane") ergibt den Fehlerwert #WERT!, da in der durchsuchten Zeichenkette kein "x"
vorkommt.

Siehe auch:

FINDEN, ERSETZEN, WECHSELN, IDENTISCH, TEIL

SUMME (Summe)

Syntax:

SUMME(Zahl1 [; Zahl2; Zahl3 ...])
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Beschreibung:

Bildet die Summe aus den angegebenen Zahlenwerten.

Anmerkung:

Beachten Sie: Normalerweise berücksichtigt diese Funktion nur Zahlen und ignoriert Zeichenketten und
Wahrheitswerte. Anders sieht es allerdings aus, wenn Sie ihr feste Werte übergeben: Hier werden Zeichen-
ketten, die Zahlen enthalten, einbezogen. Weiterhin werden die Wahrheitswerte WAHR als 1 und FALSCH
als 0 behandelt. Siehe Beispiele.

Beispiel:

SUMME(1; 2; 3; 4) entspricht 1+2+3+4, ergibt also 10

Wenn die Zellen A1 bis A4 mit den Werten 1, 2, 3 und 4 gefüllt sind, gilt:

SUMME(A1:A4) entspricht 1+2+3+4, ergibt also 10

Aber:

SUMME(1; "2"; WAHR) ergibt 1+2+1, also 4

Aber: Sind die Zellen A1 bis A3 mit 1, "2" und WAHR gefüllt, liefert die Formel SUMME(A1:A3) ein an-
deres Ergebnis: Es kommt 1 heraus, da Zeichenketten und Wahrheitswerte nur berücksichtigt werden, wenn
sie als feste Werte übergeben wurden.

Tipp 

Über das AutoSummen-Symbol  in der Funktionsleiste können Sie besonders schnell die Summe ei-
nes bestimmten Zellbereichs bilden:

Wenn Sie dieses Symbol in einer leeren Zelle direkt unter einer Gruppe von Zellen mit Zahlen anklicken,
fügt es dort automatisch die Summenfunktion für diesen Zellbereich ein. 

Alternativ können Sie auch erst einen Bereich von Zellen mit Zahlen markieren und das Symbol dann ankli-
cken, worauf es die Summe dieses Zellbereichs direkt darunter einfügt.

Sie können dieses Symbol auch für andere Rechenfunktionen verwenden. Klicken Sie dazu auf das Pfeil-
chen rechts neben dem Symbol. Es öffnet sich eine Liste der verfügbaren Funktionen – zum Beispiel An-
zahl, Produkt, Mittelwert etc. Wählen Sie darin die gewünschte Funktion und gehen Sie dann wie oben be-
schrieben vor.

Siehe auch:

PRODUKT, SUMMENPRODUKT, SUMMEWENN, SUMMEWENNS, SUMMEXMY2,
SUMMEX2MY2, SUMMEX2PY2
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SUMMENPRODUKT (Summenprodukt)

Syntax:

SUMMENPRODUKT(Bereich1 [; Bereich2; Bereich3 ...])

Beschreibung:

Multipliziert alle sich entsprechenden Elemente von zwei oder mehr Matrizen miteinander und bildet dann
die Summe dieser Produkte.

Bereich1, Bereich2 etc. sind die Matrizen, deren Summenprodukt berechnet werden soll. In der Regel sind
hier die Zellbereiche anzugeben, in denen die Werte enthalten sind. 

Die Zahl der Zeilen und Spalten der einzelnen Matrizen muss identisch sein, andernfalls liefert die Funktion
den Fehlerwert #NV.

Leere Zellen und Zellen mit einem nicht-numerischen Inhalt (Zeichenketten etc.) werden als Null interpre-
tiert.

Beispiel:

Sie haben ein Dokument erstellt, in dem Sie Ihren Lagerbestand erfassen. 

Das Dokument enthält zwei gleich große Bereiche. Im ersten sind die Stückzahlen der Artikel eingetragen.
Im zweiten Bereich die zugehörigen Einzelpreise. 

Um den Gesamtwert aller Artikel im Lager auszurechnen, müssen die Stückzahlen der einzelnen Artikel mit
ihrem jeweiligen Einzelpreis multipliziert werden. Schließlich muss die Summe dieser Produkte gebildet
werden. 

Diese gesamte Berechnung bekommen Sie mit der Funktion SUMMENPRODUKT unter einen Hut: 
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SUMMENPRODUKT(B4:C6; B11:C13) ergibt 12710. 

Es befinden sich derzeit also Artikel im Wert von € 12710,- im Lager.

Siehe auch:

SUMME, QUADRATESUMME, SUMMEXMY2, SUMMEX2MY2, SUMMEX2PY2

SUMMEWENN (Summe ausgewählter Werte)

Syntax:

SUMMEWENN(Suchbereich; Suchkriterium [; Summenbereich])

Beschreibung:

Bildet die Summe derjenigen Werte in einem Bereich, für die die angegebene Bedingung zutrifft. 

Suchbereich ist der zu durchsuchende Bereich.

Suchkriterium ist die zu erfüllende Bedingung:

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder "Schrauben"). In diesem
Fall werden alle Posten addiert, die diesem Wert entsprechen.

Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden alle Posten addiert, die
dieser Bedingung entsprechen.

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") umgeben werden.

Das optionale Argument Summenbereich bestimmt, welche Werte tatsächlich addiert werden sollen. Wenn
Summenbereich nicht angegeben ist, werden die Werte im Suchbereich addiert.

Beispiel:

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt:

SUMMEWENN(A1:A5; "2") ergibt 2+2, also 4

SUMMEWENN(A1:A5; ">=2") ergibt 2+3+2, also 7

Sie tragen Ihre Tageseinnahmen in eine Tabelle ein – etwa wie folgt:
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Wie groß ist die Summe der Umsätze, wenn man nur Umsätze größer als € 40,- berücksichtigt?

SUMMEWENN(D2:D5; ">40") ergibt 100,80 Euro

Wie viele Blumen der Gattung "Rosen" wurden verkauft?

SUMMEWENN(C2:C5; "Rosen"; B2:B5) ergibt 18

Bei obiger Formel wurde das optionale Argument Summenbereich eingesetzt: Der Suchbereich C2:C5 (al-
so die Sorte) wurde durchsucht, die zu addierenden Zahlen wurden jedoch dem Summenbereich B2:B5 (al-
so der Stückzahl) entnommen.

Siehe auch:

MITTELWERTWENN, MITTELWERTWENNS, SUMME, SUMMEWENNS, ZÄHLENWENN,
ZÄHLENWENNS

SUMMEWENNS (Summe ausgewählter Werte)

Syntax:

SUMMEWENNS(Summenbereich; Suchbereich1; Suchkriterium1 [; Suchbereich2; Suchkriterium2 ...])

Beschreibung:

Bildet die Summe derjenigen Werte in einem Bereich, für die alle angegebenen Bedingungen zutreffen. 

Entspricht der Funktion SUMMEWENN, erlaubt allerdings die Verwendung mehrerer Suchbereiche (inklu-
sive eines Suchkriteriums für jeden Bereich)

Beachten Sie: Die Reihenfolge der Parameter ist hier anders als bei SUMMEWENN: Bei SUMMEWENNS
ist der Summenbereich der erste Parameter und nicht der letzte. 

Summenbereich ist der Bereich mit den Werten, die addiert werden sollen. 

Suchbereich1 ist der erste zu durchsuchende Bereich. Dieser muss die gleichen Ausmaße haben wie der
Summenbereich.

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müssen:

Hier können Sie einerseits einfach einen Wert angeben (zum Beispiel "42" oder "Schrauben"). In diesem
Fall werden alle Posten addiert, die diesem Wert entsprechen.
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Andererseits ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden alle Posten addiert, die
dieser Bedingung entsprechen.

Hinweis: Die Suchkriterien sollten stets mit doppelten Anführungszeichen (") umgeben werden.

Im Gegensatz zur Funktion SUMMEWENN können Sie bei SUMMEWENNS auch mehrere Suchbereiche
mit jeweils dazugehörendem Suchkriterium angeben. Es werden dann nur diejenigen Werte addiert, bei de-
nen alle Kriterien erfüllt sind.

Kompatibilitätshinweise:

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 2003 und früher. Wenn Sie
ein Dokument in diesem Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch
ihr aktuelles Ergebnis als fester Wert ersetzt. 

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht im Dateiformat "Microsoft
Excel 97-2003 (.xls)" speichern, sondern eines der folgenden Formate verwenden:

¡ "PlanMaker-Dokument (.pmdx oder .pmd)" 

¡ oder: "Microsoft Excel 2007-2016 (.xlsx)"

Beispiel:

SUMMEWENNS(A1:A10; C1:C10; ">1"; C1:C10; "<2") 

Diese Formel liefert die Summe all derjenigen Zellen im Bereich A1:A10, bei denen die entsprechende Zel-
le im Bereich C1:C10 größer als 1 und kleiner als 2 ist.

Siehe auch:

MITTELWERTWENN, MITTELWERTWENNS, SUMME, SUMMEWENN, ZÄHLENWENN,
ZÄHLENWENNS

SUMMEX2MY2 (Summe von x^2 - y^2)

Syntax:

SUMMEX2MY2(Bereich1; Bereich2)

Beschreibung:

Subtrahiert jeweils die Quadrate der sich entsprechenden Elemente von zwei Matrizen und bildet dann die
Summe dieser Differenzen.

Es wird also folgende Berechnung durchgeführt:

SUMMEX2MY2 = å(x^2 - y^2)

Bereich1 und Bereich2 sind die Matrizen, deren SummeX2MY2 berechnet werden soll. In der Regel sind
hier die Zellbereiche anzugeben, in denen die Werte enthalten sind. 
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Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, andernfalls liefert die Funktion
den Fehlerwert #NV.

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden ignoriert.

Beispiel:

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5

Wenn Sie hier SUMMEX2MY2(A1:A3; B1:B3) berechnen, entspricht das folgender Berechnung:

(9^2) - (1^2) + (4^2) - (0^2) + (7^2) - (5^2)

Das Ergebnis ist 120.

Siehe auch:

SUMME, SUMMENPRODUKT, SUMMEX2PY2, SUMMEXMY2, QUADRATESUMME

SUMMEX2PY2 (Summe von x^2 + y^2)

Syntax:

SUMMEX2PY2(Bereich1; Bereich2)

Beschreibung:

Summiert die Quadrate der Elemente von zwei Matrizen.

Es wird also folgende Berechnung durchgeführt:

SUMMEX2PY2 = å(x^2 + y^2)

Bereich1 und Bereich2 sind die Matrizen, deren SummeX2PY2 berechnet werden soll. In der Regel sind
hier die Zellbereiche anzugeben, in denen die Werte enthalten sind. 

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, andernfalls liefert die Funktion
den Fehlerwert #NV.

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden ignoriert.

Beispiel:

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5

Wenn Sie hier SUMMEX2PY2(A1:A3; B1:B3) berechnen, entspricht das folgender Berechnung:

(9^2) + (1^2) + (4^2) + (0^2) + (7^2) + (5^2)

Das Ergebnis ist 172.
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Siehe auch:

SUMME, SUMMENPRODUKT, SUMMEX2MY2, SUMMEXMY2, QUADRATESUMME

SUMMEXMY2 (Summe von (x - y)^2)

Syntax:

SUMMEXMY2(Bereich1; Bereich2)

Beschreibung:

Berechnet jeweils das Quadrat der Differenz der sich entsprechenden Elemente von zwei Matrizen und bil-
det dann die Summe dieser Differenzen.

Es wird also folgende Berechnung durchgeführt:

SUMMEXMY2 = å(x - y)^2

Bereich1 und Bereich2 sind die Matrizen, deren SummeXMY2 berechnet werden soll. In der Regel sind
hier die Zellbereiche anzugeben, in denen die Werte enthalten sind.

Die Zahl der Zeilen und Spalten dieser beiden Matrizen muss identisch sein, andernfalls liefert die Funktion
den Fehlerwert #NV.

Wertepaare, bei denen mindestens ein Wert leer oder nicht-numerisch ist, werden ignoriert.

Beispiel:

In den Zellen A1 bis A3 stehen folgende Werte: 9, 4, 7

In den Zellen B1 bis B3 stehen folgende Werte: 1, 0, 5

Wenn Sie hier SUMMEXMY2(A1:A3; B1:B3) berechnen, entspricht das folgender Berechnung:

(9-1)^2 + (4-0)^2 + (7-5)^2

Das Ergebnis ist 84.

Siehe auch:

SUMME, SUMMENPRODUKT, SUMMEX2MY2, SUMMEX2PY2, QUADRATESUMME

SUMQUADABW (Mittlere quadratische Abweichung vom Mittelwert)

Syntax:

SUMQUADABW(Zahl1 [; Zahl2; Zahl3 ...])
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Beschreibung:

Berechnet die mittlere quadratische Abweichung der angegebenen Zahlenwerte von ihrem Mittelwert.

Leere Zellen, Zeichenketten und Wahrheitswerte werden ignoriert.

Beispiel:

SUMQUADABW(2; 2; 2; 3) ergibt 0,75

Siehe auch:

MITTELABW, STABW.S/STABW, SUMME, VAR.S/VARIANZ

SVERWEIS (Zellbereich spaltenweise durchsuchen)

Syntax:

SVERWEIS(Suchkriterium; Bereich; n [; Sortiert])

Beschreibung:

Diese Funktion sucht in der ersten Spalte von Bereich nach dem ersten Vorkommen von Suchkriterium.
Wird es gefunden, liefert die Funktion den Inhalt der Zelle, die sich in der gleichen Zeile und der n-ten
Spalte von Bereich befindet.

Anmerkung: SVERWEIS arbeitet nur in senkrechter Suchrichtung. Um waagerecht zu suchen, nutzen Sie
stattdessen WVERWEIS.

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rolle.

Bereich ist der zu durchsuchende Zellbereich. Die erste Spalte muss die zu durchsuchenden Werte enthal-
ten. Dies können Zeichenketten, Zahlen oder Wahrheitswerte sein.

Für n ist anzugeben, aus der wievielten Spalte von Bereich ein Wert zurückgeliefert werden soll, wenn das
Suchkriterium gefunden wird.

Ist n kleiner als 1, wird der Fehlerwert #BEZUG! zurückgeliefert. Ist n größer als die Spaltenzahl von Be-
reich, wird der Fehlerwert #BEZUG! zurückgeliefert. 

Sortiert ist ein Wahrheitswert, mit dem Sie angeben, ob die Werte in der ersten Zeile von Bereich sortiert
sind:

Ist Sortiert WAHR oder nicht angegeben, müssen die Werte in der ersten Spalte von Bereich aufsteigend
sortiert sein.

Ist Sortiert FALSCH, spielt die Reihenfolge der Werte in der ersten Spalte keine Rolle.

Wichtig: Wenn Sie Sortiert also nicht explizit auf FALSCH setzen, müssen diese Werte in sortierter Rei-
henfolge vorliegen!
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Hinweis:

Wenn Sortiert auf WAHR gesetzt ist und SVERWEIS keinen exakt mit dem Suchkriterium übereinstim-
menden Wert findet, wird automatisch der nächstkleinere Wert genommen. Existiert kein kleinerer Wert,
weil Suchkriterium kleiner als der kleinste vorhandene Wert ist, liefert die Funktion den Fehlerwert #NV.

Beispiel:

Sie verkaufen Blumen zu unterschiedlichen Stückpreisen – je nachdem, wie viele Pflanzen der Kunde ab-
nimmt. Dazu haben Sie eine Tabelle mit einer Rabattstaffel erstellt:

Jetzt können Sie die Funktion SVERWEIS einsetzen, um abhängig von der Stückzahl den Preis für eine be-
stimmte Blumensorte zu ermitteln. 

Verwenden Sie dazu folgende Argumente:

Als Suchkriterium geben Sie den Namen der Blumensorte an (also "Rosen", "Nelken" oder "Tulpen").

Als Bereich geben Sie die den Zellbereich an, der in der ersten Zeile die Namen der Blumensorten und dar-
unter die Preise enthält – hier also A2:D4.

Für n geben Sie die Stückzahl plus Eins an, denn die erste Spalte (n=1) enthält ja keine Preise, sondern die
Namen der Pflanzen.

Beispiele:

SVERWEIS("Rosen"; A2:D4; 2; FALSCH) liefert den Stückpreis bei der Abnahme von einer Rose, also
5,50 Euro.

SVERWEIS("Rosen"; A2:D4; 3; FALSCH) liefert den Stückpreis bei der Abnahme von zwei Rosen, also
5,10 Euro.

SVERWEIS("Rosen"; A2:D4; 4; FALSCH) liefert den Stückpreis bei der Abnahme von drei Rosen, also
4,95 Euro.

SVERWEIS("Nelken"; A2:D4; 4; FALSCH) liefert den Stückpreis bei der Abnahme von drei Nelken, also
4,50 Euro.

SVERWEIS("Nelken"; A2:D4; 5; FALSCH) liefert den Fehlerwert #BEZUG, da n größer als die Zeilenzahl
von Bereich ist.

SVERWEIS("Petunien"; A2:D4; 4; FALSCH) liefert den Fehlerwert #NV, da "Petunien" in der ersten Zeile
von Bereich nicht vorkommt.

Siehe auch:

WVERWEIS, VERWEIS, INDEX, VERGLEICH, WAHL
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T (Wert in eine Zeichenkette umwandeln)

Syntax:

T(Wert)

Beschreibung:

Wandelt den übergebenen Wert in eine Zeichenkette.

Der übergebene Wert muss eine Zeichenkette sein, andernfalls liefert die Funktion eine leere Zeichenkette
zurück.

Hinweis:

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkulationen noch vorhanden.
PlanMaker selbst benötigt sie nicht mehr, da er Werte bei Bedarf automatisch in Zeichenketten umwandelt.

Beispiel:

T("Text") ergibt Text

T("42") ergibt 42

T(42) ergibt eine leere Zeichenkette

T(WAHR) ergibt eine leere Zeichenkette

Siehe auch:

N, WERT, TEXT

TAG (Tag aus einem Datumswert ermitteln)

Syntax:

TAG(Datum)

Beschreibung:

Liefert den Tag eines Datumswerts.

Beispiel:

TAG("25.9.2018") ergibt 25
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TAG("17. August") ergibt 17

Siehe auch:

WOCHENTAG, ISOKALENDERWOCHE, ISOWOCHE, KALENDERWOCHE, MONAT, JAHR

TAGE (Differenz zwischen zwei Daten)

Syntax:

TAGE(Enddatum; Ausgangsdatum)

Beschreibung:

Liefert die Differenz zwischen zwei Datumswerten in Tagen.

Beachten Sie dabei die Reihenfolge der Parameter: Die Funktion erwartet erst das Enddatum, dann das Aus-
gangsdatum. 

Hinweis:

Diese Funktion wurde in PlanMaker 2016 überarbeitet: Die Reihenfolge ihrer zwei Parameter wurde umge-
dreht.

Hintergrund: Die Funktion TAGE ist in PlanMaker schon seit langer Zeit vorhanden. Excel kannte diese
Funktion bisher nicht. In Excel 2013 wurde dann eine Funktion mit dem gleichen Namen eingeführt. Diese
funktioniert auch exakt so wie die Funktion TAGE in PlanMaker – allerdings ist die Reihenfolge der Para-
meter in Excel anders herum: erst Enddatum, dann Ausgangsdatum. Um kompatibel zu Excel zu sein, wurde
diese Reihenfolge in PlanMaker 2016 entsprechend angeglichen. 

Die bisherige Version der Funktion wurde in TAGEP umbenannt Die Funktionen TAGE und TAGEP sind
also identisch, nur die Reihenfolge der Parameter unterscheidet sich:

TAGE(Enddatum; Ausgangsdatum) entspricht

TAGEP(Ausgangsdatum; Enddatum)

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

TAGE("14.01.2018"; "01.1.2018") ergibt 13

Siehe auch:

TAGEP, DATEDIF, NETTOARBEITSTAGE, TAGE360, ZEITDIFFERENZ
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TAGE360 (Differenz zwischen zwei Daten)

Syntax:

TAGE360(Ausgangsdatum; Enddatum [; Methode])

Beschreibung:

Die Funktion TAGE360 liefert die Differenz zwischen zwei Datumswerten in Tagen. Im Unterschied zur
Funktion TAGE führt sie die Berechnung jedoch auf Basis eines Jahres mit 360 Tagen (12 Monate à 30 Ta-
ge) durch und lässt Schaltjahre außer acht.

Das optionale Argument Methode bestimmt, wie dabei mit Daten umgegangen werden soll, die auf den 31.
des Monats fallen:

FALSCH oder nicht angegeben: Es wird die amerikanische Buchführungsmethode verwendet: Ist das Aus-
gangsdatum der 31. des Monats, wird dieses zum 30 desselben Monats. Ist das Enddatum der 31., wird es
zum 1. des Folgemonats.

WAHR: Es wird die europäische Buchführungsmethode verwendet: Ist Ausgangs- oder Enddatum der 31.
des Monats, wird dieses zum 30. des Monats.

Hinweis:

Sofern Sie also nicht nach der amerikanischen Buchführungsmethode rechnen möchten, muss das Argument
Methode mit WAHR angegeben werden.

Beispiel:

TAGE360("1.1.2018"; "1.2.2018"; WAHR) ergibt 30

TAGE360("1.2.2018"; "1.3.2018"; WAHR) ergibt 30

TAGE360("1.1.2012"; "1.1.2013"; WAHR) ergibt 360

Siehe auch:

DATEDIF, NETTOARBEITSTAGE, TAGE/TAGEP, ZEITDIFFERENZ

TAGEIMJAHR (Zahl der Tage eines Jahres)

Syntax:

TAGEIMJAHR(Datum)
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Beschreibung:

Liefert die Anzahl der Tage eines bestimmten Jahres.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

TAGEIMJAHR("1.1.2012") ergibt 366 (2012 war ein Schaltjahr)

TAGEIMJAHR("1.1.2013") ergibt 365 (2013 war kein Schaltjahr)

Siehe auch:

JAHR, TAGEIMMONAT, TAGE/TAGEP, TAGE360

TAGEIMMONAT (Zahl der Tage eines Monats)

Syntax:

TAGEIMMONAT(Datum)

Beschreibung:

Liefert die Anzahl der Tage eines bestimmten Monats.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

TAGEIMMONAT("25.09.2018") ergibt 30 (Tage)

TAGEIMMONAT("25.10.2018") ergibt 31 (Tage)

Siehe auch:

TAGEIMJAHR, JAHR, TAGE/TAGEP, TAGE360 
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TAGEP (Kompatibilitätsfunktion)

Syntax:

TAGEP(Ausgangsdatum; Zieldatum)

Beschreibung:

Kompatibilitätsfunktion für ältere PlanMaker-Dokumente. 

Diese Funktion wurde durch die Funktion TAGE ersetzt (Beachten Sie, dass bei dieser die Reihenfolge der
Parameter genau umgekehrt ist)

Siehe nachfolgende Hinweise.

Hinweis:

TAGEP ist lediglich eine Kompatibilitätsfunktion. Wenn Sie ein Dokument öffnen, das mit PlanMaker
2012 oder früher erstellt wurde, werden darin alle Vorkommen der Funktion TAGE automatisch in TAGEP
konvertiert. Grund: In PlanMaker 2016 wurde die Reihenfolge der Parameter für die Funktion TAGE umge-
dreht.

Für neue Dokumente sollten Sie statt dieser Funktion vorzugsweise die Excel 2013-kompatible Funktion
TAGE verwenden. Diese ist völlig identisch – bis auf die vertauschte Reihenfolge der Parameter:

TAGE(Enddatum; Ausgangsdatum) entspricht

TAGEP(Ausgangsdatum; Enddatum)

Weitere Informationen dazu finden Sie im Abschnitt TAGE.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

TAGEP("01.1.2018"; "14.01.2018") ergibt 13

Siehe auch:

TAGE, DATEDIF, NETTOARBEITSTAGE, TAGE360, ZEITDIFFERENZ
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TAN (Tangens)

Syntax:

TAN(Zahl)

Beschreibung:

Liefert den Tangens eines Winkels. 

Der Winkel ist dabei im Bogenmaß (Radiant) anzugeben.

Tipp:

Mit der Funktion BOGENMASS können Sie einen in Grad vorliegenden Winkel ins Bogenmaß umrechnen.

Beispiel:

TAN(PI()/4) ergibt 1

TAN(BOGENMASS(45)) ergibt 1

Siehe auch:

ARCTAN, ARCTAN2, COT, SIN, COS

TANHYP (Tangens Hyperbolicus)

Syntax:

TANHYP(Zahl)

Beschreibung:

Die Funktion TANHYP (Tangens Hyperbolicus) liefert den hyperbolischen Tangens einer Zahl.

Beispiel:

TANHYP(0,45) ergibt 0,4219

Siehe auch:

ARCTANHYP, COSHYP, SINHYP
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TEIL (Teil einer Zeichenkette)

Syntax:

TEIL(Zeichenkette; Start; Anzahl)

Beschreibung:

Liefert einen Teil einer Zeichenkette. 

Das Teilstück beginnt bei Start und ist Anzahl Zeichen lang.

Beispiel:

TEIL("Kartoffel"; 2; 3) ergibt art

TEIL("Kartoffel"; 2; 8) ergibt artoffel

TEIL("Kartoffel"; 2; 100) ergibt artoffel

TEIL("Kartoffel"; 100; 100) ergibt eine leere Zeichenkette

Siehe auch:

LINKS, RECHTS, ERSETZEN, FINDEN, SUCHEN, LÄNGE

TEILERGEBNIS (Berechnungen ohne ausgeblendete Zellen)

Syntax:

TEILERGEBNIS(Funktionsnummer; Bereich1 [; Bereich2; Bereich3...])

Beschreibung:

Diese Funktion wendet eine der unten aufgelisteten Rechenfunktionen auf einen oder mehrere Zellbereiche
an, ignoriert dabei jedoch alle Zellen, die momentan ausgeblendet sind.

Im Detail: Wenn Sie mit dem Menübefehl Arbeitsblatt > Filter Teile eines Zellbereichs herausfiltern und
dann beliebige Rechenfunktionen auf diesen Bereich anwenden, beziehen diese immer auch die gefilterten
Zellen mit ein. Anders sieht es bei der Funktion TEILERGEBNIS aus: diese ignoriert die gefilterten Zellen.

Bei Bereich1, Bereich2 etc. geben Sie den Zellbereich oder die Zellbereiche an, die Sie auswerten möch-
ten.

Mit dem Argument Funktionsnummer bestimmen Sie, welche Rechenfunktion angewandt werden soll.
Geben Sie dazu einen Zahlenwert zwischen 1 und 11 gemäß folgender Tabelle ein:
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Wert Rechenfunktion Erläuterung

1: MITTELWERT (arithmetisches Mittel)

2: ANZAHL (wie viele Zellen sind mit Zahlen ausgefüllt?)

3: ANZAHL2 (wie viele Zellen sind ausgefüllt?)

4: MAX (größter Wert)

5: MIN (kleinster Wert)

6: PRODUKT (Produkt)

7: STABW (Standardabweichung Stichprobe)

8: STABWN (Standardabweichung Grundgesamtheit)

9: SUMME (Summe)

10: VARIANZ (Varianz Stichprobe)

11: VARIANZEN (Varianz Grundgesamtheit)

Tragen Sie für Funktionsnummer also beispielsweise 9 ein, liefert TEILERGEBNIS die Summe des Zell-
bereichs – ignoriert dabei aber alle Zellen, die mit dem Menübefehl Arbeitsblatt > Filter ausgeblendet
wurden.

Manuell ausgeblendete Zellen ebenfalls ignorieren:

Es gibt noch eine zweite Variante dieser Funktion. Bei dieser werden zusätzlich alle Zeilen ignoriert, die
manuell ausgeblendet wurden (zum Beispiel mit dem Menübefehl Arbeitsblatt > Zeile Ausblenden oder
dem Menübefehl Arbeitsblatt > Gliederung > Gruppieren). Um diese Variante einzusetzen, verwenden
Sie für die Funktionsnummer einfach Werte von 101 bis 111 anstelle von Werten von 1 bis 11:

Wert Rechenfunktion Erläuterung

101: MITTELWERT (arithmetisches Mittel)

102: ANZAHL (wie viele Zellen sind mit Zahlen ausgefüllt?)

103: ANZAHL2 (wie viele Zellen sind ausgefüllt?)

104: MAX (größter Wert)

105: MIN (kleinster Wert)

106: PRODUKT (Produkt)

107: STABW (Standardabweichung Stichprobe)

108: STABWN (Standardabweichung Grundgesamtheit)

109: SUMME (Summe)

110: VARIANZ (Varianz Stichprobe)

111: VARIANZEN (Varianz Grundgesamtheit)

Tragen Sie für Funktionsnummer also beispielsweise 109 ein, liefert TEILERGEBNIS die Summe des
Zellbereichs – ignoriert dabei aber alle Zellen, die mit dem Menübefehl Arbeitsblatt > Filter ausgeblendet
wurden. Außerdem werden alle Zeilen ignoriert, die über die Menübefehle Arbeitsblatt > Zeile > Ausblen-
den oder mit Arbeitsblatt > Gliederung > Gruppieren manuell ausgeblendet wurden. 

Beachten Sie: Hierbei wird nur das Ausblenden von Zeilen berücksichtigt, das Ausblenden von Spalten
spielt keine Rolle.
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Beispiel:

TEILERGEBNIS(9; A1:A10) berechnet die Summe des Bereichs A1:A10, ignoriert dabei jedoch alle mit
dem Menübefehl Arbeitsblatt > Filter herausgefilterten Zellen.

Siehe auch:

Informationen zu Filtern finden Sie im Abschnitt Filtern.

TEXT (Zahl in formatierten Text wandeln)

Syntax:

TEXT(Zahl; Format)

Beschreibung:

Wandelt eine Zahl in eine Zeichenkette mit beliebig definierbarer Formatierung um. 

Über das Argument Format geben Sie die gewünschte Formatierung an. Tragen Sie hier eine entsprechende
Zeichenkette ein. Diese muss aufgebaut sein wie eine Zeichenkette, die Sie beim Anlegen benutzerdefinier-
ter Zahlenformate mit dem Menübefehl Format > Zelle eingeben (siehe Abschnitt Aufbau eines benutzer-
definierten Zahlenformats).

Anmerkung:

Wenn Sie das Format von Zahlen ändern möchten, ohne sie dabei in eine Zeichenkette zu wandeln, rufen
Sie den Menübefehl Format > Zelle auf und wählen das gewünschte Zahlenformat.

Beispiel:

TEXT("25.9.2018"; "TT.MM.JJ") ergibt den Text 25.09.18

TEXT(2,715; "0,00 ""EUR""") ergibt den Text 2,72 EUR

Siehe auch:

WERT, T, N, FEST

TINV (Quantile einer t-Verteilung)

Hinweis: TINV wird durch die neue identische Funktion T.INV.2S und die gänzlich neue Funktion
T.INV ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet werden.
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Syntax:

TINV(Wahrscheinlichkeit; Freiheitsgrade)

Beschreibung:

Liefert die Quantile einer zweiseitigen t-Verteilung (Student-Verteilung). 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der t-Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 sein. Erwartet
wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Bitte beachten Sie: Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet
PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit ab-
weicht, zeigt er den Fehlerwert #NV an und bricht die Näherung ab.

Siehe auch:

T.INV.2S/T.INV, T.TEST/TTEST, T.VERT.2S/T.VERT.RE/T.VERT/TVERT

T.INV (Quantile einer t-Verteilung linksseitig)

Syntax:

T.INV(Wahrscheinlichkeit; Freiheitsgrade)

Beschreibung:

Liefert die Quantile einer linksseitigen t-Verteilung (Student-Verteilung). 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der t-Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 sein. Erwartet
wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Bitte beachten Sie: Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet
PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit ab-
weicht, zeigt er den Fehlerwert #NV an und bricht die Näherung ab.

Hinweis:

Die Funktion T.INV ergänzt zusammen mit T.INV.2S die bisherige Funktion TINV.

T.INV.2S liefert dasselbe Ergebnis wie TINV (zweiseitiges Quantil).

T.INV (linksseitiges Quantil) ist gänzlich neu.
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Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

TINV/T.INV.2S, T.TEST/TTEST, T.VERT.2S/T.VERT.RE/T.VERT/TVERT

T.INV.2S (Quantile einer t-Verteilung zweiseitig)

Syntax:

T.INV.2S(Wahrscheinlichkeit; Freiheitsgrade)

Beschreibung:

Liefert die Quantile einer zweiseitigen t-Verteilung (Student-Verteilung). 

Wahrscheinlichkeit ist die gegebene Wahrscheinlichkeit aus der t-Verteilung. Zulässig sind nur Werte aus
dem Intervall [0..1].

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 sein. Erwartet
wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Bitte beachten Sie: Das Ergebnis dieser Funktion wird mit Hilfe eines Iterationsverfahrens ermittelt. Findet
PlanMaker nach 100 Iterationen kein Ergebnis, das weniger als ±3x10^-7 von Wahrscheinlichkeit ab-
weicht, zeigt er den Fehlerwert #NV an und bricht die Näherung ab.

Hinweis:

Die Funktion T.INV.2S ergänzt zusammen mit T.INV die bisherige Funktion TINV.

T.INV.2S liefert dasselbe Ergebnis wie TINV (zweiseitiges Quantil).

T.INV (linksseitiges Quantil) ist gänzlich neu.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

TINV/T.INV, T.TEST/TTEST, T.VERT.2S/T.VERT.RE/T.VERT/TVERT
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TTEST (t-Test)

Hinweis: TTEST wird durch die neue identische Funktion T.TEST ergänzt, die in neueren Versionen
von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

TTEST(Werte1; Werte2; Seiten; Typ)

Beschreibung:

Liefert die Teststatistik eines Studentschen t-Tests. 

Mit einem t-Test kann die Konsistenz der Mittelwerte zweier Stichproben geprüft werden.

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben).

Seiten bestimmt, ob ein ein- oder ein zweiseitiger Test verwendet werden soll:

1: einseitiger Test

2: zweiseitiger Test

Typ bestimmt die Art des Tests:

1: abhängige Stichproben ("gepaart")

2: unabhängige Stichproben, gleiche Varianzen ("homoskedastisch")

3: unabhängige Stichproben, ungleiche Varianzen ("heteroskedastisch")

Siehe auch:

T.TEST, T.INV.2S/T.INV/TINV, T.VERT.2S/T.VERT.RE/T.VERT/TVERT

T.TEST (t-Test)

Syntax:

T.TEST(Werte1; Werte2; Seiten; Typ)

Beschreibung:

Liefert die Teststatistik eines Studentschen t-Tests. 

Mit einem t-Test kann die Konsistenz der Mittelwerte zweier Stichproben geprüft werden.

Werte1 und Werte2 sind die zu untersuchenden Wertebereiche (Stichproben).
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Seiten bestimmt, ob ein ein- oder ein zweiseitiger Test verwendet werden soll:

1: einseitiger Test

2: zweiseitiger Test

Typ bestimmt die Art des Tests:

1: abhängige Stichproben ("gepaart")

2: unabhängige Stichproben, gleiche Varianzen ("homoskedastisch")

3: unabhängige Stichproben, ungleiche Varianzen ("heteroskedastisch")

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

TTEST, T.INV.2S/T.INV/TINV, T.VERT.2S/T.VERT.RE/T.VERT/TVERT

TREND (Werte einer linearen Regression)

Syntax:

TREND(y_Werte [; x_Werte] [; Neue_x_Werte] [; Konstante])

Beschreibung:

Liefert die Werte einer linearen Regression.

Unter einer linearen Regression versteht man das Anpassen einer linearen Funktion (Regressionsgerade
oder Ausgleichsgerade genannt) an eine Menge von Punkten (zum Beispiel den Messpunkten einer Messrei-
he).

TREND erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen x-Werte) und liefert
als Ergebnis eine Matrix mit den entsprechenden y-Koordinaten der Regressionsgeraden.

Im Einzelnen erwartet die Funktion folgende Argumente:

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen Werte, an. y_Werte kann
entweder ein Zellbezug oder eine Matrix sein.

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte angegeben werden. Auch
x_Werte kann entweder ein Zellbezug oder eine Matrix sein. Wird x_Werte nicht angegeben, verwendet
die Funktion automatisch die Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte).

Neue_x_Werte: Wird dieses Argument nicht angegeben, liefert die Ergebnismatrix dieser Funktion die y-
Koordinaten der Regressionsgeraden entsprechend den in x_Werte angegebenen x-Koordinaten. Bei Bedarf
können Sie mit Neue_x_Werte jedoch andere x-Koordinaten angeben. Auch Neue_x_Werte kann entweder
ein Zellbezug oder eine Matrix sein. 
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Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die Konstante b (der y-Ach-
senabschnitt) auf Null gesetzt werden soll:

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch berechnet.

FALSCH: b wird auf Null gesetzt. Die Regressionsgerade wird dadurch gezwungen, durch den Nullpunkt
zu laufen. Dies geschieht durch entsprechendes Anpassen des Koeffizienten m.

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Anmerkung:

Die lineare Regression wird bei dieser Funktion mit Hilfe der Methode der kleinsten Quadrate durchgeführt.

Beispiel:

Von einem temperaturabhängigen Widerstand wurde gemessen, welcher Widerstand bei verschiedenen
Temperaturen vorliegt.

In den Zellen A1 bis A4 sind die x-Koordinaten der Messpunkte eingetragen (also die unabhängigen Varia-
blen; in unserem Beispiel ist das die Temperatur): 8, 20, 25, 28

In den Zellen B1 bis B4 sind die y-Koordinaten eingetragen (also die abhängigen Variablen; in unserem
Beispiel ist dies der Widerstand): 261, 508, 608, 680

Mit der folgenden Formel erhalten Sie die y-Koordinaten der entsprechenden Punkte auf der Regressionsge-
raden (als Matrix):

TREND(B1:B4; A1:A4)

Siehe auch:

RGP, RKP, VARIATION, SCHÄTZER

TVERT (t-Verteilung)

Hinweis: TVERT wird durch die neuen Funktionen T.VERT.2S, T.VERT.RE und T.VERT mit zusätzli-
chen Funktionalitäten ergänzt, die in neueren Versionen von Microsoft Excel (ab 2010) verwendet wer-
den.

Syntax:

TVERT(X; Freiheitsgrade; Seiten)

Beschreibung:

Liefert Werte der Verteilungsfunktion einer t-verteilten (Student-verteilten) Zufallsvariablen.



662Formeln und Funktionen

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 sein. Erwartet
wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Seiten bestimmt, ob ein ein- oder ein zweiseitiger Test verwendet werden soll:

1: einseitiger Test

2: zweiseitiger Test

Siehe auch:

T.VERT.2S/T.VERT.RE/T.VERT, T.INV.2S/T.INV/TINV, T.TEST/TTEST 

T.VERT (t-Verteilung)

Syntax:

T.VERT(X; Freiheitsgrade; Kumuliert)

Beschreibung:

Liefert Werte der Verteilungsfunktion einer t-verteilten (Student-verteilten) Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 sein. Erwartet
wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Kumuliert bestimmt als Schalter die Art der Funktion: Gibt man den Wert WAHR ein, wird die kumulierte
Verteilungsfunktion der linksseitigen t-verteilung berechnet. Durch Eingabe von Wert FALSCH berechnet
sich die Dichtefunktion der linksseitigen t-verteilung.

Hinweis:

Die Funktion T.VERT ergänzt zusammen mit T.VERT.2S und T.VERT.RE die bisherige Funktion TVERT,
wobei T.VERT über das zusätzliche Argument Kumuliert verfügt.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

T.VERT.2S/T.VERT.RE/TVERT, T.INV/T.INV.2S/TINV, T.TEST/TTEST
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T.VERT.2S (t-Verteilung zweiseitig)

Syntax:

T.VERT.2S(X; Freiheitsgrade)

Beschreibung:

Liefert Werte der Verteilungsfunktion einer zweiseitigen t-verteilten (Student-verteilten) Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 sein. Erwartet
wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Hinweis:

Die Funktion T.VERT.2S ergänzt zusammen mit T.VERT.RE und T.VERT die bisherige Funktion TVERT,
wobei T.VERT.2S dasselbe Ergebnis liefert, wie TVERT mit dem Argument Seiten=2.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

T.VERT.RE/T.VERT/TVERT, T.INV.2S/T.INV/TINV, T.TEST/TTEST

T.VERT.RE (t-Verteilung rechtsseitig)

Syntax:

T.VERT.RE(X; Freiheitsgrade)

Beschreibung:

Liefert Werte der Verteilungsfunktion einer rechtsseitigen t-verteilten (Student-verteilten) Zufallsvariablen.

X ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. X darf keine negative Zahl sein.

Freiheitsgrade bestimmt die Zahl der Freiheitsgrade. Dieser Wert darf nicht kleiner als 1 sein. Erwartet
wird jeweils eine ganze Zahl; ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.
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Hinweis:

Die Funktion T.VERT.RE ergänzt zusammen mit T.VERT.2S und T.VERT die bisherige Funktion TVERT,
wobei T.VERT.RE dasselbe Ergebnis liefert, wie TVERT mit dem Argument Seiten=1.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

T.VERT.2S/T.VERT/TVERT, T.INV.2S/T.INV/TINV, T.TEST/TTEST

TYP (Typ des Arguments ermitteln)

Syntax:

TYP(Wert)

Beschreibung:

Liefert den Datentyp des Arguments in Form einer Zahl.

Welche Zahl für welchen Typ steht, können Sie der nachfolgenden Tabelle entnehmen:

Argument ist ... Ergebnis

Zahl oder leere Zelle 1

Zeichenkette 2

Wahrheitswert 4

Fehlerwert 16

Matrix 64

Beispiel:

TYP(42) ergibt 1

Steht in Zelle A1 die Zeichenkette "Text", so gilt:

TYP(A1) ergibt 2

Siehe auch:

FEHLERTYP
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UMWANDELN (Maßeinheiten umrechnen)

Syntax:

UMWANDELN(Zahl; Quelleinheit, Zieleinheit)

Beschreibung:

Wandelt eine Zahl von einer Einheit in eine andere um.

Die Argumente Quelleinheit und Zieleinheit geben Sie mit Hilfe der Codes in der nachfolgenden Tabelle
an. 

Beide Einheiten müssen aus der gleichen Kategorie sein. So können Sie beispielsweise Meter in Meilen um-
rechnen, aber natürlich nicht in Gramm.

Wenn diese Funktion den Fehlerwert #NV zurückliefert, liegt dies meist daran, dass a) Quelleinheit und
Zieleinheit nicht aus derselben Kategorie stammen oder b) einer der beiden Codes in falscher Schreibweise
angegeben wurde.

Achten Sie genau auf die Groß-/Kleinschreibung der Codes!

Es gibt folgende Codes:

Masse Code

Gramm g

Stück (Gewichtseinheit) sg

Pfund* (Handelsgewicht) lbm

u (Atommasse) u

Unze ozm

* Entspricht nicht dem im deutschen Sprachraum teil-
weise noch verwendeten Pfund (½ Kilo)

Länge Code

Meter m

Meile (Landmeile) mi

Meile (nautische Meile) Nmi

Zoll (Inch) in

Fuß (Feet) ft

Yard yd

Ångström ang

Pica Pica

Lichtjahr* ly
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Parsec (Parallaxensekunde)* parsec

* Diese Einheit wird von Excel nicht unterstützt.

Zeit Code

Sekunde sec

Minute mn

Stunde hr

Tag day

Jahr** yr

Fortnight* ftn

* Diese Einheit wird von Excel nicht unterstützt.

** Basierend auf einem Jahr mit 365,25 Tagen

Flüssigkeitsmaße Code

Liter l (kleines "L")

Teelöffel (Teaspoon) tsp

Esslöffel (Tablespoon) tbs

Flüssige Unze (Ounce) oz

Tasse (Cup) cup

Pint (U.S.) pt

Pint (U.K.) uk_pt

Quart (amerikanisches) qt

Gallone (amerikanische) gal

Kraft Code

Newton N

Dyne dyn

Pound-force lbf

Leistung Code

Watt W

PS HP

Feldstärke Code

Tesla T

Gauß ga
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Energie Code

Joule J

Erg e

Thermodynamische Kalorie c

Kalorie cal

Elektronvolt eV

PS mal Stunde HPh

Wattstunden Wh

Foot-pound force flb

BTU (British Thermal Unit) BTU

Druck Code

Pascal Pa

Atmosphären atm

mm Quecksilbersäule mmHg

Temperatur Code

Grad Fahrenheit F

Grad Celsius C

Grad Kelvin K

Weiterhin können Sie vor den Code einen der gebräuchlichen Präfixe setzen. So lässt sich beispielsweise
der Präfix "m" (Milli...) mit der Einheit "g" (Gramm) zur Einheit "mg" (Milligramm) kombinieren.

Achten Sie auch hier genau auf die Groß-/Kleinschreibung!

Es gibt folgende Präfixe:

Präfix (und Faktor) Code

Exa (10^18) E

Peta (10^15) P

Tera (10^12) T

Giga (10^9) G

Mega (10^6) M

Kilo (1000) k

Hekto (100) h

Deka (10) e

Dezi (0,1) d
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Zenti (0,01) c

Milli (0,001) m

Mikro (10^-6) u

Nano (10^-9) n

Piko (10^-12) p

Femto (10^-15) f

Atto (10^-18) a

Beispiel:

UMWANDELN(1; "day"; "sec") ergibt 86400 (Tage -> Sekunden)

UMWANDELN(1; "mi"; "km") ergibt 1,60934 (Meilen -> Kilometer)

UMWANDELN(100; "kW"; "HP") ergibt 134,10201 (100 kW -> PS)

UMWANDELN(1;"aparsec";"cm") ergibt 3,08568 (Attoparsec -> cm)

UND (Logisches UND)

Syntax:

UND(Wahrheitswert1 [; Wahrheitswert2; Wahrheitswert3 ...])

Beschreibung:

Diese Funktion liefert WAHR, wenn alle ihr übergebenen Wahrheitswerte WAHR sind, ansonsten liefert
sie FALSCH.

Sie können damit beispielsweise prüfen, ob mehrere Bedingungen allesamt zutreffen.

Beispiel:

UND(WAHR; WAHR) ergibt WAHR

UND(WAHR; FALSCH) ergibt FALSCH

UND(FALSCH; FALSCH) ergibt FALSCH

UND(A1>0; A1<1) ergibt WAHR; wenn A1 größer als Null und kleiner als Eins ist.

Siehe auch:

ODER, XODER, NICHT
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UNGERADE (Aufrunden auf eine ungerade Zahl)

Syntax:

UNGERADE(Zahl)

Beschreibung:

Rundet Zahl auf die betragsmäßig nächstgrößere ungerade Zahl auf.

Beispiel:

UNGERADE(41) ergibt 41

UNGERADE(42) ergibt 43

UNGERADE(-42) ergibt -43

Siehe auch:

GERADE, ABRUNDEN, AUFRUNDEN, RUNDEN, VRUNDEN

UNTERGRENZE (Abrunden auf ein Vielfaches von n)

Syntax:

UNTERGRENZE(Zahl; Basis)

Beschreibung:

Rundet Zahl auf ein Vielfaches von Basis ab.

Bei positiven Zahlen wird auf das nächstkleinere Vielfache von Basis abgerundet, bei negativen Zahlen
wird hingegen auf das nächstgrößere Vielfache aufgerundet.

Zahl und Basis müssen das gleiche Vorzeichen haben, sonst liefert die Funktion den Fehlerwert #ZAHL!

Beispiel:

UNTERGRENZE(42,5; 1) ergibt 42

UNTERGRENZE(-42,5; -1) ergibt -42

UNTERGRENZE(21; 5) ergibt 20

UNTERGRENZE(12,3456; 0,01) ergibt 12,34
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Siehe auch:

OBERGRENZE, ABRUNDEN, AUFRUNDEN, RUNDEN, VRUNDEN, KÜRZEN

VARIANZ (Varianz einer Stichprobe)

Hinweis: VARIANZ wird durch die neue identische Funktion VAR.S ergänzt, die in neueren Versionen
von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

VARIANZ(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert einen Schätzwert für die Varianz einer Grundgesamtheit anhand einer Stichprobe.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe). 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Anmerkung:

Die Varianz wird nach der Methode "Erwartungstreue Schätzung" oder "n-1" berechnet.

Beispiel:

VARIANZ(2; 2; 3; 4; 1) ergibt 1,3

Siehe auch:

VAR.S, VARIANZA, VARIANZENA, VAR.P/VARIANZEN, STABW.S/STABW, STABW.N/STABWN 

VARIANZA (Varianz)

Syntax:

VARIANZA(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Die Funktion VARIANZA entspricht nahezu der Funktion VARIANZ (siehe Hinweis). Sie liefert also
einen Schätzwert für die Varianz einer Grundgesamtheit anhand einer Stichprobe.
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Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe). 

Hinweis:

Im Gegensatz zu VARIANZ berücksichtigt die Funktion VARIANZA auch Werte, die keine Zahlen sind:
Beliebige Zeichenketten und der Wahrheitswert FALSCH werden als 0 interpretiert, WAHR als 1.

Leere Zellen werden hingegen auch hier ignoriert.

Anmerkung:

Die Varianz wird nach der Methode "Erwartungstreue Schätzung" oder "n-1" berechnet.

Beispiel:

VARIANZA(2; 2; 3; 4; 1) ergibt 1,3

Siehe auch:

VAR.S/VARIANZ, VARIANZENA

VARIANZEN (Varianz einer Grundgesamtheit)

Hinweis: VARIANZEN wird durch die neue identische Funktion VAR.P ergänzt, die in neueren Versio-
nen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

VARIANZEN(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert die Varianz einer vollständigen Grundgesamtheit.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. Es müssen alle Werte der Grundgesamtheit an-
gegeben werden. Falls nur eine Stichprobe aus der Grundgesamtheit vorliegt, ist statt VARIANZEN die
Funktion VAR.S/VARIANZ zu verwenden Diese liefert einen Schätzwert für die Varianz

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Anmerkung:

Die Varianz wird nach der Methode "n" berechnet.

Beispiel:

VARIANZEN(2; 2; 3; 4; 1) ergibt 1,04
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Siehe auch:

VAR.P, VAR.S/VARIANZ, STABW.S/STABW, STABW.N/STABWN 

VARIANZENA (Varianz)

Syntax:

VARIANZENA(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Die Funktion VARIANZENA entspricht nahezu der Funktion VARIANZEN (siehe Hinweis). Sie liefert al-
so die Varianz einer vollständigen Grundgesamtheit.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. Es müssen alle Werte der Grundgesamtheit an-
gegeben werden. Falls nur eine Stichprobe aus der Grundgesamtheit vorliegt, ist statt VARIANZENA die
Funktion VARIANZA oder VAR.S/VARIANZ zu verwenden Diese liefert einen Schätzwert für die Varianz

Hinweis:

Im Gegensatz zu VARIANZEN berücksichtigt die Funktion VARIANZENA auch Werte, die keine Zahlen
sind: Beliebige Zeichenketten und der Wahrheitswert FALSCH werden als 0 interpretiert, WAHR als 1.

Leere Zellen werden hingegen auch hier ignoriert.

Beispiel:

VARIANZENA(2; 2; 3; 4; 1) ergibt 1,04

Siehe auch:

VAR.P/VARIANZEN, VAR.S/VARIANZ, VARIANZA

VARIATION (Werte einer exponentiellen Regression)

Syntax:

VARIATION(y_Werte [; x_Werte] [; Neue_x_Werte] [; Konstante])

Beschreibung:

Liefert die Werte einer exponentiellen Regression.
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Unter einer exponentiellen Regression versteht man das Anpassen einer Exponentialkurve an eine Menge
von Punkten (zum Beispiel den Messpunkten einer Messreihe).

VARIATION erwartet als Argumente die y-Werte (und, sofern angegeben, die zugehörigen x-Werte) und
liefert als Ergebnis eine Matrix mit den y-Koordinaten der Exponentialkurve.

Im Einzelnen erwartet die Funktion folgende Argumente:

y_Werte: Hier geben Sie die vorliegenden y-Koordinaten, also die abhängigen Werte, an. y_Werte kann
entweder ein Zellbezug oder eine Matrix sein. Es sind nur positive Werte zulässig; andernfalls liefert die
Funktion den Fehlerwert #ZAHL.

x_Werte: Hier können optional die x-Koordinaten, also die unabhängigen Werte angegeben werden. Auch
x_Werte kann entweder ein Zellbezug oder eine Matrix sein. Wird x_Werte nicht angegeben, verwendet
die Funktion automatisch die Werte 1, 2, 3, ... (entsprechend der Anzahl der vorliegenden y_Werte).

Neue_x_Werte: Wird dieses Argument nicht angegeben, liefert die Ergebnismatrix dieser Funktion die y-
Koordinaten der Regressionsgeraden entsprechend den in x_Werte angegebenen x-Koordinaten. Bei Bedarf
können Sie mit Neue_x_Werte jedoch andere x-Koordinaten angeben. Auch Neue_x_Werte kann entweder
ein Zellbezug oder eine Matrix sein. 

Konstante: Mit dem optionalen Argument Konstante können Sie festlegen, ob die Konstante b auf Eins
gesetzt werden soll:

WAHR oder nicht angegeben: b wird aus den vorliegenden Daten automatisch berechnet.

FALSCH: b wird fest auf Eins gesetzt und die Kurve durch Anpassen des Koeffizienten m entsprechend
"hingebogen".

Hinweis:

Diese Formel muss als Matrixformel eingegeben werden. Informationen dazu finden Sie im Abschnitt Ar-
beiten mit Matrizen.

Siehe auch:

RGP, RKP, TREND

VARIATIONEN (Variationen)

Syntax:

VARIATIONEN(n; k)

Beschreibung:

Ermittelt die Anzahl der geordneten Stichproben vom Umfang k, die man einer Gesamtheit von n verschie-
denen Elementen ohne Zurücklegen entnehmen kann.

n gibt an, aus wie vielen Elementen die Gesamtheit besteht. n muss größer als k sein.

k gibt an, wie viele Elemente in einer Stichprobe gezogen werden sollen. k muss größer als 0 und kleiner als
n sein.
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n und k sollten natürlich ganze Zahlen sein. Ist das nicht der Fall, kürzt PlanMaker die Nachkommastellen
automatisch weg.

Anmerkung:

VARIATIONEN unterscheidet sich von KOMBINATIONEN wie folgt: Bei den Variationen darf die Rei-
henfolge der gezogenen Elemente nachträglich nicht mehr verändert werden, bei den Kombinationen spielt
sie keine Rolle 

Mit VARIATIONEN können Sie also zum Beispiel berechnen, wie viele Möglichkeiten es für die ersten 3
Plätze eines Wettlaufs mit 10 Teilnehmern gibt. Mit KOMBINATIONEN können Sie hingegen ermitteln,
wie viele Möglichkeiten es beim Ziehen von 6 Kugeln aus 49 gibt.

Der Unterschied: Während sich die Reihenfolge der gezogen Lottozahlen nach Belieben ändern lässt (sie
könnten diese also zum Beispiel nachträglich aufsteigend sortieren), würden die Läufer natürlich protestie-
ren, wenn Sie die Plätze 1-3 nun plötzlich nach den Anfangsbuchstaben der Nachnamen umsortieren wür-
den. 

Bei den Variationen spielt also die Anordnung eine Rolle; bei den Kombinationen hingegen nicht.

Beispiel:

Greifen wir gleich das Beispiel mit den Läufern auf. Sie möchten wissen, wie viele Variationen es für die
ersten 3 Plätze eines Wettlaufs mit 10 Läufern gibt. Die Formel hierfür lautet:

VARIATIONEN(10; 3)

Ergebnis: Es gibt 720 Variationsmöglichkeiten.

Siehe auch:

KOMBINATIONEN

VAR.P (Varianz einer Grundgesamtheit)

Syntax:

VAR.P(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert die Varianz einer vollständigen Grundgesamtheit.

Zahl1; Zahl2 etc. sind die zu untersuchenden Zahlenwerte. Es müssen alle Werte der Grundgesamtheit an-
gegeben werden. Falls nur eine Stichprobe aus der Grundgesamtheit vorliegt, ist statt VARIANZEN die
Funktion VAR.S/VARIANZ zu verwenden Diese liefert einen Schätzwert für die Varianz

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.
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Anmerkung:

Die Varianz wird nach der Methode "n" berechnet.

Beispiel:

VAR.P(2; 2; 3; 4; 1) ergibt 1,04

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

VARIANZEN, VAR.S/VARIANZ, STABW.S/STABW, STABW.N/STABWN 

VAR.S (Varianz einer Stichprobe)

Syntax:

VAR.S(Zahl1; Zahl2 [; Zahl3 ...])

Beschreibung:

Liefert einen Schätzwert für die Varianz einer Grundgesamtheit anhand einer Stichprobe.

Zahl1; Zahl2 etc. sind die zu untersuchenden Werte (Stichprobe). 

Bezieht sich diese Funktion auf leere Zellen oder Zellen, die Zeichenketten oder Wahrheitswerte enthalten,
so werden diese ignoriert.

Anmerkung:

Die Varianz wird nach der Methode "Erwartungstreue Schätzung" oder "n-1" berechnet.

Beispiel:

VAR.S(2; 2; 3; 4; 1) ergibt 1,3

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.
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Siehe auch:

VARIANZ, VARIANZA, VAR.P/VARIANZEN, VARIANZENA, STABW.S/STABW,
STABW.N/STABWN

VERGLEICH (Position eines Werts in einem Bereich)

Syntax:

VERGLEICH(Suchkriterium; Suchvektor [; Modus])

Beschreibung:

Durchsucht einen Vektor (also einen eindimensionalen Zellbereich) nach einem Suchkriterium und liefert
dann dessen Position innerhalb dieses Zellbereichs. Ist das Suchkriterium also das fünfte Element des Such-
vektors, liefert die Funktion das Ergebnis 5.

Suchkriterium ist der gesuchte Wert. Zulässig sind alle Werte von Werten oder ein Zellbezug.

Suchvektor ist der zu durchsuchende Zellbereich. Dieser kann entweder Zeichenketten, Zahlen oder Wahr-
heitswerte enthalten. Es muss sich dabei um einen Vektor handeln (also um einen Bereich mit entweder nur
einer Zeile oder einer Spalte).

Modus gibt an, welche Art von Suche durchgeführt werden soll:

1 oder nicht angegeben: Es wird der größte Wert gesucht, der kleiner oder gleich Suchkriterium ist. Wich-
tig: Die Elemente im Suchvektor müssen bei diesem Modus aufsteigend sortiert sein. Andernfalls liefert die
Funktion möglicherweise falsche Ergebnisse. 

0: Es wird der Wert gesucht, der dem Suchkriterium genau entspricht. Die Elemente im Suchvektor brau-
chen bei diesem Modus nicht sortiert zu sein. 

-1: Es wird der kleinste Wert gesucht, der größer oder gleich Suchkriterium ist. Wichtig: Die Elemente im
Suchvektor müssen bei diesem Modus absteigend sortiert sein. Andernfalls liefert die Funktion möglicher-
weise falsche Ergebnisse. 

Tipp: Wenn Sie Modus 0 verwenden und nach einer Zeichenkette suchen, darf das Suchkriterium darf auch
Platzhalter enthalten: ein Fragezeichen (?) steht für ein beliebiges Zeichen, ein Sternchen (*) für beliebig
viele Zeichen.

Beispiel:

VERGLEICH("b"; {"a";"b";"c";"d"}; 0) ergibt 2. "b" ist also das zweite Element des durchsuchten Vektors.

Siehe auch:

INDEX, VERWEIS, SVERWEIS, WVERWEIS
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VERKETTEN (Zeichenketten verbinden)

Syntax:

VERKETTEN(Zeichenkette1 [; Zeichenkette2; Zeichenkette3 ...])

Beschreibung:

Verbindet zwei oder mehr Zeichenketten zu einer einzigen Zeichenkette.

Anmerkung:

Der Operator & macht exakt das gleiche. VERKETTEN("Text1"; "Text2") entspricht also "Text1" &
"Text2".

Beispiel:

VERKETTEN("Guten "; "Morgen") ergibt Guten Morgen

VERKETTEN(2; " Stück"; " Zucker") ergibt 2 Stück Zucker

VERWEIS (Zellbereich durchsuchen)

Vorbemerkung:

Die Funktion VERWEIS durchsucht einen Zellbereich nach einem Suchkriterium (also z.B. nach einer Zahl
oder einer Zeichenkette) und liefert dann den Inhalt einer anderen Zelle mit entsprechender Position. 

Die zu durchsuchenden Daten müssen dabei in sortierter Reihenfolge vorliegen. Tipp: Es gibt zwei Alterna-
tiven zu dieser Funktion, die auch mit unsortierten Daten zurechtkommen und zudem etwas flexibler sind:
SVERWEIS und WVERWEIS

Die Funktion VERWEIS kann auf zwei verschiedene Arten eingesetzt werden:

Variante mit zwei eindimensionalen Bereichen: Hier werden der Funktion zwei Vektoren (also eindimen-
sionale Bereiche) übergeben: Suchvektor und Ergebnisvektor. Findet die Funktion das Suchkriterium im
Suchvektor, liefert sie als Ergebnis die Zelle mit der gleichen Position im Ergebnisvektor.

Variante mit einem zweidimensionalen Bereich: Hier wird der Funktion ein zweidimensionaler Bereich
übergeben. Findet sie das Suchkriterium in der ersten Zeile (beziehungsweise Spalte) dieses Bereichs, lie-
fert sie als Ergebnis die Zelle mit der gleichen Position in der letzten Zeile (beziehungsweise Spalte) dieses
Bereichs.
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Variante mit zwei eindimensionalen Bereichen

Syntax:

VERWEIS(Suchkriterium; Suchvektor; Ergebnisvektor)

Beschreibung:

Diese Variante der Funktion VERWEIS durchsucht den Zellbereich Suchvektor nach dem Suchkriterium.
Wird es gefunden, liefert sie den Inhalt der Zelle, die sich in der gleichen Zeile/Spalte im Zellbereich Er-
gebnisvektor befindet.

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rolle.

Suchvektor ist der zu durchsuchende Zellbereich. Dieser kann Zeichenketten, Zahlen oder Wahrheitswerte
enthalten. Es muss sich dabei allerdings um einen Vektor (also einen eindimensionalen Bereich) handeln,
was bedeutet, dass Suchvektor entweder nur eine Zeile oder nur eine Spalte umfassen darf.

Wichtig: Die Werte in Suchvektor müssen aufsteigend sortiert sein. Andernfalls liefert diese Funktion
möglicherweise falsche Ergebnisse. Falls die Werte nicht sortiert sind, können Sie alternativ die Funktionen
SVERWEIS oder WVERWEIS verwenden

Ergebnisvektor ist der Zellbereich, aus dem das Ergebnis der Funktion geliefert werden soll. Auch dieser
Bereich muss ein Vektor sein. Außerdem muss seine Größe und seine Ausrichtung (horizontal oder vertikal)
der von Ergebnisvektor entsprechen.

Hinweis:

Wenn VERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden Wert findet, wird automatisch
der nächstkleinere Wert genommen.

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhandene Wert ist, liefert die
Funktion den Fehlerwert #NV.

Beispiel:

Bei folgender Tabelle ...

... liefert VERWEIS folgende Ergebnisse:

VERWEIS(1; A1:A3; B1:B3) ergibt Ergebnis_1

VERWEIS(2; A1:A3; B1:B3) ergibt Ergebnis_2

VERWEIS(3; A1:A3; B1:B3) ergibt Ergebnis_3

VERWEIS(2,5; A1:A3; B1:B3) ergibt Ergebnis_2 (da hier der nächstkleinere Wert genommen wird)
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VERWEIS(10; A1:A3; B1:B3) ergibt Ergebnis_3 (aus dem gleichen Grund)

VERWEIS(0; A1:A3; B1:B3) ergibt #NV

Siehe auch:

SVERWEIS, WVERWEIS, INDEX, VERGLEICH

Variante mit einem zweidimensionalen Bereich

Syntax:

VERWEIS(Suchkriterium; Bereich)

Beschreibung:

Diese Variante der Funktion VERWEIS durchsucht die erste Spalte von Bereich nach dem Suchkriterium.
Wird es gefunden, liefert sie den Inhalt der Zelle, die sich in der gleichen Zeile der letzten Spalte von Be-
reich befindet.

Alternativ kann diese Funktion den Bereich auch spaltenweise durchsuchen. Die Suchrichtung wird nämlich
durch die Dimensionen von Bereich bestimmt: 

Umfasst Bereich mehr Spalten als Zeilen, durchsucht die Funktion die erste Zeile und liefert den Wert aus
der letzten Zeile. 

Umfasst Bereich mehr Zeilen als Spalten oder ist quadratisch, durchsucht die Funktion die erste Spalte und
liefert den Wert aus der letzten Spalte. 

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rolle.

Bereich ist der zu durchsuchende Bereich. Er muss in der ersten Zeile (beziehungsweise Spalte) die zu
durchsuchenden Werte und in der letzten Zeile (beziehungsweise Spalte) die zu liefernden Ergebnisse ent-
halten. Es kann sich dabei um Zeichenketten, Zahlen oder Wahrheitswerte handeln. Der Bereich muss zwei-
dimensional sein, also mindestens zwei Zeilen und zwei Spalten umfassen.

Wichtig: Die Werte in der ersten Zeile (beziehungsweise Spalte) müssen aufsteigend sortiert sein. Andern-
falls liefert diese Funktion möglicherweise falsche Ergebnisse. Falls die Werte nicht sortiert sind, können
Sie alternativ die Funktionen SVERWEIS oder WVERWEIS verwenden

Hinweis:

Wenn VERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden Wert findet, wird automatisch
der nächstkleinere Wert genommen.

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhandene Wert ist, liefert die
Funktion den Fehlerwert #NV.

Beispiel:

Bei folgender Tabelle ...
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... liefert VERWEIS folgende Ergebnisse:

VERWEIS(1; A1:B3) ergibt Ergebnis_1

VERWEIS(2; A1:B3) ergibt Ergebnis_2

VERWEIS(3; A1:B3) ergibt Ergebnis_3

VERWEIS(2,5; A1:B3) ergibt Ergebnis_2 (da hier der nächstkleinere Wert genommen wird)

VERWEIS(10; A1:B3) ergibt Ergebnis_3 (aus dem gleichen Grund)

VERWEIS(0; A1:B3) ergibt #NV

Siehe auch:

SVERWEIS, WVERWEIS, INDEX, VERGLEICH

VORZEICHEN (Vorzeichen einer Zahl)

Syntax:

VORZEICHEN(Zahl)

Beschreibung:

Diese Funktion liefert das Vorzeichen einer Zahl. Sie kann folgende Werte annehmen:

1, wenn die übergebene Zahl positiv ist

-1, wenn die Zahl negativ ist

0, wenn die Zahl Null ist

Beispiel:

VORZEICHEN(-5) ergibt -1

Siehe auch:

ABS, NEG
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VRUNDEN (Runden auf ein Vielfaches von n)

Syntax:

VRUNDEN(Zahl; Basis)

Beschreibung:

Rundet Zahl auf ein Vielfaches von Basis.

Basis muss größer als Null sein.

Ist der Rest der Division von Zahl durch Basis kleiner als die Hälfte von Basis, wird abgerundet. Ist er grö-
ßer oder gleich der Hälfte von Basis, wird aufgerundet (siehe Beispiele).

Beispiel:

VRUNDEN(1234,5678; 1) ergibt 1235

VRUNDEN(1234,5678; 0,01) ergibt 1234,57

VRUNDEN(22; 5) ergibt 20

VRUNDEN(23; 5) ergibt 25

VRUNDEN(22,5; 5) ergibt 25

Siehe auch:

UNTERGRENZE, OBERGRENZE, ABRUNDEN, AUFRUNDEN, RUNDEN, KÜRZEN, GANZZAHL

WAHL (Auswahl aus einer Liste)

Syntax:

WAHL(Index; Wert1 [; Wert2; Wert3 ...])

Beschreibung:

Diese Funktion wählt mit Hilfe von Index einen Wert aus der Liste der Argumente aus.

Index gibt die Position in der Liste der Argumente an. Ist Index 1, wird das erste Element zurückgeliefert,
ist Index 2, das zweite Element etc.

Wenn Index kleiner als 1 oder größer als die Anzahl der Listeneinträge ist, liefert die Funktion den Fehler-
wert #WERT! zurück.
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Beispiel:

WAHL(2; "Eins"; "Zwei"; "Drei") ergibt Zwei

Siehe auch:

INDEX, SVERWEIS, WVERWEIS

WAHR (Wahrheitswert)

Syntax:

WAHR()

Beschreibung:

Liefert den Wahrheitswert WAHR. 

Siehe auch:

FALSCH

WAHRSCHBEREICH (Wahrscheinlichkeit)

Syntax:

WAHRSCHBEREICH(Werte; Wahrscheinlichkeiten; k1 [; k2])

Beschreibung:

Liefert die Wahrscheinlichkeit für ein Intervall von Werten, deren Einzelwahrscheinlichkeiten jeweils ange-
geben sind.

Einfacher ausgedrückt: Diese Funktion summiert die jeweiligen Wahrscheinlichkeiten der Werte in die-
sem Intervall.

Werte sind die zu untersuchenden Werte.

Wahrscheinlichkeiten sind die dazugehörigen Einzelwahrscheinlichkeiten.

Alle Wahrscheinlichkeiten müssen größer gleich 0 (0%) und kleiner gleich 1 (100%) sein. Die Summe der
Einzelwahrscheinlichkeiten muss 1 ergeben.

Sind mehr oder weniger Werte als Wahrscheinlichkeiten angegeben, liefert die Funktion den Fehler #NV.
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k1 und k2 bestimmen das Intervall von Werten, deren gemeinsame Wahrscheinlichkeit ermittelt werden sol-
len. Wenn k2 nicht angegeben ist, wird nur die Wahrscheinlichkeit des Wertes k1 ermittelt.

Beispiel:

In den Zellen A1 bis A3 sind die Werte 1, 2, 3 eingetragen, in den Zellen B1 bis B3 die dazugehörigen
Wahrscheinlichkeiten: 17%, 33%, 50%.

Wie groß ist die Wahrscheinlichkeit, dass ein Wert zwischen 2 und 3 liegt?

WAHRSCHBEREICH(A1:A3; B1:B3; 2; 3) ergibt 33% + 50% = 83%

WÄHRUNG (Zahl als Währung formatieren)

Syntax:

WÄHRUNG(Zahl [; n])

Beschreibung:

Konvertiert eine Zahl in eine Zeichenkette. Diese enthält die auf n Stellen gerundete und als Währung for-
matierte Zahl.

PlanMaker ermittelt die anzuzeigende Währung aus den Ländereinstellungen Ihres Betriebssystems. Bei
Anwendern in Deutschland und Österreich wird der Betrag also in Euro angezeigt, bei Schweizern in sFr
etc.

Zahl ist die umzuwandelnde Zahl.

Das optionale Argument n bestimmt gewünschte Anzahl an Nachkommastellen. Wird es nicht angegeben,
wird die Zahl auf 2 Nachkommastellen gerundet.

n darf auch ein negativer Wert sein, worauf der ganzzahlige Teil der Zahl gerundet wird: Ist n beispielswei-
se -2, wird die Zahl auf ein Vielfaches von Hundert gerundet (siehe letztes Beispiel).

Hinweis:

Beachten Sie, dass das Ergebnis dieser Funktion eine Zeichenkette ist. Um eine Zahl zu runden, ohne sie in
eine Zeichenkette zu wandeln, verwenden Sie eine der Rundungsfunktionen wie zum Beispiel RUNDEN 

Um eine Zahl nur gerundet und als Währung formatiert anzuzeigen, können Sie auch über den Menübefehl
Format > Zelle ihr Zahlenformat ändern.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Beispiel:

WÄHRUNG(123,456) ergibt die Zeichenkette € 123,46
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WÄHRUNG(123,456; 2) ergibt die Zeichenkette € 123,46

WÄHRUNG(123,456; -2) ergibt die Zeichenkette € 100

WECHSELN (Text in Zeichenkette ersetzen)

Syntax:

WECHSELN(Zeichenkette; Suchtext; Ersatztext [; n])

Beschreibung:

Ersetzt den Suchtext in einer Zeichenkette durch den Ersatztext.

Zeichenkette ist die ursprüngliche Zeichenkette.

Suchtext ist der zu ersetzende Text. Hierbei ist die Groß-/Kleinschreibung zu beachten.

Ersatztext ist neue Text.

Das optionale Argument n bestimmt, das wievielte Vorkommen des Suchbegriffs ersetzt werden soll. Wird
n nicht angegeben, werden alle Vorkommen ersetzt.

Beispiel:

WECHSELN("aabbaabb"; "aa"; "xx") ergibt xxbbxxbb

WECHSELN("aabbaabb"; "aa"; "xx"; 2) ergibt aabbxxbb

WECHSELN("aabbaabb"; "AA"; "xx") ergibt aabbaabb

Siehe auch:

FINDEN, SUCHEN, ERSETZEN, WIEDERHOLEN

WEIBULL (Weibull-Verteilung)

Hinweis: WEIBULL wird durch die neue identische Funktion WEIBULL.VERT ergänzt, die in neueren
Versionen von Microsoft Excel (ab 2010) verwendet wird.

Syntax:

WEIBULL(x; Alpha; Beta; Kumuliert)
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Beschreibung:

Liefert Wahrscheinlichkeiten einer Weibull-verteilten Zufallsvariablen.

Die Weibull-Verteilung ist eine Erweiterung der Exponentialverteilung (siehe Funktion
EXPON.VERT/EXPONVERT) auf Ereignisse, die nicht rein zufällig sind und nicht exakt der Poisson-Ver-
teilung (siehe Funktion POISSON.VERT/POISSON) genügen.

Sie wird besonders bei Zuverlässigkeitsbetrachtungen eingesetzt.

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer oder gleich Null sein.

Alpha ist ein Parameter der Verteilung. Alpha bestimmt die Form der Verteilungskurve. Bei Alpha=1 ent-
spricht die Weibull-Verteilung einer Exponentialverteilung mit Lambda = 1/Beta.

Beta ist ein weiterer Parameter der Verteilung. Beta bestimmt die Skalierung der Verteilungskurve, streckt
beziehungsweise staucht den Funktionsgraphen also.

Beide Parameter müssen größer als Null sein.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

Beispiel:

WEIBULL(42; 2; 100; WAHR) ergibt 0,16172

WEIBULL(42; 2; 100; FALSCH) ergibt 0,00704

Siehe auch:

WEIBULL.VERT, EXPON.VERT/EXPONVERT, POISSON.VERT/POISSON 

WEIBULL.VERT (Weibull-Verteilung)

Syntax:

WEIBULL.VERT(x; Alpha; Beta; Kumuliert)

Beschreibung:

Liefert Wahrscheinlichkeiten einer Weibull-verteilten Zufallsvariablen.

Die Weibull-Verteilung ist eine Erweiterung der Exponentialverteilung (siehe Funktion
EXPON.VERT/EXPONVERT) auf Ereignisse, die nicht rein zufällig sind und nicht exakt der Poisson-Ver-
teilung (siehe Funktion POISSON.VERT/POISSON) genügen

Sie wird besonders bei Zuverlässigkeitsbetrachtungen eingesetzt.

x ist der Wert, dessen Wahrscheinlichkeit berechnet werden soll. x muss größer oder gleich Null sein.
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Alpha ist ein Parameter der Verteilung. Alpha bestimmt die Form der Verteilungskurve. Bei Alpha=1 ent-
spricht die Weibull-Verteilung einer Exponentialverteilung mit Lambda = 1/Beta.

Beta ist ein weiterer Parameter der Verteilung. Beta bestimmt die Skalierung der Verteilungskurve, streckt
beziehungsweise staucht den Funktionsgraphen also.

Beide Parameter müssen größer als Null sein.

Mit dem Wahrheitswert Kumuliert bestimmen Sie, welche Funktion geliefert werden soll:

FALSCH: Es wird die Dichtefunktion geliefert.

WAHR: Es wird die kumulierte Verteilungsfunktion geliefert.

Beispiel:

WEIBULL.VERT(42; 2; 100; WAHR) ergibt 0,16172

WEIBULL.VERT(42; 2; 100; FALSCH) ergibt 0,00704

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2010. In älteren Versionen ist die Funktion unbe-
kannt.

Siehe auch:

WEIBULL, EXPON.VERT/EXPONVERT, POISSON.VERT/POISSON

WENN (Wenn-Dann-Sonst-Bedingung)

Syntax:

WENN(Bedingung; WennWahr [; WennFalsch])

Beschreibung:

Diese Funktion liefert den Wert WennWahr, wenn Bedingung wahr ist, ansonsten den Wert WennFalsch
(sofern angegeben).

Bedingung kann ein beliebiger Ausdruck sein, der WAHR oder FALSCH zurückliefert.

WennWahr und WennFalsch können beliebige Werte oder Ausdrücke (also auch Formeln) sein.

Beispiel:

Die Formel WENN(A1<5; "Nachbestellen!"; "Bestand ok") liefert die Zeichenkette "Nachbestellen!", wenn
A1<5 ist. Ist dies nicht der Fall (A1 ist also ³ 5), liefert sie die Zeichenkette "Bestand ok".
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Siehe auch:

AUSWAHL, WENNFEHLER

WENNFEHLER (liefert definierten Wert bei Fehler)

Syntax:

WENNFEHLER(Wert; WertWennFehler)

Beschreibung:

Gibt normalerweise den übergebenen Wert zurück. Liefert dieser Wert jedoch einen (beliebigen) Fehler-
wert, wird stattdessen der definierte WertWennFehler zurückgegeben.

Kompatibilitätshinweise:

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 2003 und früher. Wenn Sie
ein Dokument in diesem Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch
ihr aktuelles Ergebnis als fester Wert ersetzt. 

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht im Dateiformat "Microsoft
Excel 97-2003 (.xls)" speichern, sondern eines der folgenden Formate verwenden:

¡ "PlanMaker-Dokument (.pmdx oder .pmd)" 

¡ oder: "Microsoft Excel 2007-2016 (.xlsx)"

Beispiel:

WENNFEHLER(A1; "Fehler!") liefert den Inhalt der Zelle A1, solange diese keinen Fehlerwert enthält. Be-
findet sich in dieser Zelle jedoch ein Fehlerwert, wird stattdessen der Text "Fehler!" geliefert.

Siehe auch:

ISTFEHL, ISTFEHLER, ISTNV, FEHLERTYP, Abschnitt über Fehlerwerte

WERT (Zeichenkette in Zahl umwandeln)

Syntax:

WERT(Zeichenkette)
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Beschreibung:

Wandelt eine Zeichenkette in eine Zahl um (sofern diese aus einer gültigen Zahl besteht).

Hinweis:

Diese Funktion ist nur aus Gründen der Kompatibilität mit älteren Tabellenkalkulationen noch vorhanden.
PlanMaker selbst benötigt sie nicht mehr, da er Zeichenketten bei Bedarf automatisch in Zahlen umwandelt.

Beispiel:

WERT("42") ergibt 42

WERT("42 DM") ergibt 42, denn "DM" ist eine Währungseinheit.

WERT("42 Bolzen") ergibt hingegen den Fehlerwert #WERT!.

WERT("WAHR") ergibt 1

WERT("25.09.2014") ergibt 41907, die serielle Datumszahl für das Datum 25.09.2014

Siehe auch:

TEXT, T, N

WIEDERHOLEN (Zeichenkette n mal wiederholen)

Syntax:

WIEDERHOLEN(Zeichenkette; n)

Beschreibung:

Wiederholt die übergebene Zeichenkette n mal.

Über das Argument n bestimmen Sie die Anzahl der Wiederholungen. n sollte eine ganze Zahl sein. Ist dies
nicht der Fall, schneidet PlanMaker die Nachkommastellen automatisch ab.

Beispiel:

WIEDERHOLEN("Text"; 3) ergibt TextTextText

Siehe auch:

ERSETZEN, WECHSELN
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WOCHENTAG (Wochentag aus Datum ermitteln)

Syntax:

WOCHENTAG(Datum [; Modus])

Beschreibung:

Liefert den Wochentag eines Datums in Form einer Zahl von 1 bis 7 beziehungsweise 0 bis 6.

Über das optionale Argument Modus können Sie festlegen, welche Ergebnisse diese Funktion liefern soll:

Ist Modus 1 oder nicht angegeben, liefert die Funktion Werte von 1 (=Sonntag) bis 7 (=Samstag).

Ist Modus 2, liefert die Funktion Werte von 1 (=Montag) bis 7 (=Sonntag).

Ist Modus 3, liefert die Funktion Werte von 0 (=Montag) bis 6 (=Sonntag).

Beispiel:

WOCHENTAG("25.9.1966") ergibt 1 (also Sonntag)

WOCHENTAG("25.9.1966"; 2) ergibt 7 (also Sonntag)

Siehe auch:

ISOKALENDERWOCHE, ISOWOCHE, KALENDERWOCHE, JAHR, MONAT, TAG

WURZEL (Quadratwurzel)

Syntax:

WURZEL(Zahl)

Beschreibung:

Liefert die Quadratwurzel einer Zahl. 

Die übergebene Zahl muss größer gleich Null sein.

Beispiel:

WURZEL(25) ergibt 5

WURZEL(-25) ergibt den Fehlerwert #ZAHL!
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Siehe auch:

WURZELN, POTENZ

WURZELN (Wurzel)

Syntax:

WURZELN(Zahl [; n])

Beschreibung:

Zieht die n-te Wurzel aus einer Zahl. Wird n nicht angegeben, liefert die Funktion die Quadratwurzel
(n=2). 

n sollte eine ganze Zahl sein. Ist dies nicht der Fall, schneidet PlanMaker die Nachkommastellen automa-
tisch ab.

Wenn n gerade ist, muss Zahl positiv sein.

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Tipp: Alternativ können Sie die n-te Wurzel auch mit folgender Excel-kompatibler Funktion berechnen: 

WURZELN(Zahl; n) entspricht POTENZ(Zahl; 1/n)

Beispiel:

WURZELN(25) ergibt 5

WURZELN(-25) ergibt den Fehlerwert #ZAHL!

WURZELN(125; 3) ergibt 5

WURZELN(-125; 3) ergibt -5

Siehe auch:

WURZEL, POTENZ
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WURZELPI (Quadratwurzel von x*Pi)

Syntax:

WURZELPI(Zahl)

Beschreibung:

Liefert die Quadratwurzel einer mit der Kreiszahl Pi multiplizierten Zahl.

Die übergebene Zahl muss größer gleich Null sein.

Beispiel:

WURZELPI(42) entspricht WURZEL(42*PI()), ergibt also 11,48681381

Siehe auch: 

PI, WURZEL, WURZELN

WVERWEIS (Zellbereich zeilenweise durchsuchen)

Syntax:

WVERWEIS(Suchkriterium; Bereich; n [; Sortiert])

Beschreibung:

Sucht in der ersten Zeile von Bereich nach dem ersten Vorkommen von Suchkriterium. Wird es gefunden,
liefert die Funktion den Inhalt der Zelle, die sich in der gleichen Spalte und der n-ten Zeile von Bereich be-
findet.

Anmerkung: WVERWEIS arbeitet nur in waagerechter Suchrichtung. Um senkrecht zu suchen, nutzen Sie
stattdessen SVERWEIS.

Suchkriterium ist der gesuchte Wert. Die Groß-/Kleinschreibung spielt keine Rolle.

Bereich ist der zu durchsuchende Zellbereich. Die erste Zeile muss die zu durchsuchenden Werte enthalten.
Dies können Zeichenketten, Zahlen oder Wahrheitswerte sein.

Für n ist anzugeben, aus der wievielten Zeile von Bereich ein Wert zurückgeliefert werden soll, wenn das
Suchkriterium gefunden wird.

Ist n kleiner als 1, wird der Fehlerwert #WERT! zurückgeliefert. Ist n größer als die Zeilenzahl von Be-
reich, wird der Fehlerwert #BEZUG! zurückgeliefert. 

Sortiert ist ein Wahrheitswert, mit dem Sie angeben, ob die Werte in der ersten Zeile von Bereich sortiert
sind:
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Ist Sortiert WAHR oder nicht angegeben, müssen die Werte in der ersten Zeile von Bereich aufsteigend
sortiert sein.

Ist Sortiert FALSCH, spielt die Reihenfolge der Werte in der ersten Zeile keine Rolle.

Wichtig: Wenn Sie Sortiert also nicht explizit auf FALSCH setzen, müssen diese Werte in sortierter Rei-
henfolge vorliegen!

Hinweis:

Wenn WVERWEIS keinen exakt mit dem Suchkriterium übereinstimmenden Wert findet, wird automa-
tisch der nächstkleinere Wert genommen. 

Existiert kein kleinerer Wert, weil Suchkriterium kleiner als der kleinste vorhandene Wert ist, liefert die
Funktion den Fehlerwert #NV.

Beispiel:

Sie verkaufen Blumen zu unterschiedlichen Stückpreisen – je nachdem, wie viele Pflanzen der Kunde ab-
nimmt. Dazu haben Sie eine Tabelle mit einer Rabattstaffel erstellt:

Jetzt können Sie die Funktion WVERWEIS einsetzen, um abhängig von der Stückzahl den Preis für eine be-
stimmte Blumensorte zu ermitteln.

Verwenden Sie dazu folgende Argumente:

Als Suchkriterium geben Sie den Namen der Blumensorte an (also "Rosen", "Nelken" oder "Tulpen").

Als Bereich geben Sie die den Zellbereich an, der in der ersten Zeile die Namen der Blumensorten und dar-
unter die Preise enthält – hier also B1:D4.

Für n geben Sie die Stückzahl plus Eins an, denn die erste Zeile (n=1) enthält ja keine Preise, sondern die
Namen der Pflanzen.

Beispiele:

WVERWEIS("Rosen"; B1:D4; 2; FALSCH) liefert den Preis für eine Rose, also € 5,50.

WVERWEIS("Rosen"; B1:D4; 4; FALSCH) liefert den Preis für drei Rosen, also € 4,95.

WVERWEIS("Nelken"; B1:D4; 4; FALSCH) liefert den Preis für drei Nelken, also € 4,50.

WVERWEIS("Nelken"; B1:D4; 5; FALSCH) liefert den Fehlerwert #BEZUG, da n größer als die Zeilen-
zahl von Bereich ist.

WVERWEIS("Petunien"; B1:D4; 4; FALSCH) liefert den Fehlerwert #NV, da "Petunien" in der ersten Zei-
le von Bereich nicht vorkommt.
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Siehe auch:

SVERWEIS, VERWEIS, INDEX, VERGLEICH, WAHR

XINTZINSFUSS (Interner Zinsfuß)

Syntax:

XINTZINSFUSS(Werte; Daten [; Schätzwert])

Beschreibung:

Liefert einen Schätzwert für den internen Zinsfuß einer Investition mit nicht periodisch anfallenden Zahlun-
gen.

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Werte) und Einzahlungen
(positive Werte). Die Zahlungen dürfen zu beliebigen Zeitpunkten erfolgen. Das Datum für jede Zahlung ist
jeweils im Bereich Daten anzugeben.

Die Funktion erwartet folgende Argumente:

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wurden. Es muss mindestens ei-
ne Auszahlung und eine Einzahlung vorliegen.

Für Daten gibt man einen Zellbezug an, in dem die Datumsangaben für jede im Bereich Werte eingetragene
Zahlung angegeben ist.

Für Schätzwert können Sie (optional) einen Schätzwert für das Ergebnis der Berechnung angeben (siehe
Hinweis).

Hinweis:

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). Falls die Funktion nach
20 Näherungsschritten noch kein Ergebnis mit einer Genauigkeit von 0,00001% oder besser findet, bricht
sie die Näherung ab und liefert als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen
anderen Wert für Schätzwert anzugeben.

Siehe auch:

IKV, NBW, QIKV, XKAPITALWERT, ZINS

XKAPITALWERT (Nettobarwert)

Syntax:

XKAPITALWERT(Zins; Werte; Daten)
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Beschreibung:

Liefert den Kapitalwert (Nettobarwert) einer Investition mit nicht periodisch anfallenden Zahlungen.

Als Basis dienen die im Bereich Werte angegebenen Auszahlungen (negative Werte) und Einzahlungen
(positive Werte). Die Zahlungen dürfen zu beliebigen Zeitpunkten erfolgen. Das Datum für jede Zahlung ist
jeweils im Bereich Daten anzugeben.

Die Funktion erwartet folgende Argumente:

Zins ist der Kapitalzinsfuß für die Zahlungen.

Für Werte gibt man einen Zellbezug an, in dem die Zahlungen eingetragen wurden. Es muss mindestens ei-
ne Auszahlung und eine Einzahlung vorliegen.

Für Daten gibt man einen Zellbezug an, in dem die Datumsangaben für jede im Bereich Werte eingetragene
Zahlung angegeben ist.

Siehe auch:

NBW, XINTZINSFUSS

XODER (Logisches EXKLUSIV ODER)

Syntax:

XODER(Wahrheitswert1 [; Wahrheitswert2; Wahrheitswert3 ...])

Beschreibung:

Die Funktion XODER ("Exklusiv Oder") liefert WAHR, wenn eine ungerade Anzahl der ihr übergebenen
Wahrheitswerte WAHR ist, ansonsten liefert sie FALSCH.

Häufig wird diese Funktion mit nur zwei Argumenten verwendet. Hier gilt entsprechend: Wenn entweder
das eine oder das andere Argument WAHR ist, liefert sie WAHR. Sind hingegen beide WAHR oder beide
FALSCH, liefert sie FALSCH.

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

Beispiel:

XODER(WAHR; WAHR) ergibt FALSCH

XODER(WAHR; FALSCH) ergibt WAHR

XODER(FALSCH; WAHR) ergibt WAHR

XODER(FALSCH; FALSCH) ergibt FALSCH
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Siehe auch:

ODER, UND, NICHT

ZÄHLENWENN (Zählen ausgewählter Werte)

Syntax:

ZÄHLENWENN(Suchbereich; Suchkriterium)

Beschreibung:

Ermittelt, wie viele Werte in einem Bereich der angegebenen Bedingung entsprechen.

Suchbereich ist der zu durchsuchende Bereich.

Suchkriterium ist die zu erfüllende Bedingung:

Hier können Sie einerseits einen einfachen Wert angeben (zum Beispiel "42" oder "Schrauben"). In diesem
Fall werden alle Posten gezählt, die diesem Wert entsprechen. 

Tipp: Um alle nicht-leeren Zellen zu zählen, geben Sie als Kriterium "*" an. ZÄHLENWENN(D2:D4; "*")
zählt beispielsweise alle Zellen im angegebenen Bereich, die nicht leer sind.

Weiterhin ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier werden alle Posten gezählt, die die-
ser Bedingung entsprechen.

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") umgeben werden.

Beispiel:

In den Zellen A1 bis A5 stehen die Werte 1; 2; 3; 2; 1. Hier gilt:

ZÄHLENWENN(A1:A5; "2") ergibt 2

ZÄHLENWENN(A1:A5; ">=2") ergibt 3

Siehe auch:

ANZAHL, MITTELWERTWENN, MITTELWERTWENNS, SUMMEWENN, SUMMEWENNS,
ZÄHLENWENNS

ZÄHLENWENNS (Zählen ausgewählter Werte)

Syntax:

ZÄHLENWENNS(Suchbereich1; Suchkriterium1 [; Suchbereich2; Suchkriterium2 ...])
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Beschreibung:

Prüft die Zellen aus mehreren Bereichen auf jeweils eine Bedingung und zählt, wie oft dabei alle Bedingun-
gen erfüllt sind. 

Entspricht der Funktion ZÄHLENWENN, erlaubt allerdings die Verwendung mehrerer Suchbereiche (in-
klusive eines Suchkriteriums für jeden Bereich)

Suchbereich1 ist der erste zu durchsuchende Bereich. Beachten Sie, dass alle Suchbereiche die gleichen
Ausmaße haben müssen.

Suchkriterium1 ist die Bedingung, die die Werte in Suchbereich1 erfüllen müssen:

Hier können Sie einerseits einen einfachen Wert angeben (zum Beispiel "42" oder "Schrauben"). In diesem
Fall gilt die Bedingung als erfüllt, wenn die Zelle diesen Wert enthält.

Weiterhin ist auch eine Bedingung wie ">10" oder "<=5" zulässig. Hier gilt die Bedingung als erfüllt, wenn
der Zellinhalt dieser Bedingung entspricht.

Hinweis: Das Suchkriterium sollte stets mit doppelten Anführungszeichen (") umgeben werden.

Im Gegensatz zur Funktion ZÄHLENWENN können Sie bei ZÄHLENWENNS auch mehrere Bereiche (je-
weils mit zugehörigem Suchkriterium) angeben. Es wird dann gezählt, wie oft die Zellen aus den einzelnen
Bereichen alle ihrem jeweiligen Kriterium entsprechen. Siehe Beispiele.

Kompatibilitätshinweise:

Diese Funktion ist nicht kompatibel zum .xls-Dateiformat von Microsoft Excel 2003 und früher. Wenn Sie
ein Dokument in diesem Format speichern, werden alle Berechnungen, die diese Funktion enthalten, durch
ihr aktuelles Ergebnis als fester Wert ersetzt. 

Wenn Sie diese Funktion einsetzen möchten, sollten Sie Ihr Dokument also nicht im Dateiformat "Microsoft
Excel 97-2003 (.xls)" speichern, sondern eines der folgenden Formate verwenden:

¡ "PlanMaker-Dokument (.pmdx oder .pmd)" 

¡ oder: "Microsoft Excel 2007-2016 (.xlsx)"

Beispiel:

ZÄHLENWENNS(C1:C10; ">1"; C1:C10; "<2") 

Diese Formel ermittelt, wie viele der Werte im Bereich C1:C10 größer als 1 und kleiner als 2 sind.

ZÄHLENWENNS(A1:D4; "Thunfisch"; G10:K14; ">500") 

Diese Formel ermittelt, wie oft die folgenden Bedingungen zutreffen: die Zelle im Bereich A1:D4 enthält
"Thunfisch" und die entsprechende Zelle im Bereich G10:K14 ist größer als 500.

Siehe auch:

ANZAHL, MITTELWERTWENN, MITTELWERTWENNS, SUMMEWENN, SUMMEWENNS,
ZÄHLENWENN



697Formeln und Funktionen

ZEICHEN (Zeichen per ANSI-Code)

Syntax:

ZEICHEN(Zahl)

Beschreibung:

Liefert das Zeichen mit dem ANSI-Code Zahl.

Zahl muss größer oder gleich 10 sein.

Beispiel:

ZEICHEN(65) ergibt A

ZEICHEN(32) ergibt ein Leerzeichen

ZEICHEN(CODE("X") ergibt X

Siehe auch:

CODE

ZEILE (Zeilennummer von Zellen)

Syntax:

ZEILE([Bezug])

Beschreibung:

Liefert die Zeilennummer(n) einer Zelle oder eines Bereichs von Zellen:

Ist Bezug eine einzelne Zelle, liefert die Funktion die Zeilennummer dieser Zelle.

Ist Bezug ein Bereich von Zellen, liefert die Funktion die darin enthaltenen Zeilennummern als vertikale
Matrix. Hinweis: In diesem Fall muss die Formel als Matrixformel eingegeben werden (siehe Abschnitt Ar-
beiten mit Matrizen).

Wird das Argument Bezug nicht angegeben, liefert die Funktion die Zeilennummer der Zelle, in der sie auf-
gerufen wurde.

Beispiel:

ZEILE(D2) ergibt 2
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ZEILE(D2:F4) ergibt {2;3;4}

ZEILE() ergibt 5, wenn Sie die Funktion ZEILE() beispielsweise in der Zelle A5 aufrufen

Siehe auch:

SPALTE, ZEILEN, ZELLE

ZEILEN (Zahl der Zeilen)

Syntax:

ZEILEN(Bereich)

Beschreibung:

Liefert die Anzahl der Zeilen im angegebenen Bereich.

Beispiel:

ZEILEN(A1:D5) ergibt 5

Siehe auch:

ZEILE, SPALTEN, BEREICHE

ZEIT (Datumswert bilden)

Syntax:

ZEIT(Stunde; Minute; Sekunde)

Beschreibung:

Bildet einen Datumswert aus den Argumenten Stunde, Minute und Sekunde.

Beispiel:

ZEIT(0; 20; 0) ergibt 0,01389. Dieser Datumswert wird von PlanMaker allerdings automatisch im Zahlen-
format "Datum/Zeit" formatiert, so dass in der Zelle steht: 00:20:00.

Siehe auch:

ZEITWERT, DATUM, DATWERT
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ZEITDIFFERENZ (Differenz zwischen zwei Uhrzeiten)

Syntax:

ZEITDIFFERENZ(Beginn; Ende)

Beschreibung:

Berechnet die zwischen zwei Uhrzeiten verstrichene Zeit.

Für Beginn und Ende ist jeweils eine Uhrzeit anzugeben. 

Sie können auch ein Datum mit einer Uhrzeit angeben (siehe letztes Beispiel), in diesem Fall müssen aber
sowohl Beginn als auch Ende ein Datum enthalten, sonst liefert die Funktion den Fehlerwert #WERT!.

Hinweis:

Diese Funktion liefert auch dann sinnvolle Resultate, wenn Ende kleiner als Beginn ist. 

Beispiel: Ein Arbeiter nimmt seine Tätigkeit um 22:00 auf und geht um 6:00 nach Hause. Würden Sie jetzt,
um seine Arbeitszeit zu ermitteln, einfach Anfangszeit von Endzeit abziehen, wäre das Ergebnis -16 Stun-
den. Verwenden Sie hingegen die Funktion ZEITDIFFERENZ, ist das Ergebnis 8 Stunden.

Beispiel:

ZEITDIFFERENZ("8:00"; "16:00") ergibt 8:00

ZEITDIFFERENZ("22:00"; "6:00") ergibt 8:00

ZEITDIFFERENZ("1.10.2018 22:00"; "2.10.2018 6:00") ergibt 8:00

Kompatibilitätshinweise:

Diese Funktion ist in Excel nicht vorhanden. Wenn Sie ein Dokument im Excel-Format speichern, werden
alle Berechnungen, die diese Funktion enthalten, durch ihr aktuelles Ergebnis als fester Wert ersetzt.

Siehe auch:

ZEIT, ZEITWERT, TAGE/TAGEP, TAGE360

ZEITWERT (Text in Uhrzeit wandeln)

Syntax:

ZEITWERT(Zeichenkette)
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Beschreibung:

Wandelt eine als Zeichenkette übergebene Zeitangabe in eine Uhrzeit (genauer gesagt: in eine serielle Da-
tumszahl) um. 

Hinweis:

Diese Funktion ist nur aus Kompatibilitätsgründen zu älteren Tabellenkalkulationen noch vorhanden.
PlanMaker selbst benötigt sie nicht mehr, da er Uhrzeiten, die als Text angegeben sind, bei Bedarf automa-
tisch in den Typ Datum/Uhrzeit umwandelt.

Beispiel:

ZEITWERT("10:30:00") ergibt die serielle Datumszahl 0,4375.

Formatieren Sie diese mit dem Menübefehl Format > Zelle nun in einem der Datum/Zeit-Formate (zum
Beispiel h:mm), so wird in der Zelle die Uhrzeit angezeigt, die sich hinter diesem Wert verbirgt: 10:30.

Siehe auch:

DATWERT, DATUM, ZEIT

ZELLE (Informationen über eine Zelle)

Syntax:

ZELLE(Typ [; Bezug])

Beschreibung:

Liefert verschiedene Informationen über die angegebene Zelle zurück.

Der Parameter Typ bestimmt, welche Art von Information geliefert werden soll. Geben Sie dazu eine der
folgenden Zeichenketten an:

Typ Erläuterung

"Adresse" Liefert die Adresse der Zelle (als Text).

"Breite" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.)

"Dateiname" Liefert den vollständigen Pfad und Dateinamen des Dokuments, in dem sich die Zelle befindet.

"Farbe" Liefert 1, wenn das Zahlenformat der Zelle die Option Negative Werte in Rot verwendet; an-
sonsten wird 0 zurückgeliefert.

"Format" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.)

"Inhalt" Liefert den Wert zurück, der sich in der Zelle befindet.
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"Klammern" (Wird nicht unterstützt und liefert deshalb den Fehlerwert #NV.)

"Präfix" Liefert eine der folgenden Zeichenketten zurück:

', wenn die Zelle linksbündigen Text enthält

^, wenn die Zelle zentrierten Text enthält

", wenn die Zelle rechtsbündigen Text enthält

\, wenn die Zelle ausgefüllten Text enthält

"", wenn die Zelle etwas anderes enthält

"Schutz" Liefert 1, wenn die Zelle geschützt ist; ansonsten wird 0 zurückgeliefert.

"Spalte" Liefert die Spaltennummer der Zelle (als Zahl).

"Typ" Liefert eine der folgenden Zeichenketten zurück:

b, wenn die Zelle leer ist

l, wenn die Zelle Text enthält

w, wenn die Zelle etwas anderes enthält

"Zeile" Liefert die Zeilennummer der Zelle.

Bezug (optional) ist die Adresse der Zelle, zu der Informationen geliefert werden sollen. 

Wenn Bezug mehrere Zellen umfasst, wird nur die linke obere Zelle verwendet.

Wenn Bezug weggelassen wird, wird die aktuelle Zelle verwendet. (Excel verhält sich hier anders; siehe
Hinweis.)

Kompatibilitätshinweise:

Diese Funktion ist nicht 100% identisch mit der gleichnamigen Excel-Funktion. Es gibt folgende Einschrän-
kungen:

1. PlanMaker unterstützt nicht alle Typen von Informationen (siehe Tabelle oben). 

2. Wenn der Parameter Bezug leer gelassen wird, liefert PlanMaker Informationen zur aktuellen Zelle, Ex-
cel hingegen zu der zuletzt geänderten Zelle.

Beispiel:

=ZELLE("Zeile"; B5) liefert die Zeilennummer dieser Zelle, also 5.

Siehe auch:

DATEINAME, SPALTE, ZEILE
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ZINS (Zinssatz per Iterationsverfahren)

Syntax:

ZINS(Zzr; Rmz; Bw [; Zw] [; Fälligkeit] [; Schätzwert])

Beschreibung:

Liefert eine Schätzung für den Zinsanteil der Zahlung pro Periode, basierend auf einer Investition mit regel-
mäßigen konstanten Zahlungen und feststehendem Zins.

Die Funktion erwartet folgende Argumente:

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Rmz = Annuität (Betrag, der pro Periode gezahlt wird)

Bw = Barwert (der anfängliche Betrag)

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zahlung erreichen möchten.
Wenn Sie das Argument Zw nicht angeben, wird es auf Null gesetzt.

Fälligkeit (optional) = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Schätzwert (optional) = Ihr Schätzwert, wie hoch der Zinssatz vermutlich sein wird (siehe Hinweis).

Hinweis:

Die Berechnung erfolgt mit Hilfe eines Näherungsverfahrens (Iterationsverfahren). Falls die Funktion nach
20 Näherungsschritten noch kein Ergebnis mit einer Genauigkeit von 0,00001% oder besser findet, bricht
sie die Näherung ab und liefert als Ergebnis den Fehlerwert #ZAHL!. Versuchen Sie in diesem Fall einen
anderen Wert für Schätzwert anzugeben.

Beispiel:

ZINS(12*10; -650; 60000) ergibt 0,455087%

Diese Formel berechnet per Iterationsverfahren den Zinssatz bei einem Kredit über € 60.000 mit einer Lauf-
zeit von 10 Jahren (=12*10 Monate) und einer Zahlung von € 650,- (pro Monat).

Das Ergebnis ist der Zinssatz pro Monat. Um den Jahreszins zu erhalten, muss es also mit 12 multipliziert
werden.

Siehe auch:

BW, KAPZ, RMZ, XINTZINSFUSS, ZINSZ, ZSATZINVEST, ZW, ZZR, IKV, QIKV
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ZINSZ (Zinszahlung)

Syntax:

ZINSZ(Zins; Zr; Zzr; Bw [; Zw] [; Fälligkeit])

Beschreibung:

Liefert den Zinsanteil der Zahlung in der angegebenen Periode, basierend auf einer Investition mit regelmä-
ßigen konstanten Zahlungen und feststehendem Zins.

Sie können mit dieser Funktion beispielsweise berechnen, wie groß bei einem Kredit der Zinsanteil der An-
nuität in einer bestimmten Periode ist. 

"Periode" bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen Rückzahlungen ist die
dritte Periode beispielsweise der dritte Monat.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Zr = die zu betrachtende Periode

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Bw = Barwert (der anfängliche Betrag)

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zahlung erreichen möchten.
Wenn Sie das Argument Zw nicht angeben, wird es auf Null gesetzt.

Fälligkeit (optional) = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Beispiel:

Es wird ein Kredit über € 100.000,- zu folgenden Bedingungen aufgenommen:

Jahreszins: 10%

Zahlungen: monatlich

Laufzeit: 6 Jahre

Wie groß ist der Zinsanteil der Zahlung (Annuität) in Monat 32?

ZINSZ(10%/12; 32; 6*12; 100000) ergibt -534 Euro

Beachten Sie dabei, dass alle Angaben auf der gleichen Zeiteinheit basieren müssen – hier also auf Mona-
ten, da die Zahlungen monatlich erfolgen. 

Deshalb wurde in der obigen Formel der Jahreszins durch 12 geteilt (um den Zins pro Monat zu erhalten)
und die Laufzeit mit 12 multipliziert (um die Laufzeit in Monaten zu erhalten).
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Anmerkung:

Die Funktion KAPZ ist das Gegenstück zu ZINSZ: Sie liefert den Tilgungsanteil der Zahlung in dieser Peri-
ode. 

Die Funktion RMZ hingegen liefert den Gesamtbetrag der Zahlung (Annuität) pro Periode, also die Summe
von Tilgungsanteil und Zinsanteil.

Siehe auch:

BW, ISPMT, KAPZ, KUMKAPITAL, KUMZINSZ, RMZ, ZINS, ZW, ZZR

ZSATZINVEST (Zinssatz)

Syntax:

ZSATZINVEST(Zr; Bw; Zw)

Beschreibung:

Berechnet den Zinssatz pro Periode, der benötigt wird, um mit einer festverzinslichen Anlage innerhalb ei-
ner bestimmten Anzahl an Perioden einen bestimmten Betrag zu erreichen. 

Es werden hierbei keine regelmäßigen Zahlungen geleistet; es gibt also nur eine einzige Einzahlung am Be-
ginn der Laufzeit.

Die Funktion erwartet folgende Argumente:

Zr = Zeitraum (Anzahl der Perioden). Wird beispielsweise der Jahreszins betrachtet, ist eine Periode ein
Jahr lang.

Bw = Barwert (der anfängliche Betrag)

Zw = Zukünftiger Wert (der Zielwert)

Beispiel:

Sie möchten mit einer festverzinslichen Anlage von € 3000,- innerhalb von 10 Jahren € 5000,- erreichen.
Wie hoch muss der jährliche Zinssatz sein?

ZSATZINVEST(10; 3000; 5000) ergibt einen Jahreszins von 0,05241 (also etwa 5,24%).

Kompatibilitätshinweise:

Microsoft Excel unterstützt diese Funktion erst ab Version 2013. In älteren Versionen ist die Funktion unbe-
kannt.

In früheren Versionen von PlanMaker hieß diese Funktion ZGZ.
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Siehe auch:

LAUFZEIT, ZINS

ZUFALLSBEREICH (zufälliger Wert)

Syntax:

ZUFALLSBEREICH(Untergrenze; Obergrenze)

Beschreibung:

Liefert eine ganze Zufallszahl x im Bereich Untergrenze £ x £ Obergrenze.

Bei jeder Neuberechnung des Dokuments wird diese Zufallszahl neu erzeugt. 

Tipp: Durch Aufruf des Menübefehl Weiteres > Neu berechnen können Sie ein Dokument manuell neu be-
rechnen lassen.

Beispiel:

ZUFALLSBEREICH(1; 6) liefert ganze Zufallszahlen zwischen 1 und 6, simuliert also einen Würfel.

Siehe auch:

ZUFALLSZAHL

ZUFALLSZAHL (zufälliger Wert)

Syntax:

ZUFALLSZAHL()

Beschreibung:

Liefert eine Zufallszahl im Bereich ³ 0 und < 1.

Bei jeder Neuberechnung des Dokuments wird diese Zufallszahl neu erzeugt. 

Tipp: Durch Aufruf des Menübefehl Weiteres > Neu berechnen können Sie ein Dokument manuell neu be-
rechnen lassen.

Beispiel:

Folgende Formel liefert eine ganze Zufallszahl zwischen 1 und 6, simuliert also einen Würfel:
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GANZZAHL(ZUFALLSZAHL()*6+1)

Tipp: Einfacher geht dies allerdings mit ZUFALLSBEREICH(1; 6).

Siehe auch:

ZUFALLSBEREICH 

ZULETZTGEDRUCKT (Datum des letzten Ausdrucks)

Syntax:

ZULETZTGEDRUCKT()

Beschreibung:

Liefert das Datum, an dem das aktuelle Dokument zuletzt ausgedruckt wurde.

Siehe auch:

ZULETZTGESPEICHERT

ZULETZTGESPEICHERT (Datum des letzten Speicherns)

Syntax:

ZULETZTGESPEICHERT()

Beschreibung:

Liefert das Datum, an dem das aktuelle Dokument zuletzt gespeichert wurde.

Siehe auch:

ZULETZTGEDRUCKT
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ZW (Zukünftiger Wert)

Syntax:

ZW(Zins; Zzr; Rmz [; Bw] [; Fälligkeit])

Beschreibung:

Liefert den zukünftigen Wert einer Investition, basierend auf einer Investition mit regelmäßigen konstanten
Zahlungen und feststehendem Zins.

Sie können mit dieser Funktion beispielsweise den zukünftigen Wert (= Endwert) eines Kredits ausrechnen.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Zzr = Zahl der Zahlungszeiträume (wie viele Perioden umfasst die Laufzeit?)

Rmz = Annuität (Betrag, der pro Periode gezahlt wird)

Bw (optional) = Barwert. Wenn Sie das Argument Bw nicht angeben, wird es auf Null gesetzt.

Fälligkeit (optional) = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Beispiel:

ZW(6,5%/12; 10; -1000) ergibt 10.247,30

Siehe auch:

BW, KAPZ, RMZ, ZINS, ZINSZ, ZW2, ZZR

ZW2 (Zukünftiger Wert)

Syntax:

ZW2(Bw; Zinsen)

Beschreibung:

Liefert den zukünftigen Wert einer Investition für eine Reihe unterschiedlicher periodischer Zinssätze.

Es werden keine regelmäßigen Zahlungen geleistet; es gibt also nur eine einzige Einzahlung am Beginn der
Laufzeit.
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Sie können mit dieser Funktion beispielsweise den zukünftigen Wert (= Endwert) eines Kredits ausrechnen.

Die Funktion erwartet folgende Argumente:

Bw = Barwert (der anfängliche Betrag)

Zinsen = Zellbezug auf einen Tabellenbereich, in dem die unterschiedlichen Zinssätze pro Periode enthal-
ten sind (in entsprechender Reihenfolge, also beispielsweise erst der Zinssatz für das erste Jahr, dann der für
das zweite Jahr etc.).

Beispiel:

Für eine Einlage von € 10.000,- erhalten Sie im ersten Jahr 5% Zinsen, im zweiten 5,2%, im dritten 5,5%,
im vierten 5,9%. Um den zukünftigen Wert dieser Investition zu berechnen, tragen Sie diese vier Zinssätze
(in der korrekten Reihenfolge) beispielsweise in die Zellen A1 bis A4 ein und wenden dann die folgende
Formel an:

ZW2(10000; A1:A4) ergibt 12.341 Euro

Die unterschiedlichen Zinssätze können auch direkt in folgender Form angegeben werden:

ZW2(10000; {5%; 5,2%; 5,5%; 5,9%})

Siehe auch:

ZW

ZWEIFAKULTÄT (Zweierfakultät)

Syntax:

ZWEIFAKULTÄT(Zahl)

Beschreibung:

Liefert die Zweierfakultät einer Zahl.

Die Zweierfakultät wird wie folgt gebildet:

Ist Zahl gerade, wird das Produkt aller geraden positiven Zahlen von 2 bis Zahl berechnet (also
2*4*6*...*Zahl).

Ist Zahl ungerade, wird das Produkt aller ungeraden positiven Zahlen von 1 bis Zahl berechnet (also
1*3*5*...*Zahl).

Die übergebene Zahl muss positiv sein. Nachkommastellen werden automatisch abgeschnitten.

Beispiel:

ZWEIFAKULTÄT(8) entspricht 2*4*6*8, ergibt also 384

ZWEIFAKULTÄT(9) entspricht 1*3*5*7*9, ergibt also 945
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Siehe auch:

FAKULTÄT

ZZR (Zinszeitraum)

Syntax:

ZZR(Zins; Rmz; Bw [; Zw] [; Fälligkeit])

Beschreibung:

Ermittelt die Zahl der Zahlungszeiträume (Perioden), basierend auf einer Investition mit regelmäßigen kon-
stanten Zahlungen und feststehendem Zins.

Sie können mit dieser Funktion beispielsweise berechnen, wie viele regelmäßige Zahlungen (Annuitäten)
bei einem Kredit erfolgen müssen.

"Periode" bezeichnet einen Zahlungszeitraum. Bei einem Kredit mit monatlichen Rückzahlungen ist die
dritte Periode beispielsweise der dritte Monat.

Die Funktion erwartet folgende Argumente:

Zins = Zinssatz (pro Periode)

Rmz = Annuität (Betrag, der pro Periode gezahlt wird)

Bw = Barwert (der anfängliche Betrag)

Zw (optional) = Zukünftiger Wert, also der Endstand, den Sie nach der letzten Zahlung erreichen möchten.
Wenn Sie das Argument Zw nicht angeben, wird es auf Null gesetzt.

Fälligkeit (optional) = Wann die Zahlungen fällig sind:

0 oder nicht angegeben: jeweils am Ende der Periode

1: jeweils am Anfang der Periode

Siehe auch:

BW, KAPZ, RMZ, ZINS, ZINSZ, ZW
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Anhang
Im Anhang des Handbuchs finden Sie folgende Informationen:

¡ Menübefehle und entsprechende Ribbonbefehle 

In diesem Abschnitt finden Sie eine Tabelle aller Menübefehle und dem jeweils entsprechenden Befehl
im Ribbon (Menüband).

¡ Tastenbelegung 

Dieser Abschnitt enthält Tabellen mit den wichtigsten Tastenkürzeln, die Sie im Programm verwenden
können. 

Menübefehle und entsprechende Ribbonbefehle
In diesem Abschnitt finden Sie eine Tabelle aller Menübefehle und dem jeweils entsprechenden Befehl im
Ribbon (Menüband).

Tipp: Sie können die Benutzeroberfläche jederzeit zwischen Ribbon und klassischen Menüs mit Symbol-
leisten umschalten. Rufen Sie dazu im Menü den Befehl Weiteres > Einstellungen auf (beziehungsweise
im Ribbon den Befehl Datei > Einstellungen). Wechseln Sie in dem Dialog auf die Karteikarte Ausse-
hen und klicken Sie darin auf die Schaltfläche Benutzeroberfläche. Es erscheint ein weiterer Dialog, in
dem Sie die gewünschte Art von Benutzeroberfläche wählen können.

Die nachfolgende Tabelle enthält folgende Spalten:

¡ Linke Spalte: Menübefehl 

Die linke Spalte listet alle Menübefehle im Programm, geordnet nach der Reihenfolge im Hauptmenü. 

¡ Rechte Spalte: entsprechender Befehl im Ribbon 

In der rechten Spalte finden Sie jeweils den entsprechenden Befehl im Ribbon – in folgendem Format:

Karteikarte > Sektion > Befehl

Beispiel: 

Der Ribbonbefehl Datei > Dokument > Speichern ist auf dem Ribbon also wie folgt zu finden: Kartei-
karte Datei, Sektion Dokument, Symbol Speichern. 

Bei manchen Befehlen ist zusätzlich noch ein vierter Eintrag angehängt. Hier befindet sich der entspre-
chende Befehl in der Liste, die sich öffnet, wenn Sie auf das angegebene Symbol (oder das Pfeilchen
rechts davon) klicken.

Hier also die angekündigte Tabelle:
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Datei > Neu Datei > Datei > Neu >> Weitere

Datei > Öffnen Datei > Datei > Öffnen

Datei > Schließen Datei > Datei > Schließen

Datei > Speichern Datei > Dokument > Speichern

Datei > Speichern unter Datei > Dokument > Speichern unter

Datei > Alles speichern Datei > Dokument > Alles speichern

Datei > Zurück zu vorheriger Version Datei > Dateiverwaltung > Versionen

Datei > Holen Einfügen > Objekte > Grafikrahmen >> Von Scanner

Datei > Quelle wählen Einfügen > Objekte > Grafikrahmen >> Quelle wählen

Datei > Eigenschaften Datei > Dateiverwaltung > Eigenschaften

Datei > Dateimanager Datei > Dateiverwaltung > Dateimanager

Datei > Seite einrichten Datei > Drucken > Seite einrichten

Datei > Druckvorschau Datei > Drucken > Druckvorschau

Datei > Druckbereich > Druckbereich festlegen Datei > Drucken > Druckbereich festlegen

Datei > Druckbereich > Druckbereich entfernen Datei > Drucken > Druckbereich festlegen >> Druckbe-
reich entfernen

Datei > Drucken Datei > Drucken > Drucken

Datei > Als PDF-Dokument exportieren Datei > Dokument > PDF-Export

Datei > Versenden Datei > Dokument > Versenden

Bearbeiten > Rückgängig Schnellzugriffsleiste > Rückgängig

Bearbeiten > Wiederherstellen Schnellzugriffsleiste > Wiederherstellen
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Bearbeiten > Wiederholen Schnellzugriffsleiste > Wiederholen

Bearbeiten > Ausschneiden Start > Bearbeiten > Ausschneiden

Bearbeiten > Kopieren Start > Bearbeiten > Kopieren

Bearbeiten > Einfügen Start > Bearbeiten > Einfügen

Bearbeiten > Duplizieren Layout > Objekte > Duplizieren

Bearbeiten > Inhalte einfügen Start > Bearbeiten > Einfügen >> Inhalte einfügen

Bearbeiten > Alles markieren Start > Auswahl > Alles markieren

Bearbeiten > Ausfüllen Start > Inhalte > Füllen

Bearbeiten > Selektiv löschen Start > Inhalte > Löschen

Bearbeiten > Selektiv löschen > Formate Start > Inhalte > Löschen > Formate

Bearbeiten > Selektiv löschen > Inhalte Start > Inhalte > Löschen > Inhalte

Bearbeiten > Selektiv löschen > Kommentare Start > Inhalte > Löschen > Kommentare

Bearbeiten > Selektiv löschen > Bedingte Forma-
tierung

Start > Inhalte > Löschen > Bedingte Formatierung

Bearbeiten > Selektiv löschen > Gültigkeitsprü-
fung

Start > Inhalte > Löschen > Gültigkeitsprüfung

Bearbeiten > Suchen Start > Suchen > Suchen

Bearbeiten > Ersetzen Start > Suchen > Ersetzen

Bearbeiten > Suchen wiederholen Start > Suchen > Weitersuchen

Bearbeiten > Gehe zu Start > Suchen > Gehe zu

Bearbeiten > Verknüpfung OLE-Objekt > OLE > Verknüpfung bearbeiten

Bearbeiten > OLE-Objekt OLE-Objekt > OLE > OLE-Objekt

Ansicht > Fingereingabemodus Schnellzugriffsleiste > Fingereingabemodus
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Menü Ribbon

Ansicht > Fixieren Ansicht > Fenster > Titel fixieren

Ansicht > Originalgröße Ansicht > Zoom > Originalgröße

Ansicht > Vergrößerungsstufe Ansicht > Zoom > Vergrößerungsstufe

Ansicht > Objektmodus Ansicht > Modus > Objektmodus

Ansicht > Formelanzeige Ansicht > Ansicht > Formelanzeige

Ansicht > Syntaxhervorhebung Ansicht > Ansicht > Syntaxhervorhebung

Ansicht > Zeilen- & Spaltenköpfe Ansicht > Ansicht > Zeilen- und Spaltenköpfe

Ansicht > Beobachtungsfenster Formeln > Beobachtung > Beobachtungsliste anzeigen

Ansicht > Vollbild Ansicht > Fenster > Vollbildmodus

Ansicht > Pivot-Tabellen-Seitenleiste > Links an-
zeigen

Ansicht > Fenster > Pivot-Tabellen-Seitenleiste > Links
anzeigen

Ansicht > Pivot-Tabellen-Seitenleiste > Rechts
anzeigen

Ansicht > Fenster > Pivot-Tabellen-Seitenleiste > Rechts
anzeigen

Format > Zelle Start > Zahl und Start > Ausrichtung

Format > Zeichen Start > Zeichen

Format > Standard Start > Inhalte > Löschen >> Zeichenformatierung zurück-
setzen

Format > Absatz Start > Ausrichtung

Format > Umrandung Start > Format > Umrandung

Format > Schattierung Start > Format > Schattierung

Format > Hyperlink Einfügen > Verknüpfungen > Hyperlink

Format > Hyperlink entfernen Start > Inhalte > Löschen >> Hyperlink entfernen

Format > Zellenvorlage Start > Format > Zellenvorlagen >> Zellenvorlagen ver-
walten
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Format > Bedingte Formatierung > Neue Regel Start > Format > Bedingte Formatierung >> Neue Regel

Format > Bedingte Formatierung > Regeln ver-
walten

Start > Format > Bedingte Formatierung >> Regeln ver-
walten

Format > Gültigkeitsprüfung Überprüfen > Gültigkeitsprüfung > Gültigkeitsprüfung

Format > Format übertragen Start > Bearbeiten > Format übertragen

Einfügen > Funktion Formeln > Funktion > Funktion

Einfügen > Kommentar Einfügen > Kommentare > Kommentar

Einfügen > Sonderzeichen Einfügen > Text > Sonderzeichen

Einfügen > Textbaustein Einfügen > Text > Textbaustein

Einfügen > Kopf- und Fußzeile Einfügen > Text > Kopf- oder Fußzeile

Einfügen > Seitenumbruch > Vor Zeile einfügen Layout > Seite einrichten > Seitenumbruch > Vor Zeile
einfügen

Einfügen > Seitenumbruch > Vor Zeile löschen Layout > Seite einrichten > Seitenumbruch > Vor Zeile lö-
schen

Einfügen > Seitenumbruch > Vor Spalte einfügen Layout > Seite einrichten > Seitenumbruch > Vor Spalte
einfügen

Einfügen > Seitenumbruch > Vor Spalte löschen Layout > Seite einrichten > Seitenumbruch > Vor Spalte
löschen

Arbeitsblatt > Spalte > Breite Layout > Zellen > Zellengröße

Arbeitsblatt > Spalte > Optimale Breite Layout > Zellen > Optimale Breite

Arbeitsblatt > Spalte > Einblenden Start > Zellen > Sichtbarkeit >> Spalten anzeigen

Arbeitsblatt > Spalte > Ausblenden Start > Zellen > Sichtbarkeit >> Spalten verbergen

Arbeitsblatt > Zeile > Höhe Layout > Zellen > Zellengröße

Arbeitsblatt > Zeile > Optimale Höhe Layout > Zellen > Optimale Höhe

Arbeitsblatt > Zeile > Einblenden Start > Zellen > Sichtbarkeit >> Zeilen anzeigen
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Arbeitsblatt > Zeile > Ausblenden Start > Zellen > Sichtbarkeit >> Zeilen verbergen

Arbeitsblatt > Blatt > Einfügen Einfügen > Tabellen > Blatt >> Einfügen

Arbeitsblatt > Blatt > Kopieren Einfügen > Tabellen > Blatt >> Kopieren

Arbeitsblatt > Blatt > Verschieben Einfügen > Tabellen > Blatt >> Verschieben

Arbeitsblatt > Blatt > Löschen Einfügen > Tabellen > Blatt >> Löschen

Arbeitsblatt > Blatt > Umbenennen Einfügen > Tabellen > Blatt >> Umbenennen

Arbeitsblatt > Blatt > Einblenden Einfügen > Tabellen > Blatt >> Einblenden

Arbeitsblatt > Blatt > Ausblenden Einfügen > Tabellen > Blatt >> Ausblenden

Arbeitsblatt > Blatt > Eigenschaften Einfügen > Tabellen > Blatt >> Eigenschaften

Arbeitsblatt > Kopierte Zellen einfügen Start > Zellen > Einfügen >> Kopierte Zellen einfügen

Arbeitsblatt > Zellen einfügen Start > Zellen > Einfügen

Arbeitsblatt > Zellen löschen Start > Zellen > Löschen

Arbeitsblatt > Entfernen > Leere Zeilen Daten > Bearbeiten > Leere Zeilen entfernen

Arbeitsblatt > Entfernen > Doppelte Zeilen Daten > Bearbeiten > Leere Zeilen entfernen >> Doppelte
Zeilen entfernen

Arbeitsblatt > Namen > Bearbeiten Formeln > Benannte Bereiche > Namen bearbeiten

Arbeitsblatt > Namen > Anwenden Formeln > Benannte Bereiche > Namen anwenden

Arbeitsblatt > Namen > Übernehmen Formeln > Benannte Bereiche > Namen erstellen

Arbeitsblatt > Namen > Liste einfügen Formeln > Benannte Bereiche > Namen einfügen

Arbeitsblatt > Sortieren Start > Inhalte > Sortieren und filtern >> Sortieren

Arbeitsblatt > Transponieren Daten > Bearbeiten > Transponieren

Arbeitsblatt > Filter > AutoFilter Start > Inhalte > Sortieren und filtern >> AutoFilter



716Anhang

Menü Ribbon

Arbeitsblatt > Filter > Alles anzeigen Start > Inhalte > Sortieren und filtern >> Alles anzeigen

Arbeitsblatt > Filter > Filter erneut anwenden Start > Inhalte > Sortieren und filtern >> Filter erneut an-
wenden

Arbeitsblatt > Filter > Spezialfilter Start > Inhalte > Sortieren und filtern >> Spezialfilter

Arbeitsblatt > Text in Spalten aufteilen Daten > Bearbeiten > Text in Spalten

Arbeitsblatt > Gliederung > Gliederungsfeld auto-
matisch anzeigen

Arbeitsblatt > Gliederung > Gruppieren Daten > Gliederung > Gruppieren

Arbeitsblatt > Gliederung > Gruppierung aufhe-
ben

Daten > Gliederung > Gruppierung aufheben

Arbeitsblatt > Gliederung > Gliederung entfernen Daten > Gliederung > Gliederung komplett entfernen

Arbeitsblatt > Gliederung > Details einblenden Daten > Gliederung > Details anzeigen

Arbeitsblatt > Gliederung > Details ausblenden Daten > Gliederung > Details verbergen

Arbeitsblatt > Gliederung > Optionen Daten > Gliederung

Arbeitsblatt > Externe Bezüge Daten > Bearbeiten > Externe Bezüge

Arbeitsblatt > Daten konsolidieren Daten > Analyse > Datenkonsolidierung

Arbeitsblatt > Pivot-Tabelle Einfügen > Tabellen > Pivot-Tabelle

Arbeitsblatt > Neue Tabelle Einfügen > Tabellen > Tabelle

Arbeitsblatt > Tabelle > Tabellenbereich Tabelle > Tabelle > Bereich

Arbeitsblatt > Tabelle > Tabelleneigenschaften Tabelle > Tabelle > Eigenschaften

Arbeitsblatt > Tabelle > Pivot-Tabelle erstellen Tabelle > Tabelle > Als Pivot-Tabelle zusammenfassen

Arbeitsblatt > Tabelle > In Bereich konvertieren Tabelle > Tabelle > In Bereich konvertieren

Arbeitsblatt > Tabelle > Tabelle löschen Tabelle > Tabelle > Tabelle löschen
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Menü Ribbon

Arbeitsblatt > Tabelle > Selektieren > Zeilen se-
lektieren

Tabelle > Auswahl > Zeilen selektieren

Arbeitsblatt > Tabelle > Selektieren > Spalten se-
lektieren

Tabelle > Auswahl > Spalten selektieren

Arbeitsblatt > Tabelle > Selektieren > Tabelle se-
lektieren

Tabelle > Auswahl > Tabelle selektieren

Arbeitsblatt > Tabelle > Einfügen > Zeilen ober-
halb einfügen

Tabelle > Bearbeiten > Oberhalb einfügen

Arbeitsblatt > Tabelle > Einfügen > Zeilen unter-
halb einfügen

Tabelle > Bearbeiten > Unterhalb einfügen

Arbeitsblatt > Tabelle > Einfügen > Spalten links
einfügen

Tabelle > Bearbeiten > Links einfügen

Arbeitsblatt > Tabelle > Einfügen > Spalten
rechts einfügen

Tabelle > Bearbeiten > Rechts einfügen

Arbeitsblatt > Tabelle > Löschen > Zeilen lö-
schen

Tabelle > Bearbeiten > Zeilen löschen

Arbeitsblatt > Tabelle > Löschen > Spalten lö-
schen

Tabelle > Bearbeiten > Spalten löschen

Arbeitsblatt > Tabelle > Kopfzeile Tabelle > Vorlage > Kopfzeile

Arbeitsblatt > Tabelle > Ergebniszeile Tabelle > Vorlage > Ergebniszeile

Objekt > Neuer Diagrammrahmen Einfügen > Objekte > Diagrammrahmen

Objekt > Neuer Textrahmen Einfügen > Objekte > Textrahmen

Objekt > Neuer Grafikrahmen Einfügen > Objekte > Grafikrahmen

Objekt > Neuer OLE-Objektrahmen Einfügen > Objekte > OLE-Objektrahmen

Objekt > Neues Formularobjekt > Kontrollkäst-
chen

Einfügen > Objekte > Formularobjekt >> Kontrollkäst-
chen

Objekt > Neues Formularobjekt > Optionsfeld Einfügen > Objekte > Formularobjekt >> Optionsfeld

Objekt > Neues Formularobjekt > Auswahlliste Einfügen > Objekte > Formularobjekt >> Auswahlliste

Objekt > Neues Formularobjekt > Liste Einfügen > Objekte > Formularobjekt >> Liste



718Anhang
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Objekt > Neues Formularobjekt > Schaltfläche Einfügen > Objekte > Formularobjekt >> Schaltfläche

Objekt > Neues Formularobjekt > Drehfeld Einfügen > Objekte > Formularobjekt >> Drehfeld

Objekt > Neues Formularobjekt > Bildlaufleiste Einfügen > Objekte > Formularobjekt >> Bildlaufleiste

Objekt > Neues Formularobjekt > Bezeichnung Einfügen > Objekte > Formularobjekt >> Bezeichnung

Objekt > Neues Formularobjekt > Gruppenfeld Einfügen > Objekte > Formularobjekt >> Gruppenfeld

Objekt > Neue Zeichnung > Linie Einfügen > Objekte > Linien

Objekt > Neue Zeichnung > Kurve Einfügen > Objekte > Linien

Objekt > Neue Zeichnung > Freihandform Einfügen > Objekte > Linien

Objekt > Neue Zeichnung > Gerade Verbindung Einfügen > Objekte > Linien

Objekt > Neue Zeichnung > Gewinkelte Verbin-
dung

Einfügen > Objekte > Linien

Objekt > Neue Zeichnung > Gekrümmte Verbin-
dung

Einfügen > Objekte > Linien

Objekt > Neue Zeichnung > Rechteck Einfügen > Objekte > Autoform

Objekt > Neue Zeichnung > Abgerundetes Recht-
eck

Einfügen > Objekte > Autoform

Objekt > Neue Zeichnung > Ellipse/Kreis Einfügen > Objekte > Autoform

Objekt > Neue Zeichnung > AutoForm Einfügen > Objekte > AutoForm

Objekt > Neue Zeichnung > TextArt Einfügen > Objekte > TextArt-Objekt

Objekt > Gruppieren Layout > Objekte > Gruppieren

Objekt > Reihenfolge > In den Vordergrund Layout > Position > In den Vordergrund

Objekt > Reihenfolge > In den Hintergrund Layout > Position > In den Hintergrund

Objekt > Reihenfolge > Eine Ebene nach vorne Layout > Position > In den Vordergrund >> Eine Ebene
nach vorne
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Objekt > Reihenfolge > Eine Ebene nach hinten Layout > Position > In den Hintergrund >> Eine Ebene
nach hinten

Objekt > Drehen oder kippen > Horizontal kippen Layout > Position > Objekt drehen >> Horizontal kippen

Objekt > Drehen oder kippen > Vertikal kippen Layout > Position > Objekt drehen >> Vertikal kippen

Objekt > Drehen oder kippen > 90° gegen den
Uhrzeigersinn drehen

Layout > Position > Objekt drehen >> 90° gegen den Uhr-
zeigersinn drehen

Objekt > Drehen oder kippen > 90° im Uhrzeiger-
sinn drehen

Layout > Position > Objekt drehen >> 90° im Uhrzeiger-
sinn drehen

Objekt > Ausrichten oder verteilen > Linksbündig
ausrichten

Layout > Position > Objekte ausrichten >> Linksbündig

Objekt > Ausrichten oder verteilen > Horizontal
zentrieren

Layout > Position > Objekte ausrichten >> Horizontal
zentrieren

Objekt > Ausrichten oder verteilen > Rechtsbün-
dig ausrichten

Layout > Position > Objekte ausrichten >> Rechtsbündig

Objekt > Ausrichten oder verteilen > Oben aus-
richten

Layout > Position > Objekte ausrichten >> Oben ausrich-
ten

Objekt > Ausrichten oder verteilen > Vertikal
zentrieren

Layout > Position > Objekte ausrichten >> Vertikal zen-
trieren

Objekt > Ausrichten oder verteilen > Unten aus-
richten

Layout > Position > Objekte ausrichten >> Unten ausrich-
ten

Objekt > Ausrichten oder verteilen > Horizontal
verteilen

Layout > Position > Objekte ausrichten >> Horizontal ver-
teilen

Objekt > Ausrichten oder verteilen > Vertikal ver-
teilen

Layout > Position > Objekte ausrichten >> Vertikal ver-
teilen

Objekt > Diagramm > Daten in Spalten Diagramm > Daten > Datenreihen in Spalten

Objekt > Diagramm > Daten in Zeilen Diagramm > Daten > Datenreihen in Zeilen

Objekt > Diagramm > Position des Diagramms
ändern

Diagramm > Position > Diagrammposition

Objekt > Diagramm > Als Grafik speichern Diagramm > Exportieren > Diagramm als Grafik spei-
chern

Objekt > Diagramm > Eigenschaften des Ele-
ments

Diagramm > Diagrammelemente > Element bearbeiten
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Objekt > Eigenschaften Objekt > Format > AutoForm-Vorlagen >> Weitere

Weiteres > Rechtschreibprüfung Überprüfen > Rechtschreibung > Rechtschreibprüfung

Weiteres > Wörterbücher bearbeiten Überprüfen > Rechtschreibung > Rechtschreibprüfung >>
Wörterbücher bearbeiten

Weiteres > Blattschutz Überprüfen > Berechtigungen > Blattschutz

Weiteres > Arbeitsmappenschutz Überprüfen > Berechtigungen > Arbeitsmappenschutz

Weiteres > Script starten Datei > Skripte > Script starten

Weiteres > Script bearbeiten Datei > Skripte > Script bearbeiten

Weiteres > Listen editieren

Weiteres > Szenarien Daten > Analyse > Szenario-Manager

Weiteres > Zielwertsuche Daten > Analyse > Zielwertsuche

Weiteres > Kommentare > Kommentar bearbeiten Überprüfen > Kommentare > Bearbeiten

Weiteres > Kommentare > Vorheriger Kommen-
tar

Überprüfen > Kommentare > Vorheriger Kommentar

Weiteres > Kommentare > Nächster Kommentar Überprüfen > Kommentare > Nächster Kommentar

Weiteres > Kommentare > Diesen Kommentar
anzeigen

Überprüfen > Kommentare > Kommentarsichtbarkeit >>
Diesen Kommentar anzeigen

Weiteres > Kommentare > Alle Kommentare an-
zeigen

Überprüfen > Kommentare > Kommentarsichtbarkeit >>
Alle Kommentare anzeigen

Weiteres > Kommentare > Kommentarposition
zurücksetzen

Überprüfen > Kommentare > Kommentarsichtbarkeit >>
Alle Kommentarpositionen zurücksetzen

Weiteres > Formelüberwachung > Spur zu den
Vorgängern

Formeln > Spuren > Spur zu den Vorgängern

Weiteres > Formelüberwachung > Spuren zu den
Vorgängern entfernen

Formeln > Spuren > Alle Spuren entfernen >> Spuren zu
den Vorgängern entfernen

Weiteres > Formelüberwachung > Spur zu den
Nachfolgern

Formeln > Spuren > Spur zu den Nachfolgern
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Weiteres > Formelüberwachung > Spuren zu den
Nachfolgern entfernen

Formeln > Spuren > Alle Spuren entfernen >> Spuren zu
den Nachfolgern entfernen

Weiteres > Formelüberwachung > Alle Spuren
entfernen

Formeln > Spuren > Alle Spuren entfernen

Weiteres > Formelüberwachung > Vorgänger se-
lektieren

Formeln > Spuren > Spur zu den Vorgängern >> Vorgän-
ger selektieren

Weiteres > Formelüberwachung > Nachfolger se-
lektieren

Formeln > Spuren > Spur zu den Nachfolgern >> Nach-
folger selektieren

Weiteres > Formelüberwachung > Spur zum Feh-
ler

Formeln > Spuren > Spur zum Fehler

Weiteres > Formelüberwachung > Gehe zum vor-
hergehenden Fehler

Formeln > Spuren > Vorheriger Fehler

Weiteres > Formelüberwachung > Gehe zum
nächsten Fehler

Formeln > Spuren > Nächster Fehler

Weiteres > Formelüberwachung > Ungültige Da-
ten markieren

Daten > Überprüfung > Ungültige Daten markieren

Weiteres > Formelüberwachung > Markierung für
ungültige Daten entfernen

Daten > Überprüfung > Markierung entfernen

Weiteres > Formelüberwachung > Gehe zur vor-
hergehenden ungültigen Zelle

Daten > Überprüfung > Vorhergehende ungültige Zelle

Weiteres > Formelüberwachung > Gehe zur
nächsten ungültigen Zelle

Daten > Überprüfung > Nächste ungültige Zelle

Weiteres > Neu berechnen Formeln > Aktualisieren > Daten aktualisieren >> Berech-
nungen aktualisieren

Weiteres > Diagramme aktualisieren Formeln > Aktualisieren > Daten aktualisieren >> Dia-
gramme aktualisieren

Weiteres > Alle Pivot-Tabellen aktualisieren Formeln > Aktualisieren > Daten aktualisieren >> Pivot-
Tabellen aktualisieren

Weiteres > Externe Bezüge aktualisieren Formeln > Aktualisieren > Daten aktualisieren >> Externe
Bezüge aktualisieren

Weiteres > Anpassen Datei > Einstellungen > Anpassen >> Ribbon anpassen

Weiteres > Einstellungen Datei > Einstellungen > Einstellungen
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Tastenbelegung
Auf den nächsten Seiten finden Sie Tabellen mit den wichtigsten Tastenkürzeln, die Sie im Programm ver-
wenden können:

¡ Tastenkürzel in der Windows-Version und der Linux-Version 

¡ Tastenkürzel in der Mac-Version

Tipp: Über den Menübefehl Weiteres > Anpassen können Sie die vordefinierten Tastenkürzel jederzeit
abändern und auch neue Tastenkürzel festlegen (siehe Abschnitt Tastenkürzel anpassen).

Tastenkürzel in der Windows-Version und der Linux-Version

In der Windows-Version und der Linux-Version gibt es folgende Tastenkürzel:

Tastenkürzel zum Editieren von Tabellen

Befehl Tastenkürzel

Zur nächsten Zelle ß/à/á/â

Zur nächsten / vorherigen Zelle horizontal Tab / Umschalt+Tab

Zur nächsten / vorherigen Zelle vertikal Eingabetaste / Umschalt+Eingabetaste

Zur nächsten ausgefüllten Zelle Strg + ß/à/á/â

Zur ersten Zelle der aktuellen Spalte Strg+Bildá

Zur letzten Zelle der aktuellen Spalte Strg+Bildâ

Zur ersten Zelle der aktuellen Zeile Pos1

Zur letzten ausgefüllten Zelle der aktuellen Zeile Ende

Zur ersten Zelle der Tabelle (Zelle A1) Strg+Pos1

Zur letzten ausgefüllten Zelle der Tabelle Strg+Ende

Zur nächsten zirkulären Verknüpfung Umschalt+F5

Zum nächsten Fehler Strg+F3

Zelle über der aktuellen Zelle kopieren Strg+, (Komma)

Wert aus Zelle über der aktuellen Zelle kopieren Strg+Umschalt+, (Komma)
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Befehl Tastenkürzel

Matrixformel eingeben Strg+Umschalt+¿

Matrixformel selektieren Strg+7

Bedingtes Format selektieren Strg+6

Auswahlliste mit den Zellinhalten direkt 
oberhalb oder unterhalb der Zelle öffnen

Alt+Umschalt+â

Umschalten zwischen den Eingabemodi AUTO und TEXT (sie-
he Abschnitt Statuszeile)

Strg+Umschalt+F4

Langen Gedankenstrich einfügen (Geviertstrich —) Strg+Alt+Minus(Nummernblock)

Geschütztes Leerzeichen einfügen
 (nicht-trennendes Leerzeichen)

Strg+Umschalt+Leertaste

Hexadezimalen Zeichencode in Unicode-Zeichen wandeln* Strg+Alt+Umschalt+X

* Tippen Sie beispielsweise 20AC ein und betätigen dann diese Tastenkombination, erscheint ein Eurozeichen (da dieses Zeichen im Unicode-Zei-
chensatz den Code 20AC hat).

Tastenkürzel für Menübefehle

Menübefehl Tastenkürzel

Datei > Neu Strg+N

Datei > Öffnen Strg+O

Datei > Schließen Strg+W oder Strg+F4

Datei > Speichern Strg+S

Datei > Dateimanager F12

Datei > Drucken Strg+P

Datei > Beenden Strg+Q oder Alt+F4

Bearbeiten > Rückgängig Strg+Z

Bearbeiten > Wiederherstellen Strg+Y

Bearbeiten > Wiederholen Strg+Umschalt+Y

Bearbeiten > Ausschneiden Strg+X

Bearbeiten > Kopieren Strg+C

Bearbeiten > Einfügen Strg+V

Bearbeiten > Inhalte einfügen Strg+Alt+V

Bearbeiten > Alles markieren Strg+A
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Menübefehl Tastenkürzel

Bearbeiten > Suchen Strg+F

Bearbeiten > Ersetzen Strg+H

Bearbeiten > Suchen wiederholen F3

Bearbeiten > Gehe zu Strg+G oder F5

Ansicht > Vollbild F6

Format > Zelle Strg+1

Zahlenformat: Zahl Strg+Umschalt+1

Zahlenformat: Wissenschaftlich Strg+Umschalt+2

Zahlenformat: Währung Strg+Umschalt+4

Zahlenformat: Prozent Strg+Umschalt+5

Format > Zeichen Strg+2

Schriftart in der Formatleiste wählen Strg+D

Fettdruck ein-/ausschalten Strg+Umschalt+F oder Strg+B

Kursivschrift ein-/ausschalten Strg+Umschalt+K oder Strg+I

Unterstreichen ein-/ausschalten Strg+Umschalt+U

Hochstellen Strg+Umschalt+Plus(Nummernblock)

Tiefstellen Strg+Umschalt+Minus(Nummernblock)

Hoch-/Tiefstellen abschalten Strg+Umschalt+*(Nummernblock)

Ausrichtung: Standard Strg+T

Ausrichtung: Linksbündig Strg+L

Ausrichtung: Zentriert Strg+E

Ausrichtung: Rechtsbündig Strg+R

Ausrichtung: Blocksatz Strg+J

Format > Hyperlink Strg+K

Format > Format übertragen (Schritt kopieren) Strg+Umschalt+C

Format > Format übertragen  (Schritt einfügen) Strg+Umschalt+V

Einfügen > Funktion F7

Einfügen > Kommentar Umschalt+F2

Aktuelles Datum einfügen Strg+. (Punkt)



725Anhang

Menübefehl Tastenkürzel

Aktuelle Uhrzeit einfügen Strg+Umschalt+. (Punkt)

Aktuelle Zeile ausblenden Strg+9

Aktuelle Zeile einblenden Strg+Umschalt+9

Aktuelle Spalte ausblenden Strg+0

Aktuelle Spalte einblenden Strg+Umschalt+0

Arbeitsblatt > Zellen einfügen Strg+Plus

Arbeitsblatt > Zellen löschen Strg+Minus

Weiteres > Neu berechnen F9

Nur aktuelles Arbeitsblatt neu berechnen Umschalt+F9

Weiteres > Diagramme aktualisieren F8

Weitere nützliche Tastenkürzel

Befehl Tastenkürzel

Ribbon ein-/ausblenden Strg+F1

Zur nächsten Ribbon-Karte Strg+F12

Zur vorherigen Ribbon-Karte Strg+Umschalt+F12

Zum nächsten Arbeitsblatt
(bei geöffneten Dialogen: zur nächsten Karteikarte)

Strg+Tab

Zum vorherigen Arbeitsblatt
(bei geöffneten Dialogen: zur vorherigen Karteikarte)

Strg+Umschalt+Tab

Tastenkürzel in der Mac-Version

Anmerkung: Bei den meisten Tastenkürzeln mit der Cmd-Taste lässt sich alternativ auch die Ctrl-Taste
statt der Cmd-Taste verwenden. Für das Tastenkürzel Cmd+S können Sie also wahlweise auch Ctrl+S
drücken.

In der Mac-Version gibt es folgende Tastenkürzel:
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Tastenkürzel zum Editieren von Tabellen

Befehl Tastenkürzel

Zur nächsten Zelle ß/à/á/â

Zur nächsten / vorherigen Zelle horizontal Tab / Umschalt+Tab

Zur nächsten / vorherigen Zelle vertikal Eingabetaste / Umschalt+Eingabetaste

Zur nächsten ausgefüllten Zelle Cmd + ß/à/á/â

Zur ersten Zelle der aktuellen Spalte Cmd+Bildá

Zur letzten Zelle der aktuellen Spalte Cmd+Bildâ

Zur ersten Zelle der aktuellen Zeile Pos1

Zur letzten ausgefüllten Zelle der aktuellen Zeile Ende

Zur ersten Zelle der Tabelle (Zelle A1) Cmd+Pos1

Zur letzten ausgefüllten Zelle der Tabelle Cmd+Ende

Zur nächsten zirkulären Verknüpfung Umschalt+F5

Zum nächsten Fehler Cmd+F3

Zelle über der aktuellen Zelle kopieren Cmd+, (Komma)

Wert aus Zelle über der aktuellen Zelle kopieren Cmd+Umschalt+, (Komma)

Matrixformel eingeben Cmd+Umschalt+¿

Matrixformel selektieren Cmd+7

Bedingtes Format selektieren Cmd+6

Auswahlliste mit den Zellinhalten direkt oberhalb oder unter-
halb der Zelle öffnen

Alt+Umschalt+â

Umschalten zwischen den Eingabemodi AUTO und TEXT (sie-
he Abschnitt Statuszeile)

Cmd+Umschalt+F4

Langen Gedankenstrich einfügen (Geviertstrich —) Cmd+Alt+Minus(Nummernblock)

Geschütztes Leerzeichen einfügen
 (nicht-trennendes Leerzeichen)

Cmd+Umschalt+Leertaste

Hexadezimalen Zeichencode in Unicode-Zeichen wandeln* Cmd+Alt+Umschalt+X

* Tippen Sie beispielsweise 20AC ein und betätigen dann diese Tastenkombination, erscheint ein Eurozeichen (da dieses Zeichen im Unicode-Zei-
chensatz den Code 20AC hat).
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Tastenkürzel für Menübefehle

Menübefehl Tastenkürzel

Datei > Neu Cmd+N

Datei > Öffnen Cmd+O

Datei > Schließen Cmd+W oder Cmd+F4

Datei > Speichern Cmd+S

Datei > Dateimanager F12

Datei > Drucken Cmd+P

Datei > Beenden Cmd+Q oder Alt+F4

Bearbeiten > Rückgängig Cmd+Z

Bearbeiten > Wiederherstellen Cmd+Y

Bearbeiten > Wiederholen Cmd+Umschalt+Y

Bearbeiten > Ausschneiden Cmd+X

Bearbeiten > Kopieren Cmd+C

Bearbeiten > Einfügen Cmd+V

Bearbeiten > Inhalte einfügen Cmd+Alt+V

Bearbeiten > Alles markieren Cmd+A

Bearbeiten > Suchen Cmd+F

Bearbeiten > Ersetzen Cmd+H

Bearbeiten > Suchen wiederholen F3

Bearbeiten > Gehe zu Cmd+G oder F5

Ansicht > Vollbild F6

Format > Zelle Cmd+1

Zahlenformat: Zahl Cmd+Umschalt+1

Zahlenformat: Wissenschaftlich Cmd+Umschalt+2

Zahlenformat: Währung Cmd+Umschalt+4

Zahlenformat: Prozent Cmd+Umschalt+5

Format > Zeichen Cmd+2

Schriftart in der Formatleiste wählen Cmd+D
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Menübefehl Tastenkürzel

Fettdruck ein-/ausschalten Cmd+Umschalt+F oder Cmd+B

Kursivschrift ein-/ausschalten Cmd+Umschalt+K oder Cmd+I

Unterstreichen ein-/ausschalten Cmd+Umschalt+U

Hochstellen Cmd+Umschalt+Plus(Nummernblock)

Tiefstellen Cmd+Umschalt+Minus(Nummernblock)

Hoch-/Tiefstellen abschalten Cmd+Umschalt+*(Nummernblock)

Ausrichtung: Standard Cmd+T

Ausrichtung: Linksbündig Cmd+L

Ausrichtung: Zentriert Cmd+E

Ausrichtung: Rechtsbündig Cmd+R

Ausrichtung: Blocksatz Cmd+J

Format > Hyperlink Cmd+K

Format > Format übertragen (Schritt kopieren) Cmd+Umschalt+C

Format > Format übertragen  (Schritt einfügen) Cmd+Umschalt+V

Einfügen > Funktion F7

Einfügen > Kommentar Umschalt+F2

Aktuelles Datum einfügen Cmd+. (Punkt)

Aktuelle Uhrzeit einfügen Cmd+Umschalt+. (Punkt)

Aktuelle Zeile ausblenden Cmd+9

Aktuelle Zeile einblenden Cmd+Umschalt+9

Aktuelle Spalte ausblenden Cmd+0

Aktuelle Spalte einblenden Cmd+Umschalt+0

Arbeitsblatt > Zellen einfügen Cmd+Plus

Arbeitsblatt > Zellen löschen Cmd+Minus

Weiteres > Neu berechnen F9

Nur aktuelles Arbeitsblatt neu berechnen Umschalt+F9

Weiteres > Diagramme aktualisieren F8
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Weitere nützliche Tastenkürzel

Befehl Tastenkürzel

Ribbon ein-/ausblenden Cmd+F1

Zur nächsten Ribbon-Karte Cmd+F12

Zur vorherigen Ribbon-Karte Cmd+Umschalt+F12

Zum nächsten Arbeitsblatt
(bei geöffneten Dialogen: zur nächsten Karteikarte)

Cmd+Tab

Zum vorherigen Arbeitsblatt
(bei geöffneten Dialogen: zur vorherigen Karteikarte)

Cmd+Umschalt+Tab
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#
#BEZUG!   416

#DIV/0!   416

#FEHLER!   416

#NAME?   416

#NV   416, 483, 531, 587

#WERT!   416

#ZAHL!   416

$
$-Zeichen   412

%
%-Zeichen (Operator)   409

3
3D-Ansicht  

bei Diagrammen   283

3D-Effekt  
bei Objekten   233

A
ABRUNDEN (Abrunden auf n Stellen)   422

Abrunden auf ein Vielfaches von n  
(UNTERGRENZE)   669

ABS (Absolutbetrag)   422

Absatz   184, 186, 305

Abschreibung  
arithmetisch-degressiv (DIA)   476
geometrisch-degressiv (GDA)   497
geometrisch-degressiv (GDA2)   498
linear (LIA)   553

Absolutbetrag (ABS)   422

Absolute Zellbezüge   412

Abstand zur Blattkante   209

Achsen (in Diagrammen)   274, 276, 277

ACHSENABSCHNITT (Achsenabschnitt einer  
Regressionsgeraden)   423

Addition (Operator)   409

ADRESSE (Zelladresse als Text ausgeben)   424

Aktualisieren   49, 97

Aktualisierungen suchen   370

Alle schließen (Fenster)   354

Alles markieren   55

Alles speichern (Datei)   39

Analysieren von Tabellen   90

Änderungsdatum   213

Annuität  

siehe RMZ   618

Anpassen  
Benutzerdefinierte Symbole erstellen   399
Symbolleisten anpassen   388
Tastenkürzel anpassen   400

Ansicht > Beobachtungsfenster   92

Ansicht > Fingereingabemodus   363

Ansicht > Fixieren   154

Ansicht > Formelanzeige   90

Ansicht > Objektmodus   224

Ansicht > Originalgröße   383

Ansicht > Symbolleisten   384

Ansicht > Syntaxhervorhebung   91

Ansicht > Vergrößerungsstufe   383

Ansicht > Vollbild   383

Ansicht > Zeilen- &amp; Spaltenköpfe   381

ANSI-Code eines Zeichens (CODE)   458

Antialiasing   363

ANZAHL (Wie viele Zellen mit Zahlen ausgefüllt?)   425

ANZAHL2 (Wie viele Zellen ausgefüllt?)   425

ANZAHLLEEREZELLEN (Wie viele Zellen leer?)   426

ANZAHLP (PlanMaker97-Kompatibilitätsfunktion)   426

Arabische Schriftzeichen   349, 359

Arbeitsblatt   72
Ausblenden   74
Eigenschaften ändern   74, 381
Einblenden   74
Einfügen   73
Kopieren   74
Löschen   74
Umbenennen   74
Verschieben   74

Arbeitsblatt > Blatt   73, 74

Arbeitsblatt > Daten konsolidieren   104, 106, 108, 110

Arbeitsblatt > Eigenschaften   74, 381

Arbeitsblatt > Entfernen  
Doppelte Zeilen   60
Leere Zeilen   59

Arbeitsblatt > Externe Bezüge   415

Arbeitsblatt > Filter  
AutoFilter   84
Spezialfilter   88

Arbeitsblatt > Gliederung  
Gliederung entfernen   321
Gliederungsfeld automatisch einblenden   322, 323
Gruppieren   321
Gruppierung aufheben   321
Optionen   323

Arbeitsblatt > Kopierte Zellen einfügen   61

Arbeitsblatt > Namen   76, 79
Anwenden   80
Bearbeiten   76
Liste einfügen   78
Übernehmen   78

Arbeitsblatt > Neue Pivot-Tabelle   123
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Arbeitsblatt > Neue Tabelle   111, 112

Arbeitsblatt > Pivot-Tabellenbereiche ändern   150

Arbeitsblatt > Sortieren   81

Arbeitsblatt > Spalte  
Ausblenden   161
Breite   160
Einblenden   161
Optimale Breite   160

Arbeitsblatt > Tabelle  
Einfügen   114
Ergebniszeile   116
In Bereich konvertieren   113
Kopfzeile   116
Löschen   114
Selektieren   114
Tabelle löschen   113
Tabellenbereich   114
Tabelleneigenschaften   116

Arbeitsblatt > Tabelle > Pivot-Tabelle erstellen   123

Arbeitsblatt > Text in Spalten aufteilen   83

Arbeitsblatt > Transponieren   82

Arbeitsblatt > Zeile  
Ausblenden   161
Einblenden   161
Höhe   160
Optimale Höhe   160

Arbeitsblatt > Zellen einfügen   60

Arbeitsblatt > Zellen löschen   59

Arbeitsblattregister   73, 357, 376

Arbeitsmappe   72

Arbeitsmappenschutz   339

ARBEITSTAG (Datum nach x Arbeitstagen)   427

Arbeitstage zählen (NETTOARBEITSTAGE)   579

ARCCOS (Arcuscosinus)   428

ARCCOSHYP (Arcuscosinus Hyperbolicus)   429

ARCCOT (Arcuscotangens)   429

ARCCOTHYP (Arcuscotangens Hyperbolicus)   430

ARCSIN (Arcussinus)   430

ARCSINHYP (Arcussinus Hyperbolicus)   431

ARCTAN (Arcustangens)   432

ARCTAN2 (Arcustangens)   432

ARCTANHYP (Arcustangens Hyperbolicus)   433

Arcuscosinus (ARCCOS)   428

Arcuscosinus Hyperbolicus (ARCCOSHYP)   429

Arcuscotangens (ARCCOT)   429

Arcuscotangens Hyperbolicus (ARCCOTHYP)   430

Arcussinus (ARCSIN)   430

Arcussinus Hyperbolicus (ARCSINHYP)   431

Arcustangens  
ARCTAN   432
ARCTAN2   432

Arcustangens Hyperbolicus (ARCTANHYP)   433

Asiatische Schriftzeichen   359

AUFRUNDEN (Aufrunden auf n Stellen)   433

Aufrunden auf ein Vielfaches von n  
(OBERGRENZE)   588

Ausblenden von Zellen  
manuell   161
mittels einer Gliederung   320

Ausfüllen   67

Ausfüllen von Zellen (automatisch)   67

Ausrichten oder verteilen (Objekt)   228

Ausrichtung  
bei Textrahmen   239
der Druckseiten   209
von Zellinhalten   175

Ausschneiden   62

AUSWAHL (Ist x>0, x=0 oder x&lt;0?)   434

Auswahlliste (Formularobjekt)   294

Auto-Eingabemodus   31

AutoFilter   84

AutoFormat   196

AutoFormen  
Eigenschaften ändern   254
Text hinzufügen   253
Zeichnen   251

Automatisch berechnen   378

Automatische Prozentwerteingabe   360

Automatische Wiederherstellung   368

Autosumme   638

B
B (Kompatibilitätsfunktion)   435

BAK-Dateien   316

Balkendiagramm   260

Barwert (BW)   453

BasicMaker   352

BASIS (Dezimalzahl in anderes Zahlensystem  
wandeln)   436

Bearbeiten > Alles markieren   55

Bearbeiten > Ausfüllen   67

Bearbeiten > Ausschneiden   62

Bearbeiten > Duplizieren   228

Bearbeiten > Einfügen   62

Bearbeiten > Ersetzen   218

Bearbeiten > Ersetzen wiederholen   218

Bearbeiten > Gehe zu   220

Bearbeiten > Gehe zu Hyperlink   324

Bearbeiten > Inhalte einfügen   64

Bearbeiten > Kopieren   62

Bearbeiten > Löschen   35, 58

Bearbeiten > Rückgängig   36, 54

Bearbeiten > Selektiv löschen   58

Bearbeiten > Suchen   217, 218

Bearbeiten > Suchen wiederholen   218

Bearbeiten > Verknüpfungen   248
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Bearbeiten > Wiederherstellen   36, 54

Bearbeiten > Wiederholen   54

Bearbeitungsleiste   28

Bedingte Formatierung   197
Neue Regel   197
Regeln in den markierten Zellen löschen   203
Regeln verwalten   201

Bedingung  
AUSWAHL   434
WENN   686

Beenden (Datei)   39

Beim Speichern nach Dokumentinfo fragen   368

Benannte Bereiche   79

Benutzerdaten   359

Benutzerdaten ausgeben (BENUTZERFELD)   436

Benutzerdefinierte Zahlenformate   163, 166, 167

BENUTZERFELD (Benutzerdaten ausgeben)   436

Benutzeroberfläche (Ribbon oder Menüs mit  
Symbolleisten?)   363

Benutzerwörterbücher   304

Beobachtungsfenster   92

BEREICH.VERSCHIEBEN (Versetzter Zellbezug)   438

BEREICHE (Zahl der Bereiche)   438

Bereiche benennen   76

Beschnitt (von Grafiken)   243, 244

Bessel   439, 440

BESSELI (Modifizierte Besselfunktion erster Art)   439

BESSELJ (Besselfunktion erster Art)   439

BESSELK (Modifizierte Besselfunktion  
zweiter Art)   440

BESSELY (Besselfunktion zweiter Art)   440

Bestimmtheitskoeffizient  
(BESTIMMTHEITSMASS)   441

BESTIMMTHEITSMASS  
(Bestimmtheitskoeffizient)   441

BETA.INV (Quantile einer Betaverteilung)   442

BETA.VERT (Betaverteilung)   443

BETAINV (Quantile einer Betaverteilung)   441

BETAVERT (Betaverteilung)   443

Betaverteilung  
BETA.INV   442
BETA.VERT   443
BETAINV   441
BETAVERT   443

Bildlaufleiste (Formularobjekt)   298

Bildlaufleiste ein-/ausschalten   376

Bildschirmschriftarten glätten   363

Binärzahl in Dezimalzahl wandeln (BININDEZ)   444

Binärzahl in Hexadezimalzahl wandeln  
(BININHEX)   445

Binärzahl in Oktalzahl wandeln (BININOKT)   446

BININDEZ (Binärzahl in Dezimalzahl wandeln)   444

BININHEX (Binärzahl in Hexadezimalzahl  

wandeln)   445

BININOKT (Binärzahl in Oktalzahl wandeln)   446

BINOM.INV (Binomialverteilung)   447

BINOM.VERT (Binomialverteilung)   449

BINOM.VERT.BEREICH (Binomialverteilung)   450

Binomialverteilung  
BINOM.INV   447
BINOM.VERT   449
BINOM.VERT.BEREICH   450
BINOMVERT   448
KRITBINOM   547
NEGBINOM.VERT   578
NEGBINOMVERT   577

BINOMVERT (Binomialverteilung)   448

Blasendiagramm   260

Blatt (Menü Arbeitsblatt)   73, 74

BLATT (Nummer eines Arbeitsblatts)   451

BLATTNAME (Name eines Tabellenblatts)   452

BLATTNUMMER (Kompatibilitätsfunktion)   452

Blattschutz   336, 337

Blattschutz aufheben   338

Blocksatz, vertikaler   239

Bodenfläche (in Diagrammen)   269

BOGENMASS (Grad in Bogenmaß umwandeln)   453

Bogenmaß in Grad umwandeln (GRAD)   502

Börsendiagramm   260

Boxplot-Diagramm   260

Box-Whisker-Plot   260

Breite einer Spalte ändern   159

Bruch (Zahlenformat)   163

Buchhaltung (Zahlenformat)   163

BW (Barwert)   453

C
CHIINV (Quantile einer Chi-Quadrat-Verteilung)   454

CHIQU.INV.RE (Quantile einer Chi-Quadrat-  
Verteilung)   455

CHIQU.TEST (Chi-Quadrat-Unabhängigkeitstest)   456

CHIQU.VERT.RE (Chi-Quadrat-Verteilung)   456

Chi-Quadrat-Unabhängigkeitstest  
CHIQU.TEST   456
CHITEST   457

Chi-Quadrat-Verteilung  
CHIINV   454
CHIQU.INV.RE   455
CHIQU.VERT.RE   456
CHIVERT   457

CHITEST (Chi-Quadrat-Unabhängigkeitstest)   457

CHIVERT (Chi-Quadrat-Verteilung)   457

CODE (ANSI-Code eines Zeichens)   458

COS (Cosinus)   458

COSHYP (Cosinus Hyperbolicus)   459

Cosinus (COS)   458
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Cosinus Hyperbolicus (COSHYP)   459

COT (Cotangens)   459

Cotangens (COT)   459

Cotangens Hyperbolicus (COTHYP)   460

COTHYP (Cotangens Hyperbolicus)   460

CSV-Dateiformat   344

D
DATEDIF (Datumsdifferenz)   461

Datei > Alles speichern   39

Datei > Als PDF-Dokument exportieren   331

Datei > Beenden   39

Datei > Dateimanager   313

Datei > Druckbereich  
Druckbereich entfernen   210
Druckbereich festlegen   210

Datei > Drucken   328

Datei > Druckvorschau   327

Datei > Eigenschaften   374
Karteikarte Berechnen   378
Karteikarte Farben   374
Karteikarte Infos   313, 374
Karteikarte Optionen   376
Karteikarte Schriften   381
Karteikarte Schutz   340, 381
Karteikarte Statistik   376

Datei > Holen   241

Datei > Neu   36, 194, 195

Datei > Öffnen   37, 195, 343

Datei > Quelle wählen   241

Datei > Schließen   354

Datei > Seite einrichten   209, 210, 213

Datei > Speichern   39

Datei > Speichern unter   39, 343

Datei > Versenden   335

Datei > Zurück zu vorheriger Version   316

Dateierweiterungen verknüpfen   370

Dateiformat   343

Dateiformate   343

Dateimanager   313

DATEINAME (Dateiname des Dokuments)   462

Dateityp   343

Daten in Zellen eingeben   51

Daten konsolidieren   104, 106, 108, 110

Datenbankfunktionen   420
DBANZAHL   464
DBAUSZUG   465
DBMAX   466
DBMIN   466
DBMITTELWERT   467
DBPRODUKT   467
DBSTDABW   468
DBSTDABWN   469

DBSUMME   469
DBVARIANZ   470
DBVARIANZEN   470

Datenbereich (von Diagrammen)   281

Datenpunkte (in Diagrammen)   270

Datenquelle (von Diagrammen)   281

Datenreihen (in Diagrammen)   270, 281

Datum  
aktuelles (HEUTE)   506
aktuelles, mit Uhrzeit (JETZT)   535
Datumswert bilden (DATUM)   462
Eingeben   51

DATUM (Datumswert bilden)   462

Datum des Erstellens eines Dokuments  
(ERSTELLDATUM)   478

Datum in/vor n Monaten (EDATUM)   476

Datum/Zeit (Zahlenformat)   163

Datumsdifferenz (DATEDIF)   461

Datumsfilter (AutoFilter)   84

DATWERT (Text in Datum wandeln)   463

DBANZAHL (Datenbankfunktion)   464

dBase-Dateiformat   343

DBAUSZUG (Datenbankfunktion)   465

DBMAX (Datenbankfunktion)   466

DBMIN (Datenbankfunktion)   466

DBMITTELWERT (Datenbankfunktion)   467

DBPRODUKT (Datenbankfunktion)   467

DBSTDABW (Datenbankfunktion)   468

DBSTDABWN (Datenbankfunktion)   469

DBSUMME (Datenbankfunktion)   469

DBVARIANZ (Datenbankfunktion)   470

DBVARIANZEN (Datenbankfunktion)   470

DELTA (Prüfen auf Gleichheit zweier Werte)   471

Design Science   250

Determinante einer Matrix (MDET)   560

DEZIBEL (Dezibelwert zweier Größen)   472

DEZIMAL (Zahl aus anderem Zahlensystem  
umwandeln)   472

Dezimaltrenner nach Zahleneingabe verschieben   376

Dezimalzahl in anderes Zahlensystem  
wandeln (BASIS)   436

Dezimalzahl in Binärzahl wandeln (DEZINBIN)   473

Dezimalzahl in Hexadezimalzahl wandeln  
(DEZINHEX)   474

Dezimalzahl in Oktalzahl wandeln (DEZINOKT)   475

DEZINBIN (Dezimalzahl in Binärzahl wandeln)   473

DEZINHEX (Dezimalzahl in Hexadezimalzahl  
wandeln)   474

DEZINOKT (Dezimalzahl in Oktalzahl wandeln)   475

DIA (Arithmetisch-degressive Abschreibung)   476

Diagramme   258
Aktualisieren   284, 378
Als Grafik speichern   285
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Diagramme   258
Anordnung der Datenreihen ändern   264, 281
Bearbeiten   259
Daten in Spalten   264
Daten in Zeilen   264
Diagrammeigenschaften ändern   280
Diagrammelemente bearbeiten   265
Diagrammtyp ändern   260
Einfügen   259
Gitternetzlinien anzeigen   278
Position des Diagramms ändern   285
Trendlinie hinzufügen   273

Diagrammfläche (in Diagrammen)   267

Diagrammleiste   259

Diagrammtitel   283

Diagrammtyp   260

Dialogsprache   363

Division (Operator)   409

Dokument drucken   328

Dokument schließen   354

Dokument skalieren   363

Dokumenteigenschaften   374
Karteikarte Berechnen   378
Karteikarte Farben   374
Karteikarte Infos   374
Karteikarte Optionen   376
Karteikarte Schriften   381
Karteikarte Schutz   381
Karteikarte Statistik   376

Dokumentfenster   353

Dokumentinfos   313

Dokumentschutz   340

Dokumentstatistik   376

Dokumentvorlagen   194, 195

Doppelte Zeilen entfernen   60

Drag and Drop   62

Drehen  
Achsenbeschriftungen   274, 276, 277
Objekte   227, 229
Text in AutoFormen   255
Text in Textrahmen   239
Zellinhalte   175

Drehen oder Kippen (von Objekten)   227

Drehfeld (Formularobjekt)   297

Dreidimensionale Berechnungen   45, 75

Druckbereich   210
Druckbereich entfernen   210
Druckbereich festlegen   210

Druckdatum   213

Drucken   328

Druckrichtung   210

Druckvorschau   327

Druckzeit   213

Duplikate entfernen   60

Duplizieren   228

Durchstreichen   180

E
Echtzeitvorschau   363

Ecken (in Diagrammen)   269

EDATUM (Datum in/vor n Monaten)   476

Editiermodus   224

Effekte (bei Objekten)   233

EFFEKTIV (Effektivzins)   477

Effektivzins (EFFEKTIV)   477

Eigenschaften (Menü Arbeitsblatt)   74, 381

Eigenschaften (Menü Datei)   374
Karteikarte Berechnen   378
Karteikarte Farben   374
Karteikarte Infos   313, 374
Karteikarte Optionen   376
Karteikarte Schriften   381
Karteikarte Schutz   340, 381
Karteikarte Statistik   376

Eigenschaften (Menü Objekt)  
Allgemeine Eigenschaften   228
Bei Auswahllisten   294
Bei Bezeichnungen   299
Bei Bildlaufleisten   298
Bei Diagrammen   260, 280
Bei Drehfeldern   297
Bei Grafiken   243
Bei Gruppenfeldern   299
Bei Kontrollkästchen   291
Bei Listen   295
Bei OLE-Objekten   248
Bei Optionsfeldern   293
Bei Schaltflächen   296
Bei Textrahmen   239
Bei Zeichnungen   254
Standardeinstellungen ändern   235

Eigenschaften der Arbeitsmappe   374

Einblenden von Zellen   161

Einfügen   62
kopierte Zellen   61
Spalten   60
Zeilen   60
Zellen   60

Einfügen > Funktion   410

Einfügen > Kommentar   98

Einfügen > Kopf- und Fußzeile   213

Einfügen > Seitenumbruch   216

Einfügen > Sonderzeichen   155

Einfügen > Textbaustein   308, 309

Einstellungen (PlanMaker)   356, 357
Karteikarte Allgemein   359
Karteikarte Ansicht   357
Karteikarte Aussehen   363
Karteikarte Bearbeiten   360
Karteikarte Dateien   368
Karteikarte Schriften   373
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Einstellungen (PlanMaker)   356, 357
Karteikarte Sprache   367
Karteikarte System   370

Einzüge   184

Ellipsen  
Eigenschaften ändern   254
Zeichnen   251

E-Mail   335

Endergebnisse runden   378

Entfernen  
Doppelte Zeilen   60
Leere Zeilen   59

Ersetzen (Menü Bearbeiten)   218

ERSETZEN (Text in Zeichenkette ersetzen)   478

Ersetzen wiederholen (Menü Bearbeiten)   218

Erste Spalte hervorheben   116

Erstelldatum   213

ERSTELLDATUM (Datum des Erstellens  
eines Dokuments)   478

Erweiterte Unterstützung für arabischen Text   349, 359

Erweiterte Unterstützung für asiatische Schriften   359

EUROCONVERT (Euro-Währungen konvertieren)   479

Euro-Währungen konvertieren (EUROCONVERT)   479

Excel-Dateiformat   290, 343, 346, 348

EXP (e hoch x)   480

EXPON.VERT (Exponentialverteilung)   482

Exponentialverteilung  
EXPON.VERT   482
EXPONVERT   481

Exponentielle Regression  
Kenngrößen (RKP)   617
Werte (VARIATION)   672

EXPONVERT (Exponentialverteilung)   481

Export (eines Fremdformats)   343

Externe Bezüge  
Aktualisieren   415
Eingeben   413
Verwalten   415

Externe Zellbezüge   413

F
F.INV.RE (Quantile einer F-Verteilung)   487

F.TEST (F-Test)   490

F.VERT.RE (F-Verteilung)   491

FAKULTÄT (Fakultät)   482

FALSCH (Wahrheitswert)   483

Farbe  
von Objekten   230
von Text   181
von Zellen   174

Farbpalette bearbeiten   374

Farbverlauf (bei Objekten)   230

FEHLER.TYP (Fehlerwerte abfragen)   483

Fehlerfunktion  
GAUSSFEHLER   497
GAUSSFKOMPL (Komplement)   497

Fehlerindikator (in Diagrammen)   270

Fehlerwerte   96, 416

Fehlerwerte abfragen (FEHLER.TYP)   483

FEIERTAG (Datum von beweglichen Feiertagen)   484

Felder (für Kopf-/Fußzeilen)   213

Fenster > Alle schließen   354

Fenster > Nebeneinander anzeigen   355

FEST (Zahl mit festen Nachkommastellen  
formatieren)   485

Fett   180

Filter   84, 654
AutoFilter   84
Spezialfilter   88

FINDEN (Text in Zeichenkette suchen)   486

Fingereingabemodus   363

FINV (Quantile einer F-Verteilung)   487

FISHER (Fisher-Transformation)   488

FISHERINV (Umkehrung der Fisher-  
Transformation)   489

Fixieren (Ansicht)   154

Flächendiagramm   260

Format > Absatz   184, 186, 305

Format > AutoFormat   196

Format > Bedingte Formatierung   197
Neue Regel   197
Regeln in den markierten Zellen löschen   203
Regeln verwalten   201

Format > Format übertragen   208

Format > Gültigkeitsprüfung   96, 204

Format > Hyperlink   324

Format > Hyperlink entfernen   324

Format > Schattierung   174

Format > Standard   183

Format > Umrandung   171

Format > Zeichen   178, 180, 181, 182, 183

Format > Zeichenvorlage   187, 188, 189

Format > Zelle  
Karteikarte Ausrichtung   175
Karteikarte Schattierung   174
Karteikarte Schutz   337
Karteikarte Umrandung   171
Karteikarte Zahlenformat   162, 163, 166

Format > Zellenvorlage   190, 191, 193

Format übertragen   208

Formatleiste   28, 180

Formel einer Zelle anzeigen (FORMELTEXT)   489

Formelanzeige (Ansicht)   90

Formeleditor   250

Formeln   408

FORMELTEXT (Formel einer Zelle anzeigen)   489
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Formelüberwachung   93, 94, 95, 96

Formelüberwachungsleiste   93

Formulare   287

Formularleiste   288

Fraktil (siehe QUANTIL)   601, 602

Freihandformen  
Eigenschaften ändern   254
Zeichnen   251

Fremdformate   343

F-Test  
F.TEST   490

FTEST (F-Test)   490

F-Test (FTEST)   490

Füllung  
von Objekten   230
von Zellen   174

Funktionen   408
Einfügen   410
Funktionen von A-Z   421

Funktionsleiste   27

Fußzeile   213

FVERT (F-Verteilung)   491

F-Verteilung  
F.INV.RE   487
F.VERT.RE   491
FINV   487
FVERT   491

G
G.TEST (Gauß-Test)   504

GAMMA (Gammafunktion)   492

GAMMA.INV (Quantile einer Gammaverteilung)   493

GAMMA.VERT (Gammaverteilung)   495

Gammafunktion  
GAMMA   492
GAMMALN   494

GAMMAINV (Quantile einer Gammaverteilung)   492

GAMMALN (Logarithmus der Gammafunktion)   494

GAMMAVERT (Gammaverteilung)   494

Gammaverteilung  
GAMMA.INV   493
GAMMA.VERT   495
GAMMAINV   492
GAMMAVERT   494

GANZZAHL (Runden auf ganze Zahl)   495

GAUSS (Standardnormalverteilung)   496

GAUSSFEHLER (Gaußsche Fehlerfunktion)   497

GAUSSFKOMPL (Komplement zur Gaußschen  
Fehlerfunktion)   497

Gaußsche Fehlerfunktion  
GAUSSFEHLER   497
GAUSSFKOMPL   497

Gauß-Test  
G.TEST   504

GTEST   504

Gauß-Verteilung (NORM.VERT)   585

Gauß-Verteilung (NORMVERT)   584

GDA (Geometrisch-degressive Abschreibung)   497

GDA2 (Geometrisch-degressive Abschreibung)   498

Gebänderte Zeilen und Spalten   116

Gehe zu   220

Gehe zu Hyperlink   324

Genauigkeit wie angezeigt   378

Geometrisches Mittel (GEOMITTEL)   499

GEOMITTEL (Geometrisches Mittel)   499

GERADE (Aufrunden auf eine gerade Zahl)   499

GESTUTZTMITTEL (Mittelwert ohne Randwerte)   500

GGANZZAHL (Zahl größer gleich  
Schwellenwert?)   501

GGT (Größter gemeinsamer Teiler)   501

Gipfligkeit einer Verteilung (KURT)   550

Gitternetzlinien  
in Diagrammen   278
zwischen Tabellenzellen   381

GLÄTTEN (Überflüssige Leerzeichen entfernen)   502

Gleichheit zweier Werte (DELTA)   471

Gliederungen   320, 321, 322, 323
Ein- und Ausblenden von gruppierten Zellen   321,
322
Einstellungen ändern   323
Gliederung entfernen   321
Gliederungsfeld automatisch einblenden   322, 323
Gruppieren   321
Gruppierung aufheben   321
Optionen   323

Gliederungsansicht schützen   323

Gliederungsfeld   320, 323

Gliederungsleiste   320

GRAD (Bogenmaß in Grad umwandeln)   502

Grad in Bogenmaß umwandeln (BOGENMASS)   453

Grafiken   240
Eigenschaften ändern   243
Einfügen   241
Einscannen   241
Rotieren   227

Grafiken im Speicher komprimieren   370

GROSS (In Großbuchstaben wandeln)   503

GROSS2 (In Groß-/Kleinbuchstaben wandeln)   503

Großbuchstaben   180

Größe  
von Objekten   226
von Zellen   159

Größe der Benutzeroberfläche   363

Größenachse (in Diagrammen)   276

Größter gemeinsamer Teiler (GGT)   501

Grundlagen   33

Gruppieren  
von Objekten   237
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Gruppieren  
von Zellen (Gliederung)   321
Zellen Ein-und Ausblenden   322

Gruppierung aufheben  
von Objekten   237
von Zellen (Gliederung)   321

GTEST (Gauß-Test)   504

Gültigkeitsprüfung   96, 204

H
Handbuch   21

HARMITTEL (Harmonisches Mittel)   505

Harmonisches Mittel (HARMITTEL)   505

HÄUFIGKEIT (Häufigkeitsverteilung)   505

Häufigkeitsverteilung (HÄUFIGKEIT)   505

HEUTE (Aktuelles Datum)   506

Hexadezimalzahl  
in Binärzahl wandeln (HEXINBIN)   507
in Dezimalzahl wandeln (HEXINDEZ)   508
in Oktalzahl wandeln (HEXINOKT)   508

HEXINBIN (Hexadezimalzahl in Binärzahl  
wandeln)   507

HEXINDEZ (Hexadezimalzahl in Dezimalzahl  
wandeln)   508

HEXINOKT (Hexadezimalzahl in Oktalzahl  
wandeln)   508

Hintergrundfarbe  
des Programms   363
von Text   181
von Zellen   174

Hochformat   209

Hochstellen   182

Hoch-Tief-Diagramm   260

Höhe einer Zeile ändern   159

Holen (Datei)   241

Horizontale Ausrichtung  
von Zellinhalten   175

HTML-Dokumente   326

Hunspell-Wörterbücher   367, 404

Hypergeometrische Verteilung  
HYPGEOM.VERT   511
HYPGEOMVERT   510

HYPERLINK (Funktion: Hyperlink)   509

Hyperlinks (Verknüpfungen)  
bei Objekten   234
bei Zellinhalten   324
Funktion HYPERLINK   509

Hyperlinks entfernen   324

HYPGEOM.VERT (Hypergeometrische Verteilung)  
511

HYPGEOMVERT (Hypergeometrische Verteilung)   510

I
IDENTISCH (Zeichenketten identisch?)   512

IF-Bedingung   686

Ignoriere Wörter, die mit einer Zahl beginnen   367

IKV (Interner Zinsfuß)   513

Im Dokument ablegen (Grafiken)   241

IMABS (Absolutbetrag einer komplexen Zahl)   514

IMAGINÄRTEIL (Imaginärteil einer  
komplexen Zahl)   514

IMAPOTENZ (Potenz einer komplexen Zahl)   515

IMARGUMENT (Winkel einer komplexen Zahl)   515

IMCOS (Cosinus einer komplexen Zahl)   516

IMDIV (Division komplexer Zahlen)   516

IMEXP (Algebraische Form einer komplexen Zahl)   517

IMKONJUGIERTE (Konjugiert komplexe Zahl)   517

IMLN (Natürlicher Logarithmus einer  
komplexen Zahl)   518

IMLOG10 (Zehnerlogarithmus einer  
komplexen Zahl)   518

IMLOG2 (Zweierlogarithmus einer  
komplexen Zahl)   519

IMNEG (Negativer Wert einer komplexen Zahl)   519

Import (eines Fremdformats)   343

IMPRODUKT (Produkt komplexer Zahlen)   520

IMREALTEIL (Realteil einer komplexen Zahl)   520

IMSIN (Sinus einer komplexen Zahl)   521

IMSUB (Differenz komplexer Zahlen)   521

IMSUMME (Summe komplexer Zahlen)   522

IMWURZEL (Quadratwurzel einer  
komplexen Zahl)   522

In den Ordner des Dokuments kopieren (Grafiken)   241

INDEX (Zelle in einem Bereich)   523

INDIREKT (Bezug aus Zeichenkette bilden)   523

Informationen über eine Zelle (ZELLE)   700

Inhalte einfügen   64

Innenränder  
von Text in AutoFormen   255
von Textrahmen   239
von Zellen   175

Installation  
Android   25
Linux   24
macOS   23
Windows   23

Internen Grafikcache begrenzen   370

Interner Zinsfuß  
IKV   513
QIKV   600
XINTZINSFUSS   693

Internet  
HTML-Dokumente   326

Inverse einer Matrix (MINV)   564
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ISOKALENDERWOCHE (Kalenderwoche  
nach ISO-Norm)   524

ISOWOCHE (Kalenderwoche nach ISO-Norm)   525

ISPMT (Zinszahlung)   526

ISTBEZUG (Ist ein Zellbezug?)   527

ISTFEHL (Ist ein Fehlerwert außer #NV?)   416, 527

ISTFEHLER (Ist ein Fehler?)   416, 528

ISTFORMEL (Ist eine Formel?)   528

ISTGERADE (Ist eine gerade Zahl?)   529

ISTKTEXT (Ist kein Text?)   529

ISTLEER (Ist leer?)   530

ISTLOG (Ist Wahrheitswert?)   530

ISTNV (Ist nicht vorhanden?)   531

ISTTEXT (Ist eine Zeichenkette?)   532

ISTUNGERADE (Ist eine ungerade Zahl?)   532

ISTZAHL (Ist eine Zahl?)   533

ISTZAHLP (PlanMaker 97-Kompatibilitäts-  
funktion)   534

Iterationen   378

J
JAHR (Jahr aus einem Datumswert ermitteln)   535

JETZT (Aktuelles Datum, aktuelle Uhrzeit)   535

K
Kalenderwoche  

ISOKALENDERWOCHE   524
ISOWOCHE   525

KALENDERWOCHE (Kalenderwoche)   536

Kantenglättung von Grafiken   370

Kapitälchen   180

Kapitalrückzahlung  
KAPZ   536
KUMKAPITAL (kumuliert)   548

Kapitalwert  
NBW   576
XKAPITALWERT   693

KAPZ (Kapitalrückzahlung)   536

Kegeldiagramm   260

Kenngrößen einer Regression  
RGP (linear)   615
RKP (exponentiell)   617

Kerning   183

KGRÖSSTE (k-größter Wert)   538

KGV (Kleinstes gemeinsames Vielfaches)   538

Kippen (von Objekten)   227

KKLEINSTE (k-kleinster Wert)   539

Klassische Menüs und Symbolleisten   363

KLEIN (In Kleinbuchstaben wandeln)   540

Kleinbuchstaben, wandeln in (KLEIN)   540

Kleinstes gemeinsames Vielfaches (KGV)   538

KOMBINATIONEN   540

Kommentar einfügen   98

Kommentare immer anzeigen   376

Komplexe Schriftzeichen   359

Komplexe Zahl bilden (KOMPLEXE)   541

Komplexe Zahlen  
Absolutbetrag (IMABS)   514
Algebraische Form (IMEXP)   517
Cosinus (IMCOS)   516
Differenz (IMSUB)   521
Division (IMDIV)   516
Imaginärteil (IMAGINÄRTEIL)   514
Komplexe Zahl bilden (KOMPLEXE)   541
Konjugierte (IMKONJUGIERTE)   517
Logarithmus, Zehner (IMLOG10 )   518
Logarithmus, Zweier (IMLOG2 )   519
Negativer Wert (IMNEG)   519
Potenz (IMAPOTENZ)   515
Produkt (IMPRODUKT)   520
Quadratwurzel (IMWURZEL)   522
Realteil (IMREALTEIL)   520
Sinus (IMSIN)   521
Summe (IMSUMME)   522
Winkel (IMARGUMENT)   515

KONFIDENZ (Konfidenzintervall)   543

KONFIDENZ.NORM (Konfidenzintervall)   542

Konfidenzintervall  
KONFIDENZ   543
KONFIDENZ.NORM   542

Konsolidieren von Daten   104

Kontextmenü   27

Kontrollkästchen (Formularobjekt)   291

Kopf- und Fußzeilen   213

Kopfzeilen   213

Kopieren   62

Kopierte Zellen einfügen   61

KORREL (Korrelationskoeffizient)   544

Korrelationskoeffizient  
KORREL   544
PEARSON   592

KOVAR (Kovarianz Grundgesamtheit)   544

Kovarianz  
KOVAR (Grundgesamtheit)   544
KOVARIANZ.P (Grundgesamtheit)   545
KOVARIANZ.S (Stichprobe)   546

KOVARIANZ.P (Kovarianz Grundgesamtheit)   545

KOVARIANZ.S (Kovarianz Stichprobe)   546

Kreisdiagramm   260

Kreise  
Eigenschaften ändern   254
Zeichnen   251

KRITBINOM (Binomialverteilung)   547

KUMKAPITAL (Kumulierte Kapitalrück-  
zahlung)   548

KUMZINSZ (Kumulierte Zinszahlungen)   549

Kursdiagramm   260



739Index

Kursiv   180

KURT (Kurtosis einer Verteilung)   550

Kurtosis einer Verteilung (KURT)   550

Kurven  
Eigenschaften ändern   254
Zeichnen   251

KÜRZEN (Zahl auf n Nachkommastellen kürzen)   551

L
LÄNGE (Länge einer Zeichenkette)   552

Laufweite   182

LAUFZEIT   552

Leere Zeilen löschen   59

Leerzeichen entfernen (GLÄTTEN)   502

Legende (in Diagrammen)   279

Letzte Spalte hervorheben   116

Leuchteffekt (bei Objekten)   233

LIA (Lineare Abschreibung)   553

Lineare Regression  
ACHSENABSCHNITT   423
Kenngrößen (RGP)   615
SCHÄTZER   621
Trend in Diagrammen anzeigen   273
Werte (TREND)   660

Lineares Gleichungssystem (MSOLVE)   572

Linien  
Eigenschaften ändern   254
Zeichnen   251
zur Umrandung von Objekten   231

Liniendiagramm   260

Linke Alt-Taste für Tastenkürzel verwenden   360

LINKS (Funktion: Teil einer Zeichenkette)   554

Links (Verknüpfungen)  
bei Objekten   234
bei Zellinhalten   324
Funktion HYPERLINK   509
OLE-Objekte   248

Linksbündig   175

Liste (Formularobjekt)   295

Listen editieren   402

LN (Natürlicher Logarithmus)   554

LOG (Logarithmus)   555

LOG10 (Zehnerlogarithmus)   555

Logarithmische Normalverteilung  
LOGINV   556
LOGNORM.INV   557
LOGNORM.VERT   558
LOGNORMVERT   557

Logarithmus  
natürlicher (LN)   554
Zehner (LOG10)   555
zu beliebiger Basis (LOG)   555

LOGINV (Quantile einer Lognormalverteilung)   556

LOGNORM.INV (Quantile einer Lognormal-  

verteilung)   557

LOGNORM.VERT (Logarithmische Normal-  
verteilung)   558

LOGNORMVERT (Logarithmische Normal-  
verteilung)   557

Löschen   35, 57
Doppelte Zeilen   60
Leere Zeilen   59
selektiv   58
Zellen   59
Zellinhalte   58

M
Mailen eines Dokuments   335

Makros   290, 348

Marken anzeigen   376

Markieren  
Objekte   224
Zellen   54

Markierung nach Eingabe ... bewegen   360

Maßeinheit   363

Maßeinheiten umrechnen (UMWANDELN)   665

MathType   250

Matrix  
Arbeiten mit Matrizen   417
MDET (Determinante)   560
MINV (Inverse)   564
MMULT (Multiplikation)   569
MSOLVE (Lösung eines LGS)   572
MTRANS (Transponieren)   573

Matrixfunktionen   417

MAX (Maximalwert)   559

MAXA (Maximalwert)   559

Maximal widerrufbare Aktionen   359

MDET (Determinante einer Matrix)   560

MEDIAN   561

Meldung bei fehlerhaften Formeln   360

Menüband   20, 29

Menüleiste   27

Menüs mit Symbolleisten oder Ribbon?   363

MILLISEKUNDEN (Millisekunden aus einem  
Datumswert ermitteln)   561

MIN (Minimalwert)   562

MINA (Minimalwert)   563

MINUTE (Minute aus einem Datumswert ermitteln)   563

MINV (Inverse einer Matrix)   564

MITTELABW (Mittlere Abweichung vom  
Mittelwert)   565

Mittelwert  
Arithmetisch (MITTELWERT)   565
Arithmetisch (MITTELWERTA)   566
Ausgewählter Werte (MITTELWERTWENN)   567
Ausgewählter Werte (MITTELWERTWENNS)   568
Geometrisch (GEOMITTEL)   499
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Mittelwert  
Harmonisch (HARMITTEL)   505
Ohne Randwerte (GESTUTZTMITTEL)   500

MITTELWERT (Arithmetisches Mittel)   565

MITTELWERTA (Arithmetisches Mittel)   566

MITTELWERTWENN (Mittelwert ausgewählter  
Werte)   567

MITTELWERTWENNS (Mittelwert ausgewählter  
Werte)   568

Mittlere Abweichung vom Mittelwert  
(MITTELABW)   565

Mittlere Maustaste   360

Mittlere quadratische Abweichung vom Mittelwert  
(SUMQUADABW)   645

MMULT (Multiplikation zweier Matrizen)   569

MODALWERT (Häufigster Wert)   569

Modifizierter interner Zinsfuß (QIKV)   600

Modulo   613

MODUS.EINF (Häufigster Wert)   570

MONAT (Monat aus einem Datumswert ermitteln)   571

MONATSENDE (Monatsende in/vor n Monaten)   571

MSOLVE (Lösung eines linearen Gleichungs-  
systems)   572

MTRANS (Transponieren einer Matrix)   573

MULTINOMIAL (Multinomialkoeffizient)   574

Multinomialkoeffizient  
MULTINOMIAL   574
POLYNOMIAL   597

Multiplikation (Operator)   409

Multiplikation zweier Matrizen (MMULT)   569

N
N (Wert in Zahl umwandeln)   575

Nach Produktaktualisierungen suchen   370

NACHKOMMA (Nachkommastellen einer Zahl)   575

Namen (für Zellbereiche)   76, 79
Anwenden   80
Bearbeiten   76
Liste einfügen   78
Übernehmen   78

NBW (Nettobarwert)   576

Nebeneinander anzeigen (Fenster)   355

NEG (Negativer Wert einer Zahl)   577

Negative Binomialverteilung  
NEGBINOM.VERT   578
NEGBINOMVERT   577

Negativer Wert (NEG)   577

NEGBINOM.VERT (Negative Binomialverteilung)   578

NEGBINOMVERT (Negative Binomialverteilung)   577

NETTOARBEITSTAGE (Zahl der Arbeitstage)   579

Nettobarwert  
NBW   576
XKAPITALWERT   693

Netzdiagramm   260, 284

Neu (Datei)   36, 194, 195

Neu berechnen (Tabelle)   97, 378

Neuberechnen nur vor dem ...   378

Neue Diagrammrahmen einfügen   259

Neue Grafikrahmen aus der Galerie/Kamera einfügen  
242

Neue Grafikrahmen einfügen   241

Neue OLE-Objektrahmen einfügen   245, 246

Neue Pivot-Tabelle erstellen   123

Neue Tabelle anlegen (Tabellen in Arbeitsblättern)   111,
112

Neue Textrahmen einfügen   238

Neue Zeichnungen einfügen   251

Neues Formularobjekt einfügen   288
Auswahlliste   294
Bezeichnung   299
Bildlaufleiste   298
Drehfeld   297
Gruppenfeld   299
Kontrollkästchen   291
Liste   295
Optionsfeld   292
Schaltfläche   296

Neumannfunktion (BESSELY)   440

NICHT (Logisches NICHT)   580

Nicht-druckbare Zeichen entfernen (SÄUBERN)   621

NOMINAL (Nominalverzinsung)   580

NORM.INV (Quantile einer Normalverteilung)   582

NORM.S.INV (Quantile einer  
Standardnormalverteilung)   582

NORM.S.VERT (Standardnormalverteilung)   583

NORM.VERT (Normalverteilung)   585

Normal.pmvx   195

Normalverteilung  
NORM.INV   582
NORM.VERT   585
NORMINV   581
NORMVERT   584

Normalverteilung, logarithmische  
LOGINV   556
LOGNORM.INV   557
LOGNORM.VERT   558
LOGNORMVERT   557

NORMINV (Quantile einer Normalverteilung)   581

NORMVERT (Normalverteilung)   584

NOTIERUNGBRU (Geldbetrag in Dezimalbruch  
wandeln)   586

NOTIERUNGDEZ (Geldbetrag in Dezimalzahl  
wandeln)   586

Nullwerte anzeigen/verbergen   162, 381

NV (Nicht vorhanden)   587
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O
Oberflächendiagramm   260

OBERGRENZE (Aufrunden auf ein Vielfaches  
von n)   588

Objekt > Ausrichten oder verteilen   228

Objekt > Diagramm  
Als Grafik speichern   285
Daten in Spalten   264
Daten in Zeilen   264
Gitternetzlinien anzeigen   278
Position des Diagramms ändern   285
Trendlinie hinzufügen   273

Objekt > Drehen oder Kippen   227

Objekt > Eigenschaften  
Allgemeine Eigenschaften   228
Bei Auswahllisten   294
Bei Bezeichnungen   299
Bei Bildlaufleisten   298
Bei Diagrammen   260, 280
Bei Drehfeldern   297
Bei Grafiken   243
Bei Gruppenfeldern   299
Bei Kontrollkästchen   291
Bei Listen   295
Bei OLE-Objekten   248
Bei Optionsfeldern   293
Bei Schaltflächen   296
Bei Textrahmen   239
Bei Zeichnungen   254
Standardeinstellungen ändern   235

Objekt > Gruppieren   237

Objekt > Gruppierung aufheben   237

Objekt > Neue Zeichnung   251

Objekt > Neuer Diagrammrahmen   259

Objekt > Neuer Grafikrahmen   241

Objekt > Neuer Grafikrahmen aus der Galerie   242

Objekt > Neuer Grafikrahmen von der Kamera   242

Objekt > Neuer OLE-Objektrahmen   245, 246

Objekt > Neuer Textrahmen   238

Objekt > Neues Formularobjekt   288
Auswahlliste   294
Bezeichnung   299
Bildlaufleiste   298
Drehfeld   297
Gruppenfeld   299
Kontrollkästchen   291
Liste   295
Optionsfeld   292
Schaltfläche   296

Objekt > Reihenfolge   236

Objekte   223
Ausrichten und verteilen   228
Duplizieren   228
Eigenschaften ändern   228
Einfügen   224

Größe ändern   226
Gruppieren   237
Position ändern   226
Reihenfolge ändern   236
Rotieren   227, 229
Selektieren   224
Verbergen   236
Verteilen   228

Objektleiste   224

Objektmodus   224

ODER (Logisches ODER)   588

Öffnen (Datei)   37, 195, 343

Oktalzahl  
in Binärzahl wandeln (OKTINBIN)   589
in Dezimalzahl wandeln (OKTINDEZ)   590
in Hexadezimalzahl wandeln (OKTINHEX)   591

OKTINBIN (Oktalzahl in Binärzahl wandeln)   589

OKTINDEZ (Oktalzahl in Dezimalzahl wandeln)   590

OKTINHEX (Oktalzahl in Hexadezimalzahl  
wandeln)   591

OLE-Objekte   245
Bearbeiten   247
Eigenschaften ändern   248
Einfügen   246
Verknüpfungen   248

Online-Berechnung   360

OpenGL-Bibliothek verwenden   370

Operatoren in Berechnungen   409

Optimale Breite   160

Optimale Höhe   160

Optionsfeld (Formularobjekt)   292

Originalgröße (Ansicht)   383

P
Papiergröße   209

Papierschacht   209

Papierschächte   209

Pascal-Verteilung  
NEGBINOM.VERT   578
NEGBINOMVERT   577

PDF-Export   331

PEARSON (Pearsonscher Korrelationskoeffizient)   592

PHI (Standardnormalverteilung)   592

PI (Kreiszahl Pi)   593

PIVOTDATENZUORDNEN   593

Pivot-Tabellen   121
Aktualisieren   150
Alphabetisch sortieren (Felder im Pivotbericht)   148
Alphabetisch sortieren (Felder in der Feldliste)   132
Beim Öffnen der Datei aktualisieren   144, 150
Benutzerdefinierter Name für Felder   132, 133, 137,
142
Benutzerdefinierter Name für Pivot-Tabelle   144
Berichtsfilter   127, 148
Berichtslayout (Feldeinstellungen)   137
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Pivot-Tabellen   121
Erstellen aus externen Daten   125
Erstellen aus Tabellen in Arbeitsblättern   123
Erstellen aus vorliegenden Daten   124
Feldeinstellungen   137
Felder verschieben & entfernen   133
Feldliste: Bereicheabschnitt   133
Feldliste: Feldabschnitt   132
Feldliste: Gestalten der Pivot-Tabelle   136
Feldliste: Startbild   127
Feldliste: Übungen   128
Feldliste: weitere Optionen   135
Filterbeschreibungen/Filterwerte   148
Filtern   148
Gliederungsformat   137
Kopieren   152
Layout (Pivot-Tabelleneinstellungen)   144
Layoutaktualisierung zurücksetzen   147
Löschen   152
Pivot-Tabellenbereiche ändern   150
Pivot-Tabelleneinstellungen   144
Quelldaten in der Datei speichern   144
Quelldatenbereich ändern   150
Spaltenbeschriftungen   127
Tabellenformat   137
Teilergebnisse   137
Verschieben   152
Vorlagen für Pivot-Tabellen   144
Werte-Bereich   127
Werteeinstellungen   142
Zahlenformat   142
Zeilenbeschriftungen   127

PlanMaker-Dateiformat   343

PlanMaker-Tour   40

PMBAK-Dateien   316

PMD-Dateiformat   343

PMDX-Dateiformat   343

POISSON (Poisson-Verteilung)   595

POISSON.VERT (Poisson-Verteilung)   596

Poisson-Verteilung  
POISSON   595
POISSON.VERT   596

POLYNOMIAL (Polynomialkoeffizient)   597

Polynomialkoeffizient  
MULTINOMIAL   574
POLYNOMIAL   597

Position  
von Objekten   226

Position eines Werts in einem Bereich  
(VERGLEICH)   676

POTENZ (Potenzierung)   598

Potenzierung  
Funktion POTENZ   598
Operator   409

POTENZREIHE (Potenzreihe)   598

Primäre Achsen (in Diagrammen)   283

PRODUKT (Produkt)   599

Prozent (Zahlenformat)   163

Prozentzeichen (Operator)   409

Pyramidendiagramm   260

Q
QIKV (Modifizierter interner Zinsfuß)   600

QUADRATESUMME (Summe der Quadrate)   600

Quadratwurzel (WURZEL)   689

QUANTIL (Quantile einer Datenmenge)   601

QUANTIL.EXKL (Quantile einer Datenmenge)   601

QUANTIL.INKL (Quantile einer Datenmenge)   602

QUANTILSRANG (Prozentrang eines Wertes)   603

QUANTILSRANG.EXKL (Prozentrang eines  
Wertes)   604

QUANTILSRANG.INKL (Prozentrang eines  
Wertes)   605

QUARTILE (Quartile einer Datenmenge)   606

QUARTILE.EXKL (Quartile einer Datenmenge)   607

QUARTILE.INKL (Quartile einer Datenmenge)   608

Quelle wählen (Datei)   241

Querformat   209

Quickinfos   363

Quickinfos für Formeln   360

QUOTIENT (Ganzzahliger Teil einer Division)   609

R
Rahmen und Zeichnungen direkt einfügen   360

Ränder  
Innenränder von AutoFormen   255
Innenränder von Textrahmen   239
Innenränder von Zellen   175
Seitenränder   209

Rang  
QUANTILSRANG   603
QUANTILSRANG.EXKL   604
QUANTILSRANG.INKL   605
RANG.GLEICH   610
RANG.MITTELW   611
RANK   609

RANG (Rang eines Wertes in einer Wertemenge)   609

RANG.GLEICH (Rang eines Wertes in einer  
Wertemenge)   610

RANG.MITTELW (Rang eines Wertes in einer  
Wertemenge)   611

Raster   381

Rechtecke  
Eigenschaften ändern   254
Zeichnen   251

RECHTS (Teil einer Zeichenkette)   612

Rechtsbündig   175

Rechtschreibprüfung   301, 302
Benutzerwörterbücher bearbeiten   304
Nachträglich   302
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Rechtschreibprüfung   301, 302
Sprache einstellen   301
Während des Tippens   304, 367
Wörterbücher nachinstallieren   404

Redo   36, 54

Regelmäßige Zahlung (RMZ)   618

Registerkarten für Dokumente   30, 353, 354

Regression, exponentielle  
Kenngrößen (RKP)   617
Werte (VARIATION)   672

Regression, lineare  
Kenngrößen (RGP)   615
Werte (TREND)   660

Reihenachse (in Diagrammen)   277

Reihenfolge (von Objekten)   236

Relative Zellbezüge   412

REST (Rest einer Division)   613

RESTP (Rest einer Division)   614

RGP (Kenngrößen einer linearen Regression)   615

Ribbon   20, 29, 363
Anpassen   393
Liste aller Menübefehle und Ribbonbefehle   710

Ribbon oder Menüs mit Symbolleisten?   363

Ringdiagramm   260

RKP (Kenngrößen einer exponentiellen Regression)   617

RMZ (Regelmäßige Zahlung)   618

RÖMISCH (Römische Schreibweise einer Zahl)   619

Rotieren  
Achsenbeschriftungen   274, 276, 277
Objekte   227, 229
Text in AutoFormen   255
Text in Textrahmen   239
Zellinhalte   175

Rubrikenachse (in Diagrammen)   274

Rückgängig (Änderungen)   36, 54

Runden  
ABRUNDEN   422
AUFRUNDEN   433
FEST   485
GANZZAHL   495
GERADE   499
KÜRZEN   551
OBERGRENZE   588
UNGERADE   669
UNTERGRENZE   669
VRUNDEN   681

RUNDEN (Runden auf n Stellen)   620

Rundung  
Endergebnisse runden   378
Genauigkeit wie angezeigt   378
Zahlen gerundet anzeigen (per Zahlenformat)   162
Zwischenergebnisse runden   378

S
SÄUBERN (Nicht-druckbare Zeichen entfernen)   621

Säulendiagramm   260

Scannen   241

Schaltfläche (Formularobjekt)   296

Schatten (bei Objekten)   232

Schattierung   174

SCHÄTZER (Schätzwert für einen linearen Trend)   621

SCHIEFE (Schiefe einer Verteilung)   622

Schließen (Datei)   354

Schnellwahlpfade   311

Schnellzugriffsleiste   29, 363, 395, 399

Schnittbereich  
Funktion SCHNITTBEREICH   623
Operator   409

SCHNITTBEREICH (Schnittmenge zweier  
Bereiche)   623

Schreibrichtung   349, 350

Schriftart   178

Schriftenliste mit echten Schriften   363

Schriftfarbe   181

Schriftgröße   178

Schutzanzeiger   376

Schützen   336
Arbeitsmappenschutz   339
Blattschutz   336
Dokumentschutz   340
Gliederungsansicht schützen   323

Schwellenwert (GGANZZAHL)   501

Script bearbeiten   352

Script starten   352

Scripts   290, 348, 352

Seite einrichten   209, 210, 213
auf andere Arbeitsblätter kopieren   74

Seitenformat   209

Seitennummer   210, 213

Seitenränder   209

Seitenumbruch  
Ein-/Ausblenden   381
Manuell beeinflussen   216

Seitenverhältnis beibehalten   229

Seitenzahl   213

Sekundäre Achsen (in Diagrammen)   281, 283

SEKUNDE (Sekunde aus einem Datumswert  
ermitteln)   624

Selektieren  
Objekte   224
Zellen   54

Selektiv löschen (Zellinhalte)   58

SHM-Erweiterungen verwenden   370

Sicherungskopien   316, 368

Silbentrennung   305
in Textrahmen   305
in Zellen   306
Sprache einstellen   301

SIN (Sinus)   624
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SINHYP (Sinus Hyperbolicus)   625

Sinus (SIN)   624

Sinus Hyperbolicus (SINHYP)   625

Skalierung (von Druckseiten)   210

Skalierung beibehalten   229

SoftMaker   21

SoftMaker Basic   352

SoftMaker Formeleditor   250

Sonderzeichen einfügen   155

Sortieren  
Befehl Arbeitsblatt > Sortieren   81
Funktion SORTIERENM   625
Funktion SORTIERENV   627

Sortieren (Menü Arbeitsblatt)   81

SORTIERENM (Sortieren)   625

SORTIERENV (Sortieren)   627

Spalte  
Breite   160
Breite ändern   159
Ein-/ausblenden   161
Einfügen   60
Löschen   59
Markieren   55
Optimale Breite   160

SPALTE (Funktion: Spaltennummer von Zellen)   628

SPALTEN (Funktion: Anzahl Spalten)   629

Spaltenkopf  
Ändern der Spaltenbreite   160
Drucken   210
Ein-/Ausblenden   381
Verwenden zum Markieren   55

Spaltennummer von Zellen (SPALTE)   628

Speichern (Datei)   39

Speichern unter (Datei)   39, 343

Spezialfilter   88

Spiegeln (von Objekten)   227

Spiegelungseffekt (bei Objekten)   233

Sprache  
Für die Benutzeroberfläche   363
für Rechtschreibung/Silbentrennung   301

Sprachmodule   301

STABW (Standardabweichung einer Stichprobe)   629

STABW.N (Standardabweichung einer  
Grundgesamtheit)   631

STABW.S (Standardabweichung einer Stichprobe)   633

STABWA (Standardabweichung einer Stichprobe)   630

STABWN (Standardabweichung einer  
Grundgesamtheit)   631

STABWNA (Standardabweichung einer  
Grundgesamtheit)   632

Standard (Dateiformat)   368

Standard (Zahlenformat)   163

Standard (Zeichenformatierung)   183

Standardabweichung  

Grundgesamtheit (STABW.N)   631
Grundgesamtheit (STABWN)   631
Grundgesamtheit (STABWNA)   632
Stichprobe (STABW)   629
Stichprobe (STABW.S)   633
Stichprobe (STABWA)   630

Standardfehler einer linearen Regression  
(STFEHLERYX)   636

STANDARDISIERUNG (Standardisierung)   634

Standardnormalverteilung  
GAUSS   496
NORM.S.INV   582
NORM.S.VERT   583
PHI   592
STANDNORMINV   634
STANDNORMVERT   635

Standardschrift   189

Standardwährung   376

STANDNORMINV (Quantile einer  
Standardnormalverteilung)   634

STANDNORMVERT (Standardnormalverteilung)   635

Statistik (des Dokuments)   376

Statuszeile   31
anzeigen/verbergen   363

STEIGUNG (Steigung einer Regressionsgeraden)   635

STFEHLERYX (Standardfehler einer linearen  
Regression)   636

Studentscher t-Test (T.TEST)   659

Studentscher t-Test (TTEST)   659

Student-Verteilung  
T.INV (linksseitig)   657
T.INV.2S (zweiseitig)   658
T.VERT   662
T.VERT.2S (zweiseitig)   663
T.VERT.RE (rechtsseitig)   663
TINV   656
TVERT   661

STUNDE (Stunde aus einem Datumswert ermitteln)   637

Subtraktion (Operator)   409

Suchen   217, 218
Dateien   315
Funktion FINDEN   486
Funktion SUCHEN   638
Suche wiederholen   218
Zellinhalte   217

SUCHEN (Funktion: Text in Zeichenkette suchen)   638

SUMME (Summe)   638

Summe ausgewählter Werte  
SUMMEWENN   641
SUMMEWENNS   642

SUMMENPRODUKT (Summenprodukt)   640

SUMMEWENN (Summe ausgewählter Werte)   641

SUMMEWENNS (Summe ausgewählter Werte)   642

SUMMEX2MY2 (Summe von x^2 - y^2)   643

SUMMEX2PY2 (Summe von x^2 + y^2)   644

SUMMEXMY2 (Summe von (x - y)^2)   645



745Index

SUMQUADABW (Mittlere quadratische Abweichung  
vom Mittelwert)   645

Support   21

SVERWEIS (Zellbereich spaltenweise  
durchsuchen)   646

Symbolleisten   384
Anpassen   384, 388
Benutzerdefinierte Symbole erstellen   399
Verwalten   387
Verwenden   27

Syntaxhervorhebung   91

System-Dateidialoge verwenden   363

Systemmenüs verwenden   363

Systemvoraussetzungen   22

Szenarien   100

T
T (Wert in eine Zeichenkette umwandeln)   648

T.INV (Quantile einer t-Verteilung linksseitig)   657

T.INV.2S (Quantile einer t-Verteilung zweiseitig)   658

T.TEST (t-Test)   659

T.VERT (t-Verteilung)   662

T.VERT.2S (t-Verteilung zweiseitig)   663

T.VERT.RE (t-Verteilung rechtsseitig)   663

Tabellen  
automatisch erweitern   360
Bearbeiten   49
Einfügen   114
Ergebniszeile   118
Gestalten   158
in Bereich konvertieren   113
Löschen   114
Markieren   55
Namen und Bezeichner   118
Neu anlegen   36
Öffnen   37
Schützen   336, 340
Selektieren   114
Tabelle löschen   113
Tabellen in Arbeitsblättern   111
Tabellenbereich   114
Tabelleneigenschaften   116
Tabellenvorlagen   116
Zellbezüge   118

Tabs schließen   354

Tabulatorbreite (in Textrahmen)   376

TAG (Tag aus einem Datumswert ermitteln)   648

TAGE (Differenz zwischen zwei Daten)   649

TAGE360 (Differenz zwischen zwei Daten)   650

TAGEIMJAHR (Zahl der Tage eines Jahres)   650

TAGEIMMONAT (Zahl der Tage eines Monats)   651

TAGEP (Kompatibilitätsfunktion)   652

TAN (Tangens)   653

Tangens (TAN)   653

Tangens Hyperbolicus (TANHYP)   653

TANHYP (Tangens Hyperbolicus)   653

Tastatur automatisch ein-/ausblenden   370

Tastenkürzel  
Anpassen   400
für Sonderzeichen   155
für Zeichenvorlagen   187, 188
für Zellenvorlagen   191
Vordefinierte   722
Vordefinierte:Mac   725
Vordefinierte:Windows/Linux   722

Technischer Support   21

TEIL (Teil einer Zeichenkette)   654

TEILERGEBNIS   654

TEXT (Zahl in formatierten Text wandeln)   656

Text (Zahlenformat)   163

Text eingeben   51

Text in Spalten aufteilen   83

Text in Zeichenkette ersetzen  
ERSETZEN   478
WECHSELN   684

TextArt-Objekte  
Eigenschaften ändern   254
Zeichnen   251

Textauszeichnungen   178, 180

Textbausteine   307
abrufen   309
anlegen   308
automatisch ersetzen   360
bearbeiten   309

Textdatei-Dateiformat   343, 344

Text-Eingabemodus   31

Textfilter (AutoFilter)   84

TextMaker-Dateiformat   343

Textrahmen  
Eigenschaften ändern   238, 239
Einfügen   238

Textrahmen-Hilfslinien   376

Tiefstellen   182

TINV (Quantile einer t-Verteilung)   656

Titel (von Diagrammen)   283

Titelleiste   26

Tortendiagramm   260

Transparenz (von Grafiken)   243

Transponieren (Menü Arbeitsblatt)   82

Transponieren einer Matrix (MTRANS)   573

TREND (Werte einer linearen Regression)   660

Trendlinien (in Diagrammen)   273

Trennzeichen für Zahlen   360

TTEST (t-Test)   659

TVERT (t-Verteilung)   661

t-Verteilung  
T.INV (linksseitig)   657
T.INV.2S (zweiseitig)   658
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t-Verteilung  
T.VERT   662
T.VERT.2S (zweiseitig)   663
T.VERT.RE (rechtsseitig)   663
TINV   656
TVERT   661

TYP (Typ des Arguments ermitteln)   664

U
Überlappende Objekte   239, 255

Uhrzeiten eingeben   51

Umrandung   171

UMWANDELN (Maßeinheiten umrechnen)   665

UND (Logisches UND)   668

Undo (Änderungen)   36, 54

UNGERADE (Aufrunden auf eine ungerade Zahl)   669

UNTERGRENZE (Abrunden auf ein Vielfaches  
von n)   669

Unterschneidung (Kerning)   183

Unterstreichen   180

Updates   370

V
VAR.P (Varianz einer Grundgesamtheit)   674

VAR.S (Varianz einer Stichprobe)   675

Varianz  
Grundgesamtheit (VAR.P)   674
Grundgesamtheit (VARIANZEN)   671
Grundgesamtheit (VARIANZENA)   672
Stichprobe (VAR.S)   675
Stichprobe (VARIANZ)   670
Stichprobe (VARIANZA)   670

VARIANZ (Varianz einer Stichprobe)   670
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